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Willkommen! 

Hinweis: Das Handbuch enthält bislang nur grundlegende Informationen zur 

Bedienung des Programms über die neue Menüband-Benutzeroberfläche 

(„Ribbons“). Ausführlichere Informationen dazu werden in einer späteren Auf-

lage nachgereicht.  

Tipp: Eine Tabelle, die zeigt, welcher Menübefehl welchem Ribbonbefehl ent-

spricht, finden Sie hier: Abschnitt „Menübefehle und entsprechende Ribbonbe-

fehle“ (Seite 827). 

Willkommen bei PlanMaker! Mit PlanMaker haben Sie ein überaus leistungsfähi-

ges und dabei komfortabel zu bedienendes Tabellenkalkulationsprogramm erwor-

ben.  

Wir haben uns bei der Erstellung dieses Programms bemüht, die Funktionen von 

PlanMaker so zu integrieren und aufeinander abzustimmen, dass Ihnen bei mög-

lichst geringem Arbeitsaufwand der größtmögliche Nutzen geboten wird.  

Dabei lässt Ihnen PlanMaker genügend Freiraum für Ihre individuellen Ansprüche. 

Über zahlreiche Einstellmöglichkeiten können Sie sich PlanMaker so einrichten, 

wie es Ihnen am besten gefällt. 

Hinweis: In SoftMaker FreeOffice, der kostenlosen Version von SoftMaker 

Office, wurden manche Programmfunktionen deaktiviert. Alle darin nicht ver-

fügbaren Funktionen sind in der Dokumentation mit einem solchen roten Kasten 

gekennzeichnet. 

Einige Features von PlanMaker 

 Erhältlich für Windows, Mac, Linux und Android. 

 Durchdachte und ergonomische Benutzeroberfläche – wahlweise mit moder-

nen „Ribbons“ oder klassischen Menüs und Symbolleisten 

 PlanMaker kennt über 330 Rechenfunktionen – von der einfachen Summen-

berechnung bis hin zu zahlreichen finanzmathematischen und statistischen 

Funktionen.  

 Das Erstellen von ansehnlichen Tabellen wird durch die vielfältigen Gestal-

tungsfunktionen erleichtert. Nüchterne Zahlenkolonnen können mit dem Au-
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toFormat-Befehl auf Knopfdruck in übersichtliche und ansprechende Tabellen 

verwandelt werden. Mit Zellen- und Zeichenvorlagen bringen Sie häufig be-

nötigte Formatierungen auf Knopfdruck an etc. 

 Das integrierte Diagramm-Modul erlaubt es Ihnen, Zahlen anschaulich in Dia-

grammen zu präsentieren. 

 ... und vieles mehr 

PlanMaker wird ständig weiterentwickelt. Falls Sie beim Arbeiten einmal ein Fea-

ture vermissen sollten oder andere Anregungen haben, schreiben Sie uns – wir wol-

len, dass PlanMaker den Wünschen der Anwender entspricht! 

Android-Versionen 

FreeOffice: Es gibt derzeit keine Android-Version von SoftMaker FreeOffice. 

Im Rahmen spezieller Aktionen bieten wir jedoch gelegentlich kostenlose 

Android-Apps an. Besuchen Sie unsere Website www.freeoffice.com für Details.  

PlanMaker ist auch für Android-Geräte erhältlich. Es gibt zwei Varianten mit fol-

genden Unterschieden: 

 PlanMaker HD für Android  

 Diese Version enthält praktisch alle Funktionen der Windows-Version. Sie ist 

für den Gebrauch auf Tablets optimiert. 

 PlanMaker Mobile für Android  

 Diese Version hat nur einen Teil des Funktionsumfangs der Windows-Version. 

Sie ist für den Gebrauch auf Smartphones optimiert. 

Dieses Handbuch widmet sich ausschließlich der HD-Version. (Bei der Mobile-

Version ist ein eigenes Handbuch enthalten.) 

http://www.freeoffice.com/


 

Handbuch PlanMaker Willkommen!  •  23 

Technischer Support 

Wenn Sie Fragen haben, hilft Ihnen unser technischer Support gerne weiter. Sie 

können diesen wie folgt erreichen: 

Website 

Auf unserer Website finden Sie die neuesten Updates für Ihre Programme, Tipps 

und Tricks, kostenlose Downloads und vieles mehr.  

Besuchen Sie uns auf: www.softmaker.de 

Supportforen 

In unseren Supportforen können Sie technische Fragen stellen und mit anderen 

Anwendern kommunizieren. 

Sie finden diese unter: forum.softmaker.de 

Anfragen an unseren Support 

Bei Problemen mit unserer Software helfen wir Ihnen gerne weiter.  

Sie können Ihre Fragen hier eingeben: www.softmaker.de/supportassistent 

Über dieses Handbuch 

PlanMaker besitzt sehr viele Funktionen – aber keine Sorge: Sie müssen nicht alle 

davon beherrschen! Nutzen Sie am Anfang nur die Möglichkeiten, die Sie benöti-

gen. Wenn Sie später einmal fortgeschrittenere Funktionen in Anspruch nehmen 

möchten, können Sie die entsprechenden Stellen im Handbuch immer noch nachle-

sen. 

Dieses Handbuch ist wie folgt aufgebaut: 

 Das Kapitel „Installation und Programmstart“ ab Seite 25 beschäftigt sich 

mit der Installation von PlanMaker. Sie erfahren weiterhin, wie das Programm 

gestartet wird. 

http://www.softmaker.de/
http://forum.softmaker.de/
http://www.softmaker.de/supportassistent
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 Im Kapitel „Der Arbeitsbildschirm“ ab Seite 31 werden die einzelnen Be-

standteile des Programmfensters von PlanMaker beschrieben. 

 Das Kapitel „Grundlagen“ ab Seite 41 stellt Ihnen die grundlegenden Funktio-

nen von PlanMaker vor und erläutert einige Grundbegriffe der Tabellenkalkula-

tion. 

 Das Kapitel „Die PlanMaker-Tour“ ab Seite 51 befasst sich praxisbezogen mit 

dem Thema Tabellenkalkulation und führt Sie anhand einiger Beispiele in die 

Bedienung von PlanMaker ein.  

 Mit dem Kapitel „Bearbeiten einer Tabelle“ ab Seite 63 beginnt der Referenz-

teil des Handbuchs. Dieser ist nach Sachgebieten aufgeteilt und beschreibt aus-

führlich alle Funktionen von PlanMaker. 

Systemvoraussetzungen 

Zum Einsatz dieser Software benötigen Sie folgende Hard- und Software:  

Windows-Version 

 Windows 10, Windows 8/8.1 oder Windows 7 (32 oder 64 Bit) 

Mac-Version 

 macOS oder OS X ab Version 10.9 („Mavericks“) 

Linux-Version 

 Beliebiges x86-Linux (32 oder 64 Bit) 

Android-Version 

 Android 4.0 oder höher 

 ARM-kompatible CPU 

 Displaygröße von 7 Zoll oder mehr empfohlen 
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Installation und Programmstart 
In diesem Kapitel erfahren Sie, wie Sie PlanMaker installieren und wie Sie das 

Programm starten. 

Das Kapitel ist nach Betriebssystemen aufgeteilt: 

 Installation unter Windows 

 Installation unter macOS 

 Installation unter Linux 

 Installation auf Android-Geräten 

Lesen Sie bitte bei dem Abschnitt für Ihr Betriebssystem weiter. 

Installation unter Windows 

Download 

Wenn Sie die Software als Download aus dem Internet bezogen haben, finden Sie 

Instruktionen zur Installation in der E-Mail, die Sie beim Kauf automatisch erhal-

ten haben. 

CD-ROM 

Wenn Sie die Software auf CD-ROM bezogen haben, starten Sie nun bitte das In-

stallationsprogramm im Hauptverzeichnis der CD. Folgen Sie dann den Anweisun-

gen des Installationsprogramms. 

Starten der Programme 

Zum Starten der installierten Programme verwenden Sie das Start-Menü in der 

linken unteren Bildschirmecke. Sie finden Ihre SoftMaker Office-Programme dort 

in einem Unterordner namens SoftMaker Office. 

Adresseingabe beim ersten Start: Wenn Sie PlanMaker zum ersten Mal starten, werden Sie gebeten, 

Ihren Namen, Ihre Adresse etc. anzugeben. Diese Angaben dienen nicht der Registrierung. Vielmehr 
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erlauben sie Ihnen, über die Funktion BENUTZERFELD Ihren Namen, Ihre Adresse etc. in Dokumente 

oder Dokumentvorlagen einzufügen. Sie können diese Angaben später jederzeit wieder ändern (siehe 

Abschnitt „Einstellungen, Karteikarte Allgemein“ ab Seite 435). 

Installation unter macOS 

Informationen zur Installation der Software finden Sie in der E-Mail, die Sie beim 

Kauf automatisch erhalten haben. 

Fehlermeldung beim Starten des Installationsprogramms? 

Abhängig von den Einstellungen Ihres Systems erhalten Sie beim Starten des In-

stallationsprogramms möglicherweise folgende Fehlermeldung: 

 

Dies passiert, wenn in den Sicherheitseinstellungen Ihres Systems festgelegt ist, 

dass nur Programme ausgeführt werden dürfen, die aus dem App Store herunterge-

laden wurden. 

Wie Sie das Installationsprogramm dennoch ausführen können, verrät ein Klick auf 

das Fragezeichen in der linken unteren Ecke der Meldung. Es erscheint ein Hilfe-

fenster, das folgende Vorgehensweise empfiehlt: 

1. Schließen Sie die Fehlermeldung. 

2. Halten Sie die ctrl-Taste gedrückt und klicken Sie auf das Installationspro-

gramm. 

3. Es erscheint ein Kontextmenü. Wählen Sie darin den Befehl Öffnen. 

4. Es erscheint eine Meldung, in der nachgefragt wird, ob Sie das Programm wirk-

lich öffnen möchten. Bestätigen Sie das, indem Sie auf die Schaltfläche Öffnen 

klicken. 
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Das Installationsprogramm wird nun gestartet. 

Starten der Programme 

Nach erfolgter Installation erscheinen Symbole für die installierten Programme 

sowohl im Launchpad als auch im Dock am unteren Bildschirmrand. Um eines der 

Programme zu starten, klicken Sie einfach sein Symbol an.  

Installation unter Linux 

Informationen zur Installation der Software finden Sie in der E-Mail, die Sie beim 

Kauf automatisch erhalten haben. 

Starten der Programme 

Bei den meisten Linux-Distributionen legt das Installationsprogramm automatisch 

Verknüpfungen für alle SoftMaker Office-Applikationen im Menü an. Mit diesen 

können Sie die Programme bequem per Mausklick starten. 

Als Alternative werden außerdem Skripte zum Starten der Programme angelegt:  

 textmaker18free startet TextMaker 

 planmaker18free startet PlanMaker 

 presentations18free startet Presentations 

Sie können diese Skripte beispielsweise in einer Shell aufrufen. 

Adresseingabe beim ersten Start: Wenn Sie PlanMaker zum ersten Mal starten, werden Sie gebeten, 

Ihren Namen, Ihre Adresse etc. anzugeben. Diese Angaben dienen nicht der Registrierung. Vielmehr 

erlauben sie Ihnen, über die Funktion BENUTZERFELD Ihren Namen, Ihre Adresse etc. in Dokumente 

oder Dokumentvorlagen einzufügen. Sie können diese Angaben später jederzeit wieder ändern (siehe 
Abschnitt „Einstellungen, Karteikarte Allgemein“ ab Seite 435). 



 

28  •  Installation und Programmstart Handbuch PlanMaker 

Installation auf Android-Geräten 

FreeOffice: Es gibt derzeit keine Android-Version von SoftMaker FreeOffice. 

Wir bieten jedoch gelegentlich kostenlose Versionen unserer Android-Apps an. 

Besuchen Sie unsere Website www.freeoffice.com für Details.  

Die Vorgehensweise beim Installieren von Applikationen auf Ihrem Android-Gerät 

hängt davon ab, wo Sie die Software erworben haben:  

Bei Kauf im Google Play Store 

Wenn Sie eine Applikation über den Google Play Store auf Ihrem Gerät erwerben, 

brauchen Sie zum Installieren nichts weiter zu tun: Die App wird direkt nach dem 

Kauf automatisch heruntergeladen und installiert.  

Bei Kauf im Amazon App Shop 

Das Gleiche gilt beim Kauf einer App über den Amazon App Shop auf Ihrem Ge-

rät: Auch hier wird diese direkt nach dem Kauf automatisch heruntergeladen und 

installiert.  

Hinweis: Falls Sie dabei eine Fehlermeldung erhalten, die besagt, dass Apps aus 

„unbekannten Quellen“ nicht installiert werden können, lesen Sie bitte den Ab-

schnitt „Erlauben der Installation von Apps aus unbekannten Quellen“ weiter un-

ten. 

Bei Kauf über unsere Website www.softmaker.de 

Wenn Sie SoftMaker Office hingegen über unsere Website www.softmaker.de 

gekauft haben, führen Sie die Installation wie folgt durch: 

1. Sofort nach dem Kauf erhalten Sie eine E-Mail mit Links für den Download der 

einzelnen Komponenten von SoftMaker Office. Klicken Sie diese nacheinander 

an, um die zugehörigen Installationsarchive (APK-Dateien) herunterzuladen. 

2. Wenn Sie den Download auf Ihrem Android-Gerät durchführen, startet die In-

stallation nach erfolgtem Download möglicherweise automatisch – dies hängt 

vom jeweiligen Gerät ab. Ist das nicht der Fall, führen Sie einfach eine manuel-

le Installation durch: Öffnen Sie dazu in einem beliebigen Dateimanager das 

http://www.freeoffice.com/
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Verzeichnis Download auf der SD-Karte und tippen Sie die heruntergeladenen 

APK-Dateien der Reihe nach an. 

 Wenn Sie den Download hingegen mit einem anderen Gerät durchgeführt ha-

ben (z.B. Ihrem PC), kopieren Sie die heruntergeladenen APK-Dateien auf Ihr 

Android-Gerät und tippen diese dann der Reihe nach in einem Dateimanager 

an. 

Das entsprechende Programm wird daraufhin auf Ihrem Gerät installiert. 

Hinweis: Falls Sie dabei eine Fehlermeldung erhalten, die besagt, dass Apps aus 

„unbekannten Quellen“ nicht installiert werden können, lesen Sie bitte den Ab-

schnitt „Erlauben der Installation von Apps aus unbekannten Quellen“ weiter un-

ten. 

Erlauben der Installation von Apps aus unbekannten Quellen 

Falls Sie die Apps über den Amazon App Shop oder unsere Website erworben 

haben, kann es beim Installieren zu einer Fehlermeldung kommen: 

Die meisten Android-Geräte sind so vorkonfiguriert, dass Applikationen darauf nur 

vom Google Play Store aus installiert werden können. Wenn Sie versuchen, Instal-

lationsarchive direkt zu installieren, erhalten Sie daher die Fehlermeldung, die be-

sagt, dass das Installieren aus „unbekannten Quellen“ nicht erlaubt sei. 

Damit die Installation durchgeführt werden kann, müssen Sie dem Gerät erst erlau-

ben, Anwendungen aus „unbekannten Quellen“ zu installieren. Gehen Sie dazu wie 

folgt vor: 

1. Öffnen Sie die Einstellungen Ihres Android-Geräts. 

2. Tippen Sie darin auf den Eintrag Sicherheit. 

3. Aktivieren Sie dort die Option Unbekannte Herkunft (bei manchen Geräten 

auch Unbekannte Quellen genannt). 

Nun können Sie SoftMaker Office wie oben beschrieben installieren. 

Tipp: Aus Sicherheitsgründen empfiehlt es sich, diese Option nach der Installation 

wieder zu deaktivieren. 
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Der Arbeitsbildschirm 
Auf den nächsten Seiten stellen wir Ihnen die einzelnen Komponenten der Benut-

zeroberfläche von PlanMaker vor.  

 

Das Programmfenster von PlanMaker (Windows-Version) 

Anmerkung: Die Abbildungen in diesem Handbuch wurden größtenteils mit der 

Windows-Version von PlanMaker angefertigt. Unter anderen Betriebssystemen 

sehen manche Bedienelemente zwar etwas anders aus, ihre Funktionsweise ist 

jedoch die gleiche. 

Titelleiste 

In der obersten Zeile des Programms finden Sie die Titelleiste. 

 

Diese zeigt den Programmnamen und den Namen des Dokuments an, das Sie gera-

de bearbeiten.  
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Falls das Dokument Änderungen enthält, die noch nicht gespeichert wurden, wird 

ein Sternchen hinter seinem Namen angezeigt. 

Menüleiste 

Unter der Titelleiste befindet sich die Menüleiste. 

 

Diese enthält sämtliche Befehle von PlanMaker in Form von übersichtlichen Me-

nüs. Klicken Sie auf einen Menüeintrag, um ein Menü zu öffnen und darin einen 

Befehl aufzurufen. 

Kontextmenü 

Es gibt außerdem noch ein weiteres Menü: das sogenannte Kontextmenü.  

Dieses enthält je nach Situation unterschiedliche Befehle. Wenn Sie beispielsweise 

etwas Text markieren und dann das Kontextmenü öffnen, bietet dieses Befehle zum 

Ausschneiden, Kopieren und Formatieren dieses Textes an. 

 

Um das Kontextmenü zu öffnen, markieren Sie üblicherweise erst etwas im Do-

kument und klicken das Markierte dann mit der rechten Maustaste an. 

Android: Bei der Android-Version können Sie das Kontextmenü auch mit dem Fin-

ger öffnen: Tippen Sie dazu auf den Bildschirm und halten Sie den Finger für etwa 

eine Sekunde gedrückt. 
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Funktionsleiste 

Unter der Menüleiste wird die Funktionsleiste angezeigt. Diese enthält Symbole 

für die gebräuchlichsten Befehle von PlanMaker. 

 

Symbolleisten wie die Funktionsleiste ermöglichen blitzschnellen Zugriff auf die 

Funktionen eines Programms. Jedes Symbol steht für einen bestimmten Befehl. 

Klicken Sie darauf, wird der entsprechende Befehl aufgerufen.  

Tipp: Wenn Sie mit der Maus auf eines der Symbole zeigen (ohne zu klicken), 

erscheint ein Infotext, der die Funktion des Symbols angibt. 

Es gibt in PlanMaker noch zahlreiche weitere solche Symbolleisten, die Sie nach 

Belieben ein- und ausschalten können. Rufen Sie dazu entweder den Menübefehl 

Ansicht > Symbolleisten auf oder klicken Sie mit der rechten Maustaste auf eine 

der angezeigten Symbolleisten. Es erscheint ein Menü, in dem Sie wählen können, 

welche Leisten angezeigt werden sollen. 

Symbolleisten selbst gestalten: Sie können die vorgegebenen Symbolleisten nach 

Belieben verändern und auch eigene Symbolleisten erstellen. Informationen dazu 

finden Sie im Abschnitt „Symbolleisten anpassen“ ab Seite 469. 

Formatleiste 

Die Formatleiste finden Sie unterhalb der Funktionsleiste. Sie können damit die 

gebräuchlichsten Textformatierungen (Schriftart, Fettdruck, Kursivschrift usw.) für 

Tabelleninhalte sowohl ablesen als auch ändern. 

 

Um beispielsweise eine andere Schriftart auszuwählen, klicken Sie auf das kleine 

Pfeilchen rechts neben der Schriftart, um die Liste zu öffnen, und wählen dann eine 

Schriftart aus. 

Andere Symbole der Formatleiste sind wiederum Schalter, die Sie durch Anklicken 

ein- und ausschalten können – zum Beispiel das F für Fettdruck. 

Tipp: Wenn Sie mit der Maus auf eines der Symbole zeigen (ohne zu klicken), 

erscheint ein Infotext, der die Funktion des Symbols angibt. 
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Bearbeitungsleiste 

Unterhalb von Funktions- und Formatleiste finden Sie die Bearbeitungsleiste. 

 

Auf dieser Leiste gibt es folgende Bedienelemente: 

Zelladresse 

Ganz links wird die Adresse der momentan aktiven Tabellenzelle angezeigt. 

Symbole und Eingabefeld zum Bearbeiten von Zellinhalten 

Rechts daneben finden Sie vier Symbole und ein Eingabefeld. 

Mit Hilfe des Eingabefelds können Sie den Inhalt der aktuellen Zelle bearbeiten. 

Alternativ können Sie den Zellinhalt allerdings auch direkt in der entsprechenden 

Zelle bearbeiten: die Zelle einfach ansteuern und tippen. Letzteres geht in der Re-

gel schneller.  

Ausführliche Informationen zum Ausfüllen und Bearbeiten von Tabellenzellen 

finden Sie im Abschnitt „Daten in Zellen eingeben“ ab Seite 67. 

Die Schaltflächen daneben haben folgende Funktionen: 

Symbol Funktion 

 
Menübefehl Einfügen > Funktion aufrufen 

 
Eingabe im Eingabefeld übernehmen (entspricht dem Drücken der Ein-

gabetaste (¢)) 

 
Eingabe im Eingabefeld verwerfen (entspricht dem Drücken der Taste 
(Esc)) 

Weitere Informationen zum Eingeben von Rechenformeln finden Sie im Kapitel 

„Formeln und Funktionen“ ab Seite 503. 
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Ribbon (Menüband) 

Wenn Sie in den Einstellungen ausgewählt haben, dass Sie statt klassischer Menüs 

und Symbolleisten lieber ein Ribbon (also ein Menüband) verwenden möchten, 

sieht der oberste Bereich des Programmfensters bei Ihnen etwa folgendermaßen 

aus: 

 

Das „Ribbon“ (Ausschnitt) und die Schnellzugriffsleiste (ganz unten) 

Ribbons sind eine moderne Art von Benutzeroberfläche, die Menüs und Symbol-

leisten ersetzen soll, indem sie diese quasi kombiniert. Dies soll den Umgang mit 

der Software vereinfachen. 

Wie Sie sehen, verfügt das Ribbon über mehrere Karteikarten, deren Karteikarten-

reiter ganz oben angezeigt werden (Datei, Start, Einfügen etc.). Jede dieser Kartei-

karten enthält Symbole zu einem bestimmten Aufgabenbereich. Um zu einer be-

stimmten Karteikarte zu wechseln, klicken Sie auf ihren Reiter.  

Unter dem Ribbon wird die Schnellzugriffsleiste angezeigt. Diese bietet eine Aus-

wahl an besonders häufig benötigten Befehlen. 

Hinweis: Das Handbuch enthält bislang nur grundlegende Informationen zur 

Bedienung des Programms über das Ribbon. Ausführlichere Informationen dazu 

werden in einer späteren Auflage nachgereicht.  

Tipp 1: Eine Tabelle, die zeigt, welcher Menübefehl welchem Ribbonbefehl ent-

spricht, finden Sie hier: Abschnitt „Menübefehle und entsprechende Ribbonbe-

fehle“ (Seite 827). 

Tipp 2: Sie können auch vom Ribbon aus auf das klassische Menü zugreifen: 

Klicken Sie einfach auf das Symbol  in der Schnellzugriffsleiste, um dieses zu 

öffnen. 
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Tipp 3: Die Benutzeroberfläche lässt sich jederzeit zwischen Ribbon und klassi-

schen Menüs mit Symbolleisten umschalten. Rufen Sie dazu im Menü den Befehl 

Weiteres > Einstellungen auf (beziehungsweise im Ribbon den Befehl Datei > 

Einstellungen). Wechseln Sie in dem Dialog auf die Karteikarte Aussehen und 

klicken Sie darin auf die Schaltfläche Benutzeroberfläche. Es erscheint ein wei-

terer Dialog, in dem Sie die gewünschte Art von Benutzeroberfläche wählen 

können. 

Registerkarten für Dokumente 

FreeOffice: Die Funktionen zum Arbeiten mit Registerkarten für Dokumente 

sind in SoftMaker FreeOffice nicht enthalten. Sie können jedoch mehrere Do-

kumente in verschiedenen Programmfenstern öffnen. 

Unter der Bearbeitungsleiste sehen Sie eine Leiste mit Registerkarten. Darin wird 

für jedes momentan geöffnete Dokument jeweils eine Registerkarte angezeigt. 

 

Die Registerkarten für Dokumente 

Mit den Registerkarten lassen sich folgende Aktionen durchführen: 

 Um ein Dokument zum aktiven Dokument zu machen, klicken Sie mit der lin-

ken Maustaste auf seine Registerkarte. So können Sie blitzschnell zwischen den 

geöffneten Dokumenten hin- und herwechseln. 

 Um ein Dokument zu schließen, klicken Sie mit der mittleren Maustaste auf 

seine Registerkarte. 

 Alternativ können Sie auch mit der linken Maustaste auf das x-Symbol klicken, 

das ganz rechts in der Registerkarte angezeigt wird. 

Dokumente können bei Bedarf übrigens auch in einem neuen Programmfenster 

geöffnet werden. Details zum Arbeiten mit mehreren Dokumenten finden Sie im 

Kapitel „Mehrere Dokumente gleichzeitig bearbeiten“ (Seite 425). 
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Dokument 

Den größten Teil des Programmfensters nimmt das Dokument selbst ein. Dies ist 

Ihr Arbeitsbereich. Hier tragen Sie Ihre Daten ein, nehmen Berechnungen vor etc. 

Informationen dazu finden Sie im Rest dieses Handbuchs, insbesondere im Kapitel 

„Bearbeiten einer Tabelle“ ab Seite 63. 

Arbeitsblattregister 

Unterhalb des Dokuments wird das Arbeitsblattregister angezeigt. 

Ein PlanMaker-Dokument kann aus mehreren Tabellenblättern bestehen, die – wie 

ein Stapel Papier – aufeinander gestapelt sind. Diese werden Arbeitsblätter ge-

nannt. Mit dem Arbeitsblattregister können Sie zwischen den einzelnen Arbeits-

blättern eines Dokuments wechseln, neue Blätter anlegen und Blätter löschen (sie-

he Abschnitt „Arbeiten mit mehreren Arbeitsblättern“ ab Seite 93). 

 

In obiger Abbildung sehen Sie, wie das Arbeitsblattregister bei einer Arbeitsmappe 

mit drei Arbeitsblättern aussieht. Das momentan aktive Blatt „Tabelle1“ ist hervor-

gehoben. 

Statuszeile 

Am unteren Ende des Programmfensters befindet sich die Statuszeile. 

 

Wenn Sie mit der Maus auf eines der Symbole einer Symbolleiste oder eines Rib-

bons zeigen, wird in der Statuszeile eine kurze Erläuterung zur Funktion dieses 

Symbols ausgegeben. 

Darüber hinaus werden in der Statuszeile folgende Informationen angezeigt: 



 

38  •  Der Arbeitsbildschirm Handbuch PlanMaker 

Beispiel Erläuterung 

 Ganz links werden unterschiedliche Informationen angezeigt. Zeigen 

Sie beispielsweise auf ein Symbol der Funktionsleiste, wird hier die 

Funktion dieses Symbols eingeblendet. 

Tabelle1 Rechts daneben wird der Name des aktuellen Arbeitsblatts angezeigt. 

Summe=6 Daneben wird die sogenannte Online-Berechnung angezeigt. Ist nur 

eine Zelle markiert, wird ihr Inhalt angezeigt. Sind mehrere Zellen 

markiert, wird die Summe der Zellinhalte angezeigt. (Siehe auch 

Option Online-Berechnung in Statuszeile in den Einstellungen.) 

 Dieses Symbol leuchtet auf, wenn die Tabelle einen zirkulären Be-

zug enthält. Dies weist normalerweise auf eine fehlerhaft formulierte 

Formel hin – zum Beispiel eine Rechenformel in Zelle A1, die sich 

auf die Zelle A1 bezieht. 

 Wenn Sie dieses Symbol anklicken, springt der Zellrahmen auf die 

Zelle mit dem zirkulären Bezug. Klicken Sie erneut, springt er auf 

die nächste derartige Zelle (falls mehrere vorhanden sind). 

EINF Zeigt an, ob der Einfügemodus (EINF) oder der Überschreibmodus 

(ÜB) aktiv ist. Dadurch bestimmen Sie, was beim Editieren einer 

Zelle mit dem alten Zellinhalt passieren soll: 

 EINF: Der Einfügemodus ist aktiv – neu eingegebener Text wird 

also vor dem bestehenden Text eingefügt. 

 ÜB: Der Überschreibmodus ist aktiv – neu eingegebener Text über-

schreibt also den bestehenden Text. 

 Die Standardeinstellung ist EINF. Mit der Taste (Einfg) können Sie 

zwischen diesen beiden Modi umschalten. 

AUTO Zeigt den aktuellen Eingabemodus von PlanMaker an: 

 AUTO: Der normaler Eingabemodus ist aktiv – Zahlen werden au-

tomatisch als Zahlen erkannt, und Formeln werden automatisch als 

Formeln erkannt. Dies ist die Standardeinstellung. 

 TEXT: Der Text-Eingabemodus ist aktiv – sämtliche Eingaben wer-

den in Text umgewandelt (auch Zahlen und Formeln). 

 Um zwischen diesen beiden Modi zu wechseln, klicken Sie auf den 

Text „AUTO“ in der Statuszeile oder betätigen die Tastenkombinati-

on (Strg)(ª)(F4). 
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 Wichtig: Wenn Sie in den TEXT-Eingabemodus umschalten, wird 

allen Zahlen und Formeln, die Sie eingeben, automatisch ein einfa-

ches Anführungszeichen (') vorangestellt. Dadurch werden diese in 

Text umgewandelt und können nicht mehr für Berechnungen ver-

wendet werden. (Um aus so umgewandelten Zahlen/Formeln wieder 

normale Zahlen/Formeln zu machen, wechseln Sie wieder zurück in 

den AUTO-Modus und entfernen diese Anführungszeichen.) 

Darüber hinaus enthält die Statuszeile einen Zoomregler, mit dem Sie die Vergrö-

ßerungsstufe für das Dokument ändern können: 

 

Ziehen Sie dazu entweder an dem Schieber in der Mitte, oder klicken Sie auf das 

Minus- oder Plussymbol. (Siehe auch Abschnitt „Vergrößerungsstufe“ ab Seite 

468.) 
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Grundlagen 

Dieses Kapitel stellt Ihnen die wichtigsten grundlegenden Funktionen von Plan-

Maker vor und erläutert einige Grundbegriffe der Tabellenkalkulation.  

Folgende Themen werden in diesem Kapitel behandelt: 

 Der Aufbau einer Tabelle 

 Zunächst erfahren Sie, wie Tabellen überhaupt aufgebaut sind. 

 Bewegen in einer Tabelle 

 Anschließend geht es darum, wie Sie in einer Tabelle navigieren können. 

 Daten eingeben und Daten löschen 

 In den nächsten beiden Abschnitten lernen Sie Methoden zum Eingeben und 

Löschen von Daten kennen. 

 Änderungen rückgängig machen 

 Hier erfahren Sie, wie Sie Änderungen am Dokument wieder rückgängig ma-

chen können. 

 Neues Dokument beginnen 

 Dieser Abschnitt zeigt Ihnen, wie Sie ein neues Dokument anlegen. 

 Dokument öffnen, Dokument drucken und Dokument speichern 

 In diesen drei Abschnitten geht es um das Öffnen, das Drucken und das Spei-

chern von Dokumenten. 

Lesen Sie dazu die nächsten Seiten. 

Der Aufbau einer Tabelle 

Um PlanMaker beim Durcharbeiten dieses Kapitels gleich ausprobieren zu können, 

sollten Sie ihn jetzt starten.  
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Wie Sie an der Abbildung schon erkennen können, sind Tabellen in Zeilen und 

Spalten aufgeteilt. Jede Tabelle kann bis zu eine Million Zeilen und 16384 Spalten 

haben. Diese sind wie folgt beschriftet: 

 Die Zeilen sind durchnummeriert. 

 Die Spalten hingegen sind mit Buchstaben gekennzeichnet: A bis Z, dann AA 

bis AZ, dann BA bis BZ etc. 

Durch diese Aufteilung in Zeilen und Spalten entsteht ein Netz aus „Kästchen“. 

Diese Kästchen werden die Zellen der Tabelle genannt.  

Jede Zelle hat eindeutige „Koordinaten“: „B5“ bezeichnet beispielsweise die Zelle 

in der fünften Zeile der Spalte B (also der zweiten Spalte). „A3“ wäre die Zelle in 

der dritten Zeile der Spalte A etc. Diese Koordinaten einer Zelle nennt man die 

Adresse dieser Zelle.  

Die Zelladresse ist sehr wichtig, denn Berechnungen beziehen sich oft auf andere 

Zellen: Wenn Sie beispielsweise in Zelle A2 ausrechnen möchten, wie groß der 

doppelte Wert der Zelle A1 ist, so tippen Sie einfach in Zelle A2 ein: =A1*2.  

In A2 wird nun stets der doppelte Wert von A1 ausgegeben. Wenn Sie den Wert in 

A1 ändern, wird diese Berechnung automatisch aktualisiert. 
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Bewegen in einer Tabelle 

Wenn Sie in PlanMaker etwas eingeben, landet diese Eingabe stets in der aktuellen 

Zelle. Welche Zelle dies ist, zeigt ein kleiner dunkler Rahmen, der die Zelle umgibt 

– der Zellrahmen:  

 

Um den Zellrahmen zu einer anderen Zelle zu verschieben, gehen Sie wie folgt 

vor: 

Maus: Klicken Sie die gewünschte Zelle an. 

Tastatur: Über die Tastatur können Sie den Zellrahmen mit den Richtungstasten 

verschieben. Eine Tabelle aller hierfür verfügbaren Tasten finden Sie im Abschnitt 

„Tastenbelegung“ (ab Seite 840). 

Daten eingeben 

Um in eine Zelle etwas einzugeben, steuern Sie die gewünschte Zelle mit den 

Richtungstasten oder per Mausklick an und beginnen mit dem Tippen. 

Um Ihre Eingabe abzuschließen, drücken Sie die Eingabetaste (¢).  

Wenn Sie einen Eingabefehler gemacht haben, ist das kein Problem: Drücken Sie 

nach der Eingabe statt der Eingabetaste (¢) die Taste (Esc), worauf PlanMaker 

vergisst, was Sie getippt haben, und den alten Zellinhalt wiederherstellt.  

Alternativ können Sie Eingaben auch über die folgenden Schaltflächen der Bear-

beitungsleiste abschließen: 

 Klicken Sie auf , um die Eingabe zu übernehmen. 

 Oder klicken Sie auf , um die Eingabe zu verwerfen. 

Um den Inhalt einer bereits ausgefüllten Zelle nachträglich zu bearbeiten, steuern 

Sie die Zelle an und betätigen die Taste (F2). Alternativ können Sie auch einfach 

einen Doppelklick auf die Zelle ausführen.  

Ausführliche Informationen zu diesem Thema finden Sie im Abschnitt „Daten in 

Zellen eingeben“ ab Seite 67. 
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Daten löschen 

Es gibt mehrere Möglichkeiten, Daten aus einem Dokument zu löschen: 

 Löschen des Inhalts einer Zelle 

 Um den kompletten Inhalt einer Zelle zu löschen, steuern Sie diese Zelle an 

und drücken dann die Taste (Entf) oder rufen den Menübefehl Bearbeiten > 

Löschen auf. 

 Löschen von Teilen des Inhalts einer Zelle 

 Um nur einen Teil des Inhalts einer Zelle zu löschen, steuern Sie diese an und 

drücken die Taste (F2). Nun können Sie den Zellinhalt editieren, also beispiels-

weise auch Teile davon löschen. 

 Löschen des Inhalts mehrerer Zellen 

 Um mehrere Zellen auf einmal zu löschen, markieren Sie diese bevor Sie die 

Taste (Entf) drücken oder den Befehl Löschen aufrufen. Wie man Zellen mar-

kieren kann, beschreibt der Abschnitt „Markieren von Zellen und Zellinhalten“, 

Seite 71. 

Ausführlichere Informationen zu diesem Thema finden Sie im Abschnitt „Löschen 

von Zellen und Zellinhalten“ ab Seite 75. 

Änderungen rückgängig machen 

Mit dem Menübefehl Bearbeiten > Rückgängig können Sie die zuletzt an einem 

Dokument durchgeführten Änderungen widerrufen. Formatieren Sie also bei-

spielsweise Zellen in einer anderen Schrift, brauchen Sie nur Bearbeiten > Rück-

gängig aufzurufen, und schon wird dies wieder aufgehoben.  

Der Befehl Rückgängig lässt sich bei Bedarf mehrmals hintereinander anwenden. 

Rufen Sie ihn zum Beispiel fünfmal auf, werden die letzten fünf Änderungen wi-

derrufen. 

Wiederherstellen von widerrufenen Aktionen 

Es gibt auch ein Gegenstück zum Befehl Rückgängig: den Menübefehl Bearbei-

ten > Wiederherstellen. Er stellt die zuletzt von Ihnen widerrufene Aktion wieder 

her. So können Sie also das Widerrufen von Änderungen widerrufen. 
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Ausführliche Informationen zu diesem Thema finden Sie im Abschnitt 

„Änderungen rückgängig machen“ ab Seite 70).  

Neues Dokument beginnen 

Wenn Sie ein neues Dokument beginnen möchten, rufen Sie den Menübefehl Datei 

> Neu auf. 

Es erscheint ein Dialogfenster, in dem Sie eine Dokumentvorlage für die Tabelle 

wählen können. Wenn Sie einfach eine normale Tabelle ohne weitere Vorgaben 

erstellen möchten, wählen Sie die Standardvorlage NORMAL.PMVX.  

Sobald Sie mit OK bestätigen, wird das neue Dokument angelegt. 

Neues Programmfenster: Die Option Neues Programmfenster im Dialogfenster 

dieses Befehls hat dabei folgende Bedeutung: Wenn sie eingeschaltet ist, erscheint 

das neue Dokument in einem neuen Programmfenster. Ist sie ausgeschaltet, wird 

das Dokument im bestehenden Programmfenster angelegt. (Hinweis: Diese Option 

steht in der Android-Version nicht zur Verfügung.) 

Informationen zur Verwendung von Dokumentvorlagen können Sie später im Ab-

schnitt „Dokumentvorlagen“ ab Seite 208 nachlesen. 

Dokument öffnen 

Um ein Dokument zu öffnen, rufen Sie den Befehl Öffnen im Menü Datei auf.  

Es erscheint ein Dialogfenster, das beispielsweise wie folgt aussehen kann: 
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Je nach Betriebssystem ist dieses Dialogfenster etwas anders gestaltet, seine Funk-

tion ist aber immer die gleiche: Über diesen Dialog teilen Sie PlanMaker mit, wel-

ches Dokument geöffnet werden soll. 

Dazu könnten Sie einfach den Namen der zu öffnenden Datei von Hand eintippen. 

Über die Auswahlliste mit den Dateien geht dies allerdings komfortabler, denn hier 

werden alle Dateien im aktuellen Ordner aufgelistet und können bequem ausge-

wählt werden. 

Neues Programmfenster: Die Option Neues Programmfenster im Dialogfenster 

dieses Befehls hat dabei folgende Bedeutung: Wenn sie eingeschaltet ist, erscheint 

das Dokument in einem neuen Programmfenster. Ist sie ausgeschaltet, wird das 

Dokument im bestehenden Programmfenster geöffnet. (Hinweis: Diese Option 

steht in der Android-Version nicht zur Verfügung.) 

Andere Dateiformate öffnen 

PlanMaker kann nicht nur seine eigenen Dokumente, sondern auch Dateien anderer 

Programme öffnen. Sie müssen dazu lediglich das gewünschte Format in der Liste 

Dateityp auswählen.  
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Weitere Informationen dazu finden Sie im Kapitel „Fremdformate“ ab Seite 411. 

Vorschau auf ein Dokument 

Wenn die Option Vorschau eingeschaltet ist, erscheint rechts neben dem Dialog 

eine kleine Vorschau auf den Inhalt des momentan selektierten Dokuments. 

Schnellwahlpfade verwenden 

Über die Schaltfläche Schnellwahlpfad können Sie Schnellwahlpfade anlegen und 

abrufen, um beim Öffnen oder Speichern von Dateien blitzschnell in einen be-

stimmten Ordner wechseln zu können.  

Weitere Informationen dazu finden Sie im Abschnitt „Schnellwahlpfade“ ab Seite 

368. 

Dateimanager 

FreeOffice: Der Dateimanager ist in SoftMaker FreeOffice nicht enthalten. 

Über die Schaltfläche Dateimanager können Sie den integrierten Dateimanager 

aufrufen. Dieser zeigt eine Liste Ihrer Dokumente an und lässt Sie diese nicht nur 

öffnen, drucken, ansehen oder löschen, sondern auch durchsuchen.  

Weitere Informationen dazu finden Sie im Abschnitt „Dateimanager“ ab Seite 370. 

Liste der zuletzt geöffneten Dateien 

Tipp: Am unteren Ende des Menüs Datei finden Sie eine Liste der zuletzt geöffne-

ten Dateien. Um eine dieser Dateien erneut zu öffnen, klicken Sie sie einfach an. 

Dokument drucken 

Wenn Sie das aktuelle Dokument ausdrucken möchten, rufen Sie den Menübefehl 

Datei > Drucken auf. 

Es erscheint ein Dialogfenster, in dem Sie unter anderem einstellen können, welche 

Bestandteile des Dokuments gedruckt werden sollen. 
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Ausführliche Informationen zum Ausgeben Ihrer Dokumente finden Sie im Kapitel 

„Ausgeben von Dokumenten“ (Seite 389). 

Dokument speichern 

Wenn Sie ein Dokument fertiggestellt haben, sollten Sie dieses speichern, um es 

dauerhaft zu erhalten. Rufen Sie dazu den Menübefehl Datei > Speichern auf.  

Sollte das Dokument noch keinen Namen besitzen, fordert Sie PlanMaker vor dem 

Speichern automatisch auf, einen Dateinamen zu vergeben. 

Speichern unter einem anderen Namen/an einem anderen Ort 

PlanMaker verfügt außerdem über den Menübefehl namens Datei > Speichern 

unter. Dieser sichert Ihr Dokument ebenfalls, jedoch können Sie ihm zuvor einen 

anderen Dateinamen geben oder einen anderen Ordner zum Speichern wählen. 

Speichern in einem anderen Dateiformat 

Sie können ein Dokument mit dem Menübefehl Datei > Speichern unter auch im 

Dateiformat eines anderen Programms speichern. Wählen Sie dazu das gewünschte 

Format in der Liste Dateityp (siehe Kapitel „Fremdformate“ ab Seite 411). 

Speichern aller geöffneten Dokumente 

Haben Sie mehrere Dokumente gleichzeitig geöffnet, können Sie den Menübefehl 

Datei > Alles speichern verwenden, um diese alle auf einmal speichern zu lassen. 

PlanMaker prüft dabei nach, ob die Dokumente seit dem letzten Speichern geän-

dert wurden, und speichert nur diejenigen Dokumente, bei denen dies der Fall ist. 

Arbeit beenden 

Wenn Sie PlanMaker beenden möchten, rufen Sie den Menübefehl Datei > Been-

den auf.  
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Wurde eines der geöffneten Dokumente seit seiner letzten Speicherung verändert, 

fragt PlanMaker automatisch nach, ob Sie es zuvor noch speichern möchten. 
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Die PlanMaker-Tour 

Willkommen bei der PlanMaker-Tour!  

Auf den nächsten Seiten werden Sie PlanMaker noch etwas näher kennenlernen als 

im Kapitel „Grundlagen“. Anwender, die keine oder nur wenig Erfahrung im Um-

gang mit Tabellenkalkulationen haben, sollten die nächsten Seiten unbedingt lesen.  

Auch fortgeschrittene Anwender sollten dieses Kapitel zumindest überfliegen – Sie 

werden darin einige nützliche Tipps finden, die Ihnen die Bedienung von PlanMa-

ker erleichtern. 

Anmerkung: Die Abbildungen in diesem Handbuch wurden größtenteils mit der 

Windows-Version von PlanMaker angefertigt. Unter anderen Betriebssystemen 

sehen manche Bedienelemente zwar etwas anders aus, ihre Funktionsweise ist 

jedoch die gleiche. 

Zu Beginn fünf Minuten Theorie 

Das Thema „Rechnen und Computer“ erschließt sich am besten von einem kleinen 

Rückblick her. Denn gerade über das Gebiet „Rechnen“ erfolgte ursprünglich der 

Siegeszug der Computertechnik in die Haushalte und Büros. Den ersten zaghaften 

Vorstoß unternahmen die Taschenrechner. Sie sind sicherlich eine große Hilfe, aber 

gerade an ihren Nachteilen lässt sich gut zeigen, wo die Stärken einer Tabellenkal-

kulation liegen: 

Wenn Sie beispielsweise einen Computerkauf planen, müssen Sie diverse Angebo-

te vergleichen, die jeweils aus verschiedenen Einzelposten bestehen: Sie brauchen 

beispielsweise einen PC, einen Monitor und einen Drucker. Beim einen Anbieter 

ist der PC sehr günstig, beim anderen gibt es den Monitor billiger etc. Welches 

Angebot ist nun das günstigste? 

Um dies herauszufinden, müssen Sie fleißig addieren. Dazu zücken Sie den Ta-

schenrechner, addieren Zahl für Zahl, notieren das Ergebnis – und ärgern sich. 

Denn bei jedem neuen Angebot beginnt das gleiche Spiel von vorn. Selbst dann, 

wenn die meisten Zahlen gleich bleiben sollten. 

Mit einer Tabellenkalkulation lassen sich derartige Kalkulationen komfortabler 

durchführen. 
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Die erste Technik, der Sie beim Arbeiten mit PlanMaker begegnen werden, ist der 

Einsatz von „Variablen“. Variablen helfen dabei, Formeln – in unserem Beispiel 

einfache Additionen – zunächst einmal ohne Zahlen zu notieren. Dies könnte so 

aussehen: 

PC + Monitor + Drucker = Gesamtpreis  

Ein wenig abstrakter ausgedrückt – so, wie wir es alle einmal im Mathematikunter-

richt gelernt haben – heißt unsere Formel also: 

a + b + c = d 

Praktischen Nutzen hat solch eine Formel beim Rechnen ohne Tabellenkalkulation 

nur, wenn Sie beispielsweise einen programmierbaren Taschenrechner besitzen – in 

den können Sie dann die Formel eintippen, und er fragt Angebot für Angebot die 

Einzelpreise ab, um daraus automatisch die Summe zu berechnen. Allzu viel ge-

wonnen ist damit allerdings noch nicht... 

Erste Schritte mit PlanMaker 

Nach diesen Vorüberlegungen ist es nun an der Zeit, sich einmal anzusehen, wie 

solche Aufgaben mit PlanMaker gelöst werden können. 

Starten Sie dazu PlanMaker jetzt. 

Unter Windows sieht PlanMaker wie folgt aus: 
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Den größten Teil des Programmfensters nimmt das Arbeitsblatt ein. Oben ist es 

durch eine Leiste mit Buchstaben begrenzt, links durch eine Leiste mit Zahlen. 

Sehen wir uns ein solches Arbeitsblatt einmal etwas genauer an: 

Der Aufbau einer Tabelle 

Wie Sie aus dem Kapitel „Grundlagen“ bereits wissen, ist ein Arbeitsblatt (wir 

nennen es meist einfach „Tabelle“) in Zeilen und Spalten aufgeteilt. Die grauen 

Linien, die in der Tabelle zu sehen sind, deuten dies auch an.  

Die Zelle in der linken oberen Ecke ist mit einem dunklen Rahmen umgeben. Die-

ser wird Zellrahmen genannt. Er zeigt an, welche Zelle gerade aktiv ist.  

 

Wenn Sie etwas eintippen, landet das immer in der Zelle, auf der sich der Zellrah-

men befindet. 

Drücken Sie nun einige Male die Pfeiltasten (¼) und (Æ), um den Zellrahmen zu 

bewegen.  
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Achten Sie dabei auf das Anzeigefeld links oberhalb der Tabelle: Dort zeigt Plan-

Maker die Adresse der Zelle an, auf der sich der Zellrahmen gerade befindet. Die 

Adresse besteht immer aus ein bis zwei Buchstaben und einer Zahl:  

„A1“ bedeutet „Spalte 1, Zeile 1“. 

„A5“ bedeutet „Spalte 1, Zeile 5“. 

„D5“ bedeutet „Spalte 4, Zeile 5“ etc. 

Die Tatsache, dass jede Zelle eine eindeutige Adresse hat, ist der Schlüssel zu allen 

Funktionen der Tabellenkalkulation: Sie können dadurch in jede beliebige Zelle 

Berechnungen eingeben, die sich auf andere Zellen beziehen – also beispielsweise 

die Summe von Zellen bilden. Dabei brauchen Sie nicht einmal mit Variablen wie 

a, b, c zu hantieren, sondern verwenden einfach die Koordinaten der Zellen. 

Dies verhält sich so, als würden Sie jemandem ein Arbeitsblatt übergeben und ihn 

beispielsweise auffordern: „Addiere bitte die Zahlen in der zweiten, dritten und 

vierten Zeile der zweiten Spalte“. 

Eingeben von Werten und Formeln 

Genug der Theorie. Lassen Sie uns nun die erste Berechnung durchführen. 

Zuerst tippen wir den Preis für den PC, darunter den Preis für den Monitor und 

darunter den Preis für den Drucker ein. 

Steuern Sie also die Zelle B2 an und tippen Sie den Wert 799 ein. Der Wert er-

scheint sowohl in der gewählten Zelle als auch in der Bearbeitungsleiste oberhalb 

der Tabelle.  

Hinweis: Übernehmen Sie bitte beim Eingeben von Zahlen nicht die früher ver-

breitete Angewohnheit, statt der Zahl „0“ den Buchstaben „O“ oder „o“ zu tip-

pen. PlanMaker unterscheidet nämlich penibel zwischen Zahlen und Buchstaben. 

Der Buchstabe „O“ ist für das Programm keine Zahl. PlanMaker akzeptiert Ihre 

Eingabe zwar, interpretiert sie aber als Text und kann dementsprechend keine 

Berechnungen damit anstellen. 

Drücken Sie nun die Eingabetaste (¢), um Ihre Eingabe abzuschließen. Der Zell-

rahmen wandert automatisch um eine Zeile nach unten in die Zelle B3. Tragen Sie 

hier den Wert 425 und in der Zelle darunter den Wert 199 ein. 
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Tipp: Wenn Sie einmal in eine Zelle etwas Falsches eingegeben und bereits die 

Eingabetaste (¢) gedrückt haben, ist dies nicht weiter schlimm. Steuern Sie die 

Zelle mit den Pfeiltasten an und tippen Sie den richtigen Inhalt ein. Drücken Sie 

dann wieder die Eingabetaste, und der Zellinhalt wird überschrieben. Sie können 

den Inhalt bereits ausgefüllter Zellen auch editieren: drücken Sie dazu in der Zel-

le die Taste (F2). 

Eingeben von Rechenformeln 

Nun geht es an die erste Rechenformel: 

Um die Gesamtkosten für unsere Computerausstattung auszurechnen, müssen wir 

die gerade eingetippten Einzelpreise addieren. Und das geht denkbar einfach: 

Steuern Sie die Zelle B5 an und tippen Sie erst ein Gleichheitszeichen = ein. Das 

Gleichheitszeichen ist nämlich für PlanMaker das Signal, dass Sie nun eine Formel 

in diese Zelle eingeben möchten. 

Als nächstes tippen Sie die Rechenformel ein. Dazu arbeiten Sie, wie schon ange-

deutet, mit den Adressen der Zellen als „Variablen“. Die Eingabe lautet somit: 

=B2+B3+B4 

Die Buchstaben dürfen wahlweise als Groß- oder als Kleinbuchstaben getippt wer-

den.  

Wenn Sie die Eingabetaste (¢) drücken, erscheint sofort das Ergebnis der Berech-

nung in der Zelle: 

 

Probieren Sie nun einmal aus, was geschieht, wenn Sie die Zahlen in den Zellen 

auswechseln. Steuern Sie beispielsweise die „425“ einmal an und tippen Sie „259“ 

oder einen beliebigen anderen Wert ein. Drücken Sie dann wieder die Eingabetaste 
(¢) und beobachten Sie, was passiert: Sobald Sie den Zellinhalt ersetzen, wird 

sofort das Ergebnis der Addition aktualisiert.  

Sie sehen: Egal, was in den Zellen B2, B3 und B4 steht, PlanMaker addiert es brav 

zusammen. Ändert sich bei einem Computer-Angebot also beispielsweise nur der 
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Preis für den Drucker, brauchen Sie diesen nur zu ändern und schon steht in Zelle 

B5 der neue Gesamtpreis. 

Die Funktion „SUMME“ 

Die vorgestellte Methode zum Berechnen der Summe war nun sicherlich zweck-

mäßig, aber noch nicht allzu komfortabel. Stellen Sie sich einmal vor, es wären 

nicht drei, sondern 50 Zahlen zu addieren – das gäbe eine lange Formel zu tippen! 

Zum Glück gibt es hier Alternativen: die Rechenfunktionen von PlanMaker. 

Um eine davon kennenzulernen, steuern Sie noch einmal die Zelle B5 mit der Re-

chenformel an.  

Löschen Sie erst den Inhalt, indem Sie die Taste (Entf) drücken – oder überschrei-

ben Sie den Zellinhalt einfach. Tippen Sie folgende Formel ein: 

=SUMME(B2:B4) 

Nach dem Betätigen der Eingabetaste (¢) steht das Ergebnis der Berechnung in 

der Zelle: die Summe der Zellen B2 bis B4. 

PlanMaker kennt eine ganze Reihe von Rechenfunktionen – und eine davon ist 

SUMME. Diese ermittelt, wie der Name schon sagt, die Summe von Werten. Der 

eingeklammerte Ausdruck hinter dem Funktionsnamen sagt PlanMaker, wo er mit 

dem Summieren beginnen und aufhören soll:  

Der Start soll in diesem Fall bei der Zelle B2 liegen und das Ende der zu addieren-

den Zahlenkolonne bei B4. Dazwischen liegt in diesem Fall nur die Zahl in B3, 

aber die Summenfunktion würde auch mit Angaben wie B2:B123 funktionieren. 

Die Schreibweise Startzelle:Endzelle funktioniert übrigens auch zeilen- und spal-

tenübergreifend. Wenn Sie beispielsweise als Startzelle B2 und als Endzelle C4 

eingeben, so bilden diese beiden Koordinaten in der Tabelle die Eckpunkte eines 

Rechtecks. Die Formel =SUMME(B2:C4) berechnet also die Summe aller in die-

sem Rechteck enthaltenen Zahlen. 

Formelvielfalt 

Um einen Eindruck von der Vielzahl der Rechenfunktionen zu bekommen, die in 

PlanMaker zur Verfügung stehen, können Sie nun einmal den Menübefehl Einfü-

gen > Funktion aufrufen. 

Es erscheint nun ein Dialogfenster mit einer Liste aller Rechenfunktionen, die 

PlanMaker beherrscht. 
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Tipp: Bei der Windows-Version von PlanMaker können Sie eine Hilfeseite zu 

jeder Rechenfunktion abrufen, indem Sie die gewünschte Funktion in obigem 

Dialog anklicken und dann die Taste (F1) drücken. 

Probieren wir noch ein Beispiel aus: Wir berechnen den Mittelwert unserer drei 

Zahlen in der Tabelle: 

Verlassen Sie dazu das Dialogfenster und löschen Sie noch einmal den Inhalt von 

B5.  

Rufen Sie dann den Menübefehl Einfügen > Funktion auf. Wählen Sie in der lin-

ken Liste die Kategorie „Alle Funktionen“. Durchblättern Sie dann die rechte Liste 

mit Hilfe des Rollbalkens, bis die Funktion „Mittelwert“ zu sehen ist. Klicken Sie 

dann doppelt auf „Mittelwert“.  

Im Eingabefeld des Dialogs hat PlanMaker nun automatisch die Zeile 

Mittelwert() 

eingesetzt. Um die Formel zu vervollständigen, tippen Sie wieder B2:B4 ein.  

Alternativ können Sie auch hier einfach den gewünschten Bereich direkt in der 

Tabelle mit der Maus markieren, also die Maus bei gedrückter linken Maustaste 

über die Zellen B2 bis B4 ziehen. Sie wissen ja schon, wie das geht. Falls das Dia-

logfenster im Weg sein sollte, ziehen Sie es einfach beiseite, indem Sie auf seine 

Titelleiste klicken und es dann bei gedrückter Maustaste verschieben. 

Die fertige Formel sieht schließlich wie folgt aus: 
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=Mittelwert(B2:B4) 

Klicken Sie auf Einfügen, wird diese Formel in Zelle B5 übertragen und sofort 

ausgerechnet. 

Zwei der über 330 Rechenfunktionen von PlanMaker haben Sie nun kennenge-

lernt. Eine Liste aller Funktionen mit ausführlicher Beschreibung finden Sie übri-

gens im Abschnitt „Funktionen von A-Z“, der auf Seite 522 beginnt. 

Die dritte Dimension 

Tabellen müssen nicht unbedingt aus nur einem einzigen Arbeitsblatt bestehen. Es 

ist auch möglich, mehrere Arbeitsblätter quasi hintereinander zu legen – wie bei 

einem Stapel Papier. Wir nennen ein PlanMaker-Dokument deshalb auch eine Ar-

beitsmappe. Jede Arbeitsmappe kann bis zu 256 Arbeitsblätter enthalten. 

Der Clou dabei: Berechnungen in einem Arbeitsblatt können sich auch auf Zellen 

anderer Arbeitsblätter beziehen, was Ihnen ermöglicht quasi „dreidimensionale“ 

Berechnungen durchzuführen. 

Ein Beispiel: Sie erfassen auf drei Arbeitsblättern die Bilanzen mehrerer Filialen 

Ihrer Firma. Nun könnten Sie ein viertes Arbeitsblatt anlegen und darauf bei-

spielsweise die Summe der Ergebnisse auf den drei anderen Blättern berechnen. 

Wenn Sie ein neues Arbeitsblatt anlegen möchten, rufen Sie den Menübefehl Ar-

beitsblatt > Blatt > Einfügen auf. Um zwischen den vorhandenen Blättern zu 

wechseln, können Sie das Arbeitsblattregister am unteren Fensterrand verwenden.  

 

Klicken Sie das gewünschte Arbeitsblatt dort einfach mit der Maus an.  

Weitere Informationen zu diesem Thema finden Sie im Abschnitt „Arbeiten mit 

mehreren Arbeitsblättern“ ab Seite 93. 

Tabellen gestalten 

Kehren wir noch einmal zu unserer ersten Beispieltabelle zurück. Gut rechnen ließ 

es sich mit ihr, aber von der Gestaltung her sieht sie bislang nicht gerade anspre-

chend aus. Dabei verfügt PlanMaker doch über äußerst leistungsfähige Möglich-

keiten zur optischen Aufbereitung von Tabellen.  
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Probieren wir einige davon einmal aus: 

Überschrift hinzufügen 

Was unserer Tabelle auf jeden Fall fehlt, ist eine Überschrift. Tragen wir also ein-

fach in eine Zelle oberhalb der Zahlen einen entsprechenden Text ein und formatie-

ren diesen in einer größeren Schrift. 

Setzen Sie den Zellrahmen dazu auf die Zelle B1. Tippen Sie dann zum Beispiel 

folgenden Text: 

Meine erste Tabelle(¢) 

Zeichenformatierung ändern 

Jetzt sollten wir vielleicht noch eine andere Schrift für die Überschrift wählen und 

sie vor allem deutlich größer machen. 

Bewegen Sie den Zellrahmen dazu wieder in die Zelle B1 mit der Überschrift zu-

rück. Klappen Sie dann die Schriftenliste in der Formatleiste auf, indem Sie das 

kleine Pfeilchen rechts neben dem Schriftnamen anklicken.  

 

Es erscheint eine Liste aller auf Ihrem Rechner installierten Schriften. Wählen Sie 

beispielsweise die Schriftart „Tahoma“. Öffnen Sie dann die Liste mit den Schrift-

größen rechts daneben und wählen Sie die Größe 24 Punkt.  
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Rechts daneben könnten Sie auf Wunsch noch die Schriftfarbe einstellen, und noch 

ein Stück weiter rechts finden Sie drei mit F, K und U beschriftete Schaltflächen 

zum Ein-/Ausschalten von Fettdruck, Kursivschrift und Unterstreichen. 

Zahlenformatierung ändern 

In einer Tabellenkalkulation finden Sie natürlich auch umfangreiche Möglichkeiten 

zum Formatieren von Zahlen. Sie können nicht nur Zeichenformat von Zellinhalten 

ändern (Schriftart, Schriftgröße etc.), sondern auch deren Zahlenformat. 

Probieren Sie es aus: In den Zellen B2 bis B5 stehen Geldbeträge – also sollen die-

se auch wie Geldbeträge angezeigt werden. Dies erreichen Sie folgendermaßen: 

Markieren Sie zunächst die Zellen B2 bis B5. Klicken Sie dazu einfach die Zelle 

B2 an und ziehen Sie den Mauszeiger dann – mit weiterhin gedrückter Maustaste – 

zur Zelle B5.  

Android: Falls Sie die Android-Version verwenden, beachten Sie bitte, dass das 

Markieren von Zellen dort etwas anders funktioniert. Siehe Abschnitt 

„Markieren von Zellen und Zellinhalten“ ab Seite 71. 

Wenn die gewünschten Zellen markiert sind, rufen Sie den Menübefehl Format > 

Zelle auf. Es erscheint ein Dialog mit zahlreichen Einstellungsmöglichkeiten. Uns 

interessiert aber nur die erste Karteikarte: die Karteikarte Zahlenformat. Wählen 

Sie darin in der Liste den Eintrag „Währung“ und bestätigen Sie mit OK.  

Das Ergebnis: PlanMaker versieht die Zahlen in den markierten Zellen nun mit 

einem Währungssymbol und zeigt sie mit zwei Nachkommastellen an, wie das bei 

Geldbeträgen üblich ist. 

Es gibt viele weitere Einstellungen zum Zahlenformat, mit denen Sie das Erschei-

nungsbild von Zahlen ändern können. So lässt sich beispielsweise die Anzahl der 

angezeigten Nachkommastellen einstellen, Zahlen können als Prozentwerte darge-

stellt werden etc. Wichtig: Die Zahl in der entsprechenden Zelle bleibt dabei stets 

unverändert – es ändert sich lediglich ihre Darstellung. 

Einen kleinen Teil der Funktionen zum Gestalten von Tabellen haben Sie jetzt ken-

nengelernt. Wie Sie sich denken können, gibt es noch viele weitere Möglichkeiten, 

Tabellen optisch aufzuwerten und übersichtlicher zu machen. Alle Informationen 

dazu finden Sie im Kapitel „Gestalten einer Tabelle“, das auf Seite 163 beginnt.  
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Diagramme 

Werfen wir zum Schluss unserer kleinen PlanMaker-Tour noch einen Blick auf 

Diagramme. 

Zahlenkolonnen machen es einem oft schwer, ihre wirkliche Bedeutung zu erken-

nen. PlanMaker hat deshalb zur optischen Aufbereitung der Daten aus Ihren Tabel-

len ein eigenes Diagramm-Modul aufzuweisen. 

Um ein Diagramm einzufügen, markieren Sie die darzustellenden Werte und rufen 

den Menübefehl Objekt > Neuer Diagrammrahmen auf. Es erscheint ein Dialog, 

in dem Sie nur noch den gewünschten Diagrammtyp auswählen müssen – und 

schon erscheint das fertige Diagramm im Dokument. 

 

Weitere Informationen zu diesem Thema finden Sie im Kapitel „Diagramme“ ab 

Seite 295. 
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Ausblick 

Hier endet unsere kleine Einführung in PlanMaker. Die grundlegendsten Funktio-

nen haben Sie jetzt kennengelernt, alles Weitere erfahren Sie im Referenzteil des 

Handbuchs, der mit dem nächsten Kapitel beginnt.  

Der Referenzteil ist nach Sachgebieten aufgeteilt und beschreibt ausführlich alle 

Funktionen von PlanMaker. Sie müssen diesen natürlich nicht Kapitel für Kapitel 

durchlesen, um gleich alle Funktionen von PlanMaker auf einmal zu erlernen. Be-

fassen Sie sich immer nur den Kapiteln, die Sie gerade benötigen, und erkunden 

Sie so Schritt für Schritt die Funktionen von PlanMaker. 

In diesem Sinne: Viel Spaß mit PlanMaker! 
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Bearbeiten einer Tabelle 

Mit diesem Kapitel beginnt der Referenzteil des Handbuchs, der ausführliche In-

formationen zu den einzelnen Funktionen von PlanMaker enthält und nach Sach-

gebieten geordnet ist. 

In diesem ersten Kapitel erfahren Sie, wie Sie eine Tabelle ausfüllen und bearbei-

ten. Folgende Themen werden in diesem Kapitel behandelt: 

 Daten in Zellen eingeben 

 Im ersten Abschnitt wird erläutert, was es beim Ausfüllen von Tabellenzellen 

mit Text, Zahlen, Berechnungen etc. zu beachten gibt. 

 Änderungen rückgängig machen 

 Über den Menübefehl Bearbeiten > Rückgängig kann man Operationen wie-

der ungeschehen machen. Der Befehl Bearbeiten > Wiederherstellen ist das 

Gegenstück dazu – er macht quasi den Befehl Rückgängig wieder rückgängig. 

 Befehle wiederholen 

 Der Menübefehl Bearbeiten > Wiederholen wiederholt die Ausführung des 

zuletzt aufgerufenen Befehls mit genau den gleichen Einstellungen. 

 Markieren von Zellen und Zellinhalten 

 Hier erfahren Sie, wie man Zellen markiert – zum Beispiel durch Überstreichen 

der Zellen mit gedrückter Maustaste oder per Tastatur. 

 Löschen von Zellen und Zellinhalten 

 Sie können wahlweise mit dem Menübefehl Bearbeiten > Löschen nur die 

Zellinhalte löschen oder mit Arbeitsblatt > Zellen löschen die kompletten Zel-

len aus der Tabelle entfernen (der Rest der Tabelle rückt dann entsprechend 

nach). 

 Einfügen von neuen Zellen 

 Der Menübefehl Arbeitsblatt > Zellen einfügen fügt neue Zellen in die Tabel-

le ein, wobei der Rest der Tabelle automatisch verschoben wird. 

 Verschieben und Kopieren 

 Markierte Tabellenbereiche können mit den Befehlen des Menüs Bearbeiten 

oder einfach per Maus kopiert oder verschoben werden. Rechenformeln werden 

dabei automatisch angepasst. 
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 Selektives Einfügen 

 Der Menübefehl Bearbeiten > Inhalte einfügen ist eine leistungsfähigere Va-

riante des Befehls Einfügen. Sie können damit beim Einfügen der Zwischenab-

lage bestimmen, dass beispielsweise nur die nackten Zellinhalte oder nur deren 

Formatierung eingefügt werden soll. 

 Automatisches Füllen von Zellen 

 Mit dem Menübefehl Bearbeiten > Ausfüllen können Sie Zellen bequem mit 

gleichbleibenden Werten oder Wertereihen füllen. 

 Arbeiten mit mehreren Arbeitsblättern 

 Sie können in PlanMaker mehrere Arbeitsblätter – wie bei einem Stapel Papier 

– hintereinander anlegen und damit „dreidimensional“ rechnen. 

 Bereiche benennen 

 Wenn Sie Zellbereichen mit dem Menübefehl Arbeitsblatt > Namen einen 

Namen geben, können Sie diese Namen in Berechnungen verwenden – zum 

Beispiel =SUMME(Umsätze). 

 Sortieren 

 Mit dem Menübefehl Arbeitsblatt > Sortieren können Sie Tabellenzellen nach 

einem oder mehreren Kriterien sortieren lassen. 

 Transponieren 

FreeOffice: Die Funktion Transponieren ist in SoftMaker FreeOffice nicht 

enthalten. 

 Der Menübefehl Arbeitsblatt > Transponieren vertauscht die zeilen-

/spaltenweise Anordnung eines Zellbereichs. 

 Text in Spalten aufteilen 

FreeOffice: Die Funktion Text in Spalten aufteilen ist in SoftMaker Free-

Office nicht enthalten. 

 Mit dem Menübefehl Arbeitsblatt > Text in Spalten aufteilen können Sie 

Text, der sich in einer Tabellenzelle befindet, auf mehrere Tabellenspalten auf-

teilen. 
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 Filtern 

 Mit dem Menübefehl Arbeitsblatt > Filter lässt sich ein Zellbereich nach ei-

nem oder mehreren Kriterien filtern. Es werden dann alle Zeilen in diesem Be-

reich, die den Filterbedingungen nicht entsprechen, verborgen. 

 Analysieren von Tabellen 

 Dieser Abschnitt stellt einige Werkzeuge vor, die für die Analyse von Tabellen 

und die Fehlersuche sehr nützlich sein können. Dazu gehören die Formelanzei-

ge, die Syntaxhervorhebung, das Beobachtungsfenster für Zellinhalte sowie 

verschiedene Funktionen zum Analysieren der Rechenformeln in einer Tabelle. 

 Aktualisieren von Tabellen 

 Die Berechnungen in einer Tabelle werden automatisch auf dem neuesten Stand 

gehalten. Jedes Mal, wenn Sie einen Zellinhalt abändern, rechnet PlanMaker 

die gesamte Tabelle neu durch. Bei Bedarf können Sie dieses Verhalten ab-

schalten und den Menübefehl Weiteres > Neu berechnen verwenden, um die 

Tabelle manuell zu aktualisieren. 

 Kommentare einfügen 

 Mit dem Menübefehl Einfügen > Kommentar können Sie Zellen mit einem 

Kommentar versehen. Dieser wird angezeigt, wenn Sie mit der Maus auf die 

Zelle zeigen. 

 Zielwertsuche 

 Mit dem Menübefehl Weiteres > Zielwertsuche können Sie durch ein Nähe-

rungsverfahren ermitteln, welchen Wert ein bestimmter Bestandteil einer Be-

rechnung annehmen muss, damit das gewünschte Ergebnis herauskommt. 

 Szenarien 

FreeOffice: Die Funktion Szenarien ist in SoftMaker FreeOffice nicht ent-

halten. 

 Der Menübefehl Weiteres > Szenarien erlaubt das Anlegen und Anzeigen ver-

schiedener Szenarien. Mit deren Hilfe können Sie beobachten, welche Auswir-

kungen das Ändern der Werte in bestimmten Zellen auf die Berechnungen in 

einem Arbeitsblatt hat. Dies ermöglicht das Durchführen von „Was-wäre-

wenn“-Analysen aller Art. 
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 Konsolidieren von Daten 

FreeOffice: Die Funktion Daten konsolidieren ist in SoftMaker FreeOffice 

nicht enthalten. 

 Mit dem Menübefehl Arbeitsblatt > Daten konsolidieren lassen sich Daten 

aus einem oder mehreren Zellbereichen auswerten, um beispielsweise die 

Summe der einzelnen Daten über all diese Bereiche hinweg zu ermitteln. 

 Tabellen in Tabellen 

FreeOffice: Das Anlegen von Tabellen in Tabellen ist in SoftMaker Free-

Office nicht enthalten. 

 Sie können einen Zellbereich markieren und daraus dann mit dem Menübefehl 

Arbeitsblatt > Neue Tabelle eine „Tabelle in der Tabelle“ erstellen.  

 Dies hat u.a. folgende Auswirkungen:  

 Der Bereich wird mit einer sogenannten Tabellenvorlage formatiert. Sie können 

diese jederzeit wechseln, und damit das Aussehen des kompletten Zellbereichs 

auf einmal zu verändern. Außerdem wird die „Tabelle“ automatisch mit einem 

Autofilter versehen. Darüber stehen weitere nützliche Features wie eine Ergeb-

niszeile mit zusammenfassenden Berechnungen zur Verfügung. 

 Fixieren von Zeilen und Spalten 

 Mit dem Menübefehl Ansicht > Fixieren können Sie die ersten Zeilen oder 

Spalten einer Tabelle auf dem Bildschirm fixieren. Das bewirkt, dass sich diese 

beim Blättern in der Tabelle nicht mehr bewegen. Ideal für Spalten- oder Zei-

lenbeschriftungen. 

 Sonderzeichen einfügen 

 Der Menübefehl Einfügen > Sonderzeichen öffnet ein Dialogfenster mit allen 

verfügbaren Zeichen einer Schrift. Mit dessen Hilfe können Sie Zeichen einfü-

gen, die per Tastatur nicht erreichbar sind. 

Ausführliche Informationen zu diesen Themen finden Sie, in obiger Reihenfolge, 

auf den nächsten Seiten. 
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Daten in Zellen eingeben 

Um in eine Zelle etwas einzugeben, steuern Sie die gewünschte Zelle mit den 

Richtungstasten oder per Mausklick an und beginnen einfach mit dem Tippen. 

Um Ihre Eingabe abzuschließen, drücken Sie die Eingabetaste (¢).  

Wenn Sie einen Eingabefehler gemacht haben, ist dies kein Problem: Drücken Sie 

statt der Eingabetaste (¢) die Taste (Esc), vergisst PlanMaker, was Sie getippt ha-

ben, und stellt den alten Zellinhalt wieder her. 

Alternativ können Sie Eingaben auch über die folgenden Schaltflächen der Bear-

beitungsleiste abschließen: 

 Klicken Sie auf , um die Eingabe zu übernehmen. 

 Oder klicken Sie auf , um die Eingabe zu verwerfen. 

Um den Inhalt einer bereits ausgefüllten Zelle nachträglich zu bearbeiten, steuern 

Sie die Zelle an und betätigen die Taste (F2). Alternativ können Sie auch einen 

Doppelklick auf die Zelle ausführen. 

Anmerkungen zum Eingeben von Zahlen: 

 Zahlen können auch in wissenschaftlicher Schreibweise (Exponentialschreib-

weise) eingegeben werden. 4E03 entspricht beispielsweise 4 * 10^3, also 4000. 

Anderes Beispiel: 4E-03 entspricht 4* 10^-3, also 0,004. 

 Zahlen können auch als Brüche eingegeben werden. 2 1/2 entspricht beispiels-

weise 2,5. 

 Zahlen können auch als Prozentwerte eingegeben werden. 70% entspricht bei-

spielsweise 0,7. 

Mit dem Menübefehl Format > Zelle können Sie das Format von Zahlen in Tabel-

lenzellen jederzeit ändern. Sie können PlanMaker also beispielsweise veranlassen, 

Zahlen als Prozentwerte oder als Währung mit einem Währungssymbol anzuzei-

gen. Siehe dazu Abschnitt „Zahlenformat“ ab Seite 168. 

Anmerkungen zum Eingeben von Daten und Uhrzeiten: 

 Daten können in beliebiger Schreibweise eingetragen werden – also zum Bei-

spiel 25.09.18 oder 25.9.2018 etc. 
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 Sie können Daten zwischen dem 1.1.1900 und dem 31.12.2500 eingeben. 

 Wenn Sie ein Datum lediglich mit zweistelliger Jahreszahl eingeben, wird die-

ses wie folgt interpretiert: 

 Jahreszahl zwischen 0 und 29: 2000 bis 2029. 

 Jahreszahl zwischen 30 und 99: 1930 bis 1999. 

 Der 1.1.29 ist für PlanMaker also der 1.1.2029, der 1.1.30 hingegen der 

1.1.1930. 

 Uhrzeiten lassen sich in einem (nahezu) beliebigen Format eingeben. Die Uhr-

zeit 9:30 kann also beispielsweise eingetragen werden als: 

 9:30 

 09:30 

 09:30:00 

 09:30:00 AM  

 etc.  

 Sie können in eine Zelle auch eine Kombination aus Datum und Uhrzeit einge-

ben, indem Sie das Datum, ein Leerzeichen und dann die Uhrzeit eintragen. Bei 

der Eingabe 25.9.18 6:00 weiß PlanMaker beispielsweise, dass damit der 25. 

September 2018 um 6:00 Uhr gemeint ist. 

Anmerkung: Daten und Uhrzeiten werden in Tabellenkalkulationen stets als Zahl 

gespeichert, damit Berechnungen mit ihnen durchgeführt werden können. Die Zahl 

0 steht für den 1.1.1900, die Zahl 1 für den 2.1.1900 etc. Die Uhrzeit wird in den 

Nachkommastellen der Zahl gespeichert. 

Darum brauchen Sie sich aber nicht zu kümmern. Geben Sie Daten und Uhrzeiten 

einfach in beliebiger Schreibweise ein. PlanMaker wandelt Ihre Eingabe unbe-

merkt in eine Zahl um, formatiert diese aber automatisch als Datum beziehungs-

weise Uhrzeit. Wie Sie das Format von Daten und Uhrzeiten ändern, können Sie 

bei Bedarf im Abschnitt „Zahlenformat“ ab Seite 168 nachlesen. 

Anmerkungen zum Eingeben von Wahrheitswerten: 

 Um in eine Zelle einen Wahrheitswert einzugeben, tragen Sie dort entweder 

WAHR oder FALSCH ein. 
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Anmerkungen zum Eingeben von Berechnungen: 

 Rechenformeln müssen stets mit dem Gleichheitszeichen = beginnen – zum 

Beispiel =2+5. 

 Über den Menübefehl Einfügen > Funktion lassen sich komfortabel Rechen-

funktionen einfügen. Sie können diese aber auch einfach eintippen – zum Bei-

spiel =SUMME(2; 5). 

 Ausführliche Informationen zum Durchführen von Berechnungen finden Sie im 

Kapitel „Formeln und Funktionen“ ab Seite 503. 

 Eine Beschreibung aller Rechenfunktionen finden Sie im Abschnitt 

„Funktionen von A-Z“ ab Seite 522. 

Anmerkungen zum Eingeben von Text: 

 Text kann einfach eingetippt werden.  

 In bestimmten Situationen möchte man PlanMaker „zwingen“, eine Zahl als 

Text anzusehen. Dies können Sie erreichen, indem Sie der Zahl ein einfaches 

Anführungszeichen voranstellen. Tippen Sie in eine Zelle also beispielsweise 

'42 ein (inklusive des Anführungszeichens), betrachtet PlanMaker diese Einga-

be als Text – nicht als Zahl. 

 Tipp: Wenn Sie in einer Spalte einige Texteinträge direkt untereinander einge-

geben haben, können Sie jederzeit eine Auswahlliste mit diesen Einträgen auf-

rufen. Betätigen Sie dazu in der Zelle unter dem letzten (oder über dem ersten) 

Eintrag die Tastenkombination (Alt)(ª)(¼).  

 Es erscheint daraufhin eine Liste aller Zellinhalte direkt oberhalb oder unter-

halb dieser Zelle. Wenn Sie einen der Einträge auswählen und mit der Eingabe-

taste (¢) bestätigen, wird dieser in die Zelle übernommen. Dies spart Ihnen 

viel Tipparbeit bei häufig wiederkehrenden Texteinträgen. 

 Hinweis: Dies funktioniert nur mit Texteinträgen – nicht mit Zahlen, Datums-

angaben oder Formeln. 

 Ein weiterer Tipp: Darüber hinaus macht PlanMaker beim Eintippen von Text 

in eine Zelle automatisch Vorschläge aus den Texteinträgen in den Zellen ober-

halb und unterhalb dieser Zelle.  

 Ein Beispiel: Sie haben in drei Tabellenzellen untereinander „New York“, „Rio“ 

und „Tokyo“ eingetragen. Wenn Sie nun in der Zelle unterhalb dieser Einträge 

ein „N“ eintippen, schlägt das Programm automatisch „New York“ vor. Tippen 

Sie hingegen ein „T“ ein, wird „Tokyo“ vorgeschlagen etc. 
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 Um den Vorschlag zu übernehmen, drücken Sie die Eingabetaste (¢). Um ihn 

abzulehnen, tippen Sie einfach weiter oder drücken Sie die Taste (Entf). 

 Hinweis: Falls Sie nicht möchten, dass PlanMaker beim Tippen solche Vor-

schläge macht, können Sie diese Funktion jederzeit deaktivieren. Rufen Sie da-

zu den Menübefehl Weiteres > Einstellungen und schalten Sie auf der Kartei-

karte Bearbeiten die Option Zellen automatisch vervollständigen aus. 

Änderungen rückgängig machen 

Mit dem Menübefehl Bearbeiten > Rückgängig können Sie die zuletzt an einem 

Dokument durchgeführten Änderungen widerrufen. Formatieren Sie beispielsweise 

Zellen in einer anderen Schrift, brauchen Sie nur Bearbeiten > Rückgängig aufzu-

rufen, und schon wird diese Änderung wieder aufgehoben.  

Dies funktioniert nicht nur bei Formatierungen, sondern bei praktisch allen Ände-

rungen – so können Sie beispielsweise auch das Eintippen oder Löschen von Text 

rückgängig machen.  

Der Befehl Rückgängig lässt sich bei Bedarf mehrmals hintereinander anwenden. 

Rufen Sie ihn zum Beispiel fünfmal auf, werden die letzten fünf Änderungen wi-

derrufen. 

Wiederherstellen von widerrufenen Aktionen 

Es gibt auch ein Gegenstück zum Befehl Rückgängig: den Menübefehl Bearbei-

ten > Wiederherstellen. Er stellt die zuletzt von Ihnen widerrufene Aktion wieder 

her. So können Sie also das Widerrufen von Änderungen widerrufen. 

Auch dieser Befehl lässt sich mehrmals hintereinander aufrufen. Rufen Sie also 

beispielsweise fünfmal den Befehl Rückgängig auf, werden die letzten fünf Ände-

rungen widerrufen. Rufen Sie anschließend fünfmal den Befehl Wiederherstellen 

auf, erhalten Sie wieder den Ausgangszustand. 
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Befehle wiederholen 

Der Menübefehl Bearbeiten > Wiederholen wiederholt die Ausführung des zu-

letzt aufgerufenen Befehls mit genau den gleichen Einstellungen. 

Dies ist insbesondere beim Anbringen von Formatierungen praktisch. Wenn Sie 

beispielsweise eine Zelle über den Menübefehl Format > Zeichen mit einer ande-

ren Schrift versehen haben, können Sie anschließend weitere Zellen ansteuern und 

dort einfach den Menübefehl Bearbeiten > Wiederholen aufrufen. Diese Zellen 

werden dann in der gleichen Schrift formatiert – als ob Sie den letzten Befehl noch 

einmal aufgerufen und erneut die gleichen Einstellungen vorgenommen hätten. 

Auch viele andere Befehle lassen sich auf diese Weise beliebig oft wiederholen. 

Markieren von Zellen und Zellinhalten 

Bei manchen PlanMaker-Befehlen können Sie vor deren Ausführung erst Zellen 

markieren. Der Befehl wird dann auf alle Zellen innerhalb der Markierung ange-

wandt.  

Wenn Sie beispielweise einige Zellen markieren und dann den Menübefehl Bear-

beiten > Löschen aufrufen, werden alle markierten Zellen auf einmal gelöscht. 

 

Bei gedrückter Strg-Taste können auch unzusammenhängende Bereiche markiert werden. 
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Je nachdem, unter welchem Betriebssystem Sie das Programm einsetzen, unter-

scheidet sich die Vorgehensweise zum Markieren etwas. Deshalb enthält dieser 

Abschnitt folgende zwei Teile: 

 Markieren in der Windows-, Mac- oder Linux-Version 

 Markieren in der Android-Version 

Markieren in der Windows-, Mac- oder Linux-Version 

In der Windows-, Mac- oder der Linux-Version von PlanMaker können Sie Zellen 

und Zellinhalte folgendermaßen markieren: 

Markieren mit der Maus 

Um etwas mit der Maus zu markieren, gehen Sie wie folgt vor: 

 Markieren beliebiger Zellbereiche 

 Zellbereiche beliebigen Umfangs können durch Überstreichen der gewünschten 

Zellen bei gedrückter linker Maustaste markiert werden. 

 Markieren kompletter Zeilen und Spalten 

 Eine komplette Spalte wird markiert, wenn Sie den dazugehörigen Spaltenkopf 

anklicken. Die Spaltenköpfe sind die Schaltflächen oberhalb der Tabelle (be-

schriftet mit A, B, C usw.).  

 Weiterhin gibt es für jede Zeile einen Zeilenkopf (links der Tabelle, beschriftet 

mit 1, 2, 3 etc.). Klicken Sie diesen an, wird die komplette Zeile markiert.  

 Ziehen Sie den Mauszeiger bei gedrückter Maustaste über mehrere Spalten- 

oder Zeilenköpfe, können Sie mehrere Spalten beziehungsweise Zeilen auf 

einmal markieren. 

 Markieren der gesamten Tabelle 

 Eine besondere Funktion hat die Schaltfläche links oben im Tabellenfenster 

(oberhalb von 1 und links von A): Ein Klick darauf markiert die gesamte Tabel-

le. 

 Alternativ können Sie dies auch mit dem Menübefehl Bearbeiten > Alles 

markieren erreichen. 
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 Markieren einer einzelnen Zelle 

 Um eine einzelne Zeile zu markieren, klicken Sie diese an und führen dann den 

Mauszeiger bei weiterhin gedrückter Maustaste auf eine Nachbarzelle und wie-

der zurück.  

 Markieren unzusammenhängender Bereiche 

 Sie können auch unzusammenhängende Bereiche markieren. Halten Sie dazu 

die Taste (Strg) gedrückt und markieren Sie dann die gewünschten Bereiche. 

 Markieren nur eines Teils des Zellinhalts 

 Um nur einen Teil des Inhalts einer Zelle zu markieren, gehen Sie wie folgt vor: 

 Klicken Sie zunächst doppelt auf die Zelle, um ihren Inhalt bearbeiten zu kön-

nen. Dann streichen Sie bei gedrückter linker Maustaste mit der Maus über den 

Teil des Zellinhalts, den Sie markieren möchten. 

 Markieren von Objekten 

 Um ein Objekt (zum Beispiel eine Grafik oder Zeichnung) zu markieren, kli-

cken Sie dieses mit der Maus an. Es erscheint dann ein Rahmen um das Objekt, 

um anzuzeigen, dass es nun markiert ist. 

Markieren mit der Tastatur 

Alternativ können Sie zum Markieren auch die Tastatur verwenden. Gehen Sie 

dabei wie folgt vor: 

 Markieren beliebiger Zellbereiche 

 Um einen Bereich von Zellen zu markieren, halten Sie die Umschalttaste (ª) 

gedrückt und betätigen dann beliebige Richtungstasten. 

 Wenn Sie beispielsweise die Zelle B5 ansteuern und dann bei gedrückter Um-

schalttaste fünfmal die Pfeiltaste (¼) drücken, werden die Zellen B5 bis B10 

markiert. Eine Liste aller Tastenkombinationen zum Bewegen und Markieren in 

einer Tabelle finden Sie im Abschnitt „Tastenbelegung“ (ab Seite 840). 

 Markieren einer einzelnen Zelle 

 Eine einzelne Zelle markieren Sie, indem Sie die Zelle ansteuern, dann bei ge-

drückter Umschalttaste eine benachbarte Zelle markieren und schließlich wie-

der in die Ausgangszelle zurückkehren.  
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 Drücken Sie also beispielsweise von der zu markierenden Zelle aus bei ge-

drückter Umschalttaste (ª) erst die Taste (Æ) und dann die Taste (æ). 

 Markieren unzusammenhängender Bereiche 

 Unzusammenhängende Bereiche können nur mit der Maus markiert werden 

(siehe oben). 

 Markieren nur eines Teils des Zellinhalts 

 Um nur einen Teil des Inhalts einer Zelle zu markieren, gehen Sie wie folgt vor: 

 Steuern Sie die Zelle an und betätigen Sie die Taste (F2), um ihren Inhalt bear-

beiten zu können. Dann verwenden Sie wie gewohnt die Richtungstasten mit 

gleichzeitig gedrückter Umschalttaste (ª), um Text zu markieren. 

 Markieren von Objekten 

Objekte können nur mit der Maus markiert werden (siehe oben). 

Markieren in der Android-Version 

Auf Android-Geräten funktioniert das Markieren teilweise etwas anders. Sie kön-

nen dabei wahlweise den Finger oder eine Maus verwenden. Gehen Sie wie folgt 

vor: 

 Markieren von Zellen 

 Tabellenzellen können unter Android wie folgt selektiert werden:  

 Tippen Sie ein Mal auf die gewünschte Startzelle. (Die Schreibmarke darf jetzt 

nicht darin blinken.) 

 Nach einer kurzen Pause tippen Sie erneut auf diese Zelle, halten den Finger 

weiterhin gedrückt, und ziehen den Finger dann zur gewünschten Endzelle. 

 Markieren nur eines Teils des Zellinhalts 

 Um nur einen Teil des Inhalts einer Zelle zu markieren, gehen Sie wie folgt vor: 

 Tippen Sie zunächst doppelt auf die Zelle, um ihren Inhalt bearbeiten zu kön-

nen. Dann tippen Sie doppelt auf dasjenige Wort in der Zelle, mit dem die Mar-

kierung beginnen soll. Das Wort sollte nun markiert sein. Sie erkennen das da-

ran, dass große „Greifer“ davor und dahinter erscheinen: 
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 Diese Greifer stehen für den Anfang und das Ende der Markierung. Um die 

Markierung auf weiteren Text auszuweiten, ziehen Sie die beiden Greifer ein-

fach an die gewünschten Positionen. 

 Markieren von Objekten 

 Um ein Objekt (zum Beispiel eine Grafik oder Zeichnung) zu markieren, tippen 

Sie einfach darauf. Es erscheint dann ein Rahmen um das Objekt, um anzuzei-

gen, dass es nun markiert ist. 

Löschen von Zellen und Zellinhalten 

Wenn Sie etwas aus einer Tabelle herauslöschen möchten, sollten Sie beachten, 

dass es hierfür zwei unterschiedliche Methoden gibt: 

 Löschen von Zellinhalten 

 Wenn Sie den Menübefehl Bearbeiten > Löschen verwenden, werden nur die 

Inhalte der markierten Zellen gelöscht.  

 Löschen kompletter Zellen 

 Wenn Sie hingegen den Menübefehl Arbeitsblatt > Zellen löschen verwenden, 

werden die markierten Zellen komplett aus der Tabelle gelöscht. Die anderen 

Zellen der Tabelle rücken entsprechend nach. 

Darüber hinaus gibt es Befehle speziell zum Löschen von leeren Zeilen und dop-

pelt vorkommenden Zeilen: 

 Löschen leerer Zeilen 

FreeOffice: Der Menübefehl Entfernen leerer Zeilen ist in SoftMaker Free-

Office nicht enthalten. 

 Um alle leeren Zeilen innerhalb eines bestimmten Bereichs von Zeilen zu lö-

schen, markieren Sie diese Zeilen und rufen dann den Menübefehl Arbeitsblatt 

> Entfernen > Leere Zeilen auf. 
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 Löschen doppelt vorkommender Zeilen 

FreeOffice: Der Menübefehl Entfernen doppelter Zeilen ist in SoftMaker 

FreeOffice nicht enthalten. 

 Um alle doppelt vorkommenden Zeilen innerhalb eines bestimmten Bereichs 

von Zeilen zu löschen, markieren Sie diese Zeilen und rufen dann den Menübe-

fehl Arbeitsblatt > Entfernen > Doppelte Zeilen auf. 

Ausführlichere Informationen folgen auf den nächsten Seiten. 

Löschen von Zellinhalten 

Um die Inhalte von Zellen zu löschen, gehen Sie wie folgt vor: 

1. Markieren Sie die gewünschten Zellen. 

 (Auf welche Arten man Zellen markieren kann, beschreibt der Abschnitt 

„Markieren von Zellen und Zellinhalten“, Seite 71.) 

2. Rufen Sie den Menübefehl Bearbeiten > Löschen auf – oder drücken Sie ein-

fach das Tastenkürzel für diesen Befehl: die Taste (Entf).. 

Es werden dabei nur die Inhalte der Zellen entfernt, nicht die Zellen selbst (siehe 

nächster Abschnitt). 

Eingrenzen, was gelöscht werden soll 

Wenn Sie statt des Menübefehls Bearbeiten > Löschen den Befehl Bearbeiten > 

Selektiv löschen benutzen, können Sie eingrenzen, was genau gelöscht werden 

soll. 

Es erscheint dazu ein Untermenü mit folgenden Optionen: 

 Alles 

 Löscht alles – sowohl Zellinhalte als auch Formatierung, Kommentare, beding-

te Formatierungen und Gültigkeitsprüfung der markierten Zellen. 

 Formate 

 Löscht nur die Formatierung (Zahlenformat, Zeichenformat, Hintergrund, Um-

randung usw.) der markierten Zellen. 
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 Inhalte 

 Löscht nur die Inhalte der markierten Zellen. Alles andere (Formatierung etc., 

Kommentare etc.) bleibt erhalten. 

 Kommentare 

 Löscht weder Inhalt noch Formatierung der markierten Zellen, sondern entfernt 

nur die Kommentare, die an diesen Zellen angebracht wurden (siehe Abschnitt 

„Kommentare einfügen“ ab Seite 126). 

 Bedingte Formatierung 

 Entfernt alle bedingten Formatierungen von den markierten Zellen (siehe auch 

Abschnitt „Bedingte Formatierung“ ab Seite 211). 

 Gültigkeitsprüfung 

 Entfernt alle Gültigkeitsprüfungen von den markierten Zellen (siehe auch Ab-

schnitt „Gültigkeitsprüfung“ ab Seite 221). 

Löschen kompletter Zellen 

Der Menübefehl Arbeitsblatt > Zellen löschen löscht nicht nur den Inhalt von 

Zellen, sondern entfernt die Zellen komplett aus der Tabelle.  

Dazu erscheint ein Dialogfenster, in dem Sie bestimmen können, wie die anderen 

Tabellenzellen nach dem Löschvorgang nachrücken sollen. 

 

Folgende Optionen stehen zur Wahl: 

 Zellen nach oben verschieben 

 Wählen Sie diese Option, wird der markierte Bereich gelöscht und die Zellen, 

die sich darunter befinden, rücken nach oben nach. 
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 Zellen nach links verschieben 

 Wählen Sie diese Option, wird der markierte Bereich gelöscht und die Zellen, 

die sich rechts davon befinden, rücken nach links nach. 

 Ganze Zeilen löschen 

 Hier werden nicht nur die markierten Zellen, sondern die kompletten Zeilen 

innerhalb des markierten Bereichs gelöscht. Die Zeilen darunter rücken ent-

sprechend nach oben nach. 

 Ganze Spalten löschen 

 Hier werden nicht nur die markierten Zellen, sondern die kompletten Spalten 

innerhalb des markierten Bereichs gelöscht. Die Spalten rechts davon rücken 

entsprechend nach links nach. 

Löschen leerer Zeilen 

FreeOffice: Der Menübefehl Entfernen leerer Zeilen ist in SoftMaker Free-

Office nicht enthalten. 

Um alle leeren Zeilen innerhalb eines bestimmten Bereichs von Zeilen zu löschen, 

markieren Sie diese Zeilen und rufen den Menübefehl Arbeitsblatt > Entfernen > 

Leere Zeilen auf.  

PlanMaker durchsucht diesen Bereich dann nach leeren Zeilen (also Zeilen, in de-

nen keine einzige Zelle ausgefüllt ist). Alle entsprechenden Zeilen werden ge-

löscht. 

Anmerkung 

Normalerweise markiert man vor der Anwendung dieses Befehls einen Bereich aus 

kompletten Zeilen. Sie können allerdings auch einen Zellbereich markieren, der 

nicht aus kompletten Zeilen besteht. PlanMaker fragt dann nach, ob die gefunde-

nen Zeilen komplett gelöscht werden sollen oder nicht: 

 Antworten Sie mit Ja, wird bei allen Fundstellen die komplette Zeile gelöscht. 

 Antworten Sie mit Nein, werden nur die Zellen innerhalb der Markierung ge-

löscht. Die Zellen links und rechts der Markierung bleiben erhalten. 
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Löschen doppelt vorkommender Zeilen 

FreeOffice: Der Menübefehl Entfernen doppelter Zeilen ist in SoftMaker 

FreeOffice nicht enthalten. 

Um alle doppelt vorkommenden Zeilen innerhalb eines bestimmten Bereichs von 

Zeilen zu löschen, markieren Sie diese Zeilen und rufen den Menübefehl Arbeits-

blatt > Entfernen > Doppelte Zeilen auf.  

PlanMaker durchsucht den Bereich dann nach völlig identischen Zeilen (also Zei-

len, bei denen die Inhalte aller Zellen identisch zu den entsprechenden Inhalten in 

einer anderen Zeile sind). Diese Duplikate werden dann gelöscht. 

Anmerkung 

Normalerweise markiert man vor der Anwendung dieses Befehls einen Bereich aus 

kompletten Zeilen. Sie können allerdings auch einen Zellbereich markieren, der 

nicht aus kompletten Zeilen besteht. PlanMaker fragt dann nach, ob die gefunde-

nen Zeilen komplett gelöscht werden sollen oder nicht: 

 Antworten Sie mit Ja, wird bei allen Fundstellen die komplette Zeile gelöscht. 

 Antworten Sie mit Nein, werden nur die Zellen innerhalb der Markierung ge-

löscht. Die Zellen links und rechts der Markierung bleiben erhalten. 

Einfügen von neuen Zellen 

Der Menübefehl Arbeitsblatt > Zellen einfügen fügt neue Zellen, Zeilen oder 

Spalten in die Tabelle ein.  

 

Es erscheint dazu ein Dialogfenster, in dem Sie wählen können, auf welche Weise 

die Zellen eingefügt werden sollen: 
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 Zellen nach unten verschieben 

 Es werden genau so viele Zellen eingefügt, wie beim Aufruf des Befehls mar-

kiert sind. Wurde nichts markiert, wird nur eine Zelle eingefügt.  

 Die darunter liegenden Zellen werden nach unten verschoben. 

 Zellen nach rechts verschieben 

 Es werden genau so viele Zellen eingefügt, wie beim Aufruf des Befehls mar-

kiert sind. Wurde nichts markiert, wird nur eine Zelle eingefügt.  

 Die Zellen rechts daneben werden nach rechts verschoben. 

 Ganze Zeilen einfügen 

 Es werden so viele komplette Zeilen eingefügt, wie von der Markierung umfasst 

werden. Wurde nichts markiert, wird nur eine Zeile eingefügt.  

 Die darunter liegenden Zeilen werden nach unten verschoben.  

 Ganze Spalten einfügen 

 Es werden so viele komplette Spalten eingefügt, wie von der Markierung um-

fasst werden. Wurde nichts markiert, wird nur eine Spalte eingefügt.  

 Die Spalten rechts davon werden nach rechts verschoben. 

Verschieben und Kopieren 

Alle von PlanMaker unterstützten Betriebssysteme verfügen über eine äußerst 

nützliche Einrichtung: die Zwischenablage. 

Die Zwischenablage hat folgende Aufgabe: Sie können in der Tabelle etwas mar-

kieren und dieses dann in die Zwischenablage hinein löschen oder kopieren. An-

schließend können Sie es an einer anderen Stelle der Tabelle wieder einfügen. Auf 

diese Weise lassen sich Zellen (und auch Objekte) löschen, duplizieren oder ver-

schieben.  

Alle hierzu nötigen Befehle finden Sie im Menü Bearbeiten: 
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Befehl Erläuterung 

Ausschneiden Der Menübefehl Bearbeiten > Ausschneiden löscht den Inhalt 

der Markierung – jedoch nicht für immer. Er wandert vielmehr in 

die Zwischenablage und kann von dort aus jederzeit wieder ein-

gefügt werden.  

Kopieren Der Menübefehl Bearbeiten > Kopieren kopiert den Inhalt der 

Markierung in die Zwischenablage. 

Einfügen Um den Inhalt der Zwischenablage einzufügen, verwenden Sie 

den Menübefehl Bearbeiten > Einfügen. Setzen Sie den Zell-

rahmen an die gewünschte Position und rufen Sie diesen Befehl 

dann auf. Sie können den Inhalt der Zwischenablage auch 

mehrmals einfügen. 

Dies funktioniert auf die gleiche Weise auch mit Objekten wie Grafiken, Dia-

grammen und Zeichnungen. 

Einfügen der Zwischenablage in einen markierten Bereich 

Wenn Sie Zellen in die Zwischenablage kopieren, anschließend einen Zellbereich 

in der Tabelle markieren und erst dann den Menübefehl Bearbeiten > Einfügen 

aufrufen, werden die Zellen beim Einfügen in diese Markierung eingepasst. 

Dies äußert sich folgendermaßen: 

 Ist der markierte Zellbereich kleiner als der einzufügende Zellbereich, werden 

beim Einfügen alle Zellen abgeschnitten, die nicht hineinpassen. 

 Ist der markierte Zellbereich größer, werden die Zellen so oft wiederholt, bis 

der markierte Bereich vollständig ausgefüllt ist. 

 Dabei gibt es eine Ausnahme: 

 Umfasst der markierte Bereich nur eine einzige Zeile, werden trotzdem alle 

Spalten der kopierten Zellen eingefügt. 

 Entsprechendes gilt, wenn der markierte Zellbereich nur eine Spalte umfasst. 

Verschieben und Kopieren mit der Maus („Drag and Drop“) 

Hinweis: Diese Funktion ist in der Android-Version nicht verfügbar. 
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Sie können Zellen auch verschieben oder kopieren, indem Sie diese mit der Maus 

einfach nehmen, an eine andere Stelle ziehen und dort ablegen. Mit dieser „Drag 

and Drop“ („Ziehen und Ablegen“) genannten Technik können Sie Zellinhalte be-

sonders schnell verschieben oder kopieren. 

Gehen Sie dazu folgendermaßen vor: 

1. Markieren Sie die gewünschten Zellen.  

2. Zeigen Sie mit der Maus auf diese Zellen.  

3. Drücken Sie die linke Maustaste und halten Sie diese gedrückt. 

4. Ziehen Sie die Maus bei weiterhin gedrückter Maustaste an die Zielstelle. 

5. Wenn Sie die Maustaste nun loslassen, werden die Zellen an die Zielstelle ver-

schoben. 

 Wenn Sie beim Loslassen der Maustaste die Taste (Strg) gedrückt halten, wer-

den sie hingegen dorthin kopiert. 

 Wenn Sie beim Loslassen der Maustaste die Taste (Alt) gedrückt halten, er-

scheint ein Dialog, in dem Sie wählen können, ob verschoben oder kopiert 

werden soll. Außerdem können Sie beim Kopieren festlegen, ob nur die Inhalte 

der Zellen oder auch deren Formatierungen kopiert werden sollen. 

Tipp: Das Verschieben oder Kopieren einer einzigen Zelle funktioniert auch mit 

folgender Methode: Klicken Sie die Zelle einmal an, um sie zur aktuellen Zelle zu 

machen. Dann klicken Sie die Zelle erneut an und halten die linke Maustaste ge-

drückt. Nach etwa einer Sekunde ändert sich der Mauszeiger. Nun können Sie die 

Zelle mit der Maus an eine andere Position ziehen (wie oben beschrieben). 

Formeln mit relativen Koordinaten kopieren und verschieben 

Wenn Sie Zellen, die Formeln enthalten, kopieren oder verschieben, werden auto-

matisch die Zelladressen in diesen Formeln dem neuen Ort angepasst. 

Ein Beispiel: 

Nehmen Sie an, in A7 befände sich eine Formel, die die Werte aus den vier darüber 

liegenden Zellen zusammenrechnet: 

=SUMME(A3:A6) 

Diese Formel kopieren Sie nun an Position B7. PlanMaker setzt die Formel dabei 

automatisch so um, dass sie wieder mit den vier Zellen oberhalb der Ergebniszelle 

arbeitet. Sie bekommen also in Zelle B7 folgende Formel präsentiert: 
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=SUMME(B3:B6) 

Wünschen Sie dies nicht, verwenden Sie in den Formeln nicht die übliche relative 

Zelladressierung, sondern eine absolute Zelladressierung (siehe Abschnitt 

„Relative und absolute Zellbezüge“ ab Seite 508). 

Selektives Einfügen 

Vom Menübefehl Bearbeiten > Einfügen gibt es noch eine leistungsfähigere Vari-

ante: nämlich den Befehl Bearbeiten > Inhalte einfügen. Bei diesem können Sie 

genau festlegen, in welcher Form der Inhalt der Zwischenablage eingefügt werden 

soll. 

Hintergrund: 

Wenn Sie mit dem Befehl Ausschneiden oder Kopieren Informationen in der 

Zwischenablage ablegen, werden diese dort in mehreren Formaten gleichzeitig 

gespeichert. Hatten Sie beispielsweise Text markiert, erscheint dieser in der Zwi-

schenablage sowohl in formatierter Form als auch unformatiert. 

Normalerweise brauchen Sie sich darum nicht zu kümmern, denn PlanMaker wählt 

automatisch das geeignetste Format, wenn Sie die Zwischenablage mit dem Befehl 

Einfügen ins Dokument einfügen. Sie können das Format jedoch alternativ selbst 

auswählen. Verwenden Sie hierzu den Menübefehl Bearbeiten > Inhalte einfü-

gen.  

Beim Aufruf dieses Befehls erscheint ein Dialogfenster mit einer Liste aller Forma-

te, in denen die momentan in der Zwischenablage befindliche Information gespei-

chert ist. Wählen Sie das gewünschte Format in der Liste Einfügen als aus und 

bestätigen mit OK, wird der Inhalt der Zwischenablage im gewählten Format ein-

gefügt. 

Darüber hinaus bietet dieser Dialog verschiedene zusätzliche Optionen an, die al-

lerdings nur verfügbar sind, wenn Tabellenzellen in die Zwischenablage kopiert 

wurden: 
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Folgende zusätzliche Optionen gibt es: 

Inhalt einfügen 

Hier können Sie festlegen, auf welche Weise die Inhalte der kopierten Zellen ein-

gefügt werden sollen: 

 Inhalte einfügen 

 Ist diese Option aktiviert, wird auch der Inhalt der kopierten Zellen eingefügt. 

Ist sie deaktiviert, nur deren Formatierung. 

 Formeln in Werte umwandeln 

 Ist diese Option aktiviert, werden sämtliche in den kopierten Zellen enthaltenen 

Rechenformeln beim Einfügen ausgerechnet und als feste Werte eingetragen. 

Kopieren Sie also eine Zelle mit der Berechnung „=A1*2“ in die Zwischenab-
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lage, würde beim Einfügen nicht die Rechenformel eingefügt, sondern das Er-

gebnis dieser Berechnung als Zahlenwert. 

 Kommentare ignorieren 

 Ist diese Option aktiviert, werden Kommentare, mit denen die kopierten Zellen 

versehen wurden, beim Einfügen weggelassen. 

Formatierung einfügen 

Bestimmt, ob beim Einfügen auch die Formatierung der kopierten Zellen über-

nommen werden soll. 

Hierfür gibt es folgende Optionen: 

 Alle 

 Alle Formatierungsoptionen der kopierten Zellen übernehmen. (Schaltet sämt-

liche nachfolgend aufgeführten Optionen ein.) 

 Zahlenformat 

 Das Zahlenformat der kopierten Zellen übernehmen. 

 Zellenformat 

 Das Zellenformat der kopierten Zellen übernehmen. 

 Gültigkeitsprüfung 

 Die Einstellungen zur Gültigkeitsprüfung der kopierten Zellen übernehmen. 

 Bedingte Formatierung 

 Bedingte Formatierungen der kopierten Zellen übernehmen. 

 Umrandung, Schattierung 

 Umrandung/Schattierung der kopierten Zellen übernehmen. 

Zellengrößen einfügen 

Bestimmt, ob beim Einfügen auch die Zellengrößen der kopierten Zellen auf die 

Zielzellen übertragen werden sollen. 
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 Spaltenbreite 

 Breite der kopierten Zellen übernehmen. 

 Zeilenhöhe 

 Höhe der kopierten Zellen übernehmen. 

Optionen 

Dieser Bereich enthält folgende zusätzlichen Optionen: 

 Transponieren 

 Ist diese Option aktiviert, wird beim Einfügen die zeilen-/spaltenweise Anord-

nung der kopierten Zellen vertauscht. Zeilen werden also zu Spalten, und Spal-

ten werden zu Zeilen. 

 Leere Zellen überspringen 

 Ist diese Option aktiviert, werden beim Einfügen der kopierten Zellen alle lee-

ren Zellen übersprungen. Fügen Sie also eine leere Zelle auf einer bestehenden 

Zelle ein, behält die bestehende Zelle ihren Inhalt und ihre Formatierung bei. 

 Rechenoperation 

 Diese Option betrifft das Einfügen von kopierten Zellen auf bereits vorhandene 

Zellen. Sie bestimmt, ob dabei die vorhandenen Werte mit den kopierten Wer-

ten kombiniert werden sollen. Hierfür stehen die vier Grundrechenarten zur 

Verfügung. 

 Verfügbare Optionen: 

 Keine: Die kopierten Werte und die vorhandenen Werte nicht kombinieren. Die 

vorhandenen Werte werden also einfach überschrieben. Dies ist die Stan-

dardeinstellung. 

 Zum Ziel addieren: Die kopierten Werte zu den vorhandenen Werten addieren. 

 Vom Ziel subtrahieren: Die kopierten Werte von den vorhandenen Werten 

abziehen. 

 Mit dem Ziel multiplizieren: Die vorhandenen Werte mit den kopierten Wer-

ten multiplizieren. 

 Das Ziel dividieren: Die vorhandenen Werte durch die kopierten Werte teilen. 
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 Ein Beispiel: Sie kopieren eine Zelle, die den Wert 2 enthält, in die Zwischen-

ablage. Dann steuern Sie eine Zelle an, die den Wert 8 enthält, und rufen den 

Menübefehl Einfügen > Inhalte einfügen auf. Ist hierbei die Option Zum Ziel 

addieren eingeschaltet, wird diese Zelle danach den Wert 10 enthalten 

(8+2=10). 

Schaltfläche „Bezug einfügen“ 

Diese Schaltfläche ignoriert sämtliche Einstellungen, die Sie in dem Dialog vor-

nehmen, denn sie hat folgende Spezialfunktion: 

Wenn Sie Tabellenzellen in die Zwischenablage kopiert haben, den Menübefehl 

Bearbeiten > Inhalte einfügen aufrufen und dann auf die Schaltfläche Bezug ein-

fügen klicken, werden nicht die Inhalte dieser Zellen eingefügt, sondern Zellbezü-

ge auf die Adressen dieser Zellen. 

Kopieren Sie also die Zelle B15 in die Zwischenablage, fügt diese Schaltfläche den 

Zellbezug =B15 ein. 

Tipp: Dies funktioniert sogar, wenn Zellen von einem anderen Dokument aus in 

die Zwischenablage kopiert wurden. In diesem Fall fügt PlanMaker automatisch 

einen externen Zellbezug ein (siehe Abschnitt „Externe Zellbezüge“, Seite 510). 

Automatisches Füllen von Zellen 

Mit der Funktion Ausfüllen ist es möglich, den Inhalt einer Zelle blitzschnell in 

andere Zellen zu kopieren – oder von diesem Zellinhalt ausgehend eine ansteigen-

de oder abfallende Wertereihe über mehrere Zellen hinweg aufzubauen.  

Es gibt zwei Methoden, diese Funktion einzusetzen: 

Füllen mit der Maus 

Am einfachsten funktioniert das automatische Füllen von Zellen mit der Maus. 

Gehen Sie wie folgt vor: 

1. Tragen Sie den Ausgangswert in eine Zelle ein. 

2. Klicken Sie auf diese Zelle (um sie zur aktuellen Zelle zu machen). 
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3. Zeigen Sie mit der Maus auf das kleine Rechteck in der rechten unteren Ecke 

des Zellrahmens, der die aktuelle Zelle umgibt (in der Abbildung rot umrandet): 

  

4. Ziehen Sie dieses Rechteck bei gedrückter Maustaste in die gewünschte Rich-

tung. Lassen Sie die Maustaste los, wenn die Zielposition erreicht ist. 

Alle Zellen in dem aufgezogenen Bereich werden nun automatisch gefüllt. 

Womit die Zellen gefüllt werden, hängt davon ab, was sich in der Ausgangszelle 

befindet: 

 Ist dort Text eingetragen, füllt PlanMaker alle Zellen mit diesem Text.  

 Ist eine Zahl (z.B. 42) eingetragen, füllt PlanMaker die Zellen automatisch mit 

einer Zahlenreihe mit Inkrement 1 (hier also 43, 44, 45 etc.). 

 Tipp: Wenn Sie nicht möchten, dass PlanMaker eine Zahlenreihe bildet, son-

dern einfach nur alle Zellen mit 42 gefüllt haben möchten, dann drücken Sie 

während des Ziehens mit der Maus die Taste (Strg). 

Wenn Sie während des Ziehens die Taste (Alt) gedrückt halten, erscheint der weiter 

unten beschriebene Dialog, in dem Sie genauer festlegen können, auf welche Weise 

die Zellen gefüllt werden sollen. 

Füllen per Tastatur 

Um Zellen per Tastatur automatisch füllen zu lassen, gehen Sie wie folgt vor: 

1. Tragen Sie den Ausgangswert in eine Zelle ein. 

2. Markieren Sie die Zelle mit dem Ausgangswert und alle zu füllenden Zellen. 

3. Rufen Sie den Menübefehl Bearbeiten > Ausfüllen nach auf. 

4. Es erscheint ein Untermenü. Wählen Sie darin, in welche Richtung gefüllt wer-

den soll (ausgehend von der Zelle mit dem Ausgangswert): Links, Rechts, 

Oben oder Unten. 

5. Es erscheint ein Dialog, in dem Sie genau festlegen können, auf welche Weise 

die Zellen gefüllt werden sollen (siehe unten). 

6. Sobald Sie mit OK bestätigen, werden die markierten Zellen Ihren Einstellun-

gen entsprechend gefüllt. 
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Es erscheint dabei das folgende Dialogfenster: 

 

In diesem Dialog können folgende Einstellungen vorgenommen werden: 

 Quelle 

 Aktivieren Sie die Option Inhalte, wenn die zu füllenden Zellen mit Werten 

gefüllt werden sollen. 

 Aktivieren Sie die Option Formate, wenn die zu füllenden Zellen auch die 

Formatierung der Ausgangszelle erben sollen. 

 Standardmäßig sind beide Optionen aktiviert. 

 Aktion 

 Diese Option entspricht dem Drücken der Taste (Strg) beim Füllen von Zellen 

per Maus: Sie können dadurch bestimmen, ob der Wert in der Ausgangszelle 

fortgeschrieben oder kopiert werden soll: 

 Steht in der Ausgangszelle beispielsweise die Zahl 42, werden bei Kopieren 

alle auszufüllenden Zellen ebenfalls mit 42 gefüllt. 

 Wählen Sie hingegen Fortschreiben, werden die Zellen mit einer Zahlenreihe 

(in diesem Fall also 43, 44, 45 etc.) gefüllt. 

 Wie diese Zahlenreihe aufgebaut sein soll, legen Sie mit den anderen Optionen 

in diesem Dialog fest: 

 Reihentyp 

 Hier bestimmen Sie, welche Art von Zahlenreihe erzeugt werden soll: 
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 Automatisch:  

 Entspricht einer arithmetischen Reihe: Jeder weitere Wert wird um das Inkre-

ment erhöht. Das Inkrement ermittelt PlanMaker dabei allerdings automatisch.  

 Wenn Sie beispielsweise zwei Zellen mit den Werten 10 und 20 fortführen, 

werden die auszufüllenden Zellen mit 30, 40, 50 etc. gefüllt (siehe auch Tipps 

und Tricks im nächsten Abschnitt). 

 Arithmetisch:  

 Hier wird jeder weitere Wert um das Inkrement erhöht.  

 Steht in der Ausgangszelle also 1, werden die Zellen bei einem Inkrement von 2 

mit folgender Zahlenreihe gefüllt: 3, 5, 7, 9, 11 etc. 

 Geometrisch:  

 Hier wird jeder weitere Wert mit dem Inkrement multipliziert. 

 Steht in der Ausgangszelle also 1, werden die Zellen bei einem Inkrement von 2 

mit folgender Zahlenreihe gefüllt: 2, 4, 8, 16, 32 etc. 

 Datum:  

 Hier wird jeder weitere Wert um das Inkrement in der gewählten Zeiteinheit 

(siehe unten) erhöht. Dieser Reihentyp ist nur dann sinnvoll anwendbar, wenn 

sich in der Ausgangszelle ein Datum befindet. 

 Steht in der Ausgangszelle also 1.1.2018, werden die Zellen bei Inkrement 1 

und Zeiteinheit „Monate“ wie folgt gefüllt: 1.2.2018, 1.3.2018, 1.4.2018 etc. 

 Zeiteinheit 

 Diese Option ist nur dann verfügbar, wenn der Reihentyp auf „Datum“ gesetzt 

wurde. 

 Sie können hier die Zeiteinheit für das Inkrement bestimmen: 

 Tage: tageweise weiterzählen 

 Werktage: tageweise weiterzählen, dabei jedoch Samstag und Sonntag über-

springen. Steht in der Ausgangszelle also ein Datum, das auf einen Freitag fällt, 

so wäre der nächste Wert nicht der darauf folgende Samstag, sondern der Mon-

tag. 

 Monate: monateweise weiterzählen 

 Jahre: jahreweise weiterzählen 
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 Inkrement 

 Hier bestimmen Sie, um welchen Betrag jeder weitere Wert ansteigen soll. Ei-

nige Beispiele finden Sie weiter oben. 

 Es ist auch ein negativer Wert zulässig. 

 Diese Option ist nicht verfügbar, wenn der Reihentyp auf „Automatisch“ ge-

setzt wurde, da PlanMaker das Inkrement hier automatisch ermittelt. 

 Jede Zelle einzeln inkrementieren 

 Wenn diese Option eingeschaltet wird, wendet PlanMaker das gewählte Inkre-

ment auf jede der momentan markierten Zellen einzeln an.  

 Ein Beispiel: Sie markieren Zellen mit den Inhalten 1, 2, 3 und füllen dann die 

Zellen direkt darunter. 

 Wenn die Option ausgeschaltet ist, wird diese Sequenz einfach fortgeführt, und 

die Zellen werden wie folgt gefüllt:  

 4, 5, 6, 7, 8, 9, 10, 11, 12 etc. 

 Wenn Sie die Option hingegen einschalten, sehen die gefüllten Zellen wie folgt 

aus:  

 2, 3, 4, dann 3, 4, 5, dann 4, 5, 6 etc. 

 Schaltfläche Listen bearbeiten 

 Sie können auch eigene Listen für die Funktion Ausfüllen herstellen.  

 Erzeugen Sie beispielsweise eine Liste mit dem Inhalt „Rot“, „Grün“ und 

„Blau“ und füllen dann, ausgehend von einer Zelle mit dem Inhalt „Rot“, wei-

tere Zellen, so werden diese mit Grün, Blau, Rot, Grün, Blau etc. ausgefüllt. 

 Diese Schaltfläche ruft den Menübefehl Weiteres > Listen editieren auf, mit 

dem Sie solche Listen anlegen können. Siehe Abschnitt „Listen für das automa-

tische Füllen editieren“ ab Seite 494. 

Tipps und Tricks zum automatischen Füllen 

Die vielen Optionen, die es bei der Funktion Ausfüllen gibt, lassen ihre Anwen-

dung schwieriger erscheinen, als sie tatsächlich ist. Deshalb finden Sie nachfolgend 

einige Tipps und Tricks, wie Sie dieses äußerst nützliche Feature am effektivsten 

einsetzen. 
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Tipp: Am schnellsten gelingt das automatische Füllen, wenn Sie einfach mit der 

Maus an dem kleinen Rechteck in der rechten unteren Ecke des Zellrahmens zie-

hen. Denn hier setzt PlanMaker den Reihentyp auf „Automatisch“. Das heißt: Er 

erkennt selbstständig, mit welchen Werten die Zellen auszufüllen sind (siehe 

Beispiele). 

 Füllen mit Text 

 Beim Füllen mit Text brauchen Sie sich um keinerlei Optionen zu kümmern, 

denn Text kann ohnehin nur kopiert werden. 

 Möchten Sie also mehrere Zellen mit dem gleichen Text füllen, tragen Sie ihn 

einfach in eine Zelle ein, klicken diese Zelle an und ziehen das kleine Rechteck 

in der rechten unteren Ecke des Zellrahmens über die Zellen, die damit gefüllt 

werden sollen. 

 Füllen mit Zahlen 

 Wenn Sie zum Füllen mit Zahlen die Maus verwenden, erhalten Sie eine Zah-

lenreihe, deren Inkrement PlanMaker automatisch bestimmt. 

 Ziehen Sie also von einer Zelle mit der Zahl 42 aus an dem kleinen Rechteck, 

werden die Zellen mit den Werten 43, 44, 45 etc. gefüllt. 

 Tragen Sie hingegen in eine Zelle 10 und darunter 20 ein, markieren diese bei-

den Zellen und ziehen dann das Rechteck nach unten, erkennt PlanMaker au-

tomatisch, wie diese Reihe fortzuführen ist, trägt also 30, 40, 50 etc. ein. 

 Füllen mit Formeln 

 Wenn Sie Zellen mit Formeln füllen, versucht PlanMaker automatisch, die Zel-

ladresse in einer Reihe fortzuführen. 

 Tragen Sie in die Ausgangszelle beispielsweise =A1*2 ein, werden die Zellen 

mit =A2*2, =A3*2 etc. gefüllt. 

 Füllen mit Datumsangaben 

 Das Füllen mit Datumsangaben funktioniert genauso wie das Füllen mit Zah-

len: 

 Tragen Sie das Ausgangsdatum in die Ausgangszelle ein, ziehen Sie an dem 

Rechteck und PlanMaker addiert bei jeder Zelle einen Tag hinzu. 

 Bei Bedarf können Sie über den Dialog des Menübefehls Bearbeiten > Ausfül-

len festlegen, ob um Tage, Monate oder Jahre weitergezählt werden soll. 
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 Füllen mit Strukturen 

 Wie Sie bereits erfahren haben, können Sie auch mehrere Zellen markieren und 

diese fortführen. Was aber, wenn die markierten Zellen kein automatisch er-

kennbares Inkrement oder völlige unterschiedliche Werte haben? 

 Hier versucht PlanMaker, dennoch eine Regelmäßigkeit zu erkennen. Tragen 

Sie beispielsweise untereinander die Werte 1, 2, Text ein, so führt PlanMaker 

diese Reihe mit 3, 4, Text, 5, 6, Text, 7, 8, Text etc. fort. 

 Handelt es sich bei den Werten ausschließlich um Zeichenketten, so werden 

diese einfach wiederholt. Sind die Ausgangszellen also mit den Zeichenketten 

Rot, Grün, Blau gefüllt, werden die Zellen mit Rot, Grün, Blau, Rot, Grün, 

Blau etc. gefüllt. 

 Füllen mit selbst erstellen Listen 

 Mit dem Menübefehl Weiteres > Listen editieren können Sie eigene Listen für 

die Funktion Ausfüllen herstellen. 

 Erzeugen Sie beispielsweise eine Liste mit dem Inhalt „Rot“, „Grün“ und 

„Blau“ und füllen dann, ausgehend von einer Zelle mit dem Inhalt „Rot“, wei-

tere Zellen, so werden diese mit Grün, Blau, Rot, Grün, Blau etc. ausgefüllt. 

 Informationen zum Erstellen solcher Listen finden Sie im Abschnitt „Listen für 

das automatische Füllen editieren“ ab Seite 494. 

Arbeiten mit mehreren Arbeitsblättern 

Tabellen müssen nicht unbedingt aus nur einem einzigen Arbeitsblatt bestehen. Es 

ist auch möglich, mehrere Arbeitsblätter hintereinander zu legen – quasi wie bei 

einem Stapel Papier. Wir nennen ein PlanMaker-Dokument deshalb auch eine Ar-

beitsmappe. Jede Arbeitsmappe kann bis zu 256 Arbeitsblätter enthalten. 

Der Clou dabei: Berechnungen in einem Arbeitsblatt können sich auch auf Zellen 

anderer Arbeitsblätter beziehen, was Ihnen ermöglicht, quasi „dreidimensionale“ 

Berechnungen durchzuführen (siehe Abschnitt „Rechnen in drei Dimensionen“, 

Seite 97). 

In diesem Abschnitt erfahren Sie alles Wissenswerte zum Arbeiten mit mehreren 

Arbeitsblättern in einem Dokument. Folgende Themen werden darin behandelt: 
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 Neue Arbeitsblätter anlegen 

 Mit dem Menübefehl Arbeitsblatt > Blatt > Einfügen können Sie jederzeit ein 

neues Arbeitsblatt anlegen. 

 Verwenden des Arbeitsblattregisters 

 Mit dem Arbeitsblattregister am unteren Rand des Dokumentfensters können 

Sie per Mausklick zwischen den Arbeitsblätter eines Dokuments wechseln. 

Weiterhin lassen sich Arbeitsblätter damit anlegen, verschieben und verwalten. 

 Arbeitsblätter verwalten 

 Das Kontextmenü des Arbeitsblattregisters und der Menübefehl Arbeitsblatt > 

Blatt stellt Ihnen Befehle zur Verfügung, mit denen Sie Arbeitsblätter verwal-

ten können (umbenennen, kopieren, verschieben etc.). 

 Rechnen in drei Dimensionen 

 Im letzten Abschnitt erfahren Sie, wie Sie Berechnungen über mehrere Arbeits-

blätter hinweg durchführen. 

Ausführliche Informationen zu diesen Themen finden Sie auf den nächsten Seiten. 

Neue Arbeitsblätter anlegen 

Um ein neues Arbeitsblatt anzulegen, rufen Sie den Menübefehl Arbeitsblatt > 

Blatt auf. Es öffnet sich ein Untermenü, aus dem Sie den Befehl Einfügen wählen. 

Nun erscheint ein Dialogfenster, das Sie auffordert, dem neuen Blatt einen Namen 

zu geben. Tragen Sie einen beliebigen Namen ein und bestätigen Sie mit OK.  

PlanMaker legt das Arbeitsblatt an und macht es zum aktiven Arbeitsblatt.  

Verwenden des Arbeitsblattregisters 

Im Arbeitsblattregister am unteren Rand des Dokumentfensters werden Register-

karten für alle im aktuellen Dokument vorhandenen Arbeitsblätter angezeigt. 

 

Das momentan aktive Blatt ist hervorgehoben dargestellt. 

Mit dem Arbeitsblattregister lassen sich folgende Aktionen durchführen: 
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 Wechseln zwischen Arbeitsblättern 

 Um auf ein anderes Arbeitsblatt zu wechseln, klicken Sie einfach dessen Regis-

terkarte im Arbeitsblattregister an. 

 Hinweis: Falls aus Platzgründen nicht alle Blätter angezeigt werden, können 

Sie das Register mit Hilfe der Pfeilchen links davon durchblättern. 

 Reihenfolge von Arbeitsblättern ändern 

 Sie können Arbeitsblätter im Arbeitsblattregister jederzeit verschieben und so 

die Reihenfolge der Blätter ändern.  

 Klicken Sie dazu die Registerkarte des Blatts an, das verschoben werden soll, 

halten Sie die linke Maustaste gedrückt und ziehen Sie seine Registerkarte an 

die gewünschte Position im Register. 

 Bearbeiten mehrerer Arbeitsblätter gleichzeitig 

 Sie können im Arbeitsblattregister auch mehrere Arbeitsblätter auf einmal se-

lektieren und diese dann gemeinsam bearbeiten. Halten Sie dazu die Taste 
(Strg) gedrückt und klicken Sie die Registerkarten aller Arbeitsblätter an, die 

Sie selektieren möchten. 

 Wenn mehrere Arbeitsblätter markiert sind, wirken sich Änderungen an einem 

dieser Arbeitsblätter auf alle markierten Arbeitsblätter gleichzeitig aus.  

 Beispiele: 

 Wenn Sie die Formatierung von Zellen ändern, wird diese Änderung auch von 

den gleichen Zellen auf den anderen markierten Blättern übernommen. 

 Wenn Sie den Inhalt einer Zelle bearbeiten oder löschen, wird auch diese Ände-

rung auf allen markierten Blättern übernommen. 

 Änderungen mit den Menübefehlen Arbeitsblatt > Zeile und Arbeitsblatt > 

Spalte wirken sich ebenfalls auf alle markierten Blätter aus. 

 Verwalten von Arbeitsblättern 

 Wenn Sie mit der rechten Maustaste auf eine der Registerkarten im Arbeits-

blattregister klicken, erscheint ein Kontextmenü, das alle Befehle zum Anlegen 

und Verwalten von Arbeitsblättern enthält. Lesen Sie dazu den nächsten Ab-

schnitt. 
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 Anlegen eines neuen Arbeitsblatts 

 Die Registerkarte mit dem Sternchen (*) ganz rechts dient als „Abkürzung“ für 

das Anlegen neuer Arbeitsblätter: Wenn Sie darauf klicken, legt PlanMaker so-

fort ein neues Arbeitsblatt an. 

Arbeitsblätter verwalten 

Wenn Sie den Menübefehl Arbeitsblatt > Blatt aufrufen, öffnet sich ein Unterme-

nü mit Befehlen zum Verwalten von Arbeitsblättern. 

Tipp: Dieses Menü erscheint auch, wenn Sie mit der rechten Maustaste auf die 

gewünschte Registerkarte im Arbeitsblattregister klicken. 

Folgende Befehle sind in dem Menü verfügbar: 

 Der Befehl Einfügen legt ein neues Arbeitsblatt an. 

 Der Befehl Kopieren fertigt eine Kopie des aktuellen Arbeitsblatts an. Dazu 

erscheint ein Untermenü, in dem Sie wählen können, an welcher Position die 

Kopie platziert werden soll (innerhalb der anderen Arbeitsblätter). 

 Sie können die Kopie auch in einem anderen (momentan geöffneten) Dokument 

oder in einem neuen Dokument ablegen. Wählen Sie dazu die Option In ein 

anderes Dokument. 

 Der Befehl Verschieben verschiebt das Arbeitsblatt an eine andere Position. 

Genau wie beim Befehl Kopieren erscheint auch hier ein Untermenü zur Aus-

wahl des Zielorts. 

 Der Befehl Löschen entfernt das Arbeitsblatt (samt Inhalt). 

 Der Befehl Umbenennen lässt Sie den Namen des Arbeitsblatts ändern. 

 Der Befehl Einblenden macht ausgeblendete Arbeitsblätter wieder sichtbar 

(siehe Befehl Ausblenden).  

 Dazu öffnet sich ein Untermenü, das alle ausgeblendeten Arbeitsblätter anzeigt. 

Klicken Sie darin auf das Blatt, das wieder eingeblendet werden soll. Der Ein-

trag Alle einblenden macht alle ausgeblendeten Blätter wieder sichtbar. 

 Der Befehl Ausblenden blendet das Arbeitsblatt aus.  

 Ausgeblendete Arbeitsblätter sind unsichtbar. Sie können nicht angezeigt oder 

bearbeitet werden und erscheinen auch nicht im Arbeitsblattregister. PlanMaker 

zieht sie aber auch weiterhin bei Berechnungen heran. 
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 Die Befehle Alle Blätter selektieren und Blätter deselektieren (nur im Kon-

textmenü verfügbar) selektieren beziehungsweise deselektieren alle Arbeitsblät-

ter im Arbeitsblattregister. 

 Der Befehl Seite einrichten im Kontextmenü entspricht dem Menübefehl Da-

tei > Seite einrichten im Hauptmenü. Sie können damit Einstellungen wie Pa-

pierformat, Seitenränder etc. für das Arbeitsblatt vornehmen. Siehe Abschnitt 

„Seitenformat“ ab Seite 229. 

 Der Befehl Seiteneinrichtung kopieren im Kontextmenü erlaubt es Ihnen, die 

Seiteneinrichtung eines Arbeitsblatts (also alle mit dem Menübefehl Datei > 

Seite einrichten gemachten Einstellungen) auf ein anderes Arbeitsblatt zu 

übertragen. Es erscheint ein Untermenü mit folgenden Befehlen: 

 Auf alle Blätter: Überträgt die Seiteneinrichtung vom aktuellen Arbeitsblatt 

auf alle anderen. 

 Von...: Überträgt die Seiteneinrichtung vom einem beliebigen anderen Arbeits-

blatt auf das aktuelle Blatt. 

 Der Befehl Eigenschaften im Kontextmenü entspricht dem Menübefehl Ar-

beitsblatt > Eigenschaften im Hauptmenü. Sie können damit allgemeine Ein-

stellungen zu einem Arbeitsblatt vornehmen. Siehe Abschnitt 

„Arbeitsblatteigenschaften ändern“ ab Seite 465. 

Tipp: Wie zuvor im Abschnitt „Verwenden des Arbeitsblattregisters“ beschrieben, 

können Sie vor dem Aufruf eines dieser Befehle mehrere Arbeitsblätter im Arbeits-

blattregister selektieren. Der Befehl wird dann auf alle selektierten Blätter gleich-

zeitig angewandt. 

Hinweis: Wenn Sie in einem Dokument den Arbeitsmappenschutz aktivieren, 

bewirkt das, dass sich darin ab sofort keinerlei Änderungen am Arbeitsblattregis-

ter mehr durchführen lassen. Auch der Menübefehl Arbeitsblatt > Blatt ist nicht 

mehr verfügbar. Weitere Informationen dazu finden Sie im Abschnitt 

„Arbeitsmappenschutz“ ab Seite 404. 

Rechnen in drei Dimensionen 

Der besondere Clou an Dokumenten mit mehreren Arbeitsblättern ist, dass Sie 

auch Berechnungen über mehrere Arbeitsblätter hinweg durchführen können.  

Dazu muss in der Formel lediglich vor der Zelladresse der Name des Blatts ange-

geben werden (durch ein Ausrufezeichen getrennt). „Tabelle1!A1“ steht beispiels-

weise für die Zelle A1 auf dem Arbeitsblatt „Tabelle1“. 
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Ein Beispiel 

Nehmen wir an, Sie möchten eine Gewinn- und Verlustrechnung erstellen. Dazu 

haben Sie drei Arbeitsblätter mit den Namen „Einnahmen“, „Ausgaben“ und „Er-

gebnis“ angelegt. 

 

Nun soll beispielsweise vom Wert in der Zelle A8 des Blatts „Einnahmen“ der Wert 

in Zelle D2 des Blatts „Ausgaben“ abgezogen werden und in Zelle C9 des Blatts 

„Ergebnis“ erscheinen.  

Wechseln Sie dazu zum Blatt „Ergebnis“. Steuern Sie darin die Zelle C9 an und 

tragen Sie folgende Formel ein: 

=Einnahmen!A8-Ausgaben!D2 

Nach Betätigen der Eingabetaste (¢) erhalten Sie in der Zelle C9 auf dem Blatt 

„Ergebnis“ das Resultat dieser Berechnung. 

Bereiche benennen 

Mit dem Menübefehl Arbeitsblatt > Namen können Sie beliebigen Zellbereichen 

Namen geben.  

Hat Ihre Tabelle beispielsweise vier Spalten mit den Umsätzen für Frühling, Som-

mer, Herbst und Winter, benennen Sie diese einfach entsprechend. Nun ist bei-

spielsweise folgende Berechnung möglich: 

=SUMME(Frühling)  

Wenn Sie den Menübefehl Arbeitsblatt > Namen aufrufen, öffnet sich ein Unter-

menü. Dieses enthält alle Befehle, die Sie für benannte Bereiche benötigen. 

Hinweis: Dieser Befehl ist nicht verfügbar, wenn mindestens ein Arbeitsblatt der 

Tabelle mit einem Blattschutz versehen ist (siehe auch Abschnitt „Blattschutz“ ab 

Seite 401). 

Ausführlichere Information zum Arbeiten mit Bereichen finden Sie auf den nächs-

ten Seiten. Folgende Themen werden darin behandelt: 

 Namen festlegen 

 Namen umbenennen oder löschen 
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 Namen aus der Markierung automatisch festlegen 

 Liste aller Namen ausgeben 

 Namen in der Praxis einsetzen 

 Namen nachträglich auf Berechnungen anwenden 

Namen festlegen 

Um einem Zellbereich einen Namen zu geben, gehen Sie wie folgt vor: 

1. Markieren Sie den Zellbereich, der benannt werden soll. 

2. Rufen Sie den Menübefehl Arbeitsblatt > Namen > Bearbeiten auf. 

3. Geben Sie in das Eingabefeld Name den gewünschten Namen ein. 

4. Klicken Sie auf die Schaltfläche Hinzufügen. 

Der markierte Zellbereich wurde nun mit dem angegebenen Namen versehen. 

Diesen Namen können Sie ab jetzt – stellvertretend für die Zellen im angegebenen 

Bereich – in Formeln verwenden. Geben Sie zum Beispiel dem Bereich A2 bis A10 

den Namen „Januar“, ist die Rechenformel =SUMME(Januar) gleichbedeutend mit 

=SUMME(A2:A10). 

Hinweis: Namen für benannte Bereiche dürfen nur aus Buchstaben, Zahlen, Un-

terstrichen und Punkten bestehen. Das erste Zeichen muss ein Buchstabe oder 

ein Unterstrich sein.  

Weiterhin dürfen Namen nicht wie Zellbezüge aufgebaut sein. Der Name „A2“ 

ist beispielsweise nicht zulässig, da PlanMaker ihn nicht von der Adresse der 

Zelle A2 unterscheiden kann. 

Tipp: Eine schnellere Methode 

Folgendermaßen können Sie Namen noch schneller festlegen: 

Links oberhalb der Tabelle befindet sich eine editierbare aufklappbare Liste, die 

normalerweise anzeigt, in welcher Zelle sich der Zellrahmen gerade befindet.  
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Sie können dort aber auch blitzschnell Bereiche benennen: 

1. Markieren Sie den Zellbereich, der benannt werden soll. 

2. Klicken Sie mit der Maus in diese editierbare Liste. 

3. Tragen Sie den Namen ein, den der markierte Bereich erhalten soll. 

4. Drücken Sie die Eingabetaste (¢). 

Der markierte Bereich wurde nun mit dem eingegebenen Namen versehen. 

Namen umbenennen oder löschen 

Um einen benannten Bereichs umzubenennen oder ihn zu löschen, gehen Sie wie 

folgt vor: 

1. Rufen Sie den Menübefehl Arbeitsblatt > Namen > Bearbeiten auf. 

2. Selektieren Sie den zu gewünschten Namen in der Liste der Namen. 

3. Um ihn umzubenennen, klicken Sie auf die Schaltfläche Umbenennen. Um ihn 

zu löschen, klicken Sie auf Löschen. 

Der Name wurde nun geändert beziehungsweise entfernt. 

Hinweis: Wenn Sie einen Namen löschen, wird anschließend bei Formeln, die 

diesen Namen verwenden, anstelle des Ergebnisses der Fehlerwert #NAME? zu-

rückgegeben. War also beispielsweise ein Zellbereich mit dem Namen „Januar“ 

versehen, wird als Ergebnis der Formel =SUMME(Januar) jetzt #NAME? ange-

zeigt. 

Namen aus der Markierung automatisch festlegen 

Wenn Sie Zellen markieren, die sowohl Werte als auch Zeilen- oder Spaltenüber-

schriften enthalten, können Sie PlanMaker daraus entsprechend benannte Bereiche 
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generieren lassen. Die Namen holt sich PlanMaker dabei automatisch aus den 

Überschriften. 

Gehen Sie dazu wie folgt vor: 

1. Markieren Sie den gewünschten Zellbereich. Dieser muss sowohl die Werte als 

auch die Überschriften, die für die Namensgebung verwendet werden sollen, 

enthalten. 

2. Rufen Sie den Menübefehl Arbeitsblatt > Namen > Übernehmen auf. 

3. Es erscheint ein Dialog, in dem Sie angeben, in welcher Zeile und/oder Spalte 

sich die Überschriften befinden, die für die Namensgebung herangezogen wer-

den sollen (siehe Beispiel). 

4. Bestätigen Sie mit OK. 

Die Namen wurden nun den Überschriften entsprechend festgelegt. 

Ein Beispiel 

Sie haben die folgende Tabelle erstellt: 

 

Markieren Sie nun alle Werte und alle Bezeichnungen und rufen Sie den Menübe-

fehl Arbeitsblatt > Namen > Übernehmen auf. Legen Sie dann fest, aus welcher 

Zeile und/oder Spalte Namen erzeugt werden sollen: 

 Wenn Sie nur die Option Oberste Zeile einschalten, gibt PlanMaker den Zellen 

unter Januar, Februar und März automatisch den Namen „Januar“, „Februar“ 

beziehungsweise „März“. 

 Wenn Sie nur die Option Linke Spalte einschalten, benennt PlanMaker die 

Zellen neben Kiel, Hamburg und München mit „Kiel“, „Hamburg“ bezie-

hungsweise „München“. 

 Sie können auch beide Optionen einschalten, worauf PlanMaker alle sechs oben 

aufgeführten Namen anlegt. 
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Liste aller Namen ausgeben 

Sie können PlanMaker anweisen, eine Liste aller benannten Bereiche in die Tabelle 

einzufügen. Dies ist praktisch, wenn man einen Überblick haben möchte, welche 

benannten Bereiche sich in der Tabelle befinden und welche Zellen diese umfas-

sen. 

Gehen Sie dazu wie folgt vor: 

1. Steuern Sie die Zelle an, an der die Liste eingefügt werden soll. 

2. Rufen Sie den Menübefehl Arbeitsblatt > Namen > Liste einfügen auf. 

Es wird nun eine Liste aller benannten Bereiche in die Tabelle eingefügt. 

Namen in der Praxis einsetzen 

Wenn Sie mit dem Menübefehl Arbeitsblatt > Namen Zellbereiche benannt ha-

ben, können Sie verschiedene Operationen wesentlich effizienter durchführen. 

Folgendermaßen setzen Sie benannte Bereiche in der Praxis ein: 

Schnelles Markieren eines benannten Bereichs 

Links oberhalb des Tabellenfensters befindet sich eine aufklappbare Liste, die 

normalerweise anzeigt, in welcher Zelle sich der Zellrahmen gerade befindet.  

 

Wenn Sie diese mit einem Mausklick auf das kleine Pfeilchen rechts daneben öff-

nen, werden alle vorhandenen Bereichsnamen angezeigt. Klicken Sie einen Namen 

an, wird der entsprechende Bereich sofort markiert. 

Verwenden von Namen in Rechenformeln 

Sie können den Namen eines Bereichs – stellvertretend für die Zellen, die sich da-

rin befinden – in Rechenformeln verwenden. Dies spart Ihnen nicht nur Tipparbeit, 

sondern macht Formeln auch übersichtlicher. 
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Ein Beispiel: 

In den Zellen A2 bis A10 haben Sie die Umsätze für den Monat Januar eingetra-

gen. Diesem Bereich geben Sie nun den Namen „Januar“. 

Wenn Sie nun die Summe aller Umsätze vom Januar ermitteln möchten, tippen Sie 

einfach: 

=SUMME(Januar) 

Darunter kann man sich schon wesentlich besser vorstellen, was diese Formel be-

rechnet, als bei der Formel =SUMME(A2:A10). 

Natürlich können Sie nun auch die Umsätze für Februar, März etc. entsprechend 

benennen. 

Tipp: Im Dialogfenster des Menübefehls Einfügen > Funktion gibt es in der 

Liste Kategorie auch einen Eintrag namens „Benannte Bereiche“. Wenn Sie die-

sen wählen, werden in der Liste Funktion alle benannten Bereiche aufgelistet, so 

dass Sie diese bequem in Formeln einfügen können. 

Namen nachträglich auf Berechnungen anwenden 

Der Befehl Anwenden im Untermenü des Menübefehls Arbeitsblatt > Namen ist 

ein nützlicher Helfer für den Einsatz benannter Bereiche: Er durchsucht alle For-

meln im markierten Bereich. Findet er innerhalb einer Formel einen Zellbezug, für 

den bereits ein Name definiert wurde, ersetzt er diesen durch den Namen. 

Folgendermaßen setzen Sie diesen Befehl ein: 

1. Markieren Sie den Tabellenbereich, dessen Formeln angepasst werden sollen. 

Wenn Sie nichts markieren, wirkt sich diese Funktion auf die gesamte Tabelle 

aus. 

2. Rufen Sie den Menübefehl Arbeitsblatt > Namen > Anwenden auf. 

3. Selektieren Sie in der Liste Namen alle Namen, die angewandt werden sollen 

oder klicken Sie auf Alle markieren, um alle Namen auszuwählen. 

4. Bestätigen Sie mit OK. 

PlanMaker durchsucht nun alle Zellbezüge, die in dem markierten Bereich vor-

kommen. Befinden sich darin Zellbezüge, die benannt wurden, ersetzt er sie durch 

den entsprechenden Namen. 

Ein Beispiel: 
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Sie haben den Bereich A2 bis A10 „Januar“ genannt. In Ihrer Tabelle befindet sich 

eine Zelle mit der Berechnung =SUMME(A2:A10). Setzen Sie nun den Menübe-

fehl Arbeitsblatt > Namen > Anwenden ein, wird die Formel in dieser Zelle in 

=SUMME(Januar) umgewandelt. 

Die Option „Auch relative Bezüge umwandeln“ 

Im obigen Dialog gibt es eine Option namens Auch relative Bezüge umwandeln. 

Normalerweise sollten Sie diese eingeschaltet lassen. 

Diese Option hat folgende Bedeutung: 

Wir haben Ihnen bisher der Einfachheit halber unterschlagen, dass sich Namen 

immer auf Zellbereiche mit absoluter Adressierung (also beispielsweise 

$A$1:$A$10) beziehen. In Berechnungen verwendet man jedoch meist die relative 

Adressierung (zum Beispiel A1:A10).  

Ist diese Option eingeschaltet, werden auch relativ adressierte Zellbezüge umge-

wandelt. 

Wird die Option ausgeschaltet, werden nur absolut adressierte Zellbezüge umge-

wandelt. 

Ein Beispiel: 

Der Bereich von A1 bis A10 (genauer gesagt also $A$1:$A$10) wurde „Januar“ 

genannt. Wenden Sie die Funktion Anwenden nun auf die Berechnung 

=SUMME($A$1:$A$10) an, wird diese in jedem Fall in =SUMME(Januar) um-

gewandelt. Wenden Sie sie jedoch auf die Berechnung =SUMME(A1:A10) an, 

wird diese nur dann umgewandelt, wenn die Option Auch relative Bezüge um-

wandeln eingeschaltet ist. 

Weitere Informationen zum Thema „Relative und absolute Zellbezüge“ finden Sie 

im gleichnamigen Abschnitt ab Seite 508. 

Sortieren 

Mit dem Menübefehl Arbeitsblatt > Sortieren können Sie einen Zellbereich sor-

tieren lassen. 
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Gehen Sie wie folgt vor: 

1. Markieren Sie den Zellbereich, der sortiert werden soll. 

2. Rufen Sie den Menübefehl Arbeitsblatt > Sortieren auf. 

3. Wählen Sie bei 1: die Spalte aus, nach der sortiert werden soll.  

4. Rechts daneben können Sie auch die Reihenfolge der Sortierung ändern: Auf-

steigend (A bis Z) oder Absteigend (Z bis A). 

5. Bei Bedarf können Sie bei 2: und 3: noch weitere Spalten wählen, nach denen 

sortiert werden soll.  

 Wählen Sie beispielsweise bei 1: eine Spalte mit Nachnamen und bei 2: eine 

Spalte mit Vornamen, wird der Zellbereich nach Nachnamen und (innerhalb 

gleicher Nachnamen) außerdem nach Vornamen sortiert. 

6. Nehmen Sie bei Bedarf weitere Einstellungen vor, siehe unten. 

Sobald Sie mit OK bestätigen, wird der Zellbereich entsprechend sortiert. 

Optionen des Dialogs 

Das Dialogfenster für diesen Befehl hat folgende Optionen: 
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 Spalte und Reihenfolge 

 Wählen Sie zuerst hier die gewünschte(n) Spalte(n) aus, nach denen sortiert 

werden soll.  

 Sie können jeweils auch die Reihenfolge bestimmen: Aufsteigend (A bis Z) 

oder Absteigend (Z bis A). 

 Standardmäßig lassen sich bis zu drei Spalten festlegen. Sie können sogar noch 

weitere Spalten hinzufügen, wenn Sie mehr als drei Sortierkriterien benötigen. 

Maximal sind 64 Spalten möglich. Gehen Sie dazu wie folgt vor: 

 Spalte hinzufügen: Klicken Sie auf die Schaltfläche mit dem Plus-Zeichen, 

um eine weitere Spalte einzufügen. 

 Spalte anhängen: Klicken Sie auf die Schaltfläche Anhängen (unter der 

Liste), um eine weitere Spalte unter allen anderen anzuhängen. 

 Spalte entfernen: Klicken Sie auf die Schaltfläche mit dem Minus-

Zeichen, um die entsprechende Spalte zu entfernen. (Dies funktioniert nur, 

wenn mehr als 3 Spalten vorhanden sind.) 

 Zeilenweise sortieren oder Spaltenweise sortieren 

 Diese Option bestimmt, ob zeilen- oder spaltenweise sortiert werden soll. 

 Erste Zeile enthält Überschriften 

 Wenn die erste Zeile (beziehungsweise Spalte) des markierten Zellbereichs 

Überschriften enthält, sollten Sie diese Option einschalten. PlanMaker sortiert 

diese dann nicht mit. 

 Beispiel: Sie haben eine Adressenliste markiert, die Sie zeilenweise sortieren 

möchten. In der ersten Zeile der Markierung stehen Überschriften wie „Name“, 

„Straße“, „Ort“ etc., darunter die Daten. Hier sollten Sie diese Option einschal-

ten, damit diese Zeile nicht mitsortiert wird, sondern weiterhin die erste Zeile 

bleibt. 

 Groß-/Kleinschreibung beachten 

 Wenn Sie diese Option einschalten, wird beim Sortieren zwischen groß- und 

kleingeschriebenen Buchstaben unterschieden. Dadurch landen beispielsweise 

alle Wörter, die mit einem Kleinbuchstaben beginnen, vor den Wörtern, die mit 

einem Großbuchstaben beginnen: 

 Aus: Apfel, birne, Clementine. Ein: birne, Apfel, Clementine. 
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 Umrandung/Schattierung mitsortieren 

 Ist diese Option aktiviert, nimmt jede Zelle ihre Umrandung und Schattierung 

mit, wenn sie durch das Sortieren verschoben wird.  

 Ist sie ausgeschaltet, bleibt die ursprüngliche Formatierung der Zellen im mar-

kierten Zellbereich erhalten, was Umrandungen und Schattierungen betrifft.  

Transponieren 

FreeOffice: Die Funktion Transponieren in SoftMaker FreeOffice nicht enthal-

ten. 

Der Menübefehl Arbeitsblatt > Transponieren vertauscht die zeilen- und spal-

tenweise Anordnung der markierten Zellen. Zeilen werden also zu Spalten, und 

Spalten werden zu Zeilen. 

Markieren Sie den gewünschten Zellbereich, bevor Sie diesen Befehl anwenden. 

Wichtig: Beachten Sie, dass beim Transponieren keinerlei Rechenformeln oder 

Bereichsnamen auf die dadurch verschobenen Zelladressen angepasst werden – 

weder innerhalb noch außerhalb des transponierten Bereichs! 

Text in Spalten aufteilen 

FreeOffice: Die Funktion Text in Spalten aufteilen ist in SoftMaker FreeOffice 

nicht enthalten. 

Mit dem Menübefehl Arbeitsblatt > Text in Spalten aufteilen können Sie Text, 

der sich in einer Tabellenzelle befindet, auf mehrere Tabellenspalten aufteilen. 

Steht in dieser Zelle beispielsweise ein Satz, verteilt dieser Befehl die einzelnen 

Wörter auf jeweils eine Spalte. 

Wenden Sie diesen Befehl wie folgt an: 

1. Navigieren Sie zu der Zelle, die den Text enthält, den Sie auf Spalten verteilen 

möchten.  
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 (Sie können auch mehrere Zellen markieren, wenn Sie die Inhalte mehrerer 

Zellen auf einmal auf Spalten verteilen möchten.) 

2. Rufen Sie den Menübefehl Arbeitsblatt > Text in Spalten aufteilen auf. 

3. Es erscheint ein Dialogfenster mit einigen Optionen (siehe unten).  

 In der Regel nimmt PlanMaker alle Einstellungen darin automatisch vor, und 

Sie brauchen nichts zu ändern. 

4. Bestätigen Sie mit OK. 

Der Text in der Zelle wird nun auf mehrere Spalten verteilt. 

Optionen des Dialogs 

Tipp: Die optimalen Einstellungen für dieses Dialogfenster werden nach Analyse 

des Zellinhalts automatisch ermittelt und müssen in der Regel nicht verändert 

werden. 

Das Dialogfenster für diesen Befehl hat folgende Optionen: 

 Zielbereich 

 Hier können Sie auf Wunsch einen anderen Zielbereich eintragen. Der verteilte 

Text landet dann nicht an seiner ursprünglichen Position, sondern an der ange-

gebenen Zielposition.  

 Es genügt, die Adresse der Zelle in der linken oberen Ecke der Zielposition 

anzugeben. 

 Trennzeichen 

 Hier können Sie bei Bedarf festlegen, welches Zeichen PlanMaker als Trenn-

zeichen ansehen soll. Ist in die Zelle beispielsweise der Satz „Dies ist ein Test.“ 

eingetragen, wählt PlanMaker automatisch ein Leerzeichen als Trennzeichen, 

verteilt also jedes Wort auf eine Spalte.  

 Texterkennungszeichen 

 Falls der Text in der Zelle mit Texterkennungszeichen versehen ist, können Sie 

hier einstellen, welches Zeichen hierfür verwendet wurde (zum Beispiel Anfüh-

rungszeichen).  

 (Hintergrund: Die Text-Exportfunktion mancher Programme umgibt jedes Da-

tenfeld mit einem solchen Texterkennungszeichen, damit genau zu erkennen ist, 

wo jedes Feld beginnt und endet.) 
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Filtern 

Sie können einen Tabellenbereich markieren und dann die Daten darin anhand ei-

ner Filterbedingung „filtern“. Alle Zeilen, die dieser Bedingung nicht entsprechen, 

werden daraufhin ausgeblendet.  

Es gibt drei Befehle zum Filtern von Daten, die alle im Untermenü des Menübe-

fehls Arbeitsblatt > Filter zu finden sind: 

 Der Befehl Spezialfilter öffnet ein Dialogfenster, in dem Sie eine oder mehrere 

Filterbedingungen formulieren können. Nach Ihrem OK wird der Filter aktiv: 

Alle Zeilen im selektierten Bereich, die der Filterbedingung nicht entsprechen, 

werden ausgeblendet. 

 Der Befehl Alles anzeigen blendet alle ausgeblendeten Zellen wieder ein, hebt 

die Wirkung eines Spezialfilters also auf. 

 Der Befehl AutoFilter bietet eine Alternative zum Filtern von Tabellenzeilen: 

Wenn Sie einen Zellbereich markieren und dann diesen Befehl aufrufen, wird 

von nun an über jeder Spalte dieses Zellbereichs ein Pfeil angezeigt. Klicken 

Sie einen dieser Pfeile an, öffnet sich ein Menü mit allen Zellinhalten dieser 

Spalte – und anderen Bedingungen, nach denen Sie filtern können. 

Ausführliche Informationen zu diesen Befehlen finden Sie auf den nächsten Seiten. 

Spezialfilter 

Über den Menübefehl Arbeitsblatt > Filter > Spezialfilter können Sie die Daten 

in einem Zellbereich anhand einer oder mehrerer Bedingungen filtern. Dies be-

wirkt, dass alle Zeilen, die den Bedingungen nicht entsprechen, ausgeblendet wer-

den. 

Gehen Sie dazu wie folgt vor: 

1. Markieren Sie den gewünschten Tabellenbereich. 

2. Rufen Sie den Menübefehl Arbeitsblatt > Filter auf, worauf sich ein Unter-

menü öffnet. Wählen Sie darin den Befehl Spezialfilter. 

3. Es erscheint ein Dialogfenster. Legen Sie darin eine oder mehrere Filterbedin-

gungen fest (siehe unten). 

4. Bestätigen Sie mit OK. 

Nun werden alle Zeilen, die der Bedingung nicht entsprechen, ausgeblendet.  
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Filterbedingungen formulieren 

Um im Dialogfenster des Befehls Spezialfilter eine oder mehrere Filterbedingun-

gen festzulegen, gehen Sie wie folgt vor: 

Wählen Sie in der Rubrik Bedingung 1 zunächst links die Spalte aus, der eine Be-

dingung zugeordnet werden soll. Rechts daneben wählen Sie den Operator. Ganz 

rechts geben Sie schließlich den Vergleichswert ein. 

Einige Beispiele: 

 Die Bedingung „Spalte A entspricht Kiel“ zeigt nur noch Einträge an, bei denen 

in der Spalte A das Wort Kiel steht. 

 Bei der Bedingung „Spalte E größer oder gleich 100000“ werden alle Einträge 

herausgefiltert, bei denen die Spalte E einen Wert kleiner als 100000 enthält. 

Reicht eine Bedingung nicht aus, so haben Sie die Möglichkeit, bis zu drei Bedin-

gungen miteinander zu verknüpfen, indem Sie zusätzlich die Rubriken Bedingung 

2 und Bedingung 3 ausfüllen.  

Platzhalter verwenden: Die Zeichen * und ? können in Bedingungen als Platzhalter 

für beliebige andere Zeichen verwendet werden: * steht für eine beliebige Anzahl 

an beliebigen Zeichen, ? steht für ein einzelnes beliebiges Zeichen. Die Bedingung 

„NAME entspricht M*er“ trifft also beispielsweise auf die Namen Müller, Meier-

huber etc. zu, die Bedingung NAME = Me?er auf die Namen Meier, Meyer etc. 

Optionen des Dialogs 

Das Dialogfenster für Spezialfilter verfügt über folgende Optionen: 

 Bereich enthält Überschriften 

 Wenn die erste Zeile und/oder Spalte der markierten Zellen Überschriften ent-

hält, sollten Sie diese Option einschalten. PlanMaker ignoriert diese Zei-

le/Spalte dann beim Filtern, zeigt dafür aber in den Listen zum Formulieren von 

Bedingungen nicht Spalte A, Spalte B etc. sondern diese Überschriften an. 

 Groß-/Kleinschreibung beachten 

 Wenn diese Option eingeschaltet ist, wird die Groß-/Kleinschreibung in Bedin-

gungen beachtet. Bei der Bedingung „SPALTE A entspricht Meyer“ passieren 

den Filter also nur Zeilen, bei denen in der Spalte A „Meyer“ steht. Zeilen mit 

„MEYER“ oder „meyer“ werden hingegen herausgefiltert. 
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 Modus 

 Bestimmt, ob Zeilen oder Spalten gefiltert werden sollen. 

 Wählen Sie die Option Zeilenweise filtern, werden alle Zeilen herausgefiltert, 

die den Bedingungen nicht entsprechen. 

 Wählen Sie hingegen die Option Spaltenweise filtern, werden alle Spalten 

herausgefiltert. 

 Ergebnisse 

 Bestimmt, ob der Filter auf die Originaldaten oder auf eine Kopie davon ange-

wandt werden soll: 

 Wählen Sie die Option An Ort und Stelle filtern werden – wie zuvor be-

schrieben – die Originaldaten gefiltert. Zeilen/Spalten, die der Filterbedingung 

nicht entsprechen, werden also ausgeblendet. 

 Wählen Sie hingegen die Option An folgende Stelle kopieren, wird eine Kopie 

der Originaldaten an der angegebenen Zelladresse erstellt. Diese Kopie enthält 

nur die gefilterten Daten.  

 Geben Sie dazu in das Eingabefeld unter dieser Option ein, an welcher Stelle 

die Kopie eingefügt werden soll. Sie können entweder eine einzelne Zelladresse 

angeben (hier wird dann die linke obere Ecke der Kopie platziert) oder den 

Zellbereich, in den die Kopie gesetzt werden soll, genau festlegen. Vorsicht: 

Passt die Kopie nicht in diesen Bereich hinein, wird entsprechend abgeschnit-

ten. 

Alle ausgeblendeten Zeilen wieder einblenden 

Wenn Sie möchten, dass alle per Filter ausgeblendeten Zeilen wieder sichtbar wer-

den, dann rufen Sie den Menübefehl Arbeitsblatt > Filter > Alles anzeigen auf. 

AutoFilter 

Neben dem im vorherigen Abschnitt vorgestellten Spezialfilter gibt es noch eine 

weitere Möglichkeit, die Zeilen einer Tabelle zu filtern: den Menübefehl Arbeits-

blatt > Filter > AutoFilter.  

Wenn Sie einen Zellbereich markieren und dann diesen Befehl aufrufen, wird von 

nun an über jeder Spalte dieses Zellbereichs ein Pfeil angezeigt. Klicken Sie einen 
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dieser Pfeile an, öffnet sich ein Menü mit allen Zellinhalten dieser Spalte – und 

anderen Bedingungen, nach denen Sie filtern können. 

Im Einzelnen gehen Sie dazu wie folgt vor: 

1. Markieren Sie den gewünschten Tabellenbereich. Wichtig: Die erste Zeile des 

Bereichs sollte Überschriften für die darunter liegenden Daten enthalten. 

2. Rufen Sie den Menübefehl Arbeitsblatt > Filter auf, worauf sich ein Unter-

menü öffnet. Wählen Sie darin den Befehl AutoFilter. 

Die AutoFilter-Funktion ist nun aktiviert. Sie erkennen das daran, dass in der ersten 

Zeile des markierten Bereichs ein nach unten weisender Pfeil für jede Spalte ange-

zeigt wird.  

Klicken Sie einen solchen Pfeil an, öffnet sich in ein Menü, das unter anderem eine 

Liste aller Zellinhalte enthält, die in der entsprechenden Spalte vorkommen. Stan-

dardmäßig sind in dieser Liste alle Werte ausgewählt, es findet also keine Filterung 

statt. 

Um eine Filterung durchzuführen, verwenden Sie dieses Menü wie folgt: 

 Aufsteigend sortieren: Sortiert die Filterergebnisse (siehe unten). 

 Absteigend sortieren: Sortiert die Filterergebnisse (siehe unten). 

 (Alle): Dieser Menüeintrag ist ein praktischer Platzhalter: Mit seiner Hilfe kön-

nen Sie mit einem einzigen Klick alle Zellinhalte, die in der Spalte vorkom-

men, hinzufügen/entfernen.  

 Das Häkchen vor dem Eintrag zeigt an, dass derzeit alle Zellinhalte in den Fil-

ter aufgenommen sind. 

 Klicken Sie nun den Eintrag (Alle) an, werden alle Zellinhalte auf einmal aus 

dem Filter entfernt (und das Häkchen verschwindet). Klicken Sie ihn erneut an, 

werden wieder alle Zellinhalte in den Filter aufgenommen (das Häkchen er-

scheint wieder). 

 Weitere Filter: Öffnet ein Untermenü mit zusätzlichen Filtern (siehe unten). 

 Liste der Zellinhalte: Der wichtigste Teil: Hier werden alle Zellinhalte aufge-

listet, die in der Spalte vorkommen. Durch Anklicken eines Werts können Sie 

diesen in den Filter aufnehmen (es erscheint danach ein Häkchen davor) bezie-

hungsweise durch erneutes Anklicken wieder entfernen (das Häkchen ver-

schwindet). 
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Beispiel 

Um beispielsweise einen Zellbereich so zu filtern, dass nur noch diejenigen Zeilen 

angezeigt werden, bei denen in einer Spalte mit der Überschrift „Name“ das Wort 

„Schmidt“ steht, gehen Sie wie folgt vor: 

Markieren Sie den Zellbereich (inklusive der Spaltenüberschriften) und rufen Sie 

den Menübefehl Arbeitsblatt > Filter > AutoFilter auf, um den AutoFilter zu 

aktivieren. 

Es erscheint nun ein Pfeilchen neben jeder Spaltenüberschrift. Klicken Sie auf das 

Pfeilchen für die Spalte mit der Überschrift „Name“, um das AutoFilter-Menü für 

diese Spalte öffnen. 

Klicken Sie im AutoFilter-Menü zunächst auf den Menüeintrag (Alle), um alle 

Zellinhalte aus dem Filter zu entfernen. Dann wählen Sie den Menüeintrag 

„Schmidt“. Sie haben damit einen Filter mit der Bedingung „Name entspricht 

Schmidt“ definiert. Alle Zeilen, die dieser Filterbedingung nicht entsprechen, wer-

den nun ausgeblendet. 

Möchten Sie darüber hinaus noch alle Müllers aufgelistet bekommen, wählen Sie 

einfach zusätzlich den Menüeintrag „Müller“. Sollen die Müllers aus den Ergebnis-

sen wieder verschwinden, klicken Sie den Eintrag „Müller“ erneut an, um ihn wie-

der abzuwählen.  

Sie sehen: Die Einträge im Menü des AutoFilters können individuell zu dem Filter 

hinzugefügt und entfernt werden, dabei sind beliebige Kombinationen möglich. 

Sortieren der Ergebnisse der Filterung 

Mit den ersten beiden Befehlen im Menü des AutoFilters können Sie die Tabellen-

zeilen, die von dem Filter zurückgeliefert werden, sortieren lassen: 

 Aufsteigend sortieren: Sortiert die vom Filter zurückgelieferten Tabellenzeilen 

in aufsteigender Reihenfolge.  

 Aufsteigend sortieren: Dito, in absteigender Reihenfolge. 

Hinweis 1: Die Zeilen werden dabei nicht nur sortiert angezeigt, sondern tat-

sächlich (physikalisch) umsortiert. 

Hinweis 2: Es werden die kompletten Tabellenzeilen umsortiert, nicht nur die 

Zellen in dem Bereich, auf den der AutoFilter angewandt wurde.  
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Der Menüeintrag „Weitere Filter“ 

Der Menüeintrag Weitere Filter im Menü des AutoFilters öffnet ein Untermenü, 

das einige zusätzliche Filterbedingungen anbietet: 

 Benutzerdefiniert: Öffnet einen Dialog, in dem Sie genauere Filterbedingun-

gen festlegen können (so ähnlich wie beim Befehl Spezialfilter). 

 Top 10: Nur noch diejenigen Zeilen anzeigen, bei denen sich in dieser Spalte 

beispielsweise einer der 10 höchsten (oder 10 niedrigsten) Werte befindet. 

 Nur leere: Nur noch Zeilen anzeigen, bei denen der Wert in dieser Spalte leer 

ist. 

 Nicht leere: Nur noch Zeilen anzeigen, bei denen der Wert in dieser Spalte 

nicht leer ist. 

 Über dem Durchschnitt: Nur noch Zeilen anzeigen, bei denen der Wert in 

dieser Spalte über dem Durchschnittswert (der Werte in dieser Spalte) liegt. 

 Unter dem Durchschnitt: Nur noch Zeilen anzeigen, bei denen der Wert in 

dieser Spalte unter dem Durchschnittswert (der Werte in dieser Spalte) liegt. 

Alle ausgeblendeten Zeilen wieder einblenden 

Wenn Sie möchten, dass alle per AutoFilter ausgeblendeten Zeilen wieder sichtbar 

werden, dann rufen Sie den Menübefehl Arbeitsblatt > Filter > Alles anzeigen 

auf. 

Autofilter ausschalten 

Um die AutoFilter-Funktion gänzlich zu deaktivieren, rufen Sie den Menübefehl 

Arbeitsblatt > Filter > AutoFilter noch einmal auf. Die Pfeile über dem Zellbe-

reich verschwinden, und es werden wieder alle Zellen angezeigt. 

Analysieren von Tabellen 

In PlanMaker stehen Ihnen verschiedene Werkzeuge zum Analysieren der Zellin-

halte und Rechenformeln in einer Tabelle zur Verfügung. Diese können insbeson-

dere bei der Fehlersuche sehr hilfreich sein. 
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Im Einzelnen gibt es hierfür folgende Werkzeuge: 

 Formelanzeige 

 Wenn Sie den Menübefehl Ansicht > Formelanzeige aufrufen, werden bei 

Berechnungen die Rechenformeln statt der Ergebnisse angezeigt. 

 Syntaxhervorhebung 

 Wenn Sie den Menübefehl Ansicht > Syntaxhervorhebung aufrufen, werden 

alle Zellinhalte Ihrem Inhalt entsprechend farblich gekennzeichnet. Zellen, die 

einen Fehler enthalten, erscheinen in roter Schrift, Zellen mit einer Berechnung 

in grüner Schrift etc. 

 Beobachtungsfenster für Zellinhalte 

FreeOffice: Das Beobachtungsfenster ist in SoftMaker FreeOffice nicht 

enthalten. 

 Mit dem Menübefehl Ansicht > Beobachtungsfenster können Sie jederzeit ein 

Beobachtungsfenster für Zellen einblenden. Mit dessen Hilfe lässt sich der In-

halt der gewählten Zellen permanent überwachen. 

 Formelüberwachung 

FreeOffice: Die Formelüberwachung ist in SoftMaker FreeOffice nicht ent-

halten. 

 Der Menübefehl Weiteres > Formelüberwachung bietet Funktionen zur grafi-

schen Darstellung der Beziehungen zwischen Zellen an. Enthält die aktuelle 

Zelle beispielsweise eine Rechenformel, die sich auf andere Zellen bezieht, 

können Sie PlanMaker Pfeile zu diesen Zellen einblenden lassen. 

 Weiterhin lassen sich mit diesem Befehl Fehler in der Tabelle aufspüren oder 

ungültige Daten mit roten Kringeln kennzeichnen. 

Ausführliche Informationen zu diesen Funktionen finden Sie auf den nächsten Sei-

ten. 

Formelanzeige 

Wenn Sie die Formelanzeige einschalten, werden bei Berechnungen die Rechen-

formeln statt der Ergebnisse angezeigt. Dies kann bei der Analyse der Formeln in 

einer Tabelle und bei der Fehlersuche nützlich sein.  
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Formelanzeige ein- und ausschalten 

Um die Formelanzeige einzuschalten, rufen Sie den Menübefehl Ansicht > For-

melanzeige auf.  

Wenn Sie den Befehl noch einmal aufrufen, wird sie wieder deaktiviert. 

Syntaxhervorhebung 

Wenn Sie die Syntaxhervorhebung aktivieren, werden alle Zellinhalte Ihrem Inhalt 

entsprechend farblich gekennzeichnet. Zellen, die einen Fehler enthalten, erschei-

nen in roter Schrift, Zellen mit einer Berechnung in grüner Schrift etc. 

So können Sie auf einen Blick sehen, wo sich Formeln befinden und wo fest ein-

gegebene Werte, wo Fehler auftreten usw. 

Syntaxhervorhebung ein- und ausschalten 

Um die Syntaxhervorhebung einzuschalten, rufen Sie den Menübefehl Ansicht > 

Syntaxhervorhebung auf.  

Wenn Sie den Befehl noch einmal aufrufen, wird sie wieder deaktiviert. 

Bedeutung der Vordergrundfarbe 

Bei aktivierter Syntaxhervorhebung werden die Zellen mit folgenden Farben einge-

färbt: 

Zellinhalt Farbe 

Fehlerwert Rot 

Formel Grün 

Fest eingegebene positive Zahl Dunkelblau 

Fest eingegebene negative Zahl Hellblau 

Fest eingegebener Wahrheitswert Braun 

Fest eingegebene Zeichenkette Schwarz 
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Bedeutung der Hintergrundfarbe 

Zellen, die einen Fehler enthalten, werden also in roter Farbe dargestellt. Bei 

schwerwiegenden Fehlern wird die Zelle außerdem mit einem farbigen Hinter-

grund versehen. Dessen Farbe zeigt an, um welche Art von Fehler es sich handelt: 

Hintergrundfarbe Art des Fehlers 

Weiß Die Formel liefert einen Fehlerwert. Die Berechnung in 

dieser Zelle liefert einen Fehlerwert, weil sie beispielsweise 

eine Division durch Null enthält. 

 Abhilfe: Setzen Sie den Zellrahmen auf diese Zelle, worauf 

eine Fehlermeldung in der Statuszeile erscheint. Korrigieren 

Sie die Formel entsprechend. 

Zyanblau Schwerwiegender Fehler in der Formel. Die Formel in 

dieser Zelle ist falsch formuliert, weil beispielsweise eine 

schließende Klammer fehlt oder eine Funktion nicht mit den 

korrekten Argumenten aufgerufen wurde. 

 Abhilfe: Setzen Sie den Zellrahmen auf diese Zelle, worauf 

eine Fehlermeldung in der Statuszeile erscheint. Korrigieren 

Sie die Formel entsprechend. Wenn Sie dies nicht tun, wird 

die Formel beim Speichern entfernt und durch den Fehler-

wert #NULL! ersetzt! 

Hellgrau Nicht exportierbare Funktion. Die Formel in dieser Zelle 

verwendet eine Rechenfunktion, die das Dateiformat, in dem 

Sie das Dokument gespeichert haben, nicht unterstützt. 

 Abhilfe: Ersetzen Sie die Funktion durch eine andere Funk-

tion, die zum gewünschten Dateiformat kompatibel ist. In-

formationen dazu finden Sie bei der Beschreibung der betref-

fenden Funktion. 

Magentarot Möglicherweise falsch importierte Funktion. Die Formel 

in der Zelle enthält eine Rechenfunktion, die PlanMaker 

zwar bekannt ist, von ihm aber anders verwendet wird als 

von der Vorgängerversion PlanMaker 97. Tritt beim Import 

von PlanMaker 97-Dokumenten mit Zeit-Funktionen auf. 

 Abhilfe: Lesen Sie die Informationen bei der Beschreibung 

der betreffenden Funktion. 

Gelb Unbekannte Funktion. Die Formel in dieser Zelle enthält 

eine Rechenfunktion, die PlanMaker nicht bekannt ist. Tritt 

beim Import von Fremdformaten (z.B. Microsoft Excel) auf. 
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 Abhilfe: Ersetzen Sie die Funktion durch eine entsprechende 

PlanMaker-Funktion. Informationen über alle verfügbaren 

Rechenfunktionen finden Sie im Abschnitt „Funktionen von 

A-Z“ ab Seite 522. 

Beobachtungsfenster für Zellinhalte 

FreeOffice: Das Beobachtungsfenster ist in SoftMaker FreeOffice nicht enthal-

ten. 

Sie können jederzeit ein Beobachtungsfenster für Zellen einblenden. Mit dessen 

Hilfe lässt sich der Inhalt der gewählten Zellen permanent überwachen.  

 

Beobachtungsfenster ein- und ausschalten 

Um das Beobachtungsfenster einzublenden, rufen Sie den Menübefehl Ansicht > 

Beobachtungsfenster auf.  

Wenn Sie den Befehl noch einmal aufrufen, wird das Fenster wieder ausgeblendet. 

Zellen zum Beobachtungsfenster hinzufügen 

Um den Inhalt einer Zelle zu überwachen, fügen Sie diese dem Beobachtungsfens-

ter hinzu. Gehen Sie dazu wie folgt vor: 

1. Klicken Sie im Beobachtungsfenster auf die Schaltfläche Zelle hinzufügen. 

2. Geben Sie die Adresse der Zelle ein und bestätigen Sie mit OK. 

 Tipp: Sie können auch einen ganzen Zellbereich angeben. Tragen Sie als Ad-

resse beispielsweise A1:A3 ein, werden die Zellen A1, A2 und A3 hinzugefügt. 
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Der Inhalt der angegebenen Zellen wird nun im Beobachtungsfenster angezeigt. 

Bei jeder Neuberechnung der Tabelle wird auch das Beobachtungsfenster aktuali-

siert. 

Zellen aus dem Beobachtungsfenster entfernen 

Wenn Sie eine Zelle nicht mehr überwachen möchten, können Sie diese jederzeit 

aus dem Beobachtungsfenster entfernen. Selektieren Sie die Zelle dazu im Be-

obachtungsfenster und klicken Sie auf die Schaltfläche Zelle entfernen. 

Sie können auch alle beobachteten Zellen auf einmal entfernen, indem Sie auf die 

Schaltfläche Alle entfernen klicken. 

Formelüberwachung 

FreeOffice: Die Formelüberwachung ist in SoftMaker FreeOffice nicht enthal-

ten. 

Der Menübefehl Weiteres > Formelüberwachung bietet Funktionen zur grafi-

schen Darstellung der Beziehungen zwischen Zellen an. Enthält die aktuelle Zelle 

beispielsweise eine Rechenformel, die sich auf andere Zellen bezieht, können Sie 

PlanMaker Pfeile zu diesen Zellen einblenden lassen. 

Weiterhin lassen sich mit diesem Befehl Fehler in der Tabelle aufspüren oder un-

gültige Daten mit roten Kringeln kennzeichnen. 

Wenn Sie den Menübefehl Weiteres > Formelüberwachung aufrufen, öffnet sich 

ein Untermenü, das entsprechende Kommandos bereithält. Nach Themen geordnet 

stehen darin folgende Funktionen zur Verfügung: 

 Anzeigen der Beziehungen zwischen Zellen 

 Der Menübefehl Weiteres > Formelüberwachung bietet unter anderem 

Kommandos, mit denen sich die Beziehungen zwischen Zellen grafisch darstel-

len lassen. So können Sie beispielsweise Pfeile zu allen Zellen einblenden, auf 

die sich die Rechenformel in der aktuellen Zelle bezieht. Enthält die Zelle also 

die Berechnung =A1*A2, erscheinen Pfeile zu den Zellen A1 und A2. 

 Selektieren der mit einer Zelle verbundenen Zellen 

 Darüber hinaus gibt es Kommandos zum Selektieren aller Zellen, auf die sich 

die Rechenformel in der aktuellen Zelle bezieht. Oder umgekehrt aller Zellen, 

die sich auf die aktuelle Zelle beziehen. 
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 Fehler in Berechnungen aufspüren 

 Außerdem können Sie auf die vorherige oder nächste Zelle springen, die einen 

Fehlerwert enthält, und Pfeile zur Quelle des Fehlers einblenden lassen. 

 Ungültige Daten in Zellen aufspüren 

 Schließlich lassen sich alle Zellen aufspüren, deren Inhalt der Gültigkeitsprü-

fung für die entsprechende Zelle nicht entspricht. 

Ausführliche Informationen zu diesen Themen finden Sie auf den nächsten Seiten. 

Tipp: Verwenden der Formelüberwachungsleiste 

Am schnellsten lassen sich die Funktionen dieses Befehls über die Formelüberwa-

chungsleiste aufrufen. 

 

Sie können diese Leiste jederzeit ein- oder ausblenden, indem Sie den Menübefehl 

Weiteres > Formelüberwachung > Formelüberwachungsleiste anzeigen aufru-

fen. 

Die Leiste verfügt über folgende Schaltflächen (von links nach rechts): 

 Spur zu den Vorgängern 

 Spuren zu den Vorgängern entfernen 

 Spur zu den Nachfolgern 

 Spuren zu den Nachfolgern entfernen 

 Alle Spuren entfernen 

 Spur zum Fehler 

 Ungültige Daten markieren 

 Markierung für ungültige Daten entfernen 

 Gehe zum vorhergehenden Fehler 

 Gehe zum nächsten Fehler 

 Gehe zur vorhergehenden ungültigen Zelle 

 Gehe zur nächsten ungültigen Zelle 

Informationen zur Funktion der einzelnen Symbole folgen auf den nächsten Seiten. 
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Anzeigen der Beziehungen zwischen Zellen 

FreeOffice: Die Formelüberwachung ist in SoftMaker FreeOffice nicht enthal-

ten. 

Der Menübefehl Weiteres > Formelüberwachung bietet unter anderem Kom-

mandos, mit denen sich die Beziehungen zwischen Zellen grafisch darstellen las-

sen.  

 

Steuern Sie dazu die Zelle an, die Sie analysieren möchten, und rufen Sie dann 

eines der folgenden Kommandos im Untermenü dieses Befehls auf: 

 Spur zu den Vorgängern 

 Dieser Befehl blendet Pfeile zu allen Zellen ein, auf die sich die Rechenformel 

in der aktuellen Zelle bezieht. 

 Beispiel: Enthält die aktuelle Zelle die Berechnung =A1*A2, zeigt dieser Be-

fehl Pfeile zu den Zellen A1 und A2 an. 

 Spuren zu den Vorgängern entfernen 

 Blendet alle Pfeile, die mit dem obigen Befehl eingeblendet wurden, für die 

aktuelle Zelle wieder aus. 

 Spur zu den Nachfolgern 

 Blendet Pfeile zu allen Zellen ein, die sich auf die aktuelle Zelle beziehen. 

 Beispiel: Enthält eine beliebige Zelle die Berechnung =B5*2, zeigt dieser Be-

fehl einen Pfeil zu dieser Zelle an, wenn Sie ihn in der Zelle B5 aufrufen. 

 Spuren zu den Nachfolgern entfernen 

 Blendet alle Pfeile, die mit dem obigen Befehl eingeblendet wurden, für die 

aktuelle Zelle wieder aus. 
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 Alle Spuren entfernen 

 Blendet alle Pfeile, die mit den Befehlen Spur zu den Vorgängern oder Spur 

zu den Nachfolgern eingeblendet wurden, für die gesamte Arbeitsmappe wie-

der aus. 

Anmerkungen und Tipps 

 Sie können die Befehle Spur zu den Vorgängern und Spur zu den Nachfol-

gern in einer Zelle auch mehrmals hintereinander aufrufen. Bei jedem Aufruf 

wird eine weitere Ebene von Beziehungen angezeigt. 

 Die Pfeile, die sich mit obigen Befehlen einblenden lassen, sind anklickbar. 

Wenn Sie auf einen solchen Pfeil klicken, springt PlanMaker zu der Zelle, die 

sich am anderen Ende des Pfeils befindet. 

 Falls sich die aktuelle Zelle auf eine Zelle bezieht, die sich auf einem anderen 

Arbeitsblatt befindet, wird nur ein kleiner Pfeil in der linken oberen Ecke der 

Zelle angezeigt. Auch diesen Pfeil können Sie anklicken, um blitzschnell zu der 

entsprechenden Zelle zu gelangen. 

 Wenn Sie den Inhalt einer Zelle bearbeiten, die Zelle löschen oder sie verschie-

ben, werden alle Pfeile zu dieser Zelle automatisch entfernt. 

 Alle eingeblendeten Pfeile erscheinen auch im Ausdruck. 

 Im Dokument werden die Pfeile allerdings nicht gespeichert. Wenn Sie das Do-

kument also speichern und erneut öffnen, sind alle Pfeile wieder entfernt.  

Selektieren der mit einer Zelle verbundenen Zellen 

FreeOffice: Die Formelüberwachung ist in SoftMaker FreeOffice nicht enthal-

ten. 

Der Menübefehl Weiteres > Formelüberwachung bietet unter anderem Kom-

mandos, mit denen Sie diejenigen Zellen selektieren können, die eine Beziehung 

zur aktuellen Zelle haben. 

Steuern Sie dazu die gewünschte Zelle an und rufen Sie dann eines der folgenden 

Kommandos im Untermenü für diesen Befehl auf: 
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 Vorgänger selektieren 

 Dieser Befehl selektiert alle Zellen, auf die sich die Rechenformel in der aktuel-

len Zelle bezieht. 

 Beispiel: Enthält die aktuelle Zelle die Berechnung =A1*A2, selektiert dieser 

Befehl die Zellen A1 und A2. 

 Nachfolger selektieren 

 Selektiert alle Zellen, die sich auf die aktuelle Zelle beziehen. 

 Beispiel: Enthält eine beliebige Zelle die Berechnung =B5*2, selektiert dieser 

Befehl diese Zelle, wenn Sie ihn in der Zelle B5 aufrufen. 

Fehler in Berechnungen aufspüren 

FreeOffice: Die Formelüberwachung ist in SoftMaker FreeOffice nicht enthal-

ten. 

Der Menübefehl Weiteres > Formelüberwachung bietet unter anderem Kom-

mandos, mit denen sich Zellen finden und analysieren lassen, die einen Fehlerwert 

liefern.  

Anmerkung: Eine Zelle liefert dann einen Fehlerwert, wenn in der Berechnung, die 

sie enthält, ein Fehler auftritt. Enthält eine Zelle beispielsweise eine Division durch 

Null, wird darin der Fehlerwert #DIV/0 angezeigt. (Weitere Informationen zu Feh-

lerwerten finden Sie im Abschnitt „Fehlerwerte“ ab Seite 515.) 

Verwenden Sie zur Fehlersuche die folgenden Kommandos im Untermenü des Me-

nübefehls Weiteres > Formelüberwachung: 

 Spur zum Fehler 

 Falls die aktuelle Zelle einen Fehlerwert enthält, blendet dieser Befehl Pfeile zu 

den Zellen ein, die diesen Fehlerwert versuchen (sofern anwendbar). 

 Beispiel: Wenn eine Zelle den Fehlerwert #DIV/0 liefert und sie diesen Befehl 

dort aufrufen, erscheinen Pfeile auf die Zellen, die diese Division durch Null 

verursachen. 

 Gehe zum vorhergehenden Fehler 

 Springt zur vorherigen Zelle mit einem Fehlerwert. 
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 Gehe zum nächsten Fehler 

 Springt zur nächsten Zelle mit einem Fehlerwert. 

Ungültige Daten in Zellen aufspüren 

FreeOffice: Die Formelüberwachung ist in SoftMaker FreeOffice nicht enthal-

ten. 

Der Menübefehl Weiteres > Formelüberwachung bietet unter anderem Kom-

mandos, mit denen sich Zellen aufspüren lassen, die einen ungültigen Wert enthal-

ten. 

Anmerkung: Eine Zelle enthält dann einen ungültigen Wert, wenn mit dem Menü-

befehl Format > Gültigkeitsprüfung festgelegt wurde, dass die Zelle nur be-

stimmte Werte enthalten darf, und der aktuelle Zellinhalt dieser Prüfung nicht ent-

spricht. (Weitere Informationen dazu finden Sie im Abschnitt „Gültigkeitsprüfung“ 

ab Seite 221.) 

Verwenden Sie zur Fehlersuche die folgenden Kommandos im Untermenü des Me-

nübefehls Weiteres > Formelüberwachung: 

 Ungültige Daten markieren 

 Dieser Befehl umgibt alle Zellen auf dem aktuellen Arbeitsblatt, die einen un-

gültigen Wert enthalten, mit einem roten Kringel. 

 Markierung für ungültige Daten entfernen 

 Entfernt alle Kringel (auf dem aktuellen Arbeitsblatt) wieder. 

 Gehe zur vorhergehenden ungültigen Zelle 

 Springt zur vorherigen Zelle mit einem ungültigen Wert. 

 Gehe zur nächsten ungültigen Zelle 

 Springt zur nächsten Zelle mit einem ungültigen Wert. 

Anmerkungen 

 Die Markierungen für ungültige Daten erscheinen auch im Ausdruck.  
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 Im Dokument werden die Markierungen allerdings nicht gespeichert. Wenn Sie 

das Dokument also speichern und erneut öffnen, sind alle Markierungen wieder 

entfernt.  

Aktualisieren von Tabellen 

Sämtliche Berechnungen in einer Tabelle werden automatisch stets auf dem neues-

ten Stand gehalten. Dazu rechnet PlanMaker jedes Mal, wenn Sie einen Zellinhalt 

abändern, die gesamte Tabelle neu durch.  

Normalerweise müssen Sie sich um dieses Thema also überhaupt nicht kümmern. 

Deaktivieren der automatischen Neuberechnung 

Bei Bedarf können Sie das automatische Neuberechnen aller Berechnungen auch 

abschalten. Dies ist beispielsweise bei sehr rechenintensiven Tabellen nützlich, bei 

denen das Neuberechnen einige Zeit dauert. 

Ändern Sie dazu die Einstellung Neuberechnung in den Dokumenteigenschaften 

entsprechend. Siehe Abschnitt „Dokumenteigenschaften, Karteikarte Berechnen“ 

(ab Seite 462). 

Das Aktualisieren der Tabelle muss dann manuell erfolgen. Hierfür gibt es folgen-

de Tasten beziehungsweise Menübefehle: 

 Wenn Sie die Taste (F9) betätigen oder den Menübefehl Weiteres > Neu be-

rechnen aufrufen, aktualisiert PlanMaker die Berechnungen auf allen Arbeits-

blättern. 

 Wenn Sie hingegen (ª)(F9) drücken, aktualisiert PlanMaker nur die Berech-

nungen auf dem aktuellen Arbeitsblatt.  

Hinweis: Letzteres kann zu veralteten Ergebnissen führen, falls das aktuelle 

Arbeitsblatt Berechnungen mit Zellen auf anderen Arbeitsblättern durchführt. 

Aktualisieren externer Zellbezüge 

Beachten Sie, dass externe Zellbezüge nicht bei jedem Neuberechnen der Arbeits-

mappe aktualisiert werden.  
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(Externe Zellbezüge sind Zellbezüge, die sich auf Zellen in einer anderen Arbeits-

mappe beziehen – also beispielsweise ='C:\Mein Verzeichnis\[Meine Arbeitsmap-

pe.pmdx]Tabelle1'!A1.) 

Solche Zellbezüge werden nur beim Öffnen des Dokuments, das die externen Be-

züge enthält, automatisch aktualisiert. Außerdem können Sie externe Bezüge jeder-

zeit manuell aktualisieren. 

Ausführliche Informationen zum Arbeiten mit externen Zellbezügen finden Sie im 

Abschnitt „Externe Zellbezüge“ (ab Seite 510). 

Kommentare einfügen 

Mit dem Menübefehl Einfügen > Kommentar können Sie die aktuelle Tabellen-

zelle mit einem Kommentar versehen – zum Beispiel: „Hier müssen noch die Da-

ten vom Vorjahr eingetragen werden!“. 

Folgendermaßen arbeiten Sie mit Kommentaren: 

Anbringen von Kommentaren 

Um einen Kommentar anzubringen, steuern Sie die gewünschte Zelle an und rufen 

den Menübefehl Einfügen > Kommentar auf. Es erscheint ein gelbes Rechteck, in 

das Sie den Kommentar eintippen. Um Ihre Eingabe abzuschließen, klicken Sie an 

eine beliebige Stelle außerhalb des gelben Rechtecks oder drücken die Taste (Esc). 

Kommentare werden im Dokument gespeichert, stehen also wieder zur Verfügung, 

wenn Sie das Dokument das nächste Mal öffnen. 

Ansehen von Kommentaren 

Bei Zellen, die mit einem Kommentar versehen sind, wird in der rechten oberen 

Ecke ein gelbes Dreieck angezeigt. Zeigen Sie mit der Maus auf eine solche Zelle, 

wird nach kurzer Zeit automatisch der Kommentar eingeblendet. Er verschwindet 

wieder, wenn Sie die Maus aus der Zelle herausbewegen. 
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Ändern von Kommentaren 

Um einen Kommentar abzuändern, rufen Sie den Menübefehl Einfügen > Kom-

mentar in der betreffenden Zelle noch einmal auf und nehmen die gewünschten 

Änderungen vor. 

Tipp: Alternativ können Sie auch einen Doppelklick auf das gelbe Dreieck in der 

Zelle durchführen oder die Tastenkombination (ª)(F2) betätigen, um den Kom-

mentar zu einer Zelle zu bearbeiten. 

Wenn Sie mit den Änderungen fertig sind, klicken Sie an eine beliebige Stelle au-

ßerhalb des Kommentars oder drücken die Taste (Esc). 

Löschen von Kommentaren 

Um Kommentare von Zellen zu entfernen, markieren Sie die betreffenden Zellen 

und rufen den Menübefehl Bearbeiten > Selektiv löschen auf. Es öffnet sich ein 

Untermenü, aus dem Sie die Option Kommentare wählen. Die Kommentare wer-

den daraufhin gelöscht. 

Zielwertsuche 

Mit dem Menübefehl Weiteres > Zielwertsuche können Sie herausfinden, wel-

chen Wert ein bestimmter Bestandteil einer Berechnung annehmen muss, damit ein 

vorgegebenes Ergebnis herauskommt.  

Hinweis: Bei der Zielwertsuche handelt es sich nicht um „schwarze Magie“ oder 

künstliche Intelligenz, sondern um ein simples mathematisches Näherungsver-

fahren (Iterationsverfahren) – und wie bei allen Näherungsverfahren muss das 

Ergebnis nicht unbedingt exakt sein. 

Steuern Sie, bevor Sie diesen Befehl aufrufen, mit dem Zellrahmen die Zelle an, in 

der die Rechenformel enthalten ist. 
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Nach dem Aufruf meldet sich der Befehl mit einem Dialogfenster. Dieses wird wie 

folgt bedient: 

 In Formelzelle geben Sie – sofern PlanMaker nicht schon den richtigen Eintrag 

ermitteln konnte – die Adresse der Zelle mit der Rechenformel ein.  

 In Zielwert tippen Sie das gewünschte Ergebnis ein. 

 In Variable Zelle tippen Sie die Adresse derjenigen Zelle ein, in der PlanMaker 

so lange verschiedene Werte ausprobieren soll, bis in der Formelzelle das ge-

wünschte Ergebnis steht. 

 Bei Genauigkeit können Sie die Genauigkeit der Annäherung festlegen. Plan-

Maker wird solange versuchen, Werte anzunähern, bis der Unterschied zum 

Zielwert kleiner als der Parameter Genauigkeit ist.  

Wenn PlanMaker auch nach mehreren Sekunden keinen ausreichend genauen Wert 

finden kann, so lässt sich dieser nicht durch Näherung ermitteln. PlanMaker bricht 

die Suche dann ab. 

Ein Beispiel 

In der weiter unten abgebildeten Tabelle wurde in Zelle A5 die Summenfunktion 

verwendet, um die Zahlen 1, 2 und 3 in den Zellen A2, A3 und A4 zu addieren. Als 

Ergebnis in A5 kommt 6 heraus. Wir möchten nun wissen, auf welchen Wert bei-

spielsweise die Zelle A3 geändert werden muss, damit das Ergebnis der Addition 7 

ist.  

Wir steuern dazu die Zelle mit der Berechnung an, deren Ergebnis wir verändern 

möchten – hier also die Zelle A5 mit der Summenformel – und rufen die Zielwert-

suche auf. 
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In der Abbildung sehen Sie, wie das Dialogfenster für die Berechnung ausgefüllt 

werden muss. Nach Ihrem OK startet PlanMaker die Annäherung und meldet das 

Ergebnis 3 in einem Dialogfenster. 

Der Inhalt der Zelle A3 muss also von 2 auf 3 geändert werden, damit die Berech-

nung das Ergebnis 7 hat. Wenn Sie in dem Dialogfenster auf Übernehmen klicken, 

wird der gefundene Wert in Zelle A3 übernommen. 

Szenarien 

FreeOffice: Die Funktion Szenarien ist in SoftMaker FreeOffice nicht enthal-

ten. 

Der Menübefehl Weiteres > Szenarien erlaubt das Anlegen und Anzeigen von 

„Szenarien“. 

Mit Hilfe von Szenarien können Sie beobachten, welche Auswirkungen das Än-

dern der Werte in bestimmten Zellen auf die Berechnungen in einem Arbeitsblatt 

hat. Dies ermöglicht das Durchführen von „Was-wäre-wenn“-Analysen aller Art. 

Beispiel: Wie ändern sich die Gesamtkosten eines Kredits, wenn die Laufzeit 24, 

36 oder 96 Monate beträgt? 
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In diesem Abschnitt erfahren Sie alles Wissenswerte zum Arbeiten mit Szenarien. 

Folgende Themen werden darin behandelt: 

 Erstellen von Szenarien 

 Anzeigen von Szenarien 

 Verwalten von Szenarien 

 Zusammenführen von Szenarien 

 Anlegen eines Szenarioberichts 

Lesen Sie dazu die nächsten Seiten. 

Erstellen von Szenarien 

FreeOffice: Die Funktion Szenarien ist in SoftMaker FreeOffice nicht enthal-

ten. 

Um Szenarien zu erstellen, füllen Sie zunächst ein Arbeitsblatt mit den gewünsch-

ten Werten und Berechnungen aus. 

Dann gehen Sie wie folgt vor: 

1. Rufen Sie den Menübefehl Weiteres > Szenarien auf. 

2. Klicken Sie auf Hinzufügen. 

3. Geben Sie bei Szenarioname einen beschreibenden Namen für das Szenario 

ein. 

4. Geben Sie bei Veränderbare Zellen die Adresse der Zelle ein, deren Inhalt 

verändert werden soll.  

 Sie können auch mehrere Zellen angeben. Trennen Sie die Zelladressen dazu 

mit einem Strichpunkt – zum Beispiel: A2;A4;A10. Auch Zellbereiche wie 

B5:B10 sind erlaubt. 

5. Klicken Sie auf die Schaltfläche Weiter, um fortzufahren. 

6. Es erscheint ein weiterer Dialog. Tragen Sie darin den Wert ein, der in diesem 

Szenario in die „veränderbare Zelle“ eingesetzt werden soll. 

 Falls Sie in dem Szenario mehrere veränderbare Zellen definiert haben, enthält 

dieser Dialog eine Liste all dieser Zellen. Klicken Sie darin auf jeden einzelnen 

Listeneintrag und tragen Sie daneben jeweils den gewünschten Zellwert ein. 
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7. Klicken Sie auf Fertigstellen, um das Anlegen dieses Szenarios abzuschließen. 

8. Wiederholen Sie die Schritte 2. bis 7. für alle weiteren Szenarien, die Sie anle-

gen möchten. 

9. Wenn Sie fertig sind, verlassen Sie den Dialog mit Schließen. 

Die gewünschten Szenarien wurden nun angelegt. Um zu erfahren, wie Sie diese 

anzeigen, lesen Sie bitte den nächsten Abschnitt. 

Optionen des Dialogs 

Im Dialogfenster für das Hinzufügen von Szenarien gibt es folgende zusätzlichen 

Optionen: 

 Kommentar 

 Hier können Sie einen beschreibenden Kommentar für das Szenario eingeben. 

 Änderungen verhindern 

 Ist diese Option eingeschaltet, lässt sich das Szenario nicht mehr bearbeiten 

oder löschen, wenn Sie den Blattschutz aktivieren. 

 Ausblenden 

 Ist diese Option eingeschaltet, wird das Szenario nicht mehr in der Liste der 

Szenarien angezeigt, wenn Sie den Blattschutz aktivieren. 

Allgemeine Informationen zum Verwenden eines Blattschutzes finden Sie im Ab-

schnitt „Blattschutz“ (Seite 401). 

Anzeigen von Szenarien 

FreeOffice: Die Funktion Szenarien ist in SoftMaker FreeOffice nicht enthal-

ten. 

Wenn Sie, wie im vorherigen Abschnitt beschrieben, Szenarien angelegt haben, 

können Sie diese jederzeit anzeigen. 

Gehen Sie dazu wie folgt vor: 

1. Rufen Sie den Befehl Weiteres > Szenarien auf. 

2. Wählen Sie das anzuzeigende Szenario in der Liste Szenarien. 
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3. Klicken Sie auf Anzeigen. 

Tipp: Schneller geht dies, wenn Sie in der Liste einfach einen Doppelklick 

auf das anzuzeigende Szenario durchführen. 

Das gewählte Szenario wird nun angezeigt.  

Durch das Wechseln zwischen verschiedenen Szenarien können Sie nun also ver-

gleichen, wie sich das Ändern der im Szenario festgelegten Zellen jeweils auf die 

Berechnungen auswirkt, die sich auf diese Zellen beziehen. 

Hinweis: Beim Anzeigen eines Szenarios werden die Werte in den angegebenen 

„veränderbaren Zellen“ physikalisch durch die Werte ersetzt, die im Szenario fest-

gelegt wurden. Die alten Zellinhalte gehen für diese Zellen also verloren. 

Verwalten von Szenarien 

FreeOffice: Die Funktion Szenarien ist in SoftMaker FreeOffice nicht enthal-

ten. 

Sie können den Menübefehl Weiteres > Szenarien auch verwenden, um die im 

aktuellen Arbeitsblatt angelegten Szenarien zu verwalten.  

Verwenden Sie dazu die folgenden Schaltflächen im Dialogfenster für diesen Be-

fehl: 

 Hinzufügen 

 Legt ein neues Szenario an. 

 Siehe dazu Abschnitt „Erstellen von Szenarien“ (Seite 130). 

 Löschen 

 Löscht das momentan in der Liste gewählte Szenario. 

 Bearbeiten 

 Öffnet einen Dialog, in dem Sie die Einstellungen für das gewählte Szenario 

bearbeiten können. Wenn Sie darin auf die Schaltfläche Weiter klicken, er-

scheint ein weiterer Dialog, in dem Sie die Werte für die veränderbaren Zellen 

ändern können. 
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 Zusammenführen 

 Führt Szenarien, die sich in anderen Arbeitsblättern (oder Arbeitsmappen) be-

finden, auf dem aktuellen Arbeitsblatt zusammen.  

 Siehe dazu Abschnitt „Zusammenführen von Szenarien“ (Seite 133). 

 Zusammenfassung 

 Erstellt einen Bericht, in dem die Werte in den veränderbaren Zellen und die 

Werte in beliebigen „Ergebniszellen“ für alle Szenarien direkt miteinander ver-

glichen werden können. 

 Siehe dazu Abschnitt „Anlegen eines Szenarioberichts“ (Seite 134). 

Zusammenführen von Szenarien 

FreeOffice: Die Funktion Szenarien ist in SoftMaker FreeOffice nicht enthal-

ten. 

Sie können den Menübefehl Weiteres > Szenarien auch verwenden, um Szenari-

en, die sich in anderen Arbeitsblättern (oder gar anderen Arbeitsmappen) befinden, 

auf dem aktuellen Arbeitsblatt zusammenzuführen. 

Hinweis: Damit dies funktioniert, sollten alle Arbeitsblätter, deren Szenarien Sie 

zusammenführen möchten, den gleichen Aufbau haben und in ihren Szenarien 

die gleichen veränderbaren Zellen verwenden. 

Um Szenarien zusammenzuführen, gehen Sie wie folgt vor: 

1. Öffnen Sie die Arbeitsmappen, in denen sich die Szenarien befinden, die Sie 

zusammenführen möchten. 

2. Wechseln Sie zu der Arbeitsmappe und dem Arbeitsblatt, auf dem die Szenarien 

zusammengeführt werden sollen. 

3. Rufen Sie den Menübefehl Weiteres > Szenarien auf. 

4. Klicken Sie auf Zusammenführen. 

5. Wählen Sie die Arbeitsmappe und das Arbeitsblatt, auf dem sich die gewünsch-

ten Szenarien befinden. 

6. Bestätigen Sie mit OK. 
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7. Wiederholen Sie die Schritte 4. bis 6. für alle weiteren Szenarien, die Sie zu-

sammenführen möchten. 

Alle gewählten Szenarien stehen nun auf dem aktuellen Arbeitsblatt zur Verfügung.  

Anlegen eines Szenarioberichts 

FreeOffice: Die Funktion Szenarien ist in SoftMaker FreeOffice nicht enthal-

ten. 

Sie können den Menübefehl Weiteres > Szenarien auch verwenden, um einen 

Szenariobericht für alle im aktuellen Arbeitsblatt vorhandenen Szenarien anzule-

gen.  

Ein Szenariobericht listet alle Szenarien übersichtlich nebeneinander auf. Für jedes 

Szenario werden sowohl die veränderbaren Zellen als auch beliebige „Ergebniszel-

len“ (mit den Berechnungen, die Sie betrachten möchten) angezeigt. 

Solche Berichte sind nützlich, um die veränderbaren Werte und die resultierenden 

Ergebnisse von Szenarien auf einen Blick miteinander vergleichen zu können. 

Um einen Szenariobericht zu erzeugen, gehen Sie wie folgt vor: 

1. Legen Sie, wie im Abschnitt „Erstellen von Szenarien“ beschrieben, die ge-

wünschten Szenarien an. 

2. Rufen Sie den Menübefehl Weiteres > Szenarien auf. 

3. Klicken Sie auf Zusammenfassung. 

4. Geben Sie die Adresse der gewünschten Ergebniszelle ein. Das ist eine beliebi-

ge Zelle mit der Berechnung, die Sie in Ihren Szenarien betrachten möchten. 

 Sie können auch mehrere Zellen angeben. Trennen Sie die Zelladressen dazu 

mit einem Strichpunkt – zum Beispiel: A2;A4;A10. Auch Zellbereiche wie 

B5:B10 sind erlaubt. 

5. Bestätigen Sie mit OK. 

PlanMaker legt nun ein neues Arbeitsblatt an und erzeugt dann darin den Szena-

riobericht. 
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Hinweis: Szenarioberichte werden nicht automatisch aktualisiert, wenn Sie Zell-

inhalte oder die Einstellungen von Szenarien verändern. Um einen Szenariobe-

richt zu aktualisieren, löschen Sie das Arbeitsblatt, das den Bericht enthält, und 

erzeugen den Bericht dann noch einmal. 

Konsolidieren von Daten 

FreeOffice: Die Funktion Daten konsolidieren ist in SoftMaker FreeOffice 

nicht enthalten. 

Mit dem Menübefehl Arbeitsblatt > Daten konsolidieren können Sie Daten aus 

einem oder mehreren Zellbereichen auswerten, um beispielsweise die Summe der 

einzelnen Daten über all diese Bereiche hinweg zu ermitteln. 

Dafür legen Sie zunächst die „Quellbereiche“ für die Konsolidierung fest. Dies 

können beliebige Zellbereiche mit den auszuwertenden Daten sein. Sie können sich 

allesamt im aktuellen Arbeitsblatt befinden, oder auf mehrere Arbeitsblätter oder 

gar mehrere Dateien verteilt sein. Für die Auswertung steht eine Vielzahl von Sta-

tistikfunktionen zur Verfügung: Summe, Minimum, Durchschnitt etc. 

Das Ergebnis der Auswertung wird – als feste Zahlenwerte – in den angegebenen 

„Zielbereich“ eingefügt. Beachten Sie: Diese Werte werden nicht aktualisiert, wenn 

sich an den Zahlen in den Quellbereichen etwas ändert. Dieser Befehl ist also in 

erster Linie dann nützlich, wenn man den aktuellen Stand von Daten auswerten und 

Änderungen nicht mehr berücksichtigen möchte (z.B. bei Monatsberichten etc.). 
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In diesem Abschnitt erfahren Sie alles Wissenswerte zum Arbeiten mit Konsolidie-

rungen. Folgende Themen werden darin behandelt: 

 Konsolidieren von Daten anhand ihrer Position 

 Im einfachsten Fall werden Daten anhand ihrer Position konsolidiert. Dies 

funktioniert wie folgt:  

 Sie haben z.B. drei Quellbereiche, die alle identisch aufgebaut und gleich groß 

sind. In jedem der Bereiche befinden sich die einzelnen Daten also jeweils an 

der gleichen (relativen) Position. 

 Beim Konsolidieren wird nun die erste Zelle (links oben) im ersten Bereich zur 

ersten Zelle im zweiten und dritten Bereich addiert. Das Ergebnis erscheint als 

erste Zelle im Zielbereich. Dann wird das gleiche mit allen anderen Zellen in 

den Quellbereichen durchgeführt. 

 Konsolidieren von Daten anhand ihrer Beschriftungen 

 Darüber hinaus kann diese Funktion auch nach Beschriftungen konsolidieren. 

Dies funktioniert wie folgt:  

 Es können ein oder mehrere Quellbereiche vorliegen, die eines gemein haben: 

Jeder einzelne Wert ist mit einer Beschriftung versehen – beispielsweise in der 

Zelle links von ihm.  
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 Wenn Sie nun beim Konsolidieren die Option Beschriftungen in linker Spalte 

einschalten, addiert PlanMaker alle Werte, bei denen sich links die gleiche Be-

schriftung befindet.  

 Dabei darf die gleiche Beschriftung beliebig oft vorkommen. Die Größe der 

Quellbereiche und die Reihenfolge der Daten spielen keine Rolle. PlanMaker 

erkennt schließlich anhand der Beschriftungen, welche Werte addiert werden 

sollen. 

 Bearbeiten und Aktualisieren von Konsolidierungen 

 Wenn Sie mit dem Menübefehl Arbeitsblatt > Daten konsolidieren eine Kon-

solidierung durchführen, merkt sich PlanMaker alle Einstellungen, die Sie im 

Konsolidieren-Dialog vorgenommen haben (und zwar pro Arbeitsblatt). 

 Dies ermöglicht es Ihnen, diesen Befehl jederzeit erneut aufzurufen, gegebe-

nenfalls Einstellungen für die Konsolidierung zu ändern und diese dann erneut 

durchzuführen.  

Ausführliche Informationen zu diesen Themen finden Sie, in obiger Reihenfolge, 

auf den nächsten Seiten. 

Konsolidieren von Daten anhand ihrer Position 

FreeOffice: Die Funktion Daten konsolidieren ist in SoftMaker FreeOffice 

nicht enthalten. 

Wie in der Einleitung des Abschnitts „Konsolidieren von Daten“ (Seite 135) erläu-

tert, können Sie mit dem Befehl Daten konsolidieren Daten aus einem oder meh-

reren Zellbereichen konsolidieren – diese Daten also auswerten und beispielsweise 

die Summe der einzelnen Daten ermitteln. 

Im einfachsten Fall werden Daten anhand ihrer Position konsolidiert. Dies funktio-

niert wie folgt:  

Sie haben z.B. drei „Quellbereiche“, die alle identisch aufgebaut und gleich groß 

sind. In jedem der Bereiche befinden sich die einzelnen Daten also jeweils an der 

gleichen (relativen) Position. 

Beim Konsolidieren wird nun die erste Zelle (links oben) im ersten Bereich zur 

ersten Zelle im zweiten und dritten Bereich addiert. Das Ergebnis erscheint als 

erste Zelle im „Zielbereich“. Dann wird das gleiche mit allen anderen Zellen in den 

Quellbereichen durchgeführt. 
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Beispiel 

Die Tageserlöse zweier Obstläden sollen, aufgeteilt nach Obstsorten, mittels Sum-

menfunktion konsolidiert werden.  

 

Dazu wurden die Erlöse der beiden Läden in eine Tabelle eingetragen. In der Ab-

bildung sieht man diese Daten in den Zellbereichen C3:C5 und C8:C10. 

Dann wurde der Befehl Daten konsolidieren aufgerufen und diese beiden Berei-

che als Quellbereiche hinzugefügt. Der Zielbereich wurde auf C13:C15 gesetzt (in 

der Abbildung selektiert) und die Konsolidierung gestartet.  

Ergebnis: Im Zielbereich erscheinen die Summen der Tageserlöse (ebenfalls wieder 

pro Obstsorte, genau wie in den Quellbereichen). 

Durchführen der Konsolidierung 

Um Daten anhand ihrer Position zu konsolidieren, gehen Sie im Einzelnen wie 

folgt vor: 

1. Tragen Sie die zu konsolidierenden Daten in einzelne Zellbereiche ein, die alle-

samt gleich aufgebaut sind. Die Daten müssen also in jedem dieser Bereiche 

gleich angeordnet sein. 
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 Die einzelnen Zellbereiche können sich alle auf dem gleichen Arbeitsblatt, in 

mehreren Arbeitsblättern oder sogar in mehreren unterschiedlichen Dokumen-

ten befinden. 

2. Rufen Sie den Menübefehl Arbeitsblatt > Daten konsolidieren auf. 

3. Klicken Sie in das Eingabefeld Quellbereiche. Tragen Sie dort die Adresse des 

ersten Zellbereichs mit den zu konsolidierenden Daten ein. (Siehe auch Anmer-

kungen weiter unten.) 

 Tipp: Alternativ können Sie auch von dem Dialog aus in die Tabelle klicken 

und den Zellbereich darin einfach mit der Maus selektieren. 

4. Klicken Sie auf die Schaltfläche Hinzufügen. 

5. Um weitere Zellbereiche zu den Quellbereichen hinzuzufügen, wiederholen Sie 

die Schritte 3. und 4.  

6. Tragen Sie bei Zielbereich die Adresse des Zellbereichs ein, in dem das Ergeb-

nis der Konsolidierung erscheinen soll. 

 Tipp: Es genügt, die Adresse der Zelle anzugeben, in der sich die linke obere 

Ecke des Zielbereichs befinden soll. PlanMaker ermittelt die korrekte Größe 

dann automatisch. 

 Tipp: Sie können die gewünschte Zelle auch einfach in der Tabelle anklicken, 

um ihre Adresse in den Dialog zu übertragen. 

7. Wählen Sie bei Funktion, welche Rechenfunktion für die Konsolidierung ver-

wenden werden soll. 

8. Die Optionen Beschriftung in... müssen bei dieser Art der Konsolidierung un-

bedingt ausgeschaltet bleiben. (Mehr zu diesen Optionen im Abschnitt 

„Konsolidieren von Daten anhand ihrer Beschriftungen“, Seite 141.) 

9. Klicken Sie auf Anwenden, um den Vorgang zu starten. 

Die Daten aus den Quellbereichen werden nun mit der gewählten Rechenfunktion 

konsolidiert, und das Ergebnis wird im Zielbereich eingefügt. 

Hinweis: Das Ergebnis der Konsolidierung wird in Form von festen Zahlenwer-

ten eingefügt. Diese werden nicht aktualisiert, wenn sich an den Werten in den 

Quellbereichen etwas ändert.  

Dieser Befehl ist also in erster Linie dann nützlich, wenn man den aktuellen 

Stand der Daten auswerten und Änderungen nicht mehr berücksichtigen möchte 

(z.B. bei Monatsberichten). Siehe auch Abschnitt „Bearbeiten und Aktualisieren 

von Konsolidierungen“, Seite 144. 
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Anmerkungen zum Festlegen der Quellbereiche 

Wenn Sie im oben beschrieben Dialogfenster in das Eingabefeld Quellbereiche 

klicken, haben Sie folgende Möglichkeiten, einen Quellbereich hinzuzufügen: 

 Quellbereich im aktuellen Arbeitsblatt 

 Wenn Sie einen Zellbereich zu den Quellbereichen hinzufügen möchten, der 

sich im aktuellen Arbeitsblatt befindet, geben Sie einfach dessen Adresse oder 

Namen ein.  

 Beispiel: D2:G5 

 Tipp: Alternativ können Sie auch von dem Dialog aus in die Tabelle klicken 

und den Zellbereich darin mit der Maus selektieren.  

 Quellbereich in einem anderen Arbeitsblatt 

 Wenn Sie einen Zellbereich hinzufügen möchten, der sich in einem anderen 

Arbeitsblatt befindet, stellen Sie der Adresse wie üblich den Namen des Ar-

beitsblatts und ein Ausrufezeichen voran. 

 Beispiel: Tabelle3!D2:G5 

 Tipp: Auch hier können Sie den Zellbereich einfach mit der Maus selektieren. 

Klicken Sie zuvor im Arbeitsblattregister auf das gewünschte Arbeitsblatt. 

 Quellbereich in einem anderen Dokument 

 Wenn Sie einen Zellbereich hinzufügen möchten, der sich in einem anderen 

Dokument befindet, tragen Sie dessen Adresse so ein, wie es im Abschnitt 

„Externe Zellbezüge“ ab Seite 510 beschrieben wurde. 

 Beispiel: 'C:\Mein Verzeichnis\[Meine Arbeitsmappe.pmdx]Tabelle3'!D2:G5 

 Tipp: Den ersten Teil der Adresse, der den Pfad und Dateinamen enthält, brau-

chen Sie nicht von Hand einzugeben. Klicken Sie einfach auf die Schaltfläche 

Datei, worauf ein Dateidialog erscheint, in dem Sie die gewünschte Datei aus-

wählen können. 

Vergessen Sie nicht, nach dem Eingeben der Adresse für einen Quellbereich je-

weils auf Hinzufügen zu klicken. 
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Konsolidieren von Daten anhand ihrer Beschriftungen  

FreeOffice: Die Funktion Daten konsolidieren ist in SoftMaker FreeOffice 

nicht enthalten. 

Wie in der Einleitung des Abschnitts „Konsolidieren von Daten“ (Seite 135) erläu-

tert, können Sie mit dem Befehl Daten konsolidieren Daten aus einem oder meh-

reren Zellbereichen konsolidieren – diese Daten also auswerten und beispielsweise 

die Summe der einzelnen Daten ermitteln. 

Neben dem Konsolidieren von Daten anhand ihrer Position (siehe vorheriger Ab-

schnitt) lassen sich Daten auch anhand ihrer Beschriftungen konsolidieren. Dies 

funktioniert wie folgt: 

Die auszuwertenden Daten können in beliebig vielen „Quellbereichen“ abgelegt 

sein – die allesamt eines gemein haben sollten: Jeder darin enthaltene Wert ist mit 

einer Beschriftung versehen (beispielsweise in der Zelle links von ihm). 

Wenn Sie nun beim Konsolidieren die Option Beschriftungen in linker Spalte 

einschalten, addiert PlanMaker alle Werte, bei denen sich links die gleiche Be-

schriftung befindet.  

Dabei darf die gleiche Beschriftung beliebig oft vorkommen. Die Größe der ein-

zelnen Quellbereiche und die Reihenfolge der Daten darin spielen keinerlei Rolle. 

PlanMaker erkennt schließlich anhand der Beschriftungen, welche Daten konsoli-

diert werden sollen. 

Beispiel 

Ein Obststand bietet verschiedene Sorten Obst an. Jeder einzelne Verkauf im Laufe 

eines Tages wird in einer Tabelle erfasst. Nun soll ausgerechnet werden, wie viel 

insgesamt von jeder Obstsorte verkauft wurde. 
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Die einzelnen Obstsorten kommen hierbei natürlich in völlig zufälliger Reihenfol-

ge vor, aber das stört den Konsolidieren-Befehl überhaupt nicht: 

Rufen Sie einfach den Befehl Daten konsolidieren auf. Fügen Sie den Zellbereich 

mit den einzelnen Verkäufen als Quellbereich hinzu (hier also B3:C11). Beachten 

Sie: Dieser muss die Zahlen und deren Beschriftungen enthalten! Dann wählen Sie 

einen beliebigen Zielbereich für das Ergebnis (in der Abbildung B14:C16) und 

bestätigen. 

Ergebnis: Im Zielbereich erscheinen die Summen der Verkäufe der einzelnen Obst-

sorten. 

Durchführen der Konsolidierung 

Um Daten anhand ihrer Beschriftungen zu konsolidieren, gehen Sie wie im Einzel-

nen folgt vor: 

1. Tragen Sie die zu konsolidierenden Daten in einen oder mehrere Zellbereiche 

ein. Deren Aufbau und Größe spielt keine Rolle – allerdings sollten die zu kon-

solidierenden Werte allesamt eine Beschriftung haben: entweder in der Spalte 

links der Werte und/oder in der Zeile oberhalb der Werte. 
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 Die einzelnen Zellbereiche können sich alle auf dem gleichen Arbeitsblatt, in 

mehreren Arbeitsblättern oder sogar in mehreren unterschiedlichen Dokumen-

ten befinden. 

2. Rufen Sie den Menübefehl Arbeitsblatt > Daten konsolidieren auf. 

3. Klicken Sie in das Eingabefeld Quellbereiche. Tragen Sie dort die Adresse des 

Zellbereichs mit den zu konsolidierenden Daten ein. (Siehe auch Anmerkungen 

am Ende des vorherigen Abschnitts.) 

 Tipp: Alternativ können Sie auch von dem Dialog aus in die Tabelle klicken 

und den Zellbereich darin einfach mit der Maus selektieren. 

Wichtig: Jeder Quellbereich muss sowohl die auszuwertenden Daten selbst 

als auch deren Beschriftungen enthalten. Die Beschriftungen müssen sich in 

der äußersten linken Spalte oder in der obersten Zeile des Bereichs befinden. 

4. Klicken Sie auf die Schaltfläche Hinzufügen. 

5. Falls Sie weitere Zellbereiche zu den Quellbereichen hinzuzufügen möchten, 

wiederholen Sie die Schritte 3. und 4.  

6. Tragen Sie bei Zielbereich die Adresse des Zellbereichs ein, in dem das Ergeb-

nis der Konsolidierung erscheinen soll. 

 Tipp: Es genügt, die Adresse der Zelle anzugeben, in der sich die linke obere 

Ecke des Zielbereichs befinden soll. PlanMaker ermittelt die korrekte Größe 

dann automatisch. 

 Tipp: Sie können die gewünschte Zelle auch einfach in der Tabelle anklicken, 

um ihre Adresse in den Dialog zu übertragen. 

7. Wählen Sie bei Funktion, welche Rechenfunktion für die Konsolidierung ver-

wenden werden soll. 

8. Geben Sie bei den Optionen an, wo sich die Beschriftungen der Daten in den 

Quellbereichen befinden: 

 Beschriftungen in linker Spalte: Die Beschriftungen befinden sich jeweils in 

der äußersten linken Spalte der Quellbereiche. (Die zugehörigen Daten müssen 

dann direkt rechts daneben eingetragen sein.) 

 Beschriftungen in oberster Zeile: Die Beschriftungen befinden sich jeweils in 

der obersten Zeile der Quellbereiche. (Die zugehörigen Daten müssen dann di-

rekt darunter eingetragen sein.) 
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 Sie können auch beide Optionen aktivieren, falls Sie Quellbereiche auswerten 

möchten, bei denen sich Beschriftungen in der äußersten linken Spalte und in 

der in der obersten Zeile befinden. 

 Wenn Sie die Option Beschriftungen sortieren einschalten, werden die Ergeb-

nisse der Konsolidierung im Zielbereich nach Beschriftungen sortiert eingetra-

gen. 

9. Klicken Sie auf Anwenden, um den Vorgang zu starten. 

Die Daten aus den Quellbereichen werden nun mit der gewählten Rechenfunktion 

konsolidiert, und das Ergebnis wird im Zielbereich eingefügt. 

Hinweis: Das Ergebnis der Konsolidierung wird in Form von festen Zahlenwer-

ten eingefügt. Diese werden nicht aktualisiert, wenn sich an den Werten in den 

Quellbereichen etwas ändert.  

Dieser Befehl ist also in erster Linie dann nützlich, wenn man den aktuellen 

Stand der Daten auswerten und Änderungen nicht mehr berücksichtigen möchte 

(z.B. bei Monatsberichten etc.). Siehe auch Abschnitt „Bearbeiten und Aktuali-

sieren von Konsolidierungen“, Seite 144. 

Bearbeiten und Aktualisieren von Konsolidierungen 

FreeOffice: Die Funktion Daten konsolidieren ist in SoftMaker FreeOffice 

nicht enthalten. 

Wenn Sie mit dem Befehl Daten konsolidieren eine Konsolidierung durchführen, 

merkt sich PlanMaker alle Einstellungen, die Sie im Konsolidieren-Dialog vorge-

nommen haben (und zwar pro Arbeitsblatt).  

Dies ermöglicht es Ihnen, diesen Befehl jederzeit erneut aufzurufen, gegebenen-

falls Einstellungen für die Konsolidierung zu ändern und diese dann erneut durch-

zuführen.  

Tipp: Die Einstellungen werden sogar im Dokument gespeichert, sodass sich 

PlanMaker auch beim nächsten Öffnen des Dokuments wieder darin erinnert.  

(Kleine Einschränkung: Der Zielbereich wird in xls-Dateien nicht gespeichert; 

da dieses Dateiformat das nicht unterstützt. Bei xlsx-Dateien, pmd-Dateien und 

pmdx-Dateien funktioniert es aber.) 
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Einstellungen bearbeiten und Konsolidierung erneut durchführen 

Um die Einstellungen für eine Konsolidierung zu bearbeiten und ihr aktualisiertes 

Ergebnis erneut einzufügen, gehen Sie wie folgt vor: 

1. Rufen Sie den Menübefehl Arbeitsblatt > Daten konsolidieren auf. 

2. Nehmen Sie die gewünschten Änderungen an den Einstellungen für die Konso-

lidierung vor. Sie können auch neue Quellbereiche hinzufügen oder vorhandene 

entfernen. 

3. Klicken Sie auf die Schaltfläche Anwenden, um die Änderungen zu überneh-

men und die Konsolidierung erneut durchzuführen. 

Die Konsolidierung auf dem aktuellen Arbeitsblatt wird nun erneut durchgeführt 

und ihr aktualisiertes Ergebnis wird in den Zielbereich eingefügt. Die alten Daten 

werden dabei überschrieben. 

Konsolidierung aktualisieren 

Wenn Sie eine Konsolidierung einfach nur aktualisieren möchten (ohne Einstellun-

gen zu ändern), gehen Sie wie folgt vor: 

1. Rufen Sie den Menübefehl Arbeitsblatt > Daten konsolidieren auf. 

2. Klicken Sie auf die Schaltfläche Anwenden. 

Die Konsolidierung auf dem aktuellen Arbeitsblatt wird nun, mit genau den glei-

chen Einstellungen wie beim letzten Mal, erneut durchgeführt. 

Tabellen in Tabellen 

FreeOffice: Das Anlegen von Tabellen in Tabellen ist in SoftMaker FreeOffice 

nicht enthalten. 

Mit dem Menübefehl Arbeitsblatt > Neue Tabelle können Sie „Tabellen“ in ei-

nem Arbeitsblatt anlegen – sozusagen also „Tabellen in Tabellen“.  
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Anmerkung: Dass dieses Feature „Tabellen“ genannt wird, ist zunächst natürlich 

verwirrend, da „Tabellen“ ja eigentlich der Oberbegriff für das ist, was Sie in ei-

ner Tabellenkalkulation bearbeiten. Nachdem jedoch Microsoft dieses Feature in 

Excel als „Tabellen“ bezeichnet, haben wir uns entschlossen, in PlanMaker aus 

Kompatibilitätsgründen den gleichen Begriff zu verwenden. 

Was aber macht dieses Feature nun genau? 

Wenn Sie einen Zellbereich markieren und dann den Menübefehl Arbeitsblatt > 

Neue Tabelle aufrufen, wird für diesen Zellbereich eine „Tabelle“ angelegt.  

Dies hat folgende Auswirkungen auf den Zellbereich: 

 Automatische Formatierung mit einer „Tabellenvorlage“ 

 Der markierte Zellbereich wird automatisch mit einer Tabellenvorlage forma-

tiert. Die Standardvorlage bringt abwechselnd eine blaue und weiße Schattie-

rung an den Zellen an. Sie können aber blitzschnell auf eine andere Vorlage 

wechseln und somit die Formatierung der gesamten „Tabelle“ auf Knopfdruck 

ändern. 

 Automatisches Anbringen eines Autofilters 

 Außerdem wird der Zellbereich, aus dem die „Tabelle“ erzeugt wurde, automa-

tisch mit einem Autofilter versehen. Sie erkennen das an den kleinen Pfeilchen 

neben den Spaltenüberschriften der Tabelle. Klicken Sie eines der Pfeilchen an, 

erscheint ein Menü, mit dem Sie einen Filter auf die Zellinhalte der zugehöri-

gen Spalte setzen können.  

 Ergebniszeile 

 Für Tabellen lässt sich zudem eine Ergebniszeile aktivieren, die unterhalb der 

Tabelle angezeigt wird. In dieser lassen sich zusammenfassende Berechnungen 

durchführen (zum Beispiel die Summe von Spalten). 

 Besondere Zellbezüge 

 Das Anlegen von „Tabellen“ in einem Arbeitsblatt erlaubt auch das Verwenden 

besonderer Zellbezüge. So lassen sich die Zellinhalte in einer Spalte einer Ta-

belle beispielsweise über ihre Spaltenüberschrift ansprechen – zum Beispiel:  

 =SUMME(Tabelle3[Frühling]) 

Auf den nächsten Seiten erfahren Sie alles Wissenswerte zu dem „Tabellen“-

Feature. Folgende Themen werden darin behandelt: 
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 Tabellen in Tabellen anlegen 

 Tabellen in Tabellen entfernen 

 Tabellen in Tabellen bearbeiten 

 Tabellen in Tabellen formatieren 

 Verwenden der Ergebniszeile von Tabellen in Tabellen 

 Tabellen in Tabellen und Zellbezüge 

Lesen Sie dazu die nächsten Seiten. 

Tabellen in Tabellen anlegen 

FreeOffice: Das Anlegen von Tabellen in Tabellen ist in SoftMaker FreeOffice 

nicht enthalten. 

Wie weiter oben in der Einleitung des Abschnitts „Tabellen in Tabellen“ beschrie-

ben, bietet Ihnen der Menübefehl Arbeitsblatt > Neue Tabelle die Möglichkeit, in 

Ihren Arbeitsblättern „Tabellen in Tabellen“ zu verwenden. Hier erfahren Sie, wie 

Sie solche Tabellen erzeugen:  

Zum Anlegen von „Tabellen in Tabellen“ gehen Sie wie folgt vor: 

1. Optional: Tragen Sie in einen zusammenhängenden Zellbereich die Daten ein, 

aus denen Sie eine Tabelle anlegen möchten. 

Tipp: Es ist hilfreich, wenn Sie diesen Zellbereich in seiner ersten Zeile mit 

Spaltenüberschriften für die jeweilige Spalte darunter versehen. (Ist das nicht 

der Fall, erzeugt PlanMaker automatische Überschriften wie Spalte1, Spalte2 

etc.)  

2. Markieren Sie den Zellbereich (inklusive Spaltenüberschriften). 

3. Rufen Sie den Menübefehl Arbeitsblatt > Neue Tabelle auf. 

4. Es erscheint ein Dialog mit folgenden Optionen: 

 Quellbereich: Der Zellbereich, aus dem die Tabelle erzeugt werden soll. Vor-

gegeben ist der Bereich, den Sie vor dem Aufruf des Befehls markiert hatten. In 

der Regel müssen Sie diesen also nur bestätigen.  

 Quellbereich enthält Überschriften: Hier können Sie angeben, ob die erste 

Zeile des Quellbereichs aus Spaltenüberschriften für die Zellinhalte darunter 
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besteht, wie oben empfohlen. Wenn Sie die Option ausschalten, generiert 

PlanMaker automatische Spaltenüberschriften wie Spalte1, Spalte2 etc. 

Sobald Sie den Dialog bestätigen, wird eine „Tabelle“ für den Quellbereich ange-

legt. Genauer gesagt, passiert dabei folgendes: 

 An den Zellen und Zellinhalten selbst ändert sich nichts 

 Die Zellen im Quellbereich bleiben auch nach dem Anlegen einer Tabelle ganz 

normale Tabellenzellen. Sie können deren Inhalte also nach Belieben bearbei-

ten, formatieren etc. 

 Automatische Formatierung mit einer „Tabellenvorlage“ 

 Es fällt allerdings sofort auf, dass die Zellen im Quellbereich automatisch um-

formatiert wurden: Standardmäßig wird die erste Zeile (also die Spaltenüber-

schriften) mit einem mittelblauen Hintergrund versehen, die Zeilen darunter 

werden abwechselnd hellblau und weiß schattiert.  

 Diese automatische Formatierung erfolgt über eine sogenannte Tabellenvorla-

ge. Wenn Sie eine Tabelle anlegen, wird diese automatisch mit dem Standard-

Tabellenstil umformatiert. Alternativ stehen zahlreiche weitere Tabellenvorla-

gen mit unterschiedlichen Farben und Stilen zur Verfügung. Mit dem Menübe-

fehl Arbeitsblatt > Tabelle > Tabelleneigenschaften können Sie jederzeit auf 

eine andere Vorlage wechseln. 

 Automatisches Anbringen eines Autofilters 

 Außerdem sehen Sie neben jeder der Spaltenüberschriften in der ersten Zeile 

einen kleinen Pfeil. Dabei handelt es sich um einen Autofilter, der automatisch 

auf den Quellbereich Ihrer Tabelle angewandt wurde.  

 Standardmäßig ist dieser Filter ausgeschaltet; es werden also alle Daten ange-

zeigt. Wenn Sie eines der Pfeilchen anklicken, öffnet sich das Menü des Auto-

filters für die zugehörige Spalte. Darin können Sie nun verschiedene Arten von 

Filtern anwenden – oder gar eine Sortierung der Daten in der Tabelle durchfüh-

ren. 

 Ausführliche Informationen zur Verwendung von Autofiltern finden Sie im Ab-

schnitt „AutoFilter“ (Seite 111). 

Tabellen in Tabellen entfernen 

Wie in der Einleitung des Abschnitts „Tabellen in Tabellen“ (Seite 145) beschrie-

ben, bietet Ihnen der Menübefehl Arbeitsblatt > Neue Tabelle die Möglichkeit, 
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„Tabellen in Tabellen“ anzulegen. Hier erfahren Sie, wie Sie solche Tabellen wie-

der entfernen können:  

Es gibt dafür folgende Möglichkeiten: 

A) Tabelle zurück in einen normalen Zellbereich verwandeln 

Um eine Tabelle wieder in einen „gewöhnlichen“ Zellbereich zurückzuwandeln, 

bewegen Sie den Zellrahmen auf eine beliebige Zelle innerhalb der Tabelle und 

rufen dann den Menübefehl Arbeitsblatt > Tabelle > In Bereich konvertieren 

auf.  

Die „Magie“ des Tabellen-Features wird daraufhin von allen Zellen dieser Tabelle 

entfernt – inklusive der automatischen Formatierung und des Autofilters. 

B) Tabelle samt Inhalt löschen 

Um eine Tabelle samt aller Inhalte komplett zu löschen, bewegen Sie den Zellrah-

men auf eine beliebige Zelle innerhalb der Tabelle und rufen dann den Menübefehl 

Arbeitsblatt > Tabelle > Tabelle löschen auf.  

Die Tabelle wird daraufhin komplett gelöscht – inklusive aller Zellinhalte. 

Tabellen in Tabellen bearbeiten 

Wie in der Einleitung des Abschnitts „Tabellen in Tabellen“ (Seite 145) beschrie-

ben, bietet Ihnen der Menübefehl Arbeitsblatt > Neue Tabelle die Möglichkeit, 

„Tabellen in Tabellen“ anzulegen. Hier erfahren Sie, wie Sie solche Tabellen bear-

beiten können: 

Es gibt dafür folgende Möglichkeiten: 

Weitere Zeilen oder Spalten anfügen 

„Tabellen in Tabellen“ lassen sich sehr leicht um eine zusätzliche Zeile oder Spalte 

erweitern – und zwar auf folgende Arten: 

 Wenn Sie in eine Zelle, die sich direkt rechts neben der Tabelle befindet, einen 

Wert eingeben, erweitert sich diese Tabelle automatisch um die Spalte mit die-

sem Wert.  
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 Wenn Sie in eine Zelle, die sich direkt unterhalb der Tabelle befindet, einen 

Wert eingeben, erweitert sich die Tabelle automatisch um die Zeile mit diesem 

Wert. 

 (Hinweis: Dies funktioniert nur, wenn die „Ergebniszeile“ für diese Tabelle 

ausgeschaltet ist.) 

Tipp: Die obigen zwei Methoden zum Erweitern einer Tabelle lassen sich de-

aktivieren, falls dieses Verhalten nicht erwünscht ist. Schalten Sie dazu im 

Dialogfenster des Menübefehls Weiteres > Einstellungen auf der Karteikarte 

Bearbeiten die Option Tabellen automatisch erweitern aus. 

 Wenn Sie in der letzten Zelle einer Tabelle (der Zelle ganz rechts unten) die 

Tabulatortaste (Tab) betätigen, wird die Tabelle automatisch um eine Zeile er-

weitert. 

Größe der Tabelle ändern 

Sie können außerdem die Größe einer Tabelle jederzeit selbst ändern – und zwar 

auf folgende Arten: 

 In der rechten unteren Ecke einer Tabelle wird ein kleiner Pfeil angezeigt. 

Wenn Sie mit der Maus an diesem Pfeil ziehen, wird die Tabelle entsprechend 

vergrößert oder verkleinert. 

 Wenn Sie den Menübefehl Arbeitsblatt > Tabelle > Tabellenbereich aufrufen, 

erscheint ein Dialog, in dem Sie den Zellbereich, den die Tabelle umfasst, edi-

tieren können. 

Zeilen oder Spalten einfügen 

Um innerhalb einer Tabelle (und zwar nur dieser Tabelle) eine neue Zeile einzufü-

gen, gehen Sie wie folgt vor: 

1. Setzen Sie den Zellrahmen in die gewünschte Zeile in der Tabelle. 

2. Rufen Sie den Menübefehl Arbeitsblatt > Tabelle > Einfügen > Zeilen ober-

halb einfügen beziehungsweise Zeilen unterhalb einfügen auf.  

Die neue Zeile wird nun oberhalb beziehungsweise unterhalb der aktuellen Zeile in 

die Tabelle eingefügt. 

Hinweis: Diese beiden Befehle fügen die neue Zeile nur in die Tabelle selbst ein 

– nicht in die Zellen, die diese Tabelle umgeben.  
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Das Einfügen von neuen Spalten funktioniert entsprechend (mit den Befehlen Ar-

beitsblatt > Tabelle > Einfügen > Spalten links einfügen beziehungsweise Spal-

ten rechts einfügen). 

Zeilen oder Spalten löschen 

Zum Löschen einer Zeile aus einer Tabelle (und zwar nur dieser Tabelle) gehen Sie 

wie folgt vor: 

1. Setzen Sie den Zellrahmen in die Zeile in der Tabelle, die gelöscht werden soll. 

2. Rufen Sie den Menübefehl Arbeitsblatt > Tabelle > Löschen > Zeilen lö-

schen auf.  

Die Zeile wird nun (samt Inhalt) aus der Tabelle entfernt. 

Hinweis: Dieser Befehl entfernt die Zeile nur aus der Tabelle selbst – nicht aus 

den Zellen, die diese Tabelle umgeben.  

Das Löschen von Spalten funktioniert entsprechend (mit dem Befehl Arbeitsblatt 

> Tabelle > Löschen > Spalten löschen). 

Zellen in einer Tabelle selektieren 

Zellen in einer Tabelle können natürlich wie üblich mit Maus oder Tastatur selek-

tiert werden.  

Als zusätzlicher Helfer für das Selektieren innerhalb von Tabellen steht außerdem 

der Menübefehl Arbeitsblatt > Tabelle > Selektieren zur Verfügung. Dieser öffnet 

ein Untermenü mit folgenden Kommandos: 

 Zeilen selektieren: Selektiert die aktuelle Zeile in der Tabelle. 

 Spalten selektieren: Selektiert die aktuelle Spalte in der Tabelle. 

 Spaltendaten selektieren: Selektiert nur die Zellen in der aktuellen Spalte, die 

Daten enthalten. Spaltenüberschriften oder Zellen in der Ergebnisleiste werden 

also nicht selektiert. 

 Tabelle selektieren: Selektiert die gesamte Tabelle. 
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Tabellen in Tabellen formatieren 

Wie in der Einleitung des Abschnitts „Tabellen in Tabellen“ (Seite 145) beschrie-

ben, bietet Ihnen der Menübefehl Arbeitsblatt > Neue Tabelle die Möglichkeit, 

„Tabellen in Tabellen“ anzulegen. Hier erfahren Sie, wie Sie solche Tabellen for-

matieren und weitere Eigenschaften der Tabelle ändern können: 

Zunächst einmal lassen sich die Zellen in Tabellen, genau wie „gewöhnliche“ Zel-

len, mit dem kompletten Arsenal an Befehlen und Funktionen formatieren, die 

PlanMaker Ihnen auch sonst zur Verfügung stellt.  

Darüber hinaus gibt es speziell für Tabellen den Menübefehl Arbeitsblatt > Tabel-

le > Tabelleneigenschaften. Dieser bietet Formatierungsoptionen, die ausschließ-

lich auf Tabellen anwendbar sind.  

Sie können diesen Befehl wie folgt anwenden: 

1. Bewegen Sie den Zellrahmen auf eine beliebige Zelle innerhalb der Tabelle, die 

sie formatieren möchten. 

2. Rufen Sie im Menü den Befehl Arbeitsblatt > Tabelle > Tabelleneigenschaf-

ten auf. 

3. Es erscheint ein Dialog mit den nachfolgend beschriebenen Optionen. Nehmen 

Sie darin die gewünschten Einstellungen vor und bestätigen Sie dann mit OK. 

Folgende Einstellungen können in diesem Dialog vorgenommen werden:  

Eine andere Tabellenvorlage anwenden 

Auf der ersten Karteikarte des Dialogs finden Sie die Liste Vorlage. Darin können 

Sie eine andere Tabellenvorlage auf die Tabelle anwenden.  

Das Anbringen einer anderen Tabellenvorlage ändert das komplette Erscheinungs-

bild einer Tabelle. In erster Linie betrifft das die Farbgebung der Tabelle (über 

Schattierungen). Die kleinen Vorschaubilder in der Liste zeigen an, welche Farben 

in der jeweiligen Vorlage enthalten sind.  

Kopfzeile und Ergebniszeile ein- und ausblenden 

Unter der Liste Vorlage finden Sie weitere Einstellungen für das Erscheinungsbild 

der Tabelle. Die ersten beiden Optionen haben folgende Funktion: 
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 Kopfzeile 

 Schaltet die Kopfzeile oberhalb der Tabelle ein/aus. Diese zeigt Spaltenüber-

schriften für jede der Spalten darunter an.  

 Sie sehen in der Kopfzeile außerdem einen kleinen Pfeil neben jeder Spalten-

überschrift. Hierbei handelt es sich um den Autofilter, der automatisch auf jede 

Tabelle angewandt wird. Um Daten zu filtern, klicken Sie eines dieser Pfeil-

chen an. Es öffnet sich ein Menü, in dem Sie verschiedene Arten von Filtern auf 

die Werte in der zugehörigen Spalte setzen können. Informationen zur Verwen-

dung von Autofiltern finden Sie im Abschnitt „AutoFilter“ (Seite 111). 

 Ergebniszeile 

 Schaltet die Ergebniszeile unterhalb der Tabelle ein/aus. Diese zeigt zusammen-

fassende Berechnungen für die Spalten der Tabelle an.  

 Standardmäßig wird lediglich die Summe der Werte in der letzten Spalte ange-

zeigt. Über die kleinen Pfeilchen rechts neben jeder einzelnen Zelle der Ergeb-

niszeile können Sie aber Anpassungen vornehmen – und darin beispielsweise 

die Summe, den Mittelwert oder andere Berechnungen für beliebige Spalten der 

Tabelle anzeigen lassen. Mehr dazu im Abschnitt „Verwenden der Ergebniszeile 

von Tabellen in Tabellen“ (Seite 154). 

Weitere Formatierungsoptionen für Tabellenvorlagen 

Die weiteren Optionen auf der Karteikarte Vorlage dienen folgendem Zweck: 

 Gebänderte Zeilen und Gebänderte Spalten 

 Schaltet die abwechselnde farbige Schattierung für die Zeilen beziehungsweise 

Spalten der Tabelle ein oder aus. Deren Farbe ist in der Tabellenvorlage festge-

legt, die Sie ebenfalls in diesem Dialog einstellen können (siehe oben). 

 Erste Spalte und Letzte Spalte 

 Wenn Sie diese Option einschalten, werden die erste und/oder die letzte Spalte 

der Tabelle besonders hervorgehoben.  

 Bei den meisten Tabellenvorlagen geschieht dies durch Einschalten von Fett-

druck, bei manchen Vorlagen werden diese Spalten zusätzlich mit einem an-

dersfarbigen Hintergrund hervorgehen – dies hängt von der jeweiligen Tabel-

lenvorlage ab. 
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Erweiterte Eigenschaften auf der Karteikarte „Eigenschaften“ 

Auf der Karteikarte Eigenschaften des gleichen Dialogfensters finden Sie folgen-

de erweiterte Einstellungen für die Tabelle: 

 Name 

 Hier können Sie den Namen der Tabelle ändern.  

 Der Name einer Tabelle kann unter anderem in Zellverweisen verwendet wer-

den (siehe Abschnitt „Tabellen in Tabellen und Zellbezüge“ ab Seite 155). 

 Beachten Sie, dass es für Tabellennamen folgende Regeln gibt: 

 1. Tabellennamen müssen eindeutig sein. 

 2. Tabellennamen müssen mit einem Buchstaben oder Unterstrich beginnen. 

 3. Tabellennamen dürfen keine Leerzeichen und andere ungültige Zeichen ent-

halten. (Für maximale Kompatibilität mit anderen Programmen verwenden Sie 

vorzugsweise nur Buchstaben, Ziffern und Unterstriche.) 

 4. Tabellennamen dürfen nicht wie Zellverweise aufgebaut sein (z.B. A1). 

 Überschrift und Beschreibung 

 Hier können Sie eine Überschrift für die Tabelle und eine kurze Beschreibung 

für deren Inhalt eintragen.  

 Dies ist hilfreich für Menschen, die aufgrund eingeschränkter Sehfähigkeit spe-

zielle Werkzeuge wie einen Screenreader verwenden, um sich die einzelnen Be-

standteile des Arbeitsblatts vorlesen zu lassen.  

Verwenden der Ergebniszeile von Tabellen in Tabellen 

Wie in der Einleitung des Abschnitts „Tabellen in Tabellen“ (Seite 145) beschrie-

ben, bietet Ihnen der Menübefehl Arbeitsblatt > Neue Tabelle die Möglichkeit, 

„Tabellen in Tabellen“ anzulegen. Hier erfahren Sie, was es mit der sogenannten 

„Ergebniszeile“ solcher Tabellen auf sich hat und wie Sie diese anpassen können: 

Ein weiterer Vorteil von „Tabellen in Tabellen“ ist nämlich die Möglichkeit, auf 

Wunsch eine Ergebniszeile mit zusammenfassenden Berechnungen anzeigen zu 

lassen. Sie können die Ergebniszeile jederzeit ein- oder ausschalten. Wenn sie ein-

geschaltet ist, erscheint sie in Form einer zusätzlichen Zeile unterhalb der Tabelle.  

Standardmäßig zeigt die Ergebniszeile lediglich links den Text „Ergebnis“ und 

rechts die Summe der Werte der Spalte ganz rechts in der Tabelle an. Sie können 
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darin aber auch andere Berechnungen vornehmen, indem Sie die Ergebniszeile 

bearbeiten (siehe unten). 

Ergebniszeile ein-/ausschalten 

Um die Ergebniszeile für eine Tabelle einzuschalten, gehen Sie wie folgt vor: 

1. Bewegen Sie den Zellrahmen auf eine beliebige Zelle innerhalb der Tabelle. 

2. Rufen Sie im Menü den Befehl Arbeitsblatt > Tabelle > Tabelleneigenschaf-

ten auf. 

3. Schalten Sie die Option Ergebniszeile auf der Karteikarte Vorlage ein. Bestä-

tigen Sie dann mit OK. 

Die Ergebniszeile wird nun unter der Tabelle angezeigt. 

Wenn Sie die Ergebniszeile wieder deaktivieren möchten, schalten Sie diese Opti-

on wieder aus. 

Ergebniszeile bearbeiten 

Standardmäßig zeigt die Ergebniszeile nur den Text „Ergebnis“ sowie die Summe 

der Werte der Spalte ganz rechts in der Tabelle an. 

Sie können dies jedoch nach Belieben anpassen. Die Zellen in der Ergebniszeile 

lassen sich bearbeiten wie jede andere Zelle in einem Arbeitsblatt auch, Sie können 

hier also jederzeit eigene Formeln oder Text eintragen.  

Für das Einfügen geeigneter Berechnungen gibt es ein kleines Helferlein: Wenn Sie 

den Zellrahmen auf eine der Zellen in der Ergebniszeile setzen, erscheint neben 

dieser Zelle ein kleiner Pfeil. Klicken Sie diesen an, öffnet sich ein Menü mit ver-

schiedenen Statistikfunktionen zur Wahl. Wenn Sie hier beispielsweise die Funkti-

on „Summe“ auswählen, fügt PlanMaker in die Zelle eine Formel ein, die die 

Summe der entsprechenden Spalte berechnet. 

Tabellen in Tabellen und Zellbezüge 

Wie in der Einleitung des Abschnitts „Tabellen in Tabellen“ (Seite 145) beschrie-

ben, bietet Ihnen der Menübefehl Arbeitsblatt > Neue Tabelle die Möglichkeit, 

„Tabellen in Tabellen“ anzulegen. Hier erfahren Sie, welche Besonderheiten es 

beim Verwenden von Zellbezügen auf die Zellen in einer solchen Tabelle es gibt: 
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Abgesehen von den üblichen Zellbezügen lassen sich Tabellen und deren Inhalte 

nämlich auch mit Namen und speziellen Bezeichnern ansprechen: 

Namen verwenden 

Namen in Zellbezügen auf Tabelleninhalte können wie folgt verwendet werden: 

 Tabellen über ihren Namen ansprechen 

 Wenn Sie in einem Zellbezug den Namen einer Tabelle verwenden, steht dieser 

stellvertretend für die entsprechende Tabelle (mit all ihren Zellen, außer den 

Spaltenüberschriften und der Ergebniszeile). 

 =SUMME(Tabelle3) liefert beispielsweise die Gesamtsumme aller Zellen in 

der Tabelle namens „Tabelle3“. 

 Tipp: Den Namen einer Tabelle können Sie über den Menübefehl Arbeitsblatt 

> Tabelle > Tabelleneigenschaften ändern (Karteikarte Eigenschaften). 

 Tabellenspalten über ihre Spaltenüberschrift ansprechen 

 Um eine einzelne Spalte einer Tabelle in einem Zellbezug anzusprechen, tippen 

Sie den Namen der Tabelle ein, gefolgt von der Spaltenüberschrift der ge-

wünschten Spalte in eckigen Klammern. 

 =SUMME(Tabelle3[Frühling]) liefert beispielsweise die Summe aller Zellen 

in der Spalte mit der Spaltenüberschrift „Frühling“ in der Tabelle namens „Ta-

belle3“. 

 Mehrere zusammenhängende Tabellenspalten ansprechen 

 Sie können auch mehrere zusammenhängende Spalten ansprechen. Verwenden 

Sie dazu die Schreibweise [[Startspalte]:[Zielspalte]]. 

 =SUMME(Tabelle3[[Frühling]:[Herbst]]) liefert beispielsweise die Summe 

aller Zellen in den Spalten „Frühling“ bis „Herbst“ in dieser Tabelle. 

 Mehrere nicht zusammenhängende Tabellenspalten ansprechen 

 Um nicht zusammenhängende Spalten anzusprechen, trennen Sie diese mit ei-

nem Strichpunkt. 

 =SUMME(Tabelle3[Sommer];Tabelle3[Winter]) liefert beispielsweise die 

Summe aller Zellen in den Spalten „Sommer“ und „Winter“.  

 Beachten Sie, dass hierbei der Name der Tabelle vor jeder Spalte angegeben 

werden muss. 
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Spezielle Bezeichner verwenden 

Abgesehen von Namen können in Zellbezügen auf Tabelleninhalte auch spezielle 

Bezeichner verwendet werden, die für eine bestimmte Komponente dieser Tabelle 

stehen.  

Der Bezeichner muss dazu, hinter dem Tabellennamen, in eckigen Klammern ein-

gegeben werden. Tabelle3[#Ergebnisse] ist beispielsweise ein Zellbezug auf alle 

Zellen in der Ergebniszeile der Tabelle namens „Tabelle3“. 

Es gibt folgende Bezeichner: 

 #Alle: Steht für die gesamte Tabelle inklusive Spaltenüberschriften und Ergeb-

niszeile, zum Beispiel: Tabelle3[#Alle].  

 #Daten: Steht für alle Zellen in der Tabelle, die die eigentlichen Werte enthal-

ten. Dies sind alle Zellen außer den Spaltenüberschriften und der Ergebniszeile.  

 #Kopfzeilen: Steht für die Zellen in der Kopfzeile der Tabelle (also der Zeile 

mit den Spaltenüberschriften).  

 #Ergebnisse: Steht für die Zellen in der Ergebniszeile der Tabelle. (Hinweis: 

Wenn die Ergebniszeile ausgeschaltet ist, liefert der Zellbezug den Fehlerwert 

#BEZUG! zurück.) 

 @[Spaltenname]: Steht für diejenige Zelle, die sich in der gleichen Zeile der 

angegebenen Spalte befindet. Dies ist vor allem bei Berechnungen innerhalb 

einer Tabelle nützlich.  

 Wenn Sie beispielsweise in einer Zelle einer Tabelle einen Zellbezug wie 

[@Frühling] verwenden, steht dieser für die Zelle, die sich in der gleichen Zei-

le der Spalte mit der Spaltenüberschrift „Frühling“ befindet.  

 Beispiel:  

 =SUMME([@[Frühling]:[Winter]]) liefert die Summe der Werte aus den 

Spalten „Frühling“ bis „Winter“ – und zwar für diejenige Zeile, in die Sie diese 

Berechnung eintragen. 

Die Groß-/Kleinschreibung spielt bei der Eingabe von Bezeichnern keine Rolle. 
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Fixieren von Zeilen und Spalten 

Mit dem Menübefehl Ansicht > Fixieren können Sie die ersten Zeilen und/oder 

Spalten einer Tabelle auf dem Bildschirm fixieren. Das bewirkt, dass sich diese 

beim Blättern in der Tabelle nicht mehr mitbewegen, sondern permanent angezeigt 

werden. 

Wenn Sie beispielsweise die Zeilen oder Spalten einer Tabelle mit Überschriften 

versehen haben, können Sie diese Beschriftungen fixieren, so dass sie immer zu 

sehen sind. 

Fixieren einschalten 

Um Zeilen oder Spalten zu fixieren, gehen Sie wie folgt vor: 

1. Zunächst müssen Sie festlegen, welche Zeilen und/oder Spalten fixiert werden 

sollen: 

 Zeilen fixieren: Wenn Sie die ersten Zeilen der Tabelle fixieren möchten, dann 

markieren Sie die Zeile direkt unterhalb der Zeilen, die fixiert werden sollen. 

 Spalten fixieren: Wenn Sie die ersten Spalten fixieren möchten, markieren Sie die 

Spalte rechts dieser Spalten. 

 Zeilen und Spalten fixieren: Wenn Sie sowohl Zeilen als auch Spalten fixieren 

möchten, setzen Sie den Zellrahmen in die Zelle rechts unter dem zu fixieren-

den Bereich. 

2. Anschließend rufen Sie den Menübefehl Ansicht > Fixieren auf. 

Die Zeilen und/oder Spalten wurden nun fixiert. Beim Blättern durch die Tabelle 

sind diese von nun an stets zu sehen. 

Tipp: Sie können auch das Symbol  in der rechten unteren Ecke des Pro-

grammfensters verwenden, um Titel zu fixieren. Ziehen Sie dieses Symbol dazu 

einfach mit der Maus an die gewünschte Stelle. 

Fixieren aufheben 

Wenn Sie Zeilen oder Spalten fixiert haben und das Menü Ansicht aufrufen, sehen 

Sie ein Häkchen vor dem Befehl Fixieren. Dieses zeigt an, dass das Fixieren ein-

geschaltet ist. Um es wieder auszuschalten, rufen Sie den Menübefehl Ansicht > 
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Fixieren noch einmal auf. Das Häkchen verschwindet; die Zeilen/Spalten sind nun 

nicht mehr fixiert. 

Tipp: Ein Mausklick auf das Symbol  in der rechten unteren Ecke des Pro-

grammfensters hebt die Fixierung ebenfalls wieder auf. 

Ein Beispiel 

Ihnen liegt folgende Tabelle mit Aktienkursen vor: 

 

Wie Sie sehen, sind darin sowohl die Spalten als auch die Zeilen beschriftet. Um 

diese Beschriftungen zu fixieren, gehen Sie wie folgt vor: 

 Die Spaltenbeschriftungen (Höchstkurs, Tiefstkurs etc.) befinden sich in der 

ersten Zeile der Tabelle.  

 Um diese zu fixieren, müssen Sie also die zweite Zeile markieren, indem Sie 

auf ihren Zeilenkopf (die mit „2“ beschriftete Schaltfläche links der Zeile) kli-

cken. Dann rufen Sie den Menübefehl Ansicht > Fixieren auf. 

 Die Zeilenbeschriftungen (23.10., 24.10. etc.) befinden sich in der ersten Spalte 

der Tabelle.  

 Um diese zu fixieren, markieren Sie die zweite Spalte (Spalte B), indem Sie auf 

ihren Spaltenkopf (die mit „B“ beschriftete Schaltfläche über der Spalte) kli-

cken. Dann rufen Sie den Menübefehl Ansicht > Fixieren auf. 

 Um beide Beschriftungen zu fixieren, setzen Sie den Zellrahmen in die Zelle 

B2 und rufen den Menübefehl Ansicht > Fixieren auf. 

Wenn Sie die Fixierung wieder aufheben möchten, rufen Sie den Befehl Fixieren 

erneut auf. 
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Sonderzeichen einfügen 

Einige Zeichen lassen sich über die Tastatur nicht direkt eingeben – zum Beispiel 

das Copyrightzeichen, das Promillezeichen oder Akzentzeichen aus anderen Spra-

chen. Bei PlanMaker können Sie diese sogenannten Sonderzeichen bequem über 

die integrierte Zeichentabelle einfügen. 

Gehen Sie dazu folgendermaßen vor: 

1. Rufen Sie den Menübefehl Einfügen > Sonderzeichen auf. 

2. Es erscheint ein Dialogfenster, das alle in der derzeit gewählten Schrift verfüg-

baren Zeichen anbietet. Über die aufklappbare Liste Schriftart können Sie bei 

Bedarf eine andere Schriftart wählen. 

3. Über die aufklappbare Liste Subset können Sie zu einem bestimmten Bereich 

des Zeichensatzes springen. Wählen Sie beispielsweise Kyrillisch, um zu den 

kyrillischen Zeichen zu gelangen (sofern in der gewählten Schriftart welche 

vorhanden sind). 

 Hinweis: Viele Schriften enthalten nur einen kleinen Teil des verfügbaren Zei-

chensatzes. Ein besonders großes Reservoir an Zeichen ist in den bei Ihrem Be-

triebssystem mitgelieferten Standardschriften vorhanden. Bei Windows sind 

dies zum Beispiel die Schriften Arial, Tahoma und Times New Roman. 

4. Selektieren Sie das einzufügende Zeichen mit den Pfeiltasten und drücken Sie 

die Eingabetaste (¢) oder führen Sie einen Doppelklick auf das Zeichen aus, 

um es in den Text einzufügen. 

5. Sie können nun auf die gleiche Weise noch weitere Zeichen einfügen oder den 

Dialog mit der Schaltfläche Schließen beenden. 

Tipp für Windows-Anwender: Die meisten Windows-Versionen enthalten zwei 

Symbolschriften namens Symbol und Wingdings. Darin finden Sie zahlreiche 

nützliche Symbole (Telefonsymbole, Bullets etc.). 

Tastenkürzel verwenden 

Wenn Sie ein bestimmtes Sonderzeichen besonders häufig benötigen, können Sie 

ihm jederzeit ein Tastenkürzel geben. Dies hat den Vorteil, dass Sie das Zeichen 

dann blitzschnell mit einem einzigen Tastendruck einfügen können. 

Um einem Sonderzeichen ein Tastenkürzel zuzuordnen, gehen Sie wie folgt vor: 

1. Rufen Sie den Menübefehl Einfügen > Sonderzeichen auf. 
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2. Wählen Sie das Sonderzeichen, dem Sie ein Tastenkürzel geben möchten. 

3. Klicken Sie neben der Option Tastenkürzel auf die Schaltfläche Ändern. 

4. Es erscheint ein weiterer Dialog. Drücken Sie darin im Eingabefeld Bitte Tas-

tenkürzel drücken das gewünschte Tastenkürzel. 

 Wir empfehlen Ihnen, stets Tastenkombinationen mit den Tasten (Strg) und (ª) 

zu verwenden, da diese normalerweise nicht belegt sind. 

 Tipp: Falls Sie sich vertippt haben, können Sie das eingegebene Tastenkürzel 

mit der Rücktaste (æ__) wieder löschen. 

5. Nicht vergessen: Klicken Sie auf Hinzufügen, um dem Zeichen dieses Tasten-

kürzel zuzuweisen.  

6. Bestätigen Sie mit OK und verlassen Sie den Hauptdialog mit Schließen. 

Von nun an können Sie dieses Sonderzeichen mit der entsprechenden Tastenkom-

bination einfügen.  

Hinweis: Das Tastenkürzel merkt sich nur das ausgewählte Zeichen, nicht jedoch 

die gewählte Schriftart. 

Weitere Informationen zum Ändern der Tastaturbelegung finden Sie im Abschnitt 

„Tastenkürzel anpassen“ (ab Seite 491). Tipp: Die Tastenkürzel für Sonderzeichen 

können Sie bearbeiten, indem Sie in dem Dialog für das Bearbeiten der Tastaturbe-

legung in der linken Liste den Eintrag Zeichen auswählen. 

Sonderzeichen über ihren Zeichencode einfügen 

Es gibt noch eine andere Methode zum Einfügen eines Sonderzeichens: Tippen Sie 

dazu dessen hexadezimalen Zeichencode (Unicode) ein, und betätigen Sie dann die 

Tastenkombination (Strg)(Alt)(ª)(X).  

Wenn Sie beispielsweise 20AC eingeben und dann diese Tastenkombination drü-

cken, erhalten Sie ein Eurozeichen, da dieses in der Unicode-Zeichentabelle den 

Zeichencode 20AC hat. 
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Gestalten einer Tabelle 

Durch den Einsatz von Diagrammen, Farben, Umrandungen und anderen Gestal-

tungsmöglichkeiten können Sie das Erscheinungsbild Ihrer Tabellen aufwerten und 

die Lesbarkeit erhöhen. 

In diesem Kapitel erfahren Sie alles über das Gestalten ansprechender Tabellen. 

Folgende Themen werden darin behandelt: 

 Zellengröße 

 Die Zellengröße kann unter anderem über die Untermenüs der Menübefehle 

Arbeitsblatt > Zeile und Arbeitsblatt > Spalte. Sie können die Zellengröße 

aber auch durch Ziehen an den Zeilen- und Spaltenköpfen ändern. 

 Zahlenformat 

 PlanMaker kann Zahlen in den unterschiedlichsten Zahlenformaten anzeigen: 

angefangen bei einfachen Zahlen mit und ohne Nachkommastellen über Wäh-

rungs-, Prozent- und Datumsformate bis hin zu frei definierbaren Formaten. 

Der Menübefehl Format > Zelle lässt Sie das Format genau festlegen. 

 Umrandung 

 Mit dem Menübefehl Format > Umrandung können Zellen mit einer Umran-

dung oder einzelnen Linien versehen werden. 

 Schattierung 

 Der Hintergrund von Zellen kann mit einer Schattierung versehen werden. Der 

Menübefehl Format > Schattierung stellt hierzu verschiedene Farben, Raster 

und Muster zur Verfügung. 

 Ausrichtung 

 Mit dem Menübefehl Format > Zelle können Sie Zellinhalte unter anderem 

ausrichten (linksbündig, rechtsbündig etc.) und drehen. 

 Schutz 

 Weiterhin können Sie mit dem Menübefehl Format > Zelle Zellen schützen, so 

dass diese beispielsweise nicht überschrieben oder verändert werden können. 

Diesem Thema widmet sich auch der Abschnitt „Blattschutz“ ab Seite 401. 
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 Zeichenformat 

 Der Menübefehl Format > Zeichen lässt Sie das Zeichenformat von Zellen 

oder einzelnen Zeichen festlegen. Dazu gehören Einstellungen wie die Schrift-

art, Textauszeichnungen (fett, kursiv etc.) und die Schriftfarbe. 

 Absatzformat (nur in Textrahmen) 

 Wenn Sie Textrahmen in die Tabelle eingefügt haben, können Sie jederzeit die 

Absatzformatierung (Zeilenabstand, Einzüge etc.) des enthaltenen Textes än-

dern. Dazu dient der Menübefehl Format > Absatz (nur in Textrahmen verfüg-

bar). 

 Zeichenvorlagen 

 Besonders häufig benötigte Zeichenformate lassen sich in einer Zeichenvorlage 

speichern, die Sie dann beliebig oft anwenden können. 

 Zellenvorlagen 

FreeOffice: Das Erstellen und Verwalten eigener Zellenvorlagen ist in Soft-

Maker FreeOffice nicht enthalten. 

 Darüber hinaus können Sie Zellenvorlagen erstellen. In diesen lässt sich sowohl 

das Zeichenformat (Schriftart etc.) als auch das Zellenformat (Zahlenformat, 

Umrandung, Schattierung, Ausrichtung und Zellschutz) speichern. 

 Dokumentvorlagen 

 Wenn Sie einen Satz an Zeichen- und Zellenvorlagen erstellt haben und der 

Meinung sind, dass Sie diese auch in Zukunft gut gebrauchen können, können 

Sie diese in einer Dokumentvorlage speichern. 

 AutoFormat 

 Der Befehl AutoFormat ist ein besonders praktischer Helfer: Er formatiert 

einen kompletten Tabellenbereich in einem von zahlreichen vorgegebenen 

Formaten – auf Knopfdruck. 

 Bedingte Formatierung 

 Sie können Zellen auch mit einer bedingten Formatierung versehen. Diese wird 

nur angewandt, wenn eine bestimmte Bedingung erfüllt ist. So können Sie bei-

spielsweise festlegen, dass eine Zelle immer dann rot eingefärbt werden soll, 

wenn sie einen Wert größer als 1000 enthält. 
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 Gültigkeitsprüfung 

FreeOffice: Die Gültigkeitsprüfung ist in SoftMaker FreeOffice nicht ent-

halten. 

 Wenn Sie Zellen mit einer Gültigkeitsprüfung versehen, werden darin nur noch 

bestimmte Arten von Werten (zum Beispiel nur Zahlen) innerhalb der angege-

benen Grenzwerte (zum Beispiel nur Werte zwischen 10 und 20) als gültig er-

achtet. 

 Format übertragen 

 Mit dem Befehl Format übertragen können Sie die Formatierung einer Zelle 

mit einem „Pinsel“ blitzschnell auf andere Zellen übertragen. 

 Seitenformat 

 Das Seitenformat bestimmt das Erscheinungsbild des Dokuments beim Aus-

druck. Dazu gehören Einstellungen wie das Papierformat, Seitenränder, Kopf- 

und Fußzeilen und vieles mehr. Diese können Sie mit dem Menübefehl Datei > 

Seite einrichten festlegen. 

Ausführliche Informationen zu diesen Themen finden Sie, in obiger Reihenfolge, 

auf den nächsten Seiten. 

Zellengröße 

Auf den nächsten Seiten lernen Sie die unterschiedlichen Methoden zum Festlegen 

der Größe von Zellen kennen. 

Wichtig: Wenn in einer Zelle statt des Inhalts lauter Doppelkreuze angezeigt 

werden (z.B. ########), liegt das daran, dass die Spalte zu schmal ist, um den 

Zellinhalt darzustellen. Verbreitern Sie die Spalte dann entsprechend. 

Zellengröße per Maus ändern 

Oberhalb der Tabelle finden Sie mit A, B, C etc. beschriftete Schaltflächen, links 

der Tabelle sehen Sie Schaltflächen mit der Beschriftung 1, 2, 3 etc.  

Über diese sogenannten Spaltenköpfe und Zeilenköpfe können Sie die Spaltenbrei-

ten und Zeilenhöhen Ihrer Tabelle ganz einfach mit der Maus ändern: 
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 Zum Ändern der Spaltenbreite einer Spalte führen Sie den Mauszeiger auf den 

rechten Rand des zugehörigen Spaltenkopfes. Der Mauszeiger verwandelt sich 

in einen Doppelpfeil. Wenn Sie nun die linke Maustaste drücken und gedrückt 

halten, können Sie die Spaltenbreite durch Ziehen mit der Maus ändern.  

 Zum Ändern der Zeilenhöhe benutzen Sie in gleicher Weise den unteren Rand 

eines Zeilenkopfes. 

Zellengröße per Menü ändern 

Über die Menübefehl Arbeitsblatt > Spalte und Arbeitsblatt > Zeile können Sie 

die Spaltenbreiten und Zeilenhöhen Ihrer Tabelle per Menü ändern.  

Beim Aufruf eines dieser beiden Menübefehle klappt ein Untermenü auf, das unter 

anderem folgende Einträge enthält: 

Breite (beziehungsweise Höhe) 

Mit diesem Befehl können Sie die Breite der Spalte beziehungsweise die Höhe der 

Zeile exakt festlegen. Geben Sie dazu den gewünschten Wert in das Eingabefeld 

ein. 

Optimale Breite (beziehungsweise Optimale Höhe) 

Der Menübefehl Arbeitsblatt > Spalte > Optimale Breite passt die Breite einer 

Tabellenspalte automatisch an ihren Inhalt an. 

Sie können diesen Befehl auf folgende Arten einsetzen: 

 Wenn Sie eine komplette Spalte markieren und diesen Befehl aufrufen, wird die 

Spaltenbreite an diejenige Zelle angepasst, deren Inhalt den meisten Platz benö-

tigt. 

Tipp: Dies geht auch schneller: Führen Sie einfach einen Doppelklick auf den 

Spaltenkopf durch, um eine Spalte auf die optimale Breite zu setzen.  

 Wenn Sie eine einige Zellen innerhalb einer Spalte markieren und diesen Befehl 

dann aufrufen, werden zum Ermitteln der optimalen Spaltenbreite nur diese 

Zellen berücksichtigt. 

 Wenn Sie hingegen gar nichts markieren und diesen Befehl aufrufen, wird die 

Spaltenbreite an den Inhalt der aktuellen Zelle angepasst. 
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Entsprechendes gilt den Menübefehl Arbeitsblatt > Zeile > Optimale Höhe, mit 

dem Sie die Höhe einer Zeile automatisch anpassen können. 

Einblenden und Ausblenden von Zeilen/Spalten 

Sie können einzelne Zeilen und Spalten ausblenden, also unsichtbar machen. Dies 

ist nützlich, wenn deren Inhalt im Augenblick nicht benötigt wird oder verborgen 

bleiben soll. 

Tipp: Wenn Sie den Blattschutz für das aktuelle Arbeitsblatt aktivieren, lassen 

sich ausgeblendete Zellen auf diesem Blatt nicht mehr einblenden. Siehe auch 

Abschnitt „Blattschutz“ ab Seite 401. 

Folgendermaßen blenden Sie Zeilen oder Spalten aus: 

Ausblenden von Zeilen über ihren Zeilenkopf 

Am schnellsten können Sie Zeilen über ihren Zeilenkopf ausblenden. Der Zeilen-

kopf ist die mit der Zeilennummer beschriftete Schaltfläche links von der Zeile. 

Um beispielsweise die Zeile 14 auszublenden, ziehen Sie die untere Begrenzungs-

linie des Zeilenkopfes für diese Zeile so lange nach oben, bis die Zeile komplett 

verschwindet. 

Die Zeile ist nun verborgen. Anstelle ihres Zeilenkopfes erscheint ein kleines Drei-

eck: 

 

Klicken Sie dieses Dreieck an, wird die Zeile wieder eingeblendet. 

Ausblenden von Zeilen über den Menübefehl „Arbeitsblatt > Zeile“ 

Alternativ können Sie Zeilen auch wie folgt ein- und ausblenden: 

Markieren Sie die auszublendenden Zeilen und rufen Sie den Menübefehl Ar-

beitsblatt > Zeile > Ausblenden auf. 

Die Zeilen werden daraufhin ausgeblendet. 
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Um sie wieder einzublenden, markieren Sie einen Bereich an Zeilen, der die aus-

geblendeten Zeilen enthält und rufen den Menübefehl Arbeitsblatt > Zeile > Ein-

blenden auf. 

Ausblenden von Spalten 

Das Aus- und Einblenden von Spalten funktioniert genauso. Hier verwenden Sie 

entsprechend die Spaltenköpfe der Spalten beziehungsweise die Menübefehle Ar-

beitsblatt > Spalte > Ausblenden und Arbeitsblatt > Spalte > Einblenden. 

Zahlenformat 

Auf der Karteikarte Zahlenformat im Dialogfenster des Menübefehls Format > 

Zelle können Sie das Zahlenformat von Zellen ändern. 

Das Zahlenformat bestimmt, wie Zahlen in diesen Zellen dargestellt werden. Sie 

können beispielsweise ein Zahlenformat auswählen, bei dem die Zahlen mit einem 

Währungssymbol versehen und auf zwei Nachkommastellen gerundet dargestellt 

werden (z.B. € 42,50). 

Beachten Sie: Die Zahlen werden hierbei nur gerundet angezeigt, aber nicht tat-

sächlich gerundet. Sie behalten also auch weiterhin alle Nachkommastellen. 

Wenn Sie eine Zahl tatsächlich runden möchten, sollten Sie Rechenfunktionen 

wie RUNDEN verwenden. 

Um das Zahlenformat von Zellen zu ändern, gehen Sie wie folgt vor: 

1. Markieren Sie die Zellen, deren Zahlenformat geändert werden soll. Soll nur 

eine einzige Zelle formatiert werden, reicht es, wenn Sie diese ansteuern. 

2. Rufen Sie den Menübefehl Format > Zelle auf. 

3. Wechseln Sie auf die Karteikarte Zahlenformat. 
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4. Legen Sie das gewünschte Format fest (siehe unten). 

5. Bestätigen Sie mit OK. 

In dem Dialogfenster können folgende Einstellungen vorgenommen werden: 

 Kategorie 

 In dieser Liste wählen Sie die gewünschte Art von Zahlenformat. Ausführliche 

Informationen zu den einzelnen Formaten finden Sie im Abschnitt „Liste der 

Zahlenformate“ weiter unten). 

 Format 

 Bei manchen Zahlenformaten stehen außerdem mehrere Unterformate zur 

Wahl. Wählen Sie hier das gewünschte Unterformat. 

 Dezimalstellen 

 Bei manchen Formaten können Sie wählen, mit wie vielen Nachkommastellen 

die Zahlen angezeigt werden sollen. 

 Hinweis: Die Zahlen werden hierbei nur gerundet angezeigt, aber nicht tatsäch-

lich gerundet. Sie behalten also auch weiterhin alle Nachkommastellen.  
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 Tausendertrennzeichen 

 Bei manchen Formaten können Sie wählen, ob Zahlen mit Tausenderpunkten 

(z.B. 5.000.000) oder ohne Tausenderpunkte (z.B. 5000000) angezeigt werden 

sollen. 

 Negative Werte in Rot 

 Bei manchen Formaten können Sie wählen, ob negative Zahlen in roter Farbe 

angezeigt werden sollen. 

 Minuszeichen unterdrücken 

 Bei manchen Formaten können Sie wählen, ob bei negativen Zahlen das Mi-

nuszeichen vor der Zahl unterdrückt werden soll. 

 Null nicht anzeigen 

 Bei manchen Formaten können Sie wählen, ob der Inhalt von Zellen, die den 

Wert „0“ enthalten, nicht angezeigt werden soll. 

Bestätigen Sie mit OK, werden die Zahlen in den markierten Zellen entsprechend 

formatiert dargestellt. 

Liste der Zahlenformate 

Wie im vorherigen Abschnitt beschrieben, können Sie mit dem Menübefehl For-

mat > Zelle das Zahlenformat einer Zelle einstellen und so bestimmen, wie Zahlen 

in dieser Zelle dargestellt werden sollen. 

Hierfür gibt es folgende Zahlenformate: 

Standard 

Stellt die Zahl so dar, wie sie eingegeben wurde.  

Genauer gesagt: Die Zahl wird rechtsbündig angezeigt; ansonsten werden aber 

keine Änderungen an ihrer Formatierung vorgenommen. Sie wird mit so vielen 

Nachkommastellen angezeigt, wie sie tatsächlich besitzt (maximal jedoch mit fünf 

Nachkommastellen). 

Beispiel:  42 
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Zahl 

Entspricht dem Zahlenformat Standard, lässt Sie aber verschiedene Formatie-

rungsoptionen einstellen (siehe vorheriger Abschnitt). Unter anderem können Sie 

festlegen, mit wie vielen Nachkommastellen die Zahl angezeigt werden soll. 

Beispiel:  42,00 

Beachten Sie: Die Zahl wird hierbei nur gerundet angezeigt, aber nicht tatsäch-

lich gerundet. Sie behält also auch weiterhin alle Nachkommastellen. Wenn Sie 

die Zahl tatsächlich runden möchten, sollten Sie eine Rechenfunktion wie RUN-

DEN verwenden. 

Währung 

Zeigt die Zahl mit einem Währungssymbol und zwei Nachkommastellen an.  

Die gewünschte Währung können Sie in der Liste Währung auswählen. 

Beispiel: € 42,00 

Buchhaltung 

Entspricht dem Zahlenformat Währung (siehe oben), stellt die Zahl jedoch so dar, 

wie es in der Buchhaltung üblich ist.  

Der Unterschied zum Währungsformat besteht darin, dass bei negativen Beträgen 

das Minuszeichen am linken Zellrand steht, abgetrennt von der Zahl. Außerdem 

werden Währungssymbole bündig untereinander ausgerichtet. 

Beispiel: -€      42,00 

Datum/Zeit 

Stellt die Zahl als Datum und/oder Uhrzeit dar. 

In der Liste Format werden dazu, abhängig von den Ländereinstellungen Ihres 

Systems, zahlreiche unterschiedliche Schreibweisen angeboten.  

Prozent 

Stellt die Zahl als Prozentwert dar.  
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Dazu wird nicht nur ein Prozentzeichen (%) hinter der Zahl angezeigt, sondern die 

Zahl auch mit 100 multipliziert dargestellt. Schließlich entspricht beispielsweise 

0,5 – in Prozent ausgedrückt – 50%. 

Beispiel: 4200% 

Wissenschaft 

Stellt die Zahl in wissenschaftlicher Schreibweise (Exponentialschreibweise) dar. 

Beispiele: 5E+03 (entspricht 5 * 103, also 5000) 

 4,2E-01 (entspricht 4,2 * 10-1, also 0,42) 

Bruch 

Stellt die Zahl als Bruch dar. 

Das Format des Bruchs ist in der Liste Format wählbar. 

Beachten Sie: Die Zahl wird dazu bei Bedarf gerundet angezeigt. Wenn Sie also 

beispielsweise das Format Als Halbe wählen und dann die Zahl 2,3 eingeben, 

wird diese als 2 1/2 angezeigt. 

Beispiele: 2 1/2 

 5 9/10 

Wahrheitswert 

Stellt den Wert in der Zelle als Wahrheitswert dar. 

Genauer gesagt: Ist der Wert Null, wird FALSCH angezeigt. Für alle anderen Wer-

te wird WAHR angezeigt. 

Beispiele: WAHR 

 FALSCH 

Text 

Ein Sonderfall: Dieses Format zwingt PlanMaker dazu, die Zahl in der Zelle wie 

Text zu behandeln – nicht wie eine Zahl.  
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Die Zahl wird linksbündig ausgerichtet und exakt so dargestellt, wie sie eingege-

ben wurde. Im Gegensatz zu allen anderen Zahlenformaten werden Zahlen hier 

nach der Eingabe nicht automatisch umformatiert. Es werden also keine führenden 

Nullen entfernt, Datumsangaben werden nicht automatisch formatiert etc. 

Ein Anwendungsgebiet für dieses Format sind Zahlen mit führenden Nullen (z.B. 

Telefonvorwahlen). Tippen Sie in einer Zelle die Telefonvorwahl „089“ ein, ent-

fernt PlanMaker normalerweise automatisch die führende Null. Formatieren Sie die 

Zelle zuvor mit dem Zahlenformat Text, geschieht dies nicht. 

Vorsicht: Dieses Zahlenformat wurde aus Kompatibilitätsgründen genau so wie 

in Microsoft Excel implementiert und liefert deshalb auch in PlanMaker uner-

wartete Ergebnisse bei numerischen Berechnungen:  

Wenn Sie beispielsweise die Zellen A1 und A2 mit diesem Format versehen, lie-

fert die Berechnung A1+A2 die korrekte Summe dieser Zellen. Das Ergebnis der 

Berechnung SUMME (A1:A2) ist hingegen Null. Für die meisten Rechenfunkti-

onen hat Text nämlich generell den Wert Null! 

Benutzerdefiniert 

Stellt die Zahl in einem frei definierbaren Zahlenformat dar. 

Lesen Sie dazu den nächsten Abschnitt. 

Benutzerdefinierte Zahlenformate verwenden 

Bei Bedarf können Sie mit dem Menübefehl Format > Zelle auch eigene Zahlen-

formate definieren und anwenden. 

Ein neues Zahlenformat definieren und anwenden 

Folgendermaßen legen Sie ein neues benutzerdefiniertes Zahlenformat an: 

1. Selektieren Sie die Tabellenzellen, auf die Sie das neue Zahlenformat anwen-

den möchten. 

2. Rufen Sie den Menübefehl Format > Zelle auf und wechseln Sie auf die Kar-

teikarte Zahlenformat. 

3. Wählen Sie in der Liste Kategorie den Eintrag Benutzerdefiniert. 
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4. Klicken Sie in das Eingabefeld bei Format. 

5. Geben Sie eine Zeichenkette mit Formatcodes ein, um das Format zu bestim-

men.  

 Eine Tabelle aller verfügbaren Codes finden Sie im Abschnitt „Aufbau eines 

benutzerdefinierten Zahlenformats“ weiter unten. 

6. Bestätigen Sie mit OK. 

Das Zahlenformat wurde nun angelegt (und auch gleich auf die markierten Zellen 

angewandt).  

Tipp: Falls Sie ein Zahlenformat erstellen möchten, das so ähnlich wie eines der 

eingebauten Zahlenformate aussehen soll, haben wir einen guten Tipp für Sie: Kli-

cken Sie nach dem Öffnen des Dialogs erst auf das gewünschte eingebaute Zahlen-

format in der Liste Kategorie. Dessen Formatcodes werden dann nämlich als Vor-

gabe in das Eingabefeld für die Formatcodes (Schritt 5.) übertragen. Jetzt müssen 

Sie nur noch die gewünschten Änderungen vornehmen – fertig. 

Benutzerdefinierte Zahlenformate anwenden 

Natürlich können Sie ein einmal definiertes Zahlenformat auch jederzeit auf andere 

Zelle anwenden. Das geht folgendermaßen: 

1. Selektieren Sie die gewünschten Tabellenzellen. 

2. Rufen Sie den Menübefehl Format > Zelle auf und wechseln Sie auf die Kar-

teikarte Zahlenformat. 

3. Wählen Sie in der Liste Kategorie den Eintrag Benutzerdefiniert. 

4. In der Liste Format sind alle benutzerdefinierten Zahlenformate für das aktuel-

le Dokument aufgelistet. Wählen Sie das gewünschte Format darin aus. 

5. Bestätigen Sie mit OK. 

Das Zahlenformat wird nun auf die markierten Zellen angewandt. 

Benutzerdefinierte Zahlenformate löschen 

Wenn Sie ein benutzerdefiniertes Zahlenformat nicht mehr benötigen, können Sie 

es jederzeit löschen. Gehen Sie dazu wie folgt vor: 

1. Rufen Sie den Menübefehl Format > Zelle auf und wechseln Sie auf die Kar-

teikarte Zahlenformat. 
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2. Wählen Sie in der Liste Kategorie den Eintrag Benutzerdefiniert. 

3. Wählen Sie das zu löschende Format in der Liste Format. 

4. Klicken Sie auf die Schaltfläche Löschen. 

5. Verlassen Sie den Dialog (am besten mit der Schaltfläche Abbrechen, da beim 

Klicken auf OK ja sonst das momentan selektierte Zahlenformat auf die aktuel-

le Zelle angewandt werden würde). 

Anmerkung: Die Schaltfläche Löschen ist nur bei benutzerdefinierten Zahlenfor-

maten verfügbar; die eingebauten Formate lassen sich nicht löschen. 

Aufbau eines benutzerdefinierten Zahlenformats 

Beim Anlegen eines neuen Zahlenformats geben Sie (wie im vorherigen Abschnitt 

beschrieben) eine Zeichenkette mit Formatcodes ein. Diese Codes bestimmen, wie 

die Zahl dargestellt wird.  

Ein Beispiel: 

#,00 

Diese Formatcodes bewirken, dass Zahlen wie folgt ausgegeben werden: sämtliche 

Vorkommastellen, dann der Dezimaltrenner, dann genau zwei Nachkommastellen.  

Im Einzelnen sind folgende Formatcodes verfügbar: 

Formatcodes für Zahlen und Text 

Für Zahlen und Text gibt es die folgenden Formatcodes: 

Code Bedeutung 

# Eine Ziffer der Zahl ausgeben. Falls sich an dieser Position der Zahl 

keine Ziffer befindet, nichts ausgeben. 

 Beispiel: #,## ergibt bei 1,2 beispielsweise 1,2. 

0 Eine Ziffer der Zahl ausgeben. Falls sich an dieser Position der Zahl 

keine Ziffer befindet, stattdessen eine Null ausgeben. 

 Beispiel: #,00 ergibt bei 1,2 beispielsweise 1,20. 

? Eine Ziffer der Zahl ausgeben. Falls sich an dieser Position der Zahl 

keine Ziffer befindet, stattdessen ein Leerzeichen ausgeben. 
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 Beispiel: #,?? ergibt bei 1,2 beispielsweise 1,2  (mit einem Leerzei-

chen hinter der 2). 

 Wichtig: Sobald sich vor dem Dezimalkomma mindestens einer der 

obigen drei Formatcodes befindet, werden alle Vorkommastellen 

angezeigt. Der Formatcode 0,00 liefert bei der Zahl 123,456 also 

nicht 3,46 sondern 123,46. 

, (Komma) An dieser Stelle den Dezimaltrenner ausgeben. 

 Hinweis: Falls Ihr System als Dezimaltrenner nicht ein Komma, 

sondern ein anderes Zeichen nutzt (zum Beispiel einen Punkt), ver-

wenden Sie bitte dieses Zeichen anstelle des Kommas. 

. (Punkt) Die Zahl mit Tausendertrennzeichen ausgeben. Fügen Sie dazu ein-

fach (an einer beliebigen Stelle) einen Punkt in das Zahlenformat 

ein. .0,00 ergibt bei 5000000 beispielsweise 5.000.000,00. 

 Hinweis: Falls Ihr System als Tausendertrenner nicht einen Punkt, 

sondern ein anderes Zeichen nutzt, verwenden Sie bitte dieses Zei-

chen anstelle des Punkts. 

% An dieser Stelle ein Prozentzeichen ausgeben, und die Zahl außer-

dem mit 100 multiplizieren.  

 Beispiel: 0% ergibt bei 0,5 beispielsweise 50%. 

E+ oder e+ Wissenschaftliche Schreibweise (Exponentialschreibweise) verwen-

den.  

 Beispiel: 0E+00 ergibt bei 50000 beispielsweise 5E+04. 

 Tipp: Technische Schreibweise (bei der nur durch 3 teilbare Expo-

nenten erlaubt sind) ist ebenfalls möglich: #00E+00 ergibt bei-

spielsweise bei 50000 nicht 5E+04 sondern 50E+03. 

E- oder e- Entspricht E+, allerdings wird das Vorzeichen beim Exponenten nur 

dann ausgegeben, wenn der Exponent negativ ist. (Bei E+ hingege-

ben wird es immer ausgegeben.)  

 Beispiel: 0E-00 ergibt bei 50000 beispielsweise 5E04. 

Standard Platzhalter für den kompletten Zellinhalt (im Zahlenformat „Stan-

dard“) 

@ Platzhalter für den kompletten Zellinhalt als Text 

\ Das nachfolgende Zeichen nicht als Formatcode interpretieren, son-

dern es einfach ausgeben. 

 Wenn Sie beispielsweise das Zeichen „#“ ausgeben möchten, müs-

sen Sie hierfür \# schreiben (da „#“ ja ein gültiger Formatcode ist). 
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"Text" Den Text zwischen den Anführungszeichen nicht als Formatcode 

interpretieren, sondern ihn einfach ausgegeben. 

 Beispiel: "MeinText" 

* (Sternchen) Das nachfolgende Zeichen wiederholen. *x füllt beispielsweise die 

komplette Zelle mit dem Zeichen „x“. 

 Beispiel: Das Zahlenformat "Summe:"* 0,00 gibt links in der Zelle 

den Text „Summe:“ und rechts die Zahl (mit zwei Nachkommastel-

len) aus. Der Raum dazwischen wird mit Leerzeichen aufgefüllt. 

_ (Unterstrich) Einen Leerraum in der Breite des nachfolgenden Zeichens ausgeben.  

 Beispiel: Der Code _- liefert beispielsweise einen Leerraum, der 

exakt breit ist wie ein Minuszeichen.  

[Rot] Zeigt den Zellinhalt in roter Farbe an. Insgesamt gibt es folgende 

Farbcodes: 

 [Schwarz] [Weiß] [Rot] [Grün] [Blau] [Zyan] [Magenta] [Gelb]  

Formatcodes für Daten und Uhrzeiten 

Für Datumsangaben und Uhrzeiten sind ausschließlich die folgenden Formatcodes 

zulässig: 

Hinweis: Achten Sie genau auf die Groß-/Kleinschreibung der Formatcodes! 

Code Bedeutung 

T Tag (1-31) 

TT Tag, zweistellig (01-31) 

TTT Wochentag, abgekürzt („Mo“ bis „So“) 

TTTT Wochentag („Montag“ bis „Sonntag“) 

M Monat (1-12) 

MM Monat, zweistellig (01-12) 

MMM Monatsname, abgekürzt („Jan“ bis „Dez“) 

MMMM Monatsname („Januar“ bis „Dezember“) 

MMMMM Monatsname, nur erster Buchstabe („J“ für Januar bis „D“ für De-

zember) 
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JJ Jahr, zweistellig (z.B. 18) 

JJJJ Jahr, vierstellig (z.B. 2018) 

Q Quartal (1-4) 

QQ Das Wort „Quartal“ in der Sprache, die in den regionalen Einstellun-

gen des Systems gewählt wurde 

h Stunde (0-23) 

hh Stunde, zweistellig (00-23) 

m Minute (0-59) 

mm  Minute, zweistellig (00-59) 

s Sekunde (0-59) 

ss Sekunde, zweistellig (00-59) 

0 Zehntelsekunden (z.B. hh:mm:ss,0) 

00 Hundertstelsekunden (z.B. hh:mm:ss,00) 

000 Tausendstelsekunden (z.B. hh:mm:ss,000) 

AM/PM Stunden im 12 Stunden-Format ausgegeben und AM beziehungswei-

se PM anhängen. Muss sich am Ende der Zeichenkette mit den For-

matcodes befinden!  

Beispiel: h:mm:ss AM/PM 

am/pm Wie AM/PM, jedoch mit am oder pm (in Kleinbuchstaben) 

a/p Wie AM/PM, jedoch mit a oder p 

[h] Zahl der Stunden im Endlosformat* 

[m] Zahl der Minuten im Endlosformat* 

[mm] dito, aber als zweistellige Zahl* 

[s] Zahl der Sekunden im Endlosformat* 

[ss] dito, aber als zweistellige Zahl* 

[$-n] Optional: Ländercode für die Sprache, in der Tages- und Monatsna-

men ausgegeben werden. Wenn Sie keinen Ländercode angeben, 

verwendet PlanMaker automatisch die Systemsprache. [$-407] steht 

beispielsweise für Deutsch, [$-409] für Englisch (US). 
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* Das Endloszeitformat zeichnet sich dadurch aus, dass es Uhrzeiten nicht nach 24 Stunden auf 0:00 

zurücksetzt. Dadurch eignet es sich besonders für das Rechnen mit Uhrzeiten. Addieren Sie bei-

spielsweise die Uhrzeiten 20:00 und 5:00, ist das Ergebnis normalerweise 1:00. Formatieren Sie die-
ses jedoch im Format [h]:mm, so lautet das Ergebnis 25:00. 

 Weiterhin sind beim Endloszeitformat auch negative Werte möglich: 7:00 - 10:00 ergibt also nicht 

21:00, sondern -3:00. 

 Das gleiche gilt für Minuten und Sekunden: Auch diese werden nicht nach 60 Minuten bzw. 60 Se-

kunden zurückgesetzt. So können Sie das Endloszeitformat sogar für das Umrechnen von Zeitanga-

ben in Minuten oder Sekunden verwenden. Formatieren Sie 02:00:00 beispielsweise als [mm]:ss, 

wird 120:00 ausgegeben; 2 Stunden sind also 120 Minuten. Beim Format [ss] würde 7200 angezeigt; 
2 Stunden sind also 7200 Sekunden. 

Definieren separater Abschnitte für positive Zahlen, negative Zahlen, Nullwerte 

und Text 

Bei Bedarf können Sie die Zeichenkette mit den Formatcodes in bis zu vier Ab-

schnitte unterteilen, die durch Strichpunkte zu trennen sind. Dies ermöglicht das 

Definieren eines eigenen Zahlenformats jeweils für positive Zahlen, negative Zah-

len, den Wert Null und Text – in folgender Form: 

Positiv; Negativ; Null; Text 

Die Anzahl der Abschnitte, die Sie dabei definieren, wirkt sich wie folgt aus: 

Zahl der Abschnitte Auswirkung 

Nur 1 Abschnitt: Die Formatcodes gelten für alle Werte. 

2 Abschnitte: Die Codes im 1. Abschnitt gelten für positive Werte. 

Die Codes im 2. Abschnitt gelten für negative Werte. 

3 Abschnitte: Die Codes im 1. Abschnitt gelten für positive Werte. 

Die Codes im 2. Abschnitt gelten für negative Werte. 

Die Codes im 3. Abschnitt gelten für die Zahl Null. 

4 Abschnitte: Die Codes im 1. Abschnitt gelten für positive Werte. 

Die Codes im 2. Abschnitt gelten für negative Werte. 

Die Codes im 3. Abschnitt gelten für die Zahl Null. 

Die Codes im 4. Abschnitt gelten für Text. 

Ein Beispiel (mit zwei Abschnitten): 

0,00; -0,00[Rot] 

Dieses Zahlenformat liefert folgende Formatierung: 

Abschnitt 1: 0,00 bedeutet: Positive Zahlen mit zwei Nachkommastellen darstellen. 
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Abschnitt 2: -0,00[Rot] bedeutet: Negative Zahlen ebenfalls mit zwei Nachkom-

mastellen darstellen. Minuszeichen davor anzeigen (siehe Hinweis!). Zahl außer-

dem rot einfärben. 

Hinweis: Wenn Sie ein Zahlenformat mit zwei (oder mehr) Abschnitten definie-

ren, müssen Sie im zweiten Abschnitt explizit ein Minuszeichen hinzufügen, 

wenn Sie möchten, dass bei negativen Zahlen eines angezeigt wird.  

Im Gegensatz zu Zahlenformaten mit nur einem Abschnitt wird das Minuszeichen 

hier bei negativen Zahlen nämlich nicht automatisch angezeigt.  

Definieren separater Abschnitte mithilfe von Bedingungen 

Alternativ können Sie die Zeichenkette mit den Formatcodes auch in mehrere Ab-

schnitte aufteilen, indem Sie eine Bedingung für jeden Abschnitt angeben.  

Auch hier sind die einzelnen Abschnitte durch Strichpunkte zu trennen. Um die 

Bedingungen zu definieren, fügen Sie einfach jedem Abschnitt die gewünschte 

Vergleichsoperation in eckigen Klammern hinzu – zum Beispiel Bedingungen wie 

[>0] oder [>=100] oder [=42]. 

Es dürfen maximal zwei Sektionen mit Bedingungen angelegt werden. Dahinter 

sollte außerdem eine Sektion ohne Bedingung hinzugefügt werden. Diese definiert 

dann das Format für Zahlen, die keiner der Bedingungen entsprechen. 

Ein Beispiel: 

[<=0][Blau]0,00; [>30][Rot]0,00; 0,00 

Diese Formatcodes zeigen die Zahlen in Blau an, wenn der Wert kleiner oder 

gleich Null ist – und in Rot, wenn der Wert größer als 30 ist. Trifft keine der beiden 

Bedingungen zu, wird der Wert ohne Einfärbung (also in schwarz) angezeigt. 

Tipp: Erheblich komfortabler lassen sich solche Aufgaben über „bedingte For-

matierungen“ lösen. Siehe Abschnitt „Bedingte Formatierung“ (Seite 211). 

Umrandung 

Auf der Karteikarte Umrandung im Dialogfenster des Menübefehls Format > 

Zelle können Sie Zellen mit einer kompletten Umrandung oder einzelnen Linien 
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versehen. Auch Gitternetzlinien (die Linien zwischen den Zellen) lassen sich hier 

anbringen. 

Alternativ lässt sich dieses Kommando auch über den Menübefehl Format > Um-

randung aufrufen. 

 

Ein ähnlicher Dialog erscheint auch bei Objekten, die sich mit Umrandungslinien 

versehen lassen (zum Beispiel Textrahmen). Die Bedienung ist jeweils identisch. 

Kurz zusammengefasst wird dieser Dialog wie folgt bedient: 

1. Erst legen Sie fest, was für eine Art von Umrandungslinie angebracht werden 

soll (Linienstil, Liniendicke, Farbe). 

2. Dann legen Sie fest, wo diese Art von Umrandungslinie angebracht werden soll. 

Dazu klicken Sie einfach in der rechten Hälfte des Dialogs auf die gewünschten 

Linien (oder deren Schaltflächen). 

Sehen wir uns die einzelnen Schritte einmal etwas genauer an.  

Um Tabellenzellen mit Umrandungslinien zu versehen, gehen Sie wie folgt vor: 

1. Selektieren Sie die gewünschten Zellen. 

2. Rufen Sie den Menübefehl Format > Umrandung auf. 
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3. Legen Sie als erstes fest, was für eine Art von Umrandungslinie angebracht 

werden soll. Hierfür gibt es folgende Einstellmöglichkeiten: 

 Linienstil (einfache Linien, doppelte Linien oder gestrichelte Linien) 

 Liniendicke (die Stärke der Linie) 

 Farbe (die Farbe der Linie) 

4. Legen Sie dann fest, wo Sie diese Art von Umrandungslinie anwenden möchten 

(oben, unten, links, rechts, etc.).  

 Hierfür finden Sie in der rechten Hälfte des Dialogs einen Kasten mit einer 

Vorschau auf das Ergebnis, umgeben von einigen Schaltflächen. Verwenden Sie 

diese wie folgt: 

 A) Klicken Sie in der Vorschau in der rechten Hälfte des Dialogs einfach direkt 

auf alle Linien, an denen eine Umrandungslinie angebracht werden soll.  

 B) Alternativ können Sie hierfür auch die Schaltflächen verwenden, die links 

und unterhalb der Vorschau angezeigt werden. Jede Schaltfläche steht für eine 

bestimmte Linie (siehe Symbol auf der Schaltfläche). 

 C) Die Schaltflächen oberhalb der Vorschau sind nützliche Abkürzungen:  

 Die Schaltfläche Kontur wendet die eingestellte Umrandungslinie auf alle 

äußeren Linien an.  

 Die Schaltfläche Gitter macht das gleiche für alle inneren Linien (also die 

„Gitternetzlinien“).  

 Die Schaltfläche Keine entfernt alle Linien auf einmal. 

5. Wenn Sie möchten, können Sie noch weitere Linien anbringen, indem Sie ein-

fach Schritt 4. wiederholen.  

 Dabei können Sie die Einstellungen für die Linie (Stil, Dicke, Farbe) jederzeit 

ändern (Schritt 3.), bevor Sie diese anbringen (Schritt 4.). 

6. Wenn alles passt, bestätigen Sie mit OK. 

Die Tabellenzellen werden nun mit den entsprechenden Linien versehen. 

Vorhandene Umrandungslinien bearbeiten oder entfernen 

Sie können Linienstil, -dicke und -farbe von vorhandenen Umrandungslinien je-

derzeit ändern beziehungsweise Linien wieder entfernen. Rufen Sie den Dialog 

dazu erneut auf und gehen Sie wie folgt vor:  
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 Ändern: Um das Aussehen einer Linie zu ändern, nehmen Sie zuerst die ge-

wünschten Einstellungen vor (Linienstil, Liniendicke, Farbe). Dann klicken Sie 

in der Vorschau auf die Linie (oder ihre Schaltfläche), auf die Sie diese Einstel-

lungen anwenden möchten. 

 Entfernen: Um eine Umrandungslinie zu entfernen, klicken Sie in der Vorschau 

zwei Mal auf diese Linie (oder auf ihre Schaltfläche). Einmaliges Anklicken 

bringt die Umrandungslinie an, nochmaliges Anklicken entfernt sie wieder.  

 Tipp: Die Schaltfläche Keine oberhalb der Vorschau entfernt alle Linien. 

Tipp: Verwenden der Formatleiste 

Sie können alternativ auch das Symbol  ganz rechts in der Formatleiste ver-

wenden, um Umrandungslinien anzubringen. 

Gehen Sie dazu wie folgt vor: 

1. Selektieren Sie die gewünschten Zellen. 

2. Klicken Sie nicht auf das Symbol selbst, sondern auf den Pfeil rechts davon. Es 

öffnet sich ein Menü, in dem Sie gewünschte Art der Umrandung bestimmen 

können. Wählen Sie darin einen Eintrag per Mausklick. 

Die entsprechende Umrandung wird nun angebracht.  

Tipp: Wenn Sie anschließend noch weitere Zellen mit genau der gleichen Art von 

Umrandung versehen möchten, genügt es, diese zu markieren und das Symbol 

selbst (nicht den Pfeil) anzuklicken. PlanMaker wendet dann die zuletzt gewählte 

Art von Umrandung erneut an. 

Schattierung 

Auf der Karteikarte Schattierung im Dialogfenster des Menübefehls Format > 

Zelle können Sie Zellen mit einer farbigen Schattierung oder einem Muster hinter-

legen. 

Alternativ lässt sich dieses Kommando auch über den Menübefehl Format > 

Schattierung aufrufen. 
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Gehen Sie wie folgt vor: 

1. Selektieren Sie die gewünschten Zellen. 

2. Rufen Sie den Menübefehl Format > Schattierung auf. 

3. Bringen Sie die gewünschte Schattierung an (siehe unten). 

4. Bestätigen Sie mit OK. 

Dabei haben Sie die Wahl zwischen folgenden Arten von Schattierungen: 

 Ein Raster anbringen 

 Ein Raster ist eine Farbschattierung, die aus der gewählten Vordergrundfarbe 

und Hintergrundfarbe gemischt wird.  

 Um ein Raster anzubringen, wählen Sie bei Typ die Option Raster und nehmen 

dann die gewünschten Einstellungen vor:  

 Stellen Sie zuerst die gewünschte Vordergrundfarbe und Hintergrundfarbe 

ein. (Für die Hintergrundfarbe ist Weiß voreingestellt.) 

 In der Rubrik Raster werden nun verschiedene Mischungen dieser beiden Far-

ben vorgeschlagen. Wählen Sie einen dieser Vorschläge aus. Alternativ können 

Sie auch in das Eingabefeld unter Raster die gewünschte Mischung in Prozent 
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eintippen. Zulässig sind Werte zwischen 0 (100% Hintergrundfarbe) und 100 

(100% Vordergrundfarbe). 

 Ein Muster anbringen 

 Um ein Muster anzubringen, klicken Sie auf eines der Muster in der Rubrik 

Muster. 

 Weiterhin können Sie die Vordergrundfarbe und Hintergrundfarbe für das 

Muster auswählen.  

 Raster oder Muster entfernen 

 Möchten Sie ein gewähltes Raster oder Muster wieder entfernen, wählen Sie 

bei Typ die Option Keines. 

Schließlich bestätigen Sie mit OK. 

Tipp: Verwenden der Formatleiste 

Sie können alternativ auch das Symbol  ganz rechts in der Formatleiste ver-

wenden, um eine Schattierung anzubringen. 

Gehen Sie dazu wie folgt vor: 

1. Selektieren Sie die gewünschten Zellen. 

2. Klicken Sie nicht auf das Symbol selbst, sondern auf den Pfeil rechts davon. Es 

öffnet sich ein Menü, in dem Sie gewünschte Farbe bestimmen können. Wählen 

Sie diese per Mausklick. 

Die Schattierung wird nun angebracht.  

Tipp: Wenn Sie anschließend noch weitere Zellen mit der gleichen Schattierung 

versehen möchten, genügt es, diese zu markieren und das Symbol selbst (nicht 

den Pfeil) anzuklicken. PlanMaker wendet dann die zuletzt gewählte Schattie-

rung erneut an. 

Ausrichtung 

Auf der Karteikarte Ausrichtung im Dialogfenster des Menübefehl Format > Zel-

le können Sie die Ausrichtung des Zellinhalts innerhalb der Zelle bestimmen. 
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Bevor Sie diesen Befehl aufrufen, müssen Sie die gewünschten Zellen markieren. 

Soll nur eine einzige Zelle bearbeitet werden, reicht es, wenn Sie diese ansteuern. 

 

Das Dialogfenster dieses Befehls enthält folgende Optionen: 

Horizontale Ausrichtung 

Bestimmt die horizontale Ausrichtung des Zellinhalts innerhalb der Zellgrenzen: 

Standard: Text linksbündig, Zahlen rechtsbündig, Wahrheitswerte und Fehlerwerte 

zentriert 

Links: Zellinhalt am linken Rand der Zelle ausrichten 

Zentriert: Zellinhalt mittig ausrichten 

Rechts: Zellinhalt am rechten Rand der Zelle ausrichten 

Blocksatz: Zellinhalt gleichmäßig zwischen linkem und rechten Rand verteilen 

(wirkt sich nur auf Zellen mit mehrzeiligem Inhalt und aktivierter Option Zei-

lenumbruch aus) 

Zentriert über Spalten: Zentriert den Inhalt einer Zelle über mehrere Spalten. 

Markieren Sie dazu die Zelle sowie beliebige viele benachbarte Zellen rechts da-
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von (diese müssen leer sein!). Wählen Sie dann die Ausrichtung Zentriert über 

Spalten. 

Vertikale Ausrichtung 

Bestimmt die vertikale Ausrichtung des Zellinhalts innerhalb der Zellgrenzen: 

Unten: Zellinhalt am unteren Rand der Zelle ausrichten 

Zentriert: Zellinhalt vertikal zentrieren 

Oben: Zellinhalt am oberen Rand der Zelle ausrichten 

Vertikaler Blocksatz: Zellinhalt gleichmäßig zwischen oberem und unterem Rand 

verteilen (wirkt sich nur auf Zellen mit mehrzeiligem Inhalt und aktivierter Option 

Zeilenumbruch aus) 

Drehen um ... 

Hier können Sie die komplette Zelle (samt Inhalt) um den gewählten Winkel dre-

hen. 

Schreibrichtung 

Für Text in arabischer Schrift können Sie hier die Schreibrichtung der Zelle auf 

rechts-nach-links ändern.  

Tipp: Bei der Standardeinstellung Kontextabhängig stellt PlanMaker die korrekte 

Schreibrichtung automatisch ein. 

Siehe auch Kapitel „Arbeiten mit arabischem Text“ (ab Seite 419). 

Innenränder 

Hier können Sie die Innenränder der Zelle einstellen. 

Zeilenumbruch 

Ist diese Option aktiviert, wird der Zellinhalt automatisch in die nächste Zeile um-

brochen, falls die Zellenbreite nicht ausreicht, um ihn in einer einzigen Zeile anzu-

zeigen.  
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Tipp: Mit der Tastenkombination (Strg)(¢) können Sie dabei manuell Zeilenum-

brüche innerhalb einer Zelle vornehmen. 

Standardmäßig ist die Option ausgeschaltet. 

Vertikaler Text 

Ist diese Option aktiviert, wird der Zellinhalt nicht von links nach rechts, sondern 

von oben nach unten gezeichnet. 

Zellen verbinden 

Ermöglicht das Verbinden einer Zelle mit ihren benachbarten Zellen. Markieren Sie 

dazu die Zelle sowie beliebige viele direkt benachbarte Zellen und aktivieren Sie 

dann diese Option. 

Verbundene Zellen werden von PlanMaker so behandelt, als ob sie eine einzige 

Zelle wären.  

Hinweis: Wenn Sie Zellen verbinden, verlieren alle Zellen außer der linken oberen 

Zelle ihren Inhalt. 

Um die Verbindung wieder zu lösen, klicken Sie auf die verbundenen Zellen und 

schalten diese Option wieder aus. 

Schutz 

Auf der Karteikarte Schutz im Dialogfenster des Menübefehl Format > Zelle 

können Sie Zellen mit einem Zellschutz versehen. 

Sämtliche Informationen hierzu finden Sie im Abschnitt „Blattschutz“ ab Seite 

401. 

Zeichenformat 

Über den Menübefehl Format > Zeichen können Sie das Zeichenformat (Schrift-

art, Schriftgröße, Schriftfarbe, Textauszeichnungen etc.) ändern. 
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Worauf sich dieser Befehl auswirkt, hängt davon ab, was Sie markiert haben, bevor 

Sie ihn aufrufen: 

 Wenn Sie nichts markieren, wirkt sich der Befehl auf die Zelle aus, auf der sich 

der Zellrahmen momentan befindet. 

 Wenn Sie mehrere Zellen markieren, sind alle markierten Zellen von der Ände-

rung betroffen. 

 Sie können auch die Taste (F2) in einer Zelle drücken und dann Zeichen inner-

halb des Zellinhalts markieren, worauf nur die Zeichenformatierung dieser Zei-

chen geändert wird. 

Das Dialogfenster des Befehls Zeichen verfügt über drei Karteikarten, zwischen 

denen Sie wechseln können, indem Sie mit der Maus oben auf einen der Karteikar-

tenreiter klicken. 

 

Die einzelnen Karteikarten enthalten folgende Formatierungen: 

 Karteikarte Schrift 

 Schriftart und Schriftgröße, Textauszeichnungen (fett, kursiv, unterstrichen 

etc.), Schriftfarbe und Hintergrundfarbe wählen 
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 Karteikarte Abstand 

 Hoch- und Tiefstellen, Laufweite und Zeichenbreite verändern und Kerning 

(Unterschneidung von Zeichen) ein-/ausschalten 

 Karteikarte Hyperlink 

 Hyperlinks (Verknüpfungen) anbringen und bearbeiten. Lesen Sie dazu den 

Abschnitt „Hyperlinks verwenden“ ab Seite 385. 

Ausführliche Informationen zu den einzelnen Formatierungen finden Sie auf den 

nächsten Seiten. 

Schriftart und Schriftgröße 

Um die Schriftart und/oder -größe zu ändern, gehen Sie wie folgt vor: 

1. Markieren Sie die gewünschten Zellen oder den gewünschten Text. 

2. Rufen Sie den Menübefehl Format > Zeichen auf. 

3. Es erscheint ein Dialog. Wechseln Sie darin auf die Karteikarte Schrift, falls 

nötig. 

Nun können Sie die gewünschte Schriftart und -größe einstellen: 

 Um die Schriftart zu ändern, wählen Sie die gewünschte Schrift in der auf-

klappbaren Liste Schriftart.  

 In der aufklappbaren Liste Größe werden die gebräuchlichsten Schriftgrößen 

angeboten. Sie können aber jederzeit andere Werte von Hand eintippen. Die 

Schriftgröße lässt sich auf Zehntel genau eingeben – Schriftgrößen wie 11,9 

sind also auch zulässig. 

Verwenden der Formatleiste 

Sie können die Schriftart und -größe auch über die Formatleiste ändern. 

 

In der Formatzeile werden Schriftart und -größe angezeigt. Um diese zu ändern, 

markieren Sie erst den gewünschten Text und öffnen dann die Liste mit den 

Schriftarten beziehungsweise -größen, indem Sie auf das kleine Pfeilchen rechts 

daneben klicken. Jetzt können Sie eine Schriftart oder -größe per Mausklick aus-

wählen. 
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Textauszeichnungen 

Als Textauszeichnungen werden Zeichenformatierungen wie Fettdruck, Kursiv-

schrift etc. bezeichnet.  

Es gibt bei PlanMaker folgende Textauszeichnungen: 

 Kursiv: Eine schräg liegende Variante der Schrift. 

 Fett: Eine kräftigere („fettere“) Variante der Schrift. 

 Unterstreichen: Der Text wird unterstrichen (einfach, doppelt, wortweise ein-

fach, wortweise doppelt). 

 KAPITÄLCHEN: Anstelle von Kleinbuchstaben werden verkleinerte Großbuch-

staben ausgegeben. 

 GROSSBUCHSTABEN: Alle Zeichen werden in Großbuchstaben ausgege-

ben. 

 Durchstreichen: Der Text wird durchgestrichen. 

 Hochstellen (z.B. r2) und Tiefstellen (z.B. H20): Diese Textauszeichnungen 

sind auf der nächsten Karteikarte zu finden (siehe Abschnitt „Hochstellen und 

Tiefstellen“ ab Seite 193). 

Anbringen von Textauszeichnungen 

Um Text mit Textauszeichnungen zu versehen, gehen Sie wie folgt vor: 

1. Markieren Sie den gewünschten Text. 

2. Rufen Sie den Menübefehl Format > Zeichen auf. 

3. Es erscheint ein Dialog. Wechseln Sie darin auf die Karteikarte Schrift, falls 

nötig. 

Um Fettdruck und/oder Kursivschrift einzuschalten, öffnen Sie die Liste Stil 

(rechts neben der Schriftgröße) und wählen darin den gewünschten Eintrag: Nor-

mal, Kursiv, Fett oder Fett-kursiv. 

Weitere Textauszeichnungen finden Sie in der Sektion Auszeichnungen. Diese 

lassen sich dort per einfachem Mausklick ein- oder ausschalten. 

Textauszeichnungen können (nahezu) beliebig miteinander kombiniert werden. 
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Verwenden der Formatleiste 

Die gebräuchlichsten Textauszeichnungen lassen sich auch über die Formatleiste 

anbringen. 

 

Klicken Sie dazu das Symbol für die Textauszeichnung an, um diese ein- oder wie-

der auszuschalten: Das F steht für Fettdruck, das K für Kursivschrift und das U für 

einfaches Unterstreichen. 

Tastenkürzel 

Tipp: Für einige Textauszeichnungen sind außerdem Tastenkürzel verfügbar: 

Befehl  Windows/Linux  Mac 

Fettdruck            (Strg)(ª)(F)            (Cmd)(B) 

Kursivschrift  (Strg)(ª)(K)  (Cmd)(I) 

Unterstreichen  (Strg)(ª)(U)  (Cmd)(U) 

Schriftfarbe 

Sie können sowohl Text als auch seinen Hintergrund einfärben.  

Gehen Sie dazu wie folgt vor: 

1. Markieren Sie die gewünschten Zellen oder den gewünschten Text. 

2. Rufen Sie den Menübefehl Format > Zeichen auf. 

3. Es erscheint ein Dialog. Wechseln Sie darin auf die Karteikarte Schrift, falls 

nötig. 

In der Liste Schriftfarbe können Sie nun die gewünschte Farbe für den Text aus-

wählen. 

Über die Liste Hintergrundfarbe können Sie zusätzlich die Hintergrundfarbe än-

dern. Wählen Sie hier anstelle der Standardeinstellung Transparent eine andere 

Farbe, wird der Text mit dieser Farbe hinterlegt. 
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Tipp: Wenn Sie die Hintergrundfarbe auf diese Weise ändern, wirkt sich das nur 

die einzelnen Zeichen innerhalb der Zelle aus. Möchten Sie hingegen die kom-

plette Zelle einfärben, sollten Sie stattdessen den Menübefehl Format > Schat-

tierung verwenden. 

Anmerkungen 

 Farblisten bieten immer nur einige Standardfarben an, Sie können aber jederzeit 

auch andere Farben wählen. Klicken Sie dazu auf den Eintrag Andere... am 

Ende der Liste (siehe auch Abschnitt „Dokumenteigenschaften, Karteikarte 

Farben“ ab Seite 456). 

 Die Schriftfarbe lässt sich auch über das Symbol  in der Formatleiste 

ändern: 

 Dazu markieren Sie den gewünschten Text (oder die gewünschten Zellen), kli-

cken auf das Pfeilchen rechts neben diesem Symbol (also nicht auf das Symbol 

selbst). Dann wählen Sie die gewünschte Farbe aus der Liste, die sich daraufhin 

öffnet.  

 Tipp: Um weiteren Text in der gleichen Farbe zu formatieren, markieren Sie 

diesen wie üblich und klicken dann einfach auf das Symbol selbst.  

Hochstellen und Tiefstellen 

Sie können Zeichen auch hochstellen (z.B. r2) oder tiefstellen (z.B. H20). 

Gehen Sie dazu wie folgt vor: 

1. Markieren Sie die gewünschten Zellen oder den gewünschten Text. 

 Wenn Sie nur einzelne Zeichen innerhalb einer Zelle ändern wollen, so drücken 

Sie erst die Taste (F2), um einzelne Zeichen markieren zu können. 

2. Rufen Sie den Menübefehl Format > Zeichen auf. 

3. Wechseln Sie auf die Karteikarte Abstand. 

Nun können Sie die Optionen Hochstellen beziehungsweise Tiefstellen einschal-

ten. 

Auf Wunsch lässt sich zusätzlich bei Position angeben, um wie viel Prozent der 

Text hoch- beziehungsweise tiefgestellt werden soll. Weiterhin können Sie durch 

eine Prozentangabe im Feld Größe bestimmen, wie stark die Schriftgröße vermin-
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dert werden soll. Geben Sie beispielsweise 100 Prozent ein, wenn die Schrift nicht 

verkleinert werden soll. 

Laufweite und Zeichenbreite 

Sie können in PlanMaker sogar die Laufweite und die Zeichenbreite von Zeichen 

ändern. 

Die Laufweite bezeichnet den Abstand zwischen den einzelnen Zeichen. Bei Wer-

ten unter 100% rutschen die Zeichen enger zusammen, bei Werten größer als 100% 

weiter auseinander. 

Wenn Sie die Zeichenbreite ändern, wird nicht der Abstand zwischen den Zeichen, 

sondern die Breite der Zeichen selbst verändert – die Zeichen werden also verzerrt.  

Um diese Einstellungen zu ändern, rufen Sie den Menübefehl Format > Zeichen 

auf, wechseln auf die Karteikarte Abstand und tragen die gewünschten Werte bei 

Laufweite beziehungsweise Zeichenbreite ein. 

Hinweis: Manche Drucker unterstützen das Ändern der Zeichenbreite bei dru-

ckerinternen Schriften nicht. Die Schrift erscheint dann zwar auf dem Bildschirm 

breiter oder schmaler, nicht jedoch im Ausdruck. 

Kerning (Unterschneidung) 

Bei bestimmten Paaren von Buchstaben sieht das Schriftbild gleichmäßiger aus, 

wenn diese Buchstaben etwas näher zusammen oder weiter auseinander geschoben 

werden. Diesen Ausgleich bezeichnet man als Unterschneiden von Zeichen (eng-

lisch: Kerning). 

Die folgende Abbildung illustriert, was gemeint ist: 

 

Oben: ohne Kerning. Unten: mit Kerning 
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Beim oberen Text (ohne Kerning) sieht man, dass die Buchstaben „V“ und „A“ 

normalerweise zu weit auseinander stehen. Beim unteren Text (mit Kerning) wurde 

dies korrigiert. 

Dieser Ausgleich findet vollautomatisch statt. Sie müssen das Kerning lediglich 

aktivieren. Dazu markieren Sie die gewünschten Zellen (oder den gewünschten 

Text), rufen den Menübefehl Format > Zeichen auf, wechseln auf die Karteikarte 

Abstand und schalten die Option Kerning verwenden ein.  

PlanMaker korrigiert dann selbstständig den Zeichenabstand von allen Buchsta-

benpaaren, bei denen dies zu einer Verbesserung des Schriftbilds führt. 

Hinweis: Nicht alle Schriften enthalten in ihren Schriftdaten die hierfür erforder-

lichen Kerninginformationen. In diesen ist genau festgelegt, bei welchen Buch-

stabenkombinationen wie viel Ausgleich erforderlich ist. So gut wie alle von 

SoftMaker veröffentlichten Schriftensammlungen sind natürlich mit umfangrei-

chen Kerninginformationen ausgestattet. 

Zeichenformatierung zurücksetzen 

Einmal angebrachte Zeichenformatierungen lassen sich jederzeit wieder entfernen. 

Gehen Sie dazu wie folgt vor: 

1. Markieren Sie die gewünschten Zellen oder den gewünschten Text. 

2. Rufen Sie den Menübefehl Format > Standard auf. 

PlanMaker entfernt nun alle Zeichenformatierungen, die Sie über den Menübefehl 

Format > Zeichen oder die Formatleiste angebracht haben. 

Absatzformat (nur in Textrahmen) 

Wenn Sie Textrahmen in Ihre Tabelle eingefügt haben, können Sie die Absatzfor-

matierung (Zeilenabstand, Einzüge etc.) des enthaltenen Textes jederzeit ändern. 

Verwenden Sie dazu den Menübefehl Format > Absatz.  

Hinweis: Der Menübefehl Format > Absatz ist nur in Textrahmen verfügbar. 

Allgemeine Informationen zum Arbeiten mit Textrahmen finden Sie im Abschnitt 

„Textrahmen“ ab Seite 269. 
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Zu den Absatzformatierungen zählen folgende Optionen: 

 Einzüge 

 Zeilenabstand 

 Absatzausrichtung 

 Abstände oberhalb/unterhalb eines Absatzes 

 Trennhäufigkeit der Silbentrennung (siehe Abschnitt „Silbentrennung“) 

Details dazu finden Sie, in obiger Reihenfolge, auf den nächsten Seiten. 

Einzüge (nur in Textrahmen) 

Hinweis: Einzüge sind nur auf Text anwendbar, der in einen Textrahmen einge-

fügt wurde. Um Text in Tabellenzellen einzurücken, können Sie die Option In-

nenränder auf der Karteikarte Ausrichtung im Dialogfenster des Menübefehls 

Format > Zelle verwenden. 

Mit Hilfe von Einzügen können Sie den linken und rechten Rand von Absätzen in 

Textrahmen ändern, um Text ein- oder auszurücken. Der Einzug für die erste Zeile 

eines Absatzes lässt sich dabei getrennt einstellen. 

Um Einzüge zu verwenden, markieren Sie die gewünschten Absätze in dem Text-

rahmen und rufen dann den Menübefehl Format > Absatz auf. 

In der Rubrik Einzüge können Sie die Einzüge Von links, Von rechts und den 

Einzug für die Erste Zeile einstellen. Geben Sie hier die gewünschten Werte ein. 

Sie dürfen auch negative Werte für Einzüge eintragen. 

Zeilenabstand (nur in Textrahmen) 

Hinweis: Der Zeilenabstand ist nur bei Text änderbar, der in einen Textrahmen 

eingefügt wurde. 

Der Zeilenabstand bestimmt den Abstand zwischen den einzelnen Zeilen eines Ab-

satzes in einem Textrahmen. 

Um den Zeilenabstand zu verändern, gehen Sie wie folgt vor: 
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1. Setzen Sie die Schreibmarke in den gewünschten Absatz des Textrahmens (oder 

markieren Sie mehrere Absätze darin). 

2. Rufen Sie den Menübefehl Format > Absatz auf.  

 Die Optionen zum Ändern des Zeilenabstands finden sie in der Rubrik Zeilen-

abstand: 

3. Wählen Sie dort zunächst über die aufklappbare Liste aus, welche Methode 

zum Festlegen des Zeilenabstands verwendet werden soll (siehe unten). 

4. Tragen Sie dann rechts daneben das gewünschte Maß ein. 

Wenn Sie mit OK bestätigen, wird der Zeilenabstand entsprechend geändert. 

Methoden zum Festlegen des Zeilenabstands 

In der aufklappbaren Liste Zeilenabstand können Sie dabei wählen, welche Me-

thode zum Festlegen des Zeilenabstands verwendet werden soll. 

Die Liste hat folgende Einträge: 

 Einfach 

 Einfacher automatischer Zeilenabstand.  

 Hier wird der optimale Zeilenabstand automatisch ermittelt: 

 Wenn Sie beispielsweise die Schriftgröße in dem Absatz erhöhen, wird auch der 

Zeilenabstand entsprechend vergrößert.  

 Reduzieren Sie die Schriftgröße, wird der Zeilenabstand hingegen automatisch 

verkleinert. 

 Mehrfach 

 Mehrfacher automatischer Zeilenabstand.  

 Entspricht der Option Einfach, liefert also ebenfalls einen automatischen Zei-

lenabstand. Allerdings können Sie diesen bei Bedarf einfach vergrößern oder 

verkleinern, indem Sie in dem Eingabefeld rechts von dieser Option die ge-

wünschte Anzahl an Zeilen angeben. 

 Beispiele: 

 Tragen Sie bei Zeilen „1,5“ ein, um anderthalbfachen automatischen Zeilenab-

stand zu erhalten. 
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 Tragen Sie „2“ ein, um zweifachen automatischen Zeilenabstand zu erhalten. 

 Tragen Sie „1“ ein, um einfachen automatischen Zeilenabstand zu erhalten 

(entspricht dem Wählen der Option Einfach). 

 Genau 

 Fester Zeilenabstand. 

 Hier können Sie den Zeilenabstand auf einen festen Wert in Punkt setzen. Der 

Zeilenabstand wird dann nicht mehr automatisch an die Schriftgröße angepasst.  

 Mindestens 

 Mindest-Zeilenabstand. 

 Diese Einstellung entspricht der Option Einfach, verhindert jedoch, dass der 

angegebene Mindestwert unterschritten wird.  

 Tragen Sie als Mindestwert also 12 Punkt ein, verwendet das Programm norma-

lerweise einen einfachen automatischen Zeilenabstand. Unterschritte dieser je-

doch 12 Punkt (weil Sie eine sehr kleine Schrift verwenden), wird stattdessen 

ein fester Zeilenabstand von 12 Punkt verwendet. 

Standardmäßig ist der Zeilenabstand auf Einfach gesetzt. 

Absatzausrichtung (nur in Textrahmen) 

Hinweis: Die Absatzausrichtung ist nur bei Text einstellbar, der in einen Text-

rahmen eingefügt wurde. Um die Ausrichtung von Text in Tabellenzellen festzu-

legen, rufen Sie den Menübefehl Format > Zelle auf und wechseln auf die Kar-

teikarte Ausrichtung. 

Mit dem Menübefehl Format > Absatz kann auch die Ausrichtung von Textabsät-

zen geändert werden, die in einen Textrahmen eingefügt wurden. 

Folgende Arten der Absatzausrichtung stehen zur Wahl: 

 Linksbündig 

 Zentriert 

 Rechtsbündig 

 Blocksatz (Wörter gleichmäßig zwischen linkem und rechtem Rand verteilen) 



 

Handbuch PlanMaker Gestalten einer Tabelle  •  199 

Abstände oberhalb/unterhalb eines Absatzes (nur in 

Textrahmen) 

Hinweis: Der Abstand oberhalb/unterhalb eines Absatzes ist nur bei Text ein-

stellbar, der in einen Textrahmen eingefügt wurde. Um die Abstände zwischen 

Tabellenzellen festzulegen, können Sie jederzeit die Zeilenhöhe der Zellen än-

dern. 

Neben dem Zeilenabstand können Sie bei Text in einem Textrahmen auch festle-

gen, wie viel Platz oberhalb der ersten Zeile und unterhalb der letzten Zeile eines 

Absatzes freigehalten werden soll.  

Dies können Sie in der Rubrik Abstände im Dialogfenster des Menübefehls For-

mat > Absatz einstellen. Es gibt hier folgende Optionen: 

Option Bedeutung 

Oberhalb Geben Sie hier ein, wie viel Abstand zum Ende des vorherigen Ab-

satzes eingehalten werden soll. 

Unterhalb Hier ist einzutragen, wie viel Abstand PlanMaker zum Beginn des 

nächsten Absatzes einhalten soll. 

Zeichenvorlagen 

Mit dem Menübefehl Format > Zeichenvorlage können Sie „Zeichenvorlagen“ 

zum Einsatz bringen.  

In einer Zeichenvorlage lässt sich ein häufig benötigtes Zeichenformat (Schriftart, 

Schriftgröße, Textauszeichnungen etc.) speichern und dann immer wieder auf be-

liebige Zeichen (oder ganze Zellen) anwenden. 

Möchten Sie beispielsweise regelmäßig kleingedruckte Bereiche in einer anderen 

Schriftart und einer kleineren Größe drucken, erstellen Sie sich einfach eine ent-

sprechende Zeichenvorlage – nennen wir sie „Kleingedrucktes“ – und wenden die-

se an den gewünschten Textstellen an. 

Anmerkung: Der Unterschied zwischen Zeichenvorlagen und Zellenvorlagen (sie-

he Abschnitt „Zellenvorlagen“ ab Seite 204) liegt darin, dass in Zeichenvorlagen 

nur das Zeichenformat gespeichert wird, in Zellenvorlagen hingegen sowohl das 

Zeichenformat als auch das Zellenformat (Zahlenformat, Ausrichtung, Umrandung 
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etc.). Weiterhin sind Zeichenvorlagen auch auf einzelne Zeichen anwendbar, Zel-

lenvorlagen hingegen nur auf komplette Zellen. 

Ausführlichere Informationen zu diesem Feature folgen auf den nächsten Seiten. 

Zeichenvorlagen erstellen 

Um eine Zeichenvorlage zu erstellen, gehen Sie wie folgt vor: 

1. Rufen Sie den Menübefehl Format > Zeichenvorlage auf. 

2. Klicken Sie auf die Schaltfläche Neu. 

3. Geben Sie der Zeichenvorlage einen beliebigen Namen und bestätigen Sie mit 

OK. 

4. Es erscheint ein Dialogfenster, das dem des Menübefehls Format > Zeichen 

weitgehend entspricht. Stellen Sie hier die gewünschte Zeichenformatierung ein 

(siehe Abschnitt „Zeichenformat“ ab Seite 188). 

5. Wurden alle gewünschten Einstellungen vorgenommen, klicken Sie auf OK, 

um die Vorlage zu definieren. 

6. Verlassen Sie das Dialogfenster „Zeichenvorlage“ mit Schließen. 

Die Vorlage ist nun definiert und einsatzbereit. Wie Sie die neue Vorlage in der 

Praxis einsetzen, erfahren Sie im nächsten Abschnitt. 

Tastenkürzel verwenden 

Benötigen Sie eine Formatvorlage besonders häufig, können Sie ihr jederzeit ein 

Tastenkürzel geben. Das hat den Vorteil, dass Sie die Vorlage blitzschnell mit ei-

nem einzigen Tastendruck aktivieren können. 

Um einer Vorlage ein Tastenkürzel zuzuordnen, wechseln Sie im Dialog des Men-

übefehls Format > Zeichenvorlage auf die Karteikarte Vorlage, setzen die 

Schreibmarke in das Eingabefeld Tastenkürzel und betätigen die gewünschte Tas-

tenkombination.  
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Hinweis: Wenn Sie eine Tastenkombination betätigen, die bereits belegt ist, wird 

unter dem Eingabefeld Tastenkürzel angezeigt, womit diese momentan belegt 

ist. Sie sollten dann die Rücktaste (æ__) betätigen, um das Tastenkürzel wieder 

zu löschen und eine andere Tastenkombination verwenden. Andernfalls über-

schreiben Sie die Tastenkombination einer anderen Vorlage oder gar die eines 

PlanMaker-Befehls. 

Wir empfehlen Ihnen, für Formatvorlagen stets Tastenkombinationen mit den Tas-

ten (Strg) und (ª) zu verwenden, da diese normalerweise nicht belegt sind. 

Zeichenvorlagen anwenden 

Um eine Zeichenvorlage anzuwenden, gehen Sie wie folgt vor: 

1. Markieren Sie die gewünschten Zellen. Sie können auch einzelne Zeichen in-

nerhalb einer Zelle markieren, nachdem Sie die Taste (F2) betätigt haben. 

2. Rufen Sie den Menübefehl Format > Zeichenvorlage auf. 

3. Wählen Sie die gewünschte Vorlage. 

4. Klicken Sie auf Anwenden. 

Sofort ändert sich die Formatierung der markierten Zeichen so, wie Sie es in der 

Zeichenvorlage festgelegt hatten.  

Tipp: Sie können Zeichenvorlagen auch aus der Liste der Schriftarten in der 

Formatleiste auswählen. 

Noch schneller: Haben Sie der Formatvorlage ein Tastenkürzel zugewiesen, 

können Sie die Vorlage noch schneller anwenden: Markieren Sie die gewünsch-

ten Zellinhalte und betätigen Sie die gewählte Tastenkombination. 

Zeichenvorlagen ändern 

Selbstverständlich können Sie Zeichenvorlagen jederzeit wieder abändern. 

Wichtig: Wenn Sie die Formatierung einer Zeichenvorlage abändern, ändert sich 

automatisch die Formatierung aller Zeichen, die mit dieser Vorlage formatiert 

wurden. 

Um eine Zeichenvorlage zu bearbeiten, gehen Sie folgendermaßen vor: 
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1. Rufen Sie den Menübefehl Format > Zeichenvorlage auf. 

2. Wählen Sie die zu ändernde Vorlage aus der Liste. 

3. Klicken Sie auf Bearbeiten. 

4. Nehmen Sie die gewünschten Änderungen an der Vorlage vor. 

5. Klicken Sie auf OK. 

6. Verlassen Sie das Dialogfenster mit Schließen. 

Zeichenvorlagen löschen oder umbenennen 

Die Schaltfläche Löschen im Dialogfenster des Befehls Zeichenvorlage löscht die 

gewählte Vorlage im aktuellen Dokument.  

Um einer Vorlage einen neuen Namen zu geben, klicken Sie auf Umbenennen und 

tippen den neuen Namen ein. Auch dies wirkt sich nur auf das aktuelle Dokument 

aus. 

Um Formatvorlagen einer Dokumentvorlage zu löschen oder umzubenennen, öff-

nen Sie die Dokumentvorlage, nehmen die Änderungen darin vor und speichern die 

Dokumentvorlage. 

Zeichenvorlage Normal 

Die Zeichenvorlage namens „Normal“ existiert standardmäßig in jedem Dokument 

und hat eine besondere Bedeutung. Sie ist die Standardvorlage für alle Zellinhalte. 

Solange Sie in einem neuen Dokument einfach etwas eintippen, wird diesem auto-

matisch die Zeichenvorlage „Normal“ zugewiesen. 

Ändern Sie beispielsweise die Schriftart der Vorlage „Normal“, ändert sich dem-

entsprechend die Schrift in sämtlichen Zellen (außer bei Zellen, die Sie mit dem 

Menübefehl Format > Zeichen in einer anderen Schrift formatiert haben). Weiter-

hin haben Sie auf diese Weise die Standardschrift für zukünftige Eingaben geän-

dert. 

Verknüpfte Zeichenvorlagen erstellen 

Wenn Sie, wie zu Beginn dieses Kapitels beschrieben, neue Vorlagen erstellen, 

basieren diese stets auf der Zeichenvorlage „Normal“. Wählen Sie also beispiels-
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weise für die Vorlage „Normal“ eine neue Schriftart, ändert sich die Schrift auch in 

allen anderen Vorlagen – sofern dort keine andere Schrift gewählt wurde. 

Also: Normalerweise sind alle Zeichenvorlagen mit der Vorlage „Normal“ ver-

knüpft. Sie können aber beim Erstellen einer neuen Vorlage unter Basierend auf 

eine beliebige andere Zeichenvorlage als Basis angeben. 

Um eine Vorlage zu erstellen und diese auf einer bestimmten anderen Vorlage ba-

sieren zu lassen, gehen Sie folgendermaßen vor: 

1. Rufen Sie den Menübefehl Format > Zeichenvorlage auf. 

2. Klicken Sie auf die Schaltfläche Neu. 

3. Geben Sie der Zeichenvorlage einen Namen. 

4. Wählen Sie auf der Karteikarte Vorlage unter Basierend auf die Vorlage, mit 

der die neue Vorlage verknüpft sein soll. 

5. Nun können Sie die gewünschte Formatierung anbringen etc. 

Relative Schriftgröße 

Wenn Sie eine Vorlage auf einer anderen basieren lassen, können Sie auf Wunsch 

die relative Schriftgröße angeben. Sie können zum Beispiel festlegen, dass die 

Schriftgröße der Vorlage X stets 80% der Schriftgröße von Vorlage Y betragen soll. 

Gehen Sie dazu wie folgt vor: 

1. Rufen Sie den Menübefehl Format > Zeichenvorlage auf. 

2. Selektieren Sie eine Vorlage und klicken Sie auf Bearbeiten. 

3. Wechseln Sie auf die Karteikarte Vorlage. 

4. Schalten Sie die Option Größe ein. 

5. Tragen Sie den gewünschten Faktor in Prozent ein – zum Beispiel 80. 

6. Bestätigen Sie mit OK. 

Die Schriftgröße einer so bearbeiteten Vorlage wird nun stets 80% der Vorlage be-

tragen, auf der sie basiert. 
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Zellenvorlagen 

FreeOffice: Das Erstellen und Verwalten eigener Zellenvorlagen ist in SoftMa-

ker FreeOffice nicht enthalten. 

Mit dem Menübefehl Format > Zellenvorlage können Sie „Zellenvorlagen“ zum 

Einsatz bringen.  

In einer Zellenvorlage lässt sich ein bestimmtes Zellenformat (Zahlenformat, Aus-

richtung, Umrandung etc.) und bei Bedarf auch das Zeichenformat (Schriftart etc.) 

abspeichern. Einmal gespeichert, können Sie diese Zellenvorlage immer wieder auf 

beliebige Zellen anwenden. 

Möchten Sie beispielsweise regelmäßig Zellen mit dem Zahlenformat „Prozent“, 

rotem Hintergrund und fetter Schrift formatieren, erstellen Sie sich einfach eine 

entsprechende Zellenvorlage und wenden diese auf die gewünschten Zellen an. 

Anmerkung: Der Unterschied zwischen Zeichenvorlagen (siehe Abschnitt 

„Zeichenvorlagen“ ab Seite 199) und Zellenvorlagen liegt darin, dass in Zeichen-

vorlagen nur das Zeichenformat (Schriftart etc.) gespeichert wird, in Zellenvorla-

gen hingegen sowohl das Zeichenformat als auch das Zellenformat. Weiterhin sind 

Zeichenvorlagen auch auf einzelne Zeichen anwendbar, Zellenvorlagen hingegen 

nur auf komplette Zellen. 

Ausführliche Informationen zu diesem Feature folgen auf den nächsten Seiten. 

Zellenvorlagen anwenden 

Um eine Zellenvorlage anzuwenden, gehen Sie wie folgt vor: 

1. Navigieren Sie zu der Zelle, die Sie formatieren möchten. Alternativ können 

Sie natürlich auch mehrere Zellen selektieren, um deren Formatierung gemein-

sam zu ändern. 

2. Rufen Sie den Menübefehl Format > Zellenvorlage auf.  

 Es erscheint ein Dialog mit einer Liste aller Zellenvorlagen. 

 Tipp: Über die Option Anzeigen können Sie dabei bestimmen, ob in dieser 

Liste alle verfügbaren Vorlagen angezeigt werden sollen – oder nur die im ak-

tuellen Dokument bereits benutzten Vorlagen. 

3. Wählen Sie die anzuwendende Zellenvorlage in der Liste Vorlagen. 
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4. Klicken Sie auf Anwenden. 

Sofort ändert sich die Formatierung der markierten Zellen so, wie es in der Zellen-

vorlage festgelegt wurde.  

Tipp: Zellenvorlagen können auch über die aufklappbare Liste ganz links in der 

Formatleiste ausgewählt werden. 

Im Einzelnen kann eine Zellenvorlage folgende Formatierungsoptionen beinhalten: 

 Zahlenformat  

 Schrift (Schriftart und -größe, Textauszeichnungen etc.) 

 Ausrichtung der Zellen 

 Schattierung 

 Umrandung 

 Zellschutz 

Über die Sektion Format enthält in obigem Dialogfenster können Sie bei Bedarf 

genau festlegen, welche dieser Formatierungsoptionen angewendet werden sollen, 

wenn Sie die ausgewählte Vorlage anwenden (siehe auch nächster Abschnitt). 

Zellenvorlagen erstellen 

FreeOffice: Das Erstellen und Verwalten eigener Zellenvorlagen ist in SoftMa-

ker FreeOffice nicht enthalten. 

Um eine neue Zellenvorlage zu erstellen, gehen Sie wie folgt vor: 

1. Rufen Sie den Menübefehl Format > Zellenvorlage auf. 

2. Optional: Wählen Sie in der Liste Vorlagen diejenige Zellenvorlage aus, auf 

der ihre neue Vorlage basieren soll (oder wählen Sie einfach die Standardvorla-

ge „Normal“). 

3. Klicken Sie auf die Schaltfläche Neu. 

4. Geben Sie der Zellenvorlage einen beliebigen Namen und bestätigen Sie mit 

OK. 

5. Die neue Vorlage wurde nun angelegt, und Sie können sie wie folgt bearbeiten: 
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 Klicken Sie auf Zeichenformat, wenn Sie das Zeichenformat der Vorlage än-

dern möchten. Dazu erscheint ein Dialogfenster, das dem des Menübefehls 

Format > Zeichen weitgehend entspricht (siehe Abschnitt „Zeichenformat“ ab 

Seite 188). 

 Klicken Sie auf Zellenformat, wenn Sie das Zellenformat der Vorlage ändern 

möchten. Dazu erscheint ein Dialogfenster, das dem des Menübefehls Format 

> Zelle weitgehend entspricht (siehe Abschnitte „Zahlenformat“ ab Seite 168 

und folgende). 

6. Ist alles wunschgemäß, verlassen Sie das Dialogfenster mit Schließen. 

Die Vorlage ist nun definiert und einsatzbereit.  

Sie können für jedes Dokument eigene Zellenvorlagen erstellen; diese werden im 

Dokument gespeichert. 

Die Sektion „Format enthält“ 

In der Sektion Format enthält in obigem Dialog können Sie bei Bedarf genau 

festlegen, welche der Formatierungsoptionen angewendet werden sollen, wenn Sie 

die Zellenvorlage anwenden. 

So sollen beispielsweise Zellenvorlagen wie „Währung“ die Zellen lediglich mit 

dem Zahlenformat „Währung“ versehen – und sonst nichts verändern. Deshalb 

sind bei dieser Vorlage alle Optionen bis auf „Zahlenformat“ deaktiviert. 

Diese Einstellungen in dieser Sektion lassen sich für jede Vorlage einzeln vorneh-

men. 

Tastenkürzel verwenden 

Wenn Sie eine Zellenvorlage besonders häufig benötigen, können Sie ihr jederzeit 

ein Tastenkürzel geben. Das hat den Vorteil, dass Sie die Vorlage blitzschnell mit 

einem einzigen Tastendruck aktivieren können. 

Um einer Vorlage ein Tastenkürzel zuzuordnen, rufen Sie den Menübefehl Format 

> Zellenvorlage auf und selektieren die gewünschte Vorlage in der Liste. Dann 

klicken Sie in das Eingabefeld Tastenkürzel und betätigen die gewünschte Tasten-

kombination.  
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Hinweis: Wenn Sie eine Tastenkombination betätigen, die bereits belegt ist, wird 

unter dem Eingabefeld Tastenkürzel angezeigt, womit diese momentan belegt 

ist. Sie sollten dann die Rücktaste (æ__) betätigen, um das Tastenkürzel wieder 

zu löschen und eine andere Tastenkombination verwenden. Andernfalls über-

schreiben Sie die Tastenkombination einer anderen Vorlage oder gar die eines 

PlanMaker-Befehls. 

Wir empfehlen Ihnen, für Formatvorlagen stets Tastenkombinationen mit den Tas-

ten (Strg) und (ª) zu verwenden, da diese normalerweise nicht belegt sind. 

Zellenvorlagen ändern 

FreeOffice: Das Erstellen und Verwalten eigener Zellenvorlagen ist in SoftMa-

ker FreeOffice nicht enthalten. 

Selbstverständlich können Sie Zellenvorlagen jederzeit wieder abändern. 

Wichtig: Wenn Sie die Formatierung einer Zellenvorlage abändern, ändert sich 

die Formatierung aller Zellen, auf die diese Vorlage angewandt wurde, entspre-

chend. 

Um eine Zellenvorlage zu bearbeiten, gehen Sie folgendermaßen vor: 

1. Rufen Sie den Menübefehl Format > Zellenvorlage auf. 

2. Wählen Sie die zu ändernde Vorlage aus der Liste. 

3. Klicken Sie auf Zeichenformat, wenn Sie ihr Zeichenformat ändern möchten, 

beziehungsweise auf Zellenformat, wenn Sie ihr Zellenformat ändern möch-

ten. 

4. Wenn Sie fertig sind, verlassen Sie das Dialogfenster mit Schließen. 

Zellenvorlagen löschen oder umbenennen 

Die Schaltfläche Löschen im Dialog des Menübefehls Format > Zellenvorlage 

löscht die gewählte Vorlage im aktuellen Dokument.  

Um einer Vorlage einen neuen Namen zu geben, klicken Sie auf Umbenennen und 

tippen den neuen Namen ein. Auch dies wirkt sich nur auf das aktuelle Dokument 

aus. 
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Hinweis: Einige der Zellenvorlagen sind vorgegeben und können nicht gelöscht 

oder umbenannt werden. 

Zellenvorlage Normal 

Die Zellenvorlage namens „Normal“ existiert standardmäßig in jedem Dokument 

und hat eine besondere Bedeutung. Sie ist die Standardvorlage für alle Zellen. So-

lange Sie einer Zelle also keine andere Vorlage zuweisen, ist Sie immer in der Zel-

lenvorlage „Normal“ formatiert. 

Ändern Sie nun beispielsweise das Zahlenformat der Vorlage „Normal“, ändert 

sich sofort das Zahlenformat aller Zellen – außer bei Zellen, denen Sie ein anderes 

Zahlenformat „von Hand“ zugewiesen haben (zum Beispiel mithilfe des Menübe-

fehls Format > Zelle). 

Dokumentvorlagen 

Wie Sie in den letzten beiden Abschnitten erfahren haben, werden Zeichen- und 

Zellenvorlagen in dem Dokument gespeichert, in dem sie erstellt wurden. Wenn 

Sie solche Formatvorlagen auch in anderen Dokumenten verwenden möchten, soll-

ten Sie diese in einer Dokumentvorlage speichern.  

Jedes Mal, wenn Sie den Menübefehl Datei > Neu aufrufen, lässt Sie PlanMaker 

nämlich auswählen, auf welcher Dokumentvorlage das neue Dokument basieren 

soll. Wählen Sie hier eine von Ihnen erstellte Dokumentvorlage, stehen in dem 

neuen Dokument genau die Zeichen- und Zellenvorlagen zur Verfügung, die in der 

Dokumentvorlage vorhanden sind. 

Dokumentvorlagen können übrigens nicht nur Ihre bevorzugten Formatvorlagen 

enthalten, sondern auch mit Text, Werten etc. vorgefüllt sein. Erstellen Sie also Ihre 

„Schablonen“ für Rechnungen, Jahresberichte, Kostengegenüberstellungen etc. – 

schon wird das Erstellen neuer Tabellen zum Kinderspiel: einfach den Menübefehl 

Datei > Neu aufrufen, die Vorlage auswählen und die Tabelle fertig ausfüllen. 

Ausführlichere Informationen folgen auf den nächsten Seiten. 

Dokumentvorlagen erstellen 

Um eine neue Dokumentvorlage zu erstellen, gehen Sie folgendermaßen vor: 
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1. Beginnen Sie ein neues Dokument oder öffnen Sie das Dokument beziehungs-

weise die Dokumentvorlage, auf deren Basis die neue Dokumentvorlage erstellt 

werden soll.  

2. Erstellen Sie die gewünschten Zeichen- und Zellenvorlagen und/oder tragen Sie 

Text, Werte etc. ein, um die Vorlage zu erstellen. 

3. Rufen Sie den Menübefehl Datei > Speichern unter auf. 

4. Wählen Sie in der Liste Dateityp den Eintrag PlanMaker-Vorlage. 

5. PlanMaker wechselt nun automatisch in den Ordner, in dem sich die Doku-

mentvorlagen befinden. 

6. Tippen Sie bei Dateiname einen Namen für die Vorlage ein. 

7. Bestätigen Sie mit OK. 

Die Vorlage wird nun gespeichert. 

Dokumentvorlagen anwenden 

Um eine Dokumentvorlage zu verwenden, beginnen Sie einfach mit dem Menübe-

fehl Datei > Neu ein neues Dokument. PlanMaker fragt Sie dabei automatisch, auf 

welcher Dokumentvorlage dieses basieren soll: 

1. Rufen Sie den Menübefehl Datei > Neu auf. 

2. Wählen Sie die gewünschte Dokumentvorlage aus der Liste Vorlage.  

3. Klicken Sie auf OK. 

Es wird nun ein neues Dokument angelegt, in dem Ihnen alle in der Dokumentvor-

lage gespeicherten Zeichen- und Zellenvorlagen zur Verfügung stehen. Enthält die 

Dokumentvorlage auch ausgefüllte Zellen, werden diese entsprechend angezeigt 

und können ganz normal bearbeitet werden. 

Dokumentvorlagen ändern 

Das Ändern einer Dokumentvorlage unterscheidet sich nicht weiter vom Bearbei-

ten eines normalen Dokuments. Sie öffnen die Vorlage, nehmen Ihre Änderungen 

vor und speichern die Dokumentvorlage. 
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Wichtig: Das Ändern einer Dokumentvorlage wirkt sich auf alle Dokumente aus, 

die anschließend mit dieser Vorlage erstellt werden. 

Um eine Dokumentvorlage zu ändern, gehen Sie folgendermaßen vor: 

1. Rufen Sie den Menübefehl Datei > Öffnen auf. 

2. Wählen Sie in der Liste Dateityp den Eintrag PlanMaker-Vorlage. 

3. Suchen Sie sich die zu ändernde Vorlage aus und bestätigen Sie mit OK. 

4. Machen Sie die gewünschten Änderungen an den Zellen und/oder Vorlagen 

dieser Dokumentvorlage. 

5. Rufen Sie den Menübefehl Datei > Speichern auf, um geänderte Vorlage zu 

speichern. 

Sie können die Vorlage natürlich auch mit dem Menübefehl Datei > Speichern 

unter unter einem anderen Namen sichern, wenn das Original nicht überschrieben 

werden soll. 

Dokumentvorlage Normal.pmvx 

Die Dokumentvorlage NORMAL.PMVX ist die Standardvorlage für neue Dokumente. 

Wenn Sie den Menübefehl Datei > Neu aufrufen, wird stets diese Vorlage vorge-

geben. Sie ist gänzlich leer und enthält lediglich die Standardzeichenvorlage 

„Normal“ sowie die Standardzellenvorlage „Normal“. 

Dementsprechend eignet sich die Dokumentvorlage NORMAL.PMVX als Basis, wenn 

Sie eine völlig neue Vorlage erstellen möchten, in der zu Beginn nichts eingetragen 

sein soll. 

Wichtig: Die Standardvorlage NORMAL.PMVX sollten Sie normalerweise nicht 

ändern. Wenn Sie dies trotzdem tun möchten, sollten Sie sich bewusst sein, dass 

sich diese Änderungen auf alle Dokumente auswirken, die anschließend auf Ba-

sis dieser Vorlage angelegt werden. 

Möchten Sie also beispielsweise das Seitenformat für alle Dokumente ändern, die 

zukünftig auf Basis der Vorlage NORMAL.PMVX erstellt werden, dann öffnen Sie 

diese Vorlage, ändern das Seitenformat und speichern die Vorlage. 

Übrigens können Sie für neue Dateien auch eine andere Standardvorlage wählen. 

Rufen Sie dazu den Menübefehl Datei > Neu auf, wählen Sie die gewünschte Vor-

lage und klicken Sie auf Neuer Standard. Ab jetzt bietet Ihnen PlanMaker beim 

Anlegen neuer Dokumente stets diese Vorlage als Standardvorlage an. 
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AutoFormat 

Mit dem Menübefehl Format > AutoFormat können Sie das Layout ganzer Tabel-

lenbereiche auf einmal ändern. 

 

Der Dialog zu diesem Befehl zeigt Ihnen eine Liste mit vorgefertigten „AutoFor-

mat-Vorlagen“, deren Aussehen Sie im Feld Beispiel vorab begutachten können. 

Zur Anwendung einer AutoFormat-Vorlage genügt es, einen Tabellenbereich zu 

markieren, obigen Befehl aufzurufen, die gewünschte Vorlage auszuwählen und 

auf OK zu klicken. 

Über die Optionen im Bereich Anwenden können Sie dabei bestimmen, welche 

Formatierungen der Vorlage angebracht werden sollen. Schalten Sie beispielsweise 

alle Optionen bis auf Umrandungen aus, werden nur die Umrandungen der Auto-

Format-Vorlage angewandt; alle anderen Formatierungen der Tabelle bleiben erhal-

ten. 

Bedingte Formatierung 

Mit dem Menübefehl Format > Bedingte Formatierung können Sie Zellen mit 

einer bedingten Formatierung versehen. Diese wird nur angewandt, wenn eine be-

stimmte Bedingung erfüllt ist. So können Sie beispielsweise festlegen, dass eine 

Zelle immer dann rot eingefärbt werden soll, wenn sie einen Wert größer als 1000 

enthält.  

Auf den nächsten Seiten erfahren Sie alles Wissenswerte dazu. Folgende Themen 

werden darin behandelt: 
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 Neue Formatierungsregeln anlegen 

 Um Tabellenzellen mit einer bedingten Formatierung zu versehen, markieren 

Sie diese Zellen und legen dann eine sogenannte Formatierungsregel für sie an 

– zum Beispiel: „Wenn der Zellinhalt größer als 1000 ist, dann stelle die Zelle 

in roter Farbe dar.“ 

 Sie können beliebig viele Formatierungsregeln an einer Zelle anbringen – also 

beispielsweise eine zweite Regel anlegen, die die Zelle mit Fettdruck versieht, 

wenn der Zellwert kleiner als Null ist etc. etc. 

 Arten von bedingten Formatierungen 

 In diesem Abschnitt werden die unterschiedlichen Arten von bedingten Forma-

tierungen vorgestellt. 

 Formatierungsregeln verwalten 

 Mit dem Befehl Regeln verwalten können Sie alle im Dokument angebrachten 

bedingten Formatierungen zentral verwalten, sie also unter anderem bearbeiten 

und löschen.  

 Bedingte Formatierung entfernen 

 Im letzten Abschnitt erfahren Sie, wie Sie bedingte Formatierungen von Zellen 

wieder entfernen können. 

Neue Formatierungsregeln anlegen 

Um Tabellenzellen mit einer bedingten Formatierung zu versehen, markieren Sie 

diese Zellen und legen dann eine sogenannte Formatierungsregel für sie an. 

Eine Formatierungsregel hat immer zwei Bestandteile: 

 eine Bedingung 

 ... und die Formatierung, die angewandt werden soll, wenn diese Bedingung 

erfüllt ist.  

Einfaches Beispiel: „Wenn der Zellinhalt größer als 1000 ist, dann stelle die Zelle 

in roter Farbe dar.“ 

Um eine solche Regel zu definieren (und gleichzeitig anzuwenden), gehen Sie wie 

folgt vor: 

1. Steuern Sie die gewünschte Zelle an. Sie können natürlich auch mehrere Zellen 

markieren, um diese gemeinsam mit einer bedingten Formatierung zu versehen. 
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2. Rufen Sie den Menübefehl Format > Bedingte Formatierung > Neue Regel 

auf. 

3. Wählen Sie zuerst bei Typ, welche Art von Bedingung verwendet werden soll.  

 In unserem Beispiel wäre das die Option Nur Zellen formatieren, die enthal-

ten.  

 (Erläuterungen zu allen verfügbaren Optionen finden Sie im Abschnitt „Arten 

von bedingten Formatierungen“ weiter unten.) 

4. Nun können Sie die gewünschte Bedingung festlegen. 

 In unserem Beispiel wäre das die Bedingung „Zellwert größer als 1000“. Wäh-

len Sie also die Optionen Zellwert und Größer als. Dann tragen Sie rechts den 

Wert 1000 ein. 

5. Im letzten Schritt klicken Sie auf die Schaltfläche Format und wählen die 

Formatierung, die angebracht werden soll, wenn diese Bedingung zutrifft.  

 Für unser Beispiel wechseln Sie also auf die Karteikarte Schrift, stellen die 

Schriftfarbe auf Rot, und bestätigen Sie mit OK. 

6. Alle nötigen Einstellungen sind nun gemacht. Klicken Sie auf OK, um die neue 

Regel anzulegen. 

7. Schließen Sie den Dialog mit der Schaltfläche Schließen. 

Die Formatierungsregel wurde nun festgelegt – und auch gleich auf die selektierten 

Zellen angewandt. Dies hat folgenden Effekt: 

 Ist der Wert in der Zelle kleiner oder gleich 1000, wird die Zelle in ihrer ur-

sprünglichen Formatierung angezeigt. 

 Ist der Wert hingegen größer als 1000, wird die bedingte Formatierung ange-

wandt, der Zellinhalt also rot dargestellt. 

Tipp: Sie können übrigens beliebig viele Formatierungsregeln an einer Zelle an-

bringen – also beispielsweise eine zweite Regel anlegen, die die Zelle mit Fett-

druck versieht, wenn der Zellwert kleiner als Null ist etc. etc. 

Arten von bedingten Formatierungen 

Im vorherigen Abschnitt wurde beschrieben, wie Sie Zellen mit einer bedingten 

Formatierung versehen. In dem Dialog, der dabei erscheint, können Sie zwischen 

folgenden Arten von Formatierungsregeln wählen: 
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Alle Zellen basierend auf ihren Werten formatieren 

Bei dieser Art von bedingter Formatierung gibt es eigentlich gar keine Bedingung. 

Es werden vielmehr alle zuvor markierten Zellen umformatiert – und zwar ent-

sprechend der Werte, die sie enthalten. 

Wählen Sie hier beispielsweise eine 2-Farben-Skala von Rot nach Grün, wird der 

niedrigste Wert rot und der höchste grün hinterlegt. Die Werte dazwischen werden 

mit einem ihrer Größe entsprechenden Zwischenton versehen. Das Ergebnis ist ein 

Farbverlauf wie etwa folgender: 

 

Es gibt für diese Art von Formatierungsregel mehrere verschiedene Untertypen. Sie 

können diese über die Option Formatstil auswählen. Diese enthält folgende Ein-

träge: 

 2-Farbenskala 

 Wie in obigem Beispiel beschrieben. 

 3-Farbenskala 

 Entspricht der 2-Farbenskala, lässt Sie aber zusätzlich die Farbe für den Mit-

telwert festlegen. 

 Datenbalken 

 Hier werden im Hintergrund der Zellen Balken eingeblendet, die der relativen 

Größe des Wertes entsprechen – ähnlich einem Balkendiagramm: 
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 Symbolsätze 

 Hier wird in der Zelle ein Symbol eingeblendet, das die Größe des Wertes wie-

dergibt – zum Beispiel ein rotes Signallicht beim unteren Drittel der Werte, ein 

gelbes beim mittleren Drittel beziehungsweise ein grünes beim oberen Drittel: 

  

Nur Zellen formatieren, die ... enthalten 

Hier werden nur diejenigen Zellen umformatiert, die die angegebene Bedingung 

erfüllen. 

Legen Sie dazu zuerst die gewünschte Bedingung fest. Verwenden Sie dazu die 

entsprechenden Kontrollen und Eingabefelder in dem Dialog. 

Klicken Sie dann auf die Schaltfläche Format und stellen Sie die Formatierung 

ein, mit der die Zellen versehen werden sollen, bei denen die Bedingung erfüllt ist. 

Ein Beispiel hierfür haben wir Ihnen im vorherigen Abschnitt vorgestellt – und 

Ihnen gezeigt, wie Sie die bedingte Formatierung „Wenn der Zellinhalt größer als 

1000 ist, dann stelle ihn in roter Farbe dar“ anlegen. 
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Nur obere oder untere Werte formatieren 

Hier werden nur diejenigen Zellen umformatiert, die die höchsten beziehungsweise 

niedrigsten Werte innerhalb der markierten Zellen enthalten. 

Legen Sie dazu zuerst fest, welche Werte umformatiert werden sollen – zum Bei-

spiel die obersten 3 Werte oder die obersten 10% der Werte. 

Klicken Sie dann auf die Schaltfläche Format und bestimmen Sie die Formatie-

rung, mit der die entsprechenden Zellen versehen werden sollen. 

Werte über oder unter dem Durchschnitt formatieren 

Hier werden nur diejenigen Zellen umformatiert, deren Werte über beziehungswei-

se unter dem Mittelwert für die markierten Zellen liegen. 

Legen Sie dazu zuerst fest, welche Werte umformatiert werden sollen – zum Bei-

spiel alle Werte über dem Durchschnitt. 

Klicken Sie dann auf die Schaltfläche Format und bestimmen Sie die Formatie-

rung, mit der die entsprechenden Zellen versehen werden sollen. 

Eindeutige oder doppelte Werte formatieren 

Hier werden alle eindeutigen Werte (beziehungsweise alle doppelten Werte) inner-

halb der markierten Zellen umformatiert. 

Wählen Sie dazu zuerst aus, welche Werte umformatiert werden sollen:  

 alle eindeutigen Werte (Werte, die nur genau ein Mal vorkommen). 

 oder alle doppelten Werte (Werte, die mindestens zwei Mal vorkommen) 

Klicken Sie dann auf die Schaltfläche Format und bestimmen Sie die Formatie-

rung, mit der die entsprechenden Zellen versehen werden sollen. 

Formel verwenden, um die zu formatierenden Zellen zu bestimmen 

Hier werden nur diejenigen Zellen umformatiert, bei denen die angegebene Re-

chenformel den Wert WAHR zurückliefert. 

Tragen Sie dazu die gewünschte Rechenformel in den Dialog ein. Es sind nur Re-

chenformeln zulässig, die einen Wahrheitswert liefern (also WAHR oder 

FALSCH). Siehe auch Hinweise weiter unten. 
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Klicken Sie dann auf die Schaltfläche Format und bestimmen Sie die Formatie-

rung, mit der die entsprechenden Zellen versehen werden sollen. 

Einige Hinweise: 

 Formulieren geeigneter Rechenformeln 

 Für die Bedingung lassen sich beliebige Rechenformeln verwenden. Sie müs-

sen lediglich beachten, dass die Rechenformel immer einen Wahrheitswert (also 

WAHR oder FALSCH) als Ergebnis haben muss. 

 Beispiele: 

 Bei der Formel „SUMME($A$1:$C$3) > 42“ wird die bedingte Formatierung 

immer dann angebracht, wenn die Summe des Zellbereichs A1:C3 größer als 42 

ist. 

 Bei der Formel „ISTGERADE(ZEILE())“ wird die bedingte Formatierung an-

gebracht, wenn sich die Zelle in einer Zeile mit einer geraden Zeilennummer 

befindet. 

 Absolute und relative Adressen 

 Beachten Sie, dass in der Formel nicht nur absolute Zellbezüge (wie im obigen 

Beispiel), sondern auch relative Zellbezüge verwendet werden können. Diese 

werden hierbei wie folgt behandelt: 

 Ein absoluter Zellbezug – zum Beispiel $A$1 – bezieht sich immer auf die Zel-

le A1. 

 Ein relativer Zellbezug – zum Beispiel A1 – bezieht sich hingegen auf die Zelle 

in der linken oberen Ecke der Markierung. Das bedeutet:  

 Wenden Sie eine bedingte Formatierung auf eine einzelne Zelle an, bezieht 

sich A1 auf eben diese Zelle.  

 Hatten Sie zuvor einen Bereich von Zellen markiert, bezieht sich A1 auf die 

Zelle in der linken oberen Ecke der Markierung, A2 auf die Zelle darunter 

etc. 

Formatierungsregeln verwalten 

Mit dem Menübefehl Format > Bedingte Formatierung > Regeln verwalten 

können Sie die bedingten Formatierungen in einem Dokument verwalten, sie also 

unter anderem bearbeiten und löschen.  
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Verwenden Sie diesen Befehl wie folgt: 

1. Steuern Sie die Zelle an, deren Formatierungsregeln Sie bearbeiten möchten. 

Sie können natürlich auch mehrere Zellen markieren.  

2. Rufen Sie den Menübefehl Format > Bedingte Formatierung > Regeln ver-

walten auf. 

3. Es erscheint ein Dialog.  

 Anmerkung: Dieser Dialog zeigt standardmäßig nur die Regeln für die aktuelle 

Zelle (oder Markierung) an. Falls Sie hingegen alle Regeln im gesamten Ar-

beitsblatt sehen möchten, schalten Sie die Option Quelle auf Aktuelles Ar-

beitsblatt um (siehe unten). 

4. Führen Sie die gewünschten Änderungen an den Formatierungsregeln durch 

(siehe unten).  

5. Beenden Sie den Dialog mit der Schaltfläche Schließen. 

Bedienung des Dialogfensters 

Das Dialogfenster für diesen Befehl hat folgende Bedienelemente: 

 Quelle 

 Hier können Sie bestimmen, welche Formatierungsregeln in dem Dialog ange-

zeigt werden sollen:  

 Nur markierte Zellen: Nur Regeln anzeigen, die die momentan markierten 

Zellen betreffen (beziehungsweise die aktuelle Zelle, falls derzeit keine Zel-

len markiert sind) 

 Aktuelles Arbeitsblatt: Alle Regeln im aktuellen Arbeitsblatt anzeigen 

 Arbeitsblatt <Name>: Alle Regeln auf einem anderen Arbeitsblatt (sofern 

vorhanden) anzeigen 

 Liste Regeln 

 In der Liste Regeln werden alle Regeln für die aktuelle Markierung oder das 

gesamte Arbeitsblatt angezeigt (je nachdem, was Sie bei Quelle ausgewählt ha-

ben). 

 Dabei sind diejenigen Regeln, die die momentan markierten Zellen betreffen, 

mit Fettdruck hervorgehoben. 
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 Anhalten: Um die Kontrollkästchen in der Spalte Anhalten müssen Sie sich 

normalerweise nicht kümmern. Diese sind nur aus Gründen der Kompatibilität 

mit älteren Dokumenten vorhanden. (Hintergrund: Bei älteren Versionen von 

PlanMaker und Excel wurde die bedingte Formatierung für eine Zelle „ange-

halten“, wenn diese Zelle mit mehreren Regeln versehen war und eine dieser 

Regeln zutraf. Alle weiteren Regeln für die Zelle wurden dann ignoriert. Bei 

aktuellen Versionen von PlanMaker und Excel ist dies jedoch nicht mehr der 

Fall: Hier werden stets alle Regeln für eine Zelle beachtet.) 

 Pfeiltasten neben der Liste Regeln 

 Mit den Pfeiltasten neben der Liste Regeln können Sie die Rangfolge der For-

matierungsregeln ändern.  

 Um die Rangfolge einer Regel zu ändern, selektieren Sie diese in der Liste und 

schicken sie dann durch Anklicken der Pfeiltasten nach oben (= höherer Rang) 

oder unten (= niedriger Rang). 

 Dies kann notwendig sein, wenn ein Zellbereich mit konkurrierenden Formatie-

rungsregeln versehen wurde. Einfaches Beispiel: Eine Regel möchte die Zelle 

grün einfärben, eine andere Regel will sie hingegen rot einfärben. 

 Je weiter oben sich eine Regel in der Liste befindet, umso höher ist ihre Rang-

folge. 

Hinweis: Beachten Sie dabei, dass die Liste nicht die Reihenfolge wieder-

gibt, in der die Regeln abgearbeitet werden – im Gegenteil: Die Liste wird 

von unten nach oben abgearbeitet, damit die Regeln mit der höchsten Rang-

folge zuletzt angewandt werden. 

 Anwenden auf 

 Hier können Sie den Zellbereich ändern, auf den eine Regel angewandt werden 

soll.  

 Wählen Sie die Regel dazu in der Liste Regeln und tragen Sie dann den ge-

wünschten Zellbereich in dieses Eingabefeld ein. 

 Schaltfläche Neu 

 Legt, genau wie der Menübefehl Format > Bedingte Formatierung > Neue 

Regel, eine neue Formatierungsregel für die momentan im Arbeitsblatt mar-

kierten Zellen an.  

 Es erscheint dazu wieder der Dialog zum Erstellen von Regeln, der im Ab-

schnitt „Neue Formatierungsregeln anlegen“ (Seite 212) beschrieben wurde. 
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 Schaltfläche Bearbeiten 

 Lässt Sie die Regel bearbeiten, die momentan in der Liste Regeln ausgewählt 

ist. 

 Die Regel wird dann in allen Zellen geändert, auf die sie angewandt wurde – 

unabhängig davon, welche Zellen derzeit im Arbeitsblatt markiert sind. 

 Es erscheint dazu wieder der Dialog zum Erstellen von Regeln, der im Ab-

schnitt „Neue Formatierungsregeln anlegen“ (Seite 212) beschrieben wurde. 

 Schaltfläche Löschen 

 Löscht die Regel, die momentan in der Liste Regeln ausgewählt ist.  

 Die Regel wird dann von allen Zellen entfernt, auf die sie angewandt wurde – 

unabhängig davon, welche Zellen derzeit im Arbeitsblatt markiert sind. 

 Weitere Informationen zum Thema „Bedingte Formatierung entfernen“ finden 

Sie im nächsten Abschnitt. 

 Schaltfläche Gehe zu 

 Schließt den Dialog und springt zu dem Zellbereich für die Regel, die momen-

tan in der Liste Regeln ausgewählt ist. 

Bedingte Formatierung entfernen 

Zum Entfernen bedingter Formatierung gibt es zwei Möglichkeiten: 

A) Löschen von Formatierungsregeln 

Wenn Sie eine Formatierungsregel löschen, wird diese von allen Zellen entfernt, 

auf die sie angewandt wurde – ganz unabhängig davon, welche Zellen derzeit im 

Arbeitsblatt markiert sind. 

Gehen Sie wie folgt vor: 

1. Rufen Sie den Menübefehl Format > Bedingte Formatierung > Regeln ver-

walten auf. 

2. Es erscheint ein Dialog.  

 Anmerkung: Dieser Dialog zeigt standardmäßig nur die Regeln für die aktuelle 

Zelle (oder Markierung) an. Falls Sie hingegen alle Regeln im gesamten Ar-
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beitsblatt sehen möchten, schalten Sie die Option Quelle auf Aktuelles Ar-

beitsblatt um. 

3. Wählen Sie die zu löschende Regel in der Liste Regeln. 

4. Klicken Sie auf die Schaltfläche Löschen. 

Die ausgewählte Regel wird nun gelöscht – und somit von allen Zellen entfernt, die 

sie betraf. 

B) Entfernen aller bedingten Formatierungen von einem Zellbereich 

Es gibt noch eine andere Methode zum Entfernen von bedingter Formatierung: Bei 

dieser wird sämtliche bedingte Formatierung von den markierten Zellen entfernt. 

Gehen Sie dazu wie folgt vor: 

1. Markieren Sie die Zellen, von denen Sie sämtliche bedingte Formatierung ent-

fernen möchten. 

2. Rufen Sie den Menübefehl Format > Bedingte Formatierung > Regeln in 

den markierten Zellen löschen auf. 

 (Alternativ können Sie auch den Menübefehl Bearbeiten > Selektiv löschen > 

Bedingte Formatierung aufrufen, der genau das gleiche tut.) 

Die markierten Zellen werden nun von sämtlichen bedingten Formatierungsregeln, 

mit denen sie derzeit versehen sind, „befreit“.  

Alle Formatierungsregeln, die dadurch überflüssig werden, werden automatisch 

gelöscht. 

Gültigkeitsprüfung 

FreeOffice: Die Gültigkeitsprüfung ist in SoftMaker FreeOffice nicht enthalten. 

Wenn Sie Zellen mit einer Gültigkeitsprüfung versehen, können Sie damit folgen-

des erreichen: 

 Festlegen, dass in diesen Zellen nur noch bestimmte Arten von Werten (zum 

Beispiel nur Zahlen) innerhalb bestimmter Grenzwerte (zum Beispiel nur Werte 

zwischen 10 und 20) als gültig erachtet werden. 
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 Einen Infotext zum Ausfüllen der Zellen anzeigen lassen, sobald der Anwender 

diese Zelle ansteuert (zum Beispiel: „Hier bitte nur Zahlen zwischen 10 und 20 

eingeben!“). 

 Eine Fehler-, Warn- oder Infomeldung ausgeben lassen, wenn der Anwender 

dennoch Werte eingibt, die der Gültigkeitsprüfung nicht entsprechen. 

Dies ist nützlich, wenn Sie Tabellen erstellen, die von anderen Anwendern ausge-

füllt werden sollen, und Sie verhindern möchten, dass in diesen Zellen falsche Wer-

te eingetippt werden können. 

Wenn Sie beispielsweise möchten, dass in bestimmten Zellen nur noch Zahlen zwi-

schen 10 und 20 als gültig erachtet werden, gehen Sie dazu wie folgt vor: 

1. Selektieren Sie die gewünschten Zellen. 

2. Rufen Sie den Menübefehl Format > Gültigkeitsprüfung auf. 

3. Auf der Karteikarte Einstellungen können Sie bestimmen, welche Arten von 

Werten für die Zellen als gültig erachtet werden sollen – und Grenzwerte für 

die zulässigen Werte festlegen.  

 In unserem Beispiel wäre also einzustellen:  

 Zulässig sind: „Dezimalzahlen“ 

 Mit Werten: „zwischen“ 

 Minimum: 10 

 Maximum: 20 

4. Auf der Karteikarte Eingabemeldung können Sie (auf Wunsch) einen Infotext 

eintragen, der angezeigt wird, sobald der Anwender eine dieser Zellen ansteu-

ert.  

 Tragen Sie beispielsweise „Hier bitte nur Zahlen zwischen 10 und 20 einge-

ben!“ ein. Sie können die Eingabemeldung natürlich auch leer lassen. 

5. Auf der Karteikarte Fehlermeldung können Sie festlegen, was für eine Mel-

dung erscheinen soll, wenn der Anwender in die Zellen ungültige Werte ein-

tippt. 

 Über die Symbole im Bereich Typ bestimmen Sie zunächst die Art der Fehler-

meldung (siehe Erläuterungen weiter unten).  
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Wichtig: Der Typ der Meldung bestimmt auch, ob es dem Anwender erlaubt 

sein soll, trotzdem ungültige Eingaben zu machen. Nur beim Typ Fehlermel-

dung (erstes Symbol) weist PlanMaker ungültige Eingaben strikt zurück! 

 Weiterhin können Sie den Text der Meldung angeben. Wenn Sie nichts einge-

ben, wird eine Standardmeldung ausgegeben. 

 Wählen Sie hier beispielsweise den Typ Fehlermeldung (erstes Symbol) und 

tragen Sie auf Wunsch eine geeignete Meldung ein (zum Beispiel mit dem Titel 

„Eingabefehler“ und dem Text „Hier dürfen nur Zahlen zwischen 10 und 20 

eingegeben werden!“). 

6. Bestätigen Sie mit OK. 

In den gewählten Zellen werden jetzt nur noch Zahlen zwischen 10 und 20 als gül-

tig erachtet. Gibt der Anwender etwas anderes ein, erscheint eine Fehlermeldung. 

Hinweis: Beachten Sie dabei, dass die Gültigkeitsprüfung nur dann aktiv wird, 

wenn der Anwender Werte eintippt. Fügt der Anwender hingegen ungültige Wer-

te durch Kopieren und Einfügen ein (zum Beispiel mit dem Menübefehl Bear-

beiten > Einfügen), schlägt die Gültigkeitsprüfung nicht Alarm! 

Wenn Sie die Gültigkeitsprüfung wieder abschalten möchten, markieren Sie die 

betroffenen Zellen und wenden den Menübefehl Bearbeiten > Selektiv löschen > 

Gültigkeitsprüfung an. Alternativ können Sie auch erneut den Menübefehl For-

mat > Gültigkeitsprüfung aufrufen und bei Zulässig sind: wieder „Alle Werte“ 

auswählen. 

Das Dialogfenster des obigen Befehls verfügt über folgende Optionen: 

Karteikarte Einstellungen 

 Zulässig sind: 

 Mit dieser Option bestimmen Sie, welche Arten von Werten zulässig sind: 

Option Erläuterung 

Alle Werte Alle Arten von Werten zulassen (die Gültigkeitsprü-

fung also deaktivieren) 

Ganze Zahlen Nur ganze Zahlen zulassen 

Dezimalzahlen Nur Zahlen zulassen 
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Feste Listeneinträge Nur Einträge aus einer Liste von zulässigen Einträ-

gen zulassen. 

 Tragen Sie dazu in das Feld Quelle eine durch 

Strichpunkte getrennte Liste der erlaubten Werte ein 

– zum Beispiel Hund;Katze;Maus oder 1;2;3;4;5;6. 

 Alternativ können Sie auch ein Gleichheitszeichen 

und dahinter einen Zellbereich eintragen, der alle 

gültigen Einträge enthält. Enthalten die Zellen C1 

bis C3 also z.B. „Hund“, „Katze“ und „Maus“ und 

Sie geben bei Quelle =C1:C3 ein, sind nur noch 

diese drei Begriffe zulässig. 

 Über die Schaltfläche Einstellungen können Sie 

zusätzliche Optionen einstellen. 

Datumswerte Nur Datumsangaben zulassen 

Zeitwerte Nur Uhrzeiten zulassen 

Textlänge Nur Einträge (auch Zahlen) mit der angegebenen 

Textlänge zulassen 

Benutzerdefiniert Nur Einträge zulassen, die der angegebenen Bedin-

gung entsprechen. Tragen Sie diese anschließend im 

Feld Berechnung ein. Weitere Informationen dazu 

finden Sie am Ende dieses Abschnitts. 

 Mit Werten 

 Hier können Sie die zulässigen Werte weiter eingrenzen. Wählen Sie beispiels-

weise die Option Zwischen, können Sie darunter das Minimum und Maximum 

angeben, zwischen dem die Werte liegen müssen. 

 Minimum, Maximum etc. 

 Darunter legen Sie die Grenzwerte für die Eingaben fest. Tragen Sie beispiels-

weise als Minimum 10 und als Maximum 20 ein, werden nur noch Werte zwi-

schen 10 und 20 akzeptiert. 

 Sie können hier übrigens auch Rechenformeln verwenden. Tragen Sie bei Mi-

nimum zum Beispiel C1 ein, muss der Zellinhalt größer als der Inhalt der Zelle 

C1 sein. Tragen Sie SUMME(D2:D8) ein, muss der Zellinhalt größer als die 

Summe der Zellen D2 bis D8 sein etc. 

 Auswahlliste verwenden 

 Nur verfügbar, wenn bei Zulässig sind der Eintrag Feste Listenwerte gewählt 

wurde. Ist diese Option aktiviert, erscheint ein Pfeilchen am rechten Rand der 
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Tabellenzelle, wenn der Anwender sie ansteuert. Wird dieses Pfeilchen ange-

klickt, erscheint eine Liste aller zulässigen Werte zur Auswahl. 

 Leere Zellen ignorieren 

 Ist diese Option aktiviert, wird bei leeren Zellen keine Gültigkeitsprüfung vor-

genommen. Löscht der Anwender also beispielsweise den Zellinhalt, wird in 

der Zelle keine Gültigkeitsprüfung mehr vorgenommen (bis wieder ein Wert 

eintragen wird). 

Karteikarte Eingabemeldung 

Auf dieser Karteikarte können Sie einen Infotext zum Ausfüllen der Zellen anzei-

gen lassen (zum Beispiel „Hier bitte nur Zahlen zwischen 10 und 20 eingeben!“). 

Dieser wird angezeigt, wenn der Anwender diese Zelle ansteuert. 

Es gibt hierfür folgende Optionen: 

 Eingabemeldung anzeigen, wenn die Zelle markiert ist 

 Bestimmt, ob die Eingabemeldung angezeigt werden soll oder nicht. 

 Titel 

 Hier können Sie den Titel der Meldung angeben. 

 Meldung 

 Hier können Sie den Meldungstext angeben. 

Karteikarte Fehlermeldung 

Auf dieser Karteikarte können Sie die Fehler-, Warn- oder Infomeldung festlegen, 

die erscheinen soll, wenn der Anwender Daten eingibt, die der Gültigkeitsprüfung 

nicht entsprechen. 

Es gibt hierfür folgende Optionen: 

 Fehlermeldung anzeigen, wenn ungültige Daten eingegeben wurden 

 Bestimmt, ob die Fehlermeldung angezeigt werden soll oder nicht. 

 Anmerkung: Normalerweise sollten Sie diese Option eingeschaltet lassen, da 

eine Gültigkeitsprüfung nicht sonderlich hilfreich ist, wenn der Anwender nicht 

darauf hingewiesen wird, dass er ungültige Daten eingibt. 
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 Typ 

 Hier können Sie den Typ der Meldung festlegen. Klicken Sie dazu auf das ge-

wünschte Symbol. 

Wichtig: Der Typ der Meldung bestimmt auch, ob es dem Anwender erlaubt 

sein soll, dennoch ungültige Eingaben zu machen. Nur beim Typ Fehlermel-

dung (erstes Symbol) weist PlanMaker ungültige Eingaben strikt zurück! 

 Folgende Arten von Meldungen stehen zur Wahl: 

 Fehlermeldung (erstes Symbol): PlanMaker gibt eine Fehlermeldung aus. Der 

Anwender ist gezwungen, einen gültigen Wert anzugeben; ungültige Werte 

werden nicht akzeptiert. 

 Warnmeldung (zweites Symbol): PlanMaker gibt eine Warnmeldung aus. Der 

Anwender kann selbst entscheiden, ob er den ungültigen Wert dennoch in das 

Arbeitsblatt übernehmen möchte. 

 Infomeldung (drittes Symbol): PlanMaker gibt nur eine Infomeldung aus. Der 

Anwender muss diese lediglich bestätigen, und der ungültige Wert wird über-

nommen (sofern der Anwender nicht auf Abbrechen klickt). 

 Titel 

 Hier können Sie den Titel der Meldung angeben.  

 Wenn Sie nichts eintragen, wird ein Standardtext ausgegeben. 

 Meldung 

 Hier können Sie den Meldungstext angeben. 

 Wenn Sie nichts eintragen, wird ein Standardtext ausgegeben. 

Tipp: Wenn Sie im Meldungstext das festgelegte Minimum und/oder Maxi-

mum für die Zelle ausgeben möchten, verwenden Sie darin einfach die Platz-

halter %min und %max. Beispiel: „Fehler – hier sind nur Werte zwischen 

%min und %max erlaubt!“. 

Beispiele 

Abschließend einige Beispiele zur Verwendung dieser Funktion: 
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 Nur Werte innerhalb der angegebenen Grenzen zulassen 

 Wählen Sie auf der Karteikarte Einstellungen zunächst den gewünschten Typ 

von Werten. Sollen beispielsweise nur Datumsangaben zulässig sein, setzen Sie 

die Option Zulässig sind auf „Datumswerte“. Sollen nur Zahlen zulässig sein, 

verwenden Sie die Option „Dezimalzahlen“ etc. 

 Danach können Sie mit der Option Mit Werten die zulässigen Grenzwerte fest-

legen. Sollen beispielsweise nur Werte größer als Eins zulässig sein, wählen Sie 

dort den Eintrag „größer als“ und tragen darunter bei Minimum eine 1 ein. 

 Nur Werte mit einer bestimmten Länge zulassen 

 Wenn Sie beispielsweise verhindern möchten, dass Anwender einen Wert mit 

mehr als 40 Zeichen eingeben können, wählen Sie folgende Einstellungen:  

 Zulässig sind: „Textlänge“ 

 Mit Werten: „kleiner oder gleich“ 

 Maximum: 40. 

 Hinweis: Hierbei gelten Ziffern, Punkte, Kommas, Vorzeichen etc. genauso als 

ein Zeichen wie Buchstaben. 

 Eigene Formeln für die Gültigkeitsprüfung verwenden 

 Fortgeschrittene Anwender können bei Zulässig sind: auch die Option „Benut-

zerdefiniert“ wählen und dann eine beliebige Formel für die Gültigkeitsprüfung 

angeben.  

 Verwenden Sie dazu eine Formel, die einen Wahrheitswert (also entweder 

WAHR oder FALSCH) zurückliefert. Ist das Resultat der Formel WAHR, er-

achtet PlanMaker den Eintrag als gültig, ansonsten wird er als ungültig erachtet. 

 Ein Beispiel: Wenn Sie die Formel SUMME($A$1:$C$3) > 42 eintragen, wird 

die Eingabe nur dann als gültig erachtet, wenn die Summe des Zellbereichs 

A1:C3 größer als 42 ist. 

 Hinweis: Beachten Sie, dass in solchen Formeln nicht nur absolute Zellbezüge 

(wie im obigen Beispiel), sondern auch relative Zellbezüge verwendet werden 

können: 

 Absolute Zellbezüge wie $A$1 beziehen sich immer auf die Zelle A1. 

 Relative Zellbezüge wie A1 beziehen sich hingegen auf die Zelle in der linken 

oberen Ecke der Markierung. Wenden Sie eine Gültigkeitsprüfung auf nur eine 

Zelle an, bezieht sich A1 also auf eben diese Zelle. Hatten Sie zuvor einen Be-
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reich von Zellen markiert, bezieht sich A1 auf die Zelle in der linken oberen 

Ecke, A2 auf die Zelle darunter etc. 

Format übertragen 

Mit dem Menübefehl Format > Format übertragen können Sie blitzschnell die 

Formatierung von Zellen auf andere Zellen übertragen. 

Gehen Sie dazu wie folgt vor: 

1. Klicken Sie zuerst die Zelle an, deren Format Sie auf andere Zellen übertragen 

möchten. 

2. Rufen Sie den Menübefehl Format > Format übertragen auf. 

 Der Mauszeiger ändert sich nun in ein Fadenkreuz mit einem Pinsel:  

3. Ziehen Sie die Maus nun (bei gedrückter Maustaste) über die Zellbereiche, auf 

die das Format übertragen werden soll. Sie können diese Funktion dabei auf be-

liebig viele Zellbereiche oder Einzelzellen anwenden (Einzelzellen dazu ein-

fach anklicken). 

4. Wenn Sie fertig sind, rufen Sie den Befehl Format übertragen erneut auf oder 

drücken einfach die Taste (Esc). 

Übertragen wird dabei sowohl das Zeichenformat (Schriftart, Textauszeichnungen 

etc.) als auch das Zellenformat (Zahlenformat, Ausrichtung etc.). 

Übertragen des Formats ganzer Zellbereiche 

Sie können auch das Format ganzer Zellbereiche auf andere Zellen übertragen. 

Verfahren Sie dazu wie oben beschrieben, markieren jedoch bei Punkt 1. den Zell-

bereich, dessen Format übertragen werden soll. 

Markieren Sie beispielsweise drei Zellen, die mit rotem, grünem und blauem Hin-

tergrund formatiert sind, und übertragen deren Format auf einen anderen Zellbe-

reich, wird dieser Bereich abwechselnd mit rotem, grünem und blauem Hinter-

grund formatiert. 
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Seitenformat 

In diesem Abschnitt erfahren Sie, welche Möglichkeiten es gibt, ein Arbeitsblatt 

für den Ausdruck zu formatieren. 

Folgende Themen werden darin behandelt: 

 Seitenformat einstellen 

 Über den Menübefehl Datei > Seite einrichten können Sie unter anderem das 

Seitenformat für das aktuelle Arbeitsblatt festlegen. Dazu zählen Einstellungen 

wie Papiergröße, Papierausrichtung (Hoch- oder Querformat) und die Seiten-

ränder. 

 Optionen zum Seitenformat einstellen 

 Auf der Karteikarte Optionen desselben Befehls finden Sie verschiedene Opti-

onen für die Seitennummerierung, Druckrichtung etc. und können festlegen, 

welche Bestandteile des Arbeitsblatts gedruckt werden sollen. 

 Kopf- und Fußzeile einrichten 

 Auf der Karteikarte Kopf- und Fußzeilen können Sie das Dokument mit einer 

Kopfzeile und/oder Fußzeile versehen, die am Anfang beziehungsweise am En-

de jeder Druckseite des Arbeitsblatts ausgegeben wird. 

 Seitenumbruch manuell beeinflussen 

 Zur Seitenformatierung zählt weiterhin die Möglichkeit, den automatischen 

Seitenumbruch bei Bedarf von Hand zu beeinflussen. Hierzu dient der Menübe-

fehl Einfügen > Seitenumbruch. 

Auf den nächsten Seiten erfahren Sie alles Wissenswerte zu diesen Themen. 

Seitenformat einstellen 

Mit dem Menübefehl Datei > Seite einrichten können Sie unter anderem das Sei-

tenformat eines Arbeitsblatts festlegen. Dazu zählen Einstellungen wie Papierfor-

mat und -ausrichtung (Hochformat oder Querformat). 

Hinweis: Das Seitenformat kann für jedes Arbeitsblatt eines Dokuments anders 

eingestellt werden. Sie können also beispielsweise für ein Arbeitsblatt das Hoch-

format wählen und für ein anderes das Querformat. 
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Um das Seitenformat eines Arbeitsblatts zu ändern, rufen Sie den Menübefehl Da-

tei > Seite einrichten auf, wechseln auf die Karteikarte Seitenformat und nehmen 

dann die gewünschten Einstellungen vor: 

Ausrichtung 

Hier können Sie die Ausrichtung der Druckseiten festlegen: Hochformat oder 

Querformat. 

Papiergröße 

Hier bestimmen Sie das Format der Druckseiten. In der aufklappbaren Liste Pa-

piergröße werden alle vom derzeit gewählten Drucker unterstützten Papierformate 

angeboten; Sie können aber unter Breite und Höhe auch eigene Werte von Hand 

angeben. 

Ränder 

Hier können Sie die Seitenränder einstellen. 

Abstand zur Blattkante 

Hier können Sie bestimmen, wie viel Abstand zwischen Kopf- und Fußzeilen und 

der oberen beziehungsweise unteren Blattkante freigelassen werden soll. 

Hinweis: Kopf- und Fußzeilen werden stets in den oberen beziehungsweise unteren 

Seitenrand gedruckt. 

Papierschächte 

Nur unter Windows verfügbar: Falls Ihr Drucker über mehrere Papierschächte 

verfügt, können Sie hier einstellen, aus welchem Schacht der Drucker das Papier 

einziehen soll. Ist die Standardeinstellung Aus Druckereinstellung gewählt, 

nimmt PlanMaker keinen Einfluss auf den Papiereinzug. Soll beispielsweise die 

erste Seite aus Schacht 1 und alle weiteren aus Schacht 2 eingezogen werden, än-

dern Sie diese Einstellung einfach entsprechend. 
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Optionen zum Seitenformat einstellen 

Auf der Karteikarte Optionen des Menübefehls Datei > Seite einrichten können 

Sie Einstellungen vornehmen, die den Ausdruck des aktuellen Arbeitsblatts betref-

fen: 

Wiederholungszeilen/Wiederholungsspalten 

Falls das Arbeitsblatt Zeilenbeschriftungen oder Spaltenbeschriftungen enthält, und 

Sie möchten, dass diese auf allen Druckseiten wiederholt werden, dann tragen Sie 

diese hier ein.  

Verwenden Sie dazu die Schreibweise Startzeile:Endzeile beziehungsweise Start-

spalte:Endspalte. 

Enthält beispielsweise die erste Zeile einer langen Liste von Daten eine Beschrif-

tung, die auf allen Seiten wiederholt werden soll, so ist bei Wiederholungszeilen 

1:1 einzutragen. 

Möchten Sie hingegen, dass die Spalten A bis C auf jeder Seite wiederholt werden 

sollen, so tragen Sie bei Wiederholungsspalten A:C ein. 

Drucken 

Hier können Sie bestimmen, ob die folgenden Komponenten der Tabelle im Aus-

druck erscheinen sollen: 

 Zeilen- und Spaltenköpfe (die mit 1, 2, 3... beziehungsweise A, B, C... be-

schrifteten Schaltflächen links und oberhalb der Tabelle) 

 Gitternetz (die grauen Gitternetzlinien zwischen den Zellen) 

 Kommentare (mit dem Menübefehl Einfügen > Kommentar an Zellen ange-

brachte Kommentare). 

Außerdem lässt sich über die Option Farben festlegen, ob der Ausdruck in Farbe 

erfolgen soll: 

 Originalfarben: Der Ausdruck erfolgt farbig. 

 Graustufen: Farbiger Text wird in schwarz/weiß ausgegeben; farbige Objekte 

(Grafiken, Diagramme etc.) werden in Grautöne umgewandelt. 

 Nur Umrisse: Farbiger Text wird in schwarz/weiß ausgegeben; von Objekten 

werden nur die Umrisslinien (in schwarz/weiß) ausgegeben. 
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Zentrierungsoptionen 

Schalten Sie die Option Horizontal zentrieren ein, wird der zu druckende Tabel-

leninhalt horizontal auf der Druckseite zentriert. 

Analog zentriert die Option Vertikal zentrieren den Tabelleninhalt vertikal auf der 

Druckseite. 

Seitennummer 

Hier können Sie die Seitennummerierung beeinflussen: 

Automatisch: Die Druckseiten werden mit 1 beginnend durchnummeriert. 

Wert: Die Druckseiten werden mit dem hier eingetragenen Wert beginnend durch-

nummeriert. 

Tipp: Um auf einem Arbeitsblatt die Seitennummer ausgeben zu lassen, fügen 

Sie das Feld Seitennummer in eine Kopf- oder Fußzeile ein (siehe nächster Ab-

schnitt). 

Druckrichtung 

Hier bestimmen Sie, in welcher Reihenfolge PlanMaker Arbeitsblätter, die breiter 

als eine Druckseite sind, ausgeben soll. 

 Von links nach rechts 

 Es wird erst von links nach rechts und anschließend von oben nach unten ge-

druckt. 

 Von oben nach unten 

 Es wird erst von oben nach unten und anschließend von links nach rechts ge-

druckt. 

Druckbereich 

Hier können Sie einen Druckbereich für das aktuelle Arbeitsblatt definieren.  

Wenn ein Druckbereich definiert ist, werden beim Drucken des Arbeitsblatts nur 

noch diejenigen Zellen ausgegeben, die sich innerhalb dieses Zellbereichs befin-

den. Der Rest des Arbeitsblatts wird wegelassen. 
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Standardmäßig ist dieses Eingabefeld leer – es ist also kein Druckbereich definiert 

und das gesamte Arbeitsblatt wird gedruckt. Wenn Sie hier allerdings einen Zellbe-

reich (oder den Namen eines benannten Bereichs) eintippen, wird beim Ausdru-

cken des Arbeitsblatts generell nur noch dieser Bereich ausgegeben. 

Der Druckbereich kann für jedes Arbeitsblatt einer Tabelle gesondert angegeben 

werden. 

Wichtig: Diese Einstellung wird permanent im Dokument gespeichert. Wenn Sie 

das Dokument also später erneut öffnen und es ausdrucken, wird der Ausdruck 

auch weiterhin nur die Zellen innerhalb des Druckbereichs enthalten. Wenn Sie 

möchten, dass wieder das gesamte Arbeitsblatt ausgegeben wird, leeren Sie ein-

fach das Eingabefeld Druckbereich in diesem Dialog, um den Druckbereich zu 

entfernen. 

Tipp: Es gibt alternativ eine etwas komfortablere Methode zum Arbeiten mit 

Druckbereichen: Sie können einen Druckbereich für ein Arbeitsblatt auch definie-

ren, indem Sie den gewünschten Zellbereich selektieren und dann den Menübefehl 

Datei > Druckbereich > Druckbereich festlegen aufrufen. Auch für das Entfer-

nen des Druckbereichs für ein Arbeitsblatt gibt es ein eigenes Kommando: den 

Menübefehl Datei > Druckbereich > Druckbereich entfernen. 

Skalierungsoptionen 

Hier können Sie die Vergrößerungsstufe für Ausdrucke des Dokuments ändern.  

Die Standardeinstellung ist ein fester Skalierungsfaktor von 100% (sprich: die Ori-

ginalgröße). 

Um den Skalierungsfaktor zu ändern, wählen Sie erst den gewünschten Skalie-

rungsmodus und stellen Sie dann die gewünschte Vergrößerung ein: 

 Festen Skalierungsfaktor verwenden: Hier können Sie die Vergrößerungsstu-

fe manuell auf einen Prozentwert setzen. Es sind Werte zwischen 20 und 200 

Prozent zulässig. Bei 50% wird der Ausdruck beispielsweise halb so groß, bei 

200% doppelt so groß. 

Bei den anderen 4 Skalierungsmodi wird die Vergrößerungsstufe anhand Ihrer Vor-

gaben automatisch berechnet: 

 Höhe in Seiten festlegen: Hier können Sie die gewünschte Höhe des Aus-

drucks in Druckseiten vorgeben. Die entsprechende Vergrößerungsstufe ermit-

telt PlanMaker dann automatisch. 
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 Breite in Seiten festlegen: Analog lässt sich hier die gewünschte Breite des 

Ausdrucks in Druckseiten vorgeben. 

 Höhe und Breite in Seiten festlegen: Hier können Sie die gewünschte maxi-

male Höhe und Breite des Ausdrucks vorgeben. 

 Gesamtzahl der Seiten festlegen: Hier können Sie vorgeben, wie viele Seiten 

der Ausdruck insgesamt umfassen soll.  

Hinweis: Die automatisch ermittelte Vergrößerungsstufe kann dabei nicht 

kleiner als 20% werden. Wird dieser Wert unterschritten, verwendet PlanMa-

ker automatisch den zulässigen Minimalwert von 20%. Entsprechendes gilt 

für den Maximalwert von 200%. 

Kopf- und Fußzeile einrichten 

Sie können Arbeitsblätter auf Wunsch mit einer Kopfzeile und/oder einer Fußzeile 

versehen. Das sind Zeilen, die am oberen beziehungsweise unteren Ende jeder Sei-

te des Arbeitsblatts gedruckt werden. 

Hinweis: Kopf- und Fußzeilen können für jedes Arbeitsblatt separat definiert 

werden. 

Um beispielsweise die Kopfzeile des aktuellen Arbeitsblatts zu bearbeiten, gehen 

Sie wie folgt vor: 

1. Rufen Sie den Menübefehl Datei > Seite einrichten auf und wechseln Sie auf 

die Karteikarte Kopf- und Fußzeilen. 

 Alternativ können Sie auch den Menübefehl Einfügen > Kopf- und Fußzeile 

aufrufen, der genau das gleich tut. 
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2. Um eine der vordefinierten Arten von Kopfzeilen zu verwenden, wählen Sie 

diese in der aufklappbaren Liste im oberen Teil des Dialogs. 

 Um die Kopfzeile nach Ihren Wünschen anzupassen, klicken Sie auf die Schalt-

fläche Bearbeiten (siehe Abschnitt „Bearbeiten von Kopf- und Fußzeilen“ wei-

ter unten). 

 Um das Format der Kopfzeile zu ändern, klicken Sie auf die Schaltfläche For-

mat (siehe Abschnitt „Formatieren von Kopf- und Fußzeilen“ weiter unten). 

3. Bestätigen Sie mit OK. 

Die Kopfzeile wurde nun entsprechend geändert. 

Das Bearbeiten der Fußzeile funktioniert genauso (mit den Dialogelementen im 

unteren Teil des Dialogs). 

Tipp: Kopf- und Fußzeilen werden nicht im Dokument selbst angezeigt – sie er-

scheinen nur im Ausdruck. Sie können aber jederzeit den Menübefehl Datei > 

Druckvorschau aufrufen, um das Aussehen der Kopf- und Fußzeile zu begut-

achten. 
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Bearbeiten von Kopf- und Fußzeilen 

Wenn Sie in obigem Dialogfenster auf die Schaltfläche Bearbeiten klicken, kön-

nen Sie die Kopfzeile bzw. Fußzeile des Arbeitsblatts nach Belieben bearbeiten. 

 

Hierzu einige Anmerkungen: 

 Kopf- und Fußzeilen können aus bis zu drei Teilen bestehen 

 Die Eingabefelder in diesem Dialog sind dreigeteilt. Das liegt daran, dass Kopf- 

und Fußzeilen aus bis zu drei Teilen bestehen können: einem linken (linksbün-

digen), einem mittleren (zentrierten) und einem rechten (rechtsbündigen Be-

reich). So können Sie beispielsweise links das Datum, in der Mitte den Datei-

namen und rechts die Seitennummer ausgeben lassen. 

 Natürlich können Sie auch nur einen der drei Bereiche ausfüllen, wenn Sie bei-

spielsweise nur links den Dateinamen ausgeben lassen möchten. 

 Verwenden von Feldern für die Seitennummer etc. 

 Über die Schaltfläche Felder können Sie Felder in die Kopf- beziehungsweise 

Fußzeile einfügen. 

 Felder sind Platzhalter, die symbolisch für bestimmte Informationen stehen. 

Fügen Sie beispielsweise ein Feld für die Seitennummer ein, steht der Platzhal-

ter {\SEITENNUMMER} in dem Eingabefeld. Beim Ausdruck wird diese 

symbolische Angabe dann automatisch durch die Seitennummer ersetzt. 

 Es stehen folgende Felder zur Verfügung: 
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Feldname Funktion 

Name des Dokuments Dateiname des Dokuments (z.B. „Meine Tabel-

le.pmdx“) 

Name und Pfad des Dokuments Dateiname und Pfad des Dokuments (z.B. 

„C:\Tabellen\Meine Tabelle.pmdx“) 

Name des Arbeitsblatts Name des aktuellen Arbeitsblatts 

Seitennummer Seitennummer 

Seitenzahl Gesamtzahl der Seiten 

Druckdatum Aktuelles Datum (zum Zeitpunkt des Druckens) 

Druckzeit Aktuelle Uhrzeit (zum Zeitpunkt des Druckens) 

Änderungsdatum Datum, an dem das Dokument zuletzt geändert 

und (sprich: gespeichert) wurde 

Erstelldatum Datum, an dem das Dokument erstellt wurde 

 Um eines dieser Felder einzufügen, klicken Sie auf die Schaltfläche Felder und 

dann auf das gewünschte Feld. 

 Ändern der Zeichenformatierung 

 Über die Bedienelemente im oberen Teil des Dialogs können Sie das Zeichen-

format (Schriftart, Schriftgröße etc.) der Einträge ändern.  

 Hinweis: Markieren Sie zuvor den zu formatierenden Text (in einem der drei 

Eingabefelder). 

Formatieren von Kopf- und Fußzeilen 

Abgesehen von der Zeichenformatierung in Kopf- und Fußzeilen (siehe oben), 

können Sie auch Umrandungen und Schattierungen anbringen sowie Ausrichtung 

und Ränder abändern. Klicken Sie dazu im Hauptdialog des Menübefehl Einfügen 

> Kopf- und Fußzeile auf die Schaltfläche Format. 

Es erscheint ein Dialogfenster mit folgenden Karteikarten: 

 Karteikarte Schattierung 

 Hier können Sie die Kopf-/Fußzeile mit einer farbigen Schattierung oder einem 

Muster versehen. Die Bedienung der Optionen entspricht der im Abschnitt 

„Schattierung“ ab Seite 183. 
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 Karteikarte Umrandung 

 Hier können Sie die Kopf-/Fußzeile mit einer Umrandung oder einzelnen Um-

randungslinien versehen. Die Bedienung der Optionen entspricht der im Ab-

schnitt „Umrandung“ ab Seite 180. 

 Karteikarte Ausrichtung 

 Hier können Sie die Innenränder der Kopf-/Fußzeile ändern und die vertikale 

Ausrichtung festlegen. 

Tipp: Der Abstand der Kopf-/Fußzeile zur oberen/unteren Blattkante lässt sich 

nicht hier, sondern auf der Karteikarte Seitenformat einstellen. 

Kopf- und Fußzeilen vorübergehend deaktivieren 

Wenn Sie ein Dokument einmal ohne die definierten Kopf- oder Fußzeilen ausdru-

cken möchten, rufen Sie Einfügen/Kopf- und Fußzeile auf und schalten die Opti-

on Drucken aus. Die Kopf- oder Fußzeile bleibt dann erhalten, sie wird aber nicht 

mehr ausgedruckt. 

Möchten Sie die Kopf- und Fußzeilen später wieder ausgedruckt haben, schalten 

Sie die Option Drucken einfach wieder an. 

Seitenumbruch manuell beeinflussen 

Zur Seitenformatierung zählt weiterhin die Möglichkeit, den automatischen Sei-

tenumbruch bei Bedarf von Hand zu beeinflussen. 

Normalerweise erledigt PlanMaker den Seitenumbruch ohne Ihr Zutun: Er fügt 

automatisch einen Seitenumbruch ein, sobald das Ende der Druckseite erreicht ist. 

Auf dem Bildschirm wird dies sichtbar gemacht durch einen dunklen horizontalen 

beziehungsweise vertikalen Strich zwischen den Zellen. Hieran erkennen Sie, wo 

die Druckseite beim Ausdrucken unten beziehungsweise rechts abgeschnitten wird. 

Bei Bedarf haben Sie die Möglichkeit, einen Seitenumbruch manuell herbeizufüh-

ren. Rufen Sie dazu den Menübefehl Einfügen > Seitenumbruch auf. Es öffnet 

sich ein Untermenü mit folgenden Befehlen: 

 Mit Vor Zeile einfügen fügen Sie vor der aktuellen Zeile einen horizontalen 

Seitenumbruch ein.  



 

Handbuch PlanMaker Gestalten einer Tabelle  •  239 

 Über den Befehl Vor Zeile löschen können Sie einen solchen Umbruch wieder 

entfernen. Der Zellrahmen muss sich dabei direkt unter dem Umbruch befin-

den. 

 Vor Spalte einfügen fügt dagegen vor der aktuellen Spalte einen vertikalen 

Seitenumbruch ein.  

 Über den Befehl Vor Spalte löschen können Sie einen solchen Umbruch wie-

der entfernen. Der Zellrahmen muss sich dabei direkt rechts neben dem Um-

bruch befinden. 
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Suchen und Ersetzen 
In diesem Kapitel lernen Sie alle Funktionen zum Suchen und Ersetzen in Tabellen 

kennen: 

 Suchen und Ersetzen 

 Mit den Suchfunktionen von PlanMaker können Sie eine Tabelle nach einem 

bestimmten Suchbegriff durchsuchen – und die Fundstellen bei Bedarf durch 

etwas anderes ersetzen lassen. 

 Springen zu bestimmten Zelladressen 

 Mit dem Befehl Gehe zu ... können Sie zu bestimmten Zellen, Zellbereichen 

oder benannten Bereichen springen. 

 Springen zu bestimmten Bestandteilen einer Tabelle 

 Mit den drei Schaltflächen in der rechten unteren Ecke des Dokumentfensters 

können Sie zu bestimmten Bestandteilen einer Tabelle springen (zum Beispiel 

zum nächsten Fehlerwert oder Kommentar). 

Alles Weitere zu diesen Themen erfahren Sie auf den nächsten Seiten. 

Suchen 

Mit dem Menübefehl Bearbeiten > Suchen können Sie ein Dokument nach einem 

bestimmten Suchbegriff durchsuchen lassen. 

Gehen Sie dazu wie folgt vor: 

1. Falls Sie nur einen bestimmten Zellbereich durchsuchen möchten, müssen Sie 

diesen erst markieren. Wenn Sie nichts markieren, wird das komplette Arbeits-

blatt durchsucht. 

2. Rufen Sie den Menübefehl Bearbeiten > Suchen auf. 

3. Geben Sie bei Suchen nach: den Suchbegriff ein. 

4. Stellen Sie bei Bedarf die gewünschten Optionen für die Suche ein (siehe Ab-

schnitt „Erweiterte Suchfunktionen“ ab Seite 243). 

5. Betätigen Sie die Schaltfläche Suchen, um die Suche zu beginnen. 
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Wenn der Suchbegriff gefunden wird, setzt PlanMaker den Zellrahmen auf die Zel-

le, die den Suchbegriff enthält. 

Sie haben nun folgende Möglichkeiten: 

A) Sie klicken auf Weitersuchen, um zur nächsten Fundstelle zu gelangen. 

B) Sie beenden den Suchen-Dialog mit Schließen.  

Ersetzen 

Manchmal geht es nicht nur darum, einen Suchbegriff wiederzufinden, sondern 

man möchte ihn auch gleich durch etwas anderes austauschen. Hierzu dient der 

Menübefehl Bearbeiten > Ersetzen. 

Diesen setzen Sie wie folgt ein: 

1. Falls Sie nur einen bestimmten Zellbereich durchsuchen möchten, müssen Sie 

diesen erst markieren. Wenn Sie nichts markieren, wird das komplette Arbeits-

blatt durchsucht. 

2. Rufen Sie den Menübefehl Bearbeiten > Ersetzen auf. 

3. Geben Sie bei Suchen nach: den Suchbegriff ein. 

4. Geben Sie bei Ersetzen durch: den Begriff ein, durch den der Suchbegriff er-

setzt werden soll. 

5. Stellen Sie bei Bedarf die gewünschten Optionen für die Suche ein (siehe Ab-

schnitt „Erweiterte Suchfunktionen“ ab Seite 243). 

6. Betätigen Sie die Schaltfläche Suchen, um die Suche zu beginnen. 

Wenn der Suchbegriff gefunden wird, setzt PlanMaker den Zellrahmen auf die Zel-

le, die den Suchbegriff enthält. 

Sie haben nun folgende Möglichkeiten: 

A) Sie klicken auf Ersetzen, woraufhin der Suchbegriff durch den Ersatzbegriff 

ersetzt wird und PlanMaker zur nächsten Fundstelle springt. 

B) Sie klicken auf Weitersuchen, woraufhin PlanMaker zur nächsten Fundstelle 

springt – ohne den Begriff zu ersetzen. 
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C) Sie klicken auf Alle ersetzen, woraufhin PlanMaker alle Vorkommen des 

Suchbegriffs ersetzt. 

D) Sie beenden den Suchen-Dialog mit Schließen.  

Suchen/Ersetzen wiederholen 

Um einen Such- oder Ersetzungsvorgang zu wiederholen oder ihn nach Abbruch 

fortzuführen, rufen Sie den Menübefehl Bearbeiten > Suchen wiederholen bezie-

hungsweise Bearbeiten > Ersetzen wiederholen auf oder drücken einfach die 

Taste (F3).  

PlanMaker setzt die Suche nun fort und zeigt die nächste Fundstelle an. 

Erweiterte Suchfunktionen 

Wenn Sie im Dialog des Menübefehls Bearbeiten > Suchen oder Bearbeiten > 

Ersetzen auf die Schaltfläche Erweitern klicken, wird der Suchen-Dialog vergrö-

ßert und bietet zusätzliche Optionen an. 

Mit der Schaltfläche Reduzieren lässt sich der Dialog wieder verkleinern. So kön-

nen Sie selbst bestimmen, ob Sie lieber viele Einstellmöglichkeiten haben oder bei 

der Suche möglichst viel von der Tabelle sehen möchten.  

Der erweiterte Suchen/Ersetzen-Dialog bietet folgende Optionen zusätzlich: 

Rubrik „Suchen in“ 

Hier können Sie genau festlegen, wie die Tabelle durchsucht werden soll: 

 Suchen in 

 Über die aufklappbare Liste oben können Sie wählen, welche Bestandteile der 

Tabelle durchsucht werden sollen: die Zellen der Tabelle, deren Kommentare 

oder alle Rahmen (Textrahmen und Zeichnungen, die Text enthalten). 

 Formeln 

 Ist diese Option aktiviert, werden alle Rechenformeln in Zellen durchsucht.  
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 So können Sie beispielsweise nach „Summe“ suchen, um alle Zellen zu finden, 

in denen die Rechenfunktion SUMME verwendet wird. 

 Ergebnissen 

 Ist diese Option aktiviert, werden auch alle Ergebnisse von Rechenformeln 

durchsucht.  

 Suchen Sie also beispielsweise nach „4“, werden auch Zellen gefunden, in de-

nen die Berechnung =2+2 eingetragen ist. 

 (Diese Option ist nur beim Suchen verfügbar, nicht jedoch beim Ersetzen.) 

 Werten 

 Ist diese Option aktiviert, werden alle fest eingegeben Werte durchsucht (also 

von Hand eingetragene Zahlen, Zeichenketten etc.). 

 Gesamtes Dokument 

 Ist diese Option aktiviert, werden alle Arbeitsblätter des Dokuments durch-

sucht.  

 Ist sie ausgeschaltet, wird nur das aktuelle Arbeitsblatt durchsucht (bezie-

hungsweise alle Arbeitsblätter, die derzeit im Arbeitsblattregister markiert 

sind.) 

 Spaltenweise suchen 

 Ist diese Option aktiviert, wird die Tabelle Spalte für Spalte durchsucht. 

 Ist sie ausgeschaltet, wird die Tabelle Zeile für Zeile durchsucht. 

Rubrik „Optionen“ 

Hier können Sie weitere Einstellungen zum Suchvorgang vornehmen: 

 Groß-/Kleinschreibung beachten 

 Normalerweise wird die Groß-/Kleinschreibung des Suchbegriffs ignoriert. Bei 

der Suche nach „haus“ wird also gleichermaßen „Haus“, „haus“, „HAUS“, 

„HaUs“ etc. gefunden.  

 Schalten Sie diese Option jedoch ein, wird nur dann etwas gefunden, wenn die 

Groß-/Kleinschreibung der Fundstelle genau mit der des Suchbegriffs überein-

stimmt. Bei der Suche nach „haus“ wird dann also nur noch „haus“ gefunden.  
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 Ganze Zelle muss übereinstimmen 

 Normalerweise findet PlanMaker alle Zellen, die den Suchbegriff an irgendei-

ner Position enthalten. Suchen Sie also nach „Steuer“, werden auch Zellen ge-

funden, die den Inhalt „Steuererklärung“ oder „Einkommensteuer“ haben. 

 Schalten Sie diese Option hingegen ein, muss der gesamte Zellinhalt mit dem 

Suchbegriff übereinstimmen. Bei der Suche nach „Steuer“ werden dann also 

nur noch Zellen gefunden, die exakt den Inhalt „Steuer“ haben.  

Schaltfläche „Sonstiges“ 

Die Schaltfläche Sonstiges ermöglicht es Ihnen, die nachfolgenden Platzhalter im 

Suchbegriff zu verwenden: 

 Einzelnes beliebiges Zeichen (^?) 

 Dieser Platzhalter steht für ein einzelnes beliebiges Zeichen. Bei der Suche 

nach „M^?ller“, wird beispielsweise „Müller“, „Möller“, „Miller“ etc gefunden. 

 Mehrere beliebige Zeichen (^*) 

 Dieser Platzhalter steht für beliebig viele beliebige Zeichen. Bei der Suche nach 

„M^*er“ wird beispielsweise „Müller“, „Maier“, „Mittermayer“ etc. gefunden. 

 Caret (^^) 

 Sucht nach dem Zeichen „^“ (Zirkumflex oder Caret). 

Um einen dieser Platzhalter in den Suchbegriff einzufügen, klicken Sie die Schalt-

fläche Sonstiges an und wählen dann den gewünschten Platzhalter per Mausklick. 

Sie können Platzhalter in Ihrem Suchbegriff nach Belieben wiederholen und kom-

binieren. Weiterhin können Sie sie natürlich mit normalem Text mischen. 

Schaltfläche „Alle suchen“ 

Wenn Sie die Schaltfläche Alle suchen anklicken, wird eine Liste aller Vorkom-

men des Suchbegriffs angezeigt. Klicken Sie einen der Einträge an, springt Plan-

Maker zur entsprechenden Fundstelle im Dokument. 

Hinweis: Diese Schaltfläche steht nur zur Verfügung, wenn Sie bei Suchen in die 

Option Zellen gewählt haben. 
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Springen zu bestimmten Zelladressen 

Der Menübefehl Bearbeiten > Gehe zu dient dazu, den Zellrahmen auf eine be-

stimmte Zelle in der Tabelle zu setzen. 

Es erscheint dazu ein Dialogfenster, in dem Sie die gewünschte Zelladresse ange-

ben. Es ist sowohl eine einzelne Zelladresse (zum Beispiel D2) als auch ein Zellbe-

reich zulässig (zum Beispiel D2:D4). 

In der Liste unterhalb des Eingabefelds werden weiterhin alle mit dem Menübefehl 

Arbeitsblatt > Namen benannten Bereiche der Tabelle aufgeführt, so dass auch 

diese sofort angesprungen werden können. 

Wenn Sie mit OK bestätigen, markiert PlanMaker sofort die entsprechende Zelle 

beziehungsweise den entsprechenden Zellbereich. 

Tipp: Eine schnellere Methode 

Es gibt auch eine schnellere Methode: In der Bearbeitungsleiste (oberhalb des Ta-

bellenfensters) befindet sich links eine aufklappbare Liste, die normalerweise an-

zeigt, in welcher Zelle sich der Zellrahmen gerade befindet.  

 

Hier können Sie – genau wie im Dialogfenster des Menübefehls Bearbeiten > Ge-

he zu – die Adresse einer Zelle oder eines Zellbereichs eintippen. Drücken Sie an-

schließend die Eingabetaste (¢), markiert PlanMaker die entsprechende(n) Zel-

le(n). 

Und: Wenn Sie einen Mausklick auf das kleine Pfeilchen rechts neben der Liste 

durchführen, öffnet sich diese und bietet alle Bereichsnamen zur Auswahl an. Kli-

cken Sie einen Namen an, wird der entsprechende Bereich sofort markiert. 
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Springen zu bestimmten Bestandteilen einer 

Tabelle 

Mit den drei Schaltflächen in der rechten unteren Ecke des Dokumentfensters kön-

nen Sie zu bestimmten Bestandteilen einer Tabelle springen (zum Beispiel zum 

nächsten Fehlerwert oder Kommentar). 

 

Setzen Sie diese wie folgt ein: 

 Klicken Sie auf die Schaltfläche mit dem roten Punkt, erscheint ein kleines 

Menü. Darin können Sie auswählen, wonach gesucht werden soll (siehe unten). 

 Klicken Sie auf die Schaltfläche mit dem Pfeil nach oben, springt PlanMaker 

zur vorherigen Fundstelle. Haben Sie in dem Menü also beispielsweise „Feh-

lerwert“ gewählt, wird die vorherige Zelle mit einem Fehlerwert angezeigt. 

 Klicken Sie auf die Schaltfläche mit dem Pfeil nach unten, springt PlanMaker 

zur nächsten Fundstelle, also beispielsweise zur nächsten Zelle mit einem Feh-

lerwert. 

Über das Menü, das sich nach einem Klick auf den roten Punkt öffnet, bestimmen 

Sie also, wonach gesucht werden soll. Dieses Menü hat folgende Einträge: 

Menüeintrag Erläuterung 

Formel Springe zu Zellen, die eine Rechenformel enthalten 

Matrixformel Springe zu Zellen, die eine Matrixformel enthalten 

Konstante Springe zu Zellen, die einen festen Wert enthalten 

Fehlerwert Springe zu Zellen, die einen Fehlerwert enthalten 

(siehe auch Abschnitt „Fehlerwerte“ ab Seite 515) 

Fehlerhafte Zelle Springe zu Zellen, die fehlerhaft importiert worden 

sind – also beispielsweise Zellen, die eine Excel-

Rechenfunktion enthalten, die von PlanMaker nicht 

unterstützt wird. 

Kommentar Springe zu Zellen, die einen Kommentar enthalten 

Bedingte Formatierung Springe zu Zellen, die mit einer bedingten Formatie-

rung versehen wurden 
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Gültigkeitsprüfung Springe zu Zellen, die mit einer Gültigkeitsprüfung 

versehen wurden 

Alle Blätter durchsuchen Wenn diese Option aktiviert ist, durchsucht PlanMa-

ker alle Arbeitsblätter – ansonsten nur das aktuelle 

Blatt. 
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Objekte 

Sie können in ihre Dokumente verschiedene Arten von Objekten einfügen – zum 

Beispiel Diagramme, Grafiken, Textrahmen, Zeichnungen etc.  

In diesem Kapitel erfahren Sie alles Wissenswerte zum Umgang mit Objekten. Es 

ist in folgende Abschnitte gegliedert: 

 Objekte – Allgemeines (ab Seite 249) 

 Hier lernen Sie grundlegende Funktionen wie das Einfügen, Selektieren und 

Bearbeiten von Objekten kennen. 

 Objekte – fortgeschrittene Funktionen (ab Seite 267) 

 Dieser Abschnitt richtet sich an fortgeschrittene Anwender. Sie erfahren darin, 

wie man Objekte verbirgt, gruppiert etc. 

Im Anschluss stellen wir Ihnen die einzelnen Arten von Objekten im Detail vor: 

 Diagramme (siehe dazu Kapitel „Diagramme“ ab Seite 295) 

 Textrahmen (ab Seite 269) 

 Grafiken (ab Seite 273) 

 OLE-Objekte (ab Seite 279) 

 Zeichnungen (ab Seite 286) 

Objekte – Allgemeines 

In diesem Abschnitt finden Sie grundlegende Informationen zum Arbeiten mit Ob-

jekten: 

 Objekte einfügen 

 Selektieren von Objekten 

 Der Objektmodus 

 Position und Größe von Objekten ändern 

 Rotieren und Kippen von Objekten 

 Ausrichten und Verteilen von Objekten 

 Duplizieren von Objekten 

 Eigenschaften von Objekten ändern 
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Anschließend – im Abschnitt „Objekte – fortgeschrittene Funktionen“ – werden 

Funktionen für fortgeschrittene Anwender vorgestellt. 

Objekte einfügen 

Um beispielsweise eine Grafik einzufügen, gehen Sie wie folgt vor: 

1. Rufen Sie den Menübefehl Objekt > Neuer Grafikrahmen auf. 

2. Es erscheint ein Dialog. Wählen Sie darin die gewünschte Grafikdatei aus und 

bestätigen Sie mit OK. 

3. Der Grafikrahmen wird nun eingefügt.  

 Wenn Sie möchten, können Sie den Grafikrahmen anschließend noch verschie-

ben oder seine Größe ändern: 

 Zum Verschieben klicken Sie mit der Maus auf den Grafikrahmen und ziehen 

ihn dann (bei weiterhin gedrückter Maustaste) an die gewünschte Position.  

 Um die Größe zu ändern, ziehen Sie mit der Maus an einem der runden Greifer, 

die den Grafikrahmen umgeben.  

Auf ähnliche Weise verfahren Sie auch bei allen anderen Arten von Objekten.  

Informationen zu den einzelnen Arten von Objekten finden Sie in den Abschnitten 

„Diagramme“, „Textrahmen“ etc. (ab Seite 269). 

Selektieren von Objekten 

Wenn Sie ein Objekt bearbeiten möchten, müssen Sie es erst auswählen, sprich 

selektieren. Klicken Sie das gewünschte Objekt dazu einfach an. Es erscheint dann 

ein Rahmen um das Objekt, um anzuzeigen, dass es nun selektiert ist. 

Hinweis: Dies funktioniert allerdings nicht bei Textrahmen und anderen Objek-

ten mit transparenter Füllung. Um ein solches Objekt zu selektieren, klicken Sie 

auf die Umrandung, die es umgibt, oder wechseln in den Objektmodus (siehe 

nächster Abschnitt), in dem sich alle Arten von Objekten einfach per Mausklick 

selektieren lassen. 

Wenn ein Objekt selektiert wurde, können Sie nichts mehr in die Tabellenzellen 

eingeben, sondern nur noch das selektierte Objekt bearbeiten. Möchten Sie wieder 
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Tabellenzellen bearbeiten, klicken Sie einfach mit der Maus in die gewünschte 

Zelle. Die Selektion des Objekts wird dadurch aufgehoben. 

Der Objektmodus 

Am einfachsten gestaltet sich das Arbeiten mit Objekten im Objektmodus. 

Normalerweise arbeiten Sie mit PlanMaker im Editiermodus. In diesem Modus 

können Sie Daten oder Berechnungen in Tabellenzellen eingeben, diese bearbeiten, 

formatieren usw. 

Schalten Sie in den Objektmodus um, können Sie die Tabellenzellen nicht mehr 

bearbeiten. Dafür bietet dieser Modus viele Funktionen, die das Arbeiten mit Ob-

jekten erleichtern. So können Sie im Objektmodus beispielsweise alle Arten von 

Objekten einfach per Mausklick selektieren. 

Wichtig: Solange Sie sich im Objektmodus befinden, stehen Ihnen ausschließlich 

Funktionen zum Anlegen und Bearbeiten von Objekten zur Verfügung. Sie kön-

nen keine Zellen mehr bearbeiten, und ein Großteil der Menübefehle ist nicht 

verfügbar. 

Android: Ein Tipp für Android-Anwender: Um im Objektmodus durch das Doku-

ment zu scrollen, müssen Sie mit zwei Fingern über den Bildschirm wischen – 

nicht mit nur einem. 

Wechseln zwischen Editiermodus und Objektmodus 

Es gibt zahlreiche Möglichkeiten, um zwischen Editiermodus und Objektmodus zu 

wechseln: 

 Rufen Sie den Menübefehl Ansicht > Objektmodus auf, um in den Objektmo-

dus zu gelangen. Rufen Sie den Befehl noch einmal auf, um wieder im Editier-

modus zu landen. 

 Klicken Sie das Symbol  in der Formatleiste an, um in den Objektmodus zu 

wechseln. Klicken Sie es erneut an, gelangen Sie zurück in den Editiermodus. 

 Sie können auch mit der rechten Maustaste auf eine beliebige Position im Do-

kument klicken. Es öffnet sich dann ein Kontextmenü, aus dem Sie den Befehl 

Objektmodus beziehungsweise Objektmodus verlassen auswählen. 
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 Am schnellsten geht folgende Methode: Zeigen Sie mit der Maus auf eine be-

liebige freie Position im Dokument und führen Sie einen Doppelklick mit der 

rechten Maustaste durch, um zwischen Editier- und Objektmodus zu wechseln. 

 Außerdem können Sie vom Objektmodus jederzeit in den Editiermodus zu-

rückkehren, indem Sie auf eine beliebige Stelle im Text doppelklicken, an der 

sich kein Objekt befindet. 

Die Objektleiste 

Wenn Sie den Objektmodus aktivieren, wird die Formatleiste ausgeblendet. An 

ihrer Stelle erscheint die Objektleiste. 

 

Die Objektleiste 

Die Symbole in dieser Leiste dienen zum Anlegen und Bearbeiten von Objekten. 

Von links nach rechts: 

 Zwischen Objektmodus/Editiermodus wechseln 

 Textrahmen einfügen 

 Grafikrahmen einfügen 

 Diagrammrahmen einfügen 

 OLE-Objektrahmen einfügen (nur unter Windows verfügbar) 

 OLE-Objektrahmen mit dem SoftMaker Formeleditor* einfügen 

 OLE-Objektrahmen mit einem TextMaker-Objekt einfügen 

 OLE-Objektrahmen mit einem Presentations-Objekt einfügen 

 Linie oder Kurve einfügen 

 Rechteck einfügen 

 Rechteck mit abgerundeten Ecken einfügen 

 Ellipse oder Kreis einfügen 

 AutoForm einfügen 

 TextArt-Objekt einfügen 

 Selektierte Objekte gruppieren 

 Eigenschaften des selektierten Objekts bearbeiten 

 Objektliste (eine Liste aller Objekte im Dokument, siehe unten) 

* Nicht in allen PlanMaker-Versionen enthalten 

Tipp: Wenn Sie den Mauszeiger auf eines dieser Symbole bewegen, wird dessen 

Funktion in der Statuszeile angezeigt. 

Objektliste: Ganz rechts in der Leiste sehen Sie die Objektliste. In dieser sind alle 

im aktuellen Dokument enthaltenen Objekte aufgelistet. Sie können darin ein Ob-
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jekt anhand seines Namens auswählen: Klicken Sie auf die Liste, um sie zu öffnen, 

und wählen Sie dann das gewünschte Objekt per Mausklick. Dieses wird daraufhin 

selektiert.  

Selektieren im Objektmodus 

Im Objektmodus können Sie alle Arten von Objekten einfach per Mausklick selek-

tieren. 

Dies ist besonders bei Objekten mit transparenter Füllung (z.B. Textrahmen) sehr 

praktisch, da sich derartige Objekte im Editiermodus nur durch einen gezielten 

Mausklick auf den Rand des Objekts selektieren lassen. Im Objektmodus können 

Sie solche Objekte hingegen einfach an einer beliebigen Stelle anklicken, um sie zu 

selektieren. 

Um mehrere Objekte auf einmal zu selektieren, ziehen Sie mit der Maus einen 

Rahmen um die gewünschten Objekte. Alternativ können Sie auch bei gedrückter 

Umschalttaste (ª) mehrere Objekte nacheinander anklicken, um diese zu selektie-

ren. 

Springen von Objekt zu Objekt  

Sie können im Objektmodus auch zwischen den Objekten „hin- und herspringen“. 

Verwenden Sie dazu folgende Tasten: 

Taste Funktion 

(Tab) Nächstes Objekt selektieren 

(ª)(Tab) Vorheriges Objekt selektieren 

Position und Größe von Objekten ändern 

Folgendermaßen ändern Sie die Position und Größe von Objekten: 

Position von Objekten ändern 

Um die Position eines Objekts zu ändern, selektieren Sie es per Mausklick und 

betätigen dann die Richtungstasten auf der Tastatur oder ziehen es bei gedrückter 

Maustaste mit der Maus an die gewünschte Stelle. 
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Hinweis: Objekte sind in der Regel mit der Zelle verankert, die sich unter ihrer 

linken oberen Ecke befindet. Ein Objekt lässt sich zwar nach Belieben verschie-

ben, sobald Sie das Objekt aber an der Zielposition absetzen, „wirft es seinen 

Anker“ erneut: Das Objekt verankert sich dann mit der Zelle, die sich jetzt unter 

seiner linken oberen Ecke befindet. 

Das bedeutet: Fügen Sie oberhalb des Objekts eine neue Zeile ein, wandert auch 

das Objekt eine Zeile weiter nach unten, damit sich seine linke obere Ecke weiter-

hin in der verankerten Zelle befindet. Das Gleiche passiert, wenn Sie beispielswei-

se die Höhe von Zeilen oberhalb des Objekts ändern. 

Bei Bedarf können Sie dieses Verhalten ändern, indem Sie das Objekt selektieren, 

den Menübefehl Objekt > Eigenschaften aufrufen, auf die Karteikarte Format 

wechseln und die Option Positionierung ändern. Wählen Sie dort beispielsweise 

Von Zellposition und -größe unabhängig, bleibt das Objekt unbehelligt, wenn 

Sie Zellen oberhalb des Objekts einfügen oder löschen. Siehe dazu auch Abschnitt 

„Objekt-Eigenschaften, Karteikarte Format“ ab Seite 256. 

Größe von Objekten ändern 

Wenn Sie ein Objekt selektieren, erscheint ein blauer Selektionsrahmen um das 

Objekt, der auch einige runde „Greifer“ enthält. Wenn Sie mit der Maus an einem 

dieser Greifer ziehen, ändert das Objekt seine Größe entsprechend. 

Alternativ können Sie die Position und Größe von Objekten auch mit dem Menü-

befehl Objekt > Eigenschaften ändern. Auf der Karteikarte Format lassen sich 

diese Einstellungen exakt in Zahlenwerten festlegen. Weitere Details zu diesem 

Dialog finden Sie im Abschnitt „Objekt-Eigenschaften, Karteikarte Format“ ab 

Seite 256. 

Rotieren und Kippen von Objekten 

Hinweis: Nur Zeichnungen und Grafiken lassen sich rotieren und kippen; bei an-

deren Arten von Objekten ist dies nicht möglich. 

Wenn Sie ein Objekt selektieren, das sich drehen lässt, erscheint ein zusätzlicher 

grüner Greifer auf einer seiner Begrenzungslinien. Ziehen Sie mit der Maus an 

diesem Greifer, wird das Objekt rotiert. 
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Alternativ können Sie den gewünschten Drehwinkel auch von Hand festlegen. Se-

lektieren Sie das Objekt dazu, rufen Sie den Menübefehl Objekt > Eigenschaften 

auf, wechseln Sie auf die Karteikarte Format und tragen Sie in der Rubrik Dre-

hung den Winkel ein. 

Darüber hinaus können Sie Zeichnungen und Grafiken auch über den Menübefehl 

Objekt > Drehen oder Kippen drehen und kippen (spiegeln). 

Ausrichten und Verteilen von Objekten 

Um zwei oder mehr Objekte auszurichten oder gleichmäßig zu verteilen, selektie-

ren Sie diese und rufen dann den Menübefehl Objekt > Ausrichten oder verteilen 

auf.  

Es erscheint ein Untermenü, aus dem Sie die gewünschte Ausrichtung bezie-

hungsweise Verteilung auswählen können: 

 Linksbündig ausrichten 

 Horizontal zentrieren 

 Rechtsbündig ausrichten 

 Oben ausrichten 

 Vertikal zentrieren 

 Unten ausrichten 

 Horizontal verteilen 

 Vertikal verteilen 

Die letzten beiden Befehle funktionieren nur, wenn mindestens drei Objekte selek-

tiert sind. Sie sorgen dafür, dass die Objekte gleichmäßig verteilt werden (so dass 

anschließend alle den gleichen Abstand voneinander haben). 
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Duplizieren von Objekten 

Um eine Kopie eines Objekts zu erhalten, kopieren Sie dieses üblicherweise in die 

Zwischenablage und fügen es von dort aus wieder ein.  

Alternativ können Sie auch den Menübefehl Bearbeiten > Duplizieren verwen-

den. Dieser erstellt sofort eine Kopie des selektierten Objekts. 

Tipp: Noch schneller geht das Duplizieren mit der Maus: Wenn Sie die Taste 
(Strg) gedrückt halten und mit der Maus an einem Objekt ziehen, erhalten Sie 

ein Duplikat von diesem Objekt. 

Eigenschaften von Objekten ändern 

Zu den Eigenschaften eines Objekts zählt man beispielsweise dessen Größe, Fül-

lung, Umrandung etc. Diese lassen sich zentral mit dem Menübefehl Objekt > 

Eigenschaften bearbeiten. 

Um die Eigenschaften eines Objekts zu bearbeiten, selektieren Sie dieses zunächst 

per Mausklick. Dann rufen Sie den Menübefehl Objekt > Eigenschaften auf, wo-

rauf ein entsprechender Dialog erscheint. 

Tipp: Bei den meisten Arten von Objekten können Sie diesen Dialog auch blitz-

schnell mit einem Doppelklick auf das Objekt öffnen. 

Der Dialog verfügt über mehrere Karteikarten, zwischen denen Sie wechseln kön-

nen, indem Sie oben auf einen der Karteikartenreiter klicken. 

Auf den nächsten Seiten werden alle Karteikarten mit allen darin enthaltenen Opti-

onen ausführlich beschrieben. 

Objekt-Eigenschaften, Karteikarte Format 

Auf der Karteikarte Format können Sie Einstellungen zum Format des Objekts 

vornehmen, also beispielsweise seine Größe ändern. 

Verfügbare Optionen: 

 Rubriken Größe und Skalierung 

 Hier lässt sich die Größe des Objekts ändern. Tragen Sie dazu die gewünschte 

Breite und Höhe ein. Alternativ können Sie bei Horz. Faktor und Vert. Fak-
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tor angeben, auf wie viel Prozent seiner Originalgröße das Objekt vergrö-

ßert/verkleinert werden soll. 

 Haben Sie dabei die Option Seitenverhältnis beibehalten eingeschaltet, wir-

ken sich Änderungen an der Höhe automatisch auf die Breite aus (und umge-

kehrt). 

 Bei OLE-Objekten gibt es zusätzlich eine Option namens Skalierung beibe-

halten. Ist diese eingeschaltet ist, wirken sich Änderungen an der Größe eines 

OLE-Objekts innerhalb seiner Quellanwendung automatisch auch auf das Ob-

jekt in PlanMaker aus. Ist sie ausgeschaltet, bleibt das Objekt in PlanMaker 

immer gleich groß. (Hinweis: Nicht alle OLE-Quellanwendungen unterstützen 

dieses Feature.) 

 Rubrik Positionierung 

 Diese Option bestimmt, wie sehr das Objekt (was seine Position und Größe 

betrifft) von den Tabellenzellen abhängen soll, die sich unter ihm befinden. 

 Von Zellposition und -größe abhängig: Das Objekt verhält sich, als ob es in 

der Zelle unter seiner linken oberen Ecke verankert wäre. Fügen Sie also ober-

halb dieser Zelle neue Zeilen ein, wird das Objekt entsprechend nach unten ge-

schoben. 

 Darüber hinaus ändert das Objekt seine Größe mit den darunter befindlichen 

Zellen. Erhöhen Sie also die Breite dieser Zellen, wächst das Objekt entspre-

chend mit. 

 Nur von Zellposition abhängig: Auch hier verhält sich das Objekt, als ob es in 

der Zelle unter seiner linken oberen Ecke verankert wäre. Seine Größe ändert 

sich jedoch nicht, wenn Sie die Größe der Zellen unter dem Objekt ändern. 

 Von Zellposition und -größe unabhängig: Das Objekt behält seine ursprüng-

liche Position und Größe stets bei – unabhängig von den Zellen unter dem Ob-

jekt. 

 Rubrik Drehung 

 Nur bei Zeichnungen und Grafiken verfügbar.  

 Hier können Sie das Objekt drehen. Tragen Sie dazu den Winkel ein, um den 

das Objekt im Uhrzeigersinn gedreht werden soll. 

 Rubrik Kippen 

 Nur bei Zeichnungen und Grafiken verfügbar.  

 Hier können Sie das Objekt vertikal oder horizontal kippen. 
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Objekt-Eigenschaften, Karteikarte Füllung 

Hinweis: Diese Karteikarte ist nicht bei allen Arten von Objekten verfügbar. Und: 

Bei Grafiken wirken sich Änderungen an der Füllung nur auf die transparenten 

Teile der Grafik aus. 

Auf der Karteikarte Füllung können Sie festlegen, womit das Objekt ausgefüllt 

werden soll.  

Wählen Sie zunächst in der Liste Fülltyp die gewünschte Art der Füllung. An-

schließend können Sie zu jedem Fülltyp noch diverse Einstellungen vornehmen. 

Nachfolgend eine Liste aller Fülltypen inklusive ihrer Einstellungen: 

 Keine Füllung 

 Wenn Sie den ersten Fülltyp in der Liste wählen, wird das Objekt nicht gefüllt, 

ist also transparent. 

 Farbe 

 Bei diesem Fülltyp wird das Objekt mit einer Farbe gefüllt. Wählen Sie die 

gewünschte Farbe dazu in der Liste Farben.  

 Tipp: Farblisten bieten immer nur einige Standardfarben an, Sie können aber 

jederzeit auch andere Farben wählen. Klicken Sie dazu auf Weitere Farben 

und gehen Sie dann wie im Abschnitt „Dokumenteigenschaften, Karteikarte 

Farben“ ab Seite 456 beschrieben vor. 

 Mit der Option Transparenz können Sie auf Wunsch die Transparenz der Fül-

lung ändern. Zulässig sind Werte zwischen 0% (nicht transparent) und 100% 

(völlig durchsichtig). Setzen Sie diesen Wert also beispielsweise auf 75, ist die 

Füllung zu 75% durchsichtig. 

 Raster 

 Hier wird das Objekt mit einem Raster gefüllt. Wählen Sie dazu in der Liste 

Raster die Art des Rasters und stellen Sie dann die gewünschte Farbe für Vor-

dergrund und Hintergrund ein. 

 Mit der Option Transparenz können Sie auf Wunsch die Transparenz der Fül-

lung ändern. Zulässig sind Werte zwischen 0% (nicht transparent) und 100% 

(völlig durchsichtig). 

 Grafik 

 Hier wird das Objekt mit einer Grafik gefüllt. Über die Schaltfläche Öffnen 

können Sie bestimmen, welche Grafikdatei dies sein soll. Die zuletzt verwende-



 

Handbuch PlanMaker Objekte  •  259 

ten Grafiken werden außerdem in der Liste Grafiken angezeigt und lassen sich 

dort per Mausklick auswählen. 

 Weitere Optionen: 

 Mit dem Objekt drehen: Wenn Sie diese Option einschalten, dreht sich die 

Grafik mit, wenn Sie das zu füllende Objekt rotieren. 

 Spiegelung: Mit dieser Option können Sie die Grafik horizontal oder vertikal 

spiegeln. 

 Transparenz: Mit dieser Option können Sie auf Wunsch die Transparenz der 

Füllung ändern. Zulässig sind Werte zwischen 0% (nicht transparent) und 100% 

(völlig durchsichtig). 

 Als Textur kacheln: Wenn diese Option aktiviert ist, wird die Grafik in dem 

Objekt wie ein Kachelmuster wiederholt. 

 Über die Einstellungen in der Rubrik Kacheloptionen können Sie dann die 

Größe und Position der Kacheln ändern: Mit X-Skalierung und Y-Skalierung 

ändern Sie die Größe (in Prozent). Mit X-Versatz und Y-Versatz ändern Sie die 

Position. Die Option Ausrichtung bestimmt, an welcher Kante oder Ecke des 

zu füllenden Objekts die Kacheln ausgerichtet werden sollen. 

 Ist die Option Als Textur kacheln deaktiviert, lassen sich hier lediglich die 

Abstände zu den Kanten des zu füllenden Objekts einstellen. 

 Speichern: Mit dieser Schaltfläche können Sie die momentan ausgewählte 

Grafikdatei exportieren, also eine Kopie der Grafik unter einem beliebigen 

Namen auf Festplatte speichern. 

 Linearer Farbverlauf, Rechteckiger Farbverlauf etc. 

 Die untersten fünf Fülltypen sind verschiedene Arten von Farbverläufen. Wäh-

len Sie zunächst den gewünschten Typ von Farbverlauf in der Liste Fülltyp und 

dann einen der angebotenen Untertypen in der Liste Varianten. 

 In der Rubrik Optionen lässt sich das Aussehen des Farbverlaufs noch genauer 

festlegen: 

 Mit X-Versatz und Y-Versatz können Sie das Zentrum des Farbverlaufs ver-

schieben. Weiterhin lässt sich der Drehwinkel einstellen. 

Tipp: Sie können auch das Steuerkreuz im Feld Beispiel mit der Maus ver-

schieben oder rotieren, um diese Einstellungen zu ändern. 
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 Aktivieren Sie die Option Doppelter Farbverlauf, verläuft die Farbe bei-

spielsweise nicht nur von der Ausgangsfarbe zur Endfarbe, sondern auch wie-

der zurück zur Ausgangsfarbe. 

 In der Rubrik Farben können Sie die Farben für den Verlauf ändern: 

 Um eine Farbe zu ändern, klicken Sie zunächst auf eines der kleinen Dreiecke 

unter dem Balken für den Farbverlauf. Das linke Dreieck steht für die Aus-

gangsfarbe, das rechte Dreieck für die Endfarbe: 

  

 Wählen Sie dann die gewünschte Farbe aus der Liste Farbe darunter.  

 Mit der Option Transparenz lässt sich auf Wunsch die Transparenz für die 

gewählte Farbe ändern. Zulässig sind Werte zwischen 0% (nicht transparent) 

und 100% (völlig durchsichtig). 

 Sie können dem Farbverlauf sogar noch weitere Farben hinzufügen, indem Sie 

einen Doppelklick auf die gewünschte Position in dem Balken durchführen und 

dann eine Farbe auswählen. Auf die gleiche Weise, nämlich mit einem Doppel-

klick auf das Dreieck, lassen sich zusätzliche Farben auch wieder aus dem Ver-

lauf löschen. 

Objekt-Eigenschaften, Karteikarte Linien 

Hinweis: Diese Karteikarte ist nicht bei allen Arten von Objekten verfügbar.  

Auf der Karteikarte Linien können Sie festlegen, welche Art von Linien für das 

Objekt verwendet werden soll. Bei Zeichnungen betrifft dies die Linien, mit denen 

das Objekt gezeichnet wird; bei allen anderen Objekten die Linien, mit denen das 

Objekt umrandet wird. 

Verfügbare Optionen: 

 Varianten 

 Hier können Sie den gewünschten Linienstil auswählen.  

 Die Einträge in dieser Liste sind lediglich Vorgaben; über die weiteren Optio-

nen des Dialogs können Sie das Aussehen der Linien bei Bedarf noch genauer 

festlegen. 

 Farbe 

 Lässt Sie die Farbe der Linien festlegen. 
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 Strich 

 Hier können Sie festlegen, ob durchgezogene Linien oder gestrichelte Linien 

gezeichnet werden sollen. 

 Liniendicke 

 Hier können Sie die Liniendicke exakt in Zehntelpunkt angeben. 

 Transparenz 

 Mit der Option Transparenz können Sie auf Wunsch die Transparenz der Li-

nien ändern. Zulässig sind Werte zwischen 0% (nicht transparent) und 100% 

(völlig durchsichtig). 

 Startpunkt und Endpunkt 

 Nur bei Linien, Kurven und Verbindungslinien verfügbar. 

 Hier können Sie festlegen, ob am Startpunkt beziehungsweise Endpunkt der 

Linie ein Symbol gezeichnet werden soll. Wählen Sie beispielsweise für den 

Endpunkt einer Linie das Pfeilsymbol, sieht die Linie aus wie ein Pfeil. Bei Be-

darf können Sie weiterhin die Breite und die Höhe des Symbols ändern. 

Objekt-Eigenschaften, Karteikarte Schatten 

Hinweis: Diese Karteikarte ist nicht bei allen Arten von Objekten verfügbar.  

Mit Hilfe der Karteikarte Schatten können Sie das Objekt mit einem Schatten ver-

sehen. 

Verfügbare Optionen: 

 Varianten 

 Hier können Sie den gewünschten Typ von Schatten auswählen.  

 Die Einträge in dieser Liste sind lediglich Vorgaben; über die weiteren Optio-

nen des Dialogs können Sie das Aussehen des Schattens bei Bedarf noch ge-

nauer festlegen.  

 Skalierung 

 Hier können Sie die Größe des Schattens (im Verhältnis zur Größe des Objekts) 

ändern. 
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 Versatz 

 Hier können Sie die Position des Schattens ändern. 

 Perspektive 

 Hier können Sie den Neigungswinkel des Schattens ändern. 

 Bei bestimmten Varianten des Typs „Perspektivische Schatten“ lässt sich au-

ßerdem der Horizont ändern, was den Schatten perspektivisch verzerrt. Ist Ho-

rizont ein positiver Wert, liegt der Schatten vor dem Objekt; bei negativen 

Werten liegt er hinter dem Objekt.  

 Farbe 

 Hier können Sie die Farbe des Schattens ändern. 

 Unschärfe 

 Wenn Sie hier einen Wert größer als Null eintragen, wird der Schatten mit ei-

nem Unschärfeeffekt versehen. Je größer der Wert ist, desto weicher werden die 

Kanten des Schattens gezeichnet. 

 Transparenz 

 Hier können Sie die Transparenz des Schattens ändern. Zulässig sind Werte 

zwischen 0% (nicht transparent) und 100% (völlig durchsichtig). Bei einem 

Wert von 75 ist der Schatten also beispielsweise zu 75% durchsichtig. 

Objekt-Eigenschaften, Karteikarte 3D 

Hinweis: Diese Karteikarte ist nur bei Textrahmen und Zeichnungen verfügbar. 

Mit Hilfe der Karteikarte 3D können Sie das Objekt mit einem 3D-Effekt versehen. 

Verfügbare Optionen: 

 Varianten 

 Hier können Sie den gewünschten Typ von 3D-Effekt auswählen.  

 Die Einträge in dieser Liste sind lediglich Vorgaben; über die weiteren Optio-

nen des Dialogs können Sie das Aussehen des Effekts bei Bedarf noch genauer 

festlegen.  
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 Rubrik Optionen 

 Hier können Sie die Winkel, um die das Objekt um die Achsen rotiert werden 

soll, und die Tiefe des 3D-Effekts einstellen. 

 Rubrik 3D-Oberfläche 

 Seitenflächen: Die Farbe für die Seitenflächen des Objekts wird normalerweise 

automatisch eingestellt. Falls Sie eine andere Farbe verwenden möchten, akti-

vieren Sie die Option Seitenflächen und wählen darunter die gewünschte Far-

be. 

 Vorderfläche anpassen: Wenn diese Option aktiviert ist, wird auch die Vorder-

fläche des Objekts den Beleuchtungseinstellungen des 3D-Effekts entsprechend 

abgedunkelt. Die Beleuchtung können Sie mit der Schaltfläche Weiteres beein-

flussen. 

 Drahtmodell: Wenn Sie diese Option aktivieren, wird das Objekt wie ein 

Drahtgittermodell dargestellt. 

 Schaltfläche Weiteres 

 Klicken Sie auf diese Schaltfläche, können Sie auf die Beleuchtung für den 3D-

Effekt Einfluss nehmen. Es erscheint dazu ein eigener Dialog. Klicken Sie im 

Feld Beleuchtung auf die Position, an der sich die Lichtquelle befinden soll. 

Darüber hinaus können Sie die Intensität einstellen und bestimmen, welche Art 

von Oberfläche der 3D-Effekt simulieren soll. 

Objekt-Eigenschaften, Karteikarte Effekte 

Hinweis: Diese Karteikarte ist nicht bei allen Arten von Objekten verfügbar.  

Mit Hilfe der Karteikarte Effekte können Sie das Objekt mit diversen Effekten 

versehen. 

Verfügbare Effekte und Optionen: 

 Spiegelung 

 Wenn Sie die Option Spiegelungseffekt verwenden aktivieren, wird das Ob-

jekt so dargestellt, als ob es auf einer spiegelnden Oberfläche stehen würde. 

 Optionen: 

 Sichtbarer Teil des Objekts: Bestimmt, wie viel von dem Objekt in der Spie-

gelung zu sehen sein soll (in Prozent). 
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 Transparenz beginnt bei: Die Spiegelung wird nach unten hin weich ausge-

blendet. Dieser Wert bestimmt, wie transparent die Spiegelung ganz oben sein 

soll (in Prozent). 

 Y-Versatz: Verschiebt die Spiegelung nach oben oder unten. 

 Weiche Kanten 

 Wenn Sie die Option Weiche Kanten-Effekt verwenden aktivieren, werden 

die Umrandungslinien des Objekts mit einem Weichzeichner-Effekt versehen. 

 Optionen: 

 Breite: Bestimmt, wie stark der Effekt ausfallen soll. 

 Leuchteffekt 

 Wenn Sie die Option Leuchteffekt verwenden aktivieren, werden die Umran-

dungslinien des Objekts mit einem Leuchteffekt umgeben. 

 Optionen: 

 Breite: Bestimmt, wie stark der Leuchteffekt ausfallen soll. 

 Farbe: Ändert die Farbe für den Leuchteffekt. 

Objekt-Eigenschaften, Karteikarte Eigenschaften 

Auf der Karteikarte Eigenschaften lassen sich allgemeine Einstellungen für ein 

Objekt ändern. 

Verfügbare Optionen: 

 Name 

 Jedes Objekt in einem Dokument bekommt von PlanMaker automatisch einen 

eindeutigen Namen zugewiesen. Auf Wunsch können Sie hier einen anderen 

Namen eintragen.  

 Tipp: Der Name des momentan selektierten Objekts wird in der Objektleiste 

angezeigt. Klicken Sie in der Objektleiste auf den Namen, wird eine Liste aller 

vorhandenen Objekte geöffnet. Klicken Sie einen der anderen Namen an, wird 

das entsprechende Objekt selektiert. Auf diese Weise können Sie Objekte also 

anhand ihres Namens selektieren. 
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 Sichtbar 

 Diese Option ist standardmäßig aktiviert. Sie bewirkt, dass das Objekt auf dem 

Bildschirm angezeigt wird (siehe auch Abschnitt „Verbergen von Objekten“ ab 

Seite 267). 

 Schalten Sie diese Option aus, wird das Objekt unsichtbar. 

 Drucken 

 Diese Option ist standardmäßig aktiviert. Sie bewirkt, dass das Objekt im Aus-

druck erscheint, wenn Sie das Arbeitsblatt ausdrucken (siehe auch Abschnitt 

„Verbergen von Objekten“ ab Seite 267). 

 Sperren 

 Diese Option ist standardmäßig aktiviert. Sie bewirkt, dass sich Größe, Position 

und auch alle andere Eigenschaften des Objekts nicht mehr ändern lassen, wenn 

Sie den Blattschutz einschalten (siehe auch Abschnitt „Blattschutz“ ab Seite 

401).  

 Text sperren 

 Nur bei Textrahmen und Zeichnungen, die Text enthalten, verfügbar. 

 Diese Option ist standardmäßig aktiviert. Sie bewirkt, dass sich der in diesem 

Objekt enthaltene Text nicht mehr bearbeiten lässt, wenn Sie den Blattschutz 

einschalten (siehe auch Abschnitt „Blattschutz“ ab Seite 401).  

 Hyperlink 

 Hier können Sie einen Hyperlink (eine Verknüpfung) anbringen – zum Beispiel 

auf eine Internetseite. Klicken Sie dazu auf die Schaltfläche Wählen, wählen 

Sie die Art von Link und geben Sie das gewünschte Ziel an. Dieses wird dann 

aufgerufen, wenn das Objekt angeklickt wird.  

Bei Grafiken werden in der rechten Hälfte des Dialogs außerdem Information zu 

der verwendeten Grafik angezeigt (Auflösung, Farbtiefe etc.). 

Weitere Karteikarten 

Bei manchen Arten von Objekten erscheinen zusätzliche Karteikarten mit weiteren 

Optionen. Informationen zu diesen Karteikarten finden Sie im Abschnitt über das 

betreffende Objekt. 
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Standardeinstellungen für Objekte ändern 

Sie können die Standardeinstellungen für Objekte (Zeichnungen, Grafiken etc.) 

jederzeit ändern.  

Wenn Ihnen beispielsweise die voreingestellte Liniendicke für Zeichnungen nicht 

gefällt, legen Sie einfach eine andere Liniendicke als Standard fest. Auch andere 

Standard-Eigenschaften lassen sich ändern – zum Beispiel die Füllung (von Zeich-

nungen) und die Einstellungen für Schatten- und 3D-Effekte. 

Hinweis: Änderungen an den Standardeinstellungen für Objekte betreffen nur 

Objekte, die Sie danach einfügen. Bereits vorhandene Objekte bleiben hingegen 

unberührt. 

Um die Standardeinstellungen für Objekte zu verändern, verwenden Sie die Schalt-

fläche Standard im Dialogfenster des Menübefehl Objekt > Eigenschaften.  

Die Standard-Liniendicke für Zeichnungen lässt sich beispielsweise folgenderma-

ßen ändern: 

1. Fügen Sie eine neue Zeichnung ein (oder klicken Sie auf eine vorhandene 

Zeichnung). 

2. Rufen Sie den Menübefehl Objekt > Eigenschaften auf. 

3. Nehmen Sie die gewünschten Einstellungen vor. Um also beispielsweise die 

Voreinstellung für die Liniendicke zu ändern, stellen Sie einfach auf der Kartei-

karte Linien die gewünschte Liniendicke ein. 

4. Jetzt kommt der entscheidende Schritt: Klicken Sie nicht auf OK, sondern auf 

die Schaltfläche Standard. 

5. Es erscheint ein Dialog, in dem Sie bei Bedarf noch eingrenzen können, welche 

Standardeinstellungen geändert werden sollen. In der Regel ist dies aber nicht 

nötig. 

6. Wenn Sie mit OK bestätigen, werden die aktuell im Dialog gemachten Einstel-

lungen als Standardeinstellungen für neue Zeichnungen festgelegt. 

7. Bestätigen Sie noch einmal mit OK, um den Dialog ganz zu verlassen. 

Alle Zeichnungen, die Sie von nun an einfügen, verwenden standardmäßig die so 

festgelegte Liniendicke. 

Hinweis: Die Standardeinstellungen für Objekte lassen sich für jedes Dokument 

getrennt festlegen. 
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Objekte – fortgeschrittene Funktionen 

Die nächsten Seiten enthalten Informationen zu den etwas ausgefalleneren Funkti-

onen zum Bearbeiten von Objekten. Folgende Themen werden darin behandelt: 

 Verbergen von Objekten 

 Reihenfolge von Objekten ändern 

 Gruppieren von Objekten 

Verbergen von Objekten 

Sie können ein Objekt bei Bedarf verbergen. Es wird dann auf dem Bildschirm 

und/oder im Ausdruck nicht mehr dargestellt. 

Selektieren Sie das gewünschte Objekt dazu, rufen Sie den Menübefehl Objekt > 

Eigenschaften auf, wechseln Sie auf die Karteikarte Eigenschaften und gehen Sie 

dann wie folgt vor: 

 Schalten Sie Option Sichtbar aus, wird das Objekt auf dem Bildschirm nicht 

mehr angezeigt. 

 Schalten Sie Option Drucken aus, erscheint das Objekt nicht mehr im Aus-

druck. 

Tipp: Wenn Sie ein Objekt einmal versehentlich unsichtbar gemacht haben, können 

Sie jederzeit den Menübefehl Datei > Eigenschaften aufrufen und die Option 

Verborgene Objekte anzeigen auf der Karteikarte Optionen einschalten. Nun 

werden alle unsichtbaren Objekte wieder angezeigt. Sie können das Objekt also 

wieder selektieren und die Option Sichtbar wieder einschalten. 

Reihenfolge von Objekten ändern 

Wenn sich mehrere Objekte überlappen, können Sie bestimmen, in welcher Rei-

henfolge diese hintereinander angeordnet sein sollen – also welches Objekt im 

Vordergrund ist, welches im Hintergrund etc.  

Gehen Sie dazu folgendermaßen vor: 

1. Selektieren Sie das gewünschte Objekt. 
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2. Rufen Sie den Menübefehl Objekt > Reihenfolge auf. Es öffnet sich ein Un-

termenü mit folgenden Befehlen: 

 In den Vordergrund: Bringt das Objekt vor alle anderen Objekte. 

 In den Hintergrund: Bringt das Objekt hinter alle anderen Objekte. 

 Eine Ebene nach vorne: Bringt das Objekt eine Ebene weiter nach vorne. 

 Eine Ebene nach hinten: Bringt das Objekt eine Ebene weiter nach hinten. 

Gruppieren von Objekten 

Wenn Sie mehrere Objekte gruppieren, fassen Sie diese zu einer Einheit zusam-

men, die wie ein einzelnes Objekt selektiert und manipuliert werden kann.  

Das bedeutet in der Praxis:  

Selektieren Sie ein Objekt, das zu einer Gruppe gehört, wird stets die gesamte 

Gruppe selektiert. Verschieben Sie dieses Objekt, werden alle Objekte der Gruppe 

mitbewegt. Das Gruppieren verhindert außerdem, dass zusammengehörende Ob-

jekte versehentlich mit der Maus gegeneinander verschoben werden können. 

Um Objekte zu gruppieren, gehen Sie folgendermaßen vor: 

1. Selektieren Sie die zu gruppierenden Objekte. 

 Klicken Sie die Objekte dazu bei gedrückter Umschalttaste (ª) nacheinander 

an – oder wechseln Sie in den Objektmodus und ziehen Sie dann bei gedrückter 

Maustaste ein Rechteck um alle zu selektierenden Objekte auf. 

2. Klicken Sie auf das Symbol  in der Objektleiste oder rufen Sie den Menübe-

fehl Objekt > Gruppieren auf, um die Objekte zu gruppieren. 

Gruppierung wieder aufheben 

Um die Gruppierung von Objekten wieder aufzuheben, gehen Sie folgendermaßen 

vor: 

1. Selektieren Sie die Gruppe, indem Sie eines der darin enthaltenen Objekte an-

klicken. 

2. Rufen Sie den Menübefehl Objekt > Gruppierung aufheben auf. 
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Die allgemeinen Informationen zu Objekten sind hiermit abgeschlossen. In den 

nächsten Abschnitten werden die einzelnen Arten von Objekten ausführlich vorge-

stellt: 

 Diagramme (siehe dazu Kapitel „Diagramme“ ab Seite 295) 

 Textrahmen (ab Seite 269) 

 Grafiken (ab Seite 273) 

 OLE-Objekte (ab Seite 279) 

 Zeichnungen (ab Seite 286) 

Diagramme 

Mit Hilfe von Diagrammen können Sie die Zahlenwerte in einer Tabelle grafisch 

darstellen und somit die „nackten Zahlen“ anschaulich und übersichtlich präsentie-

ren. 

Dem Arbeiten mit Diagrammen widmet sich ein eigenes Kapitel: das Kapitel 

„Diagramme“ ab Seite 295. Alle Informationen zu Diagrammen finden Sie dort. 

Textrahmen 

Mit Hilfe von Textrahmen können Sie einen Textkasten in die Tabelle setzen. In 

Textrahmen lässt sich nach Belieben Text eingeben, bearbeiten und formatieren.  

In diesem Abschnitt erfahren Sie alles Wissenswerte zum Arbeiten mit Textrahmen. 

Folgende Themen werden darin behandelt: 

 Textrahmen einfügen 

 Eigenschaften von Textrahmen ändern 

Lesen Sie dazu die nächsten Seiten. 

Textrahmen einfügen 

Um einen Textrahmen einzufügen, gehen Sie folgendermaßen vor: 



 

270  •  Objekte Handbuch PlanMaker 

1. Rufen Sie den Menübefehl Objekt > Neuer Textrahmen auf. 

 Alternativ können Sie das Symbol  in der Objektleiste anklicken, sofern Sie 

den Objektmodus aktiviert haben. 

2. Der Textrahmen wird nun eingefügt.  

 Wenn Sie möchten, können Sie den Textrahmen anschließend noch verschieben 

oder seine Größe ändern: 

 Wichtig: Zum Verschieben klicken Sie mit der Maus auf die Umrandung des 

Textrahmens. Dann ziehen Sie ihn (bei weiterhin gedrückter Maustaste) an die 

gewünschte Position.  

 Um die Größe zu ändern, ziehen Sie mit der Maus an einem der runden Greifer, 

die den Textrahmen umgeben.  

Der Textrahmen ist nun erstellt, und Sie können sofort mit der Eingabe von Text 

beginnen.  

Wenn Sie mit der Texteingabe fertig sind, klicken Sie eine beliebige Tabellenzelle 

an, um den Rahmen zu verlassen. Nun können Sie wieder Tabellenzellen bearbei-

ten. Umgekehrt gelangen Sie in den Textrahmen zurück, indem Sie in den Rahmen 

hineinklicken. 

Wichtig: Wenn PlanMaker am unteren Rand eines Textrahmens einen roten Bal-

ken anzeigt, zeigt dies an, dass der enthaltene Text nicht vollständig in den Rah-

men passt. Vergrößern Sie in diesem Falle also den Rahmen oder verringern Sie 

die Textmenge. 

Eigenschaften von Textrahmen ändern 

Um die Eigenschaften eines Textrahmens zu bearbeiten, selektieren Sie diesen zu-

nächst. Klicken Sie dazu die Umrandung an, die den Textrahmen umgibt, oder kli-

cken Sie ihn im Objektmodus einfach an. Dann rufen Sie den Menübefehl Objekt 

> Eigenschaften auf, worauf ein entsprechender Dialog erscheint. 

Tipp: Wenn Sie den Objektmodus aktiviert haben, können Sie diesen Dialog 

auch mit einem Doppelklick auf den Textrahmen öffnen. 

In dem Dialog lassen sich folgende Einstellungen vornehmen: 
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Karteikarten Format, Füllung, Linien etc. 

Diese Karteikarten sind bei praktisch allen Arten von Objekten vorhanden. Sie die-

nen zum Ändern folgender Einstellungen: 

 Format: Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. 

Siehe Abschnitt „Objekt-Eigenschaften, Karteikarte Format“ ab Seite 256. 

 Füllung: Hier können Sie die Füllung ändern. Siehe Abschnitt „Objekt-

Eigenschaften, Karteikarte Füllung“ ab Seite 258. 

 Linien: Hier können Sie Umrandungslinien anbringen. Siehe Abschnitt „Objekt-

Eigenschaften, Karteikarte Linien“ ab Seite 260. 

 Schatten: Hier können Sie einen Schatten anbringen. Siehe Abschnitt „Objekt-

Eigenschaften, Karteikarte Schatten“ ab Seite 261. 

 3D: Hier können Sie einen 3D-Effekt anbringen. Siehe Abschnitt „Objekt-

Eigenschaften, Karteikarte 3D“ ab Seite 262. 

 Effekte: Hier können Sie verschiedene Effekte anbringen. Siehe Abschnitt 

„Objekt-Eigenschaften, Karteikarte Effekte“ ab Seite 263. 

 Eigenschaften: Hier können Sie allgemeine Einstellungen ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Eigenschaften“ ab Seite 264. 

Weiterhin erscheinen bei Textrahmen zwei zusätzliche Karteikarten mit weiteren 

Optionen: 

Karteikarte Innentext 

Auf dieser Karteikarte können Sie Einstellungen zu dem enthaltenen Text ändern.  

Verfügbare Optionen: 

 Rubrik Innenränder 

 Hier können Sie die Ränder zwischen dem Textrahmen und dem darin enthalte-

nen Text ändern. Schalten Sie die Option Automatisch ein, ermittelt das Pro-

gramm automatisch geeignete Ränder. 

 Rubrik Überlappende Objekte 

 Diese Einstellung bestimmt, was passieren soll, wenn sich der Textrahmen mit 

einem anderen Rahmen überlappt.  
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 Bei der Standardeinstellung Objekt ignorieren greift PlanMaker nicht ein. In 

dem sich überlappenden Bereich wird also der Inhalt beider Rahmen überei-

nander gedruckt.  

 Wählen Sie hingegen die Option Text umbrechen, wird der Text in diesem 

Rahmen automatisch neu umbrochen, so dass er die Überlappung umfließt. 

 Rubrik Drehen um ... 

 Hier können Sie den Text um den angegebenen Winkel drehen. 

 Rubrik Vertikale Ausrichtung 

 Diese Einstellung bestimmt, wie der enthaltene Text zwischen Ober- und Un-

terkante des Rahmens ausgerichtet werden soll: 

Option Erläuterung 

Oben Der Text wird an der Oberkante des Rahmens ausge-

richtet. (Dies ist die Standardeinstellung.) 

Zentriert Der Text wird zwischen Ober- und Unterkante 

zentriert. 

Unten Der Text wird an der Unterkante des Rahmens aus-

gerichtet. 

Vertikaler Blocksatz Der Abstand zwischen den Textzeilen wird gleich-

mäßig so erweitert, dass der Text an der Oberkante 

des Rahmens beginnt und an der Unterkante endet. 

Karteikarte AutoFormen 

Ein Textrahmen ist im Prinzip nichts anderes als eine AutoForm, der Text hinzuge-

fügt wurde. Standardmäßig wird hierzu ein einfaches Rechteck als AutoForm ver-

wendet. Sie können dem Textrahmen jedoch jederzeit eine andere AutoForm zu-

weisen, also beispielsweise aus dem Rechteck eine Sprechblase oder eine beliebige 

andere Form machen. 

Wählen Sie dazu einfach auf der Karteikarte AutoForm die gewünschte Form aus. 

Ausführliche Informationen zu AutoFormen finden Sie im Abschnitt 

„Zeichnungen“ ab Seite 286. 
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Grafiken 

In diesem Abschnitt erfahren Sie alles Wissenswerte zum Einfügen und Bearbeiten 

von Grafiken. Folgende Themen werden darin behandelt: 

 Grafiken einfügen 

 Grafiken einscannen 

 Grafiken aus der Galerie einfügen (Android) 

 Eigenschaften von Grafiken ändern 

 Verwenden der Grafikleiste 

Lesen Sie dazu die nächsten Seiten. 

Grafiken einfügen 

Um eine Grafik einzufügen, gehen Sie wie folgt vor: 

1. Rufen Sie den Menübefehl Objekt > Neuer Grafikrahmen auf. 

 Alternativ können Sie das Symbol  in der Objektleiste anklicken, sofern Sie 

den Objektmodus aktiviert haben.  

2. Es erscheint ein Dialog. Wählen Sie darin die gewünschte Grafikdatei aus und 

bestätigen Sie mit OK. 

3. Der Grafikrahmen wird nun eingefügt.  

 Wenn Sie möchten, können Sie den Grafikrahmen anschließend noch verschie-

ben oder seine Größe ändern: 

 Zum Verschieben klicken Sie mit der Maus auf den Grafikrahmen und ziehen 

ihn dann (bei weiterhin gedrückter Maustaste) an die gewünschte Position.  

 Um die Größe zu ändern, ziehen Sie mit der Maus an einem der runden Greifer, 

die den Grafikrahmen umgeben.  

Optionen des Dialogs 

Die Optionen in obigem Dialogfenster haben folgende Bedeutung: 
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 Im Dokument ablegen 

 Ist diese Option eingeschaltet, speichert PlanMaker eine Kopie der Grafik im 

Dokument ab und verwendet dieses anstelle des Originals. 

 Ist sie ausgeschaltet, wird im Dokument nur ein Verweis auf die originale Gra-

fikdatei gespeichert. 

 In den Ordner des Dokuments kopieren 

 Ist diese Option eingeschaltet, erzeugt PlanMaker eine Kopie der Grafikdatei in 

dem Ordner, in dem sich das Dokument befindet, und verwendet diese anstelle 

des Originals. 

 Diese Option ist nur verfügbar, wenn das Dokument schon einmal gespeichert 

wurde. 

Grafiken einscannen 

Hinweis: Das Einscannen von Grafiken ist nur mit der Windows-Version von 

PlanMaker möglich. 

FreeOffice: Das Einscannen von Grafiken ist in SoftMaker FreeOffice nicht 

enthalten. 

Mit PlanMaker für Windows lassen sich Vorlagen direkt in ein Dokument ein-

scannen. Sie müssen dazu einen Scanner an Ihren Rechner angeschlossen und die 

mitgelieferte Software installiert haben. Die Scanner-Software muss TWAIN-

kompatibel sein, was bei praktisch allen Scannern der Fall ist. 

Um etwas in das aktuelle Dokument einzuscannen, gehen Sie wie folgt vor: 

1. Schalten Sie den Scanner ein und legen Sie die Vorlage ein. 

2. Rufen Sie den Menübefehl Datei > Holen auf. 

PlanMaker aktiviert nun die Scan-Software Ihres Scanners. Nehmen Sie darin die 

gewünschten Einstellungen vor (siehe Handbuch zum Scanner) und starten Sie den 

Scanvorgang. Wenn dieser abgeschlossen ist, erscheint das Ergebnis als Grafik im 

Dokument. 
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Andere Quelle wählen 

Wenn an Ihren PC mehrere Scanner angeschlossen sind, können Sie mit dem Me-

nübefehl Datei > Quelle wählen zwischen diesen wechseln.  

Rufen Sie den Befehl dazu auf, wählen Sie das gewünschte Gerät und bestätigen 

Sie mit OK. 

Grafiken aus der Galerie einfügen (Android) 

Hinweis: Diese Funktion steht nur in der Android-Version zur Verfügung. 

Bei der Android-Version können Sie Grafiken auch über die Grafikgalerie ihres 

Geräts einfügen. 

Gehen Sie dazu wie folgt vor: 

1. Rufen Sie den Menübefehl Objekt > Neuer Grafikrahmen aus der Galerie 

auf. 

2. Ihr Android-Gerät öffnet automatisch seine Galerie-App. Wählen Sie darin die 

gewünschte Grafik durch Antippen aus. 

Die Grafik wird nun eingefügt. 

Eigenschaften von Grafiken ändern 

Sämtliche Eigenschaften eines Objekts lassen sich zentral mit dem Menübefehl 

Objekt > Eigenschaften bearbeiten. Zu den Eigenschaften zählt man beispiels-

weise Größe, Ränder und zahlreiche weitere Einstellmöglichkeiten. 

Um die Eigenschaften einer Grafik zu bearbeiten, selektieren Sie diese zunächst 

per Mausklick. Dann rufen Sie den Menübefehl Objekt > Eigenschaften auf, wo-

rauf ein entsprechender Dialog erscheint. 

Tipp: Sie können diesen Dialog auch über einen Doppelklick auf die Grafik auf-

rufen. 

In dem Dialog lassen sich folgende Einstellungen vornehmen: 
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Karteikarten Format, Füllung, Linien etc. 

Diese Karteikarten sind bei praktisch allen Arten von Objekten vorhanden. Sie die-

nen zum Ändern folgender Einstellungen: 

 Format: Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. 

Siehe Abschnitt „Objekt-Eigenschaften, Karteikarte Format“ ab Seite 256. 

 Füllung: Hier können Sie die Füllung ändern. Nur bei Grafiken mit transparenten 

Bereichen sichtbar. Siehe Abschnitt „Objekt-Eigenschaften, Karteikarte Fül-

lung“ ab Seite 258. 

 Linien: Hier können Sie Umrandungslinien anbringen. Siehe Abschnitt „Objekt-

Eigenschaften, Karteikarte Linien“ ab Seite 260. 

 Schatten: Hier können Sie einen Schatten anbringen. Siehe Abschnitt „Objekt-

Eigenschaften, Karteikarte Schatten“ ab Seite 261. 

 Effekte: Hier können Sie verschiedene Effekte anbringen. Siehe Abschnitt 

„Objekt-Eigenschaften, Karteikarte Effekte“ ab Seite 263. 

 Eigenschaften: Hier können Sie allgemeine Einstellungen ändern. Außerdem 

werden Informationen zu der verwendeten Grafik angezeigt. Siehe Abschnitt 

„Objekt-Eigenschaften, Karteikarte Eigenschaften“ ab Seite 264. 

Weiterhin erscheint bei Grafiken eine zusätzliche Karteikarte mit weiteren Optio-

nen: 

Karteikarte Grafik 

Auf der Karteikarte Grafik können Sie Einstellungen zur Grafik selbst vornehmen.  

Tipp: Einen Teil dieser Einstellungen können Sie auch über die Grafikleiste än-

dern, die automatisch erscheint, wenn Sie eine Grafik selektieren. Siehe Ab-

schnitt „Verwenden der Grafikleiste“ (Seite 278). 

Sie finden auf dieser Karteikarte folgende Optionen: 

 Varianten 

 In dieser Liste werden einige vorgefertigte Variationen der Grafik angeboten – 

zum Beispiel andere Farbmodi (Graustufen, schwarz/weiß etc.) und Varianten, 

bei denen das Bild eingefärbt wurde. 

 Klicken Sie die gewünschte Variante einfach an. Die Optionen in dem Dialog 

werden dann automatisch auf entsprechende Einstellungen gesetzt. 
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 Rubrik Optionen 

 Hier können Sie Helligkeit, Kontrast, Sättigung und Gamma-Wert (eine alterna-

tive Möglichkeit zum Ändern der Helligkeit) ändern. 

 Schaltfläche Weiteres 

 Diese Schaltfläche öffnet einen Dialog mit zusätzlichen Einstellungen: 

 Wenn Sie die Option Einfärben aktivieren und darunter eine Farbe auswählen, 

wird die Grafik entsprechend eingefärbt. 

 Mit den Optionen in der Rubrik Beschnitt können Sie die Grafik zuschneiden. 

Dies ist nützlich, wenn Sie nur einen Ausschnitt der Grafik benötigen. Soll bei-

spielsweise das obere Viertel der Grafik abgeschnitten werden, geben Sie bei 

Oben die Zahl „25“ (Prozent) ein.  

 Rubrik Transparenz 

 Hier können Sie Einstellungen zur Transparenz der Grafik vornehmen: 

 Automatisch erkennen: PlanMaker liest aus der Grafikdatei aus, welche Teile 

der Grafik als transparent gekennzeichnet wurden, und stellt die Grafik entspre-

chend dar. Hinweis: Nur Grafiken im GIF- oder PNG-Format enthalten solche 

Transparenz-Informationen. 

 Keine Transparenz: Die Grafik wird nicht transparent dargestellt – selbst 

wenn es sich im eine Grafikdatei mit Transparenz-Informationen handelt. 

 Farbe: Lässt Sie die Farbe auswählen, die als transparente Farbe verwendet 

werden soll. Wählen Sie beispielsweise die Farbe Weiß, werden alle weißen 

Bereiche der Grafik transparent dargestellt. 

 Schaltfläche Datei 

 Über diese Schaltfläche können Sie eine andere Grafikdatei auswählen. 

 Schaltfläche Exportieren 

 Nur bei Grafiken verfügbar, die im Dokument gespeichert sind. Mit dieser 

Schaltfläche können Sie die Grafikdatei exportieren, also eine Kopie der Grafik 

unter einem beliebigen Namen auf Festplatte speichern. 

 Schalten Sie dabei die Option Verknüpfung zu Datei herstellen ein, ersetzt 

PlanMaker außerdem die im Dokument gespeicherte Grafik durch einen Ver-

weis auf die Zieldatei. Die Grafik ist dann also nicht mehr im Dokument ge-

speichert. 
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Verwenden der Grafikleiste 

Manche Eigenschaften von Grafiken können auch über die Grafikleiste geändert 

werden.  

 

Die Grafikleiste 

Diese Symbolleiste erscheint automatisch, wenn Sie eine Grafik selektieren. Sie 

enthält folgende Schaltflächen (von links nach rechts): 

 Menübefehl Objekt > Eigenschaften für die Grafik aufrufen 

 Grafik mit einem Fotorahmen-Effekt versehen (in SoftMaker FreeOffice nicht 

verfügbar) 

 Originalfarben der Grafik verwenden 

 Farben auf Graustufen reduzieren 

 Farben auf schwarz/weiß reduzieren 

 Helligkeit erhöhen 

 Helligkeit reduzieren 

 Kontrast erhöhen 

 Kontrast reduzieren 

 Gamma erhöhen 

 Gamma reduzieren 

 Um 90° nach rechts drehen 

 Um 90° nach links drehen 

 Alle mit dieser Symbolleiste gemachten Änderungen verwerfen 

 Beschnittmodus aktivieren/deaktivieren. In diesem Modus erscheinen zusätzli-

che Greifer an den Rändern der Grafik. Wenn Sie an diesen mit der Maus zie-

hen, wird die Grafik entsprechend beschnitten. (Diese Funktion ist in SoftMa-

ker FreeOffice nicht enthalten.) 

Alle obigen Einstellungen lassen sich alternativ auch mit dem Menübefehl Objekt 

> Eigenschaften vornehmen. Siehe Abschnitt „Eigenschaften von Grafiken än-

dern“ (Seite 275). 
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OLE-Objekte 

Hinweis: Die Verwendung von OLE-Objekten ist nur mit der Windows-Version 

von PlanMaker möglich. 

Bei PlanMaker für Windows können Sie in Ihre Dokumente Objekte (Zeichnun-

gen, Grafiken usw.) einbetten, die mit einer anderen Applikation erzeugt wurden. 

Ein Beispiel: Mit dem Menübefehl Objekt > Neuer OLE-Objektrahmen können 

Sie von PlanMaker aus das Windows-Malprogramm Paint starten lassen und darin 

etwas zeichnen. Beenden Sie Paint, erscheint diese Zeichnung im PlanMaker-

Dokument. Sie ist jetzt in das Dokument eingebettet. 

Vorteil: Sie müssen auf die Zeichnung im PlanMaker-Dokument nur einen Dop-

pelklick ausführen – schon wird Paint automatisch erneut gestartet. Wenn Sie die 

Zeichnung darin nun bearbeiten und Paint wieder beenden, werden die Änderun-

gen auch von PlanMaker übernommen.  

Damit dies funktioniert, muss die aufzurufende Applikation OLE unterstützen. 

OLE steht für „Object Linking and Embedding“ („Verknüpfen und Einbetten von 

Objekten“). Das Objekt, das von der anderen Applikation zu PlanMaker gereicht 

wird, nennt man ein OLE-Objekt. 

In diesem Abschnitt erfahren Sie alles Wissenswerte zum Arbeiten mit OLE-

Objektrahmen. Folgende Themen werden darin behandelt: 

 OLE-Objekte einfügen 

 OLE-Objekte bearbeiten 

 Verknüpfungen von OLE-Objekten bearbeiten 

 Eigenschaften von OLE-Objekten ändern 

 Verwendung des SoftMaker Formeleditors 

Lesen Sie dazu die nächsten Seiten. 

OLE-Objekte einfügen 

Hinweis: Die Verwendung von OLE-Objekten ist nur mit der Windows-Version 

von PlanMaker möglich. 
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Mit dem Menübefehl Objekt > Neuer OLE-Objektrahmen können Sie ein OLE-

Objekt in das Dokument einbetten. 

Der Befehl öffnet ein Dialogfenster. Dieses enthält eine Liste aller Anwendungen, 

mit denen sich OLE-Objekte erstellen lassen. Welche Einträge darin angeboten 

werden, hängt davon ab, welche OLE-fähigen Programme auf Ihrem System instal-

liert sind. 

Wenn Sie beispielsweise den Eintrag „Paintbrush-Bild“ wählen, öffnet sich das 

Windows-Malprogramm Paintbrush (oder Paint) mit einem leeren Fenster. Zeich-

nen Sie darin ein Bild und beenden Sie Paint dann einfach. Das Bild ist nun in Ihr 

Dokument eingebettet. Es wird nicht nur darin angezeigt, sondern kann jederzeit 

auch bearbeitet werden. Führen Sie zum Bearbeiten einfach einen Doppelklick auf 

das Bild im Dokument aus. 

Im Einzelnen gehen Sie zum Einfügen eines OLE-Objekts in ein Dokument wie 

folgt vor: 

1. Rufen Sie den Menübefehl Objekt > Neuer OLE-Objektrahmen auf. 

2. Es erscheint ein Dialogfenster. Wählen Sie darin aus der Liste Objekttyp die 

Quellanwendung aus, von der PlanMaker das OLE-Objekt erhalten soll. 

3. Bestätigen Sie mit OK, worauf die zum gewählten Objekttyp gehörende An-

wendung gestartet wird. 

4. Erstellen Sie das Objekt in der Anwendung. 

5. Beenden Sie die Anwendung. 

6. Die Anwendung fragt nun möglicherweise nach, ob Sie das Objekt im PlanMa-

ker-Dokument aktualisieren möchten. Bestätigen Sie dies mit „Ja“. 

7. Das OLE-Objekt wird nun angelegt. 

 Wenn Sie möchten, können Sie das Objekt anschließend noch verschieben oder 

seine Größe ändern: 

 Zum Verschieben klicken Sie mit der Maus auf das Objekt und ziehen es dann 

(bei weiterhin gedrückter Maustaste) an die gewünschte Position.  

 Um die Größe zu ändern, ziehen Sie mit der Maus an einem der runden Greifer, 

die das Objekt umgeben.  
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OLE-Objekte aus einer Datei erstellen 

Möchten Sie kein neues OLE-Objekt erstellen, sondern ein bereits vorhandenes 

Dokument einer anderen Anwendung als OLE-Objekt einbetten, rufen Sie eben-

falls den Menübefehl Objekt > Neuer OLE-Objektrahmen auf, wählen im Dia-

logfenster jedoch die Option Aus Datei erstellen.  

Das Aussehen des Dialogs ändert sich: Statt der Liste Objekttyp finden Sie nun-

mehr das Eingabefeld Datei vor. Geben Sie hier den kompletten Dateinamen an 

oder klicken Sie auf die Schaltfläche Durchsuchen, um ein Dialogfenster zu erhal-

ten, mit dem Sie Ihre Festplatte nach dem Dokument durchforsten können.  

Bestimmen Sie eine Datei und bestätigen Sie mit OK, wird diese als OLE-Objekt 

eingefügt.  

Dabei prüft Windows, ob es mit der Namenserweiterung dieser Datei etwas anfan-

gen kann, und reagiert entsprechend. Ist die Namenserweiterung nicht registriert, 

erscheint lediglich ein Symbol für die eingebettete Datei. Kann Windows die Na-

menserweiterung hingegen einem OLE-fähigen Programm zuordnen, wird der In-

halt der Datei angezeigt.  

Verknüpfung mit der Originaldatei herstellen 

Im oben beschriebenen Dialogfenster können Sie zusätzlich auswählen, ob die ein-

zufügende Datei eingebettet oder verknüpft werden soll. Lassen Sie die Option 

Verknüpfen ausgeschaltet, fügt PlanMaker eine Kopie der Datei als OLE-Objekt 

ein und speichert diese im Dokument – das OLE-Objekt wird also wie gewohnt 

eingebettet.  

Schalten Sie hingegen die Option Verknüpfen ein, stellt PlanMaker eine Verknüp-

fung mit der Originaldatei für das OLE-Objekt her. Von der Bedienung her ändert 

sich dadurch nichts. Ändern Sie jedoch später die Originaldatei des OLE-Objekts 

mit einem anderen Programm und öffnen das PlanMaker-Dokument erneut, hat 

sich auch das OLE-Objekt entsprechend geändert – das OLE-Objekt ist also mit 

der Originaldatei verknüpft. 

OLE-Objekte bearbeiten 

Folgendermaßen bearbeiten Sie vorhandene OLE-Objekte: 

Tipp: Um ein OLE-Objekt zu editieren, führen Sie einfach einen Doppelklick auf 

das OLE-Objekt durch. Es wird sofort in der zugehörigen Applikation geöffnet 

und kann darin bearbeitet werden. 
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Alternativ können Sie auch das Menü verwenden, um ein OLE-Objekt zu editieren. 

Gehen Sie folgendermaßen vor: 

1. Klicken Sie das OLE-Objekt an, um es zu selektieren. 

2. Rufen Sie das Menü Bearbeiten auf. Am Ende dieses Menüs finden Sie einen 

Menüeintrag mit dem Namen des Objekts (zum Beispiel Bitmap-Objekt). Das 

Auswählen dieses Menüeintrags öffnet ein Untermenü mit allen für dieses O-

LE-Objekt zuständigen OLE-Befehlen. Der Befehl Bearbeiten oder Edit ist für 

das Bearbeiten zuständig. Rufen Sie diesen auf. 

3. Die zu dem OLE-Objekt gehörende Quellanwendung wird nun gestartet. Neh-

men Sie die gewünschten Änderungen vor. 

Um wieder zu PlanMaker zurückzukehren, beenden Sie die Anwendung einfach. 

Beim Beenden mancher Quellanwendungen wird dabei nachgefragt, ob Sie das 

Objekt im PlanMaker-Dokument aktualisieren möchten. Antworten Sie mit „Ja“ – 

andernfalls werden Ihre Änderungen verworfen. 

Verknüpfungen von OLE-Objekten bearbeiten 

Haben Sie ein OLE-Objekt aus einer Datei erstellt und dabei die Option Verknüp-

fung aktiviert, können Sie diese Verknüpfung zu der Quelldatei mit dem Menübe-

fehl Bearbeiten > Verknüpfungen bearbeiten.  

Rufen Sie diesen Befehl dazu auf. Es erscheint ein Dialogfenster, in dem alle im 

aktuellen Dokument vorhandenen Verknüpfungen aufgelistet sind. Wenn Sie eine 

Verknüpfung selektieren, wird im unteren Teil des Dialogfensters Dateiname und 

Typ der zugehörigen Quelldatei angezeigt. 

Mit den Schaltflächen des Dialogfensters lassen sich folgende Aktionen ausführen: 

Schaltfläche Funktion 

Jetzt aktualisieren Aktualisiert das OLE-Objekt. Verwenden Sie diese Schalt-

fläche, falls die Quelldatei von einem anderen Programm 

verändert wurde und die Änderungen im PlanMaker-

Dokument nicht sichtbar werden.  

Quelle öffnen Startet die zu dem OLE-Objekt gehörende Anwendung und 

lässt Sie das Objekt darin bearbeiten. Tipp: Dies ist auch mit 

einem Doppelklick auf das Objekt erreichbar. 

Quelle ändern Lässt Sie eine andere Datei als Quelle für das OLE-Objekt 

auswählen. 
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Verknüpfung lösen Trennt die Verbindung mit der Quelldatei. Das Objekt ist 

anschließend fest in das PlanMaker-Dokument eingebettet; 

Änderungen an der Quelldatei wirken sich nicht mehr aus. 

Das Objekt lässt sich aber nach wie vor per Doppelklick 

bearbeiten. 

Eigenschaften von OLE-Objekten ändern 

Sämtliche Eigenschaften eines Objekts lassen sich zentral mit dem Menübefehl 

Objekt > Eigenschaften bearbeiten. Zu den Eigenschaften zählt man beispiels-

weise Größe, Ränder und zahlreiche weitere Einstellmöglichkeiten. 

Um die Eigenschaften eines OLE-Objekts zu bearbeiten, selektieren Sie dieses 

zunächst per Mausklick. Dann rufen Sie den Menübefehl Objekt > Eigenschaften 

auf, worauf ein entsprechender Dialog erscheint. 

In dem Dialog lassen sich folgende Einstellungen vornehmen: 

Karteikarten Format, Füllung, Linien etc. 

Diese Karteikarten sind bei praktisch allen Arten von Objekten vorhanden. Sie die-

nen zum Ändern folgender Einstellungen: 

 Format: Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. 

Siehe Abschnitt „Objekt-Eigenschaften, Karteikarte Format“ ab Seite 256. 

 Füllung: Hier können Sie die Füllung ändern. Diese Funktion wird allerdings 

nicht von allen OLE-Anwendungen unterstützt. Siehe Abschnitt „Objekt-

Eigenschaften, Karteikarte Füllung“ ab Seite 258. 

 Linien: Hier können Sie Umrandungslinien anbringen. Siehe Abschnitt „Objekt-

Eigenschaften, Karteikarte Linien“ ab Seite 260. 

 Schatten: Hier können Sie einen Schatten anbringen. Siehe Abschnitt „Objekt-

Eigenschaften, Karteikarte Schatten“ ab Seite 261. 

 Effekte: Hier können Sie verschiedene Effekte anbringen. Siehe Abschnitt 

„Objekt-Eigenschaften, Karteikarte Effekte“ ab Seite 263. 

 Eigenschaften: Hier können Sie allgemeine Einstellungen ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Eigenschaften“ ab Seite 264. 

Weiterhin erscheint bei OLE-Objekten eine zusätzliche Karteikarte mit weiteren 

Optionen: 
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Karteikarte Grafik 

Auf der Karteikarte Grafik können Sie Einstellungen zur grafischen Darstellung 

des Objekts vornehmen. 

Hinweis: Abhängig vom Typ des OLE-Objekts sind manche dieser Optionen 

möglicherweise ohne Funktion. 

Verfügbare Optionen: 

 Varianten 

 In dieser Liste werden einige vorgefertigte Variationen angeboten – zum Bei-

spiel andere Farbmodi (Graustufen, schwarz/weiß etc.) und Varianten, bei de-

nen das Objekt eingefärbt wurde. 

 Klicken Sie die gewünschte Variante einfach an. Die Optionen in dem Dialog 

werden dann automatisch auf entsprechende Einstellungen gesetzt. 

 Rubrik Optionen 

 Hier können Sie Helligkeit, Kontrast, Sättigung und Gamma-Wert (eine alterna-

tive Möglichkeit zum Ändern der Helligkeit) ändern. 

 Schaltfläche Weiteres 

 Diese Schaltfläche öffnet einen Dialog mit zusätzlichen Einstellungen: 

 Wenn Sie die Option Einfärben aktivieren und darunter eine Farbe auswählen, 

wird das Objekt entsprechend eingefärbt. 

 Mit den Optionen in der Rubrik Beschnitt können Sie das Objekt zuschneiden. 

Dies ist nützlich, wenn Sie nur einen Ausschnitt des Objekts benötigen. Soll 

beispielsweise das obere Viertel des Objekts abgeschnitten werden, geben Sie 

bei Oben die Zahl „25“ (Prozent) ein.  

 Schaltfläche Exportieren 

 Mit dieser Schaltfläche können Sie eine Kopie der grafischen Repräsentation 

des Objekts exportieren, also ein Abbild des Objekts unter einem beliebigen 

Namen auf Festplatte speichern. 



 

Handbuch PlanMaker Objekte  •  285 

Verwendung des SoftMaker Formeleditors 

FreeOffice: Der Softmaker Formeleditor ist in SoftMaker FreeOffice nicht ent-

halten. 

Hinweis: Der SoftMaker-Formeleditor ist nur unter Windows verfügbar und 

nicht in allen Versionen von PlanMaker enthalten. 

Mit dem SoftMaker Formeleditor können Sie mathematische und technische For-

meln grafisch darstellen. 

Den Formeleditor sprechen Sie, wie in den vorherigen Abschnitten beschrieben, 

über OLE an. Um also eine Formel grafisch darzustellen, fügen Sie in das Doku-

ment ein OLE-Objekt ein, das als Quellanwendung den Formeleditor verwendet. 

Dazu gehen Sie wie folgt vor: 

1. Rufen Sie den Menübefehl Objekt > Neuer OLE Objektrahmen auf. 

2. Wählen Sie in der Liste Objekttyp den Eintrag SoftMaker Formeleditor. 

3. Bestätigen Sie mit OK, worauf der Formeleditor gestartet wird. 

4. Erstellen Sie die gewünschte Formel. 

5. Wenn die Formel fertiggestellt ist, beenden Sie den Formeleditor einfach. 

Die Formel ist nun als OLE-Objekt in das PlanMaker-Dokument eingebettet. 

Sie können Formeleditor-Objekte jederzeit nachträglich bearbeiten, indem Sie ei-

nen Doppelklick darauf ausführen. Der Formeleditor wird daraufhin wieder gestar-

tet und öffnet die Formel. Nehmen Sie die gewünschten Änderungen vor und be-

enden Sie den Formeleditor dann einfach wieder. 

Mit dem Menübefehl Objekt > Eigenschaften können Sie weiterhin die Eigen-

schaften des Formeleditor-Objekts ändern, nachdem Sie es mit einem (einfachen!) 

Mausklick selektiert haben. 

Informationen vom Hersteller des Formeleditors 

Der SoftMaker Formeleditor ist eine spezielle Version des Programms MathType der Firma Design 

Science. Falls Sie häufig Formeln in Ihren Dokumenten verwenden, werden Sie in MathType eine Lö-

sung finden, die Ihren Ansprüchen noch besser genügt. MathType ist genauso einfach zu bedienen wie 

der SoftMaker Formeleditor, hat jedoch zahlreiche zusätzliche Funktionen, die Ihnen helfen, produkti-
ver zu sein und anspruchsvollere Formeln zu gestalten. 
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MathType ist in Deutsch, Englisch und anderen Sprachen erhältlich. Informationen über den Bezug von 

MathType erhalten Sie bei Ihrem Softwarehändler oder direkt bei Design Science. 

Design Science, Inc. 

140 Pine Avenue, 4th Floor 

Long Beach, CA 90802 
USA 

Telefon (USA): +1 (562) 432-2920 (für internationale Kunden) 

 +1 (800) 827-0685 (für Kunden aus USA und Kanada) 

Telefax (USA): +1 (562) 432-2857 

E-Mail (englisch): sales@dessci.com 

Internet: www.dessci.com 

Zeichnungen 

PlanMaker bietet mehrere Werkzeuge zum Erstellen von Zeichnungen an. Sie kön-

nen in Ihre Dokumente folgende Arten von Zeichnungsobjekten einfügen: 

 Linien und Kurven (Linien, Pfeile, Verbindungslinien, Kurven) 

 Rechtecke und Ellipsen 

 AutoFormen (vorgefertigte Formen unterschiedlichster Art) 

 TextArt-Objekte (mit Effekten versehene Schriftzüge) 

In diesem Abschnitt erfahren Sie alles Wissenswerte zum Arbeiten mit Zeichnun-

gen. Folgende Themen werden darin behandelt: 

 Zeichnungen einfügen 

 Text zu AutoFormen hinzufügen 

 Eigenschaften von Zeichnungen ändern 

Lesen Sie dazu die nächsten Seiten. 

Zeichnungen einfügen 

Um eine Zeichnung einzufügen, zum Beispiel ein Rechteck, gehen Sie wie folgt 

vor: 

1. Rufen Sie den Menübefehl Objekt > Neue Zeichnung auf. Es öffnet sich ein 

Untermenü, aus dem Sie das gewünschte Zeichenwerkzeug auswählen können 

– in diesem Falle also das Werkzeug Rechteck. 
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 Alternativ können Sie auch das entsprechende Symbol in der Objektleiste an-

klicken, sofern Sie den Objektmodus aktiviert haben. 

  

2. Bei manchen Werkzeugen müssen Sie nun noch weitere Schritte durchführen 

(siehe unten). Bei Rechtecken ist dies jedoch nicht der Fall. 

3. Das Rechteck wird nun eingefügt.  

 Wenn Sie möchten, können Sie das Rechteck anschließend noch verschieben 

oder seine Größe ändern: 

 Zum Verschieben klicken Sie mit der Maus auf das Rechteck und ziehen es 

dann (bei weiterhin gedrückter Maustaste) an die gewünschte Position.  

 Um die Größe zu ändern, ziehen Sie mit der Maus an einem der runden Greifer, 

die das Rechteck umgeben.  

Das Anbringen von Zeichnungen unterscheidet sich je nach verwendetem Zei-

chenwerkzeug etwas. Nachfolgend eine Liste aller verfügbaren Zeichnungsobjekte 

und Informationen zu deren Handhabung: 

Linie und Kurven 

Mit dem Werkzeug  Linie in der Objektleiste können Sie Linien und Kurven 

zeichnen.  

Wenn Sie dieses Symbol anklicken, öffnet sich eine Liste mit verschiedenen Werk-

zeugen für Linien und Kurven zur Auswahl. Wählen Sie darin das gewünschte 

Werkzeug und wenden Sie es dann wie folgt an: 

 Linien 

 Mit den Werkzeugen in der obersten Rubrik der Liste können Sie einfache Li-

nien und Pfeile zeichnen. 

 Ziehen Sie dazu, nachdem Sie das gewünschte Werkzeug angeklickt haben, bei 

gedrückter Maustaste einfach eine Linie im Dokument.  

 Tipp: Wenn Sie dabei die Umschalttaste (ª) gedrückt halten, ist die Linie auf 

45°-Winkel beschränkt. 

 Anmerkung: Pfeile sind nichts weiter als gewöhnliche Linien, bei denen in den 

Objekteigenschaften (Karteikarte Linien) für die Option Startpunkt und/oder 

Endpunkt eine Pfeilspitze gewählt wurde. 
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 Verbindungslinien (gerade, gewinkelte und gekrümmte) 

 Mit den Werkzeugen in den nächsten drei Rubriken können Sie Verbindungsli-

nien zwischen zwei Objekten ziehen. Den Unterschied zwischen den drei Arten 

von Verbindungslinien sehen Sie in folgender Abbildung: 

  

 Wählen Sie dazu eines dieser Werkzeuge und ziehen Sie dann den Mauszeiger 

bei gedrückter Maustaste von einem Objekt zum einem anderen.  

 Tipp: Es erscheinen hierbei kleine blaue Rechtecke am Objekt. Diese zeigen, an 

welchen Stellen des Objekts die Linie „andocken“ kann. 

 Kurven 

 Die Werkzeuge in dieser Kategorie dienen zum Zeichnen von Kurven: 

 Mit dem Werkzeug  Kurve können Sie Bezierkurven zeichnen. 

 Klicken Sie dazu auf den Ausgangspunkt und anschließend auf beliebig 

viele andere Positionen. Die Kurve „folgt“ Ihren Mausklicks automatisch. 

 Wenn Sie die Kurve an ihrem Ausgangspunkt enden lassen, wird die Zeich-

nung automatisch zu einer geschlossenen Kurve. Möchten Sie hingegen ei-

ne offene Kurve erhalten, müssen Sie die Zeichnung mit einem Doppelklick 

beenden. 

 Mit dem Werkzeug  Freihandform können Sie Kurven hingegen wie mit 

einem Zeichenstift zeichnen. 

 Bewegen Sie die Maus dazu auf den gewünschten Ausgangspunkt und be-

ginnen Sie bei gedrückter Maustaste zu zeichnen – wie mit einem Stift. Al-

ternativ können Sie die Maustaste auch loslassen und eine andere Stelle an-

klicken, worauf eine gerade Linie dorthin gezeichnet wird. 

 Wenn Sie die Kurve an ihrem Ausgangspunkt enden lassen, wird die Zeich-

nung automatisch zu einer geschlossenen Kurve. Möchten Sie hingegen ei-

ne offene Kurve erhalten, müssen Sie die Zeichnung mit einem Doppelklick 

beenden. 
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Rechteck, abgerundetes Rechteck und Ellipse 

Mit den drei Werkzeugen  Rechteck, Abgerundetes Rechteck und 

Ellipse können Sie Rechtecke beziehungsweise Ellipsen einfügen. 

Wenn Sie eines dieser Werkzeuge anklicken, wird das entsprechende Zeichnungs-

objekt sofort (in einer Standardgröße) eingefügt. Wenn Sie möchten, können Sie es 

anschließend mit der Maus verschieben oder seine Größe ändern, indem Sie an 

einem der runden Greifer an seinen Ecken ziehen.  

Bei abgerundeten Rechtecken lässt sich zudem noch die Rundung der Ecken än-

dern. Selektieren Sie das Rechteck dazu, worauf unter anderem ein gelber Greifer 

neben einer der Ecken erscheint. Ziehen Sie an diesem Greifer, ändert sich die 

Rundung entsprechend. 

AutoForm 

Mit dem Werkzeug  AutoForm können Sie AutoFormen einfügen. Das sind 

vorgefertigte Formen für die unterschiedlichsten Einsatzzwecke – Standardformen 

wie etwa Rechtecke, aber auch Symbole für Flussdiagramme, Sterne, Sprechblasen 

und viele mehr. 

Sobald Sie eine AutoForm ausgewählt haben, wird diese (in einer Standardgröße) 

eingefügt. Wenn Sie möchten, können Sie die AutoForm anschließend mit der 

Maus verschieben oder ihre Größe ändern, indem Sie an einem der runden Greifer 

an ihren Ecken ziehen.  

Hinweis: In manchen Arten von AutoFormen werden zusätzliche gelbe Greifer 

angezeigt, wenn diese selektiert sind. Ziehen Sie an einem dieser Greifer, ändert 

die AutoForm bestimmte Parameter ihres Aussehens. Bei Sternen lässt sich auf 

diese Weise beispielsweise die Länge der Zacken ändern. 

Tipp: Sie können sogar Text innerhalb einer AutoForm eingeben – genau wie bei 

einem Textrahmen. Informationen dazu finden Sie im Abschnitt „Text zu Auto-

Formen hinzufügen“ ab Seite 290. 

TextArt 

Mit dem Werkzeug  TextArt können Sie TextArt-Objekte einfügen. Das sind 

Schriftzüge, die mit diversen Effekten versehen werden können. 
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Wenn Sie dieses Werkzeug aktivieren, erscheint ein Dialog. Geben Sie darin den 

Text ein und klicken Sie auf Varianten, um einen der vorgefertigten Effekte aus-

zuwählen. Bestätigen Sie dann mit OK.  

Text zu AutoFormen hinzufügen 

Sie können AutoFormen auf Wunsch Text hinzufügen. Dieser Text wird dann in-

nerhalb der AutoForm angezeigt – genau wie bei einem Textrahmen. 

Gehen Sie dazu wie folgt vor: 

1. Selektieren Sie die gewünschte AutoForm. 

2. Rechtsklicken Sie auf die AutoForm, um ihr Kontextmenü aufzurufen. 

3. Wählen Sie darin den Befehl Text hinzufügen. 

Nun blinkt die Schreibmarke in der AutoForm; Sie können jetzt also Text eingeben.  

Tipp: Es gibt noch einen schnelleren Weg, Text zu einer AutoForm hinzuzufü-

gen: Selektieren Sie die AutoForm dazu und beginnen Sie dann einfach mit dem 

Tippen. 

Mit den Menübefehlen Format > Zeichen und Format > Absatz lässt sich bei 

Bedarf die gewünschte Formatierung einstellen. 

Wenn Sie mit der Eingabe fertig sind, klicken Sie auf eine beliebige Stelle außer-

halb des Objekts. Möchten Sie den Text später noch einmal bearbeiten, selektieren 

Sie die AutoForm erneut und wählen den Befehl Text bearbeiten aus dem Kon-

textmenü. 

Wichtig: Wenn PlanMaker am unteren Rand des Textes einen roten Balken an-

zeigt, zeigt dies an, dass der Text nicht vollständig in den zur Verfügung stehen-

den Platz passt. Vergrößern Sie in diesem Falle also das Objekt oder verringern 

Sie die Textmenge. 

Hinweis: Die weiter vorne in diesem Kapitel vorgestellten Textrahmen sind übri-

gens nichts anderes als AutoFormen (in diesem Falle einfache Rechtecke), denen 

Text hinzugefügt wurde. Alle Informationen im Abschnitt „Textrahmen“ (ab Seite 

269) gelten also im gleichen Maße auch für AutoFormen, denen Text hinzugefügt 

wurde. 
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Eigenschaften von Zeichnungen ändern 

Um die Eigenschaften einer Zeichnung zu bearbeiten, selektieren Sie diese zu-

nächst per Mausklick. Dann rufen Sie den Menübefehl Objekt > Eigenschaften 

auf, worauf ein entsprechender Dialog erscheint. 

Tipp: Sie können diesen Dialog auch über einen Doppelklick auf die Zeichnung 

aufrufen. 

In dem Dialog lassen sich folgende Einstellungen vornehmen: 

Karteikarten Format, Füllung, Linien etc. 

Diese Karteikarten sind bei praktisch allen Arten von Objekten vorhanden. Sie die-

nen zum Ändern folgender Einstellungen: 

 Format: Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. 

Siehe Abschnitt „Objekt-Eigenschaften, Karteikarte Format“ ab Seite 256. 

 Füllung: Hier können Sie die Füllung ändern. Siehe Abschnitt „Objekt-

Eigenschaften, Karteikarte Füllung“ ab Seite 258. 

 Linien: Hier können Sie den Linienstil der Linien, mit denen das Objekt ge-

zeichnet wird, ändern. Siehe Abschnitt „Objekt-Eigenschaften, Karteikarte Li-

nien“ ab Seite 260. 

 Schatten: Hier können Sie einen Schatten anbringen. Siehe Abschnitt „Objekt-

Eigenschaften, Karteikarte Schatten“ ab Seite 261. 

 3D: Hier können Sie einen 3D-Effekt anbringen. Siehe Abschnitt „Objekt-

Eigenschaften, Karteikarte 3D“ ab Seite 262. 

 Effekte: Hier können Sie verschiedene Effekte anbringen. Siehe Abschnitt 

„Objekt-Eigenschaften, Karteikarte Effekte“ ab Seite 263. 

 Eigenschaften: Hier können Sie allgemeine Einstellungen ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Eigenschaften“ ab Seite 264. 

Weiterhin erscheinen bei einigen Arten von Zeichnungen zusätzliche Karteikarten 

mit weiteren Optionen (siehe nachfolgende Seiten). 

Karteikarte AutoFormen (nur bei AutoFormen) 

Diese Karteikarte erscheint nur bei AutoFormen. 
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Auf dieser Karteikarte können Sie dem Objekt eine andere AutoForm zuweisen, 

also beispielsweise aus einem Rechteck eine Sprechblase oder eine beliebige ande-

re Form machen. 

Wählen Sie dazu einfach die gewünschte AutoForm aus. 

Karteikarte Innentext (nur bei AutoFormen, denen Text hinzugefügt 

wurde) 

Diese Karteikarte erscheint nur bei Textrahmen und bei AutoFormen, denen Text 

hinzugefügt wurde (siehe Abschnitt „Text zu AutoFormen hinzufügen“ ab Seite 

290).  

Auf dieser Karteikarte können Sie Einstellungen zu dem enthaltenen Text ändern. 

Verfügbare Optionen: 

 Rubrik Innenränder 

 Hier können Sie die Innenränder für den Text ändern. Schalten Sie die Option 

Automatisch ein, ermittelt das Programm die Ränder automatisch. 

 Rubrik Überlappende Objekte 

 Diese Einstellung bestimmt, was passieren soll, wenn sich das Objekt mit ei-

nem anderen Objekt überlappt.  

 Bei der Standardeinstellung Objekt ignorieren greift PlanMaker nicht ein. In 

dem sich überlappenden Bereich wird also der Inhalt beider Objekte übereinan-

der gedruckt.  

 Wählen Sie hingegen die Option Text umbrechen, wird der in diesem Objekt 

enthaltene Text automatisch neu umbrochen, so dass er die Überlappung um-

fließt. 

 Rubrik Drehen um ... 

 Hier können Sie den Text um den angegebenen Winkel drehen. 

 Rubrik Vertikale Ausrichtung 

 Diese Einstellung bestimmt, wie der enthaltene Text zwischen Ober- und Un-

terkante der Zeichnung ausgerichtet werden soll: 
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Option Erläuterung 

Oben Der Text wird an der Oberkante des Objekts ausge-

richtet. (Dies ist die Standardeinstellung.) 

Zentriert Der Text wird zwischen Ober- und Unterkante 

zentriert. 

Unten Der Text wird an der Unterkante des Objekts ausge-

richtet. 

Vertikaler Blocksatz Der Abstand zwischen den Textzeilen wird gleich-

mäßig so erweitert, dass der Text an der Oberkante 

des Objekts beginnt und an der Unterkante endet. 

Karteikarte Text (nur bei TextArt-Objekten) 

Diese Karteikarte erscheint nur bei TextArt-Objekten. 

Sie können darin den gewünschten Effekt auswählen sowie den anzuzeigenden 

Text eingeben und formatieren. 

Verfügbare Optionen: 

 Text 

 Hier können Sie den Text eintippen, der angezeigt werden soll. 

 Varianten 

 In dieser Liste können Sie auswählen, mit welchem Effekt der Text dargestellt 

werden soll. 

 Rubrik Schrift 

 Hier können Sie die Schriftart ändern und die Textauszeichnungen Fett und 

Kursiv ein-/ausschalten. 

 Aktivieren Sie die Option Gleiche Höhe, werden alle Buchstaben (inklusive 

Kleinbuchstaben) auf eine einheitliche Höhe gestreckt. 

 Rubrik Abstände 

 Die Option Zeichen ändert den Abstand zwischen den Zeichen. Bei Werten 

kleiner als 100% sind die Zeichen enger zusammen, bei Werten größer als 

100% weiter auseinander. 
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 Die Option Zeilen ändert den Zeilenabstand. Dies wirkt sich nur auf Text aus, 

der aus mehreren Zeilen besteht. 

 Rubrik Ausrichtung 

 Hier können Sie die Ausrichtung des Textes ändern. Dies wirkt sich nur auf 

Text aus, der aus mehreren Zeilen besteht. 

 Rubrik Platzierung 

 Aktivieren Sie die Option Vertikaler Text, werden die Buchstaben des Textes 

um 90° gedreht. 

Karteikarte Deformation (nur bei TextArt-Objekten) 

Diese Karteikarte erscheint nur bei TextArt-Objekten. 

Sie können darauf festlegen, mit welcher Art von Verzerrung der Schriftzug darge-

stellt werden soll. Wählen Sie dazu die gewünschte Art von Deformation aus der 

Liste. 
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Diagramme 

Mit Hilfe von Diagrammen können Sie die Zahlenwerte einer Tabelle grafisch dar-

stellen und somit die „nackten Zahlen“ anschaulicher und übersichtlicher präsen-

tieren.  

 

In diesem Kapitel finden Sie alles Wissenswerte dazu. Folgende Themen werden 

darin behandelt: 

 Diagramme einfügen 

 Als erstes erfahren Sie, wie man ein Diagramm anlegt: Zellen mit den darzu-

stellenden Daten markieren, den Menübefehl Objekt > Neuer Diagramm-

rahmen aufrufen, Diagrammtyp wählen – fertig. 

 Diagramme bearbeiten 

 Der nächste Abschnitt enthält alle Informationen zum Bearbeiten von Dia-

grammen. Sie erfahren darin, wie man den Diagrammtyp und die Anordnung 

der Datenreihen ändert, wie man mit den einzelnen Diagrammelementen (Da-

tenreihen, Achsen, Legende etc.) arbeitet und wie man die allgemeinen Dia-

grammeigenschaften verändert. 
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 Diagramme aktualisieren 

 Ein Diagramm holt sich die darzustellenden Werte stets aus den Zellen, die 

beim Erstellen des Diagramms markiert waren. Ändern sich also Werte in die-

sen Zellen, wird das Diagramm sofort aktualisiert. Bei Bedarf können Sie diese 

automatische Aktualisierung jedoch abschalten. 

 Diagramme auf ein anderes Arbeitsblatt verschieben 

 Mit dem Menübefehl Objekt > Diagramm > Position des Diagramms än-

dern können Sie ein Diagramm auf ein anderes Arbeitsblatt verschieben oder 

gar ein eigenes Diagramm-Arbeitsblatt dafür anlegen. Dieses enthält keinerlei 

Tabellenzellen, sondern nur das Diagramm in voller Größe. 

 Diagramme als Grafik speichern 

 Der Menübefehl Objekt > Diagramm > Als Grafik speichern ermöglicht es 

Ihnen, ein Abbild eines Diagramms in einer Grafikdatei zu speichern. 

Diagramme einfügen 

Mit dem Menübefehl Objekt > Neuer Diagrammrahmen können Sie neue Dia-

gramme in das Dokument einfügen. 

Gehen Sie dazu wie folgt vor: 

1. Markieren Sie die Zellen, deren Inhalte in dem Diagramm dargestellt werden 

sollen. 

 Tipp: Wenn Sie dabei Spalten- und Zeilenüberschriften mitmarkieren, werden 

diese automatisch zur Beschriftung der Achsen und der Legende herangezogen. 

2. Rufen Sie den Menübefehl Objekt > Neuer Diagrammrahmen auf. 

 Alternativ können Sie diesen Befehl auch über das Symbol  in der Funkti-

onsleiste aufrufen. 

3. Es erscheint ein Dialog, in dem Sie bestimmen können, welche Art von Dia-

gramm eingefügt werden soll. Wählen Sie dazu den gewünschten Diagramm-

typ und Untertyp. Informationen zu den einzelnen Diagrammtypen finden Sie 

im Abschnitt „Diagrammtyp ändern“ ab Seite 298. 

4. Bestätigen Sie mit OK. 

5. Das Diagramm wird nun eingefügt.  
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 Wenn Sie möchten, können Sie das Diagramm anschließend noch verschieben 

oder seine Größe ändern: 

 Zum Verschieben klicken Sie mit der Maus auf das Diagramm und ziehen es 

dann (bei weiterhin gedrückter Maustaste) an die gewünschte Position.  

 Um die Größe zu ändern, ziehen Sie mit der Maus an einem der runden Greifer, 

die das Diagramm umgeben.  

Diagramme bearbeiten 

In den nächsten Abschnitten erfahren Sie, wie Sie Diagramme bearbeiten können. 

Folgende Themen werden darin behandelt: 

 Diagrammtyp ändern (Seite 298) 

 Anordnung der Datenreihen ändern (Seite 303) 

 Diagrammelemente bearbeiten (Seite 304) 

 Diagrammeigenschaften ändern (Seite 324) 

Hinweis: Grundlegende Informationen zum Arbeiten mit Objekten finden Sie au-

ßerdem im Abschnitt „Objekte“ ab Seite 249.  

Tipp: Verwenden der Diagrammleiste 

Wenn Sie ein Diagramm selektieren, erscheint automatisch ein nützlicher Helfer 

auf dem Bildschirm: die Diagrammleiste. 

 

Die Diagrammleiste 

Diese Leiste enthält Symbole für die wichtigsten Funktionen zum Bearbeiten von 

Diagrammen. Von links nach rechts: 

 Diagrammtyp auswählen 

 Untertyp auswählen (nur bei einigen Diagrammtypen verfügbar) 

 Liste aller Diagrammelemente, die das Diagramm enthält (klicken Sie auf ein 

Element, wird es im Diagramm selektiert) 

 Eigenschaften des gewählten Diagrammelements bearbeiten 

 Allgemeine Eigenschaften des gesamten Diagramms bearbeiten 
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 Datenreihen spaltenweise anordnen 

 Datenreihen zeilenweise anordnen 

 Trendlinie hinzufügen 

 Legende ein-/ausblenden 

 Vertikale Gitternetzlinien ein-/ausblenden 

 Horizontale Gitternetzlinien ein-/ausblenden 

Informationen zur Funktion der einzelnen Symbole folgen auf den nächsten Seiten. 

Diagrammtyp ändern 

Der Diagrammtyp bestimmt, in welcher Form die Daten im Diagramm dargestellt 

werden – zum Beispiel als Balken, als Linien, in Form eines Tortendiagramms etc. 

etc. 

Um den Diagrammtyp zu ändern, gehen Sie wie folgt vor. 

1. Selektieren Sie das Diagramm per Mausklick. 

2. Rufen Sie den Menübefehl Objekt > Eigenschaften auf. 

3. Wechseln Sie auf die Karteikarte Diagrammtyp. 

4. Wählen Sie den gewünschten Diagrammtyp und Untertyp. 

Tipp: Alternativ können Sie die ersten beiden Symbole in der Diagrammleiste 

verwenden: das erste Symbol bestimmt den Diagrammtyp, das zweite den Unter-

typ (nur bei bestimmten Diagrammtypen verfügbar). 

Es gibt folgende Diagrammtypen: 

   Säulendiagramm  

Säulendiagramme eignen sich gut dazu, Werte miteinander zu vergleichen. Jeder 

Wert wird durch eine entsprechend hohe Säule dargestellt. 
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   Balkendiagramm 

Balkendiagramme entsprechen Säulendiagrammen; die Werte werden allerdings 

nicht vertikal, sondern horizontal abgebildet. 

   Liniendiagramm 

Bei einem Liniendiagramm werden die Werte als Punkte und/oder Linien zwi-

schen diesen Punkten dargestellt. 

   Flächendiagramm 

Ein Flächendiagramm ist ein Liniendiagramm, bei dem der Zwischenraum zwi-

schen X-Achse und den einzelnen Linien ausgefüllt wird. 

   XY-Punktdiagramm 

XY-Punktdiagramme stellen die Werte als Punkte und/oder Linien dar. Anders als 

bei Liniendiagrammen muss der Datenbereich dabei jedoch sowohl die x- als auch 

die y-Koordinaten der Datenpunkte enthalten. 

   Blasendiagramm 

Blasendiagramme stellen Daten als ausgefüllte Kreise („Blasen“) dar. Für ein 

Blasendiagramm verwendet man üblicherweise Datenreihen mit drei Werten: x-

Koordinate, y-Koordinate und Blasengröße. 

   Netzdiagramm 

Ein Netzdiagramm stellt die Werte auf einem Netz dar. Der Nullpunkt liegt dabei 

in der Mitte des Netzes. 
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   Oberflächendiagramm 

Bei einem Oberflächendiagramm werden die Werte zu einer dreidimensional 

dargestellten Oberfläche verbunden. Bereiche, die in der gleichen Farbe gezeichnet 

werden, zeigen an, dass sie ähnliche Werte enthalten.  

Die darzustellenden Daten sollten dabei folgende Struktur haben: 

 

(Die z-Werte sind die Höhenwerte.) 

   Kreisdiagramm (Tortendiagramm) 

Kreisdiagramme (oder Tortendiagramme) sind gut dazu geeignet, den Anteil 

von Einzelwerten am Gesamtwert darzustellen. Die Größe jedes einzelnen „Torten-

stücks“ zeigt das Verhältnis des Werts zur Gesamtsumme und zu den anderen Wer-

ten. 

Tipp: Sie können Werte besonders hervorheben, indem Sie das dazugehörige Tor-

tenstück aus der Torte herausziehen. Selektieren Sie das Tortenstück dazu und zie-

hen Sie es mit der Maus heraus. 

   Ringdiagramm 

Ringdiagramme zeigen, genau wie Kreisdiagramme, den Anteil von Einzelwerten 

am Gesamtwert. Im Gegensatz zu Kreisdiagramme können Sie jedoch nicht nur 

eine einzige Datenreihe darstellen, sondern beliebige viele Datenreihen (= Ringe). 
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   Zylinder-, Kegel- und Pyramidendiagramm 

Zylinder-, Kegel- und Pyramidendiagramme entsprechen Säulen- und Balkendi-

agrammen. Anstelle von Säulen/Balken verwenden sie jedoch Zylinder, Kegel oder 

Pyramiden zur Darstellung der Werte. 

   Kursdiagramm 

Kursdiagramme (auch Börsendiagramme oder allgemein Hoch-Tief-

Diagramme genannt) eignen sich unter anderem zum Darstellen von Aktienkur-

sen. Es lassen sich darin beispielsweise der höchste Kurs, der tiefste Kurs und der 

Schlusskurs auf einen Blick ablesen. 

Es gibt folgende Untertypen: 

 Kursdiagramm (Höchst-, Tiefst-, Schlusskurs) 

 Stellt folgende Werte dar: 

 Höchstkurs, Tiefstkurs, Schlusskurs 

 Benötigt 3 Datenreihen in obiger Reihenfolge.  

 Ein Beispiel für einen möglichen Aufbau der Daten (in Spalte A ist hier zusätz-

lich das Datum eingetragen): 

  

 Kursdiagramm (Eröffnungs-, Höchst-, Tiefst-, Schlusskurs) 

 Stellt folgende Werte dar: 

 Eröffnungskurs, Höchstkurs, Tiefstkurs, Schlusskurs 

 Benötigt 4 Datenreihen in obiger Reihenfolge. 
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 Kursdiagramm (Volumen; Höchst-, Tiefst-, Schlusskurs) 

 Stellt folgende Werte dar: 

 Handelsvolumen, Höchstkurs, Tiefstkurs, Schlusskurs 

 Benötigt 4 Datenreihen in obiger Reihenfolge.  

 Das Handelsvolumen wird dabei in einer zusätzlichen Säule dargestellt, die 

über ihre eigene Größenachse verfügt. 

 Kursdiagramm (Volumen; Eröffnungs-, Höchst-, Tiefst-, Schlusskurs) 

 Stellt folgende Werte dar: 

 Handelsvolumen, Eröffnungskurs, Höchstkurs, Tiefstkurs, Schlusskurs 

 Benötigt 5 Datenreihen in obiger Reihenfolge.  

 Das Handelsvolumen wird dabei in einer zusätzlichen Säule dargestellt, die 

über ihre eigene Größenachse verfügt. 

   Boxplot-Diagramm 

Boxplots (oder Box-Whisker-Plots) sind hilfreich bei der Datenanalyse in der 

Statistik. Ihre Anwendung hier im Detail zu erläutern würde den Rahmen dieses 

Handbuchs sprengen; bei Bedarf finden Sie weiterführende Informationen mit der 

Suchmaschine Ihrer Wahl. 

Es gibt zwei Untertypen: Horizontal und Vertikal. 

Abhängig davon, wie viele Datenreihen Sie dem Diagramm übergeben, werden 

unterschiedliche Varianten von Boxplots geliefert: 

(Hinweis: Welche Arten von Werten Sie in einem Boxplot darstellen möchten, ist 

völlig Ihnen überlassen. Die nachfolgenden Listen zeigen lediglich Beispiele.) 

 3 Punkte-Boxplot 

 Stellt beispielsweise folgende Werte dar: 

 Unteres Quartil (untere Kante der Box) 

 Median (Position des Strichs innerhalb der Box) 

 Oberes Quartil (obere Kante der Box) 

 Benötigt genau 3 Datenreihen in obiger Reihenfolge. 
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 5 Punkte-Boxplot 

 Stellt beispielsweise folgende Werte dar: 

 Unterer Whisker (Linie unter der Box) 

 Unteres Quartil (untere Kante der Box) 

 Median (Position des Strichs innerhalb der Box) 

 Oberes Quartil (obere Kante der Box) 

 Oberer Whisker (Linie oberhalb der Box) 

 Benötigt genau 5 Datenreihen in obiger Reihenfolge. 

7 Punkte-Boxplot 

 Stellt beispielsweise folgende Werte dar: 

 Minimum (als einzelner Marker) 

 Unterer Whisker (Linie unter der Box) 

 Unteres Quartil (untere Kante der Box) 

 Median (Position des Strichs innerhalb der Box) 

 Oberes Quartil (obere Kante der Box) 

 Oberer Whisker (Linie oberhalb der Box) 

 Maximum (als einzelner Marker) 

 Benötigt genau 7 Datenreihen in obiger Reihenfolge. 

Anordnung der Datenreihen ändern 

Mit den zwei Symbolen  in der Diagrammleiste können Sie festlegen, ob 

die darzustellenden Daten spaltenweise oder zeilenweise ausgewertet werden sol-

len: 

 Spaltenweise 

 Normalerweise ist das erste Symbol aktiv, das Diagramm liest die markierten 

Werte also Spalte für Spalte. Die Werte aus der ersten Spalte bilden demnach 

Datenreihe 1, die aus der zweiten Spalte Datenreihe 2 etc. 

 Zeilenweise 

 Aktivieren Sie hingegen das zweite Symbol, werden die Daten zeilenweise 

ausgelesen. Die Zuordnung der Zeilen/Spalten in der Tabelle zur X-Achse/Y-

Achse im Diagramm wird also vertauscht. 

Alternativ können Sie diese Einstellung auch über die Menübefehle Objekt > Dia-

gramm > Daten in Spalten beziehungsweise Daten in Zeilen festlegen.  
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Diagrammelemente bearbeiten 

Diagramme bestehen aus mehreren Komponenten. So gibt es neben den Datenrei-

hen selbst beispielsweise die Achsen, eine Legende etc. Diese einzelnen Kompo-

nenten eines Diagramms nennt man die Diagrammelemente. 

Die nachfolgende Abbildung zeigt, welche Diagrammelemente es gibt: 

 

Reihe 1, Reihe 2 etc. sind dabei die Datenreihen. 

Bei dreidimensionalen Diagrammtypen kommen noch ein paar zusätzliche Ele-

mente (Bodenfläche, Wände etc.) hinzu, die ebenfalls auf den nächsten Seiten be-

schrieben werden. 

Jedes dieser Diagrammelemente lässt sich bei Bedarf per Mausklick selektieren 

und dann bearbeiten. 

Selektieren von Diagrammelementen 

Um ein Diagrammelement zu selektieren, selektieren Sie zunächst das Diagramm 

selbst (durch Anklicken) und klicken dann auf das gewünschte Diagrammelement. 

Um beispielsweise eine Datenreihe zu selektieren, klicken Sie auf einen beliebigen 

Wert innerhalb dieser Reihe.  

Hinweis: Wenn Sie einen einzelnen Wert innerhalb einer Datenreihe selektieren 

möchten, müssen Sie erst auf die Datenreihe und dann auf den gewünschten Ein-

zelwert klicken. 
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Tipp: Alternativ können Sie Diagrammelemente selektieren, indem Sie die Liste 

der Elemente in der Mitte der Diagrammleiste aufklappen und darin das ge-

wünschte Element auswählen. 

 

Position und Größe von Diagrammelementen ändern 

Bei machen Diagrammelementen (z.B. der Legende) lässt sich die Position und 

Größe ändern. Selektieren Sie das Element dazu und ziehen Sie es anschließend an 

die gewünschte Position. Um die Größe zu ändern, ziehen Sie an einem der runden 

Greifer, die das Element umgeben. 

Eigenschaften von Diagrammelementen ändern 

Sie können nicht nur, wie später im Abschnitt „Diagrammeigenschaften ändern“ ab 

Seite 324 beschrieben, die Eigenschaften des Diagramms an sich ändern, sondern 

auch die Eigenschaften einzelner Diagrammelemente bearbeiten. 

Um beispielsweise die Eigenschaften der Legende eines Diagramms zu ändern, 

gehen Sie wie folgt vor: 

1. Selektieren Sie das Diagramm per Mausklick. 

2. Rechtsklicken Sie auf die Legende, um ihr Kontextmenü aufzurufen. 

 Android: Bei der Android-Version können Sie das Kontextmenü auch mit dem 

Finger öffnen: Tippen Sie dazu auf den Bildschirm und halten Sie den Finger 

für etwa eine Sekunde gedrückt. 

3. Wählen Sie im Kontextmenü den Befehl Legende: Eigenschaften aus (nicht 

den Befehl Diagramm: Eigenschaften). 

Nun erscheint ein Dialog, in dem Sie die gewünschten Einstellungen vornehmen 

können. 

Tipp: Alternativ können Sie diesen Dialog auch über das Symbol  in der Dia-

grammleiste aufrufen. 

Noch schneller: Darüber hinaus können Sie den Dialog mit einem Doppelklick 

auf das gewünschte Element öffnen. 
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Welche Eigenschaften sich in diesem Dialog ändern lassen, hängt davon ab, für 

welche Art von Diagrammelement Sie ihn aufrufen. In den nächsten Abschnitten 

finden Sie Informationen zu allen verfügbaren Diagrammelementen und ihren je-

weiligen Eigenschaften: 

 Diagrammfläche (Seite 306) 

 Zeichnungsfläche (Seite 307) 

 Wände (nur bei dreidimensionalen Diagrammtypen) (Seite 308) 

 Bodenfläche (nur bei dreidimensionalen Diagrammtypen) (Seite 309) 

 Ecken (nur bei dreidimensionalen Diagrammtypen) (Seite 310) 

 Datenreihen und Datenpunkte (Seite 310) 

 Trendlinien (Seite 314) 

 Rubrikenachse (X-Achse) (Seite 316) 

 Größenachse (Y-Achse) (Seite 318) 

 Reihenachse (Z-Achse) (Seite 320) 

 Gitternetzlinien (Seite 322) 

 Legende (Seite 323) 

Diagrammfläche 

Als Diagrammfläche wird die gesamte Fläche eines Diagrammrahmens bezeichnet. 

Eigenschaften bearbeiten: Um die Eigenschaften der Diagrammfläche zu ändern, 

selektieren Sie diese, öffnen mit einem Rechtsklick das Kontextmenü und rufen 

darin den Befehl Diagrammfläche: Eigenschaften auf.  

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Dia-

grammleiste oder per Doppelklick auf die Diagrammfläche aufrufen. 

Es lassen sich folgende Einstellungen vornehmen: 
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Karteikarte Format 

 Rubrik Umrandung 

 Hier lässt sich das gesamte Diagramm mit einer Umrandung versehen. Wählen 

Sie dazu die gewünschte Linienart.  

 Wenn Sie die Option Schatten aktivieren, wird der Diagrammrahmen außer-

dem mit einem Schatten hinterlegt. Über die Schaltfläche Anpassen können Sie 

zusätzliche Einstellungen zum Aussehen des Schatteneffekts machen. 

 Rubrik Füllung 

 Hier können Sie die Füllung der Diagrammfläche ändern. Wählen Sie dazu die 

gewünschte Art von Füllung.  

 Wenn Sie die Füllart Effekte wählen und auf die Schaltfläche Anpassen kli-

cken, erscheint ein Dialog, über den Sie auch komplexere Füllungen (z.B. einen 

Farbverlauf) anbringen können. Die Bedienung dieses Dialogs ist im Abschnitt 

„Objekt-Eigenschaften, Karteikarte Füllung“ ab Seite 258 beschrieben. 

Karteikarte Schrift 

Hier können Sie die Textformatierung für alle Diagrammelemente ändern. 

Wählen Sie dazu die gewünschte Schriftart, Schriftgröße, Ausrichtung etc. 

Wichtig: Änderungen wirken sich, wie gesagt, auf alle Diagrammelemente aus – 

auch wenn diese zuvor in einer anderen Schrift formatiert waren. 

Zeichnungsfläche 

Als Zeichnungsfläche wird der Bereich eines Diagramms bezeichnet, in dem die 

Datenreihen, die Achsen und die Gitternetzlinien gezeichnet werden. 

Eigenschaften bearbeiten: Um die Eigenschaften der Zeichnungsfläche zu ändern, 

selektieren Sie diese, öffnen mit einem Rechtsklick das Kontextmenü und rufen 

darin den Befehl Zeichnungsfläche: Eigenschaften auf.  

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Dia-

grammleiste oder per Doppelklick auf die Zeichnungsfläche aufrufen. 

Es lassen sich folgende Einstellungen vornehmen: 
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Karteikarte Format 

 Rubrik Umrandung 

 Hier lässt sich die Zeichnungsfläche mit einer Umrandung versehen. Wählen 

Sie dazu die gewünschte Linienart.  

 Rubrik Füllung 

 Hier können Sie die Füllung der Zeichnungsfläche ändern. Wählen Sie dazu die 

gewünschte Art von Füllung.  

 Wenn Sie die Füllart Effekte wählen und auf die Schaltfläche Anpassen kli-

cken, erscheint ein Dialog, über den Sie auch komplexere Füllungen (z.B. einen 

Farbverlauf) anbringen können. Die Bedienung dieses Dialogs ist im Abschnitt 

„Objekt-Eigenschaften, Karteikarte Füllung“ ab Seite 258 beschrieben. 

Wände (nur bei dreidimensionalen Diagrammtypen) 

Als Wände bezeichnet man die rückwärtigen Wände von Diagrammen, die einen 

dreidimensionalen Diagrammtyp verwenden. 

Eigenschaften bearbeiten: Um die Eigenschaften der Wände zu ändern, selektieren 

Sie diese, öffnen mit einem Rechtsklick das Kontextmenü und rufen darin den Be-

fehl Wände: Eigenschaften auf.  

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Dia-

grammleiste oder per Doppelklick auf die Wände aufrufen. 

Es lassen sich folgende Einstellungen vornehmen: 

Karteikarte Format 

 Rubrik Umrandung 

 Hier lassen sich die Wände mit einer Umrandung versehen. Wählen Sie dazu 

die gewünschte Linienart.  

 Rubrik Füllung 

 Hier können Sie die Füllung der Wände ändern. Wählen Sie dazu die ge-

wünschte Art von Füllung.  



 

Handbuch PlanMaker Diagramme  •  309 

 Wenn Sie die Füllart Effekte wählen und auf die Schaltfläche Anpassen kli-

cken, erscheint ein Dialog, über den Sie auch komplexere Füllungen (z.B. einen 

Farbverlauf) anbringen können. Die Bedienung dieses Dialogs ist im Abschnitt 

„Objekt-Eigenschaften, Karteikarte Füllung“ ab Seite 258 beschrieben. 

Karteikarte 3D-Ansicht 

Hier können Sie den 3D-Effekt für das gesamte Diagramm einstellen. Informatio-

nen dazu finden Sie im Abschnitt „Diagrammeigenschaften, Karteikarte 3D-

Ansicht“ ab Seite 329. 

Bodenfläche (nur bei dreidimensionalen Diagrammtypen) 

Als Bodenfläche bezeichnet man den Boden von Diagrammen, die einen dreidi-

mensionalen Diagrammtyp verwenden. 

Eigenschaften bearbeiten: Um die Eigenschaften der Bodenfläche zu ändern, selek-

tieren Sie diese, öffnen mit einem Rechtsklick das Kontextmenü und rufen darin 

den Befehl Bodenfläche: Eigenschaften auf.  

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Dia-

grammleiste oder per Doppelklick auf die Bodenfläche aufrufen. 

Es lassen sich folgende Einstellungen vornehmen: 

Karteikarte Format 

 Rubrik Umrandung 

 Hier lässt sich die Bodenfläche mit einer Umrandung versehen. Wählen Sie 

dazu die gewünschte Linienart.  

 Rubrik Füllung 

 Hier können Sie die Füllung der Bodenfläche ändern. Wählen Sie dazu die ge-

wünschte Art von Füllung.  

 Wenn Sie die Füllart Effekte wählen und auf die Schaltfläche Anpassen kli-

cken, erscheint ein Dialog, über den Sie auch komplexere Füllungen (z.B. einen 

Farbverlauf) anbringen können. Die Bedienung dieses Dialogs ist im Abschnitt 

„Objekt-Eigenschaften, Karteikarte Füllung“ ab Seite 258 beschrieben. 
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Karteikarte 3D-Ansicht 

Hier können Sie den 3D-Effekt für das gesamte Diagramm einstellen. Informatio-

nen dazu finden Sie im Abschnitt „Diagrammeigenschaften, Karteikarte 3D-

Ansicht“ ab Seite 329. 

Ecken (nur bei dreidimensionalen Diagrammtypen) 

Als Ecken bezeichnet man sämtliche Ecken von Diagrammen, die einen dreidi-

mensionalen Diagrammtyp verwenden. 

Eigenschaften bearbeiten: Um die Eigenschaften der Ecken zu ändern, selektieren Sie 

diese, öffnen mit einem Rechtsklick das Kontextmenü und rufen darin den Befehl 

Ecken: Eigenschaften auf.  

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Dia-

grammleiste aufrufen. 

Es lassen sich folgende Einstellungen vornehmen: 

Karteikarte 3D-Ansicht 

Hier können Sie den 3D-Effekt für das gesamte Diagramm einstellen. Informatio-

nen dazu finden Sie im Abschnitt „Diagrammeigenschaften, Karteikarte 3D-

Ansicht“ ab Seite 329. 

Datenreihen und Datenpunkte 

Die Datenreihen sind die wichtigsten Bestandteile eines Diagramms. Sie stellen die 

auszuwertenden Daten dar – je nach gewähltem Diagrammtyp in Form von Säulen, 

Balken, Linien, Kreissegmenten etc. 

Eine Datenreihe ist die grafische Repräsentation von einer Spalte beziehungsweise 

einer Zeile der Zellwerte, auf denen das Diagramm basiert. Jede Datenreihe besteht 

wiederum aus mehreren Datenpunkten, also den einzelnen Zellwerten. 

Eigenschaften bearbeiten: Um die Eigenschaften von Datenreihen und -punkten zu 

ändern, gehen Sie wie folgt vor: 

 Klicken Sie auf einen beliebigen Datenpunkt einer Datenreihe, wird zunächst 

die gesamte Datenreihe selektiert. Mit dem Befehl Reihe: Eigenschaften im 

Kontextmenü können Sie nun die Eigenschaften dieser Datenreihe bearbeiten. 
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 Klicken Sie den Datenpunkt jedoch erneut an, wird nur der einzelne Daten-

punkt selektiert. Der Befehl im Kontextmenü heißt dann dementsprechend Da-

tenpunkt: Eigenschaften. 

Es lassen sich folgende Einstellungen vornehmen: 

Karteikarte Format 

 Rubrik Umrandung (beziehungsweise Linie) 

 Hier lässt sich das Aussehen der Linien ändern, mit denen die Daten gezeichnet 

werden.  

 Wenn Sie dabei die Option Schatten aktivieren, wird der Graph außerdem mit 

einem Schatten hinterlegt. Über die Schaltfläche Anpassen können Sie weitere 

Einstellungen zum Aussehen des Schatteneffekts machen. 

 Rubrik Füllung 

 Hier können Sie die Füllung der Datenreihen/Datenpunkte ändern. Wählen Sie 

dazu die gewünschte Art von Füllung.  

 Wenn Sie die Füllart Effekte wählen und auf die Schaltfläche Anpassen kli-

cken, erscheint ein Dialog, über den Sie auch komplexere Füllungen (z.B. einen 

Farbverlauf) anbringen können. Die Bedienung dieses Dialogs ist im Abschnitt 

„Objekt-Eigenschaften, Karteikarte Füllung“ ab Seite 258 beschrieben. 

 Rubrik Markierung (nur bei bestimmten Diagrammtypen verfügbar) 

 Bei Diagrammtypen, bei denen für die einzelnen Datenpunkte Markierungen 

gezeichnet werden, können Sie hier das Aussehen dieser Markierungen anpas-

sen. 

Karteikarte 3D-Format 

Hinweis: Die Optionen auf dieser Karteikarte sind nicht bei allen Diagrammty-

pen verfügbar.  

Mit Hilfe dieser Karteikarte können Sie die darzustellenden Datenpunkte mit Be-

leuchtungseffekten und abgerundeten Kanten versehen. 

 Material 

 Hier können Sie das Material wählen, das für die Darstellung der Datenpunkte 

simuliert werden soll. 
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 Beleuchtung 

 Hier können Sie auswählen, welche Art von Beleuchtung simuliert werden soll. 

 Drehwinkel 

 Hier lässt sich der Winkel ändern, in dem das Licht einfallen soll. 

Tipp: Obige Effekte kommen besser zur Geltung, wenn Sie zusätzlich die 

nachfolgenden Optionen zum Abrunden der Kanten einsetzen. 

 Rubrik Abgeschrägte Kanten 

 Hier können Sie die Kanten der grafischen Repräsentation der Datenpunkte 

abrunden lassen. Wenden Sie diese Optionen beispielsweise auf ein Balkendia-

gramm an, werden die Kanten der Balken abgerundet. Je größer der Wert, desto 

stärker die Abrundung. 

Karteikarte Datenbeschriftungen 

Auf dieser Karteikarte können Sie Datenpunkte mit Beschriftungen versehen, also 

beispielsweise den genauen Wert der Datenpunkte im Diagramm anzeigen lassen. 

 Rubrik Anzeige 

 Hier können Sie die Art der Beschriftung wählen. Voreingestellt ist die Option 

Keine, es wird also keine Beschriftung angezeigt. Wählen Sie beispielsweise 

die Option Wert anzeigen, wird der Wert der betreffenden Datenpunkte ange-

zeigt, bei der Option Datenpunkt anzeigen sein Name etc. 

 Legendensymbol bei Beschriftung 

 Wenn Sie diese Option aktivieren, werden vor den Beschriftungen die Legen-

densymbole der betreffenden Datenpunkte angezeigt – in der Regel also ein 

Kästchen in der Farbe des Datenpunkts. 

 Rubrik Platzierung 

 Hier können Sie bestimmen, wo die Beschriftung platziert werden soll (relativ 

zum jeweiligen Datenpunkt). 

Hinweis: Wenn Sie Datenpunkte mit einer Beschriftung versehen, sind diese Be-

schriftungen selbst ebenfalls im Diagramm anklickbar. Sie können also deren Ei-

genschaften verändern und beispielsweise eine andere Schriftart wählen oder den 

anzuzeigenden Text ändern.  
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Auch hier gilt: 1x anklicken selektiert alle Beschriftungen einer Datenreihe, noch-

mals anklicken selektiert eine einzelne Beschriftung. 

Karteikarte Fehlerindikator Y 

Hinweis: Diese Karteikarte ist nur bei bestimmten zweidimensionalen Dia-

grammtypen (u.a. Säulen-, Balken und Liniendiagrammen) verfügbar. 

Mit Hilfe dieser Karteikarte können Sie Fehlerindikatoren für die Datenpunkte 

einer Datenreihe zeichnen lassen. Diese stellen den möglichen/zulässigen Fehler 

der Werte in Form einer Linie mit einem Querstrich am Ende dar. 

 

Diagramm mit Fehlerindikatoren „Plus“ und „Minus“ 

Bestimmen Sie dazu in der Rubrik Anzeige, welche Art von Indikatoren angezeigt 

werden sollen: Plus zeichnet eine Indikatorlinie nach oben, Minus nach unten, 

Plus und Minus zeichnet beide Linien. 

Mit Anzeigen als... können Sie das Aussehen der Indikatorlinien bestimmen: mit 

oder ohne Querstrich am Ende. 

In der Rubrik Wert können Sie die Länge der Indikatorlinie ändern. Wählen Sie 

beispielsweise die Option Fest, hat die Linie immer die angegebene Länge, bei der 

Option Prozentual entspricht ihre Länge dem angegebenen prozentualen Anteil 

vom jeweiligen Y-Wert etc. 

Karteikarte Fehlerindikator X 

Hinweis: Diese Karteikarte ist nur bei XY-Punkt- und Blasendiagrammen ver-

fügbar. 

Entspricht Fehlerindikator Y (siehe oben), zeichnet jedoch Indikatorlinien für die 

X-Werte statt der Y-Werte. 
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Karteikarte Hilfslinien 

Hinweis: Diese Karteikarte ist nur bei bestimmten zweidimensionalen Dia-

grammtypen (u.a. Säulen-, Balken und Liniendiagrammen) verfügbar. 

Mit Hilfe dieser Karteikarte können Sie verschiedene Hilfslinien im Diagramm 

einblenden lassen. Schalten Sie beispielsweise die Hilfslinie Durchschnitt ein, 

erscheint im Diagramm eine gestrichelte Linie, die anzeigt, wo der Durchschnitt 

der Werte dieser Datenreihe liegt. 

Sie können Hilfslinien für Durchschnitt, Standardabweichung und Mini-

mum/Maximum sowie eine Ausgleichsgerade (linearer Trend) aktivieren.  

Tipp: Über den Menübefehl Objekt > Diagramm > Trendlinie hinzufügen lassen 

sich bei Bedarf noch weitere Arten von Trendlinien im Diagramm einblenden. Sie-

he dazu Abschnitt „Trendlinien“ weiter unten. 

Karteikarte Optionen 

Auf dieser Karteikarte erscheinen je nach Diagrammtyp unterschiedliche Optionen 

zur Darstellung der Datenreihen/Datenpunkte. 

Trendlinien 

Hinweis: Trendlinien können nur in bestimmten zweidimensionalen Diagramm-

typen (u.a. Säulen-, Balken und Liniendiagrammen) verwendet werden. 

Sie können auf Wunsch zu jeder Datenreihe des Diagramms eine Trendlinie ein-

blenden lassen.  

Eine Trendlinie stellt den Trend der Datenreihe grafisch dar, zeigt also beispiels-

weise an, in welchem Maße die Werte im Mittel steigen/fallen. Sie können Trendli-

nien auch über die vorhandenen Daten hinaus verlängern lassen und so beispiels-

weise eine Prognose für zukünftige Werte erhalten. 

Die Position und Steigung der Trendlinie wird dabei mit Hilfe eines Regressions-

verfahrens ermittelt. 

Trendlinie hinzufügen: Um einer Datenreihe eine Trendlinie hinzuzufügen, selektie-

ren Sie diese Datenreihe, öffnen mit einem Rechtsklick das Kontextmenü und ru-

fen darin den Befehl Trendlinie hinzufügen auf. 



 

Handbuch PlanMaker Diagramme  •  315 

Tipp: Alternativ können Sie auch auf das Symbol  in der Diagrammleiste kli-

cken oder den Menübefehl Objekt > Diagramm > Trendlinie hinzufügen auf-

rufen. 

Trendlinie entfernen: Um eine Trendlinie wieder zu entfernen, selektieren Sie diese 

und drücken die Taste (Entf). 

Eigenschaften bearbeiten: Um die Eigenschaften einer Trendlinie zu ändern, selektie-

ren Sie diese, öffnen mit einem Rechtsklick das Kontextmenü und rufen darin den 

Befehl Trendlinie: Eigenschaften auf.  

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Dia-

grammleiste oder per Doppelklick auf die Trendlinie aufrufen. 

Es lassen sich folgende Einstellungen vornehmen: 

Karteikarte Format 

 Rubrik Linie 

 Hier lässt sich das Aussehen der Linie ändern.  

Karteikarte Trend 

 Rubrik Typ 

 Hier können Sie den Typ des darzustellenden Trends wählen. Neben linearen 

Trends (also einfachen Ausgleichsgeraden) lassen sich beispielsweise auch ex-

ponentielle oder polynomische Trends darstellen. 

 Für die einzelnen Arten von Trends werden folgende Formeln verwendet: 

Linear: y = ax + b 

Polynomisch: y = b + c1x + c2x2 + c3x3 + ... + c6x6 

Exponentiell: y = cebx   (e = Eulersche Zahl) 

Logarithmisch: y = c ln(x) + b 

Potentiell: y = cxb 

Gleitender Durchschnitt: f(xi) = (xi + xi-1 + xi-2 + ... + xi-n+1) / n 
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 Basiert auf Reihe 

 Hier können Sie festlegen, für welche Datenreihe die Trendlinie gezeichnet 

werden soll. 

 Rubrik Trend 

 Hier können Sie die Trendlinie über die vorhandenen Datenpunkte hinaus ver-

längern. 

 Sind beispielsweise 3 Datenpunkte vorhanden (zum Beispiel die Verkaufser-

gebnisse für das 1., 2. und 3. Jahr), können Sie bei Vorwärts eine 1 eingeben. 

Die Linie wird dann um eine zusätzliche Periode (= einen Datenpunkt) verlän-

gert, zeigt also eine Prognose für die Verkäufe im 4. Jahr an. 

 Schnittpunkt 

 Hier können Sie erzwingen, dass die Trendlinie die Y-Achse bei einer bestimm-

ten y-Koordinate schneiden soll. Nur bei bestimmten Arten von Trendlinien 

verfügbar. 

 Formel im Diagramm anzeigen 

 Blendet im Diagramm die Gleichung an, auf der die Trendlinie basiert. 

 Korrelationsmaß anzeigen 

 Blendet im Diagramm das Korrelationsmaß (Bestimmtheitsmaß) R2 ein. 

 Rubrik Name 

 Hier können Sie auf Wunsch den Namen der Trendlinie ändern. Dieser wird in 

der Legende angezeigt. Wählen Sie dazu die Option Benutzerdefiniert und 

tragen Sie den gewünschten Namen ein. 

Rubrikenachse (X-Achse) 

Die X-Achse eines Diagramms wird auch als Rubrikenachse bezeichnet. 

Achsen ein-/ausblenden: Um Achsen ein- oder auszublenden, selektieren Sie das Di-

agramm, rufen den Menübefehl Objekt > Eigenschaften auf und wechseln auf die 

Karteikarte Elemente. Klicken Sie nun auf das Kontrollkästchen vor X-Achse, um 

beispielsweise die Anzeige der Rubrikenachse ein- oder auszuschalten. 

Eigenschaften bearbeiten: Um die Eigenschaften der Rubrikenachse zu ändern, selek-

tieren Sie diese, öffnen mit einem Rechtsklick das Kontextmenü und rufen darin 

den Befehl Rubrikenachse: Eigenschaften auf.  
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Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Dia-

grammleiste oder per Doppelklick auf die Achse aufrufen. 

Es lassen sich folgende Einstellungen vornehmen: 

Karteikarte Format 

 Rubrik Linie 

 Hier können Sie das Aussehen der Linie ändern, mit der die Achse gezeichnet 

wird. 

 Rubriken Hauptstriche und Hilfsstriche 

 Hier können Sie bestimmen, ob zur Einteilung der Achse kleine Teilstriche an-

gezeigt werden sollen und wie diese aussehen sollen. 

 Rubrik Strichbeschriftungen 

 Hier können Sie bestimmen, ob bei den Teilstrichen Beschriftungen angezeigt 

werden sollen und wo diese platziert werden sollen. 

Karteikarte Skalierung 

Auf dieser Karteikarte können Sie die Skalierung der Achse ändern. 

Erläuterung: Unter den Rubriken eines Diagramm versteht man jeweils den ers-

ten, zweiten, dritten etc. Datenpunkt aller Datenreihen. 

 Rubrik Achse endet... 

 Diese Option bestimmt, wo die beiden Enden des sichtbaren Abschnitts der 

Achse liegen sollen: Bei den Rubriken oder Zwischen den Rubriken. 

 Rubrik Anzahl der Rubriken zwischen... 

 Standardmäßig macht PlanMaker bei jeder Rubrik einen Teilstrich auf der Ach-

se und versieht diesen mit einer Beschriftung. Über folgende Optionen können 

Sie diese Intervalle ändern: 

 Teilstrichen: Bestimmt, welche Rubriken mit einem Teilstrich versehen wer-

den. Geben Sie 1 ein, wird jede Rubrik mit einem Teilstrich versehen, bei 2 je-

de zweite etc.  
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 Teilstrichbeschriftungen: Bestimmt, welche Teilstriche beschriftet werden 

sollen. Geben Sie 1 ein, wird jeder Teilstrich beschriftet, bei 2 jeder zweite 

Teilstrich etc. 

 Rubrik Schnittpunkt zwischen X- und Y-Achse 

 Mit dieser Option können Sie bestimmen, wo der Schnittpunkt zwischen X-

Achse (Rubrikenachse) und Y-Achse (Größenachse) liegen soll: Am unteren 

Ende (also am Beginn der Rubrikenachse), Am oberen Ende (also am Ende 

der Rubrikenachse) oder bei einer bestimmten Rubrik. 

 Achse in umgekehrter Richtung 

 Wird diese Option aktiviert, läuft die Achse in umgekehrter Richtung. Dement-

sprechend wird auch die Reihenfolge der Rubriken umgekehrt; das Diagramm 

beginnt also mit der letzen Rubrik und endet mit der ersten Rubrik. 

Karteikarte Schrift 

Auf dieser Karteikarte können Sie die Formatierung der Beschriftungen der Achse 

ändern. 

Neben Schriftart, Schriftgröße und Textauszeichnungen können Sie auch die Aus-

richtung einstellen, die Beschriftungen drehen lassen und das Zahlenformat ändern. 

Größenachse (Y-Achse) 

Die Y-Achse eines Diagramms wird auch als Größenachse bezeichnet. 

Achsen ein-/ausblenden: Um Achsen ein- oder auszublenden, selektieren Sie das Di-

agramm, rufen den Menübefehl Objekt > Eigenschaften auf und wechseln auf die 

Karteikarte Elemente. Klicken Sie nun auf das Kontrollkästchen vor Y-Achse, um 

beispielsweise die Anzeige der Größenachse ein- oder auszuschalten. 

Eigenschaften bearbeiten: Um die Eigenschaften der Größenachse zu ändern, selek-

tieren Sie diese, öffnen mit einem Rechtsklick das Kontextmenü und rufen darin 

den Befehl Größenachse: Eigenschaften auf.  

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Dia-

grammleiste oder per Doppelklick auf die Achse aufrufen. 

Es lassen sich folgende Einstellungen vornehmen: 
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Karteikarte Format 

 Rubrik Linie 

 Hier können Sie das Aussehen der Linie ändern, mit der die Achse gezeichnet 

wird. 

 Rubriken Hauptstriche und Hilfsstriche 

 Hier können Sie bestimmen, ob zur Einteilung der Achse kleine Teilstriche an-

gezeigt werden sollen und wie diese aussehen sollen. 

 Rubrik Strichbeschriftungen 

 Hier können Sie bestimmen, ob Achsenbeschriftungen angezeigt werden sollen 

und wo diese platziert werden sollen. 

Karteikarte Skalierung 

Auf dieser Karteikarte können Sie die Skalierung der Achse ändern. 

 Rubriken Minimalwert und Maximalwert 

 Diese Optionen bestimmen, wo der sichtbare Ausschnitt der Achse beginnen 

und wo er enden soll. Wählen Sie entweder die Option Auto, worauf PlanMa-

ker die geeignetsten Werte automatisch ermittelt oder wählen Sie Benutzerde-

finiert und geben den gewünschten Wert selbst ein. 

 Rubrik Schnittpunkt zwischen X- und Y-Achse 

 Mit dieser Option können Sie bestimmen, wo der Schnittpunkt zwischen X-

Achse (Rubrikenachse) und Y-Achse (Größenachse) liegen soll:  

 Bei Auto ermittelt PlanMaker den geeignetsten Wert automatisch, bei Maxi-

maler Wert wird die X-Achse am Ende der Y-Achse platziert, bei Benutzerde-

finiert bei dem von Ihnen angegebenen Y-Wert. 

 Rubrik Hauptintervall 

 Hier können Sie das Intervall für die Teilstriche und Beschriftungen auf der 

Achse festlegen. Bei der Option Auto ermittelt PlanMaker die geeignetsten 

Werte automatisch. 

 Rubrik Hilfsintervall 

 Hier können Sie das Intervall für die Hilfsstriche auf der Achse festlegen. Bei 

der Option Auto ermittelt PlanMaker die geeignetsten Werte automatisch. 
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 Achse in umgekehrter Richtung 

 Wenn Sie diese Option aktivieren, läuft die Achse in umgekehrter Richtung. 

Bei einem Säulendiagramm werden die Säulen also beispielsweise nicht mehr 

von unten nach oben, sondern von oben nach unten gezeichnet. 

 Logarithmische Skalierung 

 Wenn Sie diese Option aktivieren, wird die Achse nicht mehr linear, sondern 

logarithmisch (also in Zehnerpotenzen, z.B. 10, 100, 1000 etc.) eingeteilt. 

Karteikarte Schrift 

Auf dieser Karteikarte können Sie die Formatierung der Beschriftungen der Achse 

ändern. 

Neben Schriftart, Schriftgröße und Textauszeichnungen können Sie auch die Aus-

richtung einstellen, die Beschriftungen drehen lassen und das Zahlenformat ändern. 

Reihenachse (Z-Achse) 

Die Z-Achse eines Diagramms wird auch als Reihenachse bezeichnet. Sie ist nur 

bei bestimmten dreidimensionalen Diagrammtypen vorhanden. 

Achsen ein-/ausblenden: Um Achsen ein- oder auszublenden, selektieren Sie das Di-

agramm, rufen den Menübefehl Objekt > Eigenschaften auf und wechseln auf die 

Karteikarte Elemente. Klicken Sie nun auf das Kontrollkästchen vor Z-Achse, um 

beispielsweise die Anzeige der Reihenachse ein- oder auszuschalten. 

Eigenschaften bearbeiten: Um die Eigenschaften der Reihenachse zu ändern, selek-

tieren Sie diese, öffnen mit einem Rechtsklick das Kontextmenü und rufen darin 

den Befehl Reihenachse: Eigenschaften auf.  

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Dia-

grammleiste oder per Doppelklick auf die Achse aufrufen. 

Es lassen sich folgende Einstellungen vornehmen: 
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Karteikarte Format 

 Rubrik Linie 

 Hier können Sie das Aussehen der Linie ändern, mit der die Achse gezeichnet 

wird. 

 Rubriken Hauptstriche und Hilfsstriche 

 Hier können Sie bestimmen, ob zur Einteilung der Achse kleine Teilstriche an-

gezeigt werden sollen und wie diese aussehen sollen. 

 Rubrik Strichbeschriftungen 

 Hier können Sie bestimmen, ob bei den Teilstrichen Beschriftungen angezeigt 

werden sollen und wo diese platziert werden sollen. 

Karteikarte Skalierung 

Auf dieser Karteikarte können Sie die Skalierung der Achse ändern. 

 Rubrik Anzahl der Reihen zwischen... 

 Standardmäßig macht PlanMaker bei jeder Datenreihe einen Teilstrich auf der 

Achse und versieht diesen mit einer Beschriftung. Über folgende Optionen 

können Sie diese Intervalle ändern: 

 Teilstrichen: Bestimmt, welche Datenreihen mit einem Teilstrich versehen 

werden. Geben Sie 1 ein, wird jede Reihe mit einem Teilstrich versehen, bei 2 

jede zweite etc.  

 Teilstrichbeschriftungen: Bestimmt, welche Teilstriche beschriftet werden 

sollen. Geben Sie 1 ein, wird jeder Teilstrich beschriftet, bei 2 jeder zweite 

Teilstrich etc. 

 Achse in umgekehrter Richtung 

 Wird diese Option aktiviert, läuft die Achse in umgekehrter Richtung. Dement-

sprechend wird auch die Reihenfolge der Datenreihen umgekehrt; das Dia-

gramm beginnt also mit der letzen Reihe und endet mit der ersten Reihe. 

Karteikarte Schrift 

Auf dieser Karteikarte können Sie die Formatierung der Beschriftungen der Achse 

ändern. 
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Neben Schriftart, Schriftgröße und Textauszeichnungen können Sie auch die Aus-

richtung einstellen, die Beschriftungen drehen lassen und das Zahlenformat ändern. 

Gitternetzlinien 

Sie können zum besseren Ablesen der Werte in einem Diagramm Gitternetzlinien 

einblenden lassen. Unter Gitternetzlinien versteht man ein Netz aus Linien, die – 

ausgehend von einer der Achsen des Diagramms – über die Zeichnungsfläche lau-

fen. 

Es gibt folgende Arten von Gitternetzen: 

 Das Hauptgitternetz besteht aus Linien, die jeweils von den Teilstrichen auf der 

Achse ausgehen. 

 Das Hilfsgitternetz unterteilt das Hauptgitternetz bei Bedarf in ein noch feineres 

Gitternetz. 

Gitternetzlinien ein-/ausblenden: Sie können Gitternetzlinien für jede Achse getrennt 

einschalten. Selektieren Sie dazu das Diagramm, rufen Sie den Menübefehl Objekt 

> Eigenschaften auf, wechseln Sie auf die Karteikarte Elemente und schalten Sie 

bei den gewünschten Achsen die Option Hauptgitternetz und/oder Hilfsgitternetz 

ein. 

Tipp: Alternativ können Sie auch die beiden Symbole  in der Diagramm-

leiste oder die Menübefehle Objekt > Diagramm > Vertikale Gitternetzlinien 

anzeigen beziehungsweise Horizontale Gitternetzlinien anzeigen verwenden, 

um Gitternetzlinien ein-/auszuschalten. 

Eigenschaften bearbeiten: Um beispielsweise die Eigenschaften der Hauptgitternetz-

linien der Größenachse zu ändern, selektieren Sie eine dieser Linien, öffnen mit 

einem Rechtsklick das Kontextmenü und rufen darin den Befehl Hauptgitternetz 

des Größenachse: Eigenschaften auf.  

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Dia-

grammleiste aufrufen. 

Es lassen sich folgende Einstellungen vornehmen: 
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Karteikarte Format 

 Rubrik Linie 

 Hier können Sie das Aussehen der Gitternetzlinien anpassen. 

Skalierung der Gitternetzlinien ändern 

Um die Abstände zwischen den Gitternetzlinien zu ändern, selektieren Sie die zu-

gehörige Achse, rufen deren Eigenschaften auf und nehmen die gewünschten Än-

derungen auf der Karteikarte Skalierung vor. 

Legende 

Auf Wunsch können Sie im Diagramm eine Legende einblenden. Dies ist ein klei-

ner Kasten, in dem angezeigt wird, welche Datenreihen in welcher Farbe/Muste-

rung dargestellt werden. 

Legende ein-/ausblenden: Selektieren Sie das Diagramm, rufen Sie den Menübefehl 

Objekt > Eigenschaften auf und wechseln Sie auf die Karteikarte Elemente. Nun 

können Sie über die Option Legende bestimmen, wo die Legende positioniert wer-

den soll. Wenn Sie die Option Benutzerdefiniert wählen, lässt sich die Legende 

frei mit der Maus verschieben. Wählen Sie die Option Keine, wird keine Legende 

mehr angezeigt. 

Tipp: Alternativ können Sie die Legende auch über das Symbol  in der Dia-

grammleiste oder über den Menübefehl Objekt > Diagramm > Legende anzei-

gen ein-/ausschalten. 

Eigenschaften bearbeiten: Um die Eigenschaften der Legende zu ändern, selektieren 

Sie diese, öffnen mit einem Rechtsklick das Kontextmenü und rufen darin den Be-

fehl Diagrammfläche: Eigenschaften auf.  

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Dia-

grammleiste oder per Doppelklick auf die Legende aufrufen. 

Es lassen sich folgende Einstellungen vornehmen: 
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Karteikarte Format 

 Rubrik Umrandung 

 Hier lässt sich die Linienart für die Umrandung der Legende ändern. 

 Wenn Sie die Option Schatten aktivieren, wird die Legende zusätzlich mit ei-

nem Schatten hinterlegt.  

 Rubrik Füllung 

 Hier können Sie die Füllung der Legende ändern. Wählen Sie dazu die ge-

wünschte Art von Füllung.  

 Wenn Sie die Füllart Effekte wählen und auf die Schaltfläche Anpassen kli-

cken, erscheint ein Dialog, über den Sie auch komplexere Füllungen (z.B. einen 

Farbverlauf) anbringen können. Die Bedienung dieses Dialogs ist im Abschnitt 

„Objekt-Eigenschaften, Karteikarte Füllung“ ab Seite 258 beschrieben. 

Karteikarte Schrift 

Auf dieser Karteikarte können Sie das Zeichenformat für die Legende wählen 

(Schriftart, Schriftgröße und Textauszeichnungen). 

Karteikarte Legende 

Hier können Sie bestimmen, an welcher Position die Legende angezeigt werden 

soll. 

Wenn Sie die Option Benutzerdefiniert wählen, lässt sich die Legende nach Be-

lieben mit der Maus verschieben.  

Wenn Sie Keine wählen, wird die Legende ausgeblendet. 

Diagrammeigenschaften ändern 

In den vorherigen Abschnitten wurde beschrieben, wie sie die Eigenschaften ein-

zelner Elemente eines Diagramms bearbeiten. In diesem Abschnitt geht es um die 

Eigenschaften des Diagrammrahmens selbst.  

Um die Eigenschaften eines Diagramms zu ändern, selektieren Sie das Diagramm 

per Mausklick und rufen den Menübefehl Objekt > Eigenschaften auf. 
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Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Dia-

grammleiste aufrufen. 

Welche Einstellungen sich hier vornehmen lassen, erfahren Sie auf den nächsten 

Seiten. 

Diagrammeigenschaften, Karteikarte Format 

Auf der Karteikarte Format können Sie die Größe und Position des Diagramms 

ändern. 

Siehe dazu Abschnitt „Objekt-Eigenschaften, Karteikarte Format“ (ab Seite 256). 

Diagrammeigenschaften, Karteikarte Eigenschaften 

Auf der Karteikarte Eigenschaften können Sie allgemeine Einstellungen für das 

Diagramm ändern.  

Siehe dazu Abschnitt „Objekt-Eigenschaften, Karteikarte Eigenschaften“ (ab Seite 

264). 

Diagrammeigenschaften, Karteikarte Diagrammtyp 

Auf der Karteikarte Diagrammtyp können Sie den Diagrammtyp ändern: 

Wählen Sie zunächst links den gewünschten Diagrammtyp und dann rechts den 

gewünschten Untertyp. 

Informationen zu den verfügbaren Diagrammtypen finden Sie im Abschnitt 

„Diagrammtyp ändern“ ab Seite 298. 

Diagrammeigenschaften, Karteikarte Datenquelle 

Auf der Karteikarte Datenquelle können Sie Einstellungen zu dem Datenbereich 

vornehmen, auf dem das Diagramm basiert: 

 Datenbereich 

 Hier können Sie festlegen, welchen Zellbereich der Tabelle das Diagramm dar-

stellen soll. Standardmäßig wird der Zellbereich verwendet, den Sie beim Er-
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stellen des Diagramms markiert hatten. Normalerweise müssen Sie hier also 

nichts ändern. 

 Rubrik Anordnung der Daten 

 Hier können Sie festlegen, ob der gewählte Datenbereich im Diagramm spal-

tenweise oder zeilenweise dargestellt werden soll. Siehe auch Abschnitt 

„Anordnung der Datenreihen ändern“ ab Seite 303. 

 Rubrik Datenbereich enthält 

 Hier können Sie angeben, welche Arten von Daten der Datenbereich enthält. 

 Tipp: Besteht die oberste Zeile des Datenbereichs aus Überschriften (für die 

jeweils darunter liegenden Werte), so sollte die Option Namen eingeschaltet 

werden. PlanMaker beschriftet die Datenreihen im Diagramm dann automatisch 

mit diesen Überschriften. 

 Auch verborgene Zellen verwenden 

 Wenn der Datenbereich Zellen enthält, die verborgen wurden, werden diese 

normalerweise nicht im Diagramm dargestellt. Schalten Sie diese Option ein, 

wenn Sie möchten, dass auch verborgene Zellen dargestellt werden sollen. 

Diagrammeigenschaften, Karteikarte Datenreihen 

Die Datenreihen sind die wichtigsten Bestandteile eines Diagramms. Sie stellen die 

auszuwertenden Daten dar – je nach gewähltem Diagrammtyp in Form von Säulen, 

Balken, Linien etc. 

Auf der Karteikarte Datenreihen können Sie Einstellungen zu den einzelnen Da-

tenreihen eines Diagramms vornehmen.  

Wählen Sie zunächst in der Liste Datenreihen die Datenreihe aus, deren Einstel-

lungen Sie verändern möchten. Nehmen Sie dann die gewünschten Einstellungen 

vor: 

 Datenreihen 

 In der Liste Datenreihen sind alle Datenreihen aufgelistet, die das Diagramm 

momentan enthält.  

 Mit Hilfe der Pfeil-Schaltflächen rechts der Liste können Sie die Reihenfol-

ge der Datenreihen bei Bedarf ändern.  

 Mit den Schaltflächen Hinzufügen und Löschen können Sie Datenreihen 

hinzufügen beziehungsweise entfernen. 
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 Rubrik Datenquellen 

 Hier lässt sich festlegen, welche Daten die gewählte Datenreihe darstellen soll.  

 Die Felder in dieser Rubrik werden automatisch ausgefüllt (anhand des Zellbe-

reichs, den Sie vor dem Einfügen des Diagramms markiert hatten). Normaler-

weise müssen Sie sich um diese Einstellungen also überhaupt nicht kümmern. 

 Folgende Felder gibt es hier: 

 Name: Hier lässt sich der Name der Datenreihe festlegen. Dies kann ein Zell-

bezug auf eine Zelle sein, die den Namen enthält, oder einfach ein fest einge-

tragener Text. Dieses Feld kann auch leer gelassen werden, worauf die Daten-

reihe einen automatisch erzeugten Namen erhält (z.B. „Reihe 1“, „Reihe 2“ 

etc.). 

 Y-Werte: Hier lässt sich bestimmen, aus welchem Zellbereich die Datenreihe 

die Y-Werte für die Datenpunkte beziehen soll. 

 Erläuterung: Bei den meisten Diagrammtypen sind die Y-Werte die Werte, 

die in dem Diagramm dargestellt werden sollen. Sie bestimmen also bei-

spielsweise die Höhe der Säule, die gezeichnet wird.  

 X-Werte: Analog zur Option Y-Werte lässt sich hier bestimmen, aus welchem 

Zellbereich die X-Werte für die Datenreihe stammen sollen. 

 Erläuterung: Bei den meisten Diagrammtypen sind die X-Werte irrelevant 

und auf „Auto“ (also automatisch) gesetzt, da sie lediglich zur Beschriftung 

der Rubrikenachse (X-Achse) dienen. Eine Ausnahme hiervon bilden z.B. 

XY-Punktdiagramme und Blasendiagramme: hier bestimmen die X- und Y-

Werte die Koordinaten der Datenpunkte. 

 Blasengrößen: Bei Blasendiagrammen gibt es neben X- und Y-Werten noch 

einen dritten Parameter: die Größe der Blasen für die einzelnen Datenpunkte. 

Geben Sie dazu einen Zellbezug auf die Zellen ein, die diese Werte enthalten. 

Wird dieses Feld leer gelassen, werden alle Blasen in der gleichen Größe ge-

zeichnet. 

 Rubrik Diese Datenreihe darstellen als 

 Hier können Sie festlegen, wie die Datenreihe dargestellt werden soll. Haben 

Sie als Diagrammtyp beispielsweise ein Säulendiagramm gewählt, möchten 

aber, dass eine bestimmte Datenreihe darin als Liniendiagramm dargestellt 

wird, so wählen Sie für diese Datenreihe die Option Linien. 
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 Sekundäre Achse für diese Datenreihe 

 Aktivieren Sie diese Option, wird dem Diagramm für diese Datenreihe eine 

sekundäre Größenachse (Y-Achse) hinzugefügt. Die sekundäre Größenachse 

kann einen anderen Maßstab als die primäre Größenachse haben. 

 Erläuterung: Das Darstellen von bestimmten Datenreihen auf einer sekundä-

ren Achse ist sinnvoll, wenn diese Datenreihen eine Achse mit einem völlig 

anderen Maßstab benötigen, da sie beispielsweise erheblich größere Werte 

enthalten als die anderen Datenreihen. 

Diagrammeigenschaften, Karteikarte Elemente 

Auf der Karteikarte Elemente können Sie die verschiedenen Diagrammelemente 

ein-/ausblenden und beschriften: 

 Diagrammtitel 

 Hier können Sie dem Diagramm einen Titel geben. Dieser wird dann oberhalb 

des Diagramms angezeigt. 

 Rubrik Primäre Achsen 

 Hier können Sie Einstellungen zu den primären Achsen vornehmen: 

 Mit dem Kontrollkästchen vor der jeweiligen Achse können Sie die Anzeige 

dieser Achse ein-/ausschalten. 

 Rechts daneben können Sie der Achse einen Namen geben. Dieser wird unter-

halb/neben der Achse angezeigt. 

 Die Optionen Hauptgitternetz und Hilfsgitternetz bestimmen, ob Gitternetz-

linien im Hintergrund des Diagramms angezeigt werden sollen. Diese erleich-

tern das Ablesen der Werte. Weitere Informationen dazu finden Sie im Ab-

schnitt „Gitternetzlinien“ ab Seite 322. 

 Rubrik Sekundäre Achsen 

 Sofern das Diagramm über sekundäre Achsen verfügt, können Sie diese hier, 

analog zu den primären Achsen (siehe oben), konfigurieren. 

 Legende 

 Hier können Sie die Position der Legende bestimmen. Dies ist ein kleiner Kas-

ten, in dem angezeigt wird, welche Datenreihe in welcher Farbe/Musterung 

dargestellt wird. Weitere Informationen dazu finden Sie im Abschnitt 

„Legende“ ab Seite 323. 
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Diagrammeigenschaften, Karteikarte 3D-Ansicht 

Hinweis: Diese Karteikarte erscheint nur bei dreidimensionalen Diagrammtypen. 

Auf der Karteikarte 3D-Ansicht können Sie (bei dreidimensionalen Diagrammty-

pen) den 3D-Effekt für das Diagramm verändern. 

 Drehwinkel und Betrachtungswinkel 

 Hier können Sie den Blickwinkel (in Grad) einstellen, von dem aus der Be-

trachter das Diagramm sieht. Drehwinkel dreht den Betrachter um die vertikale 

Achse, Betrachtungswinkel um die horizontale Achse. 

 Perspektive 

 Ist diese Option aktiviert, wird das Diagramm perspektivisch verzerrt. Daneben 

können Sie die Stärke der Verzerrung angeben (von 0 bis 100%). 

 Höhe und Tiefe 

 Hier können Sie die Höhe und Tiefe des Diagramms (in Prozent der Original-

maße) ändern. 

Diagrammeigenschaften, Karteikarte Netz 

Hinweis: Diese Karteikarte erscheint nur bei Netzdiagrammen. 

Auf der Karteikarte Netz können Sie (bei Netzdiagrammen) zusätzliche Einstel-

lungen zur Darstellung des Diagramms vornehmen. 

 Startwinkel 

 Rotiert das Diagramm um den angegebenen Winkel. 

 Orientierung 

 Bestimmt, ob die Werte im Uhrzeigersinn oder gegen den Uhrzeigersinn einge-

zeichnet werden sollen. 

 Netz abrunden 

 Zeichnet das Diagramm nicht mit Linien sondern mit Kreissegmenten zwischen 

den Achsen. 
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 Polarkoordinaten 

 Verwendet Polarkoordinaten statt kartesischer Koordinaten. Nur verfügbar, 

wenn Netz abrunden (siehe oben) aktiviert ist. 

 Setzen Sie dabei den Winkel zwischen Achsen auf x, wird alle x Grad eine 

Achse eingezeichnet. 

 Setzen Sie den Winkel zwischen Achsenbeschriftungen auf x, wird alle x 

Grad eine Achsenbeschriftung eingezeichnet. 

 Zeichnungsfläche auf Netzform begrenzen 

 Ist diese Option aktiviert, wird nur die Fläche innerhalb des Netzes mit der 

Füllung der Zeichnungsfläche gefüllt. Ist sie deaktiviert, wird das gesamte 

Rechteck um das Netz herum gefüllt. 

Diagramme aktualisieren 

Ein Diagramm holt sich die darzustellenden Werte stets aus den Zellen, die beim 

Erstellen des Diagramms markiert waren. Ändern sich also Werte in diesen Zellen, 

wird das Diagramm automatisch aktualisiert und gibt sofort die veränderten Werte 

wieder. 

Automatische Aktualisierung von Diagrammen deaktivieren 

Bei Bedarf können Sie diese automatische Aktualisierung deaktivieren. Rufen Sie 

dazu den Menübefehl Datei > Eigenschaften auf, wechseln Sie auf die Karteikarte 

Berechnen und deaktivieren Sie die Option Automatisch aktualisieren in der 

Rubrik Diagramme. 

Ist diese Option abgeschaltet, werden die Diagramme im aktuellen Dokument nur 

dann aktualisiert, wenn Sie den Menübefehl Weiteres > Diagramme aktualisie-

ren aufrufen. 
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Diagramme auf ein anderes Arbeitsblatt 

verschieben 

Wenn Sie ein neues Diagramm anlegen, wird dieses stets als Objekt in das aktuelle 

Arbeitsblatt eingefügt. Sie können die Position eines Diagramms aber jederzeit 

ändern: 

Um ein Diagramm innerhalb des aktuellen Arbeitsblatts zu verschieben, klicken 

Sie es einfach an und ziehen es mit der Maus an die gewünschte Position. 

Wenn Sie das Diagramm hingegen auf ein anderes Arbeitsblatt verschieben möch-

ten, gehen Sie wie folgt vor: 

1. Selektieren Sie das gewünschte Diagramm per Mausklick. 

2. Rufen Sie den Menübefehl Objekt > Diagramm > Position des Diagramms 

ändernauf. 

3. Treffen Sie die gewünschte Wahl (siehe unten) und bestätigen Sie mit OK. 

Das Diagramm wird daraufhin entsprechend verschoben. 

Verfügbare Optionen: 

 Als neues Blatt 

 Wählen Sie diese Option, erhält das Diagramm sein eigenes Diagramm-

Arbeitsblatt. Dazu entfernt PlanMaker das Diagramm aus dem aktuellen Blatt, 

legt ein neues Diagramm-Arbeitsblatt an und fügt das Diagramm darin ein. 

 Ein „Diagramm-Arbeitsblatt“ ist eine besondere Art von Arbeitsblatt, das kei-

nerlei Tabellenzellen, sondern ausschließlich das Diagramm in seiner vollen 

Größe enthält. Es stehen darin auch nur Befehle zum Bearbeiten von Diagram-

men zur Verfügung. 

 Als Objekt in ... 

 Wählen Sie hingegen diese Option, erscheint das Diagramm wie üblich als ein 

Objekt im gewählten Arbeitsblatt. 
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Diagramme als Grafik speichern 

Sie können jederzeit ein Abbild eines Diagramms als Grafikdatei speichern. Dies 

erleichtert die Weitergabe an andere und das Einfügen in Webseiten oder andere 

Dokumente. 

Gehen Sie dazu wie folgt vor: 

1. Selektieren Sie das gewünschte Diagramm per Mausklick. 

2. Rufen Sie den Menübefehl Objekt > Diagramm > Als Grafik speichernauf. 

3. Wählen Sie in der Liste Dateityp das gewünschte Grafikformat. 

 Tipp: Das PNG-Format ist hier immer eine gute Wahl, da es eine gute und dabei völlig verlustfreie 

Komprimierung bietet. 

4. Geben Sie den Dateinamen an, unter dem die Grafik gespeichert werden soll, 

und bestätigen Sie mit OK. 

5. Es erscheint ein weiterer Dialog. Wählen Sie darin die gewünschte Auflösung 

für die Grafik oder tragen Sie eigene Werte für die Breite und Höhe von Hand 

ein. Bestätigen Sie dann mit OK. 

PlanMaker legt nun eine entsprechende Grafikdatei mit einem Abbild des Dia-

gramms an.  
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Formulare 

FreeOffice: Das Einfügen von Formularobjekten wird von SoftMaker Free-

Office nicht unterstützt. Sie können also keine neuen Formulare damit anlegen 

(bestehende Formulare können aber weiterhin verwendet werden). 

Sie können in Ihre Tabellen Formularobjekte einfügen und auf diese Weise Formu-

lare herstellen. 

 

Es gibt folgende Arten von Formularobjekten: 

 Kontrollkästchen zum Ankreuzen 

 Optionsfelder zur Auswahl einer von mehreren Alternativen 
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 Auswahllisten zur Auswahl aus einer aufklappbaren Liste 

 Listen zur Auswahl aus einer Liste 

 Schaltflächen zum Anklicken 

 Drehfelder zum Erhöhen/Reduzieren von Werten per Mausklick 

 Bildlaufleisten zum Erhöhen/Reduzieren von Werten per Mausklick 

 Bezeichnungen für Beschriftungen 

 Gruppenfelder zum optischen Zusammenfassen zusammengehörender Optio-

nen 

Formularobjekte haben stets eine Ausgabezelle. In dieser Tabellenzelle wird der 

Wert abgelegt, den das Formularobjekt zurückliefert. Welche Zelle dies ist, können 

Sie für jedes Formularobjekt getrennt festlegen. 

Fügen Sie beispielsweise eine Liste mit einigen Einträgen ein, erscheint in der 

Ausgabezelle eine 1, wenn der erste Eintrag angeklickt wurde, eine 2, wenn der 

zweite Eintrag gewählt wurde etc. 

Ausführliche Informationen zum Arbeiten mit Formularen finden Sie in diesem 

Kapitel. Es besteht aus folgenden Abschnitten: 

 Formularobjekte verwenden 

 Der erste Abschnitt enthält allgemeine Informationen zum Arbeiten mit Formu-

larobjekten. Sie erfahren darin, wie man Formularobjekte einfügt, bearbeitet 

und auswertet. 

 Formularobjekte im Detail 

 Der zweite Abschnitt befasst sich mit den einzelnen Arten von Formularobjek-

ten im Detail. 

Formularobjekte verwenden 

In den nächsten Abschnitten finden Sie zunächst allgemeine Informationen zum 

Arbeiten mit Formularobjekten: 

 Formularobjekte einfügen 

 Formularobjekte bearbeiten 
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 Formularobjekte bedienen und auswerten 

 Formularobjekte und Excel-Makros und -Scripts 

Danach, im Abschnitt „Formularobjekte im Detail“, stellen wir Ihnen die einzelnen 

Arten von Formularobjekten ausführlich vor. 

Formularobjekte einfügen 

FreeOffice: Das Einfügen von Formularobjekten wird von SoftMaker Free-

Office nicht unterstützt. Sie können also keine neuen Formulare damit anlegen 

(bestehende Formulare können aber weiterhin verwendet werden). 

Das Einfügen von Formularobjekten unterscheidet sich nicht wesentlich vom Ein-

fügen anderer Arten von Objekten (siehe dazu auch Kapitel „Objekte“ ab Seite 

249). 

Um ein Formularobjekt einzufügen, gehen Sie wie folgt vor: 

1. Rufen Sie den Menübefehl Objekt > Neues Formularobjekt auf.  

2. Es öffnet sich ein Untermenü. Wählen Sie darin die gewünschte Art von Ob-

jekt. 

Das Objekt wird nun eingefügt. 

Weitere Informationen zu den einzelnen Arten von Formularobjekten finden Sie im 

Abschnitt „Formularobjekte im Detail“ ab Seite 337. 

Verwenden der Formularleiste 

Sie können zum Einfügen von Formularobjekten auch die Formularleiste verwen-

den. Um diese ein-/auszuschalten, rufen Sie den Menübefehl Ansicht > Symbol-

leisten auf und klicken auf das Kästchen vor Formular. 

 

Die Formularleiste enthält folgende Symbole (von links nach rechts): 

 Textrahmen einfügen 

 Kontrollkästchen einfügen 

 Optionsfeld einfügen 

 Auswahlliste einfügen 

 Liste einfügen 
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 Schaltfläche einfügen 

 Drehfeld einfügen 

 Bildlaufleiste einfügen 

 Bezeichnung einfügen 

 Gruppenfeld einfügen 

 Zelle schützen ein/aus (siehe auch Abschnitt „Blattschutz“ ab Seite 401) 

 Blattschutz ein/aus (siehe auch Abschnitt „Blattschutz“ ab Seite 401) 

Tipp: Wenn Sie mit der Maus auf eines der Symbole zeigen (ohne zu klicken), 

erscheint ein Infotext, der die Funktion des Symbols angibt. 

Formularobjekte bearbeiten 

Das Bearbeiten von Formularobjekten unterscheidet sich nicht wesentlich vom 

Arbeiten mit anderen Arten von Objekten (siehe dazu Kapitel „Objekte“ ab Seite 

249). 

Einen wichtigen Unterschied gibt es allerdings: 

Wichtig: Formularobjekte können nicht per Linksklick mit der Maus selektiert 

werden. Um ein Formularobjekt zu selektieren, klicken Sie mit der rechten 

Maustaste darauf.  

Alternativ können Sie auch mit dem Menübefehl Ansicht > Objektmodus in 

den Objektmodus wechseln, in dem sich auch Formularobjekte per Linksklick 

selektieren lassen. 

Wenn Sie ein Formularobjekt selektiert haben, können Sie es wie jede andere Art 

von Objekt bearbeiten – also beispielsweise mit der Maus verschieben, seine Größe 

ändern, mit dem Menübefehl Objekt > Eigenschaften seine Eigenschaften modi-

fizieren etc. 

Informationen zu den Eigenschaften von Formularobjekten finden Sie im Abschnitt 

„Formularobjekte im Detail“ ab Seite 337. 

Formularobjekte bedienen und auswerten 

Die Bedienung von Formularobjekten entspricht der von Bedienungselementen in 

Dialogfenstern. In Kontrollkästchen lässt sich beispielsweise per Mausklick ein 

Häkchen setzen/entfernen. In Listen kann per Mausklick einer der Einträge ausge-

wählt werden etc. 
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Auswerten von Formularobjekten 

Das Auswerten von Formularobjekten geschieht über die Ausgabezelle des Ob-

jekts. In dieser Tabellenzelle wird der Wert ausgegeben, den das Formularobjekt 

zurückliefert.  

Welche Zelle dies ist, können Sie für jedes Formularobjekt getrennt festlegen: Se-

lektieren Sie das Objekt dazu und rufen Sie den Menübefehl Objekt > Eigen-

schaften auf. Wechseln Sie in dem Dialog auf die Karteikarte Formularelement 

und tragen Sie bei Ausgabezelle die gewünschte Zelladresse ein. 

Ein Beispiel: Sie haben einer Liste die Ausgabezelle D4 zugewiesen. Klicken Sie 

nun in der Liste den ersten Eintrag an, trägt PlanMaker in der Zelle D4 eine 1 ein, 

klicken Sie den fünften Listeneintrag an, erscheint darin eine 5 etc. 

Die Beziehung zwischen einem Formularobjekt und seiner Ausgabezelle ist übri-

gens beidseitig: Tragen Sie also in die Ausgabezelle von Hand eine 3 ein, wird in 

der Liste automatisch der dritte Eintrag selektiert. 

Formularobjekte und Excel-Makros und -Scripts 

Microsoft Excel-Dateien können Makros und VBA-Scripts enthalten, die sich auf 

Formularobjekte anwenden lassen. Dies ist in PlanMaker nicht möglich, aber: 

Wichtig: Wenn Sie in PlanMaker eine Excel-Datei öffnen, die Makros oder 

Scripts enthält, können diese zwar nicht ausgeführt werden, sie bleiben aber er-

halten. Wenn Sie eine solche Excel-Datei also mit PlanMaker öffnen und bear-

beiten, gehen die Makros und Scripts beim Speichern nicht verloren. 

Formularobjekte im Detail 

FreeOffice: Das Einfügen von Formularobjekten wird von SoftMaker Free-

Office nicht unterstützt. Sie können also keine neuen Formulare damit anlegen 

(bestehende Formulare können aber weiterhin verwendet werden). 

In diesem Abschnitt stellen wir Ihnen die einzelnen Arten von Formularobjekten 

im Detail vor.  

Folgende Objekte werden darin behandelt: 
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 Kontrollkästchen 

 Optionsfelder 

 Auswahllisten 

 Listen 

 Schaltflächen 

 Drehfelder 

 Bildlaufleisten 

 Bezeichnungen und Gruppenfelder 

Kontrollkästchen 

FreeOffice: Das Einfügen von Formularobjekten wird von SoftMaker Free-

Office nicht unterstützt.  

Mit dem Menübefehl Objekt > Neues Formularobjekt > Kontrollkästchen fü-

gen Sie ein Kontrollkästchen ein.  

Kontrollkästchen können in Formularen für Ja/Nein-Angaben verwendet werden. 

Wird das Kästchen angekreuzt, steht das für Ja; wird es nicht angekreuzt, bedeutet 

das Nein. 

Bedienung von Kontrollkästchen 

Klicken Sie das Kästchen an, um es mit einem Häkchen zu versehen – sprich: es 

anzukreuzen. Wenn Sie es erneut anklicken, wird das Häkchen wieder entfernt. 

Eigenschaften von Kontrollkästchen ändern 

Um die Eigenschaften eines Kontrollkästchens zu ändern, selektieren Sie es (zum 

Beispiel durch Anklicken mit der rechten Maustaste) und rufen dann den Menübe-

fehl Objekt > Eigenschaften auf. 

Es erscheint ein Dialogfenster mit folgenden Optionen: 

Karteikarte Format 

Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Format“ ab Seite 256. 
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Karteikarte Eigenschaften 

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Eigenschaften“ ab Seite 264. 

Karteikarte Formularelement 

Auf dieser Karteikarte können Sie Einstellungen zu dem Kontrollkästchen selbst 

vornehmen: 

 Text 

 Hier können Sie den Text angeben, der rechts neben dem Kästchen angezeigt 

werden soll. 

 Wert 

 Hier können Sie festlegen, ob das Kästchen angekreuzt sein soll oder nicht. 

Entspricht dem Ankreuzen des Kästchens direkt im Dokument. 

 Ausgabezelle 

 Hier bestimmen Sie, in welcher Tabellenzelle der Zustand des Kontrollkäst-

chens ausgegeben werden soll.  

 In dieser Zelle erscheint dann einer der folgenden Werte: 

 WAHR, wenn das Kontrollkästchen angekreuzt ist. 

 FALSCH, wenn das Kontrollkästchen nicht angekreuzt ist. 

 Der Fehlerwert #NV, wenn der Zustand des Kontrollkästchen unbestimmt 

ist. 

 Rubrik Aussehen 

 Hier können Sie das Zeichenformat (Schriftart, -größe, -farbe etc.) für den Text 

festlegen. 

 3D-Effekt 

 Schalten Sie diese Option ein, wird das Objekt mit einem 3D-Effekt gezeichnet. 
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Optionsfelder 

FreeOffice: Das Einfügen von Formularobjekten wird von SoftMaker Free-

Office nicht unterstützt.  

Mit dem Menübefehl Objekt > Neues Formularobjekt > Optionsfeld fügen Sie 

ein Optionsfeld ein.  

Optionsfelder können in Formularen zur Auswahl einer von mehreren Optionen 

verwendet werden. 

Verwendung von Gruppenfeldern zum Kombinieren von Optionsfeldern 

Wichtig: Optionsfelder müssen stets in Gruppen von mindestens zwei Options-

feldern verwendet werden. 

Damit PlanMaker hierbei weiß, welche Optionsfelder zu einer Gruppe gehören, 

umgeben Sie diese mit einem Gruppenfeld.  

 

Fügen Sie also erst die zusammengehörenden Optionsfelder in das Dokument ein 

(zum Beispiel untereinander) und ziehen Sie dann mit dem Menübefehl Einfügen 

> Neues Formularobjekt > Gruppenfeld ein Gruppenfeld um sie herum. 

Bedienung von Optionsfeldern 

Klicken Sie eines der zusammengehörenden Optionsfelder an, um es auszuwählen. 

Innerhalb einer Gruppe von Optionsfeldern kann immer nur ein Optionsfeld aus-

gewählt sein. 

Eigenschaften von Optionsfeldern ändern 

Um die Eigenschaften eines Optionsfelds zu ändern, selektieren Sie es (zum Bei-

spiel durch Anklicken mit der rechten Maustaste) und rufen dann den Menübefehl 

Objekt > Eigenschaften auf. 
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Es erscheint ein Dialogfenster mit folgenden Optionen: 

Karteikarte Format 

Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Format“ ab Seite 256. 

Karteikarte Eigenschaften 

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Eigenschaften“ ab Seite 264. 

Karteikarte Formularelement 

Auf dieser Karteikarte können Sie Einstellungen zu dem Optionsfeld selbst vor-

nehmen: 

 Text 

 Hier können Sie den Text angeben, der in dem Optionsfeld angezeigt werden 

soll. 

 Wert 

 Hier können Sie festlegen, ob das Optionsfeld ausgewählt sein soll oder nicht. 

Entspricht dem Auswählen des Optionsfelds direkt im Dokument. 

 Ausgabezelle 

 Hier bestimmen Sie, in welcher Tabellenzelle der Zustand des Optionsfelds 

ausgegeben werden soll.  

 Wie eingangs erwähnt, müssen Optionsfelder immer in Gruppen von mindes-

tens zwei Optionsfeldern verwendet werden. In der Ausgabezelle wird dann 

ausgegeben, welches der Optionsfelder in der Gruppe ausgewählt ist. Wenn das 

erste Feld gewählt ist, erscheint darin eine 1, wenn das zweite Feld gewählt ist, 

erscheint eine 2, etc. 

 Rubrik Aussehen 

 Hier können Sie das Zeichenformat (Schriftart, -größe, -farbe etc.) für den Text 

festlegen. 
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 3D-Effekt 

 Schalten Sie diese Option ein, wird das Objekt mit einem 3D-Effekt gezeichnet. 

Auswahllisten 

FreeOffice: Das Einfügen von Formularobjekten wird von SoftMaker Free-

Office nicht unterstützt.  

Mit dem Menübefehl Objekt > Neues Formularobjekt > Auswahlliste fügen Sie 

eine aufklappbare Auswahlliste ein. 

Auswahllisten kennen Sie aus vielen Dialogfenstern. Wenn man sie aufklappt, zei-

gen Sie eine Liste von Einträgen, von denen ein Eintrag ausgewählt werden kann. 

Dies ist natürlich ideal für Formulare, da es beim Ausfüllen Tipparbeit spart und 

Tippfehler unmöglich macht. 

Bedienung von Auswahllisten 

Klicken Sie das Pfeilchen rechts der Liste an, um die Liste zu öffnen. Nun können 

Sie einen Eintrag auswählen, indem sie ihn anklicken. 

Eigenschaften von Auswahllisten ändern 

Um die Eigenschaften einer Auswahlliste zu ändern, selektieren Sie diese (zum 

Beispiel durch Anklicken mit der rechten Maustaste) und rufen dann den Menübe-

fehl Objekt > Eigenschaften auf. 

Es erscheint ein Dialogfenster mit folgenden Optionen: 

Karteikarte Format 

Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Format“ ab Seite 256. 

Karteikarte Eigenschaften 

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Eigenschaften“ ab Seite 264. 
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Karteikarte Formularelement 

Auf dieser Karteikarte können Sie Einstellungen zu der Auswahlliste selbst vor-

nehmen: 

 Zeilen (max.) 

 Hier können Sie festlegen, wie viele Einträge die Liste höchstens anzeigen soll, 

wenn sie aufgeklappt wird. 

 Listenbereich 

 Hier bestimmen Sie, welcher Zellbereich der Tabelle die Listeneinträge enthält, 

die in der Auswahlliste erscheinen sollen. 

 Wenn Sie beispielsweise die Zellen F5 bis F7 mit den Werten „Hund“, „Katze“ 

und „Maus“ ausfüllen und als Listenbereich F5:F7 angeben, erscheinen in der 

Liste genau diese drei Werte. 

 Ausgabezelle 

 Hier bestimmen Sie, in welcher Tabellenzelle der Zustand der Auswahlliste 

ausgegeben werden soll.  

 In der Ausgabezelle wird ausgegeben, welcher der Listeneinträge ausgewählt 

wurde. Wenn der erste Eintrag gewählt ist, erscheint darin eine 1, wenn der 

zweite Eintrag gewählt ist, erscheint eine 2, etc. 

 Rubrik Aussehen 

 Hier können Sie das Zeichenformat (Schriftart, -größe, -farbe etc.) für den Text 

festlegen. 

 3D-Effekt 

 Schalten Sie diese Option ein, wird das Objekt mit einem 3D-Effekt gezeichnet. 

Listen 

FreeOffice: Das Einfügen von Formularobjekten wird von SoftMaker Free-

Office nicht unterstützt.  

Mit dem Menübefehl Objekt > Neues Formularobjekt > Liste fügen Sie eine 

Liste ein. 
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Solche Listen kennen Sie aus vielen Dialogfenstern. Sie bieten mehrere Einträge 

zur Wahl, von denen per Mausklick ein Eintrag ausgewählt werden kann. Dies ist 

natürlich ideal für Formulare, da es beim Ausfüllen Tipparbeit spart und Tippfehler 

unmöglich macht. 

Eigenschaften von Listen ändern 

Um die Eigenschaften einer Liste zu ändern, selektieren Sie diese (zum Beispiel 

durch Anklicken mit der rechten Maustaste) und rufen dann den Menübefehl Ob-

jekt > Eigenschaften auf. 

Es erscheint ein Dialogfenster mit folgenden Optionen: 

Karteikarte Format 

Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Format“ ab Seite 256. 

Karteikarte Eigenschaften 

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Eigenschaften“ ab Seite 264. 

Karteikarte Formularelement 

Auf dieser Karteikarte können Sie Einstellungen zu der Liste selbst vornehmen: 

 Markierungsart 

 Verwenden Sie hier stets die Option Einfach. 

 Die beiden anderen Einträge Mehrfach und Erweitert erlauben Mehrfachse-

lektionen in der Liste; es wird dann aber kein Resultat mehr in der Ausgabezel-

le ausgegeben. Sie sind nur aus Gründen der Excel-Kompatibilität vorhanden. 

 Listenbereich 

 Hier bestimmen Sie, welcher Zellbereich der Tabelle die Listeneinträge enthält, 

die in der Liste erscheinen sollen. 
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 Wenn Sie beispielsweise die Zellen F5 bis F7 mit den Werten „Hund“, „Katze“ 

und „Maus“ ausfüllen und als Listenbereich F5:F7 angeben, erscheinen in der 

Liste genau diese drei Werte. 

 Ausgabezelle 

 Hier bestimmen Sie, in welcher Tabellenzelle der Zustand der Liste ausgegeben 

werden soll.  

 In der Ausgabezelle wird ausgegeben, welcher der Listeneinträge ausgewählt 

wurde. Wenn der erste Eintrag gewählt ist, erscheint darin eine 1, wenn der 

zweite Eintrag gewählt ist, erscheint eine 2, etc. 

 Rubrik Aussehen 

 Hier können Sie das Zeichenformat (Schriftart, -größe, -farbe etc.) für den Text 

festlegen. 

 3D-Effekt 

 Schalten Sie diese Option ein, wird das Objekt mit einem 3D-Effekt gezeichnet. 

Schaltflächen 

FreeOffice: Das Einfügen von Formularobjekten wird von SoftMaker Free-

Office nicht unterstützt.  

Mit dem Menübefehl Objekt > Neues Formularobjekt > Schaltfläche fügen Sie 

eine Schaltfläche ein. 

Hinweis: Schaltflächen können in PlanMaker nicht zum Starten von Makros oder 

VBA-Scripts verwendet werden; sie sind lediglich aus Gründen der Excel-

Kompatibilität vorhanden. 

Eigenschaften von Schaltflächen ändern 

Um die Eigenschaften einer Schaltfläche zu ändern, selektieren Sie diese (zum 

Beispiel durch Anklicken mit der rechten Maustaste) und rufen dann den Menübe-

fehl Objekt > Eigenschaften auf. 

Es erscheint ein Dialogfenster mit folgenden Optionen: 
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Karteikarte Format 

Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Format“ ab Seite 256. 

Karteikarte Eigenschaften 

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Eigenschaften“ ab Seite 264. 

Karteikarte Formularelement 

Auf dieser Karteikarte können Sie Einstellungen zu der Schaltfläche selbst vor-

nehmen: 

 Text 

 Hier können Sie den Text angeben, der auf der Schaltfläche erscheinen soll. 

 Rubrik Aussehen 

 Hier können Sie das Zeichenformat (Schriftart, -größe, -farbe etc.) für den Text 

festlegen. 

Drehfelder 

FreeOffice: Das Einfügen von Formularobjekten wird von SoftMaker Free-

Office nicht unterstützt.  

Mit dem Menübefehl Objekt > Neues Formularobjekt > Drehfeld fügen Sie ein 

Drehfeld ein. 

Mit Drehfeldern lassen sich Werte per Mausklick schrittweise erhöhen oder redu-

zieren. Ein Klick auf das Pfeilchen nach oben erhöht den Wert in der Ausgabezelle; 

das Pfeilchen nach unten reduziert den Wert. 

Eigenschaften von Drehfeldern ändern 

Um die Eigenschaften eines Drehfelds zu ändern, selektieren Sie es (zum Beispiel 

durch Anklicken mit der rechten Maustaste) und rufen dann den Menübefehl Ob-

jekt > Eigenschaften auf. 
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Es erscheint ein Dialogfenster mit folgenden Optionen: 

Karteikarte Format 

Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Format“ ab Seite 256. 

Karteikarte Eigenschaften 

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Eigenschaften“ ab Seite 264. 

Karteikarte Formularelement 

Auf dieser Karteikarte können Sie Einstellungen zu dem Drehfeld selbst vorneh-

men: 

 Rubrik Parameter 

 Hier können Sie folgende Parameter festlegen: 

 Aktueller Wert: Der aktuelle Wert (entspricht dem Wert in der Ausgabezelle). 

 Mindestwert: Der Mindestwert, der nicht unterschritten werden darf. 

 Maximalwert: Der Höchstwert, der nicht überschritten werden darf. 

 Schrittweite: Der Wert, der hinzugezählt bzw. abgezogen werden soll, wenn 

auf eines der beiden Pfeilchen geklickt wird. 

 Ausgabezelle 

 Hier bestimmen Sie, in welcher Tabellenzelle der resultierende Wert ausgege-

ben werden soll.  

 3D-Effekt 

 Schalten Sie diese Option ein, wird das Objekt mit einem 3D-Effekt gezeichnet. 
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Bildlaufleisten 

FreeOffice: Das Einfügen von Formularobjekten wird von SoftMaker Free-

Office nicht unterstützt.  

Mit dem Menübefehl Objekt > Neues Formularobjekt > Bildlaufleiste fügen Sie 

eine Bildlaufleiste ein. 

Mit Bildlaufleisten lassen sich Werte per Mausklick erhöhen oder reduzieren. Ein 

Klick auf das Pfeilchen nach oben erhöht den Wert in der Ausgabezelle um die 

angegebene Schrittweite; das Pfeilchen nach unten reduziert den Wert entspre-

chend.  

Weiterhin können Sie den „Schieber“ in der Mitte der Bildlaufleiste mit der Maus 

verschieben, um größere Sprünge machen. 

Eigenschaften von Bildlaufleisten ändern 

Um die Eigenschaften einer Bildlaufleiste zu ändern, selektieren Sie diese (zum 

Beispiel durch Anklicken mit der rechten Maustaste) und rufen dann den Menübe-

fehl Objekt > Eigenschaften auf. 

Es erscheint ein Dialogfenster mit folgenden Optionen: 

Karteikarte Format 

Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Format“ ab Seite 256. 

Karteikarte Eigenschaften 

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Eigenschaften“ ab Seite 264. 

Karteikarte Formularelement 

Auf dieser Karteikarte können Sie Einstellungen zu der Bildlaufleiste selbst vor-

nehmen: 
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 Rubrik Parameter 

 Hier können Sie folgende Parameter festlegen: 

 Aktueller Wert: Der aktuelle Wert (entspricht dem Wert in der Ausgabezelle). 

 Mindestwert: Der Mindestwert, der nicht unterschritten werden darf. 

 Maximalwert: Der Höchstwert, der nicht überschritten werden darf. 

 Schrittweite: Der Wert, der hinzugezählt bzw. abgezogen werden soll, wenn 

Sie in der Bildlaufleiste auf eines der beiden Pfeilchen klicken. 

 Seitenwechsel: Der Wert, der hinzugezählt bzw. abgezogen werden soll, wenn 

Sie in der Bildlaufleiste in den Bereich zwischen dem Schieber in der Mitte und 

einem der Pfeilchen klicken. 

 Ausgabezelle 

 Hier bestimmen Sie, in welcher Tabellenzelle der resultierende Wert ausgege-

ben werden soll.  

 3D-Effekt 

 Schalten Sie diese Option ein, wird das Objekt mit einem 3D-Effekt gezeichnet. 

Bezeichnungen und Gruppenfelder 

FreeOffice: Das Einfügen von Formularobjekten wird von SoftMaker Free-

Office nicht unterstützt.  

Neben den zuvor beschriebenen Formularobjekten gibt es zusätzlich zwei Arten 

von Formularobjekten, die sich nicht ausfüllen lassen, sondern lediglich für das 

Anbringen von Beschriftungen gedacht sind: 

 Bezeichnungen 

 In Bezeichnungen kann eine beliebige Beschriftung eingegeben werden, die im 

Formular angezeigt werden soll. 

 Gruppenfelder 

 Gruppenfelder sind Rechtecke, die sich links oben mit einer Beschriftung ver-

sehen lassen. Sie können dazu verwendet werden, zusammengehörige Teile ei-

nes Formulars optisch zu einer Gruppe zusammenzufassen.  
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Um eine Bezeichnung oder ein Gruppenfeld einzufügen, rufen Sie den Menübefehl 

Objekt > Neues Formularobjekt > Bezeichnung beziehungsweise Objekt > 

Neues Formularobjekt > Gruppenfeld auf.  

Das entsprechende Formularobjekt wird daraufhin eingefügt. Verschieben Sie es 

nun mit der Maus an die gewünschte Position. Sie können auch seine Größe än-

dern, indem Sie einem der runden Greifer ziehen, die das Objekt umgeben.  

Eigenschaften von Bezeichnungen und Gruppenfeldern ändern 

Um die Eigenschaften einer Bezeichnung oder eines Gruppenfelds zu ändern, se-

lektieren Sie dieses (zum Beispiel durch Anklicken mit der rechten Maustaste) und 

rufen dann den Menübefehl Objekt > Eigenschaften auf. 

Es erscheint ein Dialogfenster mit folgenden Optionen: 

Karteikarte Format 

Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Format“ ab Seite 256. 

Karteikarte Eigenschaften 

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe Ab-

schnitt „Objekt-Eigenschaften, Karteikarte Eigenschaften“ ab Seite 264. 

Karteikarte Formularelement 

Auf dieser Karteikarte können Sie Einstellungen zu dem Text vornehmen, den die 

Bezeichnung beziehungsweise das Gruppenfeld anzeigen soll: 

 Rubrik Text 

 Hier geben Sie den anzuzeigenden Text ein. 

 Rubrik Aussehen 

 Hier können Sie das Zeichenformat (Schriftart, -größe, -farbe etc.) des Textes 

festlegen. 
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 3D-Effekt 

 Nur bei Gruppenfeldern verfügbar. Schalten Sie diese Option ein, wird das 

Gruppenfeld mit einem 3D-Effekt gezeichnet. 
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Sprachwerkzeuge 

PlanMaker verfügt über eine leistungsfähige Rechtschreibprüfung. Diese ermög-

licht es Ihnen, die Rechtschreibung von Text überprüfen und korrigieren zu lassen. 

Außerdem steht eine automatische Silbentrennung zur Verfügung. 

In diesem Kapitel erfahren Sie alles Wissenswerte dazu. Es besteht aus folgenden 

Abschnitten: 

 Sprache einstellen 

 Die Sprache für Rechtschreibprüfung und Silbentrennung lässt sich über den 

Menübefehl Weiteres > Einstellungen (Karteikarte Sprache) einstellen. 

 Rechtschreibprüfung 

 Die Rechtschreibprüfung überprüft den Text in einem Dokument auf Tippfehler 

und macht bei Fehlern Korrekturvorschläge. 

 Silbentrennung 

 Die automatische Silbentrennung trennt lange Wörter am Zeilenende nach de-

ren Sprechsilben. Sie wird standardmäßig nur in Textrahmen aktiv, kann auf 

Wunsch aber auch mehrzeiligen Text in Tabellenzellen trennen.  

 Textbausteine 

FreeOffice: Die Funktion Textbausteine ist in SoftMaker FreeOffice nicht 

enthalten. 

 Über Textbausteine können Sie Ihre „Lieblingstippfehler“ automatisch korrigie-

ren lassen und Kürzel für häufig benötigte Floskeln definieren – zum Beispiel 

„Lst“ für „Lohnsteuer“. 

Sprache einstellen 

Wenn Sie mehrere Sprachen installiert haben, können Sie die Sprache für Recht-

schreibprüfung und Silbentrennung jederzeit wechseln. 

Gehen Sie dazu wie folgt vor: 

1. Rufen Sie den Menübefehl Weiteres > Einstellungen auf. 
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2. Wechseln Sie auf die Karteikarte Sprache. 

3. Wählen Sie die gewünschte Sprache aus der Liste Sprache. 

Hinweis: Beachten Sie dabei, dass es für Deutsch jeweils zwei Einträge in dieser 

Liste gibt:  

 „Deutsch (Deutschland)“ steht für die neue Rechtschreibung (gemäß der so-

genannten „Rechtschreibreform“ von 1996 in ihrer letzten Überarbeitung von 

2006). 

 „Deutsch (Deutschland, alt)“ steht hingegen für die alte Rechtschreibung. 

Entsprechendes gilt für „Deutsch (Österreich)“ und „Deutsch (Schweiz)“. 

Rechtschreibprüfung 

FreeOffice: Bei SoftMaker FreeOffice sind die in SoftMaker Office norma-

lerweise enthaltenen hochwertigen SoftMaker-Wörterbücher nicht verfügbar. 

Hier können ausschließlich Hunspell-Wörterbücher verwendet werden.  

Hunspell-Wörterbücher für Deutsch und Englisch sind bereits vorinstalliert. Falls 

Sie weitere Sprachen benötigen, lesen Sie bitte den Abschnitt „Installieren von 

Hunspell-Wörterbüchern“.  

Die Rechtschreibprüfung überprüft den Text in einem Dokument auf Tippfehler 

und macht bei Fehlern Korrekturvorschläge. 

In diesem Abschnitt stellen wir Ihnen die einzelnen Werkzeuge der Rechtschreib-

prüfung ausführlich vor. Folgende Themen werden darin behandelt: 

 Rechtschreibprüfung nachträglich 

 Die nachträgliche Rechtschreibprüfung lässt Sie das aktuelle Arbeitsblatt en 

bloc überprüfen und korrigieren. 

 Rechtschreibprüfung während des Tippens 

 Die Rechtschreibkorrektur während des Tippens prüft jedes Wort direkt nach 

der Eingabe. Bei Tippfehlern meldet sich sofort ein Dialogfenster zur Korrek-

tur. 
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 Benutzerwörterbücher bearbeiten 

 Wenn Sie die Rechtschreibprüfung Wörter lernen lassen, werden diese in Ihr 

Benutzerwörterbuch aufgenommen. Dieses können Sie jederzeit bearbeiten, um 

beispielsweise fälschlicherweise aufgenommene Wörter wieder zu löschen. 

Ausführliche Informationen zu diesen Themen finden Sie, in obiger Reihenfolge, 

auf den nächsten Seiten. 

Rechtschreibprüfung nachträglich 

FreeOffice: Bei SoftMaker FreeOffice sind die in SoftMaker Office norma-

lerweise enthaltenen hochwertigen SoftMaker-Wörterbücher nicht verfügbar. 

Hier können ausschließlich Hunspell-Wörterbücher verwendet werden.  

Hunspell-Wörterbücher für Deutsch und Englisch sind bereits vorinstalliert. Falls 

Sie weitere Sprachen benötigen, lesen Sie bitte den Abschnitt „Installieren von 

Hunspell-Wörterbüchern“.  

Hinweis: Tabellenzellen, die mit einem Gleichheitszeichen = beginnen (also eine 

Berechnung enthalten), werden von der Rechtschreibprüfung automatisch über-

sprungen. 

Mit dem Menübefehl Weiteres > Rechtschreibprüfung starten Sie die nachträgli-

che Rechtschreibprüfung.  

Diese überprüft das aktuelle Arbeitsblatt Wort für Wort auf Rechtschreibfehler. Bei 

einem unbekannten Wort hält die Rechtschreibprüfung an und zeigt das Wort in 

einem Dialogfenster an. 
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Sie können nun wählen, ob Sie das Wort korrigieren, lernen oder den vermeintli-

chen Fehler einfach ignorieren möchten. In der Liste unter Ändern auf finden Sie 

außerdem Vorschläge für die korrekte Schreibweise des Wortes (sofern welche 

gefunden werden). 

Verwenden Sie die Schaltflächen in dem Dialog, um zu bestimmen, was mit dem 

unbekannten Wort geschehen soll: 

Schaltfläche Funktion 

Ändern Lässt Sie das Wort korrigieren. Tippen Sie, bevor Sie diese 

Schaltfläche betätigen, die korrekte Schreibweise im Eingabefeld 

Ändern auf ein oder wählen Sie einen der Wortvorschläge aus 

der Liste. 

Alle ändern Funktioniert wie Ändern, ändert jedoch alle Vorkommen des 

Wortes im gesamten Dokument auf die angegebene Schreibwei-

se. 

Ignorieren Weist PlanMaker an, diesen Rechtschreibfehler zu ignorieren 

und die Rechtschreibprüfung fortzuführen. 

Alle ignorieren Weist PlanMaker an, fortan alle Vorkommen dieses Wortes zu 

ignorieren. 

 Hinweis: Die Liste der ignorierten Wörter merkt sich PlanMaker 

nur vorübergehend; beim nächsten Programmstart hat er sie 

wieder vergessen. Wenn Sie PlanMaker Wörter permanent ler-

nen lassen möchten, verwenden Sie stattdessen den Befehl Ler-

nen. 

Lernen Weist PlanMaker an, das Wort in das Benutzerwörterbuch aufzu-

nehmen und damit den ihm bekannten Wortschatz zu vergrößern. 



 

Handbuch PlanMaker Sprachwerkzeuge  •  357 

 Verwenden Sie diese Option bei richtig geschriebenen Wörtern, 

die PlanMaker noch nicht kennt. Diese Wörter merkt sich Plan-

Maker permanent, also auch nach einem Neustart. 

Wenn Sie die Rechtschreibprüfung beenden möchten, bevor das Ende des Arbeits-

blatts erreicht ist, klicken Sie auf Schließen. 

Rechtschreibprüfung während des Tippens 

FreeOffice: Bei SoftMaker FreeOffice sind die in SoftMaker Office norma-

lerweise enthaltenen hochwertigen SoftMaker-Wörterbücher nicht verfügbar. 

Hier können ausschließlich Hunspell-Wörterbücher verwendet werden.  

Hunspell-Wörterbücher für Deutsch und Englisch sind bereits vorinstalliert. Falls 

Sie weitere Sprachen benötigen, lesen Sie bitte den Abschnitt „Installieren von 

Hunspell-Wörterbüchern“.  

Wenn Sie die Rechtschreibkorrektur während des Tippens aktivieren, überprüft 

PlanMaker unbemerkt bei jedem Wort, das Sie eintippen, die Rechtschreibung und 

meldet sich bei einem Tippfehler sofort: Es erscheint ein Dialogfenster zum Korri-

gieren der Schreibweise. 

Hinweis: Wenn Sie die Eingabe in eine Zelle mit einem Gleichheitszeichen (=) 

beginnen (also eine Berechnung eingeben), werden die Eingaben in diese Zelle 

nicht geprüft. Das wäre bei Rechenformeln ja auch nicht sinnvoll. 

Um diese Form der Rechtschreibprüfung zu aktivieren, rufen Sie den Menübefehl 

Weiteres > Einstellungen auf, wechseln auf die Karteikarte Sprache und schalten 

dort die Option Rechtschreibkorrektur während des Tippens ein. 

PlanMaker sieht nun jedes Mal, wenn Sie ein Wort eintippen, blitzschnell in seinen 

Wörterbüchern nach, ob es sich darin befindet. Solange Sie Wörter tippen, die die 

Rechtschreibprüfung kennt, passiert nichts Sichtbares. Kann PlanMaker mit einem 

Wort aber nichts anfangen, erscheint sofort ein Dialogfenster. 

Dieses Dialogfenster entspricht dem der nachträglichen Rechtschreibprüfung, das 

im vorherigen Abschnitt vorgestellt wurde. Lesen Sie dort nach, wie das Dialog-

fenster bedient wird. 

Sie werden bemerken, dass es in dem Dialogfenster zusätzlich die Schaltfläche 

Textbaustein zum Anlegen von Textbausteinen gibt. Was es damit auf sich hat, 

erfahren Sie im Abschnitt „Textbausteine“ ab Seite 361. 
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Benutzerwörterbücher bearbeiten 

Wenn Sie die Rechtschreibprüfung Wörter lernen lassen, werden diese in Ihr Be-

nutzerwörterbuch aufgenommen. Dieses können Sie jederzeit bearbeiten, um bei-

spielsweise fälschlicherweise aufgenommene Wörter wieder zu löschen. 

Rufen Sie dazu den Menübefehl Weiteres > Wörterbücher bearbeiten auf. Es 

erscheint ein Dialogfenster mit folgenden Schaltflächen und Optionen: 

 Sprache 

 Es gibt zu jeder Sprache ein eigenes Benutzerwörterbuch. Über die aufklappba-

re Liste Sprache können Sie auswählen, welches Benutzerwörterbuch Sie be-

arbeiten möchten. 

Hinweis: Beachten Sie dabei, dass es für Deutsch jeweils zwei Einträge in 

dieser Liste gibt: „Deutsch (Deutschland)“ steht für die neue Rechtschrei-

bung und „Deutsch (Deutschland, alt)“ für die alte Rechtschreibung. Ent-

sprechendes gilt für „Deutsch (Österreich)“ und „Deutsch (Schweiz)“. 

 Wörter 

 Eine Liste aller Wörter, die sich in Ihrem Benutzerwörterbuch (für die gewählte 

Sprache) befinden. 

 Schaltfläche „Schließen“ 

 Schließt den Dialog. 

 Schaltfläche „Hinzufügen“ 

 Diese Schaltfläche ermöglicht Ihnen, ein Wort manuell zu Ihrem Benutzerwör-

terbuch hinzuzufügen. Tippen Sie das gewünschte Wort dazu in den Dialog ein, 

der nach dem Betätigen dieser Schaltfläche erscheint. 

 Auf diese Weise hinzugefügte Wörter werden genau so behandelt wie Wörter, 

die Sie dem Programm über die Schaltfläche Lernen in der Rechtschreibprü-

fung beigebracht haben. 

 Schaltfläche „Ändern“ 

 Mit dieser Schaltfläche können Sie das momentan in der Liste selektierte Wort 

editieren. Dies ist nützlich bei Wörtern, die Sie versehentlich in falscher 

Schreibweise in Ihr Benutzerwörterbuch aufgenommen haben. Es erscheint da-

zu ein Dialog, in dem Sie die Schreibweise des Wortes korrigieren können.  
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 Schaltfläche „Löschen“ 

 Diese Schaltfläche löscht das Wort, das momentan in der Liste ausgewählt ist, 

aus Ihrem Benutzerwörterbuch. 

 Die Rechtschreibprüfung wird dieses Wort künftig also wieder als falsch ge-

schrieben ansehen. 

Silbentrennung 

Die automatische Silbentrennung trennt lange Wörter am Zeilenende nach deren 

Sprechsilben. Dies geschieht völlig automatisch, während Sie tippen.  

Die Silbentrennung ist allerdings nur in zwei Fällen verfügbar: 

 Silbentrennung in Textrahmen 

 In Textrahmen ist die automatische Silbentrennung standardmäßig aktiviert. 

 Silbentrennung in Tabellenzellen 

 In Tabellenzellen ist die automatische Silbentrennung standardmäßig nicht ak-

tiviert. Bei Zellen, die mehrzeiligen Text enthalten, können Sie diese aber auf 

Wunsch einschalten.  

Ausführliche Informationen dazu finden Sie auf den nächsten Seiten. 

Wichtig: Die Silbentrennung liefert natürlich nur dann korrekte Resultate, wenn 

Sie in den Programmeinstellungen die richtige Sprache eingestellt haben. Um die 

Sprache einzustellen, rufen Sie den Menübefehl Weiteres > Einstellungen auf, 

wechseln auf die Karteikarte Sprache und wählen die Sprache aus der Liste 

Sprache. 

Silbentrennung in Textrahmen 

Wenn Sie Text in einen Textrahmen einfügen, führt PlanMaker darin automatisch 

Silbentrennungen durch. Dies geschieht völlig automatisch im Hintergrund, Sie 

brauchen sich normalerweise also überhaupt nicht darum zu kümmern.  

Sie sollten lediglich darauf achten, dass Sie in den Einstellungen die korrekte 

Sprache gewählt haben, da die Silbentrennung sonst natürlich fehlerhafte Resultate 

liefert (siehe Abschnitt „Sprache einstellen“ ab Seite 353). 
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Trennhäufigkeit einstellen 

Auf Wunsch können Sie einstellen, wie häufig die Silbentrennungsfunktion Wörter 

trennen soll – oder die Silbentrennung ganz abschalten. Diese Einstellung lässt sich 

für jeden Absatz in einem Textrahmen getrennt festlegen. 

Markieren Sie dazu die betreffenden Absätze in dem Textrahmen, rufen Sie den 

Menübefehl Format > Absatz auf und wählen Sie bei Silbentrennung die ge-

wünschte Einstellung. 

Folgende Optionen stehen zur Wahl: 

Einstellung Effekt 

Keine Keine Silbentrennungen durchführen 

Stets Beliebig viele aufeinander folgende Silbentrennungen versu-

chen. Dies ist die Standardeinstellung. 

2-Zeilen-Trennung Silbentrennung nur in jeder zweiten Zeile versuchen 

3-Zeilen-Trennung Silbentrennung nur in jeder dritten Zeile versuchen 

Mit Keine schalten Sie die Silbentrennung für die selektierten Absätze also ganz 

ab, wogegen Stets in jeder beliebigen Zeile eines Absatzes versucht, eine Silben-

trennung durchzuführen.  

Wozu aber dienen die zwei anderen Optionen? Nun, es ist nicht immer erstrebens-

wert, alle denkbaren Silbentrennungen durchzuführen. Denn das kann beispiels-

weise bei schmalen Textspalten dazu führen, dass in fast jeder Zeile getrennt wird, 

was die Lesbarkeit des Dokuments absenkt. Deshalb können Sie PlanMaker mit 

Hilfe der Optionen 2- und 3-Zeilen-Trennung anweisen, eine Silbentrennung nur 

in jeder zweiten beziehungsweise dritten Zeile zu versuchen. 

Silbentrennung in Tabellenzellen 

In Tabellenzellen ist die automatische Silbentrennung normalerweise nicht akti-

viert, sie können Sie aber auf Wunsch einschalten. Silbentrennungen werden dann 

aber natürlich nur in Zellen durchgeführt, die mehrzeiligen Text enthalten.  

Um Silbentrennungen in Zellen zu erhalten, sind also zwei Schritte erforderlich: 
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Schritt 1: Silbentrennung für Zellen aktivieren 

Damit in Zellen überhaupt Silbentrennungen durchgeführt werden, müssen Sie erst 

die Silbentrennung für Zellen aktivieren. Diese ist standardmäßig nämlich ausge-

schaltet. Um sie einzuschalten, gehen Sie wie folgt vor: 

1. Rufen Sie den Menübefehl Datei > Eigenschaften auf. 

2. Wechseln Sie auf die Karteikarte Optionen. 

3. Schalten Sie die Option Silbentrennung ein. 

Von nun an wird die Silbentrennung automatisch auch in Tabellenzellen aktiv. 

Hinweis: Dies ist eine Dokumentoption, sie kann also für jedes Dokument indivi-

duell ein- oder ausgeschaltet werden. 

Schritt 2: In den betreffenden Zellen den Zeilenumbruch einschalten 

In Tabellenzellen werden nur dann Silbentrennungen durchgeführt, wenn für die 

betreffende Zelle die Option Zeilenumbruch eingeschaltet ist. Diese sorgt dafür, 

dass langer Text automatisch am rechten Zellenrand umbrochen wird, um ihn auf 

mehrere Zeilen zu verteilen.  

Um die Option Zeilenumbruch zu aktivieren, geben Sie wie folgt vor: 

1. Markieren Sie die gewünschten Zellen. 

2. Rufen Sie den Menübefehl Format > Zelle auf. 

3. Wechseln Sie auf die Karteikarte Ausrichtung. 

4. Schalten Sie die Option Zeilenumbruch ein. 

In diesen Zellen werden nun (sofern sie mehrzeiligen Text enthalten) bei Bedarf 

automatische Silbentrennungen durchgeführt. 

Textbausteine 

FreeOffice: Die Funktion Textbausteine ist in SoftMaker FreeOffice nicht ent-

halten. 
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Textbausteine bieten eine enorme Arbeitserleichterung: Sie können sich Textbau-

steine für häufig benötigte Floskeln anlegen und diese dann blitzschnell im Text 

abrufen. 

Legen Sie beispielsweise einen Textbaustein namens „Lst“ mit dem Inhalt „Lohn-

steuer“ an. Nun können Sie diesen Baustein jederzeit abrufen. Tippen Sie dazu im 

Dokument einfach „Lst“ und dann die Leertaste, die Eingabetaste (¢) oder ein 

Satzzeichen. Sofort wird „Lst“ durch „Lohnsteuer“ ersetzt. 

Auf diese Weise können Sie sich mit PlanMaker Ihr persönliches „Computersteno“ 

zusammenstellen und beim Tippen viel Zeit sparen. 

In diesem Abschnitt erfahren Sie alles über das Arbeiten mit Textbausteinen: 

 Textbausteine anlegen 

 Neue Textbausteine können dialoggesteuert mit dem Menübefehl Einfügen > 

Textbaustein oder über die Rechtschreibprüfung angelegt werden. Für jeden 

Textbaustein muss ein Name (z.B. „Lst“) der gewünschte Inhalt angegeben 

werden (z.B. „Lohnsteuer“). 

 Textbausteine abrufen 

 Wenn in den Einstellungen die Option Textbausteine automatisch ersetzen 

aktiviert ist, lassen sich Textbausteine ganz einfach abrufen: Tippen Sie dazu 

den Namen des Bausteins und anschließend die Leertaste, die Eingabetaste (¢) 

oder ein Satzzeichen. Sofort wird der Name durch den Inhalt ersetzt. 

 Alternativ lassen sich Bausteine mit dem Menübefehl Einfügen > Textbau-

stein von Hand einfügen. 

 Textbausteine bearbeiten 

 Mit dem Menübefehl Einfügen > Textbaustein lassen sich nicht nur neue 

Textbausteine anlegen, sondern auch vorhandene Bausteine bearbeiten, umbe-

nennen oder löschen. 

Ausführliche Informationen hierzu folgen auf den nächsten Seiten. 

Textbausteine anlegen 

Sie können Textbausteine wahlweise a) dialoggesteuert anlegen oder b) die Recht-

schreibkorrektur während des Tippens dazu verwenden: 
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A) Mit dem Befehl Einfügen > Textbaustein 

Um beispielsweise einen Baustein mit dem Namen „Lst“ und dem Inhalt „Lohn-

steuer“ anzulegen, gehen Sie wie folgt vor: 

1. Rufen Sie den Menübefehl Einfügen > Textbaustein auf. 

2. Klicken Sie auf die Schaltfläche Neu, um einen neuen Baustein anzulegen. 

3. Geben Sie dem Baustein einen Namen (in unserem Beispiel also „Lst“).  

 Anhand seines Namens kann der Baustein später abgerufen werden. 

4. Bestätigen Sie mit OK. 

5. Tippen Sie nun in dem großen Eingabefeld rechts den Text für den Baustein ein 

(in unserem Beispiel also „Lohnsteuer“). 

6. Klicken Sie auf Speichern, um Ihren neuen Textbaustein zu speichern. 

7. Verlassen Sie den Dialog mit Schließen. 

Der Baustein ist nun angelegt. Wie Sie ihn abrufen können, erfahren Sie im nächs-

ten Abschnitt („Textbausteine abrufen“ ab Seite 364). 

B) Über die Rechtschreibkorrektur während des Tippens 

Alternativ lassen sich Textbausteine auch über die Rechtschreibkorrektur während 

des Tippens anlegen.  

Der Vorteil dieser Methode ist, dass sich Bausteine damit schneller anlegen lassen, 

falls Sie die Rechtschreibkorrektur während des Tippens ohnehin permanent 

eingeschaltet haben. Wenn Sie diese jedoch nicht verwenden, ist die oben be-

schriebene Methode praktischer. 

Gehen Sie wie folgt vor: 

1. Vergewissern Sie sich, dass auf der Karteikarte Sprache im Dialogfenster des 

Menübefehls Weiteres > Einstellungen die Option Rechtschreibkorrektur 

während des Tippens aktiviert ist. 

2. Tippen Sie die drei Buchstaben „Lst“ und betätigen Sie die Leertaste. 

3. Es erscheint das Dialogfenster der Rechtschreibkorrektur, da PlanMaker das 

Wort „Lst“ nicht kennt. 

4. Klicken Sie auf die Schaltfläche Textbaustein. 
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5. Tippen Sie „Lohnsteuer“ ein. 

6. Bestätigen Sie mit OK. 

Das Ergebnis ist das Gleiche: Der Baustein „Lst“ ist nun angelegt worden. 

Weitere Informationen zur Rechtschreibkorrektur während des Tippens finden Sie 

im Abschnitt „Rechtschreibprüfung während des Tippens“ ab Seite 357. 

Textbausteine abrufen 

Jetzt können Sie den im vorherigen Abschnitt definierten Textbaustein jederzeit 

abrufen.  

Dies geht denkbar einfach: Tippen Sie in einer Zelle oder einem Textrahmen den 

Namen des Bausteins – in unserem Beispiel also „Lst“ – und dann ein Leerzeichen, 

ein Satzzeichen oder die Eingabetaste (¢). Sofort ersetzt PlanMaker „Lst“ durch 

den Inhalt des Bausteins: „Lohnsteuer“. 

Hinweis: Sollte dies nicht funktionieren, haben Sie die Option Textbausteine 

automatisch ersetzen deaktiviert. Rufen Sie den Menübefehl Weiteres > Ein-

stellungen auf, wechseln Sie auf die Karteikarte Sprache und schalten Sie diese 

Option wieder ein. 

Alternativ können Sie den Baustein auch per Dialog in den Text einfügen, indem 

Sie den Menübefehl Einfügen > Textbaustein aufrufen, den gewünschten Bau-

stein auswählen und dann die Schaltfläche Einfügen betätigen. 

Textbausteine bearbeiten 

Mit dem Menübefehl Einfügen > Textbaustein können Sie weiterhin die bereits 

angelegten Textbausteine bearbeiten: 

 Neuen Baustein anlegen 

 Betätigen Sie die Schaltfläche Neu, um einen neuen Textbaustein anzulegen 

(siehe Abschnitt „Textbausteine anlegen“ ab Seite 362). 

 Baustein löschen 

 Um einen Textbaustein zu löschen, selektieren Sie ihn in der Liste Textbau-

steine und betätigen dann die Schaltfläche Löschen. 
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 Baustein umbenennen 

 Möchten Sie den Namen eines Bausteins ändern, selektieren Sie ihn in der Liste 

und klicken auf die Schaltfläche Umbenennen. Es erscheint ein Dialogfenster, 

in das Sie den neuen Namen eingeben können. 

 Baustein bearbeiten 

 Um einen Baustein zu bearbeiten, selektieren Sie ihn in der Liste und klicken 

dann in das große Eingabefeld rechts daneben. Nun können Sie den Inhalt des 

Bausteins abändern. 

 Wenn Sie die gewünschten Änderungen angebracht haben, klicken Sie auf die 

Schaltfläche Speichern. 

 Baustein einfügen 

 Um einen Baustein in den Text einzufügen, selektieren Sie ihn in der Liste und 

klicken auf die Schaltfläche Einfügen (siehe auch Abschnitt „Textbausteine ab-

rufen“ ab Seite 364). 

 Dialog schließen 

 Mit der Schaltfläche Schließen können Sie den Dialog schließlich verlassen. 
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Dokumentverwaltung 
PlanMaker verfügt über Funktionen, die es Ihnen erleichtern, Ihre Dokumente zu 

verwalten und schneller auf sie zuzugreifen: 

 Schnellwahlpfade 

 Sie können in PlanMaker Schnellwahlpfade anlegen, um beim Öffnen oder 

Speichern von Dateien blitzschnell in häufig verwendete Ordner wechseln zu 

können. 

 Dokumentinfos 

 In jedem Dokument können Sie Dokumentinfos ablegen, die sich über die Kar-

teikarte Infos im Dialogfenster des Menübefehls Datei > Eigenschaften anzei-

gen und bearbeiten lassen. Sie können Titel, Thema und Autor des Dokuments 

eintragen, Stichwörter für die Suchfunktion des Dateimanagers angeben und ei-

ne kurze Inhaltsangabe verfassen. 

 Dateimanager 

FreeOffice: Der Dateimanager ist in SoftMaker FreeOffice nicht enthalten. 

 Mit dem integrierten Dateimanager können Sie bequem auf Ihre Dokumente 

zugreifen. Sie sehen darin die Namen und Dokumentinfos aller Dokumente auf 

einen Blick und können Dokumente auf Knopfdruck betrachten, öffnen, aus-

drucken oder löschen. Die Suchfunktion lässt Sie Dokumente nicht nur anhand 

des Dateinamens finden, sondern erlaubt auch die Suche nach Thema, Titel, 

Autor etc. 

 Sicherungskopien 

 PlanMaker legt auf Wunsch bei jedem Speichervorgang automatisch eine Si-

cherungskopie mit der vorherigen Version des Dokuments an. Sie können das 

Programm sogar anweisen, mehrere Generationen von Sicherungskopien auf-

zuheben. 

FreeOffice: Bei SoftMaker FreeOffice werden nur einfache Sicherungsko-

pien unterstützt (über die Option .BAK-Dateien anlegen in den Einstellun-

gen).  

Ausführliche Informationen zu diesen Themen finden Sie auf den nächsten Seiten. 
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Schnellwahlpfade 

Sie können mit PlanMaker bis zu zwanzig Schnellwahlpfade anlegen, um beim 

Öffnen oder Speichern von Dateien blitzschnell in einen bestimmten Ordner wech-

seln zu können. 

Ein Schnellwahlpfad ist eine symbolische Angabe wie „Reisekosten“, die für einen 

bestimmten Ordner auf der Festplatte steht (zum Beispiel den Ordner 

C:\BUCHHALTUNG\REISEKOSTEN).  

Wenn Sie nun eine Datei aus diesem Ordner öffnen möchten, brauchen Sie im Dia-

logfenster des Menübefehls Datei > Öffnen nur auf die Schaltfläche Schnellwahl-

pfad zu klicken und den Schnellwahlpfad „Reisekosten“ auszuwählen. Der Dialog 

wechselt sofort in den Ordner C:\BUCHHALTUNG\REISEKOSTEN. 

Schnellwahlpfade stehen nicht nur im Dialogfenster des Menübefehls Datei > Öff-

nen zur Verfügung, sondern in allen Dialogfenstern, die zum Öffnen oder Spei-

chern von Dateien dienen. 

Ausführlichere Informationen folgen auf den nächsten Seiten. 

Anlegen von Schnellwahlpfaden 

Um einen neuen Schnellwahlpfad anzulegen, gehen Sie wie folgt vor: 

1. Rufen Sie einen beliebigen Dateidialog auf (zum Beispiel mit dem Menübefehl 

Datei > Öffnen). 

2. Betätigen Sie die Schaltfläche Schnellwahlpfad. 

3. Es öffnet sich ein Menü unter der Schaltfläche. Wählen Sie darin die Funktion 

Schnellwahlpfad neu anlegen. 

4. Tragen Sie bei Name einen beliebigen Namen für den Schnellwahlpfad ein – 

zum Beispiel „Reisekosten“. 

5. Tragen Sie bei Pfad den gewünschten Ordner ein – zum Beispiel 

„c:\buchhaltung\reisekosten“. 

Tipp: Sie können auch auf die drei Punkte neben diesem Eingabefeld klicken. 

Dies öffnet einen Dateidialog, in dem Sie den gewünschten Ordner bequem 

auswählen können. 

6. Bestätigen Sie mit OK. 
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PlanMaker weiß nun, dass der Schnellwahlpfad „Reisekosten“ in den Ordner 

C:\BUCHHALTUNG\REISEKOSTEN wechseln soll. 

Schnellwahlpfade mit Dateimasken: Sie können nicht nur reine Pfadangaben wie 

„c:\buchhaltung\reisekosten“ machen, sondern zusätzlich auch eine Dateimaske 

angeben. Definieren Sie beispielsweise einen Schnellwahlpfad auf 

„c:\buchhaltung\reisekosten\a*.*“, wird damit in den Ordner 

C:\BUCHHALTUNG\REISEKOSTEN gewechselt und darin alle Dateien angezeigt, die 

mit „a“ beginnen. 

Kennbuchstaben: Im Namen für Schnellwahlpfade kann das &-Zeichen verwendet 

werden, um dem Pfad einen Kennbuchstaben zu geben. Wird als Name beispiels-

weise „&Finanzen“ eingetragen, kann der Pfad in der geöffneten Liste der 

Schnellwahlpfade durch Drücken der Taste (F) aufgerufen werden. 

Verwenden von Schnellwahlpfaden 

Schnellwahlpfade stehen in allen Dateidialogen zur Verfügung – zum Beispiel im 

Dialog des Menübefehls Datei > Öffnen. 

Um einen Schnellwahlpfad einzusetzen, gehen Sie wie folgt vor: 

1. Klicken Sie in einem Dateidialog auf die Schaltfläche Schnellwahlpfad. 

2. Es öffnet sich ein Menü mit allen bisher eingerichteten Schnellwahlpfaden. 

Wählen Sie den gewünschten Schnellwahlpfad aus. 

PlanMaker wechselt nun in den im Schnellwahlpfad festgelegten Ordner. 

Schnellwahlpfade bearbeiten und löschen 

Um einen vorhandenen Schnellwahlpfad zu bearbeiten oder ihn zu entfernen, ge-

hen Sie wie folgt vor: 

1. Klicken Sie in einem Dateidialog auf die Schaltfläche Schnellwahlpfad. 

2. Es öffnet sich ein Menü. Wählen Sie darin den Befehl Schnellwahlpfade än-

dern. 

3. Es erscheint ein Dialogfenster. Selektieren Sie darin den gewünschten Schnell-

wahlpfad.  

4. Klicken Sie auf Ändern, um den Namen und Pfad zu bearbeiten oder auf Lö-

schen, um den Schnellwahlpfad zu entfernen. 
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Dokumentinfos 

Über den Menübefehl Datei > Eigenschaften lassen sich nicht nur dokumentspezi-

fische Einstellungen vornehmen, sondern auch die Dokumentinfos eintragen. 

Dokumentinfos sind Zusatzinformationen (wie Thema, Autor, Stichwörter etc.) zu 

einem Dokument. Um diese einzusehen oder sie zu bearbeiten, rufen Sie den Me-

nübefehl Datei > Eigenschaften auf und wechseln auf die Karteikarte Infos. 

Nehmen Sie die gewünschten Eintragungen vor und bestätigen Sie mit OK. 

Tipp: Im Dateimanager (siehe nächster Abschnitt) können Sie Dokumente nach 

den Dokumentinfos durchsuchen lassen, um beispielsweise alle Dokumente zu 

einem bestimmten Thema zu finden. 

Beim Speichern automatisch nach Dokumentinfo fragen: Auf Wunsch bittet Sie PlanMa-

ker bei jedem neuen Dokument automatisch um das Ausfüllen der Dokumentinfos. 

Rufen Sie dazu den Menübefehl Weiteres > Einstellungen auf, wählen Sie die 

Karteikarte Dateien und schalten Sie die Option Beim Speichern nach Dokumen-

tinfo fragen ein. Nun erscheint jedes Mal, wenn Sie ein neues Dokument zum ers-

ten Mal speichern, das Dialogfenster zur Eingabe der Dokumentinfos. 

Dateimanager 

FreeOffice: Der Dateimanager ist in SoftMaker FreeOffice nicht enthalten. 

Der Dateimanager zeigt eine Liste von Dokumenten aus einem oder mehreren 

Ordnern an und lässt Sie diese per Mausklick öffnen, drucken, löschen oder anse-

hen.  

Sie starten den Dateimanager mit dem Menübefehl Datei > Dateimanager. 
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Mit der Maus können Sie das Fenster des Dateimanagers jederzeit verschieben und 

es größer oder kleiner ziehen. Außerdem können Sie die Spaltenbreiten durch Zie-

hen an den Trennlinien zwischen den Spaltenüberschriften ändern.  

Durch Klicken auf eine der Spaltenüberschriften können Sie bestimmen, nach wel-

cher Spalte die Dateien sortiert werden sollen. 

Über die Schaltfläche Suchen können Sie in einen anderen Ordner wechseln. Wei-

terhin erlaubt die Suchfunktion, die sich hinter dieser Schaltfläche verbirgt, auch 

die Suche innerhalb der Dokumentinfos, so dass Sie nach einem bestimmen Titel, 

Thema, Autor, Schlagwort etc. suchen können. 

Um eine Aktion mit einer Datei durchzuführen, selektieren Sie diese und klicken 

dann auf eine der Schaltflächen. Deren genaue Funktionen sind im nächsten Ab-

schnitt beschrieben. 

Schaltflächen im Dateimanager 

FreeOffice: Der Dateimanager ist in SoftMaker FreeOffice nicht enthalten. 

Die Schaltflächen im Dateimanager haben folgende Funktionen: 

 Öffnen 

 Klicken Sie auf diese Schaltfläche, öffnet PlanMaker die selektierte Datei. 

Tipp: Sie können alternativ auch einen Doppelklick auf einen Dateinamen 

ausführen, um die Datei zu öffnen. 



 

372  •  Dokumentverwaltung Handbuch PlanMaker 

 Schließen 

 Diese Schaltfläche beendet den Dateimanager. 

 Suchen 

 Klicken Sie diese Schaltfläche an, um nach bestimmten Dateien zu suchen oder 

einfach nur den Ordner auszuwählen, der im Dateimanager angezeigt werden 

soll. Ausführliche Informationen zum Thema „Suchen mit dem Dateimanager“ 

finden Sie im nächsten Abschnitt. 

 Ausgabe 

 Verwenden Sie diese Schaltfläche, um das selektierte Dokument auszugeben. 

Es öffnet sich dazu ein kleines Menü, das folgende Funktionen enthalten kann 

(anhängig vom verwendeten Betriebssystem): 

 E-Mail: Dokument per E-Mail versenden 

 Drucken: Dokument ausdrucken 

 Umbenennen 

 Klicken Sie diese Schaltfläche an, können Sie die selektierte Datei umbenen-

nen. 

 Löschen 

 Klicken Sie diese Schaltfläche an, wird die selektierte Datei (nach Rückfrage) 

gelöscht. 

 Vorschau 

 Ein Mausklick auf diese Schaltfläche öffnet ein Fenster, in dem Sie das selek-

tierte Dokument betrachten können, ohne es dazu öffnen zu müssen. 

 Um dieses Dokument dann tatsächlich zu öffnen, klicken Sie auf die Schaltflä-

che Öffnen in der Vorschau. Um das Vorschaufenster hingegen zu verlassen, 

betätigen Sie die Schaltfläche Abbrechen. 

Suchen mit dem Dateimanager 

FreeOffice: Der Dateimanager ist in SoftMaker FreeOffice nicht enthalten. 
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Mit Hilfe der Schaltfläche Suchen im Dateimanager können Sie PlanMaker nach 

bestimmten Dateien suchen lassen oder einfach nur den Ordner wählen, der im 

Dateimanager angezeigt werden soll. 

 

Sie können Dateien nach folgenden Kriterien suchen lassen: Dateiname, Ordner, 

Dateityp und den Angaben in den Dokumentinfos (Titel, Thema, Autor, Schlüssel-

wörter).  

Dabei lassen sich auch mehrere Suchkriterien kombinieren. Wählen Sie im Su-

chen-Dialog beispielsweise einen bestimmten Ordner, zeigt PlanMaker alle Doku-

mente in diesem Ordner an. Tragen Sie zusätzlich im Feld Titel einen Suchbegriff 

ein, findet PlanMaker alle Dokumente, die 1. im gewählten Ordner sind und 2. den 

angegebenen Suchbegriff im Feld Titel der Dokumentinfos enthalten. 

Mit dem oben abgebildeten Dialogfenster steuern Sie die Suchfunktion: 

 Dateiname 

 Mit Hilfe dieses Eingabefelds können Sie nach bestimmten Dateien suchen. 

 Wenn Sie hier nichts eintragen (also die Vorgabe übernehmen), findet die Such-

funktion alle Dokumente des gewählten Dateityps im gewählten Ordner. 

 Wenn Sie einen eindeutigen Dateinamen wie LOHNSTEUER.PMDX eintippen, 

werden nur Dokumente mit exakt diesem Namen gefunden. 

 Wenn Sie einen mehrdeutigen Dateinamen wie LOHN*.PMDX eintippen, findet 

die Suche alle Dokumente, deren Dateiname mit „Lohn“ beginnt.  

 Dateityp 

 Über diese Liste können Sie wählen, nach welchem Typ von Dateien gesucht 

werden soll. Möchten Sie beispielsweise nach Dateien im Excel-Format su-

chen, wählen Sie dieses Format in der Liste Dateityp. 
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 Titel, Thema, Autor etc. 

 Durch Eingaben in diese Felder können Sie die Dokumentinfos (siehe hierzu 

auch Abschnitt „Dokumentinfos“) Ihrer Dokumente durchsuchen lassen.  

 Wenn Sie mehrere Felder ausfüllen, sucht PlanMaker nach Dokumenten in de-

nen alle diese Bedingungen zutreffen. Tragen Sie beispielsweise bei Schlüs-

selwörter „Steuer“ und bei Autor „Schmidt“ ein, werden nur Dokumente ge-

funden, bei denen die entsprechenden Felder der Dokumentinfos diese Texte 

enthalten. 

 Sie können auch nur Teile des gesuchten Begriffs angeben. Haben Sie also 

beim Feld Schlüsselwörter den Suchbegriff „Steuer“ eingetippt, werden alle 

Dokumente gefunden, bei denen Schlüsselwörter den Begriff „Steuer“ enthält 

– „Steuererhöhung“ wird also genauso gefunden wie „Meine Steuererklärung“. 

 Groß/Kleinschreibung spielt bei Ihren Eingaben keine Rolle – Dokumente mit 

dem Schlüsselwort „Einkommenssteuererklärung“ werden also auch gefunden, 

wenn der Suchbegriff „Steuer“ lautet. 

 Ordner 

 Hier können Sie wählen, in welchem Ordner PlanMaker die Suche durchführen 

soll. 

 Untergeordnete Ordner einbeziehen 

 Ist dieser Schalter aktiviert, durchsucht PlanMaker nicht nur den aktuellen Ord-

ner, sondern auch alle ihm untergeordneten Ordner. 

 Schaltfläche Neue Dateiliste 

 Startet eine neue Suche mit den aktuellen Einstellungen.  

 Schaltfläche Liste ergänzen 

 Hier wird ebenfalls mit der Suche begonnen – mit dem Unterschied, dass die 

Liste der bei der letzten Suche gefundenen Dateien nicht zuvor geleert wird. 

Sicherungskopien 

Hinweis: Diese Funktion ist in der Android-Version nicht verfügbar. Unter 

Android werden lediglich einfache Sicherungskopien unterstützt (Option .BAK-

Dateien anlegen in den Einstellungen). 
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FreeOffice: Bei SoftMaker FreeOffice werden ebenfalls nur einfache Siche-

rungskopien unterstützt.  

PlanMaker legt auf Wunsch bei jedem Speichervorgang automatisch eine Siche-

rungskopie mit der vorherigen Version des Dokuments an. Sie können das Pro-

gramm sogar anweisen, mehrere Generationen von Sicherungskopien aufzuheben. 

Die Einstellungen dazu finden Sie im Dialog des Menübefehl Weiteres > Einstel-

lungen, Karteikarte Dateien. In der aufklappbaren Liste unter Sicherungskopien 

können Sie wählen, ob und wie Sicherungskopien angelegt werden sollen: 

 Keine Sicherungskopien 

 Wenn Sie diese Option wählen, werden keine Sicherungskopien beim Speichern 

von Dokumenten angelegt. (Nicht empfohlen.) 

 Einfache Sicherungskopien 

 Hier wird pro Dokument genau eine Sicherungskopie angelegt. Diese enthält 

die vorherige Version des Dokuments. Sie hat die Namenserweiterung .BAK und 

befindet sich im gleichen Ordner wie das Dokument selbst. 

 Im Detail passiert hierbei folgendes: Wenn Sie beispielsweise ein Dokument 

namens TEST.PMDX speichern, wird zunächst die vorhandene Datei TEST.PMDX 

in TEST.BAK umbenannt. Erst dann wird das Dokument TEST.PMDX gespeichert.  

 (Diese Option entspricht dem Kontrollkästchen .BAK-Dateien anlegen in 

früheren Versionen von SoftMaker Office.) 

 Fortgeschrittene Sicherungskopien 

 Hier werden mehrere Generationen von Sicherungskopien für jedes Dokument 

angelegt. Diese werden allesamt in einem speziellen Backup-Ordner gespei-

chert.  

 Tipp: Wenn diese Option gewählt ist, steht außerdem der Menübefehl Datei > 

Zurück zu vorheriger Version zur Verfügung, mit dem Sie bequem zu einer 

früheren Version des derzeit geöffneten Dokuments zurückkehren können (sie-

he unten). 

 Zusätzliche Optionen: 

 Verzeichnis für Sicherungskopien: Hier können Sie den Pfad für den Ba-

ckup-Ordner ändern, in dem alle Sicherungskopien abgelegt werden. 

 Anzahl der Sicherungskopien pro Dokument: Hier können Sie bestimmen, 

wie viele Sicherungskopien (= Generationen) maximal pro Dokument aufgeho-

ben werden sollen. 
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 Schaltfläche „Bereinigen“: Bietet die folgenden zwei Befehle zum Löschen 

von Sicherungskopien:  

 Verwaiste Sicherungskopien löschen entfernt alle Sicherungskopien, bei 

denen das zugehörige Originaldokument nicht mehr existiert.  

 Alle Sicherungskopien löschen entfernt sämtliche Sicherungskopien im 

Verzeichnis für Sicherungskopien.  

Wie verwende ich den Befehl „Datei > Zurück zu vorheriger Version“? 

Wenn Sie die Option Fortgeschrittene Sicherungskopien verwenden (siehe 

oben), landen alle Sicherungskopien in einem speziellen Backup-Ordner. Dieser 

wird vom Programm automatisch verwaltet. Es wird nicht empfohlen, die Dateien 

in diesem Ordner manuell zu verschieben oder umzubenennen. 

Um zu einer vorherigen Version eines Dokuments zurückzukehren, muss Sie dieser 

Ordner auch überhaupt nicht interessieren – denn es gibt hierfür einen eigenen Me-

nübefehl: Datei > Zurück zu vorheriger Version.  

Mit diesem Befehl können Sie folgendermaßen zu einer vorherigen Version eines 

Dokuments zurückkehren: 

1. Öffnen Sie das gewünschte Dokument (falls es nicht bereits geöffnet ist). 

2. Rufen Sie den Menübefehl Datei > Zurück zu vorheriger Version auf.  

3. Es erscheint ein Dialog, der alle verfügbaren Sicherungskopien für das aktuelle 

Dokument auflistet. Finden Sie anhand der Zeitangaben die Version, die Sie 

wiederherstellen möchten, und wählen Sie diese aus.  

 Tipp: Mit der Schaltfläche Vorschau können Sie sich eine Vorschau auf die 

gewählte Version anzeigen lassen. 

4. Klicken Sie auf die Schaltfläche Wiederherstellen, wird die gewählte vorheri-

ge Version des Dokuments im aktuellen Fenster wiederhergestellt.  

Beachten Sie: Das aktuell geöffnete Dokument wird nun durch die gewählte 

vorherige Version ersetzt. Wenn Sie es jetzt speichern, überschreiben Sie also 

die aktuelle Version mit einer älteren Version! 

 Alternativ können Sie auch auf die Schaltfläche Als Kopie öffnen klicken. 

Diese öffnet die Sicherungskopie in einem neuen Dokumentfenster (anstatt das 

Dokument im aktuellen Fenster zu ersetzen). Dies ist nützlich, wenn Sie die ak-

tuelle Version mit einer älteren Version vergleichen möchten. 
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Was aber mache ich, wenn ich die Originaldatei verloren habe? 

Wenn die Originaldatei für ein Dokument einmal verlorengegangen sein sollte, 

weil sie beispielsweise gelöscht wurde, funktioniert die oben beschrieben Vorge-

hensweise nicht. Was nun? 

Auch in diesem Fall können Sie noch immer auf die Sicherungskopien für das Do-

kument zugreifen (sofern diese natürlich nicht ebenfalls gelöscht wurden). Öffnen 

Sie dazu einfach die Sicherungskopie selbst.  

Wo sich die Sicherungskopien befinden, können Sie im Dialog des Menübefehls 

Weiteres > Einstellungen auf der Karteikarte Dateien nachsehen. Der Ordner ist 

dort bei Verzeichnis für Sicherungskopien eingetragen. Standardmäßig ist dies 

ein Ordner namens Backup unterhalb des SoftMaker-Ordners in Ihrem Doku-

ment-Ordner. 

Die Sicherungskopien in diesem Ordner lassen sich direkt in PlanMaker öffnen. 

Gehen Sie dazu beispielsweise wie folgt vor:  

1. Navigieren Sie im Windows-Explorer zu dem Backup-Ordner (siehe oben). 

2. Suchen Sie in diesem Ordner nach Dateien, deren Name mit dem Namen der 

Originaldatei beginnt. Eine Sicherungskopie für die Datei TEST.PMDX kann bei-

spielsweise TEST.PMDX.135.PMBAK heißen. (Es wird an den Dateinamen also 

immer eine laufende Nummer und die Erweiterung .pmbak angehängt.) 

 Tipp: Je höher die laufende Nummer im Dateinamen, desto aktueller ist die 

Sicherungskopie. 

3. Doppelklicken Sie im Windows-Explorer auf die Sicherungskopie, die Sie öff-

nen möchten. 

4. PlanMaker erkennt, dass Sie versuchen, eine Sicherungskopie zu öffnen. Er 

fragt nach, was genau Sie nun tun möchten. Dazu erscheint ein Dialog mit den 

folgenden Optionen: 

 Die Sicherungskopie öffnen: Öffnet die Sicherungskopie. 

 Den Versionsmanager aufrufen: Ruft den Menübefehl Datei > Zurück zu vorhe-

riger Version auf. Dieser bietet dann alle verfügbaren früheren Versionen des 

Originalsdokuments zur Wahl an. Die Bedienung dieses Befehls wurde weiter 

oben beschrieben. 

 Die Originaldatei öffnen: Öffnet die Originaldatei zu dieser Sicherungskopie. 

(Dies funktioniert natürlich nur, wenn die Originaldatei noch existiert.) 

5. Treffen Sie Ihre Wahl, und klicken Sie dann auf OK. 
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Es sei noch einmal darauf hingewiesen, dass PlanMaker die Dateien im Backup-

Ordner automatisch anlegt und verwaltet. Sie sollten daher keine Änderungen an 

diesen Dateien von Hand vornehmen, also beispielsweise Dateien umbenennen 

oder verschieben.  

Wenn Sie mehr Platz auf dem Datenträger benötigen, können Sie jederzeit alle Da-

teien in diesem Ordner löschen, verlieren dann aber natürlich sämtliche Siche-

rungskopien. 
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Gliederungen 

Bei umfangreichen Tabellen kann es sich lohnen, diese mit einer Gliederung zu 

versehen. Sie können dann nämlich bequem per Mausklick bestimmen, ob nur die 

wichtigsten Daten oder auch Detaildaten angezeigt werden sollen. 

Um eine Tabelle zu gliedern, gruppieren Sie die zusammengehörenden Detailda-

ten. Enthält die Tabelle beispielsweise die Umsätze für mehrere Jahre, jeweils un-

terteilt in die Umsätze pro Monat, selektieren Sie jeweils die Zeilen mit den Mona-

ten eines Jahres und fassen diese zu einer Gruppe zusammen. Fortan können Sie 

diese per Mausklick ein- und ausblenden – je nachdem, ob Sie nur die Jahresum-

sätze oder auch die Monatsumsätze betrachten möchten. 

Gliederungen dürfen übrigens auch mehrere Ebenen enthalten – Sie können also 

innerhalb einer Gruppe von Daten nochmals Daten gruppieren. 

Das Gliederungsfeld 

Sobald eine Tabelle gruppierte Daten enthält, erscheint links der Tabelle ein Glie-

derungsfeld: 
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Über dieses Gliederungsfeld können Sie nun per Mausklick bestimmen, welche 

Detaildaten angezeigt werden sollen: 

 Durch Anklicken der Plus-Symbole  und Minus-Symbole  im Gliederungs-

feld können Sie beliebige Gruppen von Detaildaten individuell ein- und aus-

blenden. 

 Mit Hilfe der Schaltflächen  ganz oben können Sie bestimmen, dass 

generell nur Detaildaten ab einer bestimmten Ebene angezeigt werden sollen. 

Klicken Sie beispielsweise auf die 2, werden nur Zeilen der ersten und zweiten 

Gliederungsebene angezeigt. 

Eine Gliederung kann übrigens nicht nur zeilenweise, sondern auch spaltenweise 

erfolgen. Sie gruppieren dabei also nicht Zeilen, sondern Spalten. Das Gliede-

rungsfeld erscheint in diesem Falle oberhalb der Tabelle. 
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Verwenden der Gliederungsleiste 

Sobald eine Tabelle gruppierte Zellen enthält, erscheint nicht nur das Gliederungs-

feld, sondern auch eine Gliederungsleiste. 

 

Diese enthält die wichtigsten Symbole zum Arbeiten mit Gliederungen (von links 

nach rechts): 

 Gliederungsfeld einschalten (funktioniert nur, wenn die Tabelle gruppierte Zel-

len enthält) oder ausschalten 

 Die markierten Zellen gruppieren 

 Gruppierung der markierten Zellen aufheben 

 Gliederung für die markierten Zellen gänzlich entfernen 

 Details einblenden (entspricht einem Klick auf das Plus-Symbol im Gliede-

rungsfeld) 

 Details ausblenden (entspricht einem Klick auf das Minus-Symbol im Gliede-

rungsfeld) 

Ausführlichere Informationen zum Arbeiten mit Gliederungen finden Sie auf den 

nächsten Seiten. 

Gruppieren von Zellen 

Um eine Tabelle mit einer Gliederung zu versehen, gruppieren Sie die Zeilen (oder 

wahlweise Spalten), die Detaildaten enthalten. Diese können Sie später dann je 

nach Bedarf per Mausklick ein- und ausblenden. 

Um Tabellenzellen zu gruppieren, gehen Sie wie folgt vor: 

1. Markieren Sie die Zeilen oder Spalten, die gruppiert werden sollen. 

2. Rufen Sie den Menübefehl Arbeitsblatt > Gliederung > Gruppieren auf. 

 Alternativ können Sie diesen Befehl auch über das Symbol  in der Gliede-

rungsleiste aufrufen. 

Die Zellen sind nun gruppiert. 
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Anmerkung: Nicht gruppierte Zellen haben eine Gliederungsebene von 1. Gruppie-

ren Sie Zellen, wird deren Gliederungsebene auf 2 erhöht. Sie können sogar einen 

Teil einer Gruppe von Zellen nochmals gruppieren, worauf diese auf Gliederungs-

ebene 3 gesetzt werden etc. Insgesamt sind maximal 8 Ebenen zulässig. 

Aufheben der Gruppierung von Zellen 

Sie können die Gruppierung von Zellen jederzeit wieder aufheben.  

Gehen Sie dazu wie folgt vor: 

1. Markieren Sie die Zeilen oder Spalten, deren Gruppierung aufgehoben werden 

soll. 

2. Rufen Sie den Menübefehl Arbeitsblatt > Gliederung > Gruppierung aufhe-

ben auf. 

 Alternativ können Sie diesen Befehl auch über das Symbol  in der Gliede-

rungsleiste aufrufen. 

Die Zellen sind nun nicht mehr gruppiert – genauer gesagt: ihre Gliederungsebene 

wird um eine Stufe reduziert. Wenden Sie diesen Befehl also auf Zellen mit Gliede-

rungsebene 3 an (sprich: gruppierte Zellen innerhalb bereits gruppierter Zellen), 

wird ihre Gliederungsebene auf 2 reduziert. 

Komplettes Entfernen der Gliederung von Zellen 

Möchten Sie die Gliederung von Zellen komplett entfernen, gehen Sie wie folgt 

vor: 

1. Markieren Sie die Zeilen oder Spalten, deren Gruppierung aufgehoben werden 

soll. Hinweis: Wenn Sie nichts markieren, wird die Gliederung der gesamten 

Tabelle entfernt. 

2. Rufen Sie den Menübefehl Arbeitsblatt > Gliederung > Gliederung entfer-

nen auf. 

 Alternativ können Sie diesen Befehl auch über das Symbol  in der Gliede-

rungsleiste aufrufen. 

Die Gliederung der Zellen wurde nun vollständig entfernt, ihre Gliederungsebene 

ist also wieder auf 1 gesetzt. 
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Ein- und Ausblenden von gruppierten Zellen 

Wenn Sie, wie im vorherigen Abschnitt beschrieben, eine Tabelle mit einer Gliede-

rung versehen haben, können Sie Detaildaten (also gruppierte Zellen) bei Bedarf 

jederzeit ein- oder ausblenden. 

Verwenden Sie dazu das Gliederungsfeld, das automatisch links (beziehungsweise 

oberhalb) der Tabelle angezeigt wird, wenn die Tabelle gruppierte Zellen enthält. 

Sollte das Feld nicht eingeblendet werden, rufen Sie den Menübefehl Arbeitsblatt 

> Gliederung > Gliederungsfeld automatisch einblenden auf. 

Folgendermaßen blenden Sie mit dem Gliederungsfeld gruppierte Zellen ein und 

aus: 

 Neben gruppierten Zellen erscheint ein Balken mit einem Minus-Symbol  im 

Gliederungsfeld. Klicken Sie dieses an, werden die gruppierten Zellen ausge-

blendet. 

 Neben ausgeblendeten Zellen erscheint ein Plus-Symbol  im Gliederungsfeld. 

Klicken Sie dieses an, werden die gruppierten Zellen wieder eingeblendet. 

 Mit Hilfe der Schaltflächen  ganz oben können Sie bestimmen, dass 

generell nur Detaildaten ab einer bestimmten Ebene angezeigt werden sollen. 

Klicken Sie beispielsweise auf die 2, werden nur Zeilen der ersten und zweiten 

Gliederungsebene angezeigt. 

Hinweis: Wenn Sie gruppierte Zellen ausblenden, werden diese nicht nur auf dem 

Bildschirm ausgeblendet, sondern auch in Diagrammen nicht mehr berücksichtigt. 

Einstellungen zur Gliederung ändern 

Mit dem Menübefehl Arbeitsblatt > Gliederung > Optionen können Sie folgende 

Einstellungen zur Gliederung der aktuellen Tabelle vornehmen: 

 Titelzeile unterhalb Gruppenzeilen 

 Als Titelzeile bezeichnet man eine Zeile direkt oberhalb oder unterhalb von 

gruppierten Zellen, die beispielsweise eine Überschrift oder eine Zusammen-

fassung (zum Beispiel die Summe der Werte) enthalten kann.  

 Schalten Sie diese Option ein, wenn sich diese Titelzeile unterhalb der grup-

pierten Zellen befindet. Schalten Sie sie aus, wenn diese sich oberhalb der Zel-

len befindet. 
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 Diese Option bestimmt im Prinzip lediglich, ob im Gliederungsfeld die Minus-

symbole oberhalb oder unterhalb des Balkens für gruppierte Zellen angezeigt 

werden sollen. 

 Titelspalte rechts von Gruppenspalten 

 Diese Option entspricht der obigen Option; sie bezieht sich jedoch auf Tabellen, 

bei denen nicht Zeilen, sondern Spalten gruppiert wurden. Sie können damit 

festlegen, ob sich die Titelspalte links oder rechts der gruppierten Zellen befin-

det. 

 Gliederungsfeld automatisch anzeigen 

 Diese Option bestimmt, ob automatisch das Gliederungsfeld angezeigt werden 

soll, wenn die Tabelle gruppierte Zellen enthält.  

 Ist diese Option aktiviert, erscheint dieses Feld automatisch, sobald die Tabelle 

mindestens eine Gruppe von Zellen enthält. Ist sie deaktiviert, erscheint das 

Gliederungsfeld nicht. 

 Tipp: Alternativ können Sie diese Option über den Menübefehl Arbeitsblatt > 

Gliederung > Gliederungsfeld automatisch anzeigen ein- und ausschalten. 

 Gliederungsansicht schützen 

 Wenn diese Option aktiviert ist, wird die Gliederung geschützt, wenn Sie den 

Blattschutz für das Arbeitsblatt aktivieren (siehe dazu auch Abschnitt 

„Blattschutz“ ab Seite 401). 

 Bei aktiviertem Blattschutz wird also der aktuelle Zustand der Gliederung „ein-

gefroren“. Der Anwender kann weder gruppierte Zellen ein- oder ausblenden, 

noch Zellen gruppieren oder ihre Gruppierung aufheben. 
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Internet-Funktionen 
In diesem Kapitel lernen Sie die wichtigsten Internet-Funktionen von PlanMaker 

kennen: 

 Hyperlinks verwenden 

 Sie können in Ihren Dokumenten jederzeit Hyperlinks (Verknüpfungen) an be-

liebigen Textstellen anbringen, die dann per Mausklick beispielsweise eine 

Webseite oder ein anderes PlanMaker-Dokument öffnen. 

 Dokumente im HTML-Format speichern 

 PlanMaker-Dokumente lassen sich auch in das HTML-Format exportieren. 

Rufen Sie dazu den Menübefehl Datei > Speichern unter auf und wählen Sie 

in der Liste Dateityp das Format HTML. 

Ausführliche Informationen dazu folgen auf den nächsten Seiten. 

Hyperlinks verwenden 

Mit dem Menübefehl Format > Hyperlink können Sie Zellinhalte oder komplette 

Zellen jederzeit mit einem Hyperlink versehen. Hyperlinks sind Verknüpfungen auf 

z.B. Webseiten oder andere Dokumente, die sich dann einfach per Mausklick auf-

rufen lassen. 

Wenn Sie eine Zelle beispielsweise mit einem Link auf eine Webseite versehen, 

wird künftig beim Anklicken dieses Links automatisch der Internet-Browser ge-

startet und diese Seite darin aufgerufen.  

Als Ziel für Hyperlinks ist übrigens auch der Dateiname eines anderen Dokuments 

erlaubt. Dieses wird dann beim Anklicken des Links automatisch geöffnet. 

Hyperlink erstellen 

Um einen Hyperlink zu erzeugen, gehen Sie wie folgt vor: 

1. Markieren Sie die Zelle(n) oder Zellinhalte, an die Sie einen Hyperlink anbrin-

gen möchten.  

2. Rufen Sie den Menübefehl Format > Hyperlink auf. 
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3. Geben Sie bei URL oder Datei das Ziel für den Hyperlink an: Tragen Sie dazu 

den Pfad und Namen der Internet-Ressource oder Datei ein, auf die der mar-

kierte Text verweisen soll. 

 Für Links auf Internet-Seiten muss „http://“ und die Adresse der Seite eingetra-

gen werden – zum Beispiel „http://www.example.com/index.htm“.  

4. Darunter können Sie auf Wunsch noch ein Sprungziel (eine Textmarke oder 

eine Zelladresse) in dem zu öffnenden Dokument angeben (siehe unten). Nor-

malerweise lassen Sie dieses Feld jedoch leer. 

5. Bestätigen Sie mit OK. 

Der Hyperlink wird nun erstellt. Sie erkennen das daran, dass sich die Farbe des 

Textes ändert, um das Vorhandensein eines Links anzuzeigen. 

Tipp: Alternativ können Links auch mit der Tabellenfunktion HYPERLINK ein-

gefügt werden, die wesentlich flexibler in der Anwendung ist. 

Springen zu einer bestimmten Textmarke oder Zelladresse 

Im obigen Dialog können Sie bei Bedarf auch ein Sprungziel im zu öffnenden Do-

kument angeben. Tragen Sie dazu bei Sprungziel die Textmarke (bei HTML-

Dokumenten) beziehungsweise die Zelladresse (bei PlanMaker-Dokumenten) ein, 

zu der gesprungen werden soll. 

Tragen Sie beispielsweise bei Datei oder URL „Umsätze.pmdx“ ein und bei 

Sprungziel die Adresse D42, wird beim Aufrufen dieses Links die Datei UMSÄT-

ZE.PMDX geöffnet und der Zellrahmen darin auf die Zelle D42 gesetzt. 

Platzhalter in Hyperlinks 

Tipp: Sie können in Hyperlinks den Platzhalter * verwenden. Dieser steht stellver-

tretend für den Zellinhalt. 

Beispiel: 

Sie rufen bei einer noch leeren Zelle den Menübefehl Format > Hyperlink auf 

und tragen bei Datei oder URL http://* ein. Geben Sie in diese Zelle nun bei-

spielsweise www.example.com ein, zeigt der Link nunmehr auf die Internet-

Adresse http://www.example.com. 

Dies funktioniert auch mit anderen Protokollen, zum Beispiel mailto:* für E-Mail-

Adressen. 
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Hyperlink aufrufen 

Um einen Hyperlink aufzurufen, klicken Sie die mit dem Hyperlink versehene Zel-

le oder Textstelle einfach mit der Maus an. PlanMaker öffnet daraufhin das ver-

knüpfte Dokument. 

Alternativ können Sie auch die Schreibmarke auf eine beliebige Position innerhalb 

des Linktextes setzen und dann den Menübefehl Bearbeiten > Gehe zu Hyperlink 

aufrufen.  

Hyperlinks bearbeiten oder entfernen 

Bestehende Hyperlinks lassen sich wie folgt bearbeiten: 

 Ziel ändern 

 Um das Ziel eines Hyperlinks zu ändern, markieren Sie die Zelle(n) oder den 

Text mit dem Link und rufen dann den Menübefehl Format > Hyperlink auf. 

Es erscheint wieder das eingangs beschriebene Dialogfenster, in dem Sie das 

Ziel für den Link editieren können. 

Um einen Hyperlink zu entfernen, gehen Sie wie folgt vor: 

 Linktext/Zelle samt Hyperlink löschen 

 Wenn Sie eine Zelle oder einen Textabschnitt löschen, die einen Hyperlink ent-

hält, wird auch der Link entfernt. 

 Nur den Hyperlink entfernen 

 Soll nur der Hyperlink entfernt werden, die damit versehene Zelle oder Text-

stelle jedoch erhalten bleiben, markieren Sie diese und rufen den Menübefehl 

Format > Hyperlink entfernen   auf. 

Dokumente im HTML-Format speichern 

Um ein Dokument im HTML-Format zu speichern, gehen Sie folgendermaßen vor: 

1. Rufen Sie den Menübefehl Datei > Speichern unter auf. 

2. Wählen Sie in der Liste Dateityp das Format HTML. 

3. Geben Sie den Dateinamen an, unter dem die Datei gespeichert werden soll, 

und bestätigen Sie mit OK. 
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Das Dokument wird nun im HTML-Format gespeichert.  

Dabei werden alle nicht vom HTML-Format unterstützten Formatierungen und 

Funktionen entfernt. Unter anderem bedeutet dies: 

 Formatierungen, die das HTML-Format nicht kennt, werden nicht gespeichert. 

 Weiterhin sind HTML-Dateien nicht in der Lage, selbstständig Berechnungen 

durchzuführen. Deshalb rechnet PlanMaker beim Speichern im HTML-Format 

das komplette Arbeitsblatt durch und ersetzt alle Rechenformeln durch ihre Er-

gebnisse. 

Tipp: Öffnen Sie das Dokument nach dem Speichern mit Ihrem Internet-

Browser, um das endgültige Aussehen zu prüfen. 
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Ausgeben von Dokumenten 
In diesem Kapitel finden Sie Informationen darüber, wie Sie Ihre Dokumente mit 

PlanMaker ausgeben können. 

Das Kapitel enthält folgende Abschnitte: 

 Druckvorschau 

 Im ersten Abschnitt geht es um den Menübefehl Datei > Druckvorschau. Die-

ser stellt das Dokument exakt so auf dem Bildschirm dar, wie es beim Ausdruck 

erscheinen wird, und erspart so unnötige Probedrucke. 

 Drucken eines Dokuments 

 Um das aktuelle Dokument dann tatsächlich auf dem Drucker auszugeben, ru-

fen Sie den Menübefehl Datei > Drucken auf. 

 Exportieren eines Dokuments als PDF-Datei 

 Sie können ein Dokument auch in eine PDF-Datei ausgeben, indem Sie den 

Menübefehl Datei > Als PDF-Dokument exportieren aufrufen. 

 PDF-Dateien lassen sich auf praktisch jedem Computer betrachten, sofern dort 

ein geeignetes Anzeigeprogramm installiert ist. Alle Formatierungen und Ob-

jekte des Dokuments werden dabei originalgetreu wiedergegeben. 

 Mailen eines Dokuments 

FreeOffice: Versenden per E-Mail ist in SoftMaker FreeOffice nicht enthal-

ten. 

 Schließlich lassen sich Dokumente auch per E-Mail versenden. Hierfür ist der 

Menübefehl Datei > Versenden zuständig. 

Ausführliche Informationen zu diesen Funktionen folgen auf den nächsten Seiten. 

Druckvorschau 

Die Druckvorschau gibt ein Dokument exakt so auf dem Bildschirm wieder, wie es 

im Ausdruck aussehen wird. Dies erspart unnötige Probeausdrucke. 
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Um die Druckvorschau zu starten, rufen Sie den Menübefehl Datei > Druckvor-

schau auf.  

Um sie wieder zu beenden, klicken Sie auf die Schaltfläche Schließen oder betäti-

gen die Taste (Esc). 

Die Symbolleiste der Druckvorschau 

Die Druckvorschau erscheint in einem eigenen Fenster. Dieses enthält eine Sym-

bolleiste mit folgenden Funktionen: 

 

Diese Schaltflächen dienen zum Blättern von Seite zu Seite. Die erste Schaltfläche 

ruft die erste Seite auf, die Schaltfläche ganz rechts die letzte Seite. Die beiden 

Schaltflächen mit einfachen Pfeilen blättern je eine Seite vor oder zurück.  

Das Eingabefeld in der Mitte erlaubt das gezielte Aufschlagen einer bestimmten 

Seite. Klicken Sie dazu in dieses Eingabefeld, tippen Sie die Seitenzahl ein und 

drücken Sie die Eingabetaste (¢). 

 

Die nächsten drei Schaltflächen haben folgende Funktionen: 

 Die linke Schaltfläche ruft den Menübefehl Datei > Seite einrichten auf, mit 

dem Sie das Seitenformat (Papiergröße, Ausrichtung, Kopf- und Fußzeilen etc.) 

festlegen können. Siehe auch Abschnitt „Seitenformat einstellen“ ab Seite 229. 

 Die mittlere Schaltfläche ruft den Menübefehl Datei > Drucken auf, mit dem 

Sie das Dokument ausdrucken können. Siehe auch Abschnitt „Drucken eines 

Dokuments“ ab Seite 391. 

 Die rechte Schaltfläche ruft den Menübefehl Datei > Als PDF-Dokument ex-

portieren auf, mit dem Sie aus dem Dokument eine PDF-Datei erzeugen kön-

nen. Siehe auch Abschnitt „Exportieren eines Dokuments als PDF-Datei“ ab 

Seite 394. 

 

In diesem Bereich können Sie die Vergrößerungsstufe ändern. Tragen Sie dazu in 

das Eingabefeld den gewünschten Prozentwert ein und drücken Sie die Eingabetas-

te (¢). Oder verwenden Sie die Schaltflächen rechts daneben, mit denen Sie fol-

gende Vergrößerungsstufen einstellen können: 
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 Originalgröße (Vergrößerungsstufe 100%) 

 Auf Seitenhöhe zoomen 

 Auf Seitenbreite zoomen 

Die Schaltfläche Schließen beendet die Druckvorschau. 

Drucken eines Dokuments 

Um das aktuelle Dokument auszudrucken, rufen Sie den Menübefehl Datei > Dru-

cken auf. 

 

Es erscheint ein Dialogfenster, in dem folgende Einstellungen gemacht werden 

können: 
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Drucker 

Wählen Sie hier, auf welchem der installierten Drucker der Ausdruck erfolgen soll. 

Die Schaltfläche Einrichten öffnet ein Fenster zum Einrichten und Konfigurieren 

von Druckern. Informationen hierzu finden Sie im Handbuch zu Ihrem Drucker.  

Linux-Anwender können hier außerdem das Kommando eintragen, das den 

Druckvorgang einleiten soll. 

Drucken 

Bestimmen Sie hier, welcher Teil des Dokuments gedruckt werden soll: 

 Gesamtes Dokument 

 Das gesamte Dokument (mit allen Arbeitsblättern) drucken. 

 Nur markierte Zellen 

 Nur die Zellen drucken, die derzeit im aktuellen Arbeitsblatt markiert sind. 

 Aktuelles Arbeitsblatt 

 Nur das aktuelle Arbeitsblatt drucken. 

 Nur markierte Arbeitsblätter 

 Nur diejenigen Arbeitsblätter drucken, die derzeit im Arbeitsblattregister mar-

kiert sind. 

 Nur folgende Arbeitsblätter 

 Nur bestimmte Arbeitsblätter drucken. Um diese auszuwählen, verwenden Sie 

die Liste unterhalb dieser Option. Setzen Sie darin per Mausklick ein Häkchen 

vor jedes Arbeitsblatt, das gedruckt werden sollen. 

Druckbereich ignorieren 

Wenn Sie diese Option einschalten, ignoriert PlanMaker beim Drucken alle im 

Dokument definierten Druckbereiche.  

Hintergrundinformationen: Sie können bei Bedarf für jedes Arbeitsblatt einen 

Druckbereich definieren. Beim Drucken des Arbeitsblatts werden dann nur noch 

diejenigen Zellen ausgegeben, die sich innerhalb dieses Zellbereichs befinden. Der 

Rest wird wegelassen.  
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Diese Funktion können Sie jederzeit vorübergehend deaktivieren, indem Sie diese 

Option einschalten. 

Mehr Informationen zu Druckbereichen finden Sie im Abschnitt „Optionen zum 

Seitenformat einstellen“ (ab Seite 231). 

Seiten 

Bestimmen Sie hier, welche Seiten gedruckt werden sollen: 

 Alle 

 Alle Seiten drucken. 

 Seiten: 

 Nur die angegebenen Seiten drucken. Tragen Sie dazu die gewünschten Seiten-

nummern ein. Einige Beispiele: 

12 Drucke nur Seite 12 

12-15 Drucke die Seiten 12 bis 15 

12- Drucke alle Seiten ab Seite 12 

-12 Drucke die Seiten 1 bis 12 

 Sie auch mehrere solche Seitenangaben eintragen, indem Sie diese durch 

Kommata trennen: 

2-5, 12 Drucke die Seiten 2 bis 5 und die Seite 12 

etc.  

 Außerdem können Sie über die Option Zu druckende Seiten festlegen, ob alle 

gewählten Seiten oder nur die Seiten mit gerader beziehungsweise ungerader 

Seitennummer gedruckt werden sollen. 

 Bei Seiten pro Blatt können Sie bestimmen, wie viele Seiten auf ein Blatt Pa-

pier gedruckt werden sollen. Normalerweise druckt PlanMaker pro Blatt nur ei-

ne Seite aus, Sie können das Programm aber anweisen, pro Blatt beispielsweise 

vier (entsprechend verkleinerte) Seiten auf einmal auszugeben. 

Optionen 

Dieser Bereich enthält zusätzliche Optionen zum Drucken: 
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 Exemplare 

 Hier lässt sich einstellen, wie viele Kopien des Dokuments gedruckt werden 

sollen. 

 Kopien sortieren 

 Diese Option bestimmt, ob die Druckausgabe beim Drucken mehrerer Kopien 

eines Dokuments nach Seitennummern sortiert werden soll. 

 Ist die Option eingeschaltet, werden beim Drucken mehrerer Kopien eines z.B. 

dreiseitigen Dokuments folgende Seiten ausgegeben: 1-2-3, 1-2-3, 1-2-3, ... 

 Wird sie ausgeschaltet, ist die Reihenfolge hingegen: 1-1-1..., 2-2-2..., 3-3-3... 

 Hinweis: Einige Drucker unterstützen diese Funktion nicht. 

 In Datei drucken 

 Lenkt die Druckausgabe in eine Datei um. 

 Ohne Bilder 

 Überspringt beim Ausdruck alle Grafiken und Zeichnungen (nützlich für 

schnelle Testausdrucke). 

 Umgekehrte Reihenfolge 

 Druckt erst die letzte zu druckende Seite, dann die vorletzte etc. 

Den Ausdruck starten Sie mit OK. 

Tipp: Bevor Sie etwas tatsächlich ausdrucken, können Sie den Menübefehl Datei 

> Druckvorschau aufrufen, um eine Vorschau des Ausdrucks auf dem Bild-

schirm zu erhalten. Dies erspart Ihnen unnötige Probedrucke. 

Exportieren eines Dokuments als PDF-Datei 

Sie können ein Dokument auch in eine PDF-Datei ausgeben. 

PDF-Dateien lassen sich auf praktisch jedem Computer betrachten, sofern dort ein 

geeignetes Anzeigeprogramm (zum Beispiel der „Adobe Reader“) installiert ist. 

Alle Formatierungen und Objekte (Grafiken etc.) des Dokuments werden dabei 

originalgetreu wiedergegeben. 



 

Handbuch PlanMaker Ausgeben von Dokumenten  •  395 

Um von einem Dokument eine PDF-Datei zu erzeugen, gehen Sie wie folgt vor: 

1. Rufen Sie den Menübefehl Datei > Als PDF-Dokument exportieren auf. 

2. Es erscheint ein Dialogfenster. Nehmen Sie darin die gewünschten Einstellun-

gen vor (siehe unten) und bestätigen Sie mit OK. 

3. Nun erscheint ein weiterer Dialog. Geben Sie darin den Dateinamen an, unter 

dem die PDF-Datei gespeichert werden soll, und bestätigen Sie mit OK. 

Die PDF-Datei wird nun erzeugt. Um sie zu betrachten, starten Sie ein geeignetes 

Anzeigeprogramm und öffnen die Datei darin. 

Tipp: Falls auf Ihrem Gerät kein Anzeigeprogramm für PDF-Dokumente instal-

liert ist, suchen Sie mit Ihrem Web-Browser einfach nach „PDF Viewer“. Sie 

werden zahlreiche geeignete Programme finden; viele davon sind kostenlos. 

Das Dialogfenster des obigen Befehls erlaubt es Ihnen, folgende Einstellungen 

zum PDF-Export vorzunehmen: 

Karteikarte Allgemein 

Auf dieser Karteikarte können Sie festlegen, ob nur Teile des Dokuments ausgege-

ben werden sollen, und weitere Einstellungen machen. Die Optionen entsprechen 

weitgehend denen des Befehls Drucken, der im Abschnitt „Drucken eines Doku-

ments“ (Seite 391) beschrieben wurde. 

Darüber hinaus sind folgende Optionen zusätzlich verfügbar: 

 Lesezeichen für Arbeitsblätter anlegen 

 Wenn diese Option aktiviert ist, legt PlanMaker in der PDF-Datei automatisch 

ein Lesezeichen für jedes Arbeitsblatt an, das das Dokument enthält.  

 In Ihrem PDF-Betrachter werden diese Lesezeichen dann in einer Leiste links 

vom Dokument angezeigt. Sie können diese Leiste wie ein interaktives Inhalts-

verzeichnis verwenden: Klicken Sie eines der Lesezeichen an, springt ihr PDF-

Betrachter blitzschnell zum entsprechenden Arbeitsblatt in der PDF-Datei. 

 Tipp: Falls diese Leiste bei Ihrem PDF-Betrachter nicht angezeigt werden soll-

te, suchen Sie darin nach einem Befehl zum Anzeigen von Lesezeichen und ak-

tivieren Sie diesen. 
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 Tagged PDF erzeugen 

 Wenn diese Option aktiviert ist, werden in der PDF-Datei Informationen über 

die logische Struktur des Dokuments gespeichert.  

 Diese Informationen sorgen dafür, dass Ihre PDF-Dateien barrierefrei sind und 

beispielsweise auch mit PDF-Betrachtern verwendet werden können, die den 

Inhalt des Dokuments in Blindenschrift wiedergeben oder ihn vorlesen. 

Karteikarte Einstellungen 

Auf dieser Karteikarte können Sie Einstellungen zur Ausgabequalität machen: 

 AutoForm-Optionen 

 Hier lässt sich die Qualitätsstufe (sprich: Auflösung) einstellen, mit der Auto-

Formen und alle anderen Arten von Zeichnungen exportiert werden. Je höher 

die Qualitätsstufe, desto größer wird die erzeugte PDF-Datei. 

 Grafikoptionen 

 Hier können Sie festlegen, ob Bilder mit einer verlustfreien Komprimierung 

oder der verlustbehafteten JPEG-Komprimierung gespeichert werden sollen. 

Bei der JPEG-Komprimierung lässt sich weiterhin die Qualitätsstufe einstellen. 

Tipp: Normalerweise sollten Sie hier die verlustfreie Komprimierung wählen, 

da sie optimale Qualität gewährleistet. Enthält Ihr Dokument allerdings viele 

Bilder (speziell Fotos), kann dies zu einer sehr großen PDF-Datei führen. In 

diesem Falle ist die Verwendung der JPEG-Komprimierung zu empfehlen, da 

diese Fotos erheblich stärker komprimieren kann. 

 Die Option Für Transparenzen Alphakanal verwenden bestimmt, ob für die 

Darstellung von Transparenzen in Grafiken und Zeichnungen ein „Alphakanal“ 

verwendet werden soll. Normalerweise sehen diese am besten aus, wenn diese 

Option eingeschaltet ist. Manche PDF-Betrachter stellen Alphakanäle jedoch 

fehlerhaft dar, weshalb Sie diese Option auch abschalten können.  

 Weitere Optionen 

 PlanMaker-Dokument einbetten: Speichert eine Kopie des PlanMaker-

Dokuments innerhalb der PDF-Datei. Sie können diese PDF-Datei dann direkt 

in PlanMaker öffnen, worauf das Programm die PlanMaker-Datei daraus extra-

hiert und anzeigt. 
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 Die Datei nach dem Export im PDF-Betrachter öffnen: Startet nach dem 

Erzeugen der PDF-Datei automatisch Ihren PDF-Betrachter (sofern einer instal-

liert ist) und zeigt die Datei darin an. 

 Für Hyperlinks relative Pfade verwenden: Wandelt den Dateipfad von Hy-

perlinks (Verknüpfungen) auf Dateien automatisch in einen relativen Pfad (statt 

eines absoluten Pfads) um. Wenn Sie also beispielsweise einen Link auf die Da-

tei c:\Dokumente\Listen\test.txt eingefügt haben und die PDF-Datei in den 

Ordner c:\Dokumente exportieren, wird dieser Link automatisch in „Lis-

ten\test.txt“ umgewandelt. 

 Schriftoptionen 

 Über die Option Schriften einbetten können Sie festlegen, ob die im Doku-

ment verwendeten Schriftarten in die PDF-Datei eingebettet werden sollen.  

 Ist das Einbetten von Schriften eingeschaltet, wird die erzeugte PDF-Datei auf 

jedem Computer in den ursprünglich verwendeten Schriften angezeigt – auch 

wenn diese Schriften dort nicht installiert sind. Ist die Option hingegen ausge-

schaltet, wird die PDF-Datei mit automatisch gewählten Ersatzschriften darge-

stellt.  

 Die Option Nur verwendete Zeichen einbetten bestimmt, ob beim Einbetten 

von Schriften jeweils alle Zeichen einer Schrift oder nur die tatsächlich im Do-

kument vorkommenden Zeichen eingebettet werden sollen. Das Einschalten 

dieser Option hat den Vorteil, dass die Dateigröße der PDF-Datei nicht so stark 

anwächst. 

Karteikarte Ansicht 

Diese Karteikarte enthält erweiterte Optionen zur Darstellung der PDF-Datei in 

einem PDF-Betrachter: 

 Navigationsfenster 

 Bestimmt, was im Navigationsfenster des PDF-Betrachters angezeigt werden 

soll. (Das Navigationsfenster ist die Leiste, die links von der PDF-Datei ange-

zeigt wird.) 

 Verfügbare Optionen: 

 Standard: Standardeinstellung des PDF-Betrachters verwenden 

 Keine Navigation: Im Navigationsfenster nichts anzeigen 

 Lesezeichen: Im Navigationsfenster alle Lesezeichen des Dokuments anzeigen 
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 Miniaturseiten: Im Navigationsfenster Miniaturansichten aller Seiten des Do-

kuments anzeigen 

 Vergrößerungsstufe 

 Bestimmt, mit welcher Vergrößerungsstufe (Zoom) die PDF-Datei angezeigt 

werden soll: 

 Standard: Standardeinstellung des PDF-Betrachters verwenden 

 Ganze Seite: Vergrößerungsstufe so einstellen, dass die gesamte Seite zu sehen 

ist 

 Seitenbreite: Auf die Seitenbreite zoomen 

 Seitenhöhe: Auf die Seitenhöhe zoomen 

 Benutzerdefiniert: Eigene Vergrößerungsstufe in Prozent festlegen 

 Seitenlayout 

 Bestimmt, mit welchem Layout die Seiten dargestellt werden sollen: 

 Standard: Standardeinstellung des PDF-Betrachters verwenden 

 Einzelne Seiten: Als einzelne Seiten anzeigen 

 Doppelseiten - ungerade Seiten links: Als Doppelseiten anzeigen (mit den 

ungeraden Seiten auf der linken Seite) 

 Doppelseiten - ungerade Seiten rechts: Als Doppelseiten anzeigen (mit den 

ungeraden Seiten auf der rechten Seite) 

 Weitere Einstellungen 

 Hier finden Sie folgende zusätzliche Optionen: 

 Dokumententitel anzeigen: Zeigt in der Titelleiste des PDF-Betrachters den 

Titel des Dokuments (statt seines Dateinamens) an. Tipp: Den Titel können Sie 

auf der Karteikarte Infos im Dialogfenster des Menübefehls Datei > Eigen-

schaften eintragen. 

 PDF-Betrachter auf Bildschirm zentrieren: Zentriert das Programmfenster 

des PDF-Betrachters nach dem Öffnen der PDF-Datei automatisch in der Bild-

schirmmitte. 

 Vollbildmodus: Schaltet den PDF-Betrachter nach dem Öffnen der PDF-Datei 

automatisch in den Vollbildmodus. 

 Menüleiste verbergen: Blendet die Menüleiste des PDF-Betrachters aus. 
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 Symbolleisten verbergen: Blendet sämtliche Symbolleisten des PDF-

Betrachters aus. 

 Steuerelemente verbergen: Blendet die Steuerelemente für das Navigations-

fenster aus. 

Karteikarte Schutz 

Mit Hilfe dieser Karteikarte können Sie die zu erzeugende PDF-Datei verschlüs-

seln und mit einem Kennwort vor dem Öffnen oder Abändern durch Unberechtigte 

schützen. 

 Art der Verschlüsselung 

 Hier können Sie bestimmen, ob die PDF-Datei verschlüsselt werden soll. Ne-

ben einer 40 Bit-Verschlüsselung, die mit relativ wenig Zeitaufwand zu kna-

cken ist, ist auch die erheblich sicherere 128 Bit-Verschlüsselung verfügbar. 

Hinweis: Die anderen Optionen in diesem Dialog werden erst verfügbar, 

wenn Sie eine Verschlüsselungsart ausgewählt haben. 

 Kennwort zum Öffnen des Dokuments 

 Wenn Sie hier ein Kennwort eingeben, fragt der PDF-Betrachter beim Öffnen 

der PDF-Datei nach diesem Kennwort. Wird ein falsches Kennwort eingege-

ben, kann der Anwender die Datei nicht öffnen. 

 Wenn Sie nichts eingeben, kann jedermann die Datei ohne Kennwort öffnen. 

 Kennwort zum Setzen von Zugriffsrechten 

 Des Weiteren können Sie die Zugriffsrechte für die PDF-Datei einschränken. 

Geben Sie dazu ein Kennwort für das Ändern der Rechte ein. Legen Sie dann 

mit Hilfe der Optionen im Bereich Zugriffsrechte fest, welche Rechte Anwen-

der haben sollen. 

 Hintergrundinformation: Manche PDF-Betrachter verfügen über einen Befehl 

zum Ändern der Zugriffsrechte. Ruft ein Anwender diesen Befehl auf, darf er 

nur fortfahren, wenn er das Kennwort eingibt, das Sie hier festgelegt haben. 

 Zugriffsrechte 

 Hier können Sie bestimmen, welche Zugriffsrechte Anwender auf die PDF-

Datei haben sollen, wenn sie diese in einem PDF-Betrachter öffnen. (Nur ver-

fügbar, wenn Sie oben ein Kennwort für das Setzen von Zugriffsrechten einge-

geben haben.) 



 

400  •  Ausgeben von Dokumenten Handbuch PlanMaker 

Mailen eines Dokuments 

FreeOffice: Versenden per E-Mail ist in SoftMaker FreeOffice nicht enthalten. 

Sofern auf Ihrem Gerät ein geeignetes E-Mail-Programm installiert ist, können Sie 

Dokumente direkt von PlanMaker aus per E-Mail versenden. 

Gehen Sie dazu wie folgt vor: 

1. Erstellen oder öffnen Sie das zu versendende Dokument. 

2. Rufen Sie in PlanMaker den Menübefehl Datei > Versenden auf.  

3. Wählen Sie das Format, in dem das Dokument verschickt werden soll.  

 Hinweis: Wenn Sie hier das Format PlanMaker-Dokument auswählen, erhält der Empfänger eine 

E-Mail mit der PlanMaker-Datei als Anhang. Um diesen Anhang öffnen zu können, muss er also 

ebenfalls PlanMaker installiert haben. 

PlanMaker erzeugt nun eine E-Mail mit dem Dokument als Anhang und übergibt 

diese Ihrem E-Mail-Programm. 
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Schützen von Zellen und Tabellen 

Es gibt mehrere Möglichkeiten, Schutzmechanismen in Dokumente einzubauen. So 

können Sie beispielsweise das Editieren bestimmter Zellen verbieten oder gar das 

gesamte Dokument mit einem Kennwort gegen unberechtigtes Lesen schützen. 

Im Einzelnen stehen folgende Schutzmechanismen zur Verfügung: 

 Blattschutz 

 Mit dem Blattschutz können Sie bestimmte Zellen des Arbeitsblatts schützen. 

Wird der Blattschutz aktiviert, lassen sich diese Zellen beispielsweise nicht 

mehr ändern oder ihr Inhalt wird nicht mehr angezeigt. 

 Arbeitsmappenschutz 

 Mit dem Arbeitsmappenschutz können Sie verhindern, dass Anwender Arbeits-

blätter hinzufügen, löschen oder ein-/ausblenden können. 

 Dokumentschutz 

 Der Dokumentschutz schützt das komplette Dokument mit einem Kennwort 

gegen unberechtigtes Lesen oder Speichern. Beim Leseschutz wird das Doku-

ment zusätzlich verschlüsselt. 

Mehr zu den einzelnen Schutzarten erfahren Sie, in obiger Reihenfolge, auf den 

nächsten Seiten. 

Blattschutz 

Schalten Sie den Blattschutz für ein Arbeitsblatt ein, um dieses vor ungewollten 

Änderungen zu schützen. Bei aktiviertem Blattschutz werden alle entsprechend 

gekennzeichneten Zellen auf dem aktuellen Arbeitsblatt mit einem Schutz verse-

hen. Weiterhin sind zahlreiche Menübefehle ausgegraut (also nicht mehr aufrufbar) 

und es lassen sich keine Objekte mehr einfügen. 

Bevor Sie den Blattschutz aktivieren, müssen Sie jedoch mit dem Menübefehl 

Format > Zelle festlegen, welche Zellen geschützt werden sollen, und wie umfang-

reich der Schutz sein soll. 

Das Schützen von Zellen erfolgt also in zwei Schritten: 

 Erster Schritt: Schutzeinstellungen für Zellen festlegen 
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 Zweiter Schritt: Blattschutz aktivieren 

Lesen Sie dazu die nächsten Seiten. 

Erster Schritt: Schutzeinstellungen für Zellen festlegen 

Um Zellen zu schützen, legen Sie zunächst fest, welche Zellen geschützt werden 

sollen und wie umfangreich der Schutz sein soll.  

Dazu gehen Sie wie folgt vor: 

1. Markieren Sie die Zelle(n), deren Schutzeinstellungen geändert werden sollen. 

2. Rufen Sie den Menübefehl Format > Zelle auf. 

3. Wechseln Sie auf die Karteikarte Schutz. 

4. Wählen Sie die gewünschten Schutzeinstellungen (siehe unten). 

5. Bestätigen Sie mit OK. 

Die einzelnen Schutzeinstellungen im Dialogfenster dieses Befehls haben folgende 

Bedeutung: 

 Zelle schützen 

 Schützt die Zelle gegen Änderungen. 

 Bei aktiviertem Blattschutz kann also weder ihr Inhalt noch ihre Formatierung 

verändert werden. 

Wichtig: Standardmäßig ist diese Option bei allen Zellen aktiviert. Wenn Sie 

also möchten, dass bestimmte Zellen bei aktiviertem Blattschutz noch edi-

tierbar sein sollen, müssen Sie die Option Zellen schützen für diese Zellen 

ausschalten. 

 Formel nicht anzeigen 

 Zeigt bei Zellen, die eine Berechnung enthalten, die enthaltene Formel nicht 

mehr an, sondern nur ihr Ergebnis. 

 Bei aktiviertem Blattschutz kann also nicht mehr herausgefunden werden, wel-

che Berechnung diese Zelle enthält. 

 Zelle nicht anzeigen 

 Verbirgt den Inhalt der Zelle auf dem Bildschirm. 
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 Bei aktiviertem Blattschutz wird die Zelle also unsichtbar. Sie erscheint jedoch 

weiterhin im Ausdruck (siehe nächste Option). 

 Zelle nicht ausdrucken 

 Unterdrückt den Inhalt der Zelle im Ausdruck. 

 Bei aktiviertem Blattschutz erscheint die Zelle also im Ausdruck nicht, wenn 

Sie das Dokument drucken. 

Zweiter Schritt: Blattschutz aktivieren 

Der zweite Schritt beim Schützen von Zellen besteht darin, den Blattschutz für das 

aktuelle Arbeitsblatt zu aktivieren. 

Denn wenn Sie (wie gerade beschrieben) die Schutzeinstellungen von Zellen geän-

dert haben, hat dies noch keine Auswirkungen auf das Dokument. Sie müssen den 

Blattschutz erst aktivieren, damit diese Einstellungen wirksam werden. 

Hinweis: Der Aktivieren des Blattschutzes wirkt sich nur auf das aktuelle Ar-

beitsblatt aus. 

Um den Blattschutz für ein Arbeitsblatt zu aktivieren, gehen Sie wie folgt vor: 

1. Rufen Sie den Menübefehl Weiteres > Blattschutz auf. 

2. Nun können Sie auf Wunsch das Kennwort eingeben, das der Anwender ein-

geben muss, wenn er den Blattschutz wieder deaktivieren will. 

 Wenn Sie kein Kennwort vergeben möchten, lassen Sie das Eingabefeld einfach 

leer. 

3. Bestätigen Sie mit OK. 

Der Blattschutz ist nun aktiviert; die Schutzeinstellungen der Zellen werden jetzt 

also wirksam. 

Sie merken dies unter anderem daran, dass sich nur noch Zellen editieren lassen, 

bei denen die Einstellung Zelle schützen nicht aktiviert wurde. Diese Zellen wer-

den mit einem kleinen grünen Dreieck in der linken unteren Ecke gekennzeichnet. 

Dadurch sieht man sofort, welche Zellen sich bei aktiviertem Blattschutz noch ver-

ändern lassen. 
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Tipp: Wenn Sie den Blattschutz aktivieren, können beim Bewegen in der Tabelle 

mit der Tabulatortaste (Tab) ausschließlich editierbare Zellen angefahren werden 

können. Geschützte Zellen werden übersprungen. 

Bei aktiviertem Blattschutz gibt es außerdem folgende Einschränkungen:  

 Die meisten Menübefehle zum Bearbeiten des Blattes sind gesperrt. 

 Bei Objekten lassen sich Position, Größe und auch alle anderen Eigenschaften 

nicht mehr verändern (außer bei Objekten, bei denen Sie die Eigenschaft Sper-

ren deaktiviert haben). 

 Text in Textrahmen lässt sich nicht mehr verändern (außer bei Objekten, bei 

denen Sie die Eigenschaft Text sperren deaktiviert haben). 

 Es lassen sich keine Objekte mehr auf dem Arbeitsblatt einfügen. 

Blattschutz deaktivieren 

Wenn Sie den Blattschutz aktiviert haben, können Sie diesen jederzeit wieder auf-

heben, indem Sie den Menübefehl Weiteres > Blattschutz aufheben aufrufen. 

Der Blattschutz wird dadurch wieder ausgeschaltet. 

Die über den Menübefehl Format > Zelle festgelegten Schutzeinstellungen sind 

nun also wieder unwirksam. PlanMaker merkt sie sich aber weiterhin. Wenn Sie 

den Blattschutz also erneut aktivieren, werden dieselben Schutzeinstellungen wie-

der aktiv. 

Tipp: Wenn Sie ein Dokument bei aktiviertem Blattschutz speichern, wird der 

Blattschutz automatisch wieder aktiviert, wenn das Dokument das nächste Mal 

geöffnet wird. Wenn der Blattschutz weiterhin mit einem Kennwort gesichert ist, 

kann er nur mit dem korrekten Kennwort deaktiviert werden. So können Sie Do-

kumente gegen Veränderungen durch Unbefugte schützen. 

Arbeitsmappenschutz 

Wenn Sie in einem Dokument den Arbeitsmappenschutz aktivieren, bewirkt das, 

dass sich darin ab sofort keinerlei Änderungen am Arbeitsblattregister mehr durch-

führen lassen. Auch der Menübefehl Arbeitsblatt > Blatt ist nicht mehr verfügbar.  
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Dies hat vor allem folgende Auswirkungen: 

 Der Anwender kann keine Arbeitsblätter mehr hinzufügen. 

 Arbeitsblätter lassen sich nicht mehr kopieren, löschen oder umbenennen. 

 Arbeitsblätter lassen sich nicht mehr ein- oder ausblenden. 

Um den Arbeitsmappenschutz einzuschalten, rufen Sie den Menübefehl Weiteres > 

Arbeitsmappenschutz auf. Mit dem gleichen Befehl können Sie ihn auch wieder 

ausschalten. 

Weitere Informationen dazu finden Sie auf den nächsten Seiten. 

Arbeitsmappenschutz aktivieren 

Um den Arbeitsmappenschutz für das aktuelle Dokument zu aktivieren, gehen Sie 

wie folgt vor: 

1. Rufen Sie den Menübefehl Weiteres > Arbeitsmappenschutz auf. 

2. Nun können Sie auf Wunsch das Kennwort eingeben, das der Anwender ein-

geben muss, wenn er den Arbeitsmappenschutz wieder deaktivieren will.  

 Wenn Sie kein Kennwort vergeben möchten, lassen Sie das Eingabefeld einfach 

leer. 

3. Bestätigen Sie mit OK. 

Der Arbeitsmappenschutz ist nun aktiviert; es lassen sich nun also keine Arbeits-

blätter mehr einfügen, löschen, ein-/ausblenden etc. 

Darüber hinaus ist der größte Teil der Optionen im Dialogfenster des Menübefehls 

Datei > Eigenschaften nicht mehr verfügbar. 

Arbeitsmappenschutz deaktivieren 

Wenn im aktuellen Dokument der Arbeitsmappenschutz aktiviert wurde, können 

Sie diesen jederzeit wieder deaktivieren, indem Sie den Menübefehl Weiteres > 

Arbeitsmappenschutz aufheben aufrufen. 

Der Arbeitsmappenschutz wird dadurch wieder ausgeschaltet; das Einfügen, Lö-

schen, Ein-/Ausblenden von Arbeitsblättern etc. ist also wieder möglich. 
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Tipp: Wenn Sie ein Dokument mit aktiviertem Arbeitsmappenschutz speichern, 

wird der Arbeitsmappenschutz künftig bei jedem Öffnen dieses Dokuments au-

tomatisch erneut aktiviert. Wenn der Schutz außerdem mit einem Kennwort gesi-

chert ist, kann er nur mit dem korrekten Kennwort deaktiviert werden. 

Dokumentschutz 

Sie können Dokumente gegen unberechtigtes Lesen oder Speichern schützen, in-

dem Sie sie mit einem Dokumentschutz – genauer gesagt einem Lese- und/oder 

Schreibschutz – versehen. Öffnen beziehungsweise Speichern eines geschützten 

Dokuments ist nur nach Eingabe des korrekten Kennworts möglich. 

Um ein Dokument zu schützen, rufen Sie darin den Menübefehl Datei > Eigen-

schaften auf, wechseln auf die Karteikarte Schutz und wählen die Art des Doku-

mentschutzes. Tragen Sie außerdem das gewünschte Lese- und/oder Schreibkenn-

wort ein. 

Es gibt folgende Arten von Dokumentschutz: 

 Kein Schutz 

 Schreibschutz (Dokument kann geöffnet werden, lässt sich aber nur mit 

Kennwort speichern) 

 Leseschutz (Dokument kann nur mit Kennwort geöffnet werden) 

 Schutz abhängig vom Kennwort (Kombination aus Lese- und Schreibschutz) 

Ausführliche Informationen folgen auf den nächsten Seiten. 

Dokumentschutz aktivieren 

Sie können Dokumente vor unberechtigtem Lesen oder Speichern schützen, indem 

Sie sie mit einem Dokumentschutz – genauer gesagt einem Lese- und/oder Schreib-

schutz – versehen. Öffnen beziehungsweise Speichern eines geschützten Doku-

ments ist nur nach Eingabe des Kennworts möglich. 

Beim Leseschutz wird das Dokument zusätzlich verschlüsselt, damit es auch mit 

anderen Programmen nicht eingesehen werden kann. 

Um ein Dokument zu schützen, gehen Sie wie folgt vor: 
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1. Rufen Sie den Menübefehl Datei > Eigenschaften auf.  

2. Wechseln Sie auf die Karteikarte Schutz. 

3. Wählen Sie die gewünschte Art von Dokumentschutz (siehe unten). 

4. Im Gegensatz zu Blattschutz und Arbeitsmappenschutz müssen Sie beim Do-

kumentschutz immer ein Kennwort vergeben. Tragen Sie nun also ein Lese- 

und/oder Schreibkennwort ein (mindestens 4, maximal 15 Zeichen). 

Wichtig: Wenn Sie ein Kennwort vergessen, kann das Dokument nicht mehr 

geöffnet beziehungsweise gespeichert werden. Es ist daher ratsam, sich das 

Kennwort zu notieren. Achten Sie dabei genau auf die Groß-/Kleinschrei-

bung! 

5. Bestätigen Sie mit OK. 

6. Es erscheint ein Dialog, in dem Sie das Lese- und/oder Schreibkennwort zur 

Kontrolle noch einmal eingeben müssen. 

7. Bestätigen Sie mit OK. 

8. Verlassen Sie das Dialogfenster mit OK. 

9. Speichern Sie das Dokument, damit die Änderungen wirksam werden. 

Zukünftig wird beim Öffnen dieses Dokuments automatisch das Kennwort erfragt. 

Wenn das richtige Kennwort angegeben wird, wird der Schutz vorübergehend au-

ßer Kraft gesetzt. 

Sie können im obigen Dialog zwischen folgenden Arten von Dokumentschutz wäh-

len: 

 Kein Schutz 

 Das Dokument wird nicht geschützt. Dies ist die Standardeinstellung. 

 Schreibschutz 

 Beim Öffnen des Dokuments wird der Anwender dazu aufgefordert, das 

Schreibkennwort einzugeben. Das Dokument kann nur dann gespeichert wer-

den, wenn hier das korrekte Schreibkennwort angegeben wird.  

 Wird ein falsches Kennwort oder überhaupt nichts eingegeben, wird das Do-

kument schreibgeschützt geöffnet. Es kann dann nicht gespeichert werden – 

auch nicht unter einem anderen Namen. 
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 Leseschutz 

 Versucht ein Anwender, das Dokument zu öffnen, wird er dazu aufgefordert, 

das Lesekennwort anzugeben. Wird ein falsches Kennwort eingegeben, lässt 

sich das Dokument nicht öffnen.  

 Das Dokument wird hierbei außerdem verschlüsselt gespeichert, damit es auch 

mit anderen Programmen nicht eingesehen werden kann. 

 Schutz abhängig vom Kennwort 

 Hier erscheinen beim Öffnen des Dokuments zwei Kennwortabfragen hinterei-

nander. Erst wird nach dem Lesekennwort gefragt, dann nach dem 

Schreibkennwort. 

 Gibt der Anwender nur das Lesekennwort ein, darf er das Dokument öffnen, 

aber nicht speichern.  

 Gibt er außerdem das Schreibkennwort ein, hat er vollen Zugriff, kann das Do-

kument also auch speichern. 

 Gibt er ein falsches Kennwort oder überhaupt nichts ein, wird der Zugriff auf 

das Dokument komplett verweigert. 

Verschlüsselungsmethode: „Höchste Kompatibilität“ oder „Höchste 

Sicherheit“? 

Bei Dokumenten mit Leseschutz oder einem Schutz abhängig vom Kennwort 

können Sie zusätzlich die gewünschte Verschlüsselungsmethode auswählen.  

Hinweis: Diese Einstellung betrifft in erster Linie neu erstellte Dokumente. 

Beim Öffnen eines bestehenden verschlüsselten Dokuments wird die darin ver-

wendete Verschlüsselungsmethode automatisch ermittelt und diese Einstellung 

dann entsprechend gesetzt.  

Die Wahl der Verschlüsselungsmethode ist insbesondere für Dokumente im Micro-

soft Excel-Dateiformat (.xls und .xlsx) wichtig. Manche alten Versionen von 

Microsoft Office können nämlich Dokumente, die mit der neuen Verschlüsse-

lungsmethode „Höchste Sicherheit“ verschlüsselt wurden, möglicherweise nicht 

öffnen. 

Verfügbare Optionen: 
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 Höchste Kompatibilität 

 Beim Speichern des Dokuments wird eine alte Verschlüsselungsmethode ver-

wendet, die von allen Versionen von Microsoft Office gelesen werden kann. 

Diese ist allerdings weniger sicher als die andere Methode. 

 Höchste Sicherheit 

 Es wird eine modernere und sicherere Verschlüsselungsmethode verwendet. 

Diese kann allerdings von einigen alten Versionen von Microsoft Office mög-

licherweise nicht gelesen werden.  

Ausführlichere Details zur derzeit gewählten Verschlüsselungsmethode werden im 

unteren Teil des Dialogs angezeigt. 

Dokumentschutz deaktivieren 

Wenn Sie ein lese- oder schreibgeschütztes Dokument öffnen und dabei das kor-

rekte Kennwort angeben, wird der Schutz deaktiviert – allerdings nur vorüberge-

hend. Wenn Sie dieses Dokument nämlich schließen, wird der Schutz wieder 

„scharfgemacht“; beim nächsten Öffnen erscheint also erneut die Abfrage für das 

Kennwort. 

Um den Schutz eines Dokuments permanent zu entfernen, gehen Sie wie folgt vor: 

1. Öffnen Sie das Dokument. 

2. Rufen Sie den Menübefehl Datei > Eigenschaften auf.  

3. Wechseln Sie auf die Karteikarte Schutz. 

4. Wählen Sie die Option Kein Schutz. 

5. Bestätigen Sie mit OK. 

6. Speichern Sie das Dokument, damit die Änderung wirksam wird. 

Der Dokumentschutz ist nun dauerhaft deaktiviert. 

Beim nächsten Öffnen des Dokuments erscheint keine Kennwortabfrage mehr. 

Jeder Anwender kann das Dokument nun wieder öffnen/speichern. 
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Fremdformate 

PlanMaker speichert Dokumente normalerweise in seinem „hauseigenen“ Da-

teiformat namens PlanMaker-Dokument ab. PlanMaker-Dokumente können leicht 

an der Namenserweiterung .PMDX erkannt werden. Wenn Sie zum Beispiel ein Do-

kument unter dem Namen „Lohnsteuer“ speichern, lautet sein vollständiger Datei-

name LOHNSTEUER.PMDX. 

Sie können PlanMaker aber auch anweisen, Dateien in einem anderen Dateiformat 

zu speichern. Dies ist nötig, wenn Sie beispielsweise ein PlanMaker-Dokument mit 

einem anderen Programm weiterbearbeiten möchten. Umgekehrt können Sie mit 

PlanMaker auch Dokumente öffnen, die mit anderen Tabellenkalkulationen erstellt 

wurden, also in einem Fremdformat vorliegen. 

In diesem Kapitel erfahren Sie alles Wissenswerte dazu. Es enthält folgende Ab-

schnitte: 

 Speichern und Öffnen von Fremdformaten 

 Im ersten Abschnitt erfahren Sie, wie Sie Dokumente in einem anderen Da-

teiformat speichern oder öffnen: Einfach den Menübefehl Datei > Speichern 

unter beziehungsweise Datei > Öffnen aufrufen und in der Liste Dateityp das 

gewünschte Format einstellen. 

 Anmerkungen zum Textformat 

 Beim Öffnen oder Speichern von Textdateien erscheint ein Dialogfenster mit 

zusätzlichen Optionen. Hier finden Sie alle Informationen dazu. 

 Anmerkungen zum Excel-Format 

 Der letzte Abschnitt widmet sich dem Dateiformat von Microsoft Excel. Sie 

erfahren darin alles Wissenswerte über den Datenaustausch zwischen PlanMa-

ker und Excel. 

Lesen Sie dazu die nächsten Seiten. 

Speichern und Öffnen von Fremdformaten 

Folgendermaßen speichern oder öffnen Sie Dokumente in einem anderen Da-

teiformat: 
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Speichern eines Dokuments in einem Fremdformat 

Um das aktuelle Dokument in einem anderen Dateiformat zu speichern, rufen Sie 

den Menübefehl Datei > Speichern unter auf und öffnen die aufklappbare Liste 

Dateityp. Wählen Sie darin das gewünschte Format, geben Sie bei Bedarf einen 

anderen Dateinamen an und bestätigen Sie mit OK. 

Öffnen eines in einem Fremdformat vorliegenden Dokuments 

Um ein Dokument, das in einem anderen Dateiformat vorliegt, zu öffnen, rufen Sie 

den Menübefehl Datei > Öffnen auf, öffnen die Liste Dateityp und wählen das 

Format aus, in dem die Datei vorliegt. Wählen Sie dann die zu öffnende Datei und 

bestätigen Sie mit OK. 

Unterstützte Dateiformate 

In den Dialogen zum Öffnen und Speichern von Dokumenten werden in der Liste 

Dateityp unter anderem folgende Dateiformate angeboten: 

 PlanMaker-Dokument 

 Das Hausformat für PlanMaker-Dokumente, in dem Sie Ihre Dokumente übli-

cherweise speichern (Namenserweiterung: .pmdx). 

 PlanMaker-Vorlage 

 Dokumentvorlage für PlanMaker-Dokumente (siehe Abschnitt 

„Dokumentvorlagen“ ab Seite 208) 

 Microsoft Excel-Dokument 

 Sie können auch Dokumente im Dateiformat von Microsoft Excel öffnen und 

speichern. Unterstützt werden sowohl .xls-Dateien (Excel 5.0 bis 2003) als 

auch .xlsx-Dateien (Excel ab 2007). 

FreeOffice: Bei SoftMaker FreeOffice können .xls-Dateien nur geöffnet 

werden – das Speichern in diesem Format wird hier nicht unterstützt.  

 Weitere Informationen zum Arbeiten mit Excel-Dateien finden Sie im Abschnitt 

„Anmerkungen zum Excel-Format“ ab Seite 415. 

 Microsoft Excel-Vorlage 

 Dokumentvorlage für Microsoft Excel-Dokumente 
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 PlanMaker 2012-Datei 

 Speichert das Dokument im Dateiformat von PlanMaker 2012, einer älteren 

Version von PlanMaker (Namenserweiterung: .pmd). 

 TextMaker-Datei (nur Speichern) 

 Speichert das Dokument in einem von der Textverarbeitung TextMaker lesba-

ren Dateiformat. 

 dBase 

 dBase-Datenbank, wahlweise mit DOS-, Windows- oder Unicode-Zeichensatz. 

Vor dem Öffnen/Speichern der Datenbank erscheint ein Dialog, in dem Sie den 

Zeichensatz auswählen können. 

 Beachten Sie: Die meisten Datenbanken liegen im Format dBase/DOS vor – 

nicht im Format dBase/Windows. Selbst Windows-Datenbankprogramme ver-

wenden in der Regel das DOS-Format. 

 Textdatei 

 Textdatei, zum Beispiel mit Tabulatoren oder Strichpunkten als Trenner zwi-

schen den einzelnen Zellwerten. Siehe Abschnitt „Anmerkungen zum Textfor-

mat“ im Anschluss. 

Anmerkungen zum Textformat 

Wie im vorherigen Abschnitt erwähnt, können Sie mit PlanMaker auch reine Text-

dateien (unter anderem auch CSV-Dateien) öffnen und speichern: 

 Um eine Textdatei zu öffnen, rufen Sie den Menübefehl Datei > Öffnen auf, 

wählen einfach die gewünschte Datei und bestätigen mit OK. 

 Um ein Dokument als Textdatei zu speichern, rufen Sie den Menübefehl Datei 

> Speichern unter auf, wählen bei Dateityp den Eintrag Textdatei, geben den 

gewünschten Dateinamen ein und bestätigen mit OK. 

In beiden Fällen erscheint daraufhin ein zusätzlicher Dialog, in dem sich das For-

mat der Textdatei genau festlegen lässt. 

Der Dialog enthält folgende Optionen: 
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Optionen beim Speichern einer Textdatei 

Wenn Sie ein Dokument als Textdatei speichern, können Sie in dem Dialog fol-

gende Einstellungen vornehmen: 

 Zeichensatz 

 Hier können Sie festlegen, mit welchem Zeichensatz die Textdatei gespeichert 

werden soll. 

 Hinweis: PlanMaker schlägt automatisch einen geeigneten Zeichensatz vor. In 

der Regel können Sie diese Vorgabe übernehmen. 

 Datenformat 

 Hier können Sie einstellen, in welchem Format die Zellinhalte in der Textdatei 

gespeichert werden sollen. Folgende Optionen stehen zur Wahl: 

 Trennzeichen zwischen den Feldern: Hier werden die Zellinhalte jeweils 

durch ein bestimmtes Trennzeichen voneinander getrennt (zum Beispiel einem 

Strichpunkt oder einem Tabulator). 

 Beispiel: 

 Peter;Müller-Lüdenscheidt;12345;Buxtehude 

 Thomas;Meier;54321;Neustadt 

 Feste Feldbreiten: Hier hingegen werden die Zellinhalte auf Spalten mit festen 

Breiten verteilt. Zwischenräume werden dabei mit Leerzeichen aufgefüllt.  

 Beispiel: 

 Peter   Müller-Lüdenscheidt  12345  Buxtehude 

 Thomas  Meier                54321  Neustadt 

 Trennzeichen 

 Hier können Sie bestimmen, welches Trennzeichen PlanMaker verwenden soll, 

um die einzelnen Zellinhalte einer Zeile voneinander abzugrenzen (zum Bei-

spiel Strichpunkte oder Tabulatoren). 

Hinweis: Das Trennzeichen sollte innerhalb der Zellinhalte natürlich nicht 

vorkommen, da PlanMaker dort sonst aus einer entsprechenden Zelle zwei 

Einträge machen würde. 

 Texterkennungszeichen 

 Auf Wunsch kann PlanMaker alle Zellen, die Text enthalten, mit einem be-

stimmten Zeichen umgeben (zum Beispiel Anführungszeichen).  
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 Falls Sie das möchten, wählen Sie das gewünschte Zeichen aus der Liste. 

 Zeilen beenden mit ... 

 Hier können Sie auswählen, welche Steuerzeichen am Ende jeder Zeile einge-

fügt werden sollen (um den Beginn einer neuen Zeile zu kennzeichnen). 

 Hinweis: PlanMaker schlägt automatisch geeignete Steuerzeichen vor. In der 

Regel können Sie diese Vorgabe übernehmen. 

 Folgende Optionen stehen zur Wahl: 

 CR+LF: Dies ist die empfohlene Einstellung für Windows. 

 LF: Dies ist die empfohlene Einstellung für Linux und Mac. 

 CR: Dieses Steuerzeichen war auf älteren Apple Mac-Systemen (vor Mac OS 

X) üblich. 

Optionen beim Öffnen einer Textdatei 

Beim Öffnen einer Textdatei werden die gleichen Optionen angeboten wie beim 

Speichern. Verwenden Sie diese, um PlanMaker mitzuteilen, welches Format die 

Textdatei hat, die geöffnet werden soll. 

Eine Option gibt es beim Öffnen zusätzlich: 

 Anzahl der Überschriftzeilen 

 Falls die Textdatei in den ersten Zeilen eine Überschrift (oder erläuternden Text 

o.ä.) enthält, können Sie hier einstellen, um wie viele Zeilen es sich handelt. 

PlanMaker wird diese Zeilen dann nicht auf mehrere Spalten verteilen, wie den 

Rest der Daten, sondern sie unverändert in jeweils einer Tabellenzelle ablegen. 

 Der Standardwert ist 0 (sprich: keine Überschriftzeilen vorhanden). 

Anmerkungen zum Excel-Format 

Wenn Sie vor dem Einsatz von PlanMaker die Tabellenkalkulation Microsoft Excel 

verwendet haben, wird Sie freuen, dass PlanMaker praktisch alle Excel-Dateien 

anstandslos öffnen kann. Umgekehrt ist mit PlanMaker auch das Speichern von 

Dokumenten im Excel-Format möglich. 
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FreeOffice: Bei SoftMaker FreeOffice können .xls-Dateien nur geöffnet wer-

den – das Speichern in diesem Format wird hier nicht unterstützt.  

Auf den nächsten Seiten erfahren Sie, was Sie beim Öffnen und Speichern von 

Excel-Dokumenten beachten sollten. 

Öffnen und Speichern von Excel-Dokumenten 

Wie im Abschnitt „Speichern und Öffnen von Fremdformaten“ erwähnt, kann 

PlanMaker auch Excel-Dokumente öffnen und speichern. 

FreeOffice: Bei SoftMaker FreeOffice können .xls-Dateien nur geöffnet wer-

den – das Speichern in diesem Format wird hier nicht unterstützt.  

Dies funktioniert in fast allen Fällen reibungslos. Manche Rechenfunktionen lassen 

sich jedoch nicht ohne manuellen Eingriff konvertieren, da sie a) Excel bezie-

hungsweise PlanMaker unbekannt sind oder b) in Excel beziehungsweise PlanMa-

ker unterschiedlich arbeiten. 

Was in diesem Fall zu tun ist, erfahren Sie hier: 

Warnmeldung beim Öffnen eines Excel-Dokuments 

Falls Sie beim Öffnen einer Excel-Datei die nachfolgende Hinweismeldung erhal-

ten, konnte PlanMaker nicht alle Rechenformeln umsetzen: 

 

Gehen Sie dann wie folgt vor: 

1. Aktivieren Sie mit dem Menübefehl Ansicht > Syntaxhervorhebung die Syn-

taxhervorhebung. 

2. Alle Zellen, die mit einer farblichen Hinterlegung versehen worden sind, konn-

ten nicht konvertiert werden.  
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 Diese Zellen müssen von Hand nachbearbeitet werden. Vergleichen Sie ihren 

Inhalt mit dem der entsprechenden Zelle im Excel-Dokument. Versuchen Sie, 

die inkompatiblen Rechenfunktionen durch PlanMaker-Funktionen zu ersetzen. 

Ausführliche Informationen zu allen von PlanMaker unterstützten Rechenfunk-

tionen finden Sie im Abschnitt „Funktionen von A-Z“ ab Seite 522. 

3. Wenn alle Korrekturen erledigt sind, können Sie die Syntaxhervorhebung wie-

der ausschalten. 

Nun können Sie das überarbeitete Dokument gegebenenfalls noch im PlanMaker-

Format speichern. 

Warnmeldung beim Speichern eines Dokuments im Excel-Format 

Wenn Sie ein PlanMaker-Dokument im Excel-Format speichern, erscheint die fol-

gende Warnmeldung, falls das Dokument Rechenformeln enthält, die nicht Excel-

kompatibel sind: 

 

Gehen Sie dann wie folgt vor: 

1. Aktivieren Sie mit dem Menübefehl Ansicht > Syntaxhervorhebung die Syn-

taxhervorhebung. 

2. Korrigieren Sie alle Zellen, die nun mit einem farbigen Hintergrund gekenn-

zeichnet worden sind, von Hand. Versuchen Sie, für die darin verwendeten Re-

chenfunktionen eine entsprechende Excel-Funktion zu finden. Informationen 

dazu finden Sie in der Hilfe zur betreffenden Rechenfunktion. 

3. Wenn alle Korrekturen erledigt sind, können Sie die Syntaxhervorhebung wie-

der ausschalten. 

Speichern Sie das Dokument nun erneut im Excel-Format. Erscheint dabei keine 

Warnmeldung mehr, sind alle Inkompatibilitäten beseitigt. 
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Unterschiede zwischen PlanMaker und Excel 

In diesem Abschnitt finden Sie eine Liste aller Funktionen, die in PlanMaker und 

Microsoft Excel unterschiedlich implementiert sind: 

Allgemeines 

 PlanMaker kann in Excel-Dokumenten enthaltene Makros und VBA-Scripts 

nicht ausführen. Diese bleiben jedoch im Dokument erhalten und werden kor-

rekt abgespeichert, wenn Sie ein Dokument mit PlanMaker im Excel-Format 

speichern. 

Rechenfunktionen 

 Einige Rechenfunktionen von PlanMaker werden von Excel nicht unterstützt 

(und umgekehrt). Beim Öffnen oder Speichern einer Excel-Datei, die solche 

Funktionen enthält, erscheint daher automatisch ein entsprechender Hinweis. 

Siehe dazu Abschnitt „Öffnen und Speichern von Excel-Dokumenten“ ab Seite 

416. 

Operatoren 

 Bei Excel ist die Rangfolge der Operatoren für Potenzierung (^) und das nega-

tive Vorzeichen (-) fälschlicherweise vertauscht. PlanMaker verwendet hinge-

gen die korrekte Reihenfolge. So ergibt beispielsweise -1^2 in Excel 1, in 

PlanMaker hingegen das korrekte Ergebnis -1 (da die Potenzierung vor dem 

Vorzeichenwechsel durchgeführt werden muss). 

 PlanMaker löst dieses Kompatibilitätsproblem beim Öffnen/Speichern von 

Excel-Dateien jedoch automatisch, indem er den Operator ^ durch die Rechen-

funktion POTENZ ersetzt (die auch in Excel korrekt arbeitet). 
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Arbeiten mit arabischem Text 

Sie können in Ihren PlanMaker-Dokumenten auch arabische Schrift verwenden. In 

diesem Kapitel erfahren Sie alles Wissenswerte dazu. Es enthält folgende Ab-

schnitte: 

 Aktivieren der Unterstützung für arabischen Text 

 Ändern der Schreibrichtung in Tabellenzellen 

 Ändern der Schreibrichtung in Textrahmen 

 Ändern der Richtung von Arbeitsblättern 

Lesen Sie dazu die nächsten Seiten. 

Wichtig: Die in diesem Kapitel beschriebenen Funktionen stehen nur zur Verfü-

gung, wenn in den Einstellungen die Option Erweiterte Unterstützung für 

arabischen Text aktiviert wurde. Lesen Sie dazu den nächsten Abschnitt. 

Aktivieren der Unterstützung für arabischen 

Text 

PlanMaker verfügt über eine „erweiterte Unterstützung für arabischen Text“, die 

einige zusätzliche Funktionen für das Bearbeiten von Text in arabischer Schrift 

bereitstellt. 

Um diese Option zu aktivieren, gehen Sie wie folgt vor: 

1. Rufen Sie den Menübefehl Weiteres > Einstellungen auf. 

2. Wechseln Sie auf die Karteikarte Allgemein. 

3. Schalten Sie darin die Option Erweiterte Unterstützung für arabischen Text 

ein. 

Wichtig: Nur wenn diese Option aktiviert ist, stehen die auf den nächsten Seiten 

beschriebenen Funktionen zur Verfügung. 
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Ändern der Schreibrichtung in Tabellenzellen 

Ist die Option Erweiterte Unterstützung für arabischen Text in den Einstellun-

gen aktiviert, können Sie in einer Tabellenzelle jederzeit die Schreibrichtung zwi-

schen links-nach-rechts und rechts-nach-links umschalten. 

Gehen Sie dazu wie folgt vor: 

1. Rufen Sie in der Zelle den Menübefehl Format > Zelle auf. 

2. Wechseln Sie auf die Karteikarte Ausrichtung. 

3. Wählen Sie bei Schreibrichtung die gewünschte Option: kontextabhängig, 

links-nach-rechts oder rechts-nach-links. 

Tipp: Bei der Standardeinstellung Kontextabhängig ermittelt PlanMaker die ge-

eignete Schreibrichtung selbstständig: Wenn Sie in die Zelle also Text in Arabisch 

eingeben, wird die Schreibrichtung automatisch auf rechts-nach-links gesetzt, an-

dernfalls auf links-nach-rechts. 

Ändern der Schreibrichtung in Textrahmen 

In Textrahmen können Sie die Schreibrichtung für den aktuellen Absatz jederzeit 

zwischen links-nach-rechts und rechts-nach-links umschalten – sofern in den Ein-

stellungen die Option Erweiterte Unterstützung für arabischen Text aktiviert ist. 

Gehen Sie dazu wie folgt vor: 

1. Setzen Sie die Schreibmarke in den gewünschten Absatz des Textrahmens. 

2. Rufen Sie den Menübefehl Format > Absatz auf. 

3. Wechseln Sie auf die Karteikarte Absatz. 

4. Schalten Sie unter Schreibrichtung die Option Rechts nach links ein, um die 

Schreibrichtung auf rechts-nach-links zu setzen.  

 Schalten Sie die Option aus, wenn die Schreibrichtung auf links-nach-rechts 

gesetzt werden soll. 
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Tipp: Verwenden der Tastatur 

Viel schneller geht das Ändern der Schreibrichtung eines Absatzes in einem Text-

rahmen, wenn Sie dafür die folgenden Tastenkürzel verwenden: 

 Wenn Sie gleichzeitig (Strg) und die linke Umschalttaste (ª) drücken, wird die 

Schreibrichtung auf links-nach-rechts gesetzt. 

 Wenn Sie gleichzeitig (Strg) und die rechte Umschalttaste (ª) drücken, wird 

die Schreibrichtung auf rechts-nach-links gesetzt. 

Mac/Linux: Auf manchen Systemen (inklusive macOS und einigen Linux-Distri-

butionen) funktionieren diese Tastenkombinationen nicht. Hier können Sie alterna-

tiv die Tastenkombinationen (Strg)(ª)(A) (links-nach-rechts) und (Strg)(ª)(D) 

(rechts-nach-links) verwenden. 

Ändern der Richtung von Arbeitsblättern 

Ist die Option Erweiterte Unterstützung für arabischen Text in den Einstellun-

gen aktiviert, können Sie die Schreibrichtung eines Arbeitsblatts jederzeit ändern. 

Gehen Sie dazu wie folgt vor: 

1. Rufen Sie in dem Arbeitsblatt den Menübefehl Arbeitsblatt > Eigenschaften 

auf. 

2. Schalten Sie unter Schreibrichtung die Option Rechts nach links ein, um die 

Schreibrichtung auf rechts-nach-links zu setzen.  

 Schalten Sie die Option aus, wenn die Schreibrichtung auf links-nach-rechts 

gesetzt werden soll. 

Die Richtung des Arbeitsblatts ändert sich nun entsprechend.  

Wenn Sie die Schreibrichtung eines Arbeitsblatts also auf rechts-nach-links ändern, 

ist nicht mehr die Tabellenspalte ganz links die erste Spalte, sondern die Tabellen-

spalte ganz rechts.  

Die Tabelle wird also horizontal gespiegelt – wie in folgender Abbildung zu sehen: 

 

Links: Tabelle mit Schreibrichtung links-nach-rechts 
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Rechts: Tabelle mit Schreibrichtung rechts-nach-links 

Hinweis: Die Schreibrichtung jeder einzelnen Tabellenzelle lässt sich natürlich 

auch weiterhin individuell festlegen (wie weiter oben im Abschnitt „Ändern der 

Schreibrichtung in Tabellenzellen“ beschrieben). 
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Scripts (BasicMaker) 

Hinweis: BasicMaker ist nur unter Windows verfügbar und nicht in allen Versio-

nen von SoftMaker Office enthalten. 

FreeOffice: In SoftMaker FreeOffice ist BasicMaker nicht enthalten. 

Mit dem Programm BasicMaker können Sie Scripts in der Programmiersprache 

SoftMaker Basic schreiben und ausführen. SoftMaker Basic orientiert sich an Visu-

al Basic für Applikationen (VBA), der Programmiersprache von Microsoft Office. 

Mit Hilfe von Scripts lassen sich Arbeitsabläufe in der Textverarbeitung TextMaker 

und der Tabellenkalkulation PlanMaker automatisieren.  

Starten von BasicMaker 

Um BasicMaker zu starten oder ein BasicMaker-Script ausführen zu lassen, kön-

nen Sie eine der folgenden Vorgehensweisen verwenden: 

 BasicMaker über das Start-Menü starten 

 Sie können BasicMaker starten, indem Sie im Start-Menü auf Start > Pro-

gramme > SoftMaker Office > Hilfsprogramme > BasicMaker klicken. 

 BasicMaker von TextMaker/PlanMaker aus starten 

 Alternativ können Sie BasicMaker auch von TextMaker oder PlanMaker aus 

starten. Rufen Sie dazu in TextMaker/PlanMaker den Menübefehl Weiteres > 

Script bearbeiten auf. 

 Scripts von TextMaker/PlanMaker aus ausführen lassen 

 Um ein Script ausführen zu lassen, rufen Sie in TextMaker/PlanMaker den Me-

nübefehl Weiteres > Script starten auf. Es erscheint ein Dateidialog. Wählen 

Sie darin das Script, das ausgeführt werden soll, und bestätigen Sie mit OK. 

Alle weiteren Informationen zu BasicMaker und zum „Programmieren“ von Text-

Maker und PlanMaker finden Sie in der Online-Hilfe von BasicMaker, die Sie in 

BasicMaker über das Menü Hilfe aufrufen können. 
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Mehrere Dokumente gleichzeitig 

bearbeiten 

Sie können jederzeit mehrere Dokumente gleichzeitig geöffnet haben – um diese 

miteinander zu vergleichen, sie gleichzeitig zu bearbeiten, Daten zwischen ihnen 

auszutauschen etc.  

Folgendermaßen arbeiten Sie mit mehreren Dokumenten gleichzeitig: 

 Mehrere Dokumente im gleichen Programmfenster öffnen 

 Sie können im aktuellen Programmfenster beliebig viele Dokumente gleichzei-

tig geöffnet haben.  

 Zum Wechseln zwischen diesen Dokumenten gibt es zahlreiche Möglichkeiten, 

unter anderem eine Leiste mit Registerkarten für jedes momentan geöffnete 

Dokument, die über dem aktuellen Dokument angezeigt wird:  

 

 

FreeOffice: Die Funktionen zum Arbeiten mit Registerkarten für Dokumente 

sind in SoftMaker FreeOffice nicht enthalten. Sie können jedoch mehrere 

Dokumente in verschiedenen Programmfenstern öffnen. 

 Dokumente in einem neuen Programmfenster öffnen 

 Darüber hinaus können Sie Dokumente auf Wunsch auch in einem neuen Pro-

grammfenster öffnen. Dies ermöglicht es Ihnen, Dokumente beispielsweise ne-

beneinander auf dem Monitor zu platzieren.  

 Kreuzen Sie dazu im Dialogfenster des Menübefehls Datei > Neu oder Datei > 

Öffnen die Option Neues Programmfenster an, wenn Sie das Dokument anle-

gen/öffnen. (Hinweis: Diese Option steht in der Android-Version nicht zur Ver-

fügung.) 

Diese beiden Methoden lassen sich nach Belieben kombinieren. Sie können also 

beliebig viele Programmfenster öffnen und in jedem dieser Programmfenster wie-

derum beliebig viele Dokumente öffnen. Oder alle Dokumente in nur einem Pro-

grammfenster öffnen. Oder für jedes Dokument ein eigenes Programmfenster anle-

gen lassen. Ganz wie Sie möchten. 
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In diesem Kapitel erfahren Sie alles Wissenswerte zum Arbeiten mit mehreren Do-

kumenten gleichzeitig. Lesen Sie dazu die nächsten Seiten. 

Dokument neu anlegen oder öffnen 

Um ein Dokument neu anzulegen oder zu öffnen, gehen Sie wie folgt vor: 

 Zum Anlegen eines neuen Dokuments rufen Sie den Menübefehl Datei > Neu 

auf. 

 Zum Öffnen eines bestehenden Dokuments verwenden Sie den Menübefehl 

Datei > Öffnen. 

Diese beiden Befehle werden im Kapitel „Grundlagen“ (ab Seite 41) ausführlich 

beschrieben. 

Option „Neues Programmfenster“ 

Die Option Neues Programmfenster im Dialogfenster dieser beiden Befehle hat 

dabei folgende Bedeutung: Wenn sie eingeschaltet ist, erscheint das Dokument in 

einem neuen Programmfenster. Ist sie ausgeschaltet, wird das Dokument im beste-

henden Programmfenster geöffnet. 

Hinweis: Diese Option steht in der Android-Version nicht zur Verfügung. 

Wechseln zwischen geöffneten Dokumenten 

Wenn Sie mehrere Dokumente gleichzeitig geöffnet haben, stehen Ihnen folgende 

Möglichkeiten zur Verfügung, um zu einem bestimmten Dokument zu wechseln 

und es dadurch zum aktiven Dokument zu machen: 

 Menü: Menüeintrag „Fenster“ 

 Im Menü Fenster finden Sie eine Liste aller momentan geöffneten Dokumente. 

Wählen Sie darin den Eintrag für das Dokument, zu dem Sie wechseln möch-

ten. 
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 Ribbon: Symbol „Fenster wechseln“ 

 Im Ribbon finden Sie auf der Karteikarte Ansicht ein Symbol namens Fenster 

wechseln, das ähnlich funktioniert: Wenn Sie es anklicken, erscheint eine Liste 

aller geöffneten Dokumente. Klicken Sie darin das gewünschte Dokument an.  

 Maus: Anklicken der Registerkarte für das Dokument 

 Unter den Symbolleisten beziehungsweise dem Ribbon finden Sie eine Leiste 

mit Registerkarten für alle momentan geöffneten Dokumente. Klicken Sie darin 

die Registerkarte für das Dokument an, zu dem Sie wechseln möchten. 

 

 

FreeOffice: Die Funktionen zum Arbeiten mit Registerkarten für Dokumente 

sind in SoftMaker FreeOffice nicht enthalten. Sie können jedoch mehrere 

Dokumente in verschiedenen Programmfenstern öffnen. 

 Maus: Klicken in das Programmfenster mit dem Dokument 

 Wenn Sie Dokumente in mehreren Programmfenstern geöffnet haben (siehe 

vorheriger Abschnitt), können Sie natürlich auch einfach in das Programmfens-

ter mit dem gewünschten Dokument klicken, um dieses Dokument zum aktiven 

Dokument zu machen. 

 Tastatur: Strg+F6 

 Sie können auch die Tastatur verwenden, um zwischen den momentan geöffne-

ten Dokumenten zu wechseln: (Strg)(F6) wechselt zum nächsten Dokument und 
(Strg)(ª)(F6) zum vorherigen. 

 Mac: Beim Mac sind hierfür die Tasten (Cmd)(F6) und (Cmd)(ª)(F6) zu verwen-

den. 

 

Dokument schließen 

Wenn Sie die Arbeit an einem Dokument beenden möchten, können Sie dieses je-

derzeit schließen. Hierfür gibt es folgende Möglichkeiten: 

 Menü: Rufen Sie den Menübefehl Datei > Schließen auf, um das aktuelle Do-

kument zu schließen. 
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Tipp: Mit den Menübefehl Fenster > Alle schließen können Sie alle derzeit 

geöffneten Dokumente auf einmal schließen. 

 Ribbon: Die Karteikarte Datei enthält ein Symbol namens Schließen, mit dem 

sich aktuelle Dokument schließen lässt. 

 Registerkarten für Dokumente: Unter den Symbolleisten beziehungsweise 

dem Ribbon sehen Sie eine Leiste mit Registerkarten für alle momentan geöff-

neten Dokumente. Wenn Sie mit der mittleren Maustaste auf eine dieser Regis-

terkarten klicken, wird das entsprechende Dokument geschlossen. 

 

 

 Alternativ können Sie zum Schließen auch mit der linken Maustaste auf das x-

Symbol klicken, das ganz rechts in der Registerkarte angezeigt wird. 

 Außerdem: Wenn Sie mit der rechten Maustaste auf eine Registerkarte klicken, 

erscheint ein kleines Menü. Dieses enthält Befehle zum Schließen des aktuellen 

Dokuments oder aller anderen geöffneten Dokumente. 

FreeOffice: Die Funktionen zum Arbeiten mit Registerkarten für Dokumente 

sind in SoftMaker FreeOffice nicht enthalten. Sie können jedoch mehrere 

Dokumente in verschiedenen Programmfenstern öffnen. 

 Tastatur: Sie können weiterhin das Tastenkürzel (Strg)(F4) oder wahlweise 
(Strg)(W) verwenden, um das aktuelle Dokument zu schließen. 

 Mac: Beim Mac sind hierfür die Tasten (Cmd)(F4) beziehungsweise (Cmd)(W) zu 

verwenden. 

Wenn Sie ein Dokument schließen, das seit dem letzten Speichern verändert wurde, 

fragt das Programm zuvor automatisch nach, ob Sie das Dokument erst speichern 

möchten. 

Dokumente auf dem Bildschirm anordnen 

Android: Diese Funktion ist in der Android-Version nicht verfügbar. 

Wenn Sie Dokumente in mehreren Programmfenstern geöffnet haben, können Sie 

diese wie folgt auf dem Bildschirm anordnen: 
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 Sie können die einzelnen Programmfenster natürlich manuell verschieben und 

deren Größe ändern – genau so, wie dies bei allen Arten von Programmfenstern 

möglich ist. 

 Wenn Sie den Menübefehl Fenster > Nebeneinander anzeigen aufrufen, wer-

den das aktuelle Programmfenster und ein weiteres (bereits geöffnetes) Pro-

grammfenster nebeneinander auf dem Bildschirm angeordnet. Falls derzeit 

mehr als zwei Programmfenster geöffnet sind, fragt das Programm erst nach, 

welches andere Fenster verwendet werden soll. 

FreeOffice: Die Funktion Fenster nebeneinander anzeigen ist in SoftMaker 

FreeOffice nicht enthalten.  
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Anpassen von PlanMaker 

PlanMaker lässt Sie über eine Vielzahl von Programmeinstellungen bestimmen, so 

dass Sie das Programm ganz an Ihren persönlichen Arbeitsstil anpassen können: 

 Einstellungen von PlanMaker ändern 

 Mit dem Menübefehl Weiteres > Einstellungen können Sie die Programmein-

stellungen ändern. Diese gelten für das gesamte Programm, also für alle Do-

kumente. 

 Dokumenteigenschaften ändern 

 Die Dokumenteigenschaften sind hingegen Einstellungen, die nur das aktuelle 

Dokument betreffen und auch in diesem gespeichert werden. Sie können mit 

dem Menübefehl Datei > Eigenschaften geändert werden. 

 Arbeitsblatteigenschaften ändern 

 Die Arbeitsblatteigenschaften sind schließlich Einstellungen, die für jedes Ar-

beitsblatt eines Dokuments anders eingestellt werden können. Sie können mit 

dem Menübefehl Arbeitsblatt > Eigenschaften geändert werden. 

 Bildschirmdarstellung ändern 

 In diesem Abschnitt wird beschrieben, wie Sie die Darstellung des Dokuments 

auf dem Bildschirm anpassen können. Die meisten dazu benötigten Befehle 

finden Sie im Menü Ansicht. 

 Symbolleisten anpassen 

 Nur bei „klassischen Menüs und Symbolleisten“: Dieser Abschnitt betrifft 

nur Anwender, die in den Einstellungen ausgewählt haben, dass sie das Pro-

gramm mit „klassischen Menüs und Symbolleisten“ bedienen möchten.  

 Sie erfahren hier, wie Sie die Symbolleisten (Funktionsleiste, Formatleiste etc.) 

mit dem Menübefehl Ansicht > Symbolleisten konfigurieren und mit Weiteres 

> Anpassen nach Ihren Wünschen anpassen können.  

 Ribbon (Menüband) anpassen 

 Nur bei „Ribbons“: Dieser Abschnitt ist hingegen nur für Anwender interes-

sant, die in den Einstellungen ausgewählt haben, dass sie das Programm lieber 

mit dem „Ribbon“ (Menüband) bedienen möchten.  

 Sie erfahren hier, wie Sie das Ribbon konfigurieren und anpassen können. 
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 Benutzerdefinierte Symbole erstellen 

 Sie können jederzeit benutzerdefinierte Symbole anlegen und diese dann einer 

Symbolleiste oder dem Ribbon hinzufügen. Mit solchen Symbolen lassen sich 

beliebige Programme starten. 

 Tastenkürzel anpassen 

 Auch die Tastenkürzel für das Aufrufen häufig benötigter Befehle lassen sich 

anpassen. Hierfür ist abermals der Menübefehl Weiteres > Anpassen zustän-

dig. 

 Listen für das automatische Füllen editieren 

 Mit dem Menübefehl Weiteres > Listen editieren können Sie eigene Listen für 

die Funktion Ausfüllen herstellen. 

 Installieren zusätzlicher Wörterbücher 

 In diesem Abschnitt erfahren Sie, wie Sie bei Bedarf zusätzliche Wörterbücher 

(zum Beispiel Hunspell) installieren können. 

Ausführliche Informationen zu diesen Themen folgen auf den nächsten Seiten. 

Einstellungen von PlanMaker ändern 

Allgemeine Einstellungen lassen sich mit dem Menübefehl Weiteres > Einstel-

lungen ändern. Diese Einstellungen gelten für alle Dokumente. 

Die Optionen im Dialogfenster dieses Befehls sind nach Themen geordnet auf 

mehrere Karteikarten verteilt. Klicken Sie beispielsweise auf den Karteikartenreiter 

Dateien, können Sie Einstellungen zum Öffnen und Speichern von Dateien vor-

nehmen. 

Auf den nächsten Seiten finden Sie detaillierte Erläuterungen aller verfügbaren 

Einstellungen. 

Einstellungen, Karteikarte Ansicht 

Auf der Karteikarte Ansicht im Dialogfenster des Menübefehls Weiteres > Ein-

stellungen können Sie Einstellungen zum Aussehen von Tabellen vornehmen: 
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Anzeiger 

Hier können Sie das Aussehen der kleinen Dreiecke ändern, die in Zellen angezeigt 

werden, die einen Kommentar enthalten oder geschützt sind: 

 Farbe der Kommentaranzeiger 

 Ändert die Farbe des kleinen Dreiecks, das in Zellen angezeigt wird, wenn die-

se einen Kommentar enthalten. 

 Farbe der Schutzanzeiger 

 Ändert die Farbe des kleinen Dreiecks, das bei aktiviertem Blattschutz in allen 

Zellen angezeigt wird, die nicht geschützt sind. 

 Größe 

 Ändert die Größe obiger Anzeiger. 

Ausrichten 

FreeOffice: Die Funktionen zum Ausrichten sind in SoftMaker FreeOffice 

nicht enthalten. 

Hier können Sie die verfügbaren Positionierungshilfen für das Verschieben von 

Objekten (Textrahmen, Grafikrahmen etc.) mit der Maus konfigurieren: 

 An Zellen ausrichten 

 Diese Option ist normalerweise ausgeschaltet. Wenn Sie Objekte mit der Maus 

verschieben, lassen sich diese also frei bewegen.  

 Schalten Sie die Option hingegen ein, springen Objekte beim Verschieben mit 

der Maus von Tabellenzelle zu Tabellenzelle.  

 Diese Funktion temporär aktivieren oder deaktivieren: Wenn die Option An Zellen 

ausrichten eingeschaltet ist, können Sie diese jederzeit temporär deaktivieren, 

indem Sie beim Verschieben eines Objekts mit der Maus die Taste (Alt) drü-

cken und gedrückt halten. Das gleiche geht auch umgekehrt: Ist die Option de-

aktiviert, kann sie mit der Taste (Alt) während des Verschiebens temporär akti-

viert werden. 

 An anderen Objekten ausrichten 

 Wenn diese Option eingeschaltet ist, erzeugt das Programm automatisch „magi-

sche“ Hilfslinien für die Kanten von jedem Objekt im aktuellen Arbeitsblatt. 
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Diese erleichtern das bündige und gleichmäßige Platzieren von Objekten erheb-

lich.  

 Diese „magischen“ Hilfslinien sind normalerweise unsichtbar. Sie zeigen sich 

erst, wenn Sie ein Objekt mit der Maus in die Nähe einer solchen Hilfslinie zie-

hen. Die Linie wird dann sichtbar, und das Objekt springt automatisch darauf. 

Ähnliches passiert beim Ändern der Größe eines Objekts mit der Maus.  

 Einige Beispiele für solche Hilfslinien:  

 Ziehen Sie ein Objekt an eine Position, an der seine linke Kante ungefähr 

bündig mit einem vorhandenen Objekt ist, erscheint automatisch eine Hilfs-

linie, die für die linke Kante des anderen Objekts steht. Lassen Sie Ihr Ob-

jekt darauf springen, wird es exakt linksbündig zu dem vorhandenen Objekt 

ausgerichtet. 

 Entsprechendes gilt auch für die rechte Kante von Objekten.  

 Ziehen Sie ein Objekt an eine Position, an der es ungefähr zentriert zu ei-

nem vorhandenen Objekt ist, erscheint automatisch eine Hilfslinie, die für 

das Zentrum des vorhandenen Objekts steht. Lassen Sie Ihr Objekt darauf 

springen, wird es exakt zentriert zu dem vorhandenen Objekt ausgerichtet. 

 Ziehen Sie ein Objekt unter zwei andere Objekte, erscheint außerdem eine 

horizontale Hilfslinie genau dort, wo dieses dritte Objekt den gleichen Ab-

stand wie die beiden anderen Objekte zueinander hätte. (Die drei Objekte 

wären dann also gleichmäßig verteilt.)  

 All dies funktioniert in beide Richtungen (horizontal und vertikal) – es wird 

also beispielsweise auch für die obere und untere Kante jedes Objekts eine ma-

gische Hilfslinie generiert.  

 Toleranz 

 Hier können Sie die Toleranz für die Option An anderen Objekten ausrichten 

ändern. Je höher der eingestellte Wert, umso eher springt ein Objekt beim Ver-

schieben auf eine der „magischen“ Hilfslinien um die vorhandenen Objekte. 

 Der Standardwert ist eine Entfernung von 8 Pixeln. 

Gitternetzlinien hinter den Zellen zeichnen 

Schalten Sie diese Option ein, werden die grauen Gitternetzlinien, die auf dem 

Bildschirm zwischen den Zellen angezeigt werden, im Hintergrund der Zellen (und 

nicht mehr im Vordergrund) gezeichnet. Dies bewirkt, dass bei Zellbereichen, die 
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mit einem farbigen Hintergrund versehen wurden, keine Gitternetzlinien mehr zu 

sehen sind. 

Zellmarkierung 

Hier können Sie die Farbe und Liniendicke des Zellrahmens ändern. Das ist der 

dunkle Rahmen, der die momentan aktive Zelle im Arbeitsblatt kennzeichnet: 

 

Arbeitsblattregister 

Im Arbeitsblattregister am unteren Rand des Dokumentfensters werden Register-

karten für alle im aktuellen Dokument vorhandenen Arbeitsblätter angezeigt. 

Hier können Sie einstellen, in welcher Schriftgröße die Namen der Arbeitsblätter 

darin angezeigt werden sollen. 

Einstellungen, Karteikarte Allgemein 

Auf der Karteikarte Allgemein im Dialogfenster des Menübefehls Weiteres > Ein-

stellungen können Sie allgemeine Einstellungen zu PlanMaker vornehmen: 

Schaltfläche „Benutzerdaten“ 

Hier können Sie Ihre persönlichen Daten (Name, Adresse etc.) angeben. Diese An-

gaben können dann mit der Funktion BENUTZERFELD in die Tabelle eingefügt 

werden. 

Maximal widerrufbare Aktionen 

Hier können Sie einstellen, wie viele Aktionen sich mit dem Menübefehl Bearbei-

ten > Rückgängig maximal widerrufen lassen. Sie können diese Einstellung auf 

maximal 999 erhöhen.  

Hinweis: Das Programm verbraucht mehr Hauptspeicher, wenn Sie diesen Wert 

erhöhen. Auf Geräten mit wenig Speicher sollte hier also kein allzu hoher Wert 

eingestellt werden. 
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Informationen zum Befehl Rückgängig finden Sie im Abschnitt „Änderungen 

rückgängig machen“ ab Seite 70. 

Erweiterte Unterstützung für asiatische Schriften 

Hinweis: Das Einschalten dieser Option wirkt sich nur auf die Schriftauswahl in 

Textrahmen aus. In Tabellenzellen kann immer nur eine Schrift gewählt werden. 

Ist diese Option aktiviert, erscheinen – nur bei Text in einem Textrahmen – im Dia-

logfenster des Menübefehls Format > Zeichen nicht nur eine, sondern drei Listen 

zur Auswahl von Schriftart, Schriftgröße, Schriftstil und Sprache: 

 Für lateinische Schriftzeichen (z.B. Deutsch, Englisch) 

 Für ostasiatische Schriftzeichen (Chinesisch, Japanisch, Koreanisch) 

 Für komplexe Schriftzeichen (z.B. Arabisch) 

Sie können diese Einstellungen in Textrahmen also für jede Art von Schriftzeichen 

getrennt vornehmen.  

Setzen Sie beispielsweise die Schriftart für lateinische Zeichen auf „Arial“ und die 

Schriftart für asiatische Zeichen auf „SimHei“, erscheinen alle lateinischen Zei-

chen, die Sie eintippen, automatisch in Arial und alle asiatischen Zeichen in Sim-

Hei. 

PlanMaker erkennt dabei selbsttätig, ob es sich bei den eingegebenen Zeichen um 

lateinische, asiatische oder komplexe (z.B. arabische) Schriftzeichen handelt. 

Erweiterte Unterstützung für arabischen Text 

Wenn Sie diese Option aktivieren, werden einige zusätzliche Funktionen für das 

Bearbeiten von Text in arabischer Schrift verfügbar. Informationen dazu finden Sie 

im Kapitel „Arbeiten mit arabischem Text“ (ab Seite 419). 

Warnung beim Laden von OLE-Objekten 

Nur bei Mac, Linux und Android: Ist diese Option eingeschaltet, erscheint beim 

Öffnen eines Dokuments, das OLE-Objekte enthält, eine Warnmeldung. Diese 

Meldung soll Sie darauf hinweisen, dass diese Objekte nicht angezeigt werden 

können, da OLE-Objekte nur unter Windows funktionieren. 
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Einstellungen, Karteikarte Bearbeiten 

Auf der Karteikarte Bearbeiten im Dialogfenster des Menübefehls Weiteres > 

Einstellungen können Sie Einstellungen zum Bearbeiten von Tabellenzellen vor-

nehmen: 

Markierung nach Eingabe ... bewegen 

Bestimmt, in welche Richtung sich der Zellrahmen (der dunkle Rahmen, der auf 

dem Bildschirm die aktuelle Zelle kennzeichnet) bewegen soll, wenn Sie etwas in 

die Zelle eingeben und die Eingabetaste (¢) betätigen. 

Zelle direkt in der Tabelle editieren 

Diese Option ist standardmäßig eingeschaltet. Sie können den Inhalt einer Zelle 

nach dem Drücken der Taste (F2) also direkt in der Tabelle editieren. Schalten Sie 

die Option aus, lässt sich der Zellinhalt mit (F2) nur noch in der Bearbeitungsleiste 

editieren, die oberhalb des Dokuments angezeigt wird. 

Automatische Prozentwerteingabe 

Bestimmt das Verhalten von PlanMaker beim Eintippen von Zahlen in Zellen, die 

Prozentwerte enthalten oder im Zahlenformat „Prozent“ formatiert sind. Ist diese 

Option aktiviert, wird Ihrer Eingabe dabei automatisch ein Prozentzeichen ange-

fügt. 

Zellen automatisch vervollständigen 

Wenn diese Option aktiviert ist, macht PlanMaker beim Eintippen von Text in eine 

Zelle automatisch Vorschläge aus den Texteinträgen in den Zellen oberhalb und 

unterhalb dieser Zelle. 

Ein Beispiel: Sie haben in drei Tabellenzellen untereinander „New York“, „Rio“ 

und „Tokyo“ eingetragen. Wenn Sie nun in der Zelle unterhalb dieser Einträge ein 

„N“ eintippen, schlägt das Programm automatisch „New York“ vor. Tippen Sie 

hingegen ein „T“ ein, wird „Tokyo“ vorgeschlagen etc. 
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Um den Vorschlag zu übernehmen, drücken Sie die Eingabetaste (¢). Um ihn ab-

zulehnen, tippen Sie einfach weiter oder drücken die Taste (Entf). 

Falls Sie nicht möchten, dass PlanMaker beim Tippen solche Vorschläge macht, 

können Sie diese Option jederzeit ausschalten. 

Zellbearbeitung wird nie mit linker Pfeiltaste verlassen 

Diese Option bestimmt, was passieren soll, wenn Sie eine Zelle ansteuern, einen 

Wert eintippen und dann die Pfeiltaste (æ) betätigen: 

 Ein: Die Schreibmarke wird nach links bewegt (innerhalb Ihrer Eingabe). 

 Aus: Der Zellrahmen wird nach links bewegt. Der eingegebene Wert wird also 

übernommen, und die Zelle links von der aktuellen Zelle wird zur aktiven Zelle 

gemacht. 

Meldung bei fehlerhaften Formeln 

Wenn Sie eine Formel eingeben, die fehlerhaft formuliert ist (weil beispielsweise 

eine schließende Klammer fehlt), gibt PlanMaker eine Fehlermeldung aus, sobald 

Sie Ihre Eingabe mit der Eingabetaste (¢) abschließen. Wünschen Sie dies nicht, 

schalten Sie diese Option ab. 

Hinweis: Unabhängig von dieser Option werden fehlerhafte Formeln beim Spei-

chern stets durch den Text #FEHLER! ersetzt. 

Quickinfos für Formeln 

Wenn diese Option aktiviert ist, erscheint bei der manuellen Eingabe von Rechen-

funktionen in eine Zelle automatisch ein kleines Infofenster unter der Tabellenzel-

le. Dieses listet alle Parameter, die von der Funktion benötigt werden. 

Zeichenformatierung auf das ganze Wort anwenden 

Wenn diese Option aktiviert ist, hat das folgende Auswirkungen: 
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Wenn sich die Schreibmarke innerhalb eines Wortes befindet und Sie die Zeichen-

formatierung ändern (also beispielsweise eine andere Schrift wählen oder Fett-

druck einschalten), wirkt sich dies auf das komplette Wort aus.  

So können Sie schnell die Formatierung eines einzelnen Wortes ändern, ohne die-

ses erst markieren zu müssen. 

Rahmen und Zeichnungen direkt einfügen 

Diese Option bestimmt, was passieren soll, wenn Sie einen Rahmen (Textrahmen, 

Grafikrahmen etc.) oder eine Zeichnung in ein Dokument einfügen – zum Beispiel 

mit dem Menübefehl Objekt > Neuer Textrahmen: 

 Ein: Das entsprechende Objekt wird sofort eingefügt. Seine Position und Größe 

werden dabei automatisch vorgegeben.  

 (Sie können das Objekt nach dem Einfügen natürlich nach Belieben verschie-

ben, indem Sie es mit der Maus an die gewünschte Position ziehen. Auch kön-

nen Sie seine Größe ändern, indem Sie an einem der runden Greifer ziehen, die 

das Objekt umgeben.)  

 Aus: Bevor das Objekt tatsächlich eingefügt wird, ändert sich der Mauszeiger 

in ein Fadenkreuz. Um fortzufahren, ziehen Sie mit der Maus ein Rechteck im 

Dokument auf, um die gewünschte Position und Größe festzulegen. Das Objekt 

wird dann genau nach Ihren Vorgaben eingefügt. 

Tabellen automatisch erweitern 

Wie im Abschnitt „Tabellen in Tabellen“ (Seite 145) beschrieben, bietet Ihnen der 

Menübefehl Arbeitsblatt > Neue Tabelle die Möglichkeit, „Tabellen in Tabellen“ 

anzulegen.  

Diese Option hat folgende Auswirkung auf solche Tabellen: 

 An: Wenn Sie in eine der Zellen direkt rechts neben der Tabelle etwas eintip-

pen, erweitert sich die Tabelle automatisch um eine Spalte. Das gleiche gilt für 

Zeilen: Wenn Sie etwas in eine Zelle direkt unterhalb der Tabelle eintippen, er-

weitert sich diese automatisch um eine Zeile. 

 Aus: Die Tabelle erweitert sich nicht automatisch. 
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Mittlere Maustaste 

Nur bei Mac und Linux: Diese Option bestimmt, was passieren soll, wenn Sie 

einen Mausklick mit der mittleren Maustaste durchführen. Verfügbare Optionen: 

 Nichts: Die mittlere Maustaste hat keine Funktion. 

 Markierten Inhalt einfügen: Wenn Sie mit der mittleren Maustaste in das 

Dokument klicken, wird an dieser Stelle eine Kopie des aktuellen Inhalts der 

Selektion eingefügt (also beispielsweise der momentan selektierte Text). 

Textbausteine automatisch ersetzen 

Wie im Abschnitt „Textbausteine“ ab Seite 361 beschrieben, können Sie mit Plan-

Maker Textbausteine anlegen (z.B. „Lst“ für „Lohnsteuer“).  

Wenn diese Option eingeschaltet ist, können Textbausteine direkt bei der Textein-

gabe ausgelöst werden. Dazu muss einfach das Kürzel für den Baustein (z.B. 

„Lst“) und dann Leertaste, Eingabetaste oder ein Satzzeichen getippt werden, wo-

rauf PlanMaker das Kürzel automatisch durch den Inhalt des Bausteins ersetzt.  

Ist die Option deaktiviert, können Textbausteine hingegen nur über den Menübe-

fehl Einfügen > Textbaustein abgerufen werden. 

Linke Alt-Taste für Tastenkürzel verwenden 

Nur beim Mac: Diese Option bestimmt, welche Funktion die linke Alt-Taste Ihrer 

Tastatur haben soll: 

 Aus: Die linke Alt-Taste macht das Gleiche wie die rechte Alt-Taste: Sie fügt 

Symbole in den Text ein. 

 (Alt)(E) liefert beispielsweise ein Eurozeichen. 

 Ein: Die linke Alt-Taste kann dazu verwendet werden, Menüs im klassischen 

Menü zu öffnen. (Hinweis: Dies funktioniert nur, wenn Sie das Programm mit 

klassischen Menüs anstelle des Ribbons verwenden.) 

 (Alt)(E) liefert dann kein Eurozeichen mehr, sondern öffnet stattdessen das 

Einfügen-Menü. 
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Trennzeichen für Zahlen 

Hier können Sie einstellen, welches Zeichen als Dezimaltrenner und welches als 

Tausendertrenner für Zahlen verwendet werden soll. 

Erläuterung: Der Dezimaltrenner ist das Zeichen, das man zwischen die Vor- und 

die Nachkommastellen einer Zahl setzt (z.B. das Komma in 17,50). Der Tausender-

trenner ist das Zeichen, das zum Gruppieren langer Ziffern verwendet werden kann 

(z.B. die Punkte in 1.000.000). 

 Bei der Einstellung Aus Systemeinstellung verwendet PlanMaker automatisch 

das Dezimaltrennzeichen und Tausendertrennzeichen, das in den Systemeinstel-

lungen Ihres Rechners festgelegt ist. (Dies ist die Standardeinstellung.) 

 Wählen Sie hingegen Benutzerdefiniert, können Sie selbst angeben, welche 

Zeichen als Dezimaltrenner und Tausendertrenner verwendet werden sollen. 

Warnung: Wenn Sie hier manuelle Einstellungen vornehmen, die fehlerhaft 

sind, können Berechnungen ungültige oder falsche Ergebnisse liefern! 

Online-Berechnung in Statuszeile 

Wenn Sie mehrere Zellen markieren, wird in der Statuszeile automatisch eine „On-

line-Berechnung“ für diese Zellen angezeigt – zum Beispiel die Summe der Zellen. 

Mit dieser Option können Sie bestimmen, welche Berechnung dort angezeigt wer-

den soll. 

Einstellungen, Karteikarte Aussehen 

Auf der Karteikarte Aussehen im Dialogfenster des Menübefehls Weiteres > Ein-

stellungen können Sie Einstellungen vornehmen, die das Aussehen der Benutzer-

oberfläche von PlanMaker betreffen: 

Dialogsprache 

Hier können Sie die Sprache wählen, in die Benutzeroberfläche (Menüs, Dialoge 

etc.) angezeigt werden soll.  
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Benutzeroberfläche 

Wenn Sie die Schaltfläche Benutzeroberfläche anklicken, erscheint ein Dialog, in 

dem Sie wählen können, welche Art von Benutzeroberfläche die Programme von 

SoftMaker Office nutzen sollen: 

 Ribbon (obere Zeile) 

 Wenn Sie einen der Einträge aus der oberen Zeile auswählen, verwenden die 

Programme ein „Ribbon“ (also ein Menüband) als Benutzeroberfläche, wie dies 

einige moderne Windows-Applikationen tun. (Die Unterschiede zwischen den 

einzelnen Einträgen liegen nur in der Farbgebung.) 

 Klassische Menüs und Symbolleisten (untere Zeile) 

 Wenn Sie einen der Einträge aus der unteren Zeile auswählen, verwenden die 

Programme klassische Menüs und Symbolleisten. (Auch hierfür werden mehre-

re verschiedene Farbvarianten angeboten.) 

Darüber hinaus lassen sich in dem Dialog noch folgende Einstellungen vornehmen: 

 Schnellzugriffsleiste 

 Nur bei Ribbons: Bestimmt, wo die Schnellzugriffsleiste, die Symbole für ei-

nige besonders häufig benötigte Befehle enthält, angezeigt werden soll: links 

von den Registerkarten für die momentan geöffneten Dokumente – oder in ei-

ner eigenen Leiste direkt unter dem Ribbon. 

 Fingereingabemodus 

 Wenn Sie diese Option aktivieren, werden alle Symbole im Ribbon bezie-

hungsweise in Menüs und Symbolleisten leicht vergrößert. Dies ist nützlich, 

wenn Sie die Software mit dem Finger bedienen (beispielsweise auf einem Tab-

let). 

 Tipp: Sie können den Fingereingabemodus alternativ auch mit folgenden Be-

fehlen ein-/ausschalten: 

 Menü: Befehl Ansicht > Fingereingabemodus 

 Schnellzugriffsleiste: Befehl Fingereingabemodus  

Schriftenliste mit echten Schriften 

Ist diese Option aktiviert, zeigt PlanMaker in Schriftenlisten (zum Beispiel der 

Schriftenliste in der Formatleiste) alle Schriftnamen in der jeweiligen Schriftart an. 

So können Sie gleich sehen, wie die Schriften tatsächlich aussehen.  
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Quickinfos 

Bestimmt, ob Quickinfos angezeigt werden sollen. 

Bei den Quickinfos handelt es sich um kurze Infotexte, die neben dem Mauszeiger 

angezeigt werden, wenn Sie mit der Maus auf ein Bildschirmelement wie bei-

spielsweise eine Schaltfläche in der Funktionsleiste zeigen.  

Warnton bei Meldungen 

Ist diese Option aktiviert, gibt PlanMaker bei Hinweis- und Fehlermeldungen einen 

Signalton aus. 

Echtzeitvorschau 

FreeOffice: Die Echtzeitvorschau ist in SoftMaker FreeOffice nicht enthalten. 

Hier können Sie eine Echtzeitvorschau für die aufklappbaren Listen in der Format-

leiste ein-/ausschalten.  

Ist diese aktiviert, können Sie beispielsweise Text markieren, die Schriftenliste in 

der Formatleiste öffnen und dann mit der Maus über die Schriftarten darin fahren. 

Sofort wird „in Echtzeit“ im Dokument angezeigt, wie der markierte Text in der 

entsprechenden Schrift aussehen würde. 

Um die Schrift dann tatsächlich anzuwenden, klicken Sie sie einfach an. Um die 

Änderung zu verwerfen, klicken Sie auf eine beliebige Stelle außerhalb der Schrif-

tenliste oder drücken die Taste (Esc).  

Systemmenüs verwenden 

Nur beim Mac: Diese Option bestimmt, ob das Programm sein Hauptmenü in der 

Menüleiste am oberen Bildschirmrand anzeigen soll (wie dies bei Mac-

Anwendungen üblich ist) oder nicht. 

Je nachdem, welche Art von Benutzeroberfläche Sie ausgewählt haben („Ribbon“ 

oder „Klassische Menüs und Symbolleisten“), hat diese Option folgende Auswir-

kung:  

 Aus: Das Hauptmenü wird nicht in der Menüzeile am oberen Bildschirmrand 

angezeigt.  

 Details: 
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 Klassische Menüs und Symbolleisten: Bei der klassischen Benutzerober-

fläche wird das Hauptmenü nun nicht mehr am oberen Bildschirmrand, 

sondern in seiner eigenen Leiste (unterhalb der Titelleiste) angezeigt. 

 Ribbon: Wenn Sie als Benutzeroberfläche das „Ribbon“ ausgewählt haben, 

steht Ihnen nun lediglich das „Hamburgermenü“ (das Symbol  in der 

Schnellzugriffsleiste) zur Verfügung, falls Sie doch einmal auf das klassi-

sche Hauptmenü zugreifen möchten. 

 Ein: Das Hauptmenü wird in der Menüzeile am oberen Bildschirmrand ange-

zeigt.  

 Details: 

 Klassische Menüs und Symbolleisten: Das Hauptmenü wird nun in der 

Menüleiste am oberen Bildschirmrand angezeigt – und nicht in seiner eige-

nen Leiste unterhalb der Titelleiste. 

 Ribbon: Ribbon-Anwender haben nun nicht nur Zugriff auf die Ribbon-

Benutzeroberfläche, sondern können bei Bedarf zusätzlich das klassische 

Menü in der Menüleiste verwenden. 

System-Dateidialoge verwenden 

Nur bei Windows, Mac und Linux: Diese Option bestimmt, welche Art von Dia-

logen bei Befehlen, die mit dem Öffnen und Speichern von Dateien zu tun haben, 

erscheinen sollen: 

 Aus: Es erscheinen PlanMakers eigene Dateidialoge. 

 Ein: Es erscheinen die Standard-Dateidialoge des Betriebssystems, wie Sie sie 

von den meisten anderen Applikationen her kennen. 

Erstere sind etwas übersichtlicher, letztere bieten mehr Optionen. 

Bildschirmschriftarten glätten 

Wenn Sie diese Option aktivieren, wendet PlanMaker eine Technologie an, die die 

Kanten von Schriften auf dem Bildschirm glättet und so das Schriftbild verbessert 

– das sogenannte „Antialiasing“. 

Je nach Betriebssystem stehen unterschiedliche Optionen zur Verfügung. 
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Hintergrundfarbe des Programms 

Hier können Sie die Hintergrundfarbe für Dokumentfenster ändern. 

Größe der Benutzeroberfläche 

Nur bei Mac, Linux und Android: Diese Schaltfläche öffnet einen Dialog, mit 

dem Sie die Benutzeroberfläche (Menü, Symbolleisten, Dialoge etc.) des Pro-

gramms verkleinern oder vergrößern können.  

Wählen Sie hier eine kleinere Einstellung, werden alle Bedienelemente verkleinert, 

was für mehr Übersicht sorgt. Eine größere Einstellung hingegen erhöht die Les-

barkeit. 

Die Option Größe der Dialogelemente ändert die Größe der Benutzeroberfläche 

dabei in groben Schritten. Die Option Anpassung der Schriftgröße erlaubt zusätz-

lich etwas „Feintuning“ in kleineren Schritten.  

Als kleine Hilfe zeigt Ihnen das Feld Beispiel an, wie groß beispielsweise ein Kon-

trollkästchen in einem Dialog nach dem Anwenden Ihrer Änderungen aussehen 

würde. 

Hinweis: Bei ungeeigneten Einstellungen kann es passieren, dass die Benutzer-

oberfläche deutlich zu klein oder zu groß dargestellt wird, insbesondere auf Ge-

räten mit einer relativ niedrigen Auflösung. Falls dies passieren sollte, können 

Sie jederzeit die Schaltfläche Zurücksetzen in der linken unteren Ecke dieses 

Dialogs betätigen, um zu den Standardeinstellungen zurückzukehren. 

Maßeinheit 

Nur bei Mac, Linux und Android: Hier können Sie einstellen, welche Maßein-

heiten PlanMaker standardmäßig verwenden soll: Metrisch (Zentimeter) oder U.S. 

(Zoll). 

(Unter Windows ist diese Option nicht erforderlich, da das Programm dort automa-

tisch die Einstellung übernimmt, die in den Regions- und Sprachoptionen der Sys-

temsteuerung von Windows gewählt wurde.) 

Tipp: Unabhängig von dieser Einstellung können Sie in Dialogen jederzeit Werte in 

anderen Maßeinheiten eingeben, indem sie hinter dem Wert eine der folgenden 

Maßeinheiten eintippen: 
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Einheit Bemerkung 

cm Zentimeter 

in Inch (Zoll) – 1 in entspricht 2,54 cm. 

pt Punkt – 72 pt entsprechen 1 in. 

pi Pica (Zeichen) 

Tippen Sie also beispielsweise für den linken Seitenrand „2 in“ ein, setzt PlanMa-

ker diesen auf 2 Zoll (=5,08 cm). 

Einstellungen, Karteikarte Sprache 

Auf der Karteikarte Sprache im Dialogfenster des Menübefehls Weiteres > Ein-

stellungen können Sie Einstellungen zu Rechtschreibprüfung und Silbentrennung 

vornehmen: 

Sprache 

Hier legen Sie die Sprache für Rechtschreibprüfung und Silbentrennung fest. Öff-

nen Sie die Liste dazu und wählen Sie die gewünschte Sprache darin aus. 

Hinweis: Beachten Sie dabei, dass es für Deutsch jeweils zwei Einträge in dieser 

Liste gibt:  

 „Deutsch (Deutschland)“ steht für die neue Rechtschreibung (gemäß der so-

genannten „Rechtschreibreform“ von 1996 in ihrer letzten Überarbeitung von 

2006). 

 „Deutsch (Deutschland, alt)“ steht hingegen für die alte Rechtschreibung. 

Entsprechendes gilt für „Deutsch (Österreich)“ und „Deutsch (Schweiz)“. 

Rubrik „Rechtschreibprüfung“ 

Hier können Sie folgende Einstellungen zur Rechtschreibprüfung vornehmen: 

 Rechtschreibkorrektur während des Tippens 

 Wenn Sie diese Option aktiveren, prüft PlanMaker die Rechtschreibung bereits 

während der Eingabe von Text. Bei Tippfehlern erscheint sofort ein Dialogfens-
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ter zur Korrektur. Siehe dazu Abschnitt „Rechtschreibprüfung während des 

Tippens“ ab Seite 357. 

 Hinweis: Wenn diese Option ausgeschaltet ist, müssen Sie natürlich nicht gänz-

lich auf eine Rechtschreibprüfung verzichten – Sie können diese jederzeit mit 

dem Menübefehl Weiteres > Rechtschreibprüfung manuell starten. Siehe da-

zu Abschnitt „Rechtschreibprüfung nachträglich“ ab Seite 355. 

 Warnton bei Tippfehlern 

 Diese Option bestimmt, ob PlanMaker einen Signalton ausgeben soll, wenn die 

Rechtschreibkorrektur während des Tippens ein unbekanntes Wort findet. 

 Ignoriere Wörter, die mit einer Zahl beginnen 

 Wenn Sie diese Option aktivieren, ignoriert die Rechtschreibprüfung alle Wör-

ter, die mit einer Zahl beginnen (zum Beispiel „1980er“). 

 Hunspell-Wörterbücher 

FreeOffice: Bei SoftMaker FreeOffice sind die in SoftMaker Office nor-

malerweise enthaltenen hochwertigen SoftMaker-Wörterbücher nicht verfüg-

bar. Hier können ausschließlich Hunspell-Wörterbücher verwendet werden.  

Hunspell-Wörterbücher für Deutsch und Englisch sind bereits vorinstalliert. 

Falls Sie weitere Sprachen benötigen, lesen Sie bitte den Abschnitt 

„Installieren von Hunspell-Wörterbüchern“.  

 Nur bei Windows, Mac und Linux: Neben seinen eigenen Wörterbüchern 

unterstützt SoftMaker Office auch die Verwendung von Hunspell-

Wörterbüchern. Diese sind als kostenlose Downloads erhältlich. Sie wurden 

größtenteils von engagierten Anwendern und nicht-kommerziellen Einrichtun-

gen erstellt.  

 Mit der Schaltfläche Hunspell-Wörterbücher können Sie heruntergeladene 

Hunspell-Wörterbücher installieren und außerdem einstellen, für welche Spra-

chen Hunspell-Wörterbücher verwendet werden sollen. 

 Siehe dazu Abschnitt „Installieren zusätzlicher Wörterbücher“ (ab Seite 497). 

Einstellungen, Karteikarte Dateien 

Auf der Karteikarte Dateien im Dialogfenster des Menübefehls Weiteres > Ein-

stellungen können Sie Einstellungen zum Öffnen und Speichern von Dateien vor-

nehmen: 
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Vorlagenpfad 

Hier lässt sich der Ordner einstellen, in dem sich die Dokumentvorlagen für neue 

PlanMaker-Dokumente befinden. Der Dialog, der beim Aufruf des Menübefehls 

Datei > Neu erscheint, um Sie eine Dokumentvorlage auswählen zu lassen, zeigt 

entsprechend alle Vorlagen an, die sich in diesem Ordner befinden. 

Hinweis: Normalerweise sollten Sie diese Einstellung nicht verändern. Ändern 

Sie diese nur, wenn Sie den Vorlagenordner tatsächlich an einen anderen Ort ver-

schoben haben. 

Standard-Dateiformat 

Hier können Sie das Dateiformat wählen, in dem PlanMaker neu angelegte Doku-

mente standardmäßig speichern soll. 

Wenn Sie ein Dokument mit dem Menübefehl Datei > Neu neu anlegen und es 

dann zum ersten Mal abspeichern, schlägt Ihnen der Speichern-Dialog als Vorgabe 

stets das hier eingestellte Dateiformat vor. 

Zur Wahl stehen das PlanMaker-Format und das Microsoft Excel-Format in mehre-

ren Versionen. 

Hinweis: Beachten Sie, dass das Excel-Format nicht alle Funktionen von Plan-

Maker kennt. Wenn Sie also ein mit PlanMaker erstelltes Dokument im Excel-

Format speichern, können unter Umständen Formatierungen oder Funktionen 

verloren gehen. Es empfiehlt sich daher, hier die Standardeinstellung „PlanMa-

ker“ zu verwenden. 

Rubrik „Speichern“ 

In der Rubrik Speichern können Sie Einstellungen zum Speichern von Dokumen-

ten vornehmen: 

 .BAK-Dateien anlegen 

 Nur bei Android und SoftMaker FreeOffice: Ist diese Option aktiviert, wird 

bei jedem Speichern eines Dokuments automatisch eine Sicherungskopie mit 

der vorherigen Fassung des Dokuments angelegt. (Namenserweiterung: .bak.) 

 (Bei SoftMaker Office für Windows, Mac und Linux gibt es umfassendere Op-

tionen für Sicherungskopien, siehe Rubrik Sicherungskopien weiter unten). 
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 Beim Speichern nach Dokumentinfo fragen 

 Schalten Sie diese Option ein, erscheint beim ersten Speichern eines neuen Do-

kuments automatisch das Dialogfenster zum Eintragen der Dokumentinfos 

(siehe Kapitel „Dokumentinfos“ ab Seite 370). 

 Automatische Wiederherstellung: Zustand sichern alle ... Minuten 

 Wenn diese Option aktiviert ist, macht PlanMaker im eingetragenen Zeitab-

stand (1-100 Minuten) automatisch eine temporäre Sicherungskopie von jedem 

momentan geöffneten Dokument.  

Hinweis: Diese temporären Sicherungskopien funktionieren völlig unabhän-

gig von den regulären Sicherungskopien, die Sie in der Rubrik Sicherungs-

kopien auf dieser Karteikarte konfigurieren können (siehe unten). 

 Wenn PlanMaker korrekt beendet wird, löscht er diese temporären Sicherungs-

kopien wieder. Wird er jedoch nicht korrekt beendet (zum Beispiel aufgrund ei-

nes Absturzes), erkennt PlanMaker dies beim nächsten Programmstart. Er öff-

net dann (nach Rückfrage) die temporären Sicherungskopien aller Dokumente, 

die bei dem Absturz geöffnet waren und noch nicht gespeicherte Änderungen 

enthielten.  

 Überprüfen Sie nun bei jedem der wiederhergestellten Dokumente, ob möglich-

erweise einige Ihrer zuletzt gemachten Änderungen verlorengegangen sind, und 

speichern Sie das Dokument dann. 

Rubrik Öffnen 

In der Rubrik Öffnen können Sie Einstellungen zum Öffnen von Dokumenten vor-

nehmen: 

 Einträge im Datei-Menü 

 Im Menü Datei zeigt PlanMaker eine Liste der zuletzt von Ihnen geöffneten 

Dateien an. Wählen Sie einen dieser Einträge, wird die entsprechende Datei so-

fort geöffnet. Hier lässt sich einstellen, wie viele Dateien dort angezeigt werden 

sollen. 
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Rubrik Sicherungskopien 

Hinweis: Diese Funktion ist in der Android-Version nicht verfügbar. Unter 

Android werden lediglich einfache Sicherungskopien unterstützt (über die weiter 

oben beschrieben Option .BAK-Dateien anlegen). 

FreeOffice: Bei SoftMaker FreeOffice werden ebenfalls nur einfache Siche-

rungskopien unterstützt.  

Hier können Sie festlegen, ob das Programm beim Speichern von Dokumenten 

automatisch eine Sicherungskopie mit der vorherigen Version des Dokuments anle-

gen soll.  

Die aufklappbare Liste in dieser Rubrik bietet hierfür folgende Optionen zur Wahl: 

 Keine Sicherungskopien 

 Wenn Sie diese Option wählen, werden keine Sicherungskopien beim Speichern 

von Dokumenten angelegt. (Nicht empfohlen.) 

 Einfache Sicherungskopien 

 Hier wird pro Dokument genau eine Sicherungskopie angelegt. Diese enthält 

die vorherige Version des Dokuments. Sie hat die Namenserweiterung .BAK und 

befindet sich im gleichen Ordner wie das Dokument selbst. 

 Fortgeschrittene Sicherungskopien 

 Hier werden mehrere Generationen von Sicherungskopien für jedes Dokument 

angelegt. Diese werden allesamt in einem speziellen Backup-Ordner gespei-

chert.  

 Tipp: Wenn diese Option gewählt ist, steht außerdem der Menübefehl Datei > 

Zurück zu vorheriger Version zur Verfügung, mit dem Sie bequem zu einer 

früheren Version des derzeit geöffneten Dokuments zurückkehren können. 

 Zusätzliche Optionen: 

 Verzeichnis für Sicherungskopien: Hier können Sie den Pfad für den Ba-

ckup-Ordner ändern, in dem alle Sicherungskopien abgelegt werden. 

 Anzahl der Sicherungskopien pro Dokument: Hier können Sie bestimmen, 

wie viele Sicherungskopien (= Generationen) maximal pro Dokument aufgeho-

ben werden sollen. 

Ausführliche Informationen zum Verwenden von Sicherungskopien finden Sie im 

Abschnitt „Sicherungskopien“ (ab Seite 374). 
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Einstellungen, Karteikarte System 

Auf der Karteikarte System im Dialogfenster des Menübefehls Weiteres > Ein-

stellungen können Sie folgende System-Einstellungen vornehmen: 

Grafiken im Speicher komprimieren 

Ist diese Option aktiviert, legt PlanMaker eingefügte Grafiken stets (verlustfrei) 

komprimiert im Speicher ab. Vorteil: Bei Dokumenten, die viele Bilder enthalten, 

wird erheblich weniger Arbeitsspeicher verbraucht. Nachteil: Das Komprimieren 

kostet natürlich etwas Rechenzeit. 

In der Regel sollten Sie diese Option eingeschaltet lassen. 

Hinweis: Eine Änderung an dieser Einstellung wird erst wirksam, wenn Sie das 

Programm beenden und neu starten. 

Internen Grafikcache begrenzen 

PlanMaker besitzt einen Zwischenspeicher, der die Anzeige von Grafiken in Do-

kumenten erheblich beschleunigt. Ist diese Option aktiviert, begrenzt PlanMaker 

diesen Zwischenspeicher auf maximal 20% des Arbeitsspeichers.  

In der Regel sollten Sie diese Option eingeschaltet lassen. 

Wenn Sie häufig Dokumente mit vielen hochaufgelösten Bildern verwenden, kön-

nen Sie diese Option testhalber deaktivieren. Die Anzeige von Grafiken ist dann 

möglicherweise flüssiger, allerdings kann es dabei passieren, dass PlanMaker einen 

Großteil des verfügbaren Arbeitsspeichers für sich beansprucht. 

Kantenglättung von Grafiken 

Wenn diese Option aktiviert ist, wendet PlanMaker bei Grafiken eine Technologie 

zum Glätten von Kanten und Linien an. Vorteil: Skalierte Grafiken werden schöner 

dargestellt. Nachteil: Dieses Verfahren kostet natürlich Rechenzeit beim Anzeigen 

von Grafiken. 
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Nach Produktaktualisierungen suchen 

Nur bei Windows, Mac und Linux: Hier können Sie festlegen, wie häufig die 

Software nachsehen soll, ob es Aktualisierungen (Updates) für SoftMaker Office 

gibt. Aktualisierungen enthalten Fehlerkorrekturen und Funktionsverbesserungen. 

Hinweis: Das Prüfen auf Aktualisierungen funktioniert nur, wenn Ihr Gerät auf das 

Internet zugreifen kann. 

Sie können die automatische Überprüfung auch abschalten (nicht empfohlen), in-

dem Sie den Eintrag Nie auswählen. Das Prüfen auf Aktualisierungen kann dann 

nur noch manuell (über die Schaltfläche Jetzt prüfen) durchgeführt werden. 

Tipp: Auf www.softmaker.de können Sie außerdem unseren Newsletter abon-

nieren. Dieser benachrichtigt Sie bei neuen Updates per E-Mail und versorgt Sie 

regelmäßig mit weiteren nützlichen Informationen und Angeboten rund um 

SoftMaker Office. 

Android: Bei der Android-Version erhalten Sie Updates wie folgt: 

 Android-Version, über Google Play Store erworben: Bei Applikationen, die 

vom Google Play Store aus installiert wurden, benachrichtigt Sie Ihr Gerät au-

tomatisch über Updates (sofern dies nicht in den Einstellungen des Play Store 

deaktiviert wurde).  

 Android-Version, über Amazon App Shop erworben: Entsprechendes gilt 

auch für Apps, die vom Amazon App Shop aus installiert wurden. 

 Android-Version, über www.softmaker.de erworben: Hier können Sie jeder-

zeit mit dem Menübefehl Weiteres > Nach Updates suchen überprüfen, ob es 

eine neuere Version gibt. 

Dateierweiterungen verknüpfen 

Nur bei Windows: Diese Schaltfläche öffnet einen Dialog, in dem Sie einige Da-

teitypen mit PlanMaker verknüpfen können. Für diese Arten von Dateien ist Plan-

Maker dann die Standardanwendung. 

Verknüpfen Sie beispielsweise den Dateityp „Microsoft Excel-Dokumente“ mit 

PlanMaker, werden Dateien dieses Typs künftig immer in PlanMaker geöffnet, 

wenn Sie im Windows Explorer einen Doppelklick auf eine solche Datei durchfüh-

ren. 
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Tastatur automatisch ein-/ausblenden 

Nur bei Android: Ist diese Option aktiviert, wird die Bildschirmtastatur automa-

tisch geöffnet, wenn Sie etwas eingeben können (wenn Sie also beispielsweise eine 

Zelle doppelt antippen oder in einem Dialog in ein Eingabefeld tippen). 

Tastaturlayout automatisch anpassen 

Nur bei Android: Ist diese Option aktiviert, wird das Layout der Bildschirmtasta-

tur je nach Situation automatisch geändert. Tippen Sie beispielsweise in einem Dia-

log in ein Eingabefeld, in das nur Zahlen eingegeben werden dürfen, zeigt auch die 

Bildschirmtastatur nur ein Zahlenfeld an. 

Darüber hinaus merkt sich PlanMaker bei der Eingabe von Werten in Tabellenzel-

len den aktuellen Modus der Tastatur, wenn diese Option eingeschaltet ist. Ist die 

Option hingegen deaktiviert, springt die Tastatur bei jeder neuen Zelle wieder in 

den normalen (alphanumerischen) Modus zurück. 

OpenGL-Bibliothek verwenden 

Nur bei Linux: Ist diese Option aktiviert, nutzt das Programm die OpenGL-

Grafikbibliothek. Diese beschleunigt die Bildschirmdarstellung. Sie sollten diese 

Option daher normalerweise eingeschaltet lassen. 

Hinweis: Auf Systemen mit einer stark veralteten oder fehlerhaften OpenGL-

Installation kann es dabei zu Darstellungsfehlern innerhalb der Applikation kom-

men. Dies hängt von Ihrer individuellen Systemkonfiguration und insbesondere 

dem verwendeten Grafiktreiber ab. In so einem Fall sollten Sie die Option deakti-

vieren und die Applikation neu starten.  

Außerdem: Wenn das Programm beim Starten Probleme mit der installierten O-

penGL-Bibliothek erkennt, schaltet es diese Option automatisch ab.  

SHM-Erweiterungen verwenden 

Nur bei Linux: Diese Option ist nur verfügbar, wenn die Option OpenGL-

Bibliothek verwenden deaktiviert wurde (nicht empfohlen).  

Wenn die SHM-Erweiterungen eingeschaltet sind, verwendet das Programm 

Shared Memory-Speicher (sofern verfügbar), was die Bildschirmausgabe be-

schleunigen kann. 
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XIM verwenden 

Nur bei Linux: Ist diese Option aktiviert, unterstützt PlanMaker das Zusammen-

setzen von Akzentzeichen (à, ô, é etc.) mit Hilfe von „XIM“. 

Auf einer deutschen Tastatur kann dann beispielsweise das Zeichen „ô“ erzeugt 

werden, indem Sie erst die Taste (^) und danach die Taste (O) betätigen. 

Schalten Sie die Option aus, ist das Zusammensetzen von Zeichen auf diese Weise 

nicht mehr möglich.  

Hinweis: Auf manchen Systemen gibt es kleine Eingabeverzögerungen beim 

schnellen Tippen von Text, wenn diese Option aktiviert ist. 

Verborgene Dateien und Ordner anzeigen 

Nur bei Mac, Linux: Ist diese Option aktiviert, werden in Dateidialogen (z.B. dem 

des Menübefehls Datei > Öffnen) auch verborgene Dateien und Ordner angezeigt. 

Mausrad 

Nur bei Mac, Linux: Wenn Ihre Maus mit einem Mausrad ausgestattet ist, können 

Sie hier einstellen, wie weit beim Verwenden des Mausrads geblättert werden soll: 

seitenweise (also eine komplette Bildschirmseite) oder nur eine bestimmte Anzahl 

an Zeilen. 

Externe Programme 

Nur bei Mac, Linux: Diese Schaltfläche öffnet einen Dialog, in dem Sie die ex-

ternen Programme festlegen können, die bei bestimmten Ereignissen automatisch 

gestartet werden. Der Eintrag PDF-Betrachter bestimmt beispielsweise, welche 

Applikation nach dem Erzeugen einer PDF-Datei automatisch aufgerufen wird, um 

das Ergebnis darin anzuzeigen. 

Hinweis: Sie müssen diese Felder nicht ausfüllen. Bei allen Feldern, die Sie leer 

lassen, wird automatisch das im System festgelegte Standardprogramm für diese 

Aktion verwendet. Nehmen Sie in diesem Dialog nur dann Änderungen vor, wenn 

Sie möchten, dass nicht das Standardprogramm aufgerufen wird, sondern ein ande-

res Programm. Tragen Sie dazu einfach den Dateinamen der ausführbaren Datei 

ein (inklusive Pfad, falls nötig). 
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Zusätzliche Schriftenpfade 

Nur bei Mac, Linux und Android: Hier können Sie Pfade für zusätzliche Schrift-

arten angeben, die PlanMaker verwenden soll. Tragen Sie dazu das Unterverzeich-

nis ein, in dem sich die Schriftdateien befinden. Falls Sie mehrere Verzeichnisse 

eintragen möchten, trennen Sie diese durch einen Doppelpunkt. 

PlanMaker kann diese Schriftarten dann zusätzlich zu den in Ihrem System verfüg-

baren Schriften verwenden.  

Hinweis: Änderungen an dieser Einstellung werden erst wirksam, wenn Sie das 

Programm beenden und neu starten. 

Einstellungen, Karteikarte Schriften 

Auf der Karteikarte Schriften im Dialogfenster des Menübefehls Weiteres > Ein-

stellungen können Sie festlegen, welche Schriften in Schriftenlisten (z.B. der 

Schriftenliste im Dialogfenster des Menübefehls Format > Zeichen) angezeigt 

werden sollen. 

Die Karteikarte präsentiert dazu eine Liste aller Schriften, die auf Ihrem System 

installiert sind. Um darin eine Schrift zu aktivieren oder zu deaktivieren, klicken 

Sie auf das Kästchen vor dem Namen der Schriftart. Alle Schriften, bei denen Sie 

das Häkchen entfernen, werden nicht mehr in Schriftenlisten angezeigt. 

Hintergrund: Unter den Schriftarten, die auf Ihrem System standardmäßig instal-

liert sind, befinden sich einige Schriften, die Sie vermutlich nie benötigen – weil 

diese beispielsweise ausschließlich Schriftzeichen für eine Sprache enthalten, die 

Sie nicht verwenden. Wenn Sie möchten, können Sie solche Schriften wie oben 

beschrieben ausblenden. 

Schriftenfilterung des Betriebssystems verwenden 

Nur unter Windows: Windows-Anwender finden auf dieser Karteikartei außer-

dem eine Option namens Schriftenfilterung des Betriebssystems verwenden. 

Wenn diese eingeschaltet ist, verbirgt Windows in Schriftenlisten automatisch alle 

Schriften, die ausschließlich fremdsprachige Schriftzeichen enthalten. 
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Dokumenteigenschaften ändern 

Über den Menübefehl Datei > Eigenschaften können Sie Einstellungen ändern, 

die nur das aktuelle Dokument betreffen und mit diesem gespeichert werden. Man 

nennt diese Einstellungen Dokumenteigenschaften. 

Die verfügbaren Dokumenteigenschaften sind nach Themen geordnet auf mehrere 

Karteikarten verteilt. Klicken Sie beispielsweise auf den Karteikartenreiter Infos, 

können Sie die Dokumentinfos bearbeiten. 

Auf den nächsten Seiten finden Sie detaillierte Erläuterungen aller verfügbaren 

Dokumenteigenschaften. 

Dokumenteigenschaften, Karteikarte Infos 

Auf der Karteikarte Infos im Dialogfenster des Menübefehls Datei > Eigenschaf-

ten können Sie die Dokumentinfos für das aktuelle Dokument eintragen.  

In den Dokumentinfos lassen sich erläuternde Angaben zum aktuellen Dokument 

machen (Thema, Autor, Schlüsselwörter etc.), nach denen mit dem Dateimanager 

auch gesucht werden kann. 

Informationen hierzu finden Sie im Abschnitt „Dokumentinfos“ ab Seite 370. 

Dokumenteigenschaften, Karteikarte Farben 

Auf der Karteikarte Farben im Dialogfenster des Menübefehls Datei > Eigen-

schaften können Sie die Farbpalette des aktuellen Dokuments bearbeiten. 

Wenn Sie eine Farbenliste – zum Beispiel die Farbenliste in der Formatleiste – öff-

nen, sehen Sie nur einen kleinen Ausschnitt aus den bis zu 16 Millionen verfügba-

ren Farben. Man nennt diesen Ausschnitt die Farbpalette des Dokuments. 

Diese Farbpalette kann jederzeit von Ihnen modifiziert werden. Sie können neue 

Farben hinzufügen und von Ihnen hinzugefügte Farben abändern. Die ersten 24 

Farben in der Farbpalette sind allerdings Standardfarben, die sich nicht verändern 

lassen. 

Wichtig: Änderungen an der Farbpalette werden im Dokument gespeichert. Sie 

können also zu jedem Dokument eine eigene Farbpalette zusammenstellen. 
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Hinzufügen einer Farbe 

Um der Farbpalette des aktuellen Dokuments eine Farbe hinzuzufügen, gehen Sie 

wie folgt vor: 

1. Rufen Sie den Menübefehl Datei > Eigenschaften auf und wechseln Sie auf 

die Karteikarte Farben. 

Tipp: Alternativ können Sie diesen Dialog von jedem beliebigen Dialogfens-

ter aus aufrufen, das eine Farbenliste enthält. Wählen Sie dazu in der Farben-

liste den Eintrag Andere... am Ende der Liste. 

2. Stellen Sie die gewünschte Farbe ein (siehe Abschnitt „Bedienung der Kontrol-

len zum Einstellen von Farben“ weiter unten).  

3. Klicken Sie auf die Schaltfläche Neu. 

4. Geben Sie der neuen Farbe im Feld Name einen beliebigen Namen und bestäti-

gen Sie diesen mit OK. 

5. Verlassen Sie den Dialog mit OK. 

PlanMaker fügt die neue Farbe nun der Farbpalette des Dokuments hinzu. Die Far-

be ist ab sofort in allen Dialogfenstern verfügbar, in denen eine Farbe ausgewählt 

werden kann. 

Ändern einer Farbe 

Hinweis: Sie können nur Farben ändern, die von Ihnen hinzugefügt wurden. Die 

ersten 24 Farben der Farbpalette sind Standardfarben, die sich nicht verändern 

lassen. 

Um eine Farbe zu ändern, gehen Sie wie folgt vor: 

1. Rufen Sie den Menübefehl Datei > Eigenschaften auf und wechseln Sie auf 

die Karteikarte Farben. 

 Oder: Alternativ können Sie auch den Eintrag Andere... in einer beliebigen 

Farbenliste verwenden, um diesen Dialog aufzurufen. 

2. Wählen Sie die zu verändernde Farbe in der Liste Farbpalette. 

3. Nehmen Sie die gewünschten Änderungen vor (siehe Abschnitt „Bedienung der 

Kontrollen zum Einstellen von Farben“ weiter unten). 

4. Klicken Sie auf Ändern. 
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Die Farbe wurde nun für das aktuelle Dokument verändert. 

Löschen oder Umbenennen einer Farbe 

Sie können selbstdefinierte Farben jederzeit löschen oder ihren Namen ändern. 

Rufen Sie dazu den Farbendialog auf, selektieren Sie eine Farbe in der Liste Farb-

palette und betätigen Sie die Schaltfläche Löschen beziehungsweise Umbenen-

nen. 

Bedienung der Kontrollen zum Einstellen von Farben 

Die Kontrollen in obigem Dialog lassen Sie Farben auf vielfältige Arten einstellen. 

Alle Wege führen zum gleichen Ergebnis – wählen Sie einfach die Methode, die 

Ihnen am meisten zusagt: 

 Verwenden des Farbfeldes und Helligkeitsreglers 

 Am einfachsten geht das Einstellen von Farben mit dem großen Farbfeld und 

dem Helligkeitsregler rechts daneben. Das Farbfeld stellt alle verfügbaren Farb-

töne in allen verfügbaren Sättigungen dar, der Helligkeitsregler daneben ist für 

die Helligkeit der Farbe zuständig. 

 Um eine Farbe einzustellen, klicken Sie zunächst in dem großen Farbfeld auf 

die gewünschte Farbe. Dann klicken Sie in dem Helligkeitsregler auf die ge-

wünschte Helligkeit. 

 Verwenden der Regler für Ton, Sättigung und Helligkeit 

 Alternativ können Sie Farben mit den darunter befindlichen Reglern Ton 

(=Farbton), Sätt (=Sättigung) und Hell (=Helligkeit) einstellen. Zulässig sind 

Werte zwischen 0 und 240. 

 Verwenden der Regler für Rot, Grün und Blau 

 Farben lassen sich alternativ auch über ihre Rot-, Grün- und Blauanteile einstel-

len. Dazu dienen die Regler Rot, Grün und Blau. Zulässig sind Werte zwi-

schen 0 und 255. 

 Eintippen des Hexcodes für eine Farbe 

 Sie können eine Farbe auch durch Eintippen ihres Hexcodes in das Eingabefeld 

mit dem Doppelkreuz # spezifizieren.  

 Solche Hexcodes sind beispielsweise im HTML-Code von Webseiten ge-

bräuchlich. Sie setzen sich aus drei zweistelligen hexadezimalen Werten für die 
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Farben Rot, Grün und Blau zusammen (RRGGBB). 00FF00 steht beispielswei-

se für reines Grün. 

Dokumenteigenschaften, Karteikarte Statistik 

Auf der Karteikarte Statistik im Dialogfenster des Menübefehls Datei > Eigen-

schaften können Sie statistische Informationen über das aktuelle Dokument abru-

fen: 

 In der Rubrik Zellen wird ausgegeben, wie viele Zellen ausgefüllt sind, und 

wie viele davon Text, Zahlen, Formeln beziehungsweise Kommentare enthal-

ten. 

 In der Rubrik Allgemeines wird die Zahl der Arbeitsblätter und die Zahl der 

Druckseiten ausgegeben. 

 In der Rubrik Objekte wird ausgegeben, wie viele Objekte (Diagramme, Gra-

fiken etc.) das Dokument enthält. 

 In der Rubrik Aktionen können Sie ablesen, wann das Dokument erstellt, zu-

letzt gespeichert und zuletzt gedruckt wurde. 

Dokumenteigenschaften, Karteikarte Optionen 

Auf der Karteikarte Optionen im Dialogfenster des Menübefehls Datei > Eigen-

schaften können Sie allgemeine Einstellungen zum aktuellen Dokument vorneh-

men: 

Rubrik „Textrahmen“ 

 Tabulatorbreite 

 Hier können Sie die Tabulatorbreite für Text in Textrahmen einstellen. 

Rubrik „Zellinhalte“ 

 Syntaxhervorhebung 

 Ist diese Option aktiviert, werden die Tabellenzellen je nach Inhalt unterschied-

lich eingefärbt. Entspricht dem Menübefehl Ansicht > Syntaxhervorhebung 

(siehe Abschnitt „Syntaxhervorhebung“ ab Seite 116). 
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 Formelanzeige 

 Ist diese Option aktiviert, werden bei allen Formeln die Rechenformeln statt der 

Ergebnisse angezeigt. Entspricht dem Menübefehl Ansicht > Formelanzeige 

(siehe Abschnitt „Formelanzeige“ ab Seite 115). 

 Schutzanzeiger 

 Ist diese Option aktiviert, wird – sofern der Blattschutz für das Arbeitsblatt ak-

tiviert wurde – ein kleines grünes Dreieck bei allen Zellen eingeblendet, die 

nicht geschützt sind. Dadurch kann man besser erkennen, welche Zellen noch 

editiert werden dürfen. Siehe auch Abschnitt „Blattschutz“ ab Seite 401. 

 Silbentrennung 

 Ist diese Option aktiviert, werden in allen Zellen, bei denen mit dem Menübe-

fehl Format > Zelle die Option Zeilenumbruch aktiviert wurde, bei Bedarf 

automatische Silbentrennungen durchgeführt. Siehe auch Abschnitt 

„Silbentrennung“ ab Seite 359. 

Rubrik „Kommentare“ 

 Marken anzeigen 

 Ist diese Option aktiviert, wird bei allen Zellen, die mit dem Menübefehl Ein-

fügen > Kommentar mit einem Kommentar versehen wurden, ein kleines gel-

bes Dreieck eingeblendet. Siehe auch Abschnitt „Kommentare einfügen“ ab 

Seite 126. 

 Kommentare immer anzeigen 

 Wenn Sie eine Zelle mit einem Kommentar versehen, wird dieser normaler-

weise nur dann eingeblendet, wenn Sie mit der Maus auf diese Zelle zeigen. 

Aktivieren Sie diese Option, werden hingegen alle Kommentare im Dokument 

permanent angezeigt. 

Rubrik „Dezimaltrenner nach Zahleneingabe“ 

 Verschieben um ... Stellen 

 Aktivieren Sie diese Option, wird jede ganze Zahl, die Sie in eine Zelle einge-

ben, automatisch um die angegebene Zahl an Stellen verschoben. 

 Diese Option ist nützlich, wenn Sie beispielsweise viele kleine Geldbeträge 

eingeben müssen. Setzen Sie nämlich die Zahl der Stellen auf den Wert 2 und 
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geben die Zahl 42 ein, wird dies automatisch in 0,42 gewandelt; die Eingabe 

234 wird in 2,34 gewandelt etc. So können Sie sich die Eingabe des Dezimal-

kommas sparen, wenn Sie eine lange Kolonne von Zahlen mit zwei Dezimal-

stellen eingeben möchten. 

Rubrik „Fenster“ 

 Vertikale Bildlaufleiste 

 Hier können Sie wählen, ob die vertikale Bildlaufleiste für das Dokument an-

gezeigt werden soll. 

 Horizontale Bildlaufleiste 

 Hier können Sie wählen, ob die horizontale Bildlaufleiste für das Dokument 

angezeigt werden soll. 

 Arbeitsblattregister 

 Hier können Sie wählen, ob das Arbeitsblattregister unter der Tabelle angezeigt 

werden soll. Dieses dient zum Anlegen und Verwalten von Arbeitsblättern. 

Rubrik „Objekte“ 

 Textrahmen-Hilfslinien 

 Hier können Sie wählen, ob um Textrahmen graue Linien angezeigt werden 

sollen. Diese dienen lediglich dazu, die Position und Größe des Textrahmens 

anzuzeigen; sie werden nicht ausgedruckt. 

 Verborgene Objekte anzeigen 

 Wie Sie im Abschnitt „Verbergen von Objekten“ ab Seite 267 nachlesen kön-

nen, lassen sich Objekte verbergen, sprich: unsichtbar machen. 

 Schalten Sie jedoch die Option Verborgene Objekte anzeigen ein, werden 

auch verborgene Objekte wieder sichtbar. 

Standardwährung 

Hier können Sie die Standardwährung für das Dokument ändern.  
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Hinweis: Normalerweise sollte diese Option immer auf Aus Systemeinstellung 

gesetzt sein. Das bedeutet, dass PlanMaker die Standardwährung aus den Län-

dereinstellungen Ihres Systems verwendet.  

Wenn Sie eine andere Währung auswählen, hat das folgende Auswirkung:  

Wann immer PlanMaker eine Zelle automatisch im Zahlenformat Währung for-

matiert (weil Sie beispielsweise eine Rechenfunktion enthält, die einen Geldbetrag 

zurückliefert), wird dafür die hier eingestellte Währung verwendet. 

Schaltfläche „Kompatibilität“ 

Hier können programminterne Einstellungen zur Kompatibilität mit älteren Plan-

Maker-Dokumenten und Excel-Dokumenten vorgenommen werden. Diese werden 

beim Öffnen des Dokuments automatisch gesetzt und sollten normalerweise nicht 

verändert werden. 

Dokumenteigenschaften, Karteikarte Berechnen 

Auf der Karteikarte Berechnen im Dialogfenster des Menübefehls Datei > Eigen-

schaften können Sie Einstellungen zu den Berechnungen im aktuellen Dokument 

vornehmen: 

Rubrik „Neuberechnung“ 

Hier können Sie bestimmen, ob die Berechnungen in der Tabelle automatisch aktu-

alisiert werden sollen, wenn Sie Änderungen am Tabelleninhalt vornehmen: 

 Automatisch berechnen 

 Wählen Sie diese Option, werden alle Berechnungen im Dokument automatisch 

erneut durchgeführt, wenn Sie etwas an der Tabelle ändern, also beispielsweise 

den Inhalt einer Tabellenzelle ändern. 

 Dies ist die Standardeinstellung. Sie sorgt dafür, dass alle Berechnungen stets 

aktuelle Ergebnisse liefern. 

 Neuberechnen nur vor dem ... 

 Wählen Sie hingegen diese Option, werden die Berechnungen nur dann auto-

matisch neu berechnet, wenn Sie das Dokument speichern, es drucken 

und/oder Zellen kopieren – je nachdem, welche Option(en) Sie hier wählen. 
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Schalten Sie alle drei Optionen ab, werden Berechnungen überhaupt nicht mehr 

automatisch aktualisiert. 

 Sie können die Berechnungen allerdings jederzeit manuell aktualisieren lassen: 

Rufen Sie dazu den Menübefehl Weiteres > Neu berechnen auf oder drücken 

Sie die Taste (F9). 

Rubrik „Externe Bezüge“ 

Hier können Sie Einstellungen zu externen Zellbezügen vornehmen. Das sind Be-

züge, die sich auf Zellen in anderen Arbeitsmappen beziehen. Details dazu finden 

Sie im Abschnitt „Externe Zellbezüge“ ab Seite 510. 

Verfügbare Optionen: 

 Daten nach dem Öffnen aktualisieren 

 Hier können Sie festlegen, ob beim Öffnen eines Dokuments alle darin enthal-

tenen externen Bezüge (einmalig) aktualisiert werden sollen: 

 Immer: Beim Öffnen externe Bezüge automatisch aktualisieren 

 Niemals: Beim Öffnen externe Bezüge nicht aktualisieren 

 Nachfragen: Beim Öffnen den Anwender fragen, ob die externen Bezüge aktu-

alisiert werden sollen. 

 Externe Daten im Dokument speichern 

 Ist diese Option aktiviert, speichert PlanMaker eine Kopie aller Werte, die von 

externen Zellbezügen geliefert werden, im Dokument. Fehlt die Datei für einen 

externen Bezug beim Aktualisieren, wird auch weiterhin der Wert angezeigt, 

den sich PlanMaker zuletzt gemerkt hat. 

 Schalten Sie die Option aus, wird stattdessen ein Fehlerwert angezeigt, wenn 

Sie einen externen Bezug aktualisieren und auf die zugehörige Datei nicht zu-

gegriffen werden kann. 

Rubrik „Rundung“ 

Aufgrund der Tatsache, dass wir Menschen ein anderes Zahlensystem als Compu-

ter verwenden, kann es beim Rechnen auf einem Computer gelegentlich zu (sehr 

kleinen) Rundungsfehlern kommen. Dies ist kein PlanMaker-spezifisches Problem, 

sondern prinzipbedingt und bei allen Computerprogrammen festzustellen. 
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PlanMaker hat jedoch zwei Optionen, mit denen diese Rundungsfehler weitgehend 

ausgemerzt werden können: 

 Schalten Sie die Option Endergebnis runden ein, rundet PlanMaker das End-

ergebnis jeder Berechnung in einer Zelle automatisch auf 15 Stellen.  

 Schalten Sie die Option Zwischenergebnisse runden ein, werden auch sämtli-

che Zwischenergebnisse einer Berechnung auf 15 Stellen gerundet.  

Die erste Option reduziert die Wahrscheinlichkeit, einen Rundungsfehler zu erhal-

ten, bereits erheblich, die zweite Option macht dies nochmals unwahrscheinlicher. 

Der Nachteil beider Optionen ist allerdings, dass das Neuberechnen von Tabellen 

etwas länger dauert. 

Ein klassisches Beispiel für dieses Rundungsproblem: 

Sind beide Optionen ausgeschaltet, ergibt die Berechnung (0,1+0,2-0,3)=0 den 

Wert FALSCH, obwohl WAHR das korrekte Ergebnis wäre. Schalten Sie die bei-

den Optionen ein, liefert die Berechnung ein korrektes Ergebnis. 

Rubrik „Diagramme“ 

Genau wie Berechnungen werden standardmäßig auch Diagramme automatisch 

aktualisiert, wenn Sie etwas am Tabelleninhalt ändern. 

Möchten Sie das nicht, dann können Sie die Option Automatisch aktualisieren in 

der Rubrik Diagramme ausschalten. 

Diagramme müssen dann bei Bedarf von Hand aktualisiert werden. Rufen Sie dazu 

den Menübefehl Weiteres > Diagramme aktualisieren auf. 

Rubrik „Iterationen“ 

Diese Einstellung betrifft Zellen, die einen zirkulären Bezug enthalten. Von einem 

zirkulären Bezug spricht man, wenn eine Zelle beispielsweise eine Berechnung mit 

sich selbst durchführt, also zum Beispiel in der Zelle A1 die Formel =A1+A2 steht. 

Aktivieren Sie die Option Iterationen durchführen, werden solche Berechnungen 

bei jedem Neuberechnen des Arbeitsblatts so oft wiederholt, bis entweder die Ma-

ximale Anzahl erreicht ist oder das Ergebnis der Berechnung vom vorherigen Er-

gebnis um weniger als die Maximale Änderung abweicht. 

Normalerweise sollten Tabellen jedoch keine zirkulären Bezüge enthalten, weshalb 

diese Option standardmäßig ausgeschaltet ist. 
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Hinweis: Sofern Sie nicht bewusst zirkuläre Bezüge in der Tabelle verwenden, 

um beispielsweise Werte mit einem Iterationsverfahren zu ermitteln, sollten Sie 

diese Option nicht aktivieren, da sie die für das Neuberechnen der Tabelle erfor-

derliche Zeit deutlich erhöhen kann. 

Dokumenteigenschaften, Karteikarte Schutz 

Auf der Karteikarte Schutz im Dialogfenster des Menübefehls Datei > Eigen-

schaften können Sie Dokumente mit einem Dokumentschutz versehen. 

Öffnen beziehungsweise Speichern eines geschützten Dokuments ist nur nach Ein-

gabe des korrekten Kennworts möglich. Dokumente mit Leseschutz werden dabei 

zusätzlich verschlüsselt, damit sie auch mit anderen Programmen nicht eingesehen 

werden können. 

Informationen zu diesem Thema finden Sie im Abschnitt „Dokumentschutz“ ab 

Seite 406. 

Dokumenteigenschaften, Karteikarte Schriften 

Auf der Karteikarte Schriften im Dialogfenster des Menübefehls Datei > Eigen-

schaften wird eine Liste aller im aktuellen Dokument verwendeten Schriftarten 

angezeigt. 

Die Liste ist aufgeteilt nach Schriften, die auf dem aktuell verwendeten Gerät ver-

fügbar sind, und solchen, die nicht verfügbar (sprich: installiert) sind. 

Arbeitsblatteigenschaften ändern 

Über den Menübefehl Arbeitsblatt > Eigenschaften können Sie Einstellungen 

festlegen, die nur das aktuelle Arbeitsblatt betreffen.  

Besteht ein Dokument also aus mehreren Arbeitsblättern, können Sie diese Einstel-

lungen für jedes Blatt getrennt vornehmen. Wechseln Sie dazu auf das gewünschte 

Arbeitsblatt und rufen Sie dann obigen Befehl auf. 

Es erscheint ein Dialogfenster mit folgenden Optionen: 
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 Zeilenköpfe 

 Ist diese Option aktiviert, werden Zeilenköpfe (mit 1, 2, 3... beschriftete Schalt-

flächen links der Tabelle) in dem Arbeitsblatt angezeigt. 

 Spaltenköpfe 

 Ist diese Option aktiviert, werden Spaltenköpfe (mit A, B, C... beschriftete 

Schaltflächen oberhalb der Tabelle) in dem Arbeitsblatt angezeigt. 

 Tipp: Sie können auch den Menübefehl Ansicht > Zeilen- & Spaltenköpfe 

verwenden, um die Zeilen- und die Spaltenköpfe gemeinsam ein- oder auszu-

schalten. 

 Seitenumbrüche 

 Ist diese Option aktiviert, wird eine dunkle Linie zwischen denjenigen Zellen 

angezeigt, bei denen beim Ausdruck ein Seitenumbruch stattfinden wird. 

 Nullwerte anzeigen 

 Eine Zelle enthält einen Nullwert, wenn dort entweder die Zahl 0 (Null) einge-

tragen wurde oder die Zelle eine Berechnung enthält, die Null ergibt.  

 Ist diese Option aktiviert, wird in solchen Zellen wie üblich die Zahl „0“ ange-

zeigt. Schalten Sie sie aus, wird darin nichts mehr angezeigt. 

 Gitternetzlinien 

 Ist diese Option aktiviert, wird ein Raster aus grauen Gitternetzlinien zwischen 

den Tabellenzellen angezeigt. Darunter können Sie auf Wunsch die Farbe die-

ser Linien ändern. 

 Die Gitternetzlinien werden normalerweise nicht ausgedruckt. Wenn Sie möch-

ten, dass diese Linien auch im Ausdruck erscheinen, rufen Sie den Menübefehl 

Datei > Seite einrichten auf, wechseln auf die Karteikarte Optionen und akti-

vieren darin die Option Gitternetz. 

 Arbeitsblattregister 

 Am unteren Fensterrand wird ein Arbeitsblattregister angezeigt, mit dem Sie 

zwischen den Arbeitsblättern eines Dokuments wechseln können.  

 Mit dieser Option lässt sich die Farbe der Registerkarte für das aktuelle Blatt 

ändern. 
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 Hintergrund 

 Wenn Sie hier die Option Abwechselnde Schattierung aktivieren, werden die 

Zeilen der Tabelle mit abwechselnden Schattierungen versehen: Jede ungerade 

Zeile erhält die Schattierung, die Sie mit der Schaltfläche Schattierung 1 fest-

legen; jede gerade Zeile erhält die mit Schattierung 2 festgelegte Schattierung. 

 Blattrichtung 

 Für Tabellen in arabischer Schrift können Sie hier die Richtung des Arbeits-

blatts auf rechts-nach-links ändern.  

 Das Arbeitsblatt wird dann horizontal gespiegelt – die Zelle A1 befindet sich 

also nicht mehr links oben, sondern rechts oben.  

 Siehe auch Kapitel „Arbeiten mit arabischem Text“ (ab Seite 419). 

Bildschirmdarstellung ändern 

In diesem Abschnitt erfahren Sie, wie Sie die Darstellung der Tabelle auf dem 

Bildschirm anpassen können. Die dazu benötigten Befehle finden Sie im Menü 

Ansicht. 

Folgende Themen werden in diesem Abschnitt behandelt: 

 Vergrößerungsstufe 

 Mit den Menübefehl Ansicht > Originalgröße und Ansicht > Vergrößerungs-

stufe können Sie die Vergrößerungsstufe einstellen, in der das Dokument ange-

zeigt wird. 

 Vollbildansicht 

FreeOffice: Vollbildansicht ist in SoftMaker FreeOffice nicht enthalten. 

 Der Menübefehl Ansicht > Vollbild maximiert das Programmfenster und blen-

det die meisten Bestandteile der Benutzeroberfläche aus, damit möglichst viel 

vom Dokument zu sehen ist.  

Lesen Sie dazu die nächsten Seiten. 
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Vergrößerungsstufe 

Mit den Befehlen des Menüs Ansicht können Sie unter anderem die Vergröße-

rungsstufe für das aktuelle Dokument wählen. 

Während der Menübefehl Ansicht > Originalgröße das Dokument stets auf eine 

Vergrößerungsstufe von 100% bringt, erlaubt Ansicht > Vergrößerungsstufe eine 

genaue Auswahl der gewünschten Vergrößerungsstufe: 

Vergrößerungsstufe Erläuterung 

An Selektion anpassen Wählt automatisch die Vergrößerungsstufe, bei der 

die momentan selektierten Zellen genau in das Ar-

beitsfenster passen. 

Vorherige Vergrößerungsstufe Stellt die zuletzt gewählte Vergrößerungsstufe wieder 

her. 

50%, 75% etc. Wählt eine der vorgegebenen Vergrößerungsstufen. 

Alternativ können Sie auch eine beliebige Vergrößerungsstufe in das Eingabefeld 

oberhalb der Liste eintragen (50 bis 400 Prozent). 

Tipp: Verwenden des Zoomreglers 

Sie können die Vergrößerungsstufe auch mit dem Zoomregler in der rechten unte-

ren Bildschirmecke ändern. 

 

Ziehen Sie dazu entweder an dem Schieber in der Mitte, oder klicken Sie auf das 

Minus- oder Plussymbol, um die Vergrößerungsstufe zu verändern. 

Tipp: Wenn Sie auf die Prozentangabe rechts neben dem Zoomregler klicken, öff-

net sich der Dialog des oben erwähnten Befehls Ansicht > Vergrößerungsstufe. 

Vollbildansicht 

FreeOffice: Vollbildansicht ist in SoftMaker FreeOffice nicht enthalten. 

Mit dem Menübefehl Ansicht > Vollbild) können Sie in die Vollbildansicht schal-

ten, in der das Programm den gesamten Bildschirm zur Darstellung des Dokuments 

nutzt. PlanMaker vergrößert dazu sein Programmfenster auf die volle Bildschirm-

größe und blendet sämtliche Symbolleisten aus. 
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Um diesen Ansichtsmodus wieder zu verlassen, drücken Sie die Taste (Esc) oder 

rufen den Menübefehl Ansicht > Vollbild noch einmal auf. 

Verwenden der Symbolleiste der Vollbildansicht 

Wenn Sie den Vollbildmodus aktivieren, erscheint eine zusätzliche Symbolleiste 

auf dem Bildschirm. 

 

Die Symbolleiste „Vollbildmodus“ 

Diese hat folgende Funktionen (von links nach rechts): 

 Menüleiste ein-/ausblenden 

 Seitenleiste ein-/ausblenden 

 Modus „Blatt verschieben“ aktivieren/deaktivieren 

 Wenn Sie diesen Modus aktivieren, können Sie das Dokument mit der Maus 

verschieben. Klicken Sie dazu in das Dokument und ziehen Sie es bei weiterhin 

gedrückter Maustaste in die gewünschte Richtung. 

 Hinweis: Das Anklicken von Zellen, um die Schreibmarke zu setzen, sowie das 

Selektieren von Text oder Objekten ist in diesem Modus nicht mehr möglich. 

 Um den Modus „Blatt verschieben“ wieder zu verlassen, klicken Sie dieses 

Symbol noch einmal an. 

 Die Schaltfläche Schließen beendet den Vollbildmodus. 

Symbolleisten anpassen 

Nur bei „klassischen Menüs und Symbolleisten“: Dieser Abschnitt betrifft nur 

Anwender, die in den Einstellungen ausgewählt haben, dass sie das Programm 

mit klassischen Menüs und Symbolleisten bedienen möchten. (Informationen 

zum Anpassen des Ribbons finden Sie im Abschnitt „Ribbon (Menüband) an-

passen“ ab Seite 481.) 
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Tipp: Die Benutzeroberfläche lässt sich jederzeit zwischen Ribbon und klassi-

schen Menüs mit Symbolleisten umschalten. Rufen Sie dazu im Menü den Befehl 

Weiteres > Einstellungen auf (beziehungsweise im Ribbon den Befehl Datei > 

Einstellungen). Wechseln Sie in dem Dialog auf die Karteikarte Aussehen und 

klicken Sie darin auf die Schaltfläche Benutzeroberfläche. Es erscheint ein wei-

terer Dialog, in dem Sie die gewünschte Art von Benutzeroberfläche wählen 

können. 

In diesem Abschnitt erfahren Sie, wie Sie die Symbolleisten (Funktionsleiste, For-

matleiste etc.) mit dem Menübefehl Ansicht > Symbolleisten konfigurieren und 

mit Weiteres > Anpassen nach Ihren Wünschen anpassen können.  

 

Eine Symbolleiste (hier: die Funktionsleiste) 

Folgende Themen werden darin behandelt: 

 Symbolleisten anzeigen/verbergen 

 Symbolleisten auf dem Bildschirm positionieren 

 Symbolleisten verwalten (Symbolleisten erstellen, löschen, umbenennen, zu-

rücksetzen) 

 Symbole einer Symbolleiste anpassen (Symbole hinzufügen, entfernen, ver-

schieben) 

 Verwenden des Symbolleisten-Menüs (für besonders schnellen Zugriff auf 

obige Funktionen) 

Informationen dazu finden Sie, in obiger Reihenfolge, auf den nächsten Seiten. 

Symbolleisten anzeigen/verbergen 

Nur bei „klassischen Menüs und Symbolleisten“: Dieser Abschnitt betrifft nur 

Anwender, die in den Einstellungen ausgewählt haben, dass sie das Programm 

mit klassischen Menüs und Symbolleisten bedienen möchten. (Informationen 

zum Anpassen des Ribbons finden Sie im Abschnitt „Ribbon (Menüband) an-

passen“ ab Seite 481.) 

Sie können die verfügbaren Symbolleisten jederzeit ein- oder ausschalten, um die-

se sichtbar zu machen beziehungsweise zu verbergen. 

Gehen Sie dazu wie folgt vor: 
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1. Rufen Sie den Menübefehl Ansicht > Symbolleisten auf. 

2. Klicken Sie in das Kästchen vor der gewünschten Symbolleiste, um sie ein- 

beziehungsweise auszuschalten. Wenn die Symbolleiste eingeschaltet ist, er-

scheint ein Häkchen in dem Kästchen. 

3. Verlassen Sie das Dialogfenster mit Schließen. 

Die entsprechende Symbolleiste wurde nun ein- beziehungsweise ausgeschaltet. 

Tipp: Hierfür gibt es eine Abkürzung: Wenn Sie mit der rechten Maustaste auf 

eine beliebige Symbolleiste klicken, erscheint ein Menü mit einer Liste aller ver-

fügbaren Symbolleisten. Klicken Sie einen dieser Menüeinträge an, wird die ent-

sprechende Leiste ein- beziehungsweise ausgeschaltet. 

Sichtbar in Modus ... 

Manche Symbolleisten werden nur in bestimmten Situationen angezeigt. Zum Bei-

spiel erscheint die Grafikleiste nur dann, wenn Sie ein Bild selektieren. 

Zuständig hierfür ist die Option Sichtbar in Modus, die bestimmt, wann eine 

Symbolleiste sichtbar sein soll. Einige Beispiele: 

Option Bedeutung 

Alle Die gewählte Symbolleiste ist immer sichtbar (sofern sie natür-

lich nicht ausgeschaltet wurde). Beispiel: Funktionsleiste 

Editiermodus Die Leiste ist nur im normalen Editiermodus sichtbar, nicht je-

doch im Objektmodus (siehe auch Abschnitt „Der Objektmodus“ 

ab Seite 251). Beispiel: Formatleiste 

Objekt Die Leiste ist nur im Objektmodus sichtbar, nicht jedoch im 

normalen Editiermodus (siehe auch Abschnitt „Der Objektmo-

dus“ ab Seite 251). Beispiel: Objektleiste 

Diagramm Die Leiste erscheint nur, wenn im Dokument ein Diagramm 

selektiert wird. Beispiel: Diagrammleiste 

Gliederung Die Leiste erscheint nur, wenn die Gliederung des Dokuments 

angezeigt wird (siehe auch Abschnitt „Gliederungen“ ab Seite 

379). Beispiel: Gliederungsleiste 

Grafik Die Leiste erscheint nur, wenn im Dokument eine Grafik selek-

tiert wird. Beispiel: Grafikleiste 
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Um diese Einstellung für eine der Symbolleisten zu ändern, rufen Sie den Menübe-

fehl Ansicht > Symbolleisten auf, selektieren die Leiste in der Liste Symbolleis-

ten und wählen die gewünschte Option bei Sichtbar in Modus. 

Hinweis: Es ist normalerweise nicht empfehlenswert, diese Einstellung bei den 

Standard-Symbolleisten (Funktionsleiste, Formatleiste etc.) zu ändern. Diese Op-

tion ist in erster Linie für selbsterstellte Symbolleisten gedacht. 

Symbolleisten auf dem Bildschirm positionieren 

Nur bei „klassischen Menüs und Symbolleisten“: Dieser Abschnitt betrifft nur 

Anwender, die in den Einstellungen ausgewählt haben, dass sie das Programm 

mit klassischen Menüs und Symbolleisten bedienen möchten. (Informationen 

zum Anpassen des Ribbons finden Sie im Abschnitt „Ribbon (Menüband) an-

passen“ ab Seite 481.) 

Sie können jede einzelne Symbolleiste nach Belieben auf dem Bildschirm positio-

nieren. Verwenden Sie dazu eines der folgenden Verfahren: 

Ändern der Position mit dem Befehl Ansicht > Symbolleisten 

Sie können die Position einer Symbolleiste jederzeit mit dem Menübefehl Ansicht 

> Symbolleisten ändern. Gehen Sie dazu wie folgt vor: 

1. Rufen Sie den Menübefehl Ansicht > Symbolleisten auf. 

2. Selektieren Sie die gewünschte Symbolleiste per Mausklick in der Liste. 

3. Wählen Sie bei Position, wo die Symbolleiste platziert werden soll. 

Hinweis: Wenn Sie die Option Frei wählen, werden die Symbole der Symbolleiste 

in einem Fenster angezeigt, das wie ein Programmfenster frei bewegt, vergrößert 

und verkleinert werden kann. 

Ändern der Position mit der Maus 

Manche Symbolleisten lassen sich außerdem mit der Maus verschieben. Gehen Sie 

dazu wie folgt vor: 

1. Zeigen Sie mit der Maus auf einen leeren Bereich der Symbolleiste. 

2. Drücken Sie die linke Maustaste und halten Sie diese gedrückt. 
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3. Ziehen Sie die Symbolleiste bei weiterhin gedrückter Maustaste an die ge-

wünschte Position. 

4. Lassen Sie die Maustaste los, um die Symbolleiste dort abzusetzen. 

Hinweis: Die meisten Symbolleisten sind gegen das Verschieben mit der Maus 

verriegelt, um unbeabsichtigtes Verschieben zu verhindern. Sie können diese 

Verriegelung aber jederzeit lösen: Rufen Sie dazu den Menübefehl Ansicht > 

Symbolleisten auf, selektieren Sie die Leiste und schalten Sie die Option Nicht 

verschiebbar aus. Von nun an ist diese Leiste auch mit der Maus verschiebbar. 

Beim Verschieben ist übrigens eine Positionierhilfe aktiv: Wenn Sie die Symbol-

leiste in die Nähe einer der Kanten des Programmfensters ziehen, springt diese 

automatisch auf die entsprechende Kante. Lassen Sie die Leiste beispielsweise an 

der oberen Kante los, entspricht dies dem Wählen der Position Oben im Dialog-

fenster des Menübefehls Ansicht > Symbolleisten.  

Symbolleisten verwalten 

Nur bei „klassischen Menüs und Symbolleisten“: Dieser Abschnitt betrifft nur 

Anwender, die in den Einstellungen ausgewählt haben, dass sie das Programm 

mit klassischen Menüs und Symbolleisten bedienen möchten. (Informationen 

zum Anpassen des Ribbons finden Sie im Abschnitt „Ribbon (Menüband) an-

passen“ ab Seite 481.) 

Sie können jederzeit neue Symbolleisten erstellen und vorhandene Leisten löschen, 

umbenennen etc. Verwenden Sie hierzu die Schaltflächen im Dialogfenster des 

Menübefehls Ansicht > Symbolleisten. 

Neue Symbolleiste erstellen 

Das Programm lässt Sie jederzeit eigene Symbolleisten erstellen.  

Benötigen Sie beispielsweise häufig die Befehle des Menüs Fenster, die in der 

Standard-Funktionsleiste nicht vorhanden sind, wäre es überlegenswert, sich hier-

für eine eigene Symbolleiste anzulegen. 

Folgendermaßen erstellen Sie eine neue Symbolleiste: 

1. Betätigen Sie die Schaltfläche Neu (im Dialogfenster des Menübefehls Ansicht 

> Symbolleisten). 
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2. Es erscheint ein Dialogfenster, in das Sie einen Namen für die neue Leiste ein-

geben – zum Beispiel „Meine Symbolleiste“. Bestätigen Sie dann mit OK. 

3. Die neue Symbolleiste wurde angelegt. Schließen Sie das Dialogfenster oder 

klicken Sie auf die Schaltfläche Anpassen, um sie gleich mit Symbolen zu fül-

len. Lesen Sie dazu den Abschnitt „Symbole einer Symbolleiste anpassen“ ab 

Seite 475. 

Symbole einer Symbolleiste anpassen 

Mit der Schaltfläche Anpassen können Sie die Symbole auf Symbolleisten bear-

beiten. Informationen hierzu finden Sie im nächsten Abschnitt. 

Symbolleiste löschen 

Mit der Schaltfläche Löschen entfernen Sie eine selbsterstellte Symbolleiste: 

1. Selektieren Sie die zu löschende Symbolleiste in der Liste. 

2. Betätigen Sie die Schaltfläche Löschen. 

Hinweis: Sie können nur selbsterstellte Symbolleisten löschen. Die Standard-

Symbolleisten (Funktionsleiste, Formatleiste etc.) lassen sich nicht entfernen.  

Sie können eine Standard-Symbolleiste jedoch jederzeit ausschalten, wenn Sie sie 

nicht benötigen (siehe Abschnitt „Symbolleisten anzeigen/verbergen“ ab Seite 

470). 

Symbolleiste umbenennen 

Mit der Schaltfläche Umbenennen geben Sie einer selbsterstellten Symbolleiste 

einen anderen Namen: 

1. Selektieren Sie die gewünschte Symbolleiste in der Liste. 

2. Betätigen Sie die Schaltfläche Umbenennen. 

3. Tippen Sie den neuen Namen ein und bestätigen Sie mit OK. 

Hinweis: Sie können nur selbsterstellte Symbolleisten umbenennen. Die Standard-

Symbolleisten (Funktionsleiste, Formatleiste etc.) lassen sich nicht umbenennen. 
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Symbolleiste zurücksetzen 

Mit der Schaltfläche Zurücksetzen machen Sie alle Änderungen an einer der 

Standard-Symbolleisten rückgängig: 

1. Selektieren Sie die gewünschte Symbolleiste in der Liste. 

2. Betätigen Sie die Schaltfläche Zurücksetzen. 

Nun enthält die Symbolleiste wieder die Standard-Symbole. Außerdem wurden die 

Optionen Sichtbar in Modus... und Position auf die Standardeinstellung zurück-

gesetzt. 

Hinweis: Dieser Befehl ist nur auf die Standard-Symbolleisten (Funktionsleiste, 

Formatleiste etc.) anwendbar, nicht jedoch auf selbsterstellte Symbolleisten. 

Alle Symbolleisten zurücksetzen 

Mit der Schaltfläche Alle zurücksetzen machen Sie alle Änderungen an allen 

Standard-Symbolleisten rückgängig.  

Hinweis: Dieser Befehl wirkt sich nur auf die Standard-Symbolleisten aus. Selbst-

erstellte Symbolleisten bleiben unverändert erhalten. 

Symbole einer Symbolleiste anpassen 

Nur bei „klassischen Menüs und Symbolleisten“: Dieser Abschnitt betrifft nur 

Anwender, die in den Einstellungen ausgewählt haben, dass sie das Programm 

mit klassischen Menüs und Symbolleisten bedienen möchten. (Informationen 

zum Anpassen des Ribbons finden Sie im Abschnitt „Ribbon (Menüband) an-

passen“ ab Seite 481.) 

Der Menübefehl Weiteres > Anpassen erlaubt es Ihnen, die Symbole auf einer 

Symbolleiste nach Ihren Wünschen anzupassen. Sie können unter anderem Symbo-

le hinzufügen und vorhandene Symbole entfernen oder verschieben.  

Gehen Sie folgendermaßen vor: 

1. Rufen Sie den Menübefehl Weiteres > Anpassen auf. 

2. Verwenden Sie eines der unten beschriebenen Verfahren, um Symbole hinzuzu-

fügen, zu entfernen, zu verschieben etc. 

3. Verlassen Sie den Dialog mit Schließen. 
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Tipp: Dieser Befehl lässt sich auch durch einen Doppelklick auf einen leeren Be-

reich in einer beliebigen Symbolleiste aufrufen.  

Beim Aufruf des Befehls erscheint ein Dialogfenster. 

Dieses Dialogfenster enthält zwei Listen: 

 Linke Liste: alle verfügbaren Befehle 

 Die linke Liste zeigt sämtliche im Programm verfügbaren Befehle an.  

 Tipp: Über die Option Kategorien (oberhalb der linken Liste) können Sie die 

Liste nach einer bestimmten Kategorie filtern lassen (zum Beispiel alle Kom-

mandos der Kategorie „Datei“).  

 Außerdem können Sie in das Feld Schnellsuche etwas eintippen, um die Liste 

danach durchsuchen zu lassen. 

 Rechte Liste: Symbole der momentan ausgewählten Symbolleiste 

 Die rechte Liste zeigt die Symbole an, die sich in der momentan ausgewählten 

Symbolleiste befinden. 

 Welche Symbolleiste hier angezeigt werden soll, lässt sich über die aufklappba-

re Liste Anpassen (oberhalb der rechten Liste) festlegen.  

In dem Dialog lassen sich folgende Aktionen durchführen: 

Hinzufügen eines Symbols 

Um ein Symbol zu einer bestimmten Symbolleiste hinzuzufügen, führen Sie im 

Dialogfenster des Befehls Weiteres > Anpassen folgende Schritte durch: 

1. Wählen Sie in der aufklappbaren Liste Anpassen (oberhalb der rechten Liste) 

die Symbolleiste, zu der Sie ein Symbol hinzufügen möchten. 

 Die rechte Liste zeigt nun alle Symbole an, die sich momentan in der gewählten 

Symbolleiste befinden. 

2. Optional: Selektieren Sie in der rechten Liste das Symbol, hinter dem das neue 

Symbol eingefügt werden soll. 

3. Selektieren Sie in der linken Liste das Symbol, das Sie hinzufügen möchten. 

4. Klicken Sie auf die Schaltfläche >> (zwischen den Listen). 

Das Symbol wird der Symbolleiste nun hinzugefügt. 
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Tipp: Alternativ können Sie ein Symbol auch folgendermaßen einer (beliebigen) 

Symbolleiste hinzufügen: Rufen Sie den Befehl Weiteres > Anpassen auf. Zie-

hen Sie dann das Symbol einfach mit der Maus aus dem Dialogfenster heraus 

und lassen sie es an der gewünschten Position in der Symbolleiste fallen (in der 

Symbolleiste selbst, nicht im Dialog!). Dies setzt natürlich voraus, dass die 

Symbolleiste derzeit auf dem Bildschirm sichtbar ist. 

Entfernen eines Symbols 

Um ein Symbol aus einer Symbolleiste zu entfernen, führen Sie in dem Dialog 

folgende Schritte durch: 

1. Wählen Sie in der aufklappbaren Liste Anpassen (oberhalb der rechten Liste) 

die gewünschte Symbolleiste. 

2. Selektieren Sie in der rechten Liste das zu entfernende Symbol. 

3. Klicken Sie auf die Schaltfläche << (zwischen den Listen). 

Das Symbol wird nun aus der Symbolleiste entfernt. 

Tipp: Alternativ können Sie ein Symbol auch folgendermaßen aus einer Symbol-

leiste entfernen: Rufen Sie den Befehl Weiteres > Anpassen auf. Ziehen Sie 

dann das Symbol einfach mit der Maus aus der Symbolleiste nach unten heraus 

(in der Symbolleiste selbst, nicht im Dialog!). 

Verschieben eines Symbols 

Um ein Symbol in einer Symbolleiste zu verschieben, führen Sie in dem Dialog 

folgende Schritte durch: 

1. Wählen Sie in der aufklappbaren Liste Anpassen die gewünschte Symbolleiste. 

2. Selektieren Sie in der rechten Liste das zu verschiebende Symbol. 

3. Verwenden Sie die Schaltflächen mit dem Pfeil nach oben beziehungsweise 

unten (links neben der rechten Liste), um das Symbol innerhalb der Symbol-

leiste zu verschieben. 

 Hinweis: Wenn Sie ein Symbol auf eine andere Symbolleiste verschieben 

möchten, müssen Sie dieses erst aus seiner bisherigen Symbolleiste entfernen 

und es dann der anderen Symbolleiste hinzufügen. 
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Tipp 1: Alternativ können Sie ein Symbol auch folgendermaßen verschieben: 

Rufen Sie den Befehl Weiteres > Anpassen auf. Ziehen Sie das Symbol dann 

direkt in der Symbolleiste mit der Maus an die gewünschte Position (in der Sym-

bolleiste selbst, nicht im Dialog!). Bei dieser Methode können Sie ein Symbol 

übrigens auch direkt von einer Symbolleiste in eine andere verschieben. 

Tipp 2: Das Verschieben von Symbolen funktioniert übrigens auch, wenn dieser 

Dialog nicht geöffnet ist: Wenn Sie nämlich die Taste (Alt) gedrückt halten und 

dann auf ein Symbol in einer Symbolleiste klicken, können Sie dieses (bei wei-

terhin gedrückter Maustaste) nach Belieben verschieben. 

Einfügen einer Trennlinie (Separator) 

Um in einer Symbolleiste eine Trennlinie vor einem Symbol einzufügen, führen 

Sie in dem Dialog folgende Schritte durch: 

1. Wählen Sie in der aufklappbaren Liste Anpassen die gewünschte Symbolleiste. 

2. Selektieren Sie in der rechten Liste das Symbol, vor dem die Trennlinie einge-

fügt werden soll. 

3. Klicken Sie auf die Schaltfläche Neuer Trenner (unterhalb der rechten Liste). 

Die Trennlinie wird nun eingefügt. 

Tipp: Alternativ können Sie auch folgende Vorgehensweise verwenden: Rufen 

Sie den Befehl Weiteres > Anpassen auf. Um nun eine Trennlinie links von ei-

nem Symbol in einer beliebigen Symbolleiste einzufügen, ziehen Sie dieses 

Symbol einfach mit der Maus einige Millimeter nach rechts (in der Symbolleiste 

selbst, nicht im Dialog!).  

Entfernen einer Trennlinie 

Um eine Trennlinie aus einer Symbolleiste zu entfernen, führen Sie in dem Dialog 

folgende Schritte durch: 

1. Wählen Sie in der aufklappbaren Liste Anpassen die gewünschte Symbolleiste. 

2. Selektieren Sie in der rechten Liste die zu entfernende Trennlinie. 

3. Klicken Sie auf die Schaltfläche << (zwischen den Listen). 

Die Trennlinie wird nun aus der Symbolleiste entfernt. 
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Tipp: Alternativ können Sie auch folgende Vorgehensweise verwenden: Rufen 

Sie den Befehl Weiteres > Anpassen auf. Wenn Sie nun (in der Symbolleiste 

selbst, nicht im Dialog!) ein Symbol, das sich rechts von einer Trennlinie befin-

det, an das Symbol links davon heranziehen, wird diese Trennlinie entfernt. 

Zuweisen von Tastenkürzeln 

Wenn Sie in dem Dialog die Schaltfläche Tastenkürzel anklicken, erweitert sich 

der Dialog um eine zusätzliche Sektion namens Tastenkürzel, die zum Bearbeiten 

von Tastenkürzeln für Befehle verwendet werden kann.  

Kurzfassung: Sie können hier einem beliebigen Befehl ein Tastenkürzel Ihrer Wahl 

zuweisen: Selektieren Sie den Befehl dazu in einer der beiden Listen, klicken Sie 

in das Feld Bitte Tastenkürzel drücken und betätigen Sie dann die Tastenkombi-

nation, mit der Sie diesen Befehl künftig aufrufen möchten. 

Ausführliche Informationen dazu finden Sie im Abschnitt „Tastenkürzel anpassen“ 

(Seite 491). 

Verwalten von Symbolleisten 

Das Dialogfenster des Befehls Weiteres > Anpassen verfügt außerdem über 

Schaltflächen zum Verwalten von Symbolleisten: 

 Neu 

 Legt eine neue, leere Symbolleiste an. 

 Umbenennen 

 Benennt die in der Liste Anpassen gewählte Symbolleiste um (nur bei selbster-

stellten Symbolleisten möglich). 

 Zurücksetzen 

 Setzt die in der Liste Anpassen gewählte Symbolleiste wieder auf ihren Auslie-

ferungszustand zurück.  

 Löschen 

 Löscht die in der Liste Anpassen gewählte Symbolleiste (nur bei selbsterstell-

ten Symbolleisten möglich). 
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 Alle zurücksetzen (unterhalb der rechten Liste) 

 Setzt alle Symbolleisten wieder auf ihren Auslieferungszustand zurück.  

Weitere Möglichkeiten zum Verwalten und Konfigurieren von Symbolleisten bietet 

der Menübefehl Ansicht > Symbolleisten (siehe Abschnitt „Symbolleisten verwal-

ten“ ab Seite 473). 

Verwenden des Symbolleisten-Menüs 

Nur bei „klassischen Menüs und Symbolleisten“: Dieser Abschnitt betrifft nur 

Anwender, die in den Einstellungen ausgewählt haben, dass sie das Programm 

mit klassischen Menüs und Symbolleisten bedienen möchten. (Informationen 

zum Anpassen des Ribbons finden Sie im Abschnitt „Ribbon (Menüband) an-

passen“ ab Seite 481.) 

Einige Symbolleisten enden mit einem doppelten Pfeil » nach rechts, wie in fol-

gender Abbildung zu sehen: 

 

Wenn Sie diesen Doppelpfeil anklicken, öffnet sich das Symbolleisten-Menü für 

diese Leiste.  

Dieses Menü ermöglicht schnellen Zugriff auf alle Befehle zum Arbeiten mit Sym-

bolleisten, die in den vorherigen Abschnitten beschrieben wurden. Im Einzelnen 

gibt es im Symbolleisten-Menü folgende Befehle: 

 Schaltflächen hinzufügen/entfernen 

 Dieser Befehl zeigt eine Liste aller Symbole für eine Symbolleiste an. Klicken 

Sie einen der Einträge an, wird das entsprechende Symbol in der Leiste ein- be-

ziehungsweise ausgeschaltet. 

 (Dieser Befehl soll nur zum schnellen Ein- oder Ausschalten von Symbolen 

dienen. Wie Sie die Symbole auf einer Leiste individuell konfigurieren, ist im 

Abschnitt „Symbole einer Symbolleiste anpassen“ ab Seite 475 beschrieben.) 

 Position 

 Mit diesem Befehl können Sie die Position der Symbolleiste ändern. Verfügba-

re Optionen: oben, unten, links, rechts oder frei (in einem kleinen Fenster, des-

sen Position und Größe sich mit der Maus beliebig ändern lassen). 
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 Symbolleisten 

 Ruft den Menübefehl Ansicht > Symbolleisten auf, mit dem Sie Symbolleisten 

ein-/ausschalten, konfigurieren und verwalten können. 

 Siehe Abschnitt „Symbolleisten anpassen“ ab Seite 469. 

 Anpassen 

 Ruft den Menübefehl Weiteres > Anpassen auf, mit dem Sie die Symbole einer 

Symbolleiste bearbeiten können (Symbole hinzufügen, entfernen, verschieben 

etc.). 

 Siehe Abschnitt „Symbole einer Symbolleiste anpassen“ ab Seite 475. 

 Diese Symbolleiste zurücksetzen 

 Setzt die Symbolleiste zurück. Die Leiste zeigt dann wieder ihre Standardsym-

bole an. Außerdem werden alle Einstellungen, die zu der Leiste gemacht wur-

den, verworfen. 

Ribbon (Menüband) anpassen 

Nur bei „Ribbons“: Dieser Abschnitt betrifft nur Anwender, die in den Einstel-

lungen ausgewählt haben, dass sie das Programm mit dem Ribbon (Menüband) 

bedienen möchten. (Informationen zum Anpassen der klassischen Menüs und 

Symbolleisten finden Sie im Abschnitt „Symbolleisten anpassen“ ab Seite 469.) 

Tipp: Die Benutzeroberfläche lässt sich jederzeit zwischen Ribbon und klassi-

schen Menüs mit Symbolleisten umschalten. Rufen Sie dazu im Menü den Befehl 

Weiteres > Einstellungen auf (beziehungsweise im Ribbon den Befehl Datei > 

Einstellungen). Wechseln Sie in dem Dialog auf die Karteikarte Aussehen und 

klicken Sie darin auf die Schaltfläche Benutzeroberfläche. Es erscheint ein wei-

terer Dialog, in dem Sie die gewünschte Art von Benutzeroberfläche wählen 

können. 

In diesem Abschnitt erfahren Sie, wie Sie das Ribbon (Menüband) konfigurieren 

und um zusätzliche Symbole erweitern können.  
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Das „Ribbon“ (Ausschnitt) und die Schnellzugriffsleiste (unten) 

Folgende Themen werden darin behandelt: 

 Ribbon anzeigen/verbergen 

 Position der Schnellzugriffsleiste ändern 

 Symbole im Ribbon anpassen 

 Symbole der Schnellzugriffsleiste anpassen 

Informationen dazu finden Sie, in obiger Reihenfolge, auf den nächsten Seiten. 

Ribbon anzeigen/verbergen 

Nur bei „Ribbons“: Dieser Abschnitt betrifft nur Anwender, die in den Einstel-

lungen ausgewählt haben, dass sie das Programm mit dem Ribbon (Menüband) 

bedienen möchten. (Informationen zum Anpassen der klassischen Menüs und 

Symbolleisten finden Sie im Abschnitt „Symbolleisten anpassen“ ab Seite 469.) 

Normalerweise ist das Ribbon-Menüband immer vollständig zu sehen: 

 

Das „Ribbon“ (Ausschnitt) und die Schnellzugriffsleiste (unten) 

Sie können das Ribbon aber jederzeit ausblenden, indem Sie es minimieren. Dies 

ist hilfreich, wenn Sie auf dem Bildschirm möglichst viel Platz für die Anzeige des 

Dokuments erhalten möchten. 
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Gehen Sie wie folgt vor: 

1. Klicken Sie im Ribbon auf das Symbol Anpassen in der Karteikarte Datei. 

2. Es öffnet sich ein Menü. Darin finden Sie eine Option namens Minimiertes 

Ribbon, die sich durch Anklicken ein- beziehungsweise ausschalten lässt. (Ein 

Häkchen erscheint vor der Option, wenn sie derzeit eingeschaltet ist.)  

Wenn Sie diese Option einschalten, wird das Ribbon minimiert dargestellt. Es sind 

dann nur noch seine Karteikartenreiter zu sehen. 

Tipp: Sie können alternativ auch das Symbol  in der rechten oberen Ecke des 

Programmfensters anklicken, um das Ribbon zu minimieren. Wenn Sie das Sym-

bol erneut anklicken, wird das Minimieren wieder aufgehoben. 

Darüber hinaus können Sie die Tastenkombination (Strg)(F1) (beim Mac: 
(Cmd)(F1)) verwenden, um das Minimieren ein-/auszuschalten. 

Arbeiten mit einem minimierten Ribbon 

Folgendermaßen arbeiten Sie mit einem minimierten Ribbon: 

 Wenn Sie einen der Karteikartenreiter des minimierten Ribbons anklicken, wird 

das Ribbon vorübergehend wieder vollständig sichtbar und zeigt die entspre-

chende Karteikarte an. Sobald Sie darin aber ein Kommando auslösen (also 

z.B. das Symbol für einen Befehl anklicken), wird das Ribbon automatisch 

wieder minimiert. 

 Wenn Sie auf einen der Karteikartenreiter doppelklicken, wird das Ribbon dau-

erhaft wieder sichtbar, das Minimieren wird also aufgehoben.  

 Wie oben bereits als Tipp erwähnt, können Sie außerdem das Symbol  in der 

rechten oberen Ecke des Programmfensters verwenden, um das Minimieren des 

Ribbons ein-/auszuschalten. 

Position der Schnellzugriffsleiste ändern 

FreeOffice: Das Anpassen der Schnellzugriffsleiste ist in SoftMaker FreeOffice 

nicht enthalten. 
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Nur bei „Ribbons“: Dieser Abschnitt betrifft nur Anwender, die in den Einstel-

lungen ausgewählt haben, dass sie das Programm mit dem Ribbon (Menüband) 

bedienen möchten. (Informationen zum Anpassen der klassischen Menüs und 

Symbolleisten finden Sie im Abschnitt „Symbolleisten anpassen“ ab Seite 469.) 

Unter dem Ribbon wird die Schnellzugriffsleiste angezeigt. Diese bietet eine Aus-

wahl an besonders häufig benötigten Befehlen. 

 

Das „Ribbon“ (Ausschnitt) und die Schnellzugriffsleiste (unten) 

Die Schnellzugriffsleiste kann sich wahlweise den Platz mit den Registerkarten für 

Dokumente teilen – oder in seiner eigenen Leiste untergebracht sein. Um dies zu 

ändern, gehen Sie folgendermaßen vor: 

1. Klicken Sie im Ribbon auf das Symbol Anpassen in der Karteikarte Datei. 

2. Es öffnet sich ein Menü, das einen der folgenden beiden Befehle enthält: 

 Schnellzugriffsleiste als separate Leiste anzeigen: Standardmäßig wird die 

Schnellzugriffsleiste in der Leiste angezeigt, in der sich auch die Registerkarten 

für Dokumente befinden. Wenn Sie diesen Befehl aufrufen, wandert die 

Schnellzugriffsleiste stattdessen in seine eigene Leiste. 

 Schnellzugriffsleiste links der Dokumentregisterkarten anzeigen: Dieser 

Befehl macht genau das Gegenteil: Wenn die Schnellzugriffsleiste derzeit als 

separate Symbolleiste angezeigt wird, bewirkt das Aufrufen dieses Befehls, 

dass die Schnellzugriffsleiste nun wieder in die Leiste mit den Registerkarten 

für Dokumente befördert wird. 

Symbole im Ribbon anpassen 

FreeOffice: Die Funktion Ribbon anpassen ist in SoftMaker FreeOffice nicht 

enthalten. 
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Nur bei „Ribbons“: Dieser Abschnitt betrifft nur Anwender, die in den Einstel-

lungen ausgewählt haben, dass sie das Programm mit dem Ribbon (Menüband) 

bedienen möchten. (Informationen zum Anpassen der klassischen Menüs und 

Symbolleisten finden Sie im Abschnitt „Symbolleisten anpassen“ ab Seite 469.) 

Der Ribbonbefehl Datei > Anpassen > Ribbon anpassen ermöglicht es Ihnen, das 

Ribbon in einem gewissen Rahmen anzupassen. In erster Linie soll dieser Befehl 

dazu dienen, dem Ribbon zusätzliche Symbole, Sektionen oder gar komplette Kar-

teikarten hinzuzufügen.  

Wichtig: Die Symbole in den vorgegebenen Sektionen auf dem Ribbon lassen 

sich nicht verändern. Sie können in den vorhandenen Sektionen also weder 

Symbole hinzufügen, noch Symbole entfernen, noch deren Reihenfolge ändern. 

Zusätzliche Symbole lassen sich nur in neuen Sektionen am Ende einer Kartei-

karte einfügen (oder wahlweise in einer komplett neuen Karteikarte). 

Gehen Sie zum Anpassen des Ribbons wie folgt vor: 

1. Rufen Sie im Ribbon den Befehl Datei > Anpassen > Ribbon anpassen auf. 

2. Verwenden Sie eines der unten beschriebenen Verfahren, um die Symbole auf 

einer Karteikarte des Ribbons zu bearbeiten. 

3. Verlassen Sie den Dialog mit Schließen. 

Tipp: Dieser Befehl lässt sich auch durch einen Doppelklick auf einen beliebigen 

leeren Bereich innerhalb des Ribbons aufrufen.  

Beim Aufruf des Befehls erscheint ein Dialogfenster. 

Dieses Dialogfenster enthält zwei Listen: 

 Linke Liste: alle verfügbaren Befehle 

 Die linke Liste zeigt sämtliche im Programm verfügbaren Befehle an.  

 Tipp: Über die Option Kategorien (oberhalb der linken Liste) können Sie die 

Liste nach einer bestimmten Kategorie filtern lassen (zum Beispiel alle Kom-

mandos der Kategorie „Datei“).  

 Außerdem können Sie in das Feld Schnellsuche etwas eintippen, um die Liste 

danach durchsuchen zu lassen. 
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 Rechte Liste: Symbole der momentan ausgewählten Karteikarte des Rib-

bons 

 Die rechte Liste zeigt die Symbole an, die sich in der ausgewählten Karteikarte 

des Ribbons befinden. 

 Welche Karteikarte hier angezeigt werden soll, lässt sich über die aufklappbare 

Liste Anpassen (oberhalb der rechten Liste) festlegen.  

In dem Dialog lassen sich folgende Aktionen durchführen: 

Hinzufügen eines Symbols 

Hinweis: Sie können Symbole nur in selbst hinzugefügten Sektionen (oder kom-

plett neuen Karteikarten) hinzufügen. Das Einfügen eines Symbols innerhalb der 

vorgegebenen Sektionen ist nicht möglich.  

Um ein Symbol zu einer bestimmten Karteikarte des Ribbons hinzuzufügen, führen 

Sie im Dialogfenster des Ribbonbefehls Datei > Anpassen > Ribbon anpassen 

folgende Schritte durch: 

1. Wählen Sie in der aufklappbaren Liste Anpassen (oberhalb der rechten Liste) 

die Karteikarte, zu der Sie ein Symbol hinzufügen möchten. 

 Die rechte Liste zeigt nun alle Symbole an, die sich momentan auf dieser Kar-

teikarte befinden. 

2. Selektieren Sie in der linken Liste das Symbol, das Sie hinzufügen möchten. 

3. Klicken Sie auf die Schaltfläche >> (zwischen den Listen). 

Das Symbol wird der Karteikarte nun hinzugefügt. Falls nötig, legt das Programm 

dazu automatisch eine neue Sektion am Ende der Karteikarte an. 

Entfernen eines Symbols 

Hinweis: Sie können nur selbst hinzugefügte Symbole entfernen. Das Löschen 

eines der vorgegebenen Symbole ist nicht möglich.  

Um eines der von Ihnen hinzugefügten Symbole von einer Karteikarte zu entfer-

nen, führen Sie in dem Dialog folgende Schritte durch: 

1. Wählen Sie in der aufklappbaren Liste Anpassen die Karteikarte, auf der sich 

das Symbol befindet. 
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2. Selektieren Sie in der rechten Liste das zu entfernende Symbol. 

3. Klicken Sie auf die Schaltfläche << (zwischen den Listen). 

Das Symbol wird nun von der Karteikarte entfernt. 

Verschieben eines Symbols 

Hinweis: Sie können nur selbst hinzugefügte Symbole verschieben. Das Ändern 

der Position eines der vorgegebenen Symbole ist nicht möglich.  

Um ein Symbol in einer Karteikarte zu verschieben, führen Sie in dem Dialog fol-

gende Schritte durch: 

1. Wählen Sie in der aufklappbaren Liste Anpassen die Karteikarte, auf der sich 

das Symbol befindet. 

2. Selektieren Sie in der rechten Liste das zu verschiebende Symbol. 

3. Verwenden Sie die Schaltflächen mit dem Pfeil nach oben beziehungsweise 

unten (links neben der rechten Liste), um das Symbol innerhalb der Karteikarte 

zu verschieben. 

 Hinweis: Wenn Sie ein Symbol auf eine andere Karteikarte verschieben möch-

ten, müssen Sie dieses erst aus seiner bisherigen Karteikarte entfernen und es 

dann der anderen Karteikarte hinzufügen. 

Hinzufügen einer neuen Sektion 

Hinweis: Neue Sektionen lassen sich nur hinter den vorgegebenen Sektionen 

hinzufügen. Das Einfügen einer selbsterstellten Sektion zwischen den vorgege-

benen Sektionen ist nicht möglich. 

Um einer Karteikarte eine neue Sektion (einen neuen Abschnitt) hinzuzufügen, 

führen Sie in dem Dialog folgende Schritte durch: 

1. Wählen Sie in der aufklappbaren Liste Anpassen die gewünschte Karteikarte. 

2. Klicken Sie auf die Schaltfläche Neue Sektion (unterhalb der rechten Liste). 

Die neue Sektion wird nun (am Ende der Karteikarte) angelegt. 
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Umbenennen einer Sektion 

Hinweis: Nur selbsterstellte Sektionen lassen sich umbenennen. Das Umbenen-

nen einer der vorgegebenen Sektionen ist nicht möglich.  

Um eine selbsterstellte Sektion in einer Karteikarte umzubenennen, führen Sie in 

dem Dialog folgende Schritte durch: 

1. Wählen Sie in der aufklappbaren Liste Anpassen die gewünschte Karteikarte. 

2. Selektieren Sie in der rechten Liste die gewünschte Sektion. 

3. Klicken Sie auf die Schaltfläche Umbenennen (unterhalb der rechten Liste). 

4. Tippen Sie den neuen Namen ein und bestätigen Sie ihn. 

Die Sektion wird nun entsprechend umbenannt. 

Entfernen einer Sektion 

Hinweis: Nur selbsterstellte Sektionen lassen sich entfernen. Das Löschen einer 

der vorgegebenen Sektionen ist nicht möglich. 

Um eine selbsterstellte Sektion von einer Karteikarte zu entfernen, führen Sie in 

dem Dialog folgende Schritte durch: 

1. Wählen Sie in der aufklappbaren Liste Anpassen die gewünschte Karteikarte. 

2. Selektieren Sie in der rechten Liste die gewünschte Sektion. 

3. Klicken Sie auf die Schaltfläche << (zwischen den Listen). 

Die Sektion wird nun aus der Karteikarte entfernt. 

Zuweisen von Tastenkürzeln 

Wenn Sie in dem Dialog die Schaltfläche Tastenkürzel anklicken, erweitert sich 

der Dialog um eine zusätzliche Sektion namens Tastenkürzel, die zum Bearbeiten 

von Tastenkürzeln verwendet werden kann.  

Kurzfassung: Sie können darin einem beliebigen Befehl ein Tastenkürzel Ihrer 

Wahl zuweisen: Selektieren Sie den Befehl dazu in einer der beiden Listen, klicken 

Sie in das Feld Bitte Tastenkürzel drücken und betätigen Sie dann die Tasten-

kombination, mit der Sie diesen Befehl künftig aufrufen möchten. 
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Ausführliche Informationen dazu finden Sie im Abschnitt „Tastenkürzel anpassen“ 

(Seite 491). 

Verwalten der Karteikarten des Ribbons 

Das Dialogfenster dieses Befehls verfügt außerdem über Schaltflächen zum Ver-

walten der Karteikarten des Ribbons: 

 Neu 

 Legt eine neue, leere Karteikarte an. 

 Umbenennen 

 Benennt die in der Liste Anpassen gewählte Karteikarte um (nur bei selbster-

stellten Karteikarten möglich). 

 Zurücksetzen 

 Setzt die in der Liste Anpassen gewählte Karteikarte wieder auf ihren Ausliefe-

rungszustand zurück.  

 Löschen 

 Löscht die in der Liste Anpassen gewählte Karteikarte (nur bei selbsterstellten 

Karteikarten möglich). 

 Alle zurücksetzen (unterhalb der rechten Liste) 

 Setzt alle Karteikarten wieder auf den Auslieferungszustand zurück.  

Symbole der Schnellzugriffsleiste anpassen 

FreeOffice: Das Anpassen der Schnellzugriffsleiste ist in SoftMaker FreeOffice 

nicht enthalten. 

Nur bei „Ribbons“: Dieser Abschnitt betrifft nur Anwender, die in den Einstel-

lungen ausgewählt haben, dass sie das Programm mit dem Ribbon (Menüband) 

bedienen möchten. (Informationen zum Anpassen der klassischen Menüs und 

Symbolleisten finden Sie im Abschnitt „Symbolleisten anpassen“ ab Seite 469.) 

Unter dem Ribbon wird die Schnellzugriffsleiste angezeigt. Diese bietet eine Aus-

wahl an besonders häufig benötigten Befehlen. 
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Das „Ribbon“ (Ausschnitt) und die Schnellzugriffsleiste (unten) 

Wenn Sie möchten, können Sie die Symbole auf der Schnellzugriffsleiste jederzeit 

anpassen, also beispielsweise Symbole hinzufügen, entfernen, verschieben etc.  

Rufen Sie dazu im Ribbon den Befehl Datei > Anpassen > Schnellzugriffsleiste 

anpassen auf. Es erscheint daraufhin ein Dialog zum Anpassen von Symbolleisten, 

in dem Sie die gewünschten Änderungen vornehmen können.  

Die Schnellzugriffsleiste verhält sich dabei exakt wie eine klassische Symbolleiste. 

Zum Anpassen ihrer Symbole können Sie also genau so vorgehen, wie es im Ab-

schnitt „Symbole einer Symbolleiste anpassen“ (ab Seite 475) beschrieben ist. Alle 

dort gemachten Erläuterungen treffen auch auf die Schnellzugriffsleiste zu – bis 

auf den Abschnitt „Verwalten von Symbolleisten“.  

Benutzerdefinierte Symbole erstellen 

FreeOffice: Die Funktion Ribbon anpassen in SoftMaker FreeOffice nicht ent-

halten. 

Sie können jederzeit benutzerdefinierte Symbole anlegen und diese dann einer 

Symbolleiste oder dem Ribbon hinzufügen. Mit solchen Symbolen lassen sich be-

liebige Programme starten. 

Um ein benutzerdefiniertes Symbol anzulegen – zum Beispiel eines zum Starten 

des Windows-Editors –, gehen Sie folgendermaßen vor: 

1. Rufen Sie im Menü beziehungsweise im Ribbon den folgenden Befehl auf: 

 Menü: Weiteres > Anpassen 

 Ribbon: Datei > Anpassen > Ribbon anpassen 

2. Wählen Sie in der aufklappbaren Liste Kategorien den Eintrag Benutzer. 
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3. Wählen Sie eines der Symbole in der Liste Befehle.  

 Die ersten drei Symbole sind (als Beispiele) mit dem Windows-Taschenrechner, 

der Windows-Zeichentabelle und der Windows-Systemsteuerung vorbelegt. 

Wählen Sie beispielsweise das vierte Symbol. 

4. Klicken Sie auf die Schaltfläche Bearbeiten unter der Liste. Er erscheint da-

raufhin ein weiteres Dialogfenster. 

5. Tragen Sie in dem neuen Dialogfenster bei Beschreibung eine kurze Beschrei-

bung für das zu startende Programm ein – zum Beispiel „Windows-Editor“. 

6. Bei Befehlszeile geben Sie den vollständigen Pfad und Dateinamen des zu star-

tenden Programms an – zum Beispiel C:\WINDOWS\NOTEPAD.EXE. 

7. Optional: Falls Sie möchten, dass für das Programm ein anderes Symbol als 

sein Standardsymbol angezeigt werden soll, tragen Sie bei Symboldatei den 

Pfad und Dateinamen der gewünschten Symboldatei ein.  

 Beachten Sie dabei, dass Symbole in Symbolleisten etwas kleiner sind als die 

üblichen Windows-Symbole. 

Sobald Sie mit OK bestätigen, wird das benutzerdefinierte Symbol angelegt.  

Falls Sie das benutzerdefinierte Symbol nun gleich einer Symbolleiste bezie-

hungsweise dem Ribbon hinzufügen möchten, gehen Sie vor wie in den folgenden 

Abschnitten beschrieben: 

 Symbolleisten: Abschnitt „Symbole einer Symbolleiste anpassen“ (Seite 475) 

 Ribbon: Abschnitt „Symbole im Ribbon anpassen“ (Seite 484) 

Tastenkürzel anpassen 

FreeOffice: Die Funktion Tastenkürzel anpassen ist in SoftMaker FreeOffice 

nicht enthalten. 

Die in einem Programm am häufigsten benötigten Befehle können auch über Tas-

tenkürzel aufgerufen werden. So lässt sich der Befehl zum Speichern des aktuellen 

Dokuments beispielsweise blitzschnell mit der Tastenkombination (Strg)(S) aus-

führen.  
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Die vorgegebenen Tastenkürzel lassen sich im Dialogfenster des Menübefehls 

Weiteres > Anpassen jederzeit anpassen. Sie können beliebigen Befehlen ein Tas-

tenkürzel zuordnen und vorhandene Tastenkürzel ändern oder entfernen.  

Gehen Sie dazu folgendermaßen vor: 

Tastenkürzel hinzufügen 

Um einem Befehl ein Tastenkürzel zuzuweisen, führen Sie folgende Schritte durch: 

1. Rufen Sie im Menü beziehungsweise im Ribbon den folgenden Befehl auf: 

 Menü: Weiteres > Anpassen 

 Ribbon: Datei > Anpassen > Ribbon anpassen 

2. Klicken Sie auf die Schaltfläche Tastenkürzel.  

 Der Dialog erweitert sich nun um eine zusätzliche Sektion namens Tastenkür-

zel, die zum Bearbeiten von Tastenkürzeln verwendet werden kann.  

3. Wählen Sie wahlweise in der linken oder rechten Liste den Befehl, dem Sie ein 

Tastenkürzel zuweisen möchten.  

 Die linke Liste zeigt dabei alle im Programm verfügbaren Befehle an. (Über die 

Option Kategorien können Sie diese Liste nach einer bestimmten Kategorie 

filtern und über das Feld Schnellsuche eine Suche durchführen). 

 Die rechte Liste zeigt nur die Symbole an, die sich in der momentan ausge-

wählten Symbolleiste beziehungsweise Ribbon-Karteikarte befinden. 

4. Nachdem Sie den gewünschten Befehl ausgewählt haben, klicken Sie in das 

Eingabefeld Bitte Tastenkürzel drücken und betätigen die Tastenkombination, 

die Sie dem Befehl geben möchten. 

 Tipp: Falls Sie sich dabei vertippen, können Sie das eingegebene Tastenkürzel 

mit der Rücktaste (æ__) wieder löschen. 

5. Nicht vergessen: Klicken Sie auf Hinzufügen, um dem Befehl dieses Tasten-

kürzel jetzt zuzuweisen.  

6. Verlassen Sie den Dialog mit Schließen. 

Der gewählte Befehl kann von nun an mit der angegebenen Tastenkombination 

aufgerufen werden. 
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Tastenkürzel bearbeiten (entfernen, ändern etc.) 

Sie können außerdem die vorhandenen Tastenkürzel für Befehle jederzeit bearbei-

ten, also Kürzel beispielsweise löschen oder ändern. Gehen Sie wie folgt vor: 

1. Rufen Sie den folgenden Befehl im Menü oder im Ribbon auf: 

 Menü: Weiteres > Anpassen 

 Ribbon: Datei > Anpassen > Ribbon anpassen 

2. Klicken Sie auf die Schaltfläche Tastenkürzel.  

 Der Dialog erweitert sich nun um eine zusätzliche Sektion namens Tastenkür-

zel, die zum Bearbeiten von Tastenkürzeln verwendet werden kann.  

3. Wählen Sie wahlweise in der linken oder rechten Liste den Befehl, dessen Tas-

tenkürzel Sie bearbeiten möchten.  

4. Führen Sie in der Sektion Tastenkürzel eine der folgenden Aktionen durch: 

 Tastenkürzel entfernen: Die Liste Aktuelle Tastenkürzel zeigt alle Tastenkürzel 

an, die dem ausgewählten Befehl derzeit zugewiesen sind. Um ein Kürzel zu 

entfernen, selektieren Sie es in dieser Liste und klicken auf Entfernen. 

 Tastenkürzel ändern: Um das Tastenkürzel für einen Befehl abzuändern, entfer-

nen Sie dieses erst (wie gerade beschrieben) und weisen ihm dann ein neues 

Kürzel zu (wie am Anfang dieses Abschnitts beschrieben). 

 Tastenkürzel zurücksetzen: Um alle Tastenkürzel für das komplette Programm 

auf die Vorgaben zurückzusetzen, klicken Sie auf die Schaltfläche Alle Tasten-

kürzel zurücksetzen und bestätigen die Sicherheitsabfrage. Sämtliche Ände-

rungen, die Sie an Tastenkürzeln vorgenommen haben, werden dann verworfen.  

 Liste aller Tastenkürzel ansehen: Wenn Sie die Schaltfläche Exportieren ankli-

cken, erscheint eine Tabelle mit allen momentan zugewiesenen Tastenkürzeln. 

Mit den Schaltflächen neben der Tabelle können Sie diese unter anderem in die 

Zwischenablage kopieren. 

5. Verlassen Sie den Dialog mit Schließen. 

Verfügbare Tastenkürzel 

Beachten Sie, dass nicht alle Tastenkombinationen, die Sie auf Ihrer Tastatur er-

zeugen können, auch für Tastenkürzel erlaubt sind. 
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In der Regel sollten Sie für Tastenkürzel Buchstabentasten, Zahlentasten oder 

Funktionstasten verwenden und diese mit den Tasten (Strg), (Alt) und/oder der 

Umschalttaste (ª) kombinieren. 

Sie können ganz einfach überprüfen, ob die von Ihnen gewünschte Tastenkombina-

tion zulässig ist: Betätigen Sie diese Tastenkombination im Feld Bitte Tastenkür-

zel drücken des oben beschrieben Dialogs. Wenn sie nicht erscheint, ist sie nicht 

zulässig.  

Einige Beispiele für gültige Tastenkürzel: 

 (Strg)(A) 

 (Alt)(A) (Tastenkombinationen mit der Alt-Taste sind allerdings nicht zu emp-

fehlen – (Alt)(A) ist beispielsweise für den Aufruf des Menüs Ansicht zustän-

dig!) 

 (Strg)(Alt)(A) 

 (Strg)(ª)(A) 

 (Strg)(Alt)(ª)(A) 

 (Strg)(F2) 

 etc. 

Hinweis: Buchstaben allein sind natürlich nicht zulässig. Sie können also nicht (A) 

oder (ª)(A) als Tastenkürzel verwenden. 

Tastenkürzel bereits belegt: Wenn Sie ein Tastenkürzel drücken, das bereits vergeben 

ist, wird unter dem Eingabefeld angezeigt, womit dieses Kürzel momentan belegt 

ist. Sie sollten dann die Rücktaste (æ__) betätigen, um das Tastenkürzel wieder zu 

löschen und ein anderes Tastenkürzel nehmen. Andernfalls überschreiben Sie die 

bisherige Zuordnung dieses Kürzels. 

Zweiteilige Tastenkürzel: Sie können auch zweiteilige Tastenkürzel verwenden (ent-

sprechend dem WordStar-Standard) – zum Beispiel (Strg)(K)(X). Hierbei sind al-

lerdings nur Tastenkürzel nach dem Schema „Strg + Buchstabe + Buchstabe“ zu-

lässig. 

Listen für das automatische Füllen editieren 

Wie im Abschnitt „Automatisches Füllen von Zellen“ ab Seite 87 beschrieben, 

können Sie mit dem Menübefehl Bearbeiten > Ausfüllen einen Zellbereich mit 

einem gleichbleibenden Wert oder einer Sequenz von Werten füllen. 
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Mit dem Menübefehl Weiteres > Listen editieren können Sie eigene Listen für 

diese Funktion erstellen und bearbeiten. 

Erzeugen Sie beispielsweise eine Liste mit dem Inhalt „Rot“, „Grün“ und „Blau“ 

und füllen dann, ausgehend von einer Zelle mit dem Inhalt „Rot“, weitere Zellen, 

so werden diese mit Grün, Blau, Rot, Grün, Blau etc. gefüllt. 

Das Dialogfenster des Menübefehl Weiteres > Listen editieren verfügt dazu über 

Schaltflächen mit folgenden Funktionen: 

 Schaltfläche „Neu“: Neue Liste erstellen 

 Schaltfläche „Bearbeiten“: Liste bearbeiten 

 Schaltfläche „Löschen“: Liste löschen 

 Schaltfläche „Importieren“: Aus den derzeit markierten Zellen eine Liste 

erzeugen 

Ausführliche Informationen dazu finden Sie auf den nächsten Seiten. 

Liste für das automatische Füllen erstellen 

Um eine neue Liste für die Funktion Ausfüllen zu erstellen, gehen Sie wie folgt 

vor: 

1. Rufen Sie den Menübefehl Weiteres > Listen editieren auf. 

2. Betätigen Sie die Schaltfläche Neu. 

3. Es erscheint ein Dialogfenster. Geben Sie darin die gewünschten Listeneinträge 

ein. Beachten Sie dabei, dass in jeder Zeile nur ein Eintrag stehen darf. Sie 

können jederzeit die Eingabetaste (¢) betätigen, um eine neue Zeile einzufü-

gen.  

4. Klicken Sie dann auf OK. 

Die neue Liste wurde nun angelegt. 

Liste für das automatische Füllen bearbeiten 

Um eine von Ihnen erstellte Liste für die Funktion Ausfüllen zu bearbeiten, gehen 

Sie wie folgt vor: 

1. Rufen Sie den Menübefehl Weiteres > Listen editieren auf. 
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2. Selektieren Sie die zu bearbeitende Liste per Mausklick. 

 Hinweis: Die vorgegebenen Beispiellisten können nicht bearbeitet werden. 

3. Betätigen Sie die Schaltfläche Bearbeiten. 

4. Es erscheint ein Dialogfenster mit den Listeneinträgen. Bearbeiten Sie diese 

nach Wunsch. Beachten Sie dabei, dass in jeder Zeile nur ein Eintrag stehen 

darf. Sie können jederzeit die Eingabetaste (¢) betätigen, um eine neue Zeile 

einzufügen.  

5. Klicken Sie dann auf OK. 

Die Liste wurde nun entsprechend geändert. 

Liste für das automatische Füllen löschen 

Um eine von Ihnen erstellte Liste für die Funktion Ausfüllen zu löschen, gehen Sie 

wie folgt vor: 

1. Rufen Sie den Menübefehl Weiteres > Listen editieren auf. 

2. Selektieren Sie die zu bearbeitende Liste per Mausklick. 

 Hinweis: Die vorgegebenen Beispiellisten können nicht gelöscht werden. 

3. Betätigen Sie die Schaltfläche Löschen. 

Die Liste wurde nun entfernt. 

Liste für das automatische Füllen importieren 

Wenn ein PlanMaker-Dokument eine Reihe von Zellen hat, die Sie gerne als Liste 

zum automatischen Füllen speichern möchten, gehen Sie vor folgt vor: 

1. Markieren Sie die Zellen, aus denen eine Liste erstellt werden soll. 

2. Rufen Sie den Menübefehl Weiteres > Listen editieren auf. 

3. Betätigen Sie die Schaltfläche Importieren. 

PlanMaker liest die markierten Zellen nun aus und erstellt eine neue Liste aus de-

ren Inhalten. Jede markierte Zelle wird dabei ein Listeneintrag. 

Wenn Sie dabei mehrere Zeilen und Spalten markiert haben, legt PlanMaker ent-

sprechend auch mehrere Listen an. Zuvor erscheint eine Rückfrage, ob Sie die Da-



 

Handbuch PlanMaker Anpassen von PlanMaker  •  497 

ten zeilenweise oder spaltenweise importieren möchten. Wählen Sie Zeilenweise, 

wenn jede Zeile zu einer Liste werden soll, beziehungsweise Spaltenweise, wenn 

jede Spalte zu einer Liste werden soll. 

Installieren zusätzlicher Wörterbücher 

FreeOffice: Bei SoftMaker FreeOffice sind die in SoftMaker Office norma-

lerweise enthaltenen hochwertigen SoftMaker-Wörterbücher nicht verfügbar. 

Hier können ausschließlich Hunspell-Wörterbücher verwendet werden.  

Sie können bei Bedarf weitere Wörterbücher für die Rechtschreibprüfung installie-

ren. Wie das geht, ist in den nachfolgenden Abschnitten beschrieben: 

 Installieren zusätzlicher SoftMaker-Wörterbücher 

 In diesem Abschnitt erfahren Sie, wie Sie momentan nicht installierte SoftMa-

ker-Wörterbücher nachinstallieren. 

 Hinweis: Dies ist nur für die Android-Version relevant, denn bei SoftMaker 

Office für Windows, Mac und Linux werden stets alle SoftMaker-

Wörterbücher installiert. 

 Installieren von Hunspell-Wörterbüchern 

 Windows, Mac und Linux: Neben den SoftMaker-Wörterbüchern lassen sich 

in SoftMaker Office auch freie Hunspell-Wörterbücher verwenden. Lesen Sie 

dazu diesen Abschnitt. 

 Wählen eines anderen Wörterbuchs für eine Sprache 

 Windows, Mac und Linux: Wenn Sie für eine Sprache mehrere Wörterbücher 

installiert haben (z.B. eines von SoftMaker und eines von Hunspell), können 

Sie außerdem festlegen, welches dieser Wörterbücher verwendet werden soll. 

Dieser Abschnitt verrät, wie Sie dazu vorgehen. 

Alle Details zu diesen Themen finden Sie auf nächsten Seiten. 
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Installieren zusätzlicher SoftMaker-Wörterbücher 

FreeOffice: Bei SoftMaker FreeOffice sind die in SoftMaker Office norma-

lerweise enthaltenen hochwertigen SoftMaker-Wörterbücher nicht verfügbar. 

Hier können ausschließlich Hunspell-Wörterbücher verwendet werden.  

Informationen zum Installieren zusätzlicher Hunspell-Wörterbücher finden Sie 

nicht in diesem, sondern im nächsten Abschnitt („Installieren von Hunspell-

Wörterbüchern“).  

SoftMaker Office wird mit hochwertigen Wörterbüchern für zahlreiche Sprachen 

ausgeliefert. In diesem Abschnitt erfahren Sie, wie Sie Wörterbücher, die momen-

tan nicht installiert sind, nachinstallieren können: 

Windows, Mac und Linux 

Bei der Installation von SoftMaker Office für Windows, Mac oder Linux werden 

stets alle SoftMaker-Wörterbücher installiert – hier ist ein Nachinstallieren also 

nicht nötig. 

Android 

Anders sieht es bei SoftMaker Office für Android aus: Hier können Sie SoftMa-

ker-Wörterbücher, die momentan nicht installiert sind, jederzeit kostenlos von un-

serem Server herunterladen und automatisch installieren lassen.  

Gehen Sie dazu wie folgt vor: 

1. Starten Sie eine der Apps (TextMaker, PlanMaker oder Presentations) auf Ihrem 

Android-Gerät. 

2. Rufen Sie darin den Menübefehl Weiteres > Einstellungen auf und wechseln 

Sie auf die Karteikarte Sprache. 

3. Tippen Sie auf die Schaltfläche Wörterbücher hinzufügen. 

4. Es erscheint ein Dialog mit einer Liste aller verfügbaren Sprachen. Um eine 

Sprache herunterzuladen, tippen Sie auf das Download-Symbol rechts von ihr. 

Sobald der Download abgeschlossen ist, wird das Wörterbuch automatisch instal-

liert und steht fortan in allen Applikationen von SoftMaker Office zur Verfügung. 
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Installieren von Hunspell-Wörterbüchern 

FreeOffice: Bei SoftMaker FreeOffice sind die in SoftMaker Office norma-

lerweise enthaltenen hochwertigen SoftMaker-Wörterbücher nicht verfügbar. 

Hier können ausschließlich Hunspell-Wörterbücher verwendet werden.  

Hunspell-Wörterbücher für Deutsch und Englisch sind bereits vorinstalliert. In 

diesem Abschnitt erfahren Sie, wie Sie bei Bedarf weitere Hunspell-

Wörterbücher herunterladen und installieren.  

Hinweis: Diese Funktion ist in der Android-Version nicht verfügbar. 

Neben den SoftMaker-Wörterbüchern lassen sich in SoftMaker Office für 

Windows, Mac und Linux auch Hunspell-Wörterbücher verwenden. Diese wurden 

größtenteils von engagierten Anwendern und nicht-kommerziellen Einrichtungen 

erstellt und dann kostenlos zur Verfügung gestellt.  

Hunspell-Wörterbücher gibt es für sehr viele Sprachen. Falls Sie also für eine 

Sprache kein Wörterbuch in SoftMaker Office finden, lohnt es sich nachzusehen, 

ob ein Hunspell-Wörterbuch dafür existiert. 

Eine Liste aller für SoftMaker Office verfügbaren Hunspell-Wörterbücher finden 

Sie im Bereich „Downloads“ auf unserer Website www.softmaker.de. Dort können 

Sie die Wörterbücher auch kostenlos herunterladen. 

Um ein Hunspell-Wörterbuch herunterzuladen und zu installieren, gehen Sie fol-

gendermaßen vor: 

1. Gehen Sie mit Ihrem Webbrowser auf unsere Website www.softmaker.de 

2. Wählen Sie im Menü der Webseite „Downloads“ aus, und klicken Sie dann auf 

„Wörterbücher“. 

3. Ihr Browser zeigt nun eine Seite mit einer Liste aller von SoftMaker Office 

unterstützten Hunspell-Wörterbücher an. Laden Sie das gewünschte Wörter-

buch herunter und speichern Sie es auf der Festplatte. 

4. Starten Sie eines der Programme von SoftMaker Office (TextMaker, PlanMaker 

oder Presentations). 

5. Rufen Sie darin den Menübefehl Weiteres > Einstellungen auf und wechseln 

Sie auf die Karteikarte Sprache. 

6. Klicken Sie auf die Schaltfläche Hunspell-Wörterbücher. 

http://www.softmaker.de/
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7. Es erscheint ein Dialog mit einer Liste aller installierten Sprachen/Wörter-

bücher. Klicken Sie darin auf die Schaltfläche Hunspell-Wörterbuch hinzu-

fügen. 

8. Es erscheint ein Dateidialog. Wechseln Sie darin in den Ordner, in den Sie das 

heruntergeladene Wörterbuch gespeichert haben.  

9. Wählen Sie die Wörterbuchdatei in der Dateiliste aus und klicken Sie auf Öff-

nen. 

Das Wörterbuch wird nun installiert und steht fortan in allen Applikationen von 

SoftMaker Office zur Verfügung. 

Wählen eines anderen Wörterbuchs für eine Sprache 

FreeOffice: Bei SoftMaker FreeOffice sind die in SoftMaker Office norma-

lerweise enthaltenen hochwertigen SoftMaker-Wörterbücher nicht verfügbar. 

Hier können ausschließlich Hunspell-Wörterbücher verwendet werden.  

(Siehe auch Abschnitt „Installieren von Hunspell-Wörterbüchern“.)  

Hinweis: Diese Funktion ist in der Android-Version nicht verfügbar. 

Wenn Sie für eine Sprache mehrere Wörterbücher installiert haben (zum Beispiel 

ein SoftMaker-Wörterbuch und ein Hunspell-Wörterbuch), können Sie jederzeit 

wählen, welches dieser Wörterbücher für die Sprache verwendet werden soll. Ge-

hen Sie dazu wie folgt vor:  

1. Rufen Sie den Menübefehl Weiteres > Einstellungen auf und wechseln Sie auf 

die Karteikarte Sprache. 

2. Klicken Sie auf die Schaltfläche Hunspell-Wörterbücher. 

3. Es erscheint ein Dialog mit einer Liste aller installierten Sprachen/Wörterbü-

cher. Wählen Sie zuerst in dieser Liste die gewünschte Sprache aus. 

4. Wählen Sie dann in der aufklappbaren Liste Wörterbuch aus, welches Wörter-

buch für die selektierte Sprache verwendet werden soll. Die Liste kann, je 

nachdem welche Wörterbücher installiert sind, folgende Einträge haben: 

 SoftMaker: Das bei SoftMaker Office mitgelieferte Wörterbuch. (Dies ist 

die Standardeinstellung.) 

 Hunspell: Ein Hunspell-Wörterbuch (kostenlos herunterladbares, freies 

Wörterbuch, siehe vorheriger Abschnitt) 
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5. Bestätigen Sie mit OK. 

Die Rechtschreibprüfung wird von nun an für diese Sprache das gewählte Wörter-

buch verwenden. 
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Formeln und Funktionen 
Dieses Kapitel widmet sich dem wohl wichtigsten Thema bei einer Tabellenkalku-

lation: dem Arbeiten mit Rechenformeln. 

Das Kapitel besteht aus folgenden Abschnitten: 

 Grundlegendes zu Berechnungen 

 Im ersten Abschnitt erfahren Sie, wie Formeln aufgebaut sein müssen und wel-

che Rechenoperatoren darin verwendet werden können. 

 Berechnungen eingeben 

 Hier erfahren Sie, wie Sie Rechenformeln in eine Zelle eingeben und welche 

Hilfsmittel dafür zur Verfügung stehen. 

 Relative und absolute Zellbezüge 

 Dieser Abschnitt erläutert den Unterschied zwischen relativen Zellbezügen 

(z.B. =A1) und absoluten Zellbezügen (z.B. =$A$1) in Rechenformeln. 

 Externe Zellbezüge 

 Im nächsten Abschnitt geht es um externe Zellbezüge in Rechenformeln. Das 

sind Bezüge, die sich auf Zellen in anderen Arbeitsmappen beziehen. 

 Fehlerwerte 

 Liefert eine Berechnung einen Fehler, ist das Ergebnis dieser Formel ein soge-

nannter Fehlerwert. Dieser Abschnitt beschreibt alle Fehlerwerte. 

 Arbeiten mit Matrizen 

 Hier erfahren Sie, wie Sie Matrizen und Matrixfunktionen einsetzen. 

 Anmerkungen zu den Datenbankfunktionen 

 Hier erfahren Sie Wissenswertes zum Umgang mit Datenbankfunktion wie 

dbAnzahl, dbSumme etc. 

 Funktionen von A-Z 

 Der größte Teil dieses Kapitels besteht aus einer alphabetisch sortierten Liste 

aller verfügbaren Rechenfunktionen mit einer ausführlichen Beschreibung, wie 

man die einzelnen Funktionen anwendet. 
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Tipp für Einsteiger: Eine kleine Einführung zum Durchführen von Berechnungen 

finden Sie auch im Kapitel „Die PlanMaker-Tour“ ab Seite 51. 

Grundlegendes zu Berechnungen 

Wenn Sie in PlanMaker eine Berechnung durchführen möchten, setzen Sie zu-

nächst den Zellrahmen auf die Zelle, in der das Ergebnis erscheinen soll. Dann 

tippen Sie die gewünschte Berechnung in diese Zelle ein. 

Wichtig: Beim Eintippen einer Formel müssen Sie stets mit einem Gleichheits-

zeichen = beginnen, denn sonst wird Ihre Eingabe von PlanMaker als Text be-

ziehungsweise Zahlenwert betrachtet.  

Rechenformeln können bestehen aus: 

 Festen Werten (zum Beispiel einer Zahl oder Text) 

 Zellbezüge (zum Beispiel A1 oder D2:D3) 

 Matrizen (siehe auch Abschnitt „Arbeiten mit Matrizen“ ab Seite 516) 

 Rechenoperatoren (zum Beispiel + und -, siehe auch Abschnitt „Operatoren in 

Berechnungen“ im Anschluss) 

 Rechenfunktionen (zum Beispiel SUMME) 

Das Ergebnis einer Berechnung kann sowohl einen Endwert als auch ein Zwi-

schenergebnis darstellen, denn jede Zelle, die das Ergebnis einer Berechnung ent-

hält, kann in einer anderen Zelle wieder verwendet werden. 

Eine gültige Rechenformel kann also beispielsweise folgendermaßen aussehen: 

= 67 + (A3 * Summe(B1:C5)) 

Operatoren in Berechnungen 

Sie können in Berechnungen die nachfolgend aufgelisteten Rechenoperatoren ver-

wenden. 

Beachten Sie bei Berechnungen mit mehreren verschiedenen Operatoren, dass es 

eine Rangfolge für Operatoren gibt: Teilberechnungen mit einem Operator höheren 

Rangs werden vor Teilberechnungen mit einem Operator niedrigeren Rangs durch-

geführt.  
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Diese Rangfolge kann durch die Verwendung von Klammern außer Kraft gesetzt 

werden:  

1+2*2 ergibt beispielsweise 5, da die Multiplikation einen höheren Rang hat als die 

Addition und deshalb zuerst berechnet wird. (1+2)*2 ergibt hingegen 6, da die 

Klammern diese Rangfolge außer Kraft setzen. 

Es gilt folgende Rangfolge bei den Operatoren (höchste zuerst): 

1. Rang: Leertaste Schnittbereich (siehe auch Funktion SCHNITTBE-

REICH) 

2. Rang: % Prozent 

3. Rang: ^ Potenzierung* 

4. Rang: + Positives Vorzeichen (nicht Addition!) 

 – Negatives Vorzeichen* (nicht Subtraktion!) 

5. Rang: * Multiplikation 

 / Division 

6. Rang: + Addition 

 – Subtraktion 

7. Rang: & Verkettung von Zeichenketten ("Plan" & "Maker" 

ergibt beispielsweise "PlanMaker") 

8. Rang: = Gleich 

 <> Ungleich 

 < Kleiner 

 > Größer 

 <= Kleiner oder gleich 

 >= Größer oder gleich 

* Hinweis: Bei Microsoft Excel ist die Rangfolge von Potenzierung und Vorzeichen fälschlicherweise 

vertauscht. PlanMaker verwendet hingegen die mathematisch korrekte Reihenfolge. So ergibt bei-

spielsweise die Formel -1^2 in Excel das falsche Ergebnis 1, in PlanMaker hingegen das korrekte Er-

gebnis -1. 
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Berechnungen eingeben 

Es gibt mehrere Möglichkeiten, eine Rechenformel in eine Zelle einzugeben. Diese 

lassen sich nach Belieben kombinieren. 

Eingeben von Rechenformeln per Hand 

Sie können Rechenformeln einfach von Hand in die gewünschte Tabellenzelle ein-

tragen. 

Wichtig: Wenn Sie Formeln direkt in eine Tabellenzelle eingeben, müssen Sie 

zuerst immer das Gleichheitszeichen = eintippen, damit PlanMaker weiß, dass 

nun kein Text, sondern eine Formel folgt. 

Wenn Sie die Formel eingegeben haben, betätigen Sie die Eingabetaste (¢), um 

Ihre Eingabe zu bestätigen – oder (Esc), um sie zu verwerfen. 

Alternativ können Sie Eingaben auch über die folgenden Schaltflächen der Bear-

beitungsleiste abschließen: 

 Klicken Sie auf , um die Eingabe zu übernehmen. 

 Oder klicken Sie auf , um die Eingabe zu verwerfen. 

Um die Formel in einer Zelle nachträglich zu bearbeiten, steuern Sie die Zelle an 

und betätigen die Taste (F2). Alternativ können Sie auch einen Doppelklick auf die 

Zelle ausführen, um die Formel zu bearbeiten. 

Verwenden der Maus beim Eingeben von Formeln 

Sie können beim Eingeben von Rechenformeln die Maus verwenden, um Zellbe-

reiche oder einzelne Zellen in die Formel zu übernehmen. Ziehen Sie dazu einfach 

ein Rechteck in der Tabelle auf beziehungsweise klicken Sie die gewünschte Zelle 

an. 

Ein Beispiel: 

Sie möchten in eine Zelle die Formel =SUMME(B2:D4) eingeben. Dazu können 

Sie wie folgt vorgehen: 

1. Geben Sie =SUMME( ein. 
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2. Selektieren Sie die Zellen B2 bis D4 mit der Maus. Ziehen Sie dazu bei ge-

drückter linker Maustaste ein Rechteck auf, das in Zelle B2 beginnt und in Zel-

le D4 endet. 

3. In der Zelle erscheint nun automatisch der Bereich B2:D4, so dass die Formel 

lautet: =SUMME(B2:D4 

4. Geben Sie die schließende Klammer ein und betätigen Sie die Eingabetaste 
(¢). 

Die vollständige Formel =SUMME(B2:D4) ist nun in die Zelle eingetragen. 

Der Befehl Einfügen > Funktion 

Wenn Sie in einer Formel Rechenfunktionen verwenden möchten, können Sie diese 

einfach eintippen oder aber den Menübefehl Einfügen > Funktion verwenden. 

Dieser erlaubt es Ihnen, Rechenfunktionen komfortabel per Maus auszuwählen. 

 

Das Dialogfenster für diesen Befehl hat folgende Bestandteile: 

 Eingabefeld Berechnung 

 Hier können Sie die Formel, die in die Zelle eingetragen wird, editieren. 
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 Kategorie 

 In dieser Liste können Sie wählen, welche Arten von Rechenfunktionen in der 

Liste Funktion angezeigt werden sollen. 

 Funktion 

 In dieser Liste werden alle Funktionen der gewählten Kategorie angezeigt. Füh-

ren Sie einen Doppelklick auf eine Funktion durch, um sie in das Eingabefeld 

Berechnung zu übertragen. 

 Tipp: Wenn Sie eine Funktion selektieren, wird im unteren Teil des Dialogs 

automatisch eine Kurzbeschreibung dazu eingeblendet. Bei der Windows-

Version von PlanMaker können Sie außerdem eine Hilfeseite zu jeder Rechen-

funktion abrufen, indem Sie die Funktion selektieren und dann die Taste (F1) 

drücken. 

 Operator 

 Hier werden die wichtigsten Rechenoperatoren angezeigt. Klicken Sie einen 

Operator an, wird er in das Eingabefeld eingefügt. 

 Schaltfläche Einfügen 

 Fügt den Inhalt des Eingabefelds Berechnung in die Zelle ein und schließt den 

Dialog. 

 Schaltfläche Schließen 

 Schließt den Dialog, ohne die Berechnung einzufügen. 

Relative und absolute Zellbezüge 

Wenn Sie sich in einer Rechenformel auf andere Zellen beziehen möchten, können 

Sie diesen Zellbezug entweder als relativ (z.B. =A1) oder als absolut (z.B. =$A$1) 

eintragen. 

Dieser Abschnitt erläutert die Unterschiede zwischen diesen beiden Adressierungs-

arten: 
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Relative Zellbezüge 

Wenn Sie in einer Formel die Adresse einer anderen Zelle eintippen, wird dieser 

Zellbezug von PlanMaker stets als relativer Zellbezug interpretiert. 

Ein Beispiel: Sie geben in Zelle B3 folgende Formel ein: 

=B1+B2 

Dies interpretiert PlanMaker nicht als „Addiere B1 und B2“, sondern vielmehr als 

„Addiere die Werte in den beiden Zellen, die direkt über der Zelle B3 liegen“.  

Sie merken dies, wenn Sie die Zelle B3 nach C3 kopieren oder verschieben. Plan-

Maker passt die Formel dann nämlich sofort an: 

=C1+C2 

Absolute Zellbezüge 

Wenn Sie verhindern möchten, dass die Formel automatisch angepasst wird, müs-

sen Sie den Zellbezug als absolut eintippen, indem Sie vor die Spalten- und/oder 

Zeilenadresse ein Dollarzeichen ($) setzen. Wahlweise können ganze Zelladressen 

(zum Beispiel $B$1) oder nur ein Teil davon (zum Beispiel $B1 oder B$1) als ab-

solut klassifiziert werden. 

Ein absoluter Zellbezug bezieht sich immer auf die ursprüngliche Zelladresse, ganz 

egal, wohin Sie die Zelle mit der Formel später verschieben. 

Beispiel: =$B$1 + $B$2 

Tragen Sie diese Formel in die Zelle B3 ein und verschieben diese Zelle nach C3, 

bezieht sich PlanMaker danach immer noch auf die Zellen B1 und B2. 

Tipp: Verwenden der F4-Taste zum Ändern der Adressierung 

Wenn Sie einen Zellbezug in eine Formel eingeben, können Sie anschließend mit 

der Taste (F4) zwischen relativer und absoluter Adressierung umschalten.  

Tippen Sie also beispielsweise in eine Zelle =A4 ein, ändert PlanMaker dies auf: 

=$A4, wenn Sie einmal (F4) drücken, 

=A$4, wenn Sie noch einmal (F4) drücken, 

=$A$4, wenn Sie noch einmal (F4) drücken. 
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... und wieder =A4, wenn Sie noch einmal (F4) drücken. 

Externe Zellbezüge 

Sie können sich in Rechenformeln auch auf Zellen beziehen, die sich in anderen 

PlanMaker- oder Excel-Dokumenten befinden. Solche Zellbezüge nennt man ex-

terne Zellbezüge. 

In diesem Abschnitt erfahren Sie alles Wissenswerte dazu. Folgende Themen wer-

den darin behandelt: 

 Eingeben von externen Zellbezügen 

 Aktualisieren und Verwalten von externen Zellbezügen 

Lesen Sie dazu die nächsten Seiten. 

Eingeben von externen Zellbezügen 

Zellbezüge, die sich auf Zellen in einem anderen Dokument beziehen, müssen wie 

folgt in Rechenformeln eingegeben werden: 

='C:\Mein Verzeichnis\[Meine Arbeitsmappe.pmdx]Tabelle1'!A1 

Dieses Beispiel liefert einen Bezug auf die Zelle A1 im Arbeitsblatt „Tabelle1“ im 

PlanMaker-Dokument „Meine Arbeitsmappe.pmdx“ im Verzeichnis „C:\Mein Ver-

zeichnis“. 

Wie Sie sehen, bestehen externe Zellbezüge immer aus folgenden Komponenten: 

 Anführungszeichen 

 Externe Zellbezüge sollten stets mit einem Anführungszeichen beginnen. Sie 

können wahlweise einfache Anführungszeichen (') oder doppelte Anführungs-

zeichen (") verwenden. 

 Ordner 

 Als nächstes ist der vollständige Pfad zu dem Ordner anzugeben, in dem sich 

die externe Datei befindet – zum Beispiel: C:\Mein Verzeichnis\ 

 Tipp: Falls sich die externe Datei im gleichen Verzeichnis wie Ihr Dokument 

befindet, kann der Pfad auch weggelassen werden. 
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 Dateiname in eckigen Klammern 

 Dahinter kommt der Dateiname, umgeben von eckigen Klammern. Es muss 

sich bei der Datei um ein PlanMaker- oder ein Exceldokument handeln. 

 Name des Arbeitsblatts 

 Die nächste Komponente ist der Name des Arbeitsblatts, in dem sich die ge-

wünschte Zelle befindet. 

 Anführungszeichen 

 Dahinter ist ein weiteres Anführungszeichen zu schreiben. 

 Ausrufezeichen 

 Als nächstes muss ein Ausrufezeichen getippt werden. 

 Zellbezug 

 Die letzte Komponente ist die Adresse der Zelle(n), auf die Sie sich beziehen 

möchten. Es sind natürlich auch Zellbereiche zulässig. 

Schließen Sie Ihre Eingabe mit der Eingabetaste (¢) ab. PlanMaker liest daraufhin 

den Inhalt der Zelle aus der angegebenen Datei aus. 

Informationen zum Aktualisieren und Verwalten externer Zellbezüge finden Sie im 

Anschluss. 

Anmerkungen 

 Wenn PlanMaker die angegebene Datei nicht findet, erscheint nach dem Betäti-

gen der Eingabetaste automatisch ein Dialog, in dem Sie die Datei auswählen 

können. 

 Tipp: Wenn Sie den Pfad und Dateinamen nicht von Hand eintippen möchten, 

können Sie folgenden Trick anwenden: Tippen Sie als Pfad und Dateinamen 

einfach nur [x.pmdx] ein – also beispielsweise [x.pmdx]Tabelle1!A1. So kön-

nen Sie das Erscheinen des Dateidialogs nach dem Drücken der Eingabetaste 

absichtlich auslösen und die Datei bequem aus dem Dialog auswählen. 

 Wenn PlanMaker das angegebene Arbeitsblatt nicht findet, erscheint nach dem 

Betätigen der Eingabetaste automatisch ein Dialog, in dem Sie das Arbeitsblatt 

auswählen können. 

 Der Pfad auf die externe Datei wird normalerweise absolut gespeichert. Falls 

sich das externe Dokument allerdings im gleichen Ordner befindet wie Ihre Ar-
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beitsmappe (oder einem Unterordner davon), speichert PlanMaker nur den rela-

tiven Pfad.  

 In der Praxis bedeutet das: Wenn sich Dokument und externe Datei im gleichen 

Ordner befinden und Sie beide gemeinsam in einen anderen Ordner verschie-

ben, funktionieren Bezüge auf diese externe Datei auch weiterhin. 

 Tipp: Wenn Sie sich die komplette Tipparbeit sparen möchten, können Sie einen 

externen Zellbezug auch auf folgende Art einfügen: 

 1. Öffnen Sie das Dokument mit der Zelle, auf die Sie sich beziehen möchten. 

 2. Kopieren Sie darin die gewünschte Zelle in die Zwischenablage. 

 3. Wechseln Sie zurück zum aktuellen Dokument. 

 4. Navigieren Sie zu der Zelle, in die der Bezug eingefügt werden soll. 

 5. Rufen Sie den Menübefehl Bearbeiten > Inhalte einfügen auf. 

 6. Klicken Sie auf die Schaltfläche Bezüge einfügen. 

 PlanMaker fügt nun einen externen Zellbezug auf diese Zelle ein. 

Aktualisieren und Verwalten von externen Zellbezügen 

Mit dem Menübefehl Arbeitsblatt > Externe Bezüge können Sie die externen 

Bezüge in einem Dokument aktualisieren und verwalten. 

Der Befehl öffnet ein Dialogfenster, in dem alle Dateien aufgelistet sind, zu denen 

es externe Bezüge gibt. 

Mit Hilfe der Schaltflächen in diesem Dialog können Sie folgende Aktionen durch-

führen: 

 Aktualisieren 

 Aktualisiert nur diejenigen externen Bezüge, die sich auf die Datei beziehen, 

die momentan in der Liste selektiert ist.  

 (Siehe auch Hinweise zum Aktualisieren weiter unten.) 

 Alles aktualisieren 

 Aktualisiert alle externen Bezüge im gesamten Dokument. 
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Tipp: Das Kommando Alles aktualisieren können Sie alternativ auch über 

den Menübefehl Weiteres > Externe Bezüge aktualisieren auslösen. 

 Öffnen 

 Öffnet die in der Liste selektierte externe Datei. 

 Ändern 

 Lässt Sie für die in der Liste selektierte externe Datei eine andere Datei aus-

wählen. Alle Bezüge auf diese Datei werden daraufhin im Dokument entspre-

chend angepasst. 

 Vorherige 

 Springt zur vorherigen Zelle, die einen Bezug auf die in der Liste selektierte 

Datei enthält. 

 Nächste 

 Springt zur nächsten Zelle, die einen Bezug auf die in der Liste selektierte Da-

tei enthält. 

Die Schaltfläche Schließen beendet den Dialog. 

Hinweise zum Aktualisieren von externen Zellbezügen 

Wichtig: Die Werte, die von externen Zellbezügen zurückgeliefert werden, wer-

den nicht bei jedem Neuberechnen der Arbeitsmappe automatisch aktualisiert.  

Externe Zellbezüge werden nur in folgenden Fällen aktualisiert: 

 Wenn Sie ein Dokument öffnen, werden alle darin enthaltenen externen Bezüge 

(einmalig) automatisch aktualisiert.  

 Dieses automatische Update können Sie auf Wunsch abschalten – siehe Optio-

nen weiter unten. 

 Danach können Sie die externen Bezüge jederzeit manuell aktualisieren: 

 Rufen Sie dazu den Menübefehl Arbeitsblatt > Externe Bezüge auf und ver-

wenden in dem Dialog, wie oben beschrieben, die Schaltfläche Aktualisieren 

oder Alles aktualisieren.  
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 Alternativ können Sie auch den Menübefehl Weiteres > Externe Bezüge ak-

tualisieren verwenden, der das Gleiche macht wie die Schaltfläche Alles aktu-

alisieren. 

Optionen zum Aktualisieren von externen Zellbezügen 

Für das Aktualisieren von externen Zellbezügen gibt es nachfolgende Optionen in 

den Dokumenteigenschaften.  

Um diese zu ändern, rufen Sie den Menübefehl Datei > Eigenschaften auf und 

wechseln auf die Karteikarte Berechnen. In der Rubrik Externe Bezüge finden Sie 

dort folgende Optionen: 

 Daten nach dem Öffnen aktualisieren 

 Hier können Sie festlegen, ob beim Öffnen eines Dokuments alle darin enthal-

tenen externen Bezüge (einmalig) aktualisiert werden sollen: 

 Immer: Beim Öffnen externe Bezüge automatisch aktualisieren 

 Niemals: Beim Öffnen externe Bezüge nicht aktualisieren 

 Nachfragen: Beim Öffnen den Anwender fragen, ob die externen Bezüge aktu-

alisiert werden sollen. 

 Externe Daten im Dokument speichern 

 Ist diese Option aktiviert, speichert PlanMaker eine Kopie aller Werte, die von 

externen Zellbezügen geliefert werden, im Dokument. Fehlt die Datei für einen 

externen Bezug beim Aktualisieren, wird auch weiterhin der Wert angezeigt, 

den sich PlanMaker zuletzt gemerkt hat. 

 Schalten Sie die Option aus, wird stattdessen ein Fehlerwert angezeigt, wenn 

Sie einen externen Bezug aktualisieren und auf die zugehörige Datei nicht zu-

gegriffen werden kann. 

Hinweis: Die obigen Optionen sind keine globalen Einstellungen, sondern Do-

kumenteigenschaften. Sie lassen sich also für jedes Dokument unterschiedlich 

einstellen. 
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Fehlerwerte 

Tritt in einer Berechnung ein Fehler auf, liefert sie als Ergebnis einen sogenannten 

Fehlerwert.  

Ein Beispiel: In einer Zelle ist eine Division durch den Inhalt einer anderen Zelle 

durchzuführen. Diese andere Zelle nimmt nun den Wert 0 an. PlanMaker kann die-

se Division durch Null, die ja in der Mathematik nicht zulässig ist, nicht durchfüh-

ren. Das Ergebnis der Rechenformel ist deshalb der Fehlerwert #DIV/0!, der an-

zeigt, dass hier eine Division durch Null stattfindet. 

Es gibt folgende Fehlerwerte: 

Fehlerwert Erläuterung 

#BEZUG! Ungültiger Zellbezug. Erscheint, wenn die Formel einen Zellbezug 

enthält, der ungültig ist oder nach dem Löschen von Zellen (z.B. mit 

dem Menübefehl Arbeitsblatt > Zellen löschen) nicht mehr exis-

tiert. 

#DIV/0! Division durch Null. Erscheint, wenn die Formel eine Division durch 

Null enthält, die in der Mathematik ja bekanntermaßen nicht zulässig 

ist. 

#FEHLER! Ungültige Rechenformel. Erscheint unter anderem bei falsch ge-

schriebenen oder unbekannten Funktionsnamen, wenn geöffnete 

Klammern nicht geschlossen werden oder wenn eine Funktion mit 

zu vielen oder zu wenigen Argumenten aufgerufen wird. 

#NAME? Bezug mit einem ungültigen Namen. Erscheint, wenn sich ein Zell-

bezug auf einen Blattnamen oder Bereichsnamen bezieht, der nicht 

existiert. 

#NV „Nicht vorhanden“. Erscheint, wenn die Zelle einen #NV-Fehlerwert 

oder einen Bezug auf eine Zelle mit einem #NV-Fehlerwert enthält. 

Siehe auch Beschreibung der Funktion „NV (Nicht vorhanden)“ ab 

Seite 699. 

#WERT! Ungültiger Wert. Erscheint, wenn eine Funktion mit einem nicht 

geeigneten Wertetyp aufgerufen wird, sie also beispielsweise eine 

Zahl als Argument erwartet, ihr aber eine Zeichenkette übergeben 

wird. 

#ZAHL! Ungültige Zahl. Erscheint, wenn eine Funktion mit einem Wert auf-

gerufen wird, der außerhalb des für die Funktion zulässigen Wer-

tebereichs liegt (zum Beispiel WURZEL(-2)). 

Tipp: Mit den Funktionen ISTFEHLER und ISTFEHL können Sie bei Bedarf prü-

fen, ob die Berechnung in einer bestimmten Zelle einen Fehlerwert ergibt. 
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Tipp: Weiterhin können Sie den Menübefehl Weiteres > Formelüberwachung 

verwenden, um alle Zellen mit einem Fehlerwert aufzuspüren und zu analysie-

ren. Siehe dazu Abschnitt „Analysieren von Tabellen“ ab Seite 114. (Diese Funk-

tion ist in SoftMaker FreeOffice nicht enthalten.) 

Arbeiten mit Matrizen 

Sie können in PlanMaker auch Matrizen eingeben und Berechnungen damit durch-

führen. Unter einer Matrix A versteht man ein rechteckiges Zahlenschema in fol-

gender Form: 

 

a11 bis amn nennt man die Elemente der Matrix. Diese sind auf m Zeilen und n Spal-

ten aufgeteilt. Man spricht daher auch von einer m x n-Matrix. 

Eingabe von Matrizen in entsprechende Zellbereiche 

Um eine Matrix in PlanMaker einzugeben, verteilt man die Zeilen und Spalten der 

Matrix einfach auf Zeilen und Spalten der Tabelle.  

Wenn Sie also die folgende Matrix verwenden möchten... 

 

...so ist diese in PlanMaker folgendermaßen einzutragen: 
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Wie Sie sehen kann jeder (rechteckige) Zellbereich auch als Matrix angesehen 

werden – und umgekehrt. Dementsprechend können Sie bei Rechenfunktionen, die 

als Argument eine Matrix erwarten, stets auch einen Zellbereich angeben, der die 

Elemente der Matrix enthält. 

Eingabe von Matrixformeln 

PlanMaker verfügt über sogenannte Matrixfunktionen, mit denen Sie Berechnun-

gen mit Matrizen durchführen können – zum Beispiel die Inverse einer Matrix fin-

den. Eine Rechenformel mit einer Matrixfunktion nennen wir auch Matrixformel. 

Im Unterschied zu „gewöhnlichen“ Formeln liefern Matrixformeln keinen Einzel-

wert zurück, sondern eine komplette Matrix. Aus diesem Grund müssen solche 

Matrixformeln anders eingegeben werden als sonst üblich. Sehen wir uns dies an-

hand eines Beispiels einmal an: 

Sie möchten die Inverse der oben abgebildeten 3x3-Matrix ermitteln. Dazu gehen 

Sie wie folgt vor: 

1. Markieren des Bereichs für die Ergebnismatrix 

 Schon vor der Eingabe einer Matrixformel müssen Sie den Zellbereich markie-

ren, der von der Ergebnismatrix belegt werden soll. Die Inverse einer Matrix 

hat stets genau so viele Zeilen und Spalten wie die Ausgangsmatrix. Markieren 

Sie also einen Bereich mit 3x3 Zellen – zum Beispiel die Zellen E10:G12. 

2. Eingabe der Matrixformel 

 Geben Sie nun die gewünschte Matrixformel ein. In unserem Beispiel wäre das 

die Formel =MINV(E6:G8). 

3. Strg+Umschalt+Eingabetaste 

 Wichtig: Zum Abschluss der Formel drücken Sie nicht die Eingabetaste (¢), 

sondern die Tastenkombination (Strg)(ª)(¢). 
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In den Zellen E10:G12 wird nun das Ergebnis der Berechnung, also die Inverse der 

Ausgangsmatrix, abgelegt: 

 

Anmerkungen: 

 Wenn Sie einen Bereich markiert hatten, der größer ist als der von der Ergeb-

nismatrix benötigte, wird in den überflüssigen Zellen der Fehlerwert #NV 

(„nicht vorhanden“) angezeigt. Vorsicht: Ist der markierte Bereich hingegen zu 

klein, werden nicht alle Elemente der Matrix angezeigt. 

 Zum nachträglichen Editieren von Matrixformeln ist erneut obiges Verfahren 

anzuwenden: Alle Zellen der Ergebnismatrix markieren, Formel abändern, 
(Strg)(ª)(¢) drücken. Gehen Sie nicht so vor, erhalten Sie von PlanMaker eine 

Warnmeldung und werden gefragt, ob Sie die Matrix überschreiben möchten. 

 Tipp: Um alle von einer Matrixformel belegten Zellen zu markieren, klicken 

Sie eine dieser Zellen an und drücken dann (Strg)(7). 

Eingabe von Matrizen mit festen Werten 

Bei Bedarf können Sie statt eines Zellbezugs auch eine aus festen Werten beste-

hende Matrix in Formeln eingeben. Umgeben Sie die Werte dazu mit geschweiften 

Klammern { }. Trennen Sie die Spalten durch Punkte und die Zeilen durch Strich-

punkte. 

Für die oben bereits als Beispiel verwendete Matrix... 

 

...könnte man in PlanMaker also auch schreiben: 
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={1.2.3;3.-1.1;2.2.4} 

Anmerkungen: 

 Obige Schreibweise ist nur für Matrizen zulässig, die ausschließlich aus festen 

Werten bestehen; Formeln oder Zellbezüge sind darin nicht erlaubt. 

 Mit obiger Schreibweise können natürlich auch Vektoren eingegeben werden: 

für einen Zeilenvektor wie a = (1, 2, 3) schreibt man {1.2.3}; für einen entspre-

chenden Spaltenvektor schreibt man {1;2;3}. 

Anmerkungen zu den Datenbankfunktionen 

PlanMaker verfügt über eine Reihe von Datenbankfunktionen, mit denen Sie einen 

Tabellenbereich, der wie eine Datenbank aufgebaut ist, abfragen und auswerten 

können. 

Alle Datenbankfunktionen erwarten folgende Argumente: 

FUNKTIONSNAME(Datenbankbereich; Spalte; Suchkriterienbereich) 

So berechnet die Funktion DBSUMME beispielsweise die Summe all derjenigen 

Zellen in einem Datenbankbereich, die sich in der angegebenen Spalte befinden 

und den im Suchkriterienbereich angegebenen Bedingungen entsprechen. 

Um die Datenbankfunktionen einsetzen zu können, müssen folgende Schritte 

durchgeführt werden: 

Anlegen eines Datenbankbereichs 

Ein Datenbankbereich ist ein beliebiger Zellbereich mit den auszuwertenden Da-

ten. Er muss wie folgt aufgebaut sein: 

 Die erste Zeile muss jeweils eine eindeutige Beschriftung für die darunter lie-

gende Spalte enthalten (zum Beispiel Menge, Preis etc.). 

 Die Daten müssen zeilenweise eingetragen werden. 

Jede Zeile des Datenbankbereichs entspricht also dem, was man bei Datenbank-

programmen als Datensatz bezeichnet, die Spalten entsprechen den Datenbankfel-

dern. 
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Anlegen eines Suchkriterienbereichs 

Der Suchkriterienbereich ist ein weiterer Zellbereich. In diesen können Sie beliebi-

ge viele Suchkriterien eingetragen. 

Der Suchkriterienbereich muss wie folgt aufgebaut sein: 

 Wichtig: Der Suchkriterienbereich muss sich oberhalb des Datenbankbereichs 

befinden. Weiterhin darf er den Datenbankbereich nicht überlappen. 

 Auch hier muss die erste Zeile Beschriftungen für die Spalten enthalten. Wenn 

Sie beispielsweise Suchkriterien für die Spalten festlegen wollen, die Sie im 

Datenbankbereich mit den Überschriften Menge und Preis versehen haben, 

müssen Sie auch hier Menge und Preis eintragen. 

 Unter den Beschriftungen sind die zu erfüllenden Bedingungen einzutragen. 

Dies können sowohl Einzelwerte als auch Vergleiche wie „>42“ oder „<10“ 

sein. 

 Sind mehrere Suchbedingungen in der gleichen Zeile eingetragen, müssen die 

Bedingungen in Spalte 1 und Spalte 2 und Spalte 3 etc. erfüllt werden. 

 Sind mehrere Zeilen mit Suchbedingungen eingetragen, müssen die Bedingun-

gen in Zeile 1 oder Zeile 2 oder Zeile 3 etc. erfüllt werden. 

Anwenden der Datenbankfunktionen 

Nachdem Sie Datenbankbereich und Suchkriterienbereich ausgefüllt haben, kön-

nen Sie die Datenbankfunktionen einsetzen. 

Nachfolgend einige Beispiele. Nehmen wir an, Sie haben folgende Tabelle erstellt: 



 

Handbuch PlanMaker Formeln und Funktionen  •  521 

 

Hier können beispielsweise folgende Berechnungen durchgeführt werden: 

DBANZAHL(A11:C16; ; A2:A3) ergibt 2. Hier wird die Anzahl aller Datensätze 

berechnet, bei denen gilt: Farbe = blau. 

DBANZAHL(A11:C16; ; A6:B7) ergibt 3. Hier wird die Anzahl aller Datensätze 

berechnet, bei denen gilt: (Menge > 25 und Menge < 75). 

DBANZAHL(A11:C16; ; A6:C8) ergibt 4. Hier wird die Anzahl aller Datensätze 

berechnet, bei denen gilt: (Menge > 25 und Menge < 75) oder (Farbe = rot). 

DBSUMME(A11:C16; "Menge"; A2:A3) ergibt 150. Hier wird die Summe der 

Spalte „Menge“ für die Datensätze berechnet, bei denen gilt: Farbe = blau. 

DBSUMME(A11:C16; 1; A2:A3) ergibt 150. Diese Formel entspricht der obigen, 

denn statt der Bezeichnung der Spalte können Sie auch die Nummer der Spalte 

(innerhalb der Tabellenbereichs) angeben. 
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Funktionen von A-Z 

Auf den nun folgenden Seiten finden Sie Beschreibungen aller Rechenfunktionen 

von PlanMaker in alphabetischer Reihenfolge. 

ABRUNDEN (Abrunden auf n Stellen) 

Syntax: 

ABRUNDEN(Zahl; n) 

Beschreibung: 

Rundet eine Zahl betragsmäßig auf n Nachkommastellen ab. 

n ist die gewünschte Anzahl an Nachkommastellen.  

Wird n nicht angegeben, wird die Zahl auf 0 Nachkommastellen abgerundet. 

n darf auch ein negativer Wert sein, worauf der ganzzahlige Teil der Zahl abgerun-

det wird: Ist n beispielsweise -2, wird die Zahl auf ein Vielfaches von Hundert ab-

gerundet (siehe letztes Beispiel). 

Beispiel: 

ABRUNDEN(1,234; 2) ergibt 1,23 

ABRUNDEN(1,235; 2) ergibt 1,23 

ABRUNDEN(888,999; 0) ergibt 888 

ABRUNDEN(888,999; -2) ergibt 800 

Siehe auch: 

AUFRUNDEN, RUNDEN, KÜRZEN 
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ABS (Absolutbetrag) 

Syntax: 

ABS(Zahl) 

Beschreibung: 

Liefert den Absolutbetrag einer Zahl, entfernt also ihr Vorzeichen. 

Beispiel: 

ABS(42) ergibt 42 

ABS(0) ergibt 0 

ABS(-42) ergibt 42 

Siehe auch: 

VORZEICHEN, NEG 

ACHSENABSCHNITT (Achsenabschnitt einer Regressionsge-

raden) 

Syntax: 

ACHSENABSCHNITT(y_Werte; x_Werte) 

Beschreibung: 

Ermittelt den y-Achsenabschnitt einer Regressionsgeraden. Das ist die y-

Koordinate des Punktes, an dem die Regressionsgerade die y-Achse schneidet. 

Eine Regressionsgerade ist das Resultat einer linearen Regression. Darunter ver-

steht man das Anpassen einer linearen Funktion (Regressionsgerade oder Aus-

gleichsgerade genannt) an eine Menge von Punkten (zum Beispiel den Messpunk-

ten einer Messreihe). 
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Mit der Funktion ACHSENABSCHNITT können Sie voraussagen, welchen Wert y 

(die abhängige Variable) ungefähr haben wird, wenn x (die unabhängige Variable) 

Null ist. 

Sie können somit zum Beispiel abschätzen, welchen Widerstand ein temperaturab-

hängiger Widerstand bei 0° haben wird, nachdem Sie den Widerstand bei verschie-

denen anderen Temperaturen gemessen haben. 

Für die Argumente y_Werte und x_Werte geben Sie in der Regel einen Zellbe-

reich an. 

y_Werte sind die abhängigen Variablen (in obigem Beispiel also der Widerstand). 

x_Werte sind die unabhängigen Variablen (in obigem Beispiel also die Tempera-

tur). 

Hinweis: 

Beachten Sie, dass diese Funktion erst die y_Werte und dann die x_Werte erwar-

tet – nicht umgekehrt. 

Anmerkung: 

Die lineare Regression wird bei dieser Funktion mit Hilfe der Methode der kleins-

ten Quadrate durchgeführt. 

Beispiel: 

Von einem temperaturabhängigen Widerstand wurde gemessen, welcher Wider-

stand bei verschiedenen Temperaturen vorliegt. 

In den Zellen A1 bis A4 sind die x-Koordinaten der Messpunkte eingetragen (also 

die unabhängigen Variablen; in unserem Beispiel ist das die Temperatur): 8, 20, 25, 

28 

In den Zellen B1 bis B4 sind die y-Koordinaten eingetragen (also die abhängigen 

Variablen; in unserem Beispiel ist dies der Widerstand): 261, 508, 608, 680 

Mit der folgenden Formel können Sie abschätzen, welcher Widerstand bei 0°C 

geliefert werden wird: 

ACHSENABSCHNITT(B1:B4; A1:A4) ergibt 93,69817 

Bei 0° wäre also ein Widerstand von 93,69817 (Ohm) zu erwarten. 
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Siehe auch: 

SCHÄTZER, STEIGUNG 

Anmerkung: 

ACHSENABSCHNITT(y_Werte; x_Werte) entspricht SCHÄTZER(0; y_Werte; 

x_Werte). 

ADRESSE (Zelladresse als Text ausgeben) 

Syntax: 

ADRESSE(Zeile; Spalte [; Abs] [; Modus] [; Blattname]) 

Beschreibung: 

Liefert die Adresse einer Zelle als Text. 

Für Zeile und Spalte ist die Zeilennummer und Spaltennummer der Zelle anzuge-

ben. 

Das optionale Argument Abs bestimmt, ob eine absolute oder relative Adresse ge-

liefert werden soll: 

1 oder nicht angegeben: Zeile und Spalte absolut 

2: Zeile absolut, Spalte relativ 

3: Zeile relativ, Spalte absolut 

4: Zeile und Spate relativ 

Über den optionalen Wahrheitswert Modus können Sie bestimmen, in welchem 

Format die Zelladresse ausgegeben werden soll: 

WAHR oder nicht angegeben: Normale Zelladresse ausgeben (z.B. A1) 

FALSCH: Zelladresse im Format „Z1S1“ ausgeben (eine alternative Art der Zella-

dressierung, die nur von Microsoft Excel unterstützt wird) 

Wird die optionale Zeichenkette Blattname angegeben, so wird das Ergebnis im 

Format Blattname!Adresse ausgegeben (siehe letztes Beispiel). 
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Beispiel: 

ADRESSE(1; 5) ergibt $E$1 

ADRESSE(1; 5; 4) ergibt E1 

ADRESSE(1; 5; 4; ; "Tabelle1") ergibt Tabelle1!E1 

Siehe auch: 

INDIREKT, BEREICH.VERSCHIEBEN, SPALTE, ZEILE 

ANZAHL (Wie viele Zellen mit Zahlen ausgefüllt?) 

Syntax: 

ANZAHL(Bereich1 [; Bereich2; Bereich3 ...]) 

Beschreibung: 

Ermittelt, wie viele Zellen in einem oder mehreren Bereichen mit Zahlen gefüllt 

sind. Datumsangaben sind ebenfalls Zahlen; sie werden also mitgezählt. 

Beispiel: 

Angenommen, die Zellen A1 bis A3 enthalten die Werte 42, "Test" und WAHR; die 

Zelle A4 ist leer. Dann gilt: 

ANZAHL(A1:A4) ergibt 1 

Zum Vergleich: ANZAHL2(A1:A4) ergibt 3 

Siehe auch: 

ANZAHL2, ISTZAHL 

Anmerkung: 

Die Funktion ANZAHL2 (siehe dort) arbeitet ähnlich, sie zählt jedoch Zellen mit 

beliebigem Inhalt. 



 

Handbuch PlanMaker Formeln und Funktionen  •  527 

ANZAHL2 (Wie viele Zellen ausgefüllt?) 

Syntax: 

ANZAHL2(Bereich1 [; Bereich2; Bereich3 ...]) 

Beschreibung: 

Ermittelt, wie viele Zellen in einem oder mehreren Bereichen mit beliebigen Wer-

ten gefüllt sind.  

Die Zellen dürfen beliebige Zahlen, Zeichenketten, Wahrheitswerte oder Fehler-

werte enthalten. 

Beispiel: 

Angenommen, die Zellen A1 bis A3 enthalten die Werte 42, "Test" und WAHR; die 

Zelle A4 ist leer. Dann gilt: 

ANZAHL2(A1:A4) ergibt 3 

Zum Vergleich: ANZAHL(A1:A4) ergibt 1 

Siehe auch: 

ANZAHL, ISTLEER 

Anmerkung: 

Die Funktion ANZAHL (siehe dort) arbeitet ähnlich, sie zählt jedoch nur Zellen 

mit Zahlen. 

ANZAHLLEEREZELLEN (Wie viele Zellen leer?) 

Syntax: 

ANZAHLLEEREZELLEN(Bereich) 
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Beschreibung: 

Ermittelt, wie viele Zellen in einem Bereich leer sind. 

Beispiel: 

Angenommen, die Zellen A1 bis A3 enthalten die Werte 42, "Test" und WAHR; die 

Zelle A4 ist leer. Dann gilt: 

ANZAHLLEEREZELLEN(A1:A4) ergibt 1 

Siehe auch: 

ISTLEER, ANZAHL 

ANZAHLP (PlanMaker 97-Kompatibilitätsfunktion) 

Syntax: 

ANZAHLP(Bereich1 [; Bereich2; Bereich3 ...]) 

Beschreibung: 

Ermittelt, wie viele Zellen in einem oder mehreren Bereichen mit Zahlen oder 

Wahrheitswerten gefüllt sind.  

Hinweis: 

Diese Funktion ist nur aus Kompatibilitätsgründen zu PlanMaker 97 noch vorhan-

den. Verwenden Sie diese Funktion möglichst nicht mehr, sondern benutzen Sie 

stattdessen die Excel-kompatiblen Funktionen ANZAHL und ANZAHL2. 

Der Unterschied zwischen diesen Funktionen: 

ANZAHL2 zählt alle Zellen, die nicht leer sind (unabhängig von deren Inhalt). 

ANZAHL zählt alle Zellen, die Zahlen enthalten. 

ANZAHLP zählt alle Zellen, die Zahlen oder Wahrheitswerte enthalten. 
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Kompatibilitätshinweise: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

Angenommen, die Zellen A1 bis A3 enthalten die Werte 42, "Test" und WAHR; die 

Zelle A4 ist leer. Dann gilt: 

ANZAHL2(A1:A4) ergibt 3 

ANZAHL(A1:A4) ergibt 1 

ANZAHLP(A1:A4) ergibt 2 

Siehe auch: 

ANZAHL, ANZAHL2 

ARBEITSTAG (Datum nach x Arbeitstagen) 

Syntax: 

ARBEITSTAG(Ausgangsdatum; Tage [; FreieTage]) 

Beschreibung: 

Ermittelt das Datum, das x Arbeitstage vor oder hinter dem Ausgangsdatum liegt. 

Samstage und Sonntage werden dabei übersprungen. Weiterhin kann der Funktion 

optional eine Liste mit freien Tagen (z.B. Feiertagen) übergeben werden. Diese 

werden dann ebenfalls übersprungen. 

Ausgangsdatum ist das Startdatum. 

Tage ist die Zahl der Tage. Tage darf auch ein negativer Wert sein – in diesem Fal-

le wird kein zukünftiges, sondern ein vergangenes Datum geliefert. 
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Für FreieTage kann optional eine Liste mit freien Tagen angegeben werden. (Hier-

für verwendet man üblicherweise einen Zellbereich oder eine Matrix, die die ent-

sprechenden Datumswerte enthält.) 

Beispiel: 

ARBEITSTAG("1.10.2016"; 9) ergibt den 13.10.2016. 

Das Datum, das 9 Arbeitstage hinter dem 1.10.2016 liegt, ist also der 13.10.2016. 

Der 3.10.2016 war allerdings ein Feiertag. Wollte man dies berücksichtigen, so 

müsste man schreiben: 

ARBEITSTAG("1.10.2016"; 9; "3.10.2016") – und das ergibt den 14.10. statt des 

13.10, da der Feiertag am 3.10. auf einen Wochentag fiel, in der Zählung also über-

sprungen wird. 

Siehe auch: 

FEIERTAG, NETTOARBEITSTAGE 

ARCCOS (Arcuscosinus) 

Syntax: 

ARCCOS(Zahl) 

Beschreibung: 

Die Funktion ARCCOS (= Arcuscosinus) ist die Umkehrfunktion der Funktion 

COS: Sie liefert den inversen Cosinus einer Zahl – also den Winkel, dessen Cosi-

nus Zahl ist. 

Der zulässige Wertebereich für Zahl ist: -1  Zahl  1 

Das Ergebnis wird im Bogenmaß (Radiant) geliefert. 
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Tipp: 

Mit der Funktion GRAD können Sie das Ergebnis vom Bogenmaß in Grad um-

rechnen. 

Beispiel: 

ARCCOS(1) ergibt 0 

ARCCOS(COS(0,1234)) ergibt 0,1234 

Siehe auch: 

COS 

ARCCOSHYP (Arcuscosinus Hyperbolicus) 

Syntax: 

ARCCOSHYP(Zahl) 

Beschreibung: 

Die Funktion ARCCOSHYP (= Arcuscosinus Hyperbolicus) ist die Umkehrfunk-

tion der Funktion COSHYP: Sie liefert den inversen hyperbolischen Cosinus einer 

Zahl – also den Wert, dessen hyperbolischer Cosinus Zahl ist. 

Beispiel: 

ARCCOSHYP(1,1) ergibt 0,44357 

ARCCOSHYP(COSHYP(0,1234)) ergibt 0,1234 

Siehe auch: 

COSHYP 



 

532  •  Formeln und Funktionen Handbuch PlanMaker 

ARCCOT (Arcuscotangens) 

Syntax: 

ARCCOT(Zahl) 

Beschreibung: 

Die Funktion ARCCOT (= Arcuscotangens) ist die Umkehrfunktion der Funktion 

COT: Sie liefert den inversen Cotangens einer Zahl – also den Winkel, dessen 

Cotangens Zahl ist. 

Das Ergebnis wird im Bogenmaß (Radiant) geliefert. 

Tipp: 

Mit der Funktion GRAD können Sie das Ergebnis vom Bogenmaß in Grad um-

rechnen. 

Kompatibilitätshinweise: 

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versio-

nen ist die Funktion unbekannt. 

Beispiel: 

ARCCOT(1) ergibt 0,7854 (entspricht PI()/4, also 45°) 

ARCCOT(COT(0,1234)) ergibt 0,1234 

Siehe auch: 

COT 
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ARCCOTHYP (Arcuscotangens Hyperbolicus) 

Syntax: 

ARCCOTHYP(Zahl) 

Beschreibung: 

Die Funktion ARCCOTHYP (= Arcuscotangens Hyperbolicus) ist die Umkehr-

funktion der Funktion COTHYP: Sie liefert den inversen hyperbolischen Cotan-

gens einer Zahl – also den Wert, dessen COTHYP Zahl ist. 

Kompatibilitätshinweise: 

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versio-

nen ist die Funktion unbekannt. 

Beispiel: 

ARCCOTHYP(2) ergibt 0,54931 

ARCCOTHYP(COTHYP(0,1234)) ergibt 0,1234 

Siehe auch: 

COTHYP 

ARCSIN (Arcussinus) 

Syntax: 

ARCSIN(Zahl) 

Beschreibung: 

Die Funktion ARCSIN (= Arcussinus) ist die Umkehrfunktion der Funktion SIN: 

Sie liefert den inversen Sinus einer Zahl – also den Winkel, dessen Sinus Zahl ist. 
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Der zulässige Wertebereich für Zahl ist: -1  Zahl  1 

Das Ergebnis wird im Bogenmaß (Radiant) geliefert. 

Tipp: 

Mit der Funktion GRAD können Sie das Ergebnis vom Bogenmaß in Grad um-

rechnen. 

Beispiel: 

ARCSIN(1) ergibt 1,5708... (entspricht PI()/2, also 90°) 

ARCSIN(SIN(0,1234)) ergibt 0,1234 

Siehe auch: 

SIN 

ARCSINHYP (Arcussinus Hyperbolicus) 

Syntax: 

ARCSINHYP(Zahl) 

Beschreibung: 

Die Funktion ARCSINHYP (= Arcussinus Hyperbolicus) ist die Umkehrfunktion 

der Funktion SINHYP: Sie liefert den inversen hyperbolischen Sinus einer Zahl – 

also den Wert, dessen SINHYP Zahl ist. 

Beispiel: 

ARCSINHYP(1,1) ergibt 0,9503 

ARCSINHYP(SINHYP(0,1234)) ergibt 0,1234 
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Siehe auch: 

SINHYP 

ARCTAN (Arcustangens) 

Syntax: 

ARCTAN(Zahl) 

Beschreibung: 

Die Funktion ARCTAN (= Arcustangens) ist die Umkehrfunktion der Funktion 

TAN: Sie liefert den inversen Tangens einer Zahl – also den Winkel, dessen Tan-

gens Zahl ist. 

Das Ergebnis wird im Bogenmaß (Radiant) geliefert. 

Tipp: 

Mit der Funktion GRAD können Sie das Ergebnis vom Bogenmaß in Grad um-

rechnen. 

Beispiel: 

ARCTAN(1) ergibt 0,7854 (entspricht PI()/4, also 45°) 

ARCTAN(TAN(0,1234)) ergibt 0,1234 

Siehe auch: 

ARCTAN2, TAN 

ARCTAN2 (Arcustangens 2) 

Syntax: 

ARCTAN2(x; y) 
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Beschreibung: 

Liefert den Winkel zwischen der x-Achse und einer Geraden vom Nullpunkt (0; 0) 

zu einem Punkt P (x; y). 

Als Argumente sind die x- und die y-Koordinate dieses Punktes anzugeben. 

Das Ergebnis wird in Bogenmaß (Radiant) geliefert. 

Tipp: 

Mit der Funktion GRAD können Sie das Ergebnis vom Bogenmaß in Grad um-

rechnen. 

Beispiel: 

ARCTAN2(1; 1) ergibt 0,7854 (entspricht PI()/4, also 45°) 

Siehe auch: 

ARCTAN, TAN 

ARCTANHYP (Arcustangens Hyperbolicus) 

Syntax: 

ARCTANHYP(Zahl) 

Beschreibung: 

Die Funktion ARCTANHYP (= Arcustangens Hyperbolicus) ist die Umkehrfunk-

tion der Funktion TANHYP: Sie liefert den inversen hyperbolischen Tangens einer 

Zahl – also den Wert, dessen TANHYP Zahl ist. 

Der zulässige Wertebereich für Zahl ist: -1 < Zahl < 1 

Beispiel: 

ARCTANHYP(0,5) ergibt 0,54931 
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ARCTANHYP(TANHYP(0,1234)) ergibt 0,1234 

Siehe auch: 

TANHYP 

AUFRUNDEN (Aufrunden auf n Stellen) 

Syntax: 

AUFRUNDEN(Zahl; n) 

Beschreibung: 

Rundet eine Zahl betragsmäßig auf n Nachkommastellen auf. 

n ist die gewünschte Anzahl an Nachkommastellen.  

Wird n nicht angegeben, wird die Zahl auf 0 Nachkommastellen aufgerundet. 

n darf auch ein negativer Wert sein, worauf der ganzzahlige Teil der Zahl aufge-

rundet wird: Ist n beispielsweise -2, wird die Zahl auf ein Vielfaches von Hundert 

aufgerundet (siehe letztes Beispiel). 

Beispiel: 

AUFRUNDEN(1,234; 2) ergibt 1,24 

AUFRUNDEN(1,235; 2) ergibt 1,24 

AUFRUNDEN(444,222; 0) ergibt 445 

AUFRUNDEN(444,222; -2) ergibt 500 

Siehe auch: 

ABRUNDEN, RUNDEN, KÜRZEN 
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AUSWAHL (Ist x>0, x=0 oder x<0?) 

Syntax: 

AUSWAHL(Zahl; WennGrößer [; WennNull; WennKleiner]) 

Beschreibung: 

Liefert einen der folgenden Werte zurück: 

WennGrößer, wenn Zahl größer als Null ist. 

WennNull, wenn Zahl gleich Null ist. 

WennKleiner, wenn Zahl kleiner als Null ist. 

Die letzten beiden Argumente sind dabei optional. 

Kompatibilitätshinweise: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

AUSWAHL(42; "Größer"; "Null"; "Kleiner") ergibt Größer 

AUSWAHL(0; "Größer"; "Null"; "Kleiner") ergibt Null 

AUSWAHL(-42; "Größer"; "Null"; "Kleiner") ergibt Kleiner 

Siehe auch: 

WENN 
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B (Kompatibilitätsfunktion) 

Syntax: 

B(n; p; k1 [; k2]) 

wobei: 

n = Anzahl der Versuche 

p = Trefferwahrscheinlichkeit eines Versuchs (0 bis 100%) 

k1 = Untere Schranke 

k2 = Obere Schranke (optional) 

Beschreibung: 

Liefert die Wahrscheinlichkeit, mit der bei n unabhängigen Versuchen ein Ereignis 

genau k1 mal beziehungsweise zwischen k1 und k2 mal auftritt. 

Hinweis: 

Diese Funktion ist nur aus Kompatibilitätsgründen zu PlanMaker 97 noch vorhan-

den. Verwenden Sie diese Funktion möglichst nicht mehr, sondern benutzen Sie 

stattdessen die folgenden Excel-kompatiblen Funktionen: 

B(n; p; k1) entspricht BINOMVERT(k1; n; p; FALSCH) 

B(n; p; k1; k2) entspricht BINOMVERT(k2; n; p; WAHR) - BINOMVERT(k1-1; 

n; p; WAHR) 

Kompatibilitätshinweise: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Hinweis: In Excel 2013 wurde eine neue Funktion eingeführt, die mit der Funktion 

B identisch ist: BINOM.VERT.BEREICH. PlanMaker unterstützt diese Funktion 

ebenfalls. Beachten Sie jedoch, dass ältere Versionen von Excel (und PlanMaker) 

diese Funktion noch nicht kennen. 
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Beispiel: 

Eine Münze wird 1000 Mal geworfen. Mit welcher Wahrscheinlichkeit erhält man 

dabei genau 480 Mal „Kopf“? 

Es gilt hier also: n = 1000 (1000 Versuche), p = 50% (die Wahrscheinlichkeit 

„Kopf“ zu erhalten). 

Die Berechnung sieht dementsprechend wie folgt aus: 

B(1000; 50%; 480) ergibt 0,01134 

Und wie wahrscheinlich ist es, zwischen 480 und 520 Mal „Kopf“ zu erhalten? 

B(1000; 50%; 480; 520) ergibt 0,80523 

Siehe auch: 

BINOMVERT  

BASIS (Dezimalzahl in anderes Zahlensystem wandeln) 

Syntax: 

BASIS(Zahl; Basis [; Stellen]) 

Beschreibung: 

Wandelt eine Dezimalzahl (Basis 10) in eine Zahl mit einer anderen Basis um – 

zum Beispiel eine Binärzahl (Basis 2) oder eine Hexadezimalzahl (Basis 16). 

Hinweis: Beachten Sie, dass das Ergebnis dieser Funktion eine Zeichenkette ist, 

keine Zahl.  

Zahl ist die umzuwandelnde Zahl. Es sind nur positive Zahlen erlaubt. 

Basis ist die Basis, in die Zahl umgewandelt werden soll. Es sind nur ganze Zahlen 

zwischen 2 und 36 erlaubt. 

Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen 

dabei mindestens angezeigt werden sollen. Wird es nicht angegeben, ermittelt 

PlanMaker die benötigte Stellenzahl automatisch. Stellen muss eine positive ganze 

Zahl sein.  
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Kompatibilitätshinweise: 

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versio-

nen ist die Funktion unbekannt. 

Beispiel: 

BASIS(42; 2) ergibt 101010 (die Dezimalzahl 42 als Binärzahl) 

BASIS(42; 2; 8) ergibt 00101010 (dito, aber mit mindestens 8 Stellen) 

Siehe auch: 

DEZIMAL, DEZINBIN, DEZINHEX, DEZINOKT  

BENUTZERFELD (Benutzerdaten ausgeben) 

Syntax: 

BENUTZERFELD(Feldname) 

Beschreibung: 

Liefert das angegebene Feld aus den eingetragenen Benutzerdaten (Name, Adresse 

etc.). 

Hinweis: Sie können Ihre Benutzerdaten bearbeiten, indem Sie den Menübefehl 

Weiteres > Einstellungen aufrufen, auf die Karteikarte Allgemein wechseln und 

die Schaltfläche Benutzerdaten anklicken. 

Das Argument Feldname ist der Feldname der gewünschten Information entspre-

chend der nachfolgenden Tabelle.  

Die Groß-/Kleinschreibung von Feldname spielt keine Rolle. Beachten Sie aber, 

dass feste Zeichenketten in Funktionsparametern stets mit doppelten Anführungs-

zeichen (") umgeben werden müssen – also beispielsweise BENUTZER-

FELD("Benutzer.Ort"). 

Für Feldname sind folgende Zeichenketten zulässig: 

Benutzerdaten-Feld Feldname 

Anrede Benutzer.Anrede 
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Name  Benutzer.Name 

Initialen  Benutzer.Initialen 

Firma Benutzer.Firma 

Abteilung Benutzer.Abteilung 

Adresse 1 Benutzer.Adresse 1 

Adresse 2 Benutzer.Adresse 2 

PLZ  Benutzer.PLZ 

Ort  Benutzer.Ort 

Land Benutzer.Land 

Telefon 1  Benutzer.Telefon 1 

Telefon 2  Benutzer.Telefon 2 

Telefon 3 Benutzer.Telefon 3 

Telefax  Benutzer.Telefax 

E-Mail 1 Benutzer.E-Mail 1 

E-Mail 2 Benutzer.E-Mail 2 

E-Mail 3 Benutzer.E-Mail 3 

Website  Benutzer.Website 

Kompatibilitätshinweis 1: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Kompatibilitätshinweis 2: 

In älteren Versionen von PlanMaker (bis inklusive PlanMaker 2016) gab es noch 

zwei Sätze von Benutzerdaten: „Benutzer privat“ und „Benutzer Firma“. Diese 

wurden bei PlanMaker 2018 auf einen Satz reduziert. Wenn Sie ein altes Dokument 

öffnen, das diese Funktion verwendet, werden deren Parameter automatisch ent-

sprechend konvertiert. 

Beispiel: 

BENUTZERFELD("Benutzer.Ort") ergibt Nürnberg 

Siehe auch: 

DATEINAME, BLATTNAME 
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BEREICHE (Zahl der Bereiche) 

Syntax: 

BEREICHE(Bezug) 

Beschreibung: 

Ermittelt, wie viele Bereiche der übergebene Zellbezug enthält. 

Beispiel: 

BEREICHE(A1:B2) ergibt 1 

BEREICHE((A1:B2; E5:G7)) ergibt 2 

Siehe auch: 

INDEX, SPALTEN, ZEILEN 

BEREICH.VERSCHIEBEN (Versetzter Zellbezug) 

Syntax: 

BEREICH.VERSCHIEBEN(Bezug; Zeilen; Spalten [; Höhe] [; Breite]) 

Beschreibung: 

Liefert einen Zellbezug, der gegenüber dem ursprünglichen Zellbezug um die an-

gegebene Zahl an Zeilen und/oder Spalten versetzt ist. Optional kann auch die 

Größe von Bezug geändert werden. 

Hinweis: Hierbei werden weder physikalisch Tabellenzellen verschoben, noch 

wird die Markierung versetzt. Die Funktion liefert lediglich einen versetzten Zell-

bezug zurück. 

Bezug ist der ursprüngliche Zellbezug. Sie können wahlweise eine einzelne Zelle 

oder einen Zellbereich (in der Schreibweise Startzelle:Endzelle) angeben. 
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Bei Zeilen geben Sie die Zahl der Zeilen an, um die Bezug versetzt werden soll. Es 

ist auch ein negativer Wert erlaubt – hier wird Bezug nach oben statt nach unten 

versetzt. 

Bei Spalten geben Sie die Zahl der Spalten an, um die Bezug versetzt werden soll. 

Es ist auch ein negativer Wert erlaubt – hier wird Bezug nach links statt nach 

rechts versetzt. 

Wenn Sie das optionale Argument Höhe angeben, wird die Höhe des Bezugs auf 

die entsprechende Anzahl an Zeilen geändert. 

Wenn Sie das optionale Argument Breite angeben, wird die Breite des Bezugs auf 

die entsprechende Anzahl an Spalten geändert. 

Beispiel: 

BEREICH.VERSCHIEBEN(A1; 2; 0) liefert einen Zellbezug auf die Zelle A3 

BEREICH.VERSCHIEBEN(A1:C3; 1; 1) liefert einen Zellbezug auf den Zellbe-

reich B2:D4 

BEREICH.VERSCHIEBEN(A1:C3; 1; 1; 5; 3) liefert einen Zellbezug auf den 

Zellbereich B2:D6 

SUMME(BEREICH.VERSCHIEBEN(A1:C3; 1; 1; 5; 3)) liefert die Summe der 

Zellen im Bereich B2:D6 

Siehe auch: 

ADRESSE, INDIREKT, SPALTE, ZEILE 

BESSELI (Modifizierte Besselfunktion erster Art) 

Syntax: 

BESSELI(x; n) 

Beschreibung: 

Liefert die modifizierte Besselfunktion erster Art In(x). 

x ist der auszuwertende Wert. 
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n ist die Ordnung der Besselfunktion. n muss größer gleich Null sein. Erwartet 

wird eine ganze Zahl; ist dies nicht der Fall, schneidet PlanMaker die Nachkom-

mastellen automatisch ab. 

Siehe auch: 

BESSELJ, BESSELK, BESSELY 

BESSELJ (Besselfunktion erster Art) 

Syntax: 

BESSELJ(x; n) 

Beschreibung: 

Liefert die Besselfunktion erster Art Jn(x). 

x ist der auszuwertende Wert. 

n ist die Ordnung der Besselfunktion. n muss größer gleich Null sein. Erwartet 

wird eine ganze Zahl; ist dies nicht der Fall, schneidet PlanMaker die Nachkom-

mastellen automatisch ab. 

Siehe auch: 

BESSELI, BESSELK, BESSELY 

BESSELK (Modifizierte Besselfunktion zweiter Art) 

Syntax: 

BESSELK(x; n) 

Beschreibung: 

Liefert die modifizierte Besselfunktion zweiter Art Kn(x). 
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x ist der auszuwertende Wert. 

n ist die Ordnung der Besselfunktion. n muss größer gleich Null sein. Erwartet 

wird eine ganze Zahl; ist dies nicht der Fall, schneidet PlanMaker die Nachkom-

mastellen automatisch ab. 

Siehe auch: 

BESSELI, BESSELJ, BESSELY 

BESSELY (Besselfunktion zweiter Art) 

Syntax: 

BESSELY(x; n) 

Beschreibung: 

Liefert die Besselfunktion zweiter Art Yn(x) (auch Weberfunktion oder Neumann-

funktion genannt). 

x ist der auszuwertende Wert. 

n ist die Ordnung der Besselfunktion. n muss größer gleich Null sein. Erwartet 

wird eine ganze Zahl; ist dies nicht der Fall, schneidet PlanMaker die Nachkom-

mastellen automatisch ab. 

Siehe auch: 

BESSELI, BESSELJ, BESSELK 

BESTIMMTHEITSMASS (Bestimmtheitskoeffizient) 

Syntax: 

BESTIMMTHEITSMASS(Bereich1; Bereich2) 
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Beschreibung: 

Liefert den Bestimmtheitskoeffizienten zweier Datengruppen.  

Dieser ist ein Maß für den linearen Zusammenhang der Datengruppen. Je näher er 

an 1 liegt, desto größer ist der Zusammenhang.  

Bereich1 und Bereich2 sind Zellbezüge auf die beiden Datengruppen. Diese müs-

sen Zahlen enthalten. Leere Zellen sowie Zeichenketten und Wahrheitswerte wer-

den ignoriert. 

Die Datengruppen müssen die gleiche Anzahl an Werten besitzen, ansonsten liefert 

die Funktion den Fehlerwert #NV. 

Beispiel: 

Sind die Zellen A1 bis A3 mit den Werten 2, 5, 3 und die Zellen B1 bis B3 mit den 

Werten 2, 7, 4 gefüllt, so gilt: 

BESTIMMTHEITSMASS(A1:A3; B1:B3) ergibt 0,99436 

Siehe auch: 

PEARSON 

Anmerkung: 

BESTIMMTHEITSMASS ist das Quadrat von PEARSON (Pearsonscher Korrela-

tionskoeffizient). 

BETAINV (Quantile einer Betaverteilung) 

Syntax: 

BETAINV(Wahrscheinlichkeit; Alpha; Beta [; A; B]) 

Beschreibung: 

Liefert Quantile einer Betaverteilung.  
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Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der Betaverteilung. 

Zulässig sind nur Werte mit 0 < Wahrscheinlichkeit  1. 

Alpha und Beta sind die Formparameter der Funktion. Beide müssen größer als 

Null sein.  

A und B (optional) bestimmen die Grenzen des Intervalls. Wenn Sie diese Werte 

nicht angeben, wird A auf 0 und B auf 1 gesetzt (entspricht der Normalverteilung). 

Hinweis: 

Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. 

Findet PlanMaker nach 100 Iterationen kein Ergebnis, das weniger als 3x10^-7 

von Wahrscheinlichkeit abweicht, zeigt er den Fehlerwert #NV an und bricht die 

Näherung ab. 

Siehe auch: 

BETAVERT 

BETAVERT (Betaverteilung) 

Syntax: 

BETAVERT(X; Alpha; Beta [; A; B]) 

Beschreibung: 

Liefert Werte der Verteilungsfunktion einer betaverteilten Zufallsvariablen. 

X ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll.  

Alpha und Beta sind die Formparameter der Funktion. Beide müssen größer als 

Null sein.  

A und B (optional) bestimmen die Grenzen des Intervalls. Wenn Sie diese Werte 

nicht angeben, wird A auf 0 und B auf 1 gesetzt (entspricht der Normalverteilung). 

A darf nicht kleiner als X sein. B darf nicht größer als X sein. 
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Siehe auch: 

BETAINV 

BININDEZ (Binärzahl in Dezimalzahl wandeln) 

Syntax: 

BININDEZ(Zahl) 

Beschreibung: 

Wandelt eine Binärzahl (Basis 2) in eine Dezimalzahl (Basis 10) um. 

Zahl ist die umzuwandelnde Zahl. 

Negative Zahlen müssen im 32 Bit-Zweier-Komplement notiert sein (siehe letztes 

Beispiel). 

Zahl darf maximal 32 Stellen umfassen, der zulässige Wertebereich ist also: 

-(2^31)  Zahl  (2^31)-1 

Beispiel: 

BININDEZ("101010") ergibt 42 

BININDEZ("00101010") ergibt ebenfalls 42 

BININDEZ("11111111111111111111111111010110") ergibt -42 

Siehe auch: 

DEZINBIN, BININHEX, BININOKT, DEZIMAL  
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BININHEX (Binärzahl in Hexadezimalzahl wandeln) 

Syntax: 

BININHEX(Zahl [; Stellen]) 

Beschreibung: 

Wandelt eine Binärzahl (Basis 2) in eine Hexadezimalzahl (Basis 16) um. 

Zahl ist die umzuwandelnde Zahl. 

Negative Zahlen müssen im 32 Bit-Zweier-Komplement notiert sein (siehe letztes 

Beispiel).  

Zahl darf maximal 32 Stellen umfassen, der zulässige Wertebereich ist also: 

-(2^31)  Zahl  (2^31)-1 

Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen 

angezeigt werden sollen. Wird es nicht angegeben, ermittelt PlanMaker die benö-

tigte Stellenzahl automatisch. 

Stellen muss größer Null sein. Weiterhin sollte Stellen eine ganze Zahl sein. Ist 

dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab. 

Wenn Stellen kleiner als die für die Darstellung der Zahl benötigte Mindestanzahl 

an Stellen ist, liefert die Funktion den Fehlerwert #ZAHL!. 

Wenn Zahl negativ ist, wird das Ergebnis im 32 Bit-Zweier-Komplement darge-

stellt; das Argument Stellen wird in diesem Fall ignoriert. 

Beispiel: 

BININHEX("101010") ergibt 2A 

BININHEX("00101010") ergibt ebenfalls 2A 

BININHEX("101010"; 1) ergibt den Fehlerwert #ZAHL!, da diese Zahl nur mit 

mindestens 2 Stellen dargestellt werden kann 

BININHEX("11111111111111111111111111010110") ergibt FFFFFFD6 (negative 

Zahl) 
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Siehe auch: 

HEXINBIN, BININDEZ, BININOKT 

BININOKT (Binärzahl in Oktalzahl wandeln) 

Syntax: 

BININOKT(Zahl [; Stellen]) 

Beschreibung: 

Wandelt eine Binärzahl (Basis 2) in eine Oktalzahl (Basis 8) um. 

Zahl ist die umzuwandelnde Zahl. 

Negative Zahlen müssen im 32 Bit-Zweier-Komplement notiert sein (siehe letztes 

Beispiel).  

Zahl darf maximal 32 Stellen umfassen, der zulässige Wertebereich ist also: 

-(2^31)  Zahl  (2^31)-1 

Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen 

angezeigt werden sollen. Wird es nicht angegeben, ermittelt PlanMaker die benö-

tigte Stellenzahl automatisch. 

Stellen muss größer Null sein. Weiterhin sollte Stellen eine ganze Zahl sein. Ist 

dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab. 

Wenn Stellen kleiner als die für die Darstellung der Zahl benötigte Mindestanzahl 

an Stellen ist, liefert die Funktion den Fehlerwert #ZAHL!. 

Wenn Zahl negativ ist, wird das Ergebnis im 32 Bit-Zweier-Komplement darge-

stellt; das Argument Stellen wird in diesem Fall ignoriert. 

Beispiel: 

BININOKT("101010") ergibt 52 

BININOKT("00101010") ergibt ebenfalls 52 

BININOKT("101010"; 1) ergibt den Fehlerwert #ZAHL!, da diese Zahl nur mit 

mindestens 2 Stellen dargestellt werden kann 
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BININOKT("11111111111111111111111111010110") ergibt 37777777726 (negati-

ve Zahl) 

Siehe auch: 

OKTINBIN, BININDEZ, BININHEX 

BINOMVERT (Binomialverteilung) 

Syntax: 

BINOMVERT(k; n; p; Kumuliert) 

Beschreibung: 

Liefert die Wahrscheinlichkeiten einer binomialverteilten Zufallsvariablen. 

Die Binomialverteilung ist die Wahrscheinlichkeitsverteilung für die Anzahl Tref-

fer (k) bei einem Zufallsexperiment, das n mal unabhängig wiederholt wird und 

nur zwei mögliche Ergebnisse hat (Treffer oder Fehlschlag), wobei die Wahr-

scheinlichkeit für einen Treffer pro Wiederholung p beträgt. 

Sie können mit dieser Funktion beispielsweise ermitteln, wie groß die Wahrschein-

lichkeit ist, bei 10 Münzwürfen genau 4 Mal „Kopf“ zu erhalten. 

k ist die Anzahl an Treffern, hier also 4. k muss größer gleich Null und kleiner 

gleich n sein. 

n ist die Zahl der Wiederholungen, hier also 10. 

n und k sollten ganze Zahlen sein. Ist das nicht der Fall, kürzt PlanMaker die 

Nachkommastellen automatisch weg. 

p ist die Trefferwahrscheinlichkeit pro Wiederholung, hier also die Wahrschein-

lichkeit „Kopf“ zu erhalten, sprich 50%. 

Mit dem Wahrheitswert Kumuliert bestimmen Sie, welche Funktion geliefert wer-

den soll: 

FALSCH: Es wird die Dichtefunktion geliefert. BINOMVERT ermittelt also die 

Wahrscheinlichkeit, dass es genau k Treffer gibt. 
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WAHR: Es wird die Verteilungsfunktion (also die integrierte Dichtefunktion) gelie-

fert. BINOMVERT ermittelt also die Wahrscheinlichkeit, dass es höchstens k Tref-

fer gibt.  

Beispiel: 

Greifen wir obiges Beispiel auf:  

Wie groß ist die Wahrscheinlichkeit, bei 10 Münzwürfen genau 4 Mal „Kopf“ zu 

werfen? 

BINOMVERT(4; 10; 50%; FALSCH) ergibt 0,20508. 

Wie groß ist die Wahrscheinlichkeit, höchstens 4 Mal „Kopf“ zu werfen? 

Hier verwendet man statt der Dichtefunktion die Verteilungsfunktion (Argument 

Kumuliert mit WAHR angeben): 

BINOMVERT(4; 10; 50%; WAHR) ergibt 0,37695. 

Siehe auch: 

KOMBINATIONEN, KRITBINOM, NEGBINOMVERT  

BLATT (Laufende Nummer eines Arbeitsblatts) 

Syntax: 

BLATT([Blattname]) 

Beschreibung: 

Liefert die laufende Nummer eines Arbeitsblatts in der Arbeitsmappe zurück. Das 

erste Blatt hat die Nummer 1, das zweite die Nummer 2 etc. 

Wenn das optionale Argument Blattname nicht angegeben ist, liefert die Funktion 

die Nummer des aktuellen Arbeitsblatts, ansonsten die des Blatts mit dem angege-

benen Namen. 



 

554  •  Formeln und Funktionen Handbuch PlanMaker 

Hinweis: 

Die Funktion BLATT ersetzt die (nahezu) identische Funktion BLATTNUMMER. 

Hintergrund: Die Funktion BLATTNUMMER war früher nur in PlanMaker, nicht 

aber in Excel vorhanden. In Excel 2013 hat Microsoft ebenfalls eine solche Funk-

tion eingeführt – allerdings unter einem anderen Namen: BLATT. 

Es gibt nur einen Unterschied: Wenn der übergebene Parameter ein Zellbezug ist, 

so liefert BLATT die Nummer des Arbeitsblatt, das diesen Bezug enthält. BLATT-

NUMMER hingegen liest den Inhalt der referenzierten Zelle aus und liefert dann 

die Nummer des Arbeitsblatts mit diesem Namen. 

Kompatibilitätshinweise: 

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versio-

nen ist die Funktion unbekannt. 

Beispiel: 

Beim dritten Arbeitsblatt in einer Arbeitsmappe gilt: BLATT() ergibt 3. 

BLATT("Kosten") liefert die laufende Nummer des Arbeitsblatts mit dem Namen 

„Kosten“. 

Siehe auch: 

BLATTNUMMER, BLATTNAME, DATEINAME  

BLATTNAME (Name eines Arbeitsblatts) 

Syntax: 

BLATTNAME([n]) 

Beschreibung: 

Liefert den Namen eines Arbeitsblatts. 
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Wenn das optionale Argument n nicht angegeben ist, liefert die Funktion den Na-

men des aktuellen Arbeitsblatts, ansonsten den des n-ten Blattes (von links nach 

rechts). 

Kompatibilitätshinweise: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

Ein Dokument erhält vier Arbeitsblätter: „Frühling“, „Sommer“, „Herbst“ und 

„Winter“ (in dieser Reihenfolge). Die Schreibmarke befindet sich gerade in einer 

Zelle der dritten Tabelle („Herbst“). Dann gilt: 

BLATTNAME() ergibt Herbst 

BLATTNAME(1) ergibt Frühling 

Siehe auch: 

BLATT, DATEINAME  

BLATTNUMMER (Kompatibilitätsfunktion) 

Syntax: 

BLATTNUMMER([Blattname]) 

Beschreibung: 

Kompatibilitätsfunktion für ältere PlanMaker-Dokumente.  

Diese Funktion wurde durch die (nahezu) identische Funktion BLATT ersetzt.  
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Kompatibilitätshinweise: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Tipp: Verwenden Sie statt dieser Funktion künftig die Excel 2013-kompatible 

Funktion BLATT.  

Siehe auch: 

BLATT  

BOGENMASS (Grad in Bogenmaß umwandeln) 

Syntax: 

BOGENMASS(Zahl) 

Beschreibung: 

Wandelt einen in Grad vorliegenden Winkel ins Bogenmaß (Radiant) um. 

Die Formel für die Umrechnung lautet:  

BOGENMASS(x) = x * PI() / 180 

Beispiel: 

BOGENMASS(180) ergibt 3,14159... (den Wert der Kreiszahl Pi) 

Siehe auch: 

GRAD 
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BW (Barwert) 

Syntax: 

BW(Zins; Zzr; Rmz [; Zw] [; Fälligkeit]) 

Beschreibung: 

Liefert den Barwert einer Einlage, basierend auf einer Investition mit regelmäßigen 

konstanten Zahlungen und feststehendem Zins. 

Die Funktion erwartet folgende Argumente: 

Zins = Zinssatz (pro Periode) 

Zzr = Zahl der Zahlungszeiträume (wie viele Perioden umfasst die Laufzeit?) 

Rmz = Annuität (Betrag, der pro Periode gezahlt wird) 

Zw (optional) = Zukünftiger Wert, also der Endstand, den Sie nach der letzten Zah-

lung erreichen möchten. Wenn Sie das Argument Zw nicht angeben, wird es auf 

Null gesetzt. 

Fälligkeit (optional) = Wann die Zahlungen fällig sind: 

0 oder nicht angegeben: jeweils am Ende der Periode 

1: jeweils am Anfang der Periode 

Beispiel: 

BW(6,5%/12; 12*10; 650) ergibt -57244,52 

Diese Formel berechnet den Barwert eines Darlehens mit einem Zinssatz von 6,5% 

(pro Jahr, deshalb die Teilung durch 12), einer Laufzeit von 10 Jahren (=12*10 

Monate) und einer Annuität von 650 Euro (pro Monat). 

Siehe auch: 

KAPZ, RMZ, ZINS, ZINSZ, ZW, ZZR 
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CHIINV (Quantile einer Chi-Quadrat-Verteilung) 

Syntax: 

CHIINV(Wahrscheinlichkeit; Freiheitsgrade) 

Beschreibung: 

Liefert Quantile einer Chi-Quadrat-Verteilung.  

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der Chi-Quadrat-

Verteilung. Zulässig sind nur Werte aus dem Intervall [0..1]. 

Freiheitsgrade bestimmt die Zahl der Freiheitsgrade. Dieser Wert darf nicht klei-

ner als 1 oder größer als 10^10 sein. Erwartet wird eine ganze Zahl; ist dies nicht 

der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab. 

Hinweis: 

Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. 

Findet PlanMaker nach 100 Iterationen kein Ergebnis, das weniger als 3x10^-7 

von Wahrscheinlichkeit abweicht, zeigt er den Fehlerwert #NV an und bricht die 

Näherung ab. 

Siehe auch: 

CHITEST, CHIVERT 

CHITEST (Chi-Quadrat-Unabhängigkeitstest) 

Syntax: 

CHITEST(BeobachteteWerte; ErwarteteWerte) 

Beschreibung: 

Liefert die Teststatistik eines Chi-Quadrat-Unabhängigkeitstests.  
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Ein Chi-Quadrat-Test liefert ein allgemeines Kriterium für die Übereinstimmung 

der Grundgesamtheit mit einer Stichprobe. 

Für BeobachteteWerte sind die beobachteten Werte anzugeben; für Erwartete-

Werte die erwarteten Werte. 

Siehe auch: 

CHIINV, CHIVERT 

CHIVERT (Chi-Quadrat-Verteilung) 

Syntax: 

CHIVERT(X; Freiheitsgrade) 

Beschreibung: 

Liefert Werte der Verteilungsfunktion einer Chi Quadrat-verteilten Zufallsvariab-

len. 

X ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. X darf keine ne-

gative Zahl sein. 

Freiheitsgrade bestimmt die Zahl der Freiheitsgrade. Dieser Wert darf nicht klei-

ner als 1 oder größer als 10^10 sein. Erwartet wird eine ganze Zahl; ist dies nicht 

der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab. 

Siehe auch: 

CHIINV, CHITEST 

CODE (ANSI-Code eines Zeichens) 

Syntax: 

CODE(Zeichenkette) 
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Beschreibung: 

Liefert den ANSI-Code des ersten Zeichens der übergebenen Zeichenkette. 

Beispiel: 

CODE("A") ergibt 65 

CODE("Arthur") ergibt ebenfalls 65 

CODE(ZEICHEN(123)) ergibt 123 

CODE("") ergibt 0 

Siehe auch: 

ZEICHEN 

COS (Cosinus) 

Syntax: 

COS(Zahl) 

Beschreibung: 

Liefert den Cosinus eines Winkels.  

Der Winkel ist dabei im Bogenmaß (Radiant) anzugeben. 

Tipp: 

Mit der Funktion BOGENMASS können Sie einen in Grad vorliegenden Winkel 

ins Bogenmaß umrechnen. 

Beispiel: 

COS(PI()) ergibt -1 

COS(BOGENMASS(180)) ergibt -1 
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Siehe auch: 

ARCCOS 

COSHYP (Cosinus Hyperbolicus) 

Syntax: 

COSHYP(Zahl) 

Beschreibung: 

Die Funktion COSHYP (= Cosinus Hyperbolicus) liefert den hyperbolischen Co-

sinus einer Zahl. 

Beispiel: 

COSHYP(0,1) ergibt 1,005 

Siehe auch: 

ARCCOSHYP 

COT (Cotangens) 

Syntax: 

COT(Zahl) 

Beschreibung: 

Liefert den Cotangens eines Winkels.  

Der Winkel ist dabei im Bogenmaß (Radiant) anzugeben. 
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Tipp: 

Mit der Funktion BOGENMASS können Sie einen in Grad vorliegenden Winkel 

ins Bogenmaß umrechnen. 

Kompatibilitätshinweise: 

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versio-

nen ist die Funktion unbekannt. 

Beispiel: 

COT(PI()/4) ergibt 1 

COT(BOGENMASS(45)) ergibt 1 

Siehe auch: 

ARCCOT 

COTHYP (Cotangens Hyperbolicus) 

Syntax: 

COTHYP(Zahl) 

Beschreibung: 

Die Funktion COTHYP (= Cotangens Hyperbolicus) liefert den hyperbolischen 

Cotangens einer Zahl. 

Kompatibilitätshinweise: 

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versio-

nen ist die Funktion unbekannt. 

Beispiel: 

COTHYP(0,45) ergibt 2,37024 
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Siehe auch: 

ARCCOTHYP 

DATEDIF (Datumsdifferenz) 

Syntax: 

DATEDIF(Ausgangsdatum; Enddatum; Modus) 

Beschreibung: 

Berechnet die Differenz zwischen zwei Daten, wahlweise in Tagen, Monaten oder 

Jahren. 

Hinweis: Dies ist eine undokumentierte Excel-Funktion. Sie wurde aus der Hilfe 

von Microsoft Excel wieder entfernt und wird von daher – zumindest offiziell – 

nicht mehr von Excel unterstützt. 

Ausgangsdatum und Enddatum sind die beiden Daten. Das Ausgangsdatum muss 

vor dem Enddatum liegen. 

Modus bestimmt, auf welche Weise und in welcher Einheit die Differenz zwischen 

Ausgangsdatum und Enddatum berechnet werden soll: 

"y" Zahl der vergangenen Jahre 

"m" Zahl der vergangenen Monate 

"d" Zahl der vergangenen Tage 

"ym" Zahl der Monate, wenn man die Tage und Jahre der Datumsangaben ignoriert 

"yd" Zahl der Tage, wenn man die Jahre der Datumsangaben ignoriert 

"md" Zahl der Tage, wenn man die Monate und Jahre der Datumsangaben ignoriert 

Beispiel: 

In A1 steht das Geburtsdatum einer Person (z.B. der 3.4.1970). In A2 steht das zu 

vergleichende Datum (z.B. der 8.6.2012).  

Folgendermaßen berechnen Sie das Alter der Person: 

In Jahren: 
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DATEDIF(A1; A2; "y") ergibt 42 (Jahre) 

In Monaten: 

DATEDIF(A1; A2; "m") ergibt 506 (Monate) 

In Tagen: 

DATEDIF(A1; A2; "d") ergibt 15407 (Tage) 

In Jahren, Monaten und Tagen: 

DATEDIF(A1; A2; "y") ergibt 42 (Jahre) 

DATEDIF(A1; A2; "ym") ergibt 2 (Monate) 

DATEDIF(A1; A2; "md") ergibt 5 (Tage) 

(Die Person ist also 42 Jahre, 2 Monate und 5 Tage alt.) 

Siehe auch: 

JETZT, NETTOARBEITSTAGE, TAGE 

DATEINAME (Dateiname des Dokuments) 

Syntax: 

DATEINAME([Mit_Pfad]) 

Beschreibung: 

Liefert den Dateinamen des aktuellen Dokuments. 

Der Wahrheitswert Mit_Pfad bestimmt, ob auch der Pfad (Laufwerk und Ver-

zeichnis) ausgegeben werden sollen: 

FALSCH oder nicht angegeben: ohne Pfad 

WAHR: mit Pfad 

Kompatibilitätshinweise: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 
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Beispiel: 

Speichern Sie ein Dokument im Verzeichnis c:\Dokumente unter dem Dateinamen 

Umsätze.pmdx ab, so gilt in diesem Dokument: 

DATEINAME() ergibt Umsätze.pmdx 

DATEINAME(WAHR) ergibt c:\Dokumente\Umsätze.pmdx 

Siehe auch: 

BENUTZERFELD, BLATTNAME 

DATUM (Datumswert bilden) 

Syntax: 

DATUM(Jahr; Monat; Tag) 

Beschreibung: 

Bildet einen Datumswert aus den Argumenten Jahr, Monat und Tag. 

Beispiel: 

DATUM(2013; 9; 25) ergibt 41542 

Dieser Datumswert wird von PlanMaker allerdings automatisch im Zahlenformat 

„Datum/Zeit“ formatiert, so dass in der Zelle steht: 25.09.2013. 

Siehe auch: 

DATWERT, ZEIT, ZEITWERT 
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DATWERT (Text in Datum wandeln) 

Syntax: 

DATWERT(Zeichenkette) 

Beschreibung: 

Wandelt eine als Zeichenkette übergegebene Datumsangabe in ein Datum (genauer 

gesagt: in eine serielle Datumszahl) um.  

Hinweis: 

Diese Funktion ist nur aus Kompatibilitätsgründen zu älteren Tabellenkalkulatio-

nen noch vorhanden. PlanMaker selbst benötigt sie nicht mehr, da er Daten, die als 

Text angegeben sind, bei Bedarf automatisch in ein Datum umwandelt. 

Beispiel: 

DATWERT("25.09.2013") ergibt die serielle Datumszahl 41542. 

Formatieren Sie diese nun mit dem Menübefehl Format > Zelle in einem der Da-

tum/Zeit-Formate (zum Beispiel T.M.JJ), so wird in der Zelle das Datum angezeigt, 

das sich hinter diesem Wert verbirgt: der 25.9.2013.  

Siehe auch: 

ZEITWERT, DATUM, ZEIT 

DBANZAHL (Datenbankfunktion) 

Syntax: 

DBANZAHL(Datenbankbereich; Spalte; Suchkriterienbereich) 
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Beschreibung: 

Ermittelt die Anzahl der Zellen in einem Datenbankbereich, die den im Suchkrite-

rienbereich angegebenen Bedingungen entsprechen. 

Berücksichtigt werden dabei nur Zellen, die Zahlen enthalten. Zellen mit Zeichen-

ketten und Wahrheitswerten werden ignoriert. 

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie 

im Abschnitt „Anmerkungen zu den Datenbankfunktionen“ ab Seite 519. 

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile 

muss Beschriftungen für die Spalten enthalten (zum Beispiel Menge, Preis etc.). 

Wenn das Argument Spalte nicht leer ist, berücksichtigt die Funktion nur Zellen 

aus der entsprechenden Spalte. Sie können entweder die Spaltennummer oder die 

Spaltenbeschriftung in doppelten Anführungszeichen angeben (zum Beispiel 

"Menge", "Preis" etc.). 

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen 

enthält. Auch hier muss die erste Zeile Beschriftungen für die Spalten enthalten 

(also ebenfalls Menge, Preis etc.). 

Siehe auch: 

DBANZAHL2 

DBANZAHL2 (Datenbankfunktion) 

Syntax: 

DBANZAHL2(Datenbankbereich; Spalte; Suchkriterienbereich) 

Beschreibung: 

Ermittelt die Anzahl der Zellen in einem Datenbankbereich, die den im Suchkrite-

rienbereich angegebenen Bedingungen entsprechen. 

Im Gegensatz zur Datenbankfunktion DBANZAHL berücksichtigt DBANZAHL2 

nicht nur Zellen mit Zahlenwerten, sondern beliebige Zellen – also auch Zellen mit 

Zeichenketten und Wahrheitswerten. 
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Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie 

im Abschnitt „Anmerkungen zu den Datenbankfunktionen“ ab Seite 519. 

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile 

muss Beschriftungen für die Spalten enthalten (zum Beispiel Menge, Preis etc.). 

Wenn das Argument Spalte nicht leer ist, berücksichtigt die Funktion nur Zellen 

aus der entsprechenden Spalte. Sie können entweder die Spaltennummer oder die 

Spaltenbeschriftung in doppelten Anführungszeichen angeben (zum Beispiel 

"Menge", "Preis" etc.). 

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen 

enthält. Auch hier muss die erste Zeile Beschriftungen für die Spalten enthalten 

(also ebenfalls Menge, Preis etc.). 

Siehe auch: 

DBANZAHL 

DBAUSZUG (Datenbankfunktion) 

Syntax: 

DBAUSZUG(Datenbankbereich; Spalte; Suchkriterienbereich) 

Beschreibung: 

Liefert genau den Wert aus einer Spalte eines Datenbankbereichs, der den im 

Suchkriterienbereich angegebenen Bedingungen entspricht. 

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie 

im Abschnitt „Anmerkungen zu den Datenbankfunktionen“ ab Seite 519. 

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile 

muss Beschriftungen für die Spalten enthalten (zum Beispiel Menge, Preis etc.). 

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden 

sollen. Sie können entweder die Spaltennummer oder die Spaltenbeschriftung in 

doppelten Anführungszeichen angeben (zum Beispiel "Menge", "Preis" etc.). 
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Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen 

enthält. Auch hier muss die erste Zeile Beschriftungen für die Spalten enthalten 

(also ebenfalls Menge, Preis etc.). 

Hinweis: 

Es darf nur eine einzige Zeile die Suchbedingungen erfüllen; andernfalls liefert die 

Funktion den Fehlerwert #ZAHL. 

DBMAX (Datenbankfunktion) 

Syntax: 

DBMAX(Datenbankbereich; Spalte; Suchkriterienbereich) 

Beschreibung: 

Liefert den größten Wert aus einer Spalte eines Datenbankbereichs, der den im 

Suchkriterienbereich angegebenen Bedingungen entspricht. 

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie 

im Abschnitt „Anmerkungen zu den Datenbankfunktionen“ ab Seite 519. 

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile 

muss Beschriftungen für die Spalten enthalten (zum Beispiel Menge, Preis etc.). 

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden 

sollen. Sie können entweder die Spaltennummer oder die Spaltenbeschriftung in 

doppelten Anführungszeichen angeben (zum Beispiel "Menge", "Preis" etc.). 

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen 

enthält. Auch hier muss die erste Zeile Beschriftungen für die Spalten enthalten 

(also ebenfalls Menge, Preis etc.). 

Siehe auch: 

MAX, DBMIN 
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DBMIN (Datenbankfunktion) 

Syntax: 

DBMIN(Datenbankbereich; Spalte; Suchkriterienbereich) 

Beschreibung: 

Liefert den kleinsten Wert aus einer Spalte eines Datenbankbereichs, der den im 

Suchkriterienbereich angegebenen Bedingungen entspricht. 

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie 

im Abschnitt „Anmerkungen zu den Datenbankfunktionen“ ab Seite 519. 

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile 

muss Beschriftungen für die Spalten enthalten (zum Beispiel Menge, Preis etc.). 

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden 

sollen. Sie können entweder die Spaltennummer oder die Spaltenbeschriftung in 

doppelten Anführungszeichen angeben (zum Beispiel "Menge", "Preis" etc.). 

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen 

enthält. Auch hier muss die erste Zeile Beschriftungen für die Spalten enthalten 

(also ebenfalls Menge, Preis etc.). 

Siehe auch: 

MIN, DBMAX 

DBMITTELWERT (Datenbankfunktion) 

Syntax: 

DBMITTELWERT(Datenbankbereich; Spalte; Suchkriterienbereich) 

Beschreibung: 

Liefert den Mittelwert der Werte aus einer Spalte eines Datenbankbereichs, die den 

im Suchkriterienbereich angegebenen Bedingungen entsprechen. 
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Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie 

im Abschnitt „Anmerkungen zu den Datenbankfunktionen“ ab Seite 519. 

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile 

muss Beschriftungen für die Spalten enthalten (zum Beispiel Menge, Preis etc.). 

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden 

sollen. Sie können entweder die Spaltennummer oder die Spaltenbeschriftung in 

doppelten Anführungszeichen angeben (zum Beispiel "Menge", "Preis" etc.). 

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen 

enthält. Auch hier muss die erste Zeile Beschriftungen für die Spalten enthalten 

(also ebenfalls Menge, Preis etc.). 

Siehe auch: 

MITTELWERT 

DBPRODUKT (Datenbankfunktion) 

Syntax: 

DBPRODUKT(Datenbankbereich; Spalte; Suchkriterienbereich) 

Beschreibung: 

Liefert das Produkt der Werte aus einer Spalte eines Datenbankbereichs, die den im 

Suchkriterienbereich angegebenen Bedingungen entsprechen. 

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie 

im Abschnitt „Anmerkungen zu den Datenbankfunktionen“ ab Seite 519. 

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile 

muss Beschriftungen für die Spalten enthalten (zum Beispiel Menge, Preis etc.). 

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden 

sollen. Sie können entweder die Spaltennummer oder die Spaltenbeschriftung in 

doppelten Anführungszeichen angeben (zum Beispiel "Menge", "Preis" etc.). 

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen 

enthält. Auch hier muss die erste Zeile Beschriftungen für die Spalten enthalten 

(also ebenfalls Menge, Preis etc.). 
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Siehe auch: 

PRODUKT 

DBSTDABW (Datenbankfunktion) 

Syntax: 

DBSTDABW(Datenbankbereich; Spalte; Suchkriterienbereich) 

Beschreibung: 

Liefert einen Schätzwert für die Standardabweichung der Grundgesamtheit, basie-

rend auf den Werten aus einer Spalte eines Datenbankbereichs, die den im Suchkri-

terienbereich angegebenen Bedingungen entsprechen. 

Die Funktion geht davon aus, dass die ermittelten Werte eine Stichprobe aus der 

Grundgesamtheit darstellen. Ausgehend davon wird die Standardabweichung ge-

schätzt. 

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie 

im Abschnitt „Anmerkungen zu den Datenbankfunktionen“ ab Seite 519. 

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile 

muss Beschriftungen für die Spalten enthalten (zum Beispiel Menge, Preis etc.). 

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden 

sollen. Sie können entweder die Spaltennummer oder die Spaltenbeschriftung in 

doppelten Anführungszeichen angeben (zum Beispiel "Menge", "Preis" etc.). 

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen 

enthält. Auch hier muss die erste Zeile Beschriftungen für die Spalten enthalten 

(also ebenfalls Menge, Preis etc.). 

Siehe auch: 

STABW, DBSTDABWN 
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DBSTDABWN (Datenbankfunktion) 

Syntax: 

DBSTDABWN(Datenbankbereich; Spalte; Suchkriterienbereich) 

Beschreibung: 

Liefert die Standardabweichung einer Grundgesamtheit, basierend auf den Werten 

aus einer Spalte eines Datenbankbereichs, die den im Suchkriterienbereich angege-

benen Bedingungen entsprechen. 

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie 

im Abschnitt „Anmerkungen zu den Datenbankfunktionen“ ab Seite 519. 

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile 

muss Beschriftungen für die Spalten enthalten (zum Beispiel Menge, Preis etc.). 

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden 

sollen. Sie können entweder die Spaltennummer oder die Spaltenbeschriftung in 

doppelten Anführungszeichen angeben (zum Beispiel "Menge", "Preis" etc.). 

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen 

enthält. Auch hier muss die erste Zeile Beschriftungen für die Spalten enthalten 

(also ebenfalls Menge, Preis etc.). 

Siehe auch: 

STABWN, DBSTDABW 

DBSUMME (Datenbankfunktion) 

Syntax: 

DBSUMME(Datenbankbereich; Spalte; Suchkriterienbereich) 

Beschreibung: 

Liefert die Summe der Werte aus einer Spalte eines Datenbankbereichs, die den im 

Suchkriterienbereich angegebenen Bedingungen entsprechen. 
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Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie 

im Abschnitt „Anmerkungen zu den Datenbankfunktionen“ ab Seite 519. 

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile 

muss Beschriftungen für die Spalten enthalten (zum Beispiel Menge, Preis etc.). 

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden 

sollen. Sie können entweder die Spaltennummer oder die Spaltenbeschriftung in 

doppelten Anführungszeichen angeben (zum Beispiel "Menge", "Preis" etc.). 

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen 

enthält. Auch hier muss die erste Zeile Beschriftungen für die Spalten enthalten 

(also ebenfalls Menge, Preis etc.). 

Siehe auch: 

SUMME 

DBVARIANZ (Datenbankfunktion) 

Syntax: 

DBVARIANZ(Datenbankbereich; Spalte; Suchkriterienbereich) 

Beschreibung: 

Liefert einen Schätzwert für die Varianz der Grundgesamtheit, basierend auf den 

Werten aus einer Spalte eines Datenbankbereichs, die den im Suchkriterienbereich 

angegebenen Bedingungen entsprechen. 

Die Funktion geht davon aus, dass die ermittelten Werte eine Stichprobe aus der 

Grundgesamtheit darstellen. Ausgehend davon wird die Varianz geschätzt. 

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie 

im Abschnitt „Anmerkungen zu den Datenbankfunktionen“ ab Seite 519. 

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile 

muss Beschriftungen für die Spalten enthalten (zum Beispiel Menge, Preis etc.). 

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden 

sollen. Sie können entweder die Spaltennummer oder die Spaltenbeschriftung in 

doppelten Anführungszeichen angeben (zum Beispiel "Menge", "Preis" etc.). 
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Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen 

enthält. Auch hier muss die erste Zeile Beschriftungen für die Spalten enthalten 

(also ebenfalls Menge, Preis etc.). 

Siehe auch: 

VARIANZ, DBVARIANZEN 

DBVARIANZEN (Datenbankfunktion) 

Syntax: 

DBVARIANZEN(Datenbankbereich; Spalte; Suchkriterienbereich) 

Beschreibung: 

Liefert die Varianz einer Grundgesamtheit, basierend auf den Werten aus einer 

Spalte eines Datenbankbereichs, die den im Suchkriterienbereich angegebenen 

Bedingungen entsprechen. 

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie 

im Abschnitt „Anmerkungen zu den Datenbankfunktionen“ ab Seite 519. 

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile 

muss Beschriftungen für die Spalten enthalten (zum Beispiel Menge, Preis etc.). 

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden 

sollen. Sie können entweder die Spaltennummer oder die Spaltenbeschriftung in 

doppelten Anführungszeichen angeben (zum Beispiel "Menge", "Preis" etc.). 

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen 

enthält. Auch hier muss die erste Zeile Beschriftungen für die Spalten enthalten 

(also ebenfalls Menge, Preis etc.). 

Siehe auch: 

VARIANZEN, DBVARIANZ 
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DELTA (Prüfen auf Gleichheit zweier Werte) 

Syntax: 

DELTA(Wert1; Wert2) 

Beschreibung: 

Prüft, ob zwei Zahlenwerte gleich sind. Ist dies der Fall, liefert die Funktion 1, an-

sonsten 0. 

Wert1 und Wert2 müssen Zahlen sein. Auch Zeichenketten, die ausschließlich 

eine Zahl enthalten, sind zulässig.  

Beispiel: 

DELTA(1; 2) ergibt 0 

DELTA(2; 2) ergibt 1 

DELTA(2; "2") ergibt 1 

DELTA("Text"; "Text") ergibt den Fehlerwert #WERT! 

Siehe auch: 

IDENTISCH 

DEZIBEL (Dezibelwert zweier Größen) 

Syntax: 

DEZIBEL(P2 [; P1]) 

Beschreibung: 

Berechnet den Dezibelwert (dB) für das Verhältnis zweier Größen.  

Der Berechnung liegt folgende Formel zugrunde: 
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DEZIBEL(P2; P1) = 10 * LOG10(P2/P1) 

Hinweis: Achten Sie dabei auf die Reihenfolge der Parameter: Erst muss der Zähler 

P2 des Quotienten übergeben werden, dann der Nenner P1 – nicht umgekehrt. 

P2 und P1 müssen Zahlen sein. Ihr Quotient muss größer als Null sein. 

Der Parameter P1 ist optional. Wird er nicht angegeben, setzt PlanMaker ihn auto-

matisch auf 1 (eins). 

Kompatibilitätshinweise: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

DEZIBEL(1000; 10) ergibt 20 

DEZIMAL (Zahl aus anderem Zahlensystem umwandeln) 

Syntax: 

DEZIMAL(Zahl; Basis) 

Beschreibung: 

Wandelt eine Zahl von einem Zahlensystem mit einer anderen Basis in eine Dezi-

malzahl (Basis 10) um – also beispielsweise eine Binärzahl (Basis 2) oder eine 

Hexadezimalzahl (Basis 16).  

Zahl ist die umzuwandelnde Zahl. 

Basis ist die Basis der umzuwandelnden Zahl. Es sind nur ganze Zahlen zwischen 

2 und 36 erlaubt. 

Kompatibilitätshinweise: 

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versio-

nen ist die Funktion unbekannt. 
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Beispiel: 

DEZIMAL("00101010"; 2) ergibt 42 

DEZIMAL("FF"; 16) ergibt 255 

Siehe auch: 

BASIS, BININDEZ, HEXINDEZ, OKTINDEZ  

DEZINBIN (Dezimalzahl in Binärzahl wandeln) 

Syntax: 

DEZINBIN(Zahl [; Stellen]) 

Beschreibung: 

Wandelt eine Dezimalzahl (Basis 10) in eine Binärzahl (Basis 2) um. 

Hinweis: Beachten Sie, dass das Ergebnis dieser Funktion eine Zeichenkette ist, 

keine Zahl.  

Zahl ist die umzuwandelnde Zahl. 

Der zulässige Wertebereich für Zahl ist: 

-(2^31)  Zahl  (2^31)-1 

Das entspricht: 

-2.147.483.648  Zahl  2.147.483.647 

Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen 

angezeigt werden sollen. Wird es nicht angegeben, ermittelt PlanMaker die benö-

tigte Stellenzahl automatisch. 

Stellen muss größer Null sein. Weiterhin sollte Stellen eine ganze Zahl sein. Ist 

dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab. 

Wenn Stellen kleiner als die für die Darstellung der Zahl benötigte Mindestanzahl 

an Stellen ist, liefert die Funktion den Fehlerwert #ZAHL!. 
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Wenn Zahl negativ ist, wird das Ergebnis im 32 Bit-Zweier-Komplement darge-

stellt; das Argument Stellen wird in diesem Fall ignoriert (siehe letztes Beispiel). 

Beispiel: 

DEZINBIN(42) ergibt 101010 

DEZINBIN(42; 8) ergibt 00101010 

DEZINBIN(42; 4) ergibt den Fehlerwert #ZAHL!, da die Zahl 42 binär nur mit 

mindestens 6 Stellen dargestellt werden kann 

DEZINBIN(-42) ergibt 11111111111111111111111111010110 

Siehe auch: 

BININDEZ, DEZINHEX, DEZINOKT, BASIS  

DEZINHEX (Dezimalzahl in Hexadezimalzahl wandeln) 

Syntax: 

DEZINHEX(Zahl [; Stellen]) 

Beschreibung: 

Wandelt eine Dezimalzahl (Basis 10) in eine Hexadezimalzahl (Basis 16) um. 

Hinweis: Beachten Sie, dass das Ergebnis dieser Funktion eine Zeichenkette ist, 

keine Zahl.  

Zahl ist die umzuwandelnde Zahl. 

Der zulässige Wertebereich für Zahl ist: 

-(2^31)  Zahl  (2^31)-1 

Das entspricht: 

-2.147.483.648  Zahl  2.147.483.647 
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Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen 

angezeigt werden sollen. Wird es nicht angegeben, ermittelt PlanMaker die benö-

tigte Stellenzahl automatisch. 

Stellen muss größer Null sein. Weiterhin sollte Stellen eine ganze Zahl sein. Ist 

dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab. 

Wenn Stellen kleiner als die für die Darstellung der Zahl benötigte Mindestanzahl 

an Stellen ist, liefert die Funktion den Fehlerwert #ZAHL!. 

Wenn Zahl negativ ist, wird das Ergebnis im 32 Bit-Zweier-Komplement darge-

stellt; das Argument Stellen wird in diesem Fall ignoriert (siehe letztes Beispiel). 

Beispiel: 

DEZINHEX(42) ergibt 2A 

DEZINHEX(42; 8) ergibt 0000002A 

DEZINHEX(42; 1) ergibt den Fehlerwert #ZAHL!, da die Zahl 42 hexadezimal 

nur mit mindestens 2 Stellen dargestellt werden kann 

DEZINHEX(-42) ergibt FFFFFFD6 

Siehe auch: 

HEXINDEZ, DEZINBIN, DEZINOKT, BASIS  

DEZINOKT (Dezimalzahl in Oktalzahl wandeln) 

Syntax: 

DEZINOKT(Zahl [; Stellen]) 

Beschreibung: 

Wandelt eine Dezimalzahl (Basis 10) in eine Oktalzahl (Basis 8) um. 

Hinweis: Beachten Sie, dass das Ergebnis dieser Funktion eine Zeichenkette ist, 

keine Zahl.  
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Zahl ist die umzuwandelnde Zahl. 

Der zulässige Wertebereich für Zahl ist: 

-(2^31)  Zahl  (2^31)-1 

Das entspricht: 

-2.147.483.648  Zahl  2.147.483.647 

Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen 

angezeigt werden sollen. Wird es nicht angegeben, ermittelt PlanMaker die benö-

tigte Stellenzahl automatisch. 

Stellen muss größer Null sein. Weiterhin sollte Stellen eine ganze Zahl sein. Ist 

dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab. 

Wenn Stellen kleiner als die für die Darstellung der Zahl benötigte Mindestanzahl 

an Stellen ist, liefert die Funktion den Fehlerwert #ZAHL!. 

Wenn Zahl negativ ist, wird das Ergebnis im 32 Bit-Zweier-Komplement darge-

stellt; das Argument Stellen wird in diesem Fall ignoriert (siehe letztes Beispiel). 

Beispiel: 

DEZINOKT(42) ergibt 52 

DEZINOKT(42; 8) ergibt 00000052 

DEZINOKT(42; 1) ergibt den Fehlerwert #ZAHL!, da die Zahl 42 oktal nur mit 

mindestens 2 Stellen dargestellt werden kann 

DEZINOKT(-42) ergibt 37777777726 

Siehe auch: 

OKTINDEZ, DEZINBIN, DEZINHEX, BASIS  

DIA (Arithmetisch-degressive Abschreibung) 

Syntax: 

DIA(AW; RW; ND; ZR) 
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Beschreibung: 

Liefert die arithmetisch-degressive Abschreibung eines Objekts über einen be-

stimmten Zeitraum. 

Die Funktion erwartet folgende Argumente: 

AW = Anschaffungskosten des Objekts 

RW = Restwert des Objekts am Ende der Nutzungsdauer 

ND = Nutzungsdauer (Anzahl der Perioden, über die das Objekt abgeschrieben 

wird) 

ZR = Zeitraum (in der gleichen Einheit wie ND anzugeben) 

Hinweis: 

Diese Funktion ist auf das deutsche Steuerrecht nur bedingt anwendbar! 

Beispiel: 

Bei einer für € 200.000,- erworbenen Maschine, die 10 Jahre genutzt wird und ei-

nen Restwert von € 10.000,- hat, gilt für das erste Jahr folgender jahresbezogener 

Abschreibungsbetrag: 

DIA(200000; 10000; 10; 1) ergibt 34545,45 Euro 

Siehe auch: 

GDA, LIA 

EDATUM (Datum in/vor n Monaten) 

Syntax: 

EDATUM(Ausgangsdatum; m) 



 

Handbuch PlanMaker Formeln und Funktionen  •  583 

Beschreibung: 

Ermittelt das Datum, das m Monate vor/nach dem Datum Ausgangsdatum liegt. 

Sie können damit Termine ermitteln, die auf denselben Tag eines anderen Monats 

fallen. 

Mit dem Argument m geben Sie die Zahl der Monate an. 

Wenn m positiv ist, wird das Datum berechnet, das m Monate hinter dem Aus-

gangsdatum liegt. 

Wenn m negativ ist, erhalten Sie das Datum, das m Monate vor dem Ausgangsda-

tum liegt. 

m sollte eine ganze Zahl sein. Ist dies nicht der Fall, entfernt PlanMaker die Nach-

kommastellen automatisch. 

Beispiel: 

EDATUM("30.03.2018"; 1) ergibt 30.04.2018 

EDATUM("31.03.2018"; 1) ergibt ebenfalls 30.04.2018, da der April nur 30 Tage 

hat. 

Siehe auch: 

MONATSENDE 

EFFEKTIV (Effektivzins) 

Syntax: 

EFFEKTIV(NomZins; Zinsgutschriften) 

Beschreibung: 

Ermittelt den effektiven Jahreszins, ausgehend vom nominalen Jahreszins und der 

Zahl der Zinsgutschriften pro Jahr. 

NomZins ist der nominale Jahreszins. 
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Zinsgutschriften ist die Zahl der Zinsgutschriften pro Jahr (muss mindestens 1 

sein). 

Hinweis: 

Diese Funktion berechnet nicht den effektiven Jahreszins gemäß der deutschen 

Preisangabenverordnung (PAngV). Sie berücksichtigt keinerlei Gebühren, Provisi-

onen etc., sondern schlägt lediglich die über das Jahr anfallenden Zinseszinsen auf 

den Nominalzins auf. 

Beispiel: 

Eine Geldanlage bietet 5% nominalen Jahreszins, Zinsen werden 4x pro Jahr gut-

geschrieben. Wie hoch liegt der effektive Jahreszins? 

EFFEKTIV(5%; 4) ergibt ca. 5,09% 

Siehe auch: 

NOMINAL 

ERSETZEN (Text in Zeichenkette ersetzen) 

Syntax: 

ERSETZEN(Zeichenkette; Start; Anzahl; Ersatztext) 

Beschreibung: 

Ersetzt einen bestimmten Teil einer Zeichenkette durch anderen Text. 

Zeichenkette ist die ursprüngliche Zeichenkette. 

Start ist die Position des ersten Zeichens, das ersetzt werden soll. 

Anzahl ist die Zahl der Zeichen, die ersetzt werden. 

Ersatztext ist der neue Text. 
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Beispiel: 

ERSETZEN ("aaaaaa"; 3; 2; "bb") ergibt aabbaa 

ERSETZEN ("aaaaaa"; 3; 4; "bb") ergibt aabb 

ERSETZEN ("cccccc"; 3; 2; "dddddddd") ergibt ccddcc 

ERSETZEN ("cccccc"; 3; 4; "dddddddd") ergibt ccdddd 

ERSETZEN ("cccccc"; 3; 6; "dddddddd") ergibt ccdddddd 

Siehe auch: 

FINDEN, SUCHEN, TEIL, WECHSELN 

ERSTELLDATUM (Datum des Erstellens eines Dokuments) 

Syntax: 

ERSTELLDATUM() 

Beschreibung: 

Liefert das Datum und die Uhrzeit des Zeitpunkts, an dem das aktuelle Dokument 

erstellt wurde. 

Kompatibilitätshinweise: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

Wurde ein Dokument am 16.07.2018 um 16:03 erstellt, so gilt: 

ERSTELLDATUM() = 16.07.18 16:03 
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Tipp: Über die Auswahl eines geeigneten Datumsformats mit dem Menübefehl 

Format > Zelle können Sie bestimmen, ob nur das Datum, nur die Uhrzeit oder 

beides angezeigt werden soll. 

Siehe auch: 

JETZT 

EUROCONVERT (Euro-Währungen konvertieren) 

Syntax: 

EUROCONVERT(Zahl; Quellwährung; Zielwährung) 

Beschreibung: 

Diese Funktion kann die alten Währungen aller EU-Mitgliedsländer umrechnen, 

die der Währungsunion beigetreten sind, also die Einheitswährung Euro eingeführt 

haben. 

Sie können mit dieser Funktion folgende Arten von Umrechnungen durchführen: 

a) Einen Betrag von einer dieser Währungen in Euro umrechnen – zum Beispiel 

DM in Euro. 

b) Einen Betrag von Euro in eine dieser Währungen umrechnen – zum Beispiel 

Euro in DM. 

c) Einen Betrag von einer dieser Währungen in eine andere umrechnen – und zwar 

über den Zwischenschritt der Umrechnung in den Euro („Triangulation“). Beispiel: 

Peseten -> Euro -> DM. Beachten Sie: Bei dieser Methode können Rundungsfeh-

ler (von maximal 0,01) auftreten. 

Die Argumente Quellwährung und Zielwährung geben Sie mit Hilfe der Codes in 

der nachfolgenden Tabelle an. Sie können entweder PM-Codes oder ISO-Codes 

verwenden.  

Hinweis: Microsoft Excel unterstützt bei dieser Funktion nur ISO-Codes. Wenn Ihr 

Dokument also Excel-kompatibel sein soll, müssen Sie für die Währungscodes also 

ausschließlich ISO-Codes (rechte Spalte) verwenden. 

Die Groß-/Kleinschreibung der Codes spielt keine Rolle. 
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Land PM-Code ISO-Code 

Alle Euro-Länder (Euro) € EUR 

Belgien (Franc) BF BEF 

Deutschland (Mark) DM DEM 

Estland (Krone) kr EEK 

Finnland (Markka) mk FIM 

Frankreich (Franc) F FRF 

Griechenland (Drachme) Dr GRD 

Irland (Pfund) IR£ IEP 

Italien (Lira) L ITL 

Lettland (Lats) Ls LVL 

Litauen (Litas) Lt LTL 

Luxemburg (Franc) LF LUF 

Malta (Lira) Lm MTL 

Niederlande (Gulden) fl NLG 

Österreich (Schilling) öS ATS 

Portugal (Escudo) esc PTE 

Slowakei (Krone) Sk SKK 

Slowenien (Tolar) SIT SIT 

Spanien (Peseta) pts ESP 

Beispiel: 

EUROCONVERT (100; "DM"; "€") rechnet 100 DM in Euro um, ergibt also 51,13 

(Euro) 

EUROCONVERT (100; "DEM"; "EUR") ist die Excel-kompatible Schreibweise 

des obigen Beispiels. Das Ergebnis ist natürlich das Gleiche: 51,13 (Euro) 

EUROCONVERT (100; "DEM"; "ATS") ergibt 703,55 (öS) 

EXP (e hoch x) 

Syntax: 

EXP(Zahl) 

Beschreibung: 

Führt eine Potenzierung der Konstanten e mit der angegebenen Zahl durch, be-

rechnet also ex. 
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Bei e handelt es sich um die Eulersche Zahl (2,71828...), die Basis des natürlichen 

Logarithmus. 

Anmerkung: 

Die Umkehrfunktion zu dieser Funktion ist LN (natürlicher Logarithmus). 

Beispiel: 

EXP(5) ergibt 148,4132 

EXP(LN(0,1234)) ergibt 0,1234 

Siehe auch: 

LN, POTENZ 

EXPONVERT (Exponentialverteilung) 

Syntax: 

EXPONVERT(x; Lambda; Kumuliert) 

Beschreibung: 

Liefert die Wahrscheinlichkeiten einer exponentialverteilten Zufallsvariablen. 

Mit der Exponentialverteilung können die Zeitintervalle zwischen unabhängigen 

Ereignissen modelliert werden (also beispielsweise Wartezeiten). 

Wenn beispielsweise bekannt ist, dass durchschnittlich alle drei Minuten ein Kunde 

an einem Bankschalter eintrifft, können Sie mit dieser Funktion die Wahrschein-

lichkeit berechnen, dass sich nach spätestens zwei Minuten ein Kunde einfindet. 

x ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. x muss größer 

gleich Null sein. 

Lambda () ist die mittlere Anzahl von Ereignissen pro Zeitintervall. Lambda 

muss größer als Null sein. 
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Mit dem Wahrheitswert Kumuliert bestimmen Sie, welche Funktion geliefert wer-

den soll: 

FALSCH: Es wird die Dichtefunktion geliefert. 

WAHR: Es wird die Verteilungsfunktion (also die integrierte Dichtefunktion) gelie-

fert. 

Siehe auch: 

POISSON 

FAKULTÄT (Fakultät) 

Syntax: 

FAKULTÄT(Zahl) 

Beschreibung: 

Liefert x! (die Fakultät von x). 

Als Fakultät bezeichnet man das Produkt aller positiven ganzen Zahlen von 1 bis 

zur angegebenen Zahl. 

Die übergebene Zahl muss größer gleich Null sein. Nachkommastellen werden 

automatisch abgeschnitten. 

Beispiel: 

FAKULTÄT(9) entspricht 1*2*3*4*5*6*7*8*9, ergibt also 362880 

Siehe auch: 

ZWEIFAKULTÄT 
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FALSCH (Wahrheitswert) 

Syntax: 

FALSCH() 

Beschreibung: 

Liefert den Wahrheitswert FALSCH. 

Siehe auch: 

WAHR 

FEHLER.TYP (Fehlerwerte abfragen) 

Syntax: 

FEHLER.TYP(Zelle) 

Beschreibung: 

Mit dieser Funktion kann abgefragt werden, welche Art von Fehler in einer Zelle 

auftritt. 

Als Argument erwartet die Funktion die Adresse der zu überprüfenden Zelle. 

Die Funktion liefert folgende Ergebnisse: 

Fehlerwert in der Zelle Ergebnis 

Kein Fehler #NV 

#FEHLER! 1 

#DIV/0! 2 

#WERT! 3 

#BEZUG! 4 
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#NAME? 5 

#ZAHL! 6 

#NV 7 

Informationen zu den einzelnen Fehlerwerten finden Sie im Abschnitt 

„Fehlerwerte“ ab Seite 515. 

Beispiel: 

In Zelle A1 steht die Berechnung 1/0, in Zelle A2 wird 1/1 berechnet. Hier gilt: 

FEHLER.TYP(A1) ergibt 2 (also #DIV/0!) 

FEHLER.TYP(A2) ergibt #NV (also kein Fehler) 

Die folgende Formel liefert den Text „Fehler!“ zurück, wenn in Zelle A1 ein belie-

biger Fehler auftritt, ansonsten wird der Wert in A1 zurückgeliefert: 

WENN(ISTNV(FEHLER.TYP(A1)); A1; "Fehler!") 

Siehe auch: 

ISTFEHL, ISTFEHLER, ISTNV, WENNFEHLER, Abschnitt über „Fehlerwerte“ 

ab Seite 515  

FEIERTAG (Datum von beweglichen Feiertagen) 

Syntax: 

FEIERTAG(Jahr; Typ) 

Beschreibung: 

Liefert das Datum von beweglichen christlichen Feiertagen im angegebenen Jahr. 

Jahr ist das gewünschte Jahr (als ganze Zahl). 

Typ ist eine ganze Zahl, die bestimmt, für welchen Feiertag das Datum geliefert 

werden soll: 
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0: Karfreitag 

1: Ostersonntag 

2: Ostermontag 

3: Christi Himmelfahrt 

4: Pfingstsonntag 

5: Pfingstmontag 

6: Fronleichnam 

7: Aschermittwoch  

8: Buß- und Bettag 

9: Erster Adventssonntag 

Kompatibilitätshinweise: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

FEIERTAG(2014; 1) ergibt den 20.4.2014 (Ostersonntag 2014) 

FEIERTAG(JAHR(HEUTE()); 5) liefert das Datum für den Pfingstmontag im ak-

tuellen Jahr 

Siehe auch: 

ARBEITSTAG, NETTOARBEITSTAGE 

FEST (Zahl mit festen Nachkommastellen formatieren) 

Syntax: 

FEST(Zahl [; n] [; Keine_Tausenderpunkte]) 
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Beschreibung: 

Konvertiert eine Zahl in eine Zeichenkette. Diese enthält die auf n Stellen gerunde-

te Zahl mit Tausenderpunkten. 

Zahl ist die umzuwandelnde Zahl. 

Das optionale Argument n bestimmt gewünschte Anzahl an Nachkommastellen. 

Wird es nicht angegeben, wird die Zahl auf 2 Nachkommastellen gerundet. 

n darf auch ein negativer Wert sein, worauf der ganzzahlige Teil der Zahl gerundet 

wird: Ist n beispielsweise -2, wird die Zahl auf ein Vielfaches von Hundert gerun-

det (siehe letztes Beispiel). 

Der optionale Wahrheitswert Keine_Tausenderpunkte bestimmt, ob die Zahl mit 

Tausenderpunkten formatiert werden soll:  

FALSCH oder nicht angegeben: Mit Tausenderpunkten 

WAHR: Ohne Tausenderpunkte 

Hinweis: 

Beachten Sie, dass das Ergebnis dieser Funktion eine Zeichenkette ist. Um eine 

Zahl zu runden, ohne sie in eine Zeichenkette zu wandeln, verwenden Sie eine der 

Rundungsfunktionen (siehe unten). 

Um eine Zahl nur gerundet anzuzeigen, ohne sie tatsächlich zu runden, können Sie 

auch den Menübefehl Format > Zelle verwenden. 

Beispiel: 

FEST(1234,5678; 2) ergibt die Zeichenkette 1.234,57 

FEST(1234,5678; 2; WAHR) ergibt die Zeichenkette 1234,57 (ohne Tausender-

punkte) 

FEST(1234,5678; -2) ergibt die Zeichenkette 1.200 

Siehe auch: 

RUNDEN, ABRUNDEN, AUFRUNDEN, KÜRZEN 
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FINDEN (Text in Zeichenkette suchen) 

Syntax: 

FINDEN(Suchbegriff; Zeichenkette [; Startposition]) 

Beschreibung: 

Ermittelt die Position von Suchbegriff in Zeichenkette. 

Mit dem optionalen Argument Startposition können Sie festlegen, ab welcher Po-

sition der Zeichenkette gesucht werden soll. Wird es nicht angegeben, beginnt die 

Suche mit dem ersten Zeichen. 

Die Groß-/Kleinschreibung muss hierbei exakt übereinstimmen. Verwenden Sie die 

Funktion SUCHEN, wenn die Groß-/Kleinschreibung nicht beachtet werden soll. 

Beispiel: 

FINDEN("a"; "Banane") ergibt 2 

FINDEN("A"; "Banane") ergibt den Fehlerwert #WERT!, da ein großes „A“ in der 

Zeichenkette nicht vorkommt. 

FINDEN("a"; "Banane"; 3) ergibt 4 

Siehe auch: 

SUCHEN, ERSETZEN, WECHSELN 

FINV (Quantile einer F-Verteilung) 

Syntax: 

FINV(Wahrscheinlichkeit; Freiheitsgrade1; Freiheitsgrade2) 

Beschreibung: 

Liefert Quantile einer F-Verteilung.  
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Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der F-Verteilung. 

Zulässig sind nur Werte aus dem Intervall [0..1]. 

Freiheitsgrade1 bestimmt die Zahl der Freiheitsgrade im Zähler. 

Freiheitsgrade2 bestimmt die Zahl der Freiheitsgrade im Nenner. 

Die Freiheitsgrade dürfen nicht kleiner als 1 oder größer als 10^10 sein. Erwartet 

wird jeweils eine ganze Zahl; ist dies nicht der Fall, schneidet PlanMaker die 

Nachkommastellen automatisch ab. 

Hinweis: 

Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. 

Findet PlanMaker nach 100 Iterationen kein Ergebnis, das weniger als 3x10^-7 

von Wahrscheinlichkeit abweicht, zeigt er den Fehlerwert #NV an und bricht die 

Näherung ab. 

Siehe auch: 

FTEST_FTEST_(F-Test), FVERT 

FISHER (Fisher-Transformation) 

Syntax: 

FISHER(Zahl) 

Beschreibung: 

Liefert die Fisher-Transformation für die übergebene Zahl. 

Der zulässige Wertebereich für Zahl ist: -1  Zahl < 1 

Siehe auch: 

FISHERINV, KORREL, KOVAR 
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FISHERINV (Umkehrung der Fisher-Transformation) 

Syntax: 

FISHERINV(Zahl) 

Beschreibung: 

Liefert die umgekehrte Fisher-Transformation für die übergebene Zahl. 

Anmerkung: 

Diese Funktion ist die Umkehrfunktion der Funktion FISHER. 

Siehe auch: 

FISHER  

FORMELTEXT (Formel einer Zelle anzeigen) 

Syntax: 

FORMELTEXT(Zelle) 

Beschreibung: 

Zeigt die Formel an, die sich in der angegebenen Zelle befindet. 

Kompatibilitätshinweise: 

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versio-

nen ist die Funktion unbekannt. 
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Beispiel: 

Wenn die Zelle A1 die Formel =SUMME(D2:D4) enthält, dann liefert 

FORMELTEXT(A1) den Text „=SUMME(D2:D4)“ zurück. 

Siehe auch: 

ISTFORMEL  

FTEST (F-Test) 

Syntax: 

FTEST(Werte1; Werte2) 

Beschreibung: 

Liefert die Teststatistik eines F-Tests.  

Mit einem F-Test kann die Konsistenz der Varianzen zweier Stichproben geprüft 

werden. 

Werte1 und Werte2 sind die zu untersuchenden Wertebereiche (Stichproben). 

Es müssen jeweils mindestens zwei Werte angegeben sein; andernfalls liefert die 

Funktion den Fehlerwert #DIV/0! (Division durch Null). 

Liegt die Varianz von Werte1 oder Werte2 bei 0, liefert diese Funktion den Feh-

lerwert #DIV/0!. 

Siehe auch: 

FINV, FVERT 

FVERT (F-Verteilung) 

Syntax: 

FVERT(X; Freiheitsgrade1; Freiheitsgrade2) 
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Beschreibung: 

Liefert Werte der Verteilungsfunktion einer F-verteilten Zufallsvariablen. 

X ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. X darf keine ne-

gative Zahl sein. 

Freiheitsgrade1 bestimmt die Zahl der Freiheitsgrade im Zähler. 

Freiheitsgrade2 bestimmt die Zahl der Freiheitsgrade im Nenner. 

Die Freiheitsgrade dürfen nicht kleiner als 1 oder größer als 10^10 sein. Erwartet 

wird jeweils eine ganze Zahl; ist dies nicht der Fall, schneidet PlanMaker die 

Nachkommastellen automatisch ab. 

Siehe auch: 

FINV, FTEST_FTEST_(F-Test)  

GAMMA (Gammafunktion) 

Syntax: 

GAMMA(Zahl) 

Beschreibung: 

Liefert die Gammafunktion für die übergebene Zahl.  

Zahl muss größer als Null sein. 

Kompatibilitätshinweise: 

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versio-

nen ist die Funktion unbekannt. 

Siehe auch: 

GAMMALN 
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GAMMAINV (Quantile einer Gammaverteilung) 

Syntax: 

GAMMAINV(Wahrscheinlichkeit; Alpha; Beta) 

Beschreibung: 

Liefert Quantile einer Gammaverteilung.  

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der Gammavertei-

lung. Zulässig sind nur Werte aus dem Intervall [0..1]. 

Alpha und Beta sind die Formparameter der Funktion. Beide müssen größer als 

Null sein. 

Hinweis: 

Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. 

Findet PlanMaker nach 100 Iterationen kein Ergebnis, das weniger als 3x10^-7 

von Wahrscheinlichkeit abweicht, zeigt er den Fehlerwert #NV an und bricht die 

Näherung ab. 

Siehe auch: 

GAMMAVERT 

GAMMALN (Logarithmus der Gammafunktion) 

Syntax: 

GAMMALN(Zahl) 

Beschreibung: 

Liefert den natürlichen Logarithmus der Gammafunktion.  

Zahl muss größer als Null sein. 
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Siehe auch: 

GAMMA  

GAMMAVERT (Gammaverteilung) 

Syntax: 

GAMMAVERT(X; Alpha; Beta; Kumuliert) 

Beschreibung: 

Liefert die Wahrscheinlichkeiten einer gammaverteilten Zufallsvariablen. 

X ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. X muss größer 

gleich Null sein. 

Alpha und Beta sind die Formparameter der Funktion. Beide müssen größer als 

Null sein.  

Mit dem Wahrheitswert Kumuliert bestimmen Sie, welche Funktion geliefert wer-

den soll: 

FALSCH: Es wird die Dichtefunktion geliefert. 

WAHR: Es wird die Verteilungsfunktion (also die integrierte Dichtefunktion) gelie-

fert. 

Siehe auch: 

GAMMAINV 

GANZZAHL (Runden auf ganze Zahl) 

Syntax: 

GANZZAHL(Zahl) 



 

Handbuch PlanMaker Formeln und Funktionen  •  601 

Beschreibung: 

Rundet eine Zahl betragsmäßig auf die nächstkleinere ganze Zahl ab. 

Hinweis: 

Beachten Sie beim Anwenden dieser Funktion auf negative Zahlen den Unter-

schied zu anderen Rundungsfunktionen wie zum Beispiel ABRUNDEN: 

ABRUNDEN(-1,234; 0) ergibt -1, da hier der Betrag von Zahl auf die nächstklei-

nere ganze Zahl abgerundet wird 

GANZZAHL(-1,234) ergibt -2, da hier die negative Zahl selbst auf die nächstklei-

nere ganze Zahl abgerundet wird. 

Beispiel: 

GANZZAHL(5,9) ergibt 5 

GANZZAHL(-5,1) ergibt -6 

Siehe auch: 

KÜRZEN, ABRUNDEN, AUFRUNDEN, RUNDEN 

GAUSS (Standardnormalverteilung) 

Syntax: 

GAUSS(x) 

Beschreibung: 

Liefert das Integral der Funktion PHI (Dichtefunktion einer Standardnormalvertei-

lung) abzüglich 0,5. 

Kompatibilitätshinweise: 

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versio-

nen ist die Funktion unbekannt. 
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Wir empfehlen Ihnen daher, stattdessen die Funktion STANDNORMVERT zu 

verwenden, da diese von allen Excel-Versionen unterstützt wird: 

GAUSS(x) entspricht STANDNORMVERT(x) - 0,5 

Siehe auch: 

PHI, NORMVERT, STANDNORMVERT 

GAUSSFEHLER (Gaußsche Fehlerfunktion) 

Syntax: 

GAUSSFEHLER(Untergrenze [; Obergrenze]) 

Beschreibung: 

Liefert die Gaußsche Fehlerfunktion. 

Untergrenze und Obergrenze (optional) bestimmen die Grenzen des Intervalls, 

dessen Integralfläche berechnet werden soll. Wird Obergrenze nicht angegeben, 

wird die Integralfläche von 0 bis Untergrenze berechnet. 

Siehe auch: 

GAUSSFKOMPL 

GAUSSFKOMPL (Komplement zur Gaußschen Fehlerfunktion) 

Syntax: 

GAUSSFKOMPL(Untergrenze) 

Beschreibung: 

Liefert das Komplement zur Gaußschen Fehlerfunktion. 
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Für Untergrenze ist die untere Grenze des Integrals anzugeben. Es sind nur Werte 

größer gleich Null zulässig. 

Siehe auch: 

GAUSSFEHLER 

GDA (Geometrisch-degressive Abschreibung) 

Syntax: 

GDA(AW; RW; ND; P [; Faktor]) 

Beschreibung: 

Berechnet den Abschreibungsbetrag eines Objekts für eine bestimmte Periode nach 

der Methode der geometrisch-degressiven Doppelraten-Abschreibung. 

AW = Anschaffungswert des Objekts 

RW = Restwert des Objekts am Ende der Nutzungsdauer 

ND = Nutzungsdauer (Anzahl der Perioden, über die das Objekt abgeschrieben 

wird) 

P = Periode, deren Abschreibungsbetrag berechnet werden soll (in der gleichen 

Einheit wie ND anzugeben) 

Faktor (optional) = Rate, um die der jeweilige Buchwert verringert wird. Fehlt 

dieses Argument, wird Faktor auf 2 gesetzt (Doppelraten-Abschreibung). 

Beispiel: 

Bei einer für € 200.000,- erworbenen Maschine, die 10 Jahre genutzt wird und 

dann einen Restwert von € 10.000,- hat, muss für das erste Jahr folgender jahresbe-

zogener Abschreibungsbetrag angesetzt werden: 

GDA(200000; 10000; 10; 1) ergibt 40000,- Euro 
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Siehe auch: 

GDA2, DIA, LIA 

GDA2 (Geometrisch-degressive Abschreibung) 

Syntax: 

GDA2(AW; RW; ND; P [; M]) 

Beschreibung: 

Berechnet den Abschreibungsbetrag eines Objekts für eine bestimmte Periode nach 

der Methode der geometrisch-degressiven Abschreibung.  

AW = Anschaffungswert des Objekts 

RW = Restwert des Objekts am Ende der Nutzungsdauer 

ND = Nutzungsdauer (Anzahl der Perioden, über die das Objekt abgeschrieben 

wird) 

P = Periode, deren Abschreibungsbetrag berechnet werden soll (in der gleichen 

Einheit wie ND anzugeben) 

M = Zahl der Monate im ersten Jahr (optional). Wird diese nicht angegeben, wird 

M auf 12 gesetzt. 

Beispiel: 

GDA2(200000; 10000; 6; 1; 7) ergibt 45850,00 

Siehe auch: 

GDA, DIA, LIA 
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GEOMITTEL (Geometrisches Mittel) 

Syntax: 

GEOMITTEL(Zahl1 [; Zahl2; Zahl3...]) 

Beschreibung: 

Liefert das einfache geometrische Mittel der übergebenen Zahlen. 

Dieses wird durch Ziehen der n-ten Wurzel aus dem Produkt der Einzelwerte er-

mittelt (n ist die Anzahl der Werte). 

Alle übergebenen Werte müssen größer als Null sein. 

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder 

Wahrheitswerte enthalten, so werden diese ignoriert. 

Beispiel: 

GEOMITTEL(1; 2; 6) ergibt 2,28943 

Siehe auch: 

HARMITTEL, MITTELWERT 

GERADE (Aufrunden auf eine gerade Zahl) 

Syntax: 

GERADE(Zahl) 

Beschreibung: 

Rundet Zahl auf die betragsmäßig nächstgrößere gerade Zahl auf. 
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Beispiel: 

GERADE(42) ergibt 42 

GERADE(43) ergibt 44 

GERADE(-43) ergibt -44 

Siehe auch: 

UNGERADE, VRUNDEN, RUNDEN, ISTGERADE 

GESTUTZTMITTEL (Mittelwert ohne Randwerte) 

Syntax: 

GESTUTZTMITTEL(Datenbereich; Prozentwert) 

Beschreibung: 

Liefert den Mittelwert einer Datenmenge, blendet dabei jedoch den angegebenen 

Prozentsatz an Randwerten aus. 

Unter „Randwerten“ sind die kleinsten und größten Werte einer Datenmenge zu 

verstehen. Dies sind häufig „Ausreißer“ (untypisch niedrige oder hohe Werte, die 

zum Beispiel aufgrund eines Messfehlers entstanden sind).  

Datenbereich ist ein Zellbezug auf die zu untersuchende Datenmenge. 

Mit Prozentwert geben Sie an, wie viel Prozent der Randwerte nicht berücksich-

tigt werden sollen. 

Wenn beispielsweise 100 Werte vorliegen und Prozentwert auf 10% gesetzt wur-

de, werden 10 Werte ignoriert: die 5 niedrigsten und die 5 höchsten. 

Die Zahl der nicht zu berücksichtigen Werte wird stets auf ein Vielfaches von 2 

abgerundet, damit gleich viele niedrige und hohe Werte ausgeblendet werden. Bei 

einer Datenmenge mit 30 Werten würden bei Prozentwert = 10 also nicht 3, son-

dern 2 Werte ignoriert. 
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Beispiel: 

In den Zellen A1 bis A10 befinden sich die folgenden 10 Werte: 43, 45, 42, 0, 44, 

45, 42, 1234, 40, 41 

Wie Sie sehen, befinden sich zwei Ausreißer unter diesen Werten: 0 und 1234. Mit 

der Funktion MITTELWERT würden Sie deshalb einen unbrauchbaren Mittelwert 

erhalten: 

MITTELWERT(A1:A10) ergibt 159,2 

Verwenden Sie hingegen GESTUTZTMITTEL und blenden beispielsweise 20% 

der Werte an den Rändern aus – in diesem Fall sind das günstigerweise genau die 

beiden Ausreißer unter den 10 Werten –, wird ein brauchbarer Mittelwert geliefert: 

GESTUTZTMITTEL(A1:A10; 20%) ergibt: 42,75 

Siehe auch: 

MITTELWERT, GEOMITTEL, HARMITTEL 

GGANZZAHL (Zahl größer gleich Schwellenwert?) 

Syntax: 

GGANZZAHL(Zahl; Schwelle) 

Beschreibung: 

Diese Funktion liefert 1, wenn Zahl  Schwelle ist, ansonsten liefert sie 0. 

Beispiel: 

GGANZZAHL(41; 42) ergibt 0 

GGANZZAHL(42; 42) ergibt 1 

GGANZZAHL(42,1; 42) ergibt 1 
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Siehe auch: 

DELTA 

GGT (Größter gemeinsamer Teiler) 

Syntax: 

GGT(Zahl1 [; Zahl2; Zahl3 ...]) 

Beschreibung: 

Ermittelt den ggT („größter gemeinsamer Teiler“) einer Menge von Zahlen. Der 

ggT ist die größte all derjenigen ganzen Zahlen, durch die alle Argumente ohne 

Rest teilbar sind. 

Als Argumente können Zahlen oder Zellbezüge übergeben werden. 

Alle übergebenen Zahlen müssen größer als Null sein. Weiterhin sollten nur ganze 

Zahlen verwendet werden. Ist dies nicht der Fall, schneidet PlanMaker die Nach-

kommastellen automatisch ab. 

Beispiel: 

GGT(25; 100; 250) ergibt 25 

GGT(25; 105; 250) ergibt 5 

Sind die Zellen A1 bis A3 mit den Werten 4, 8 und 6 gefüllt, so gilt: 

GGT(A1:A3) ergibt 2 

Siehe auch: 

KGV 
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GLÄTTEN (Überflüssige Leerzeichen entfernen) 

Syntax: 

GLÄTTEN(Zeichenkette) 

Beschreibung: 

Entfernt alle Leerzeichen am Beginn und am Ende einer Zeichenkette. 

Beispiel: 

GLÄTTEN("    Text  ") ergibt Text 

Siehe auch: 

SÄUBERN 

GRAD (Bogenmaß in Grad umwandeln) 

Syntax: 

GRAD(Zahl) 

Beschreibung: 

Wandelt eine Winkelangabe, die im Bogenmaß (Radiant) gegeben ist, in Grad um. 

Die Formel für die Umrechnung lautet:  

GRAD(x) = x * 180 / PI() 

Beispiel: 

GRAD(PI()) ergibt 180 
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Siehe auch: 

BOGENMASS 

GROSS (In Großbuchstaben wandeln) 

Syntax: 

GROSS(Zeichenkette) 

Beschreibung: 

Wandelt alle Buchstaben einer Zeichenkette in Großbuchstaben um. 

Beispiel: 

GROSS("PlanMaker") ergibt PLANMAKER 

Siehe auch: 

GROSS2, KLEIN 

GROSS2 (In Groß-/Kleinbuchstaben wandeln) 

Syntax: 

GROSS2(Zeichenkette) 

Beschreibung: 

Wandelt eine Zeichenkette wie folgt um: Buchstaben am Wortanfang werden groß, 

alle anderen Buchstaben klein geschrieben. 

Beispiel: 

GROSS2("guten tag") ergibt Guten Tag 



 

Handbuch PlanMaker Formeln und Funktionen  •  611 

GROSS2("Guten Tag") ergibt Guten Tag 

GROSS2("GuTeN TaG") ergibt Guten Tag 

Siehe auch: 

GROSS, KLEIN 

GTEST (Gauß-Test) 

Syntax: 

GTEST(Datenbereich; x [; Sigma]) 

Beschreibung: 

Liefert die einseitige Prüfstatistik für einen Gauß-Test. 

Sie können mit dieser Funktion prüfen, mit welcher Wahrscheinlichkeit eine Stich-

probe aus einer bestimmten Grundgesamtheit stammt. 

Datenbereich ist ein Zellbezug auf den Datenbereich, gegen den x getestet werden 

soll. Es sollten mindestens 30 Werte vorliegen. 

x ist der zu testende Wert. 

Das optionale Argument Sigma ist die Standardabweichung  der Grundgesamt-

heit (sofern bekannt). Falls diese nicht angegeben wird, verwendet PlanMaker au-

tomatisch die Standardabweichung der gegebenen Stichprobe (also der Werte in 

Datenbereich). 

Siehe auch: 

STANDARDISIERUNG, NORMVERT, STANDNORMVERT 
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HARMITTEL (Harmonisches Mittel) 

Syntax: 

HARMITTEL(Zahl1 [; Zahl2; Zahl3 ...]) 

Beschreibung: 

Liefert das harmonische Mittel der übergebenen Zahlen.  

Dieses ist definiert als der Kehrwert des arithmetischen Mittels der Kehrwerte der 

Einzelwerte. 

Alle übergebenen Werte müssen größer Null sein. 

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder 

Wahrheitswerte enthalten, so werden diese ignoriert. 

Beispiel: 

HARMITTEL(1; 2; 6) ergibt 1,8 

Siehe auch: 

GEOMITTEL, MITTELWERT 

HÄUFIGKEIT (Häufigkeitsverteilung) 

Syntax: 

HÄUFIGKEIT(Daten; Grenzen) 

Beschreibung: 

Liefert eine Häufigkeitsverteilung. Sie können damit ermitteln, wie viele Werte aus 

einer Datenmenge sich innerhalb bestimmter Intervalle befinden. 

Das Ergebnis wird in Form einer einspaltigen Matrix geliefert. 
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Bei Daten sind die auszuwertenden Daten einzutragen. Leere Zellen und Zeichen-

ketten werden ignoriert. 

Mit Klassen definieren Sie die zu betrachtenden Intervalle. Geben Sie als Klassen 

beispielsweise die Matrix {10; 15; 42} ein, liefert die Funktion eine Matrix mit 

folgenden vier Werten: 

1. Die Anzahl der Werte, die <=10 sind. 

2. Die Anzahl der Werte, die >10 und <=15 sind. 

3. Die Anzahl der Werte, die >15 und <=42 sind. 

4. Die Anzahl der Werte, die >42 sind. 

Daten und Klassen müssen jeweils eine einspaltige Matrix sein; sie dürfen also 

nicht mehr als eine Spalte an Daten enthalten. 

Hinweis: 

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu fin-

den Sie im Abschnitt „Arbeiten mit Matrizen“ ab Seite 516. 

Beachten Sie dabei, dass die von dieser Funktion gelieferte Matrix ein Element 

mehr hat als die Matrix Klassen.  

Siehe auch: 

ANZAHL 

HEUTE (Aktuelles Datum) 

Syntax: 

HEUTE() 

Beschreibung: 

Liefert das aktuelle Systemdatum (ohne Uhrzeit). 
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Das Ergebnis ist – wie alle Datumsangaben in einer Tabellenkalkulation – eine 

Zahl. PlanMaker weist ihr automatisch das Zahlenformat „Datum/Zeit“ zu, damit 

sie als Datum dargestellt wird. 

Beispiel: 

HEUTE() ergibt 16.07.2018 

Siehe auch: 

JETZT 

HEXINBIN (Hexadezimalzahl in Binärzahl wandeln) 

Syntax: 

HEXINBIN(Zahl [; Stellen]) 

Beschreibung: 

Wandelt eine Hexadezimalzahl (Basis 16) in eine Binärzahl (Basis 2) um. 

Zahl ist die umzuwandelnde Zahl. 

Negative Zahlen müssen im 32 Bit-Zweier-Komplement notiert sein (siehe letztes 

Beispiel).  

Der zulässige Wertebereich für Zahl ist (in hexadezimaler Schreibweise): 

80000000  Zahl  7FFFFFFF 

Das entspricht in Dezimalschreibweise: 

-2.147.483.648  Zahl  2.147.483.647 

Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen 

angezeigt werden sollen. Wird es nicht angegeben, ermittelt PlanMaker die benö-

tigte Stellenzahl automatisch. 

Stellen muss größer Null sein. Weiterhin sollte Stellen eine ganze Zahl sein. Ist 

dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab. 
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Wenn Stellen kleiner als die für die Darstellung der Zahl benötigte Mindestanzahl 

an Stellen ist, liefert die Funktion den Fehlerwert #ZAHL!. 

Wenn Zahl negativ ist, wird das Ergebnis im 32 Bit-Zweier-Komplement darge-

stellt; das Argument Stellen wird in diesem Fall ignoriert. 

Beispiel: 

HEXINBIN("2A") ergibt 101010 

HEXINBIN("2A"; 8) ergibt 00101010 

HEXINBIN("2A"; 2) ergibt den Fehlerwert #ZAHL!, da diese Zahl nur mit min-

destens 5 Stellen dargestellt werden kann 

HEXINBIN("FFFFFFD6") ergibt 11111111111111111111111111010110 (negative 

Zahl) 

Siehe auch: 

BININHEX, HEXINDEZ, HEXINOKT 

HEXINDEZ (Hexadezimalzahl in Dezimalzahl wandeln) 

Syntax: 

HEXINDEZ(Zahl) 

Beschreibung: 

Wandelt eine Hexadezimalzahl (Basis 16) in eine Dezimalzahl (Basis 10) um. 

Zahl ist die umzuwandelnde Zahl. 

Negative Zahlen müssen im 32 Bit-Zweier-Komplement notiert sein (siehe letztes 

Beispiel).  

Der zulässige Wertebereich für Zahl ist (in hexadezimaler Schreibweise): 

80000000  Zahl  7FFFFFFF 

Das entspricht in Dezimalschreibweise: 
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-2.147.483.648  Zahl  2.147.483.647 

Beispiel: 

HEXINDEZ("2A") ergibt 42 

HEXINDEZ("FFFFFFD6") ergibt -42 

Siehe auch: 

DEZINHEX, HEXINBIN, HEXINOKT, DEZIMAL  

HEXINOKT (Hexadezimalzahl in Oktalzahl wandeln) 

Syntax: 

HEXINOKT(Zahl [; Stellen]) 

Beschreibung: 

Wandelt eine Hexadezimalzahl (Basis 16) in eine Oktalzahl (Basis 8) um. 

Zahl ist die umzuwandelnde Zahl. 

Negative Zahlen müssen im 32 Bit-Zweier-Komplement notiert sein (siehe letztes 

Beispiel).  

Der zulässige Wertebereich für Zahl ist (in hexadezimaler Schreibweise): 

80000000  Zahl  7FFFFFFF 

Das entspricht in Dezimalschreibweise: 

-2.147.483.648  Zahl  2.147.483.647 

Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen 

angezeigt werden sollen. Wird es nicht angegeben, ermittelt PlanMaker die benö-

tigte Stellenzahl automatisch. 

Stellen muss größer Null sein. Weiterhin sollte Stellen eine ganze Zahl sein. Ist 

dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab. 
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Wenn Stellen kleiner als die für die Darstellung der Zahl benötigte Mindestanzahl 

an Stellen ist, liefert die Funktion den Fehlerwert #ZAHL!. 

Wenn Zahl negativ ist, wird das Ergebnis im 32 Bit-Zweier-Komplement darge-

stellt; das Argument Stellen wird in diesem Fall ignoriert. 

Beispiel: 

HEXINOKT("2A") ergibt 52 

HEXINOKT("2A"; 4) ergibt 0052 

HEXINOKT("2A"; 1) ergibt den Fehlerwert #ZAHL!, da diese Zahl nur mit min-

destens 2 Stellen dargestellt werden kann 

HEXINOKT("FFFFFFD6") ergibt 37777777726 (negative Zahl) 

Siehe auch: 

OKTINHEX, HEXINBIN, HEXINDEZ 

HYPERLINK (Hyperlink) 

Syntax: 

HYPERLINK(Zieladresse [; Beschriftung]) 

Beschreibung: 

Zeigt in der Zelle einen Hyperlink (eine Verknüpfung) auf die angegebene 

Zieladresse an. Als Beschriftung wird die Zieladresse oder wahlweise der mit dem 

Parameter Beschriftung übergebene Text angezeigt. 

Sie können mit dieser Funktion beispielsweise einen Hyperlink auf eine Webseite 

einfügen. Klickt der Anwender diesen an, wird automatisch sein Internet-Browser 

gestartet und diese Seite darin aufgerufen.  

Weiterhin lassen sich unter anderem Links auf ein anderes PlanMaker-Dokument 

einfügen, das beim Anklicken dieses Links automatisch geöffnet wird. Siehe Bei-

spiele. 
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Zieladresse ist die Adresse, auf die der Link zeigen soll. Zulässig hierfür ist eine 

feste Zeichenkette, eine Berechnung oder ein Bezug auf die Zelle, in der sich die 

gewünschte Zieladresse befindet. Siehe Beispiele. 

Beschriftung (optional) ist der Text, der in der Zelle erscheinen soll. Wenn dieser 

nicht angegeben wird, erscheint stattdessen die Zieladresse als Text in der Zelle. 

Beispiel: 

=HYPERLINK("http://www.softmaker.de") 

Obiger Hyperlink öffnet die Adresse www.softmaker.de im Browser. 

=HYPERLINK("http://www.softmaker.de"; "Unsere Homepage") 

Dito, allerdings wird als Linktext nicht die Zieladresse, sondern der Text „Unsere 

Homepage“ angezeigt. 

=HYPERLINK("http://www.softmaker.de#Sprungziel") 

Öffnet die Adresse www.softmaker.de im Browser und springt zu der Sprungmarke 

(dem Anker) namens „Sprungziel“ auf der Seite. Alternativ können Sie hierfür 

auch die Schreibweise =HYPERLINK("[http://www.softmaker.de]Sprungziel") 

verwenden. 

=HYPERLINK("c:\Mein Ordner\Dateiname.pmdx") 

Obiger Link öffnet die Datei c:\Mein Ordner\Dateiname.pmdx in PlanMaker. 

Hinweis: Sie können mit dieser Funktion nicht nur PlanMaker-Dateien öffnen, 

sondern auch beliebige andere Arten von Dokumenten, sofern diesen ein Pro-

gramm zugewiesen ist, mit dem sie geöffnet werden sollen. 

=HYPERLINK("[c:\Mein Ordner\Dateiname.pmdx]Tabelle1!A5") 

Obiger Link öffnet die Datei c:\Mein Ordner\Dateiname.pmdx in PlanMaker und 

springt zu der Zelle A5 auf dem Arbeitsblatt „Tabelle1“. Wichtig: Der komplette 

Dateiname muss dabei mit eckigen Klammern umgeben werden. Direkt dahinter ist 

der Name des Arbeitsblatts, ein Ausrufezeichen und die Zielzelle anzugeben. 

=HYPERLINK("[c:\Mein Ordner\Dateiname.pmdx]Tabelle1!MeinBereich") 

Obiger Link öffnet die Datei c:\Mein Ordner\Dateiname.pmdx in PlanMaker und 

springt zur linken oberen Ecke des benannten Bereichs „MeinBereich“ auf dem 

Arbeitsblatt „Tabelle1“. 

=HYPERLINK(E1; E2) 
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Obiger Link öffnet die Zieladresse, die in der Zelle E1 eingetragen ist. Als Linktext 

wird der Inhalt der Zelle E2 angezeigt. 

Siehe auch: 

Der Abschnitt „Hyperlinks verwenden“ (ab Seite 385) beschreibt eine alternative 

Methode zum Anbringen von Hyperlinks. Die HYPERLINK-Funktion ist aller-

dings flexibler in der Anwendung. 

HYPGEOMVERT (Hypergeometrische Verteilung) 

Syntax: 

HYPGEOMVERT(k; n; K; N) 

Beschreibung: 

Liefert die Wahrscheinlichkeiten einer hypergeometrisch verteilten Zufallsvariab-

len. 

Die hypergeometrische Verteilung ist die Wahrscheinlichkeitsverteilung für bei-

spielsweise das Ziehen von k roten Kugeln in einem Zufallsexperiment nach dem 

Modell der zufälligen Entnahme von n Kugeln (ohne Zurücklegen) aus einer Urne, 

die zu Beginn N Kugeln enthält, davon K rote. 

k ist die Zahl der Treffer (Treffer = Ziehen einer roten Kugel). 

n ist der Umfang der Stichprobe (Zahl der Kugeln, die gezogen werden sollen). 

K ist die Zahl der möglichen Treffer innerhalb der Grundgesamtheit (Zahl der an-

fänglich vorhandenen roten Kugeln). 

N ist der Umfang der Grundgesamtheit (Zahl der anfänglich vorhandenen Kugeln 

insgesamt). 

Alle Argumente sollten ganze Zahlen sein. Ist das nicht der Fall, kürzt PlanMaker 

die Nachkommastellen automatisch weg. 
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Beispiel: 

Eine Urne enthält insgesamt 10 Kugeln (N=10), davon 2 rote (K=2). Wie groß ist 

die Wahrscheinlichkeit, beim Ziehen von 5 Kugeln (n=5) genau 1 rote Kugel zu 

erhalten (k=1)? 

HYPGEOMVERT(1; 5; 2; 10) ergibt 0,55556 

Siehe auch: 

NEGBINOMVERT 

IDENTISCH (Zeichenketten identisch?) 

Syntax: 

IDENTISCH(Zeichenkette1; Zeichenkette2) 

Beschreibung: 

Liefert WAHR, wenn Zeichenkette1 mit Zeichenkette2 übereinstimmt. 

Auch die Groß-/Kleinschreibung muss exakt übereinstimmen.  

Beispiel: 

IDENTISCH("aaa"; "aaa") ergibt WAHR 

IDENTISCH("aaa"; "Aaa") ergibt FALSCH 

IDENTISCH(GROSS("aaa"); GROSS("Aaa")) ergibt WAHR 

Siehe auch: 

FINDEN, SUCHEN 
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IKV (Interner Zinsfuß) 

Syntax: 

IKV(Werte [; Schätzwert]) 

Beschreibung: 

Liefert einen Schätzwert für den internen Zinsfuß einer Investition. Im Gegensatz 

zur Funktion QIKV werden dabei keine Finanzierungskosten oder Reinvestitions-

gewinne berücksichtigt.  

Als Basis dienen die im Bereich Werte angegebenen Auszahlungen (negative Wer-

te) und Einzahlungen (positive Werte). Die Zahlungen dürfen unterschiedlich groß 

sein, müssen jedoch in gleichmäßigen Zeitintervallen (z.B. monatlich oder jährlich) 

auftreten. 

Die Funktion erwartet folgende Argumente: 

Für Werte gibt man einen Zellbezug an, in dem die Zahlungen eingetragen wur-

den. Es muss mindestens eine Auszahlung und eine Einzahlung vorliegen. 

Für Schätzwert können Sie (optional) einen Schätzwert für das Ergebnis der Be-

rechnung angeben (siehe Hinweis). 

Hinweis: 

Die Berechnung erfolgt mit Hilfe eines Näherungsverfahrens (Iterationsverfahren). 

Falls die Funktion nach 20 Näherungsschritten noch kein Ergebnis mit einer Ge-

nauigkeit von 0,00001% oder besser findet, bricht sie die Näherung ab und liefert 

als Ergebnis den Fehlerwert #ZAHL!. Versuchen Sie in diesem Fall einen anderen 

Wert für Schätzwert anzugeben. 

Siehe auch: 

QIKV, XINTZINSFUSS, ZINS 
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IMABS (Absolutbetrag einer komplexen Zahl) 

Syntax: 

IMABS(KomplexeZahl) 

Beschreibung: 

Liefert den Absolutbetrag (Modul) einer komplexen Zahl. 

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Beispiel: 

IMABS("2+4i") ergibt 4,47214 

Siehe auch: 

KOMPLEXE, IMARGUMENT, IMEXP, IMKONJUGIERTE 

IMAGINÄRTEIL (Imaginärteil einer komplexen Zahl) 

Syntax: 

IMAGINÄRTEIL(KomplexeZahl) 

Beschreibung: 

Liefert den Imaginärteil einer komplexen Zahl. 

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Beispiel: 

IMAGINÄRTEIL("2+4i") ergibt 4 
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Siehe auch: 

KOMPLEXE, IMREALTEIL 

IMAPOTENZ (Potenz einer komplexen Zahl) 

Syntax: 

IMAPOTENZ(KomplexeZahl; Exponent) 

Beschreibung: 

Potenziert die komplexe Zahl KomplexeZahl mit dem Exponenten Exponent. 

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Beispiel: 

IMAPOTENZ("2+4i"; 2) ergibt -12+16i 

Siehe auch: 

KOMPLEXE, IMWURZEL 

IMARGUMENT (Winkel einer komplexen Zahl) 

Syntax: 

IMARGUMENT(KomplexeZahl) 

Beschreibung: 

Liefert den Winkel (Bogenmaß) zur Darstellung der komplexen Zahl in trigono-

metrischer Schreibweise. 

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 
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Beispiel: 

IMARGUMENT("2+4i") ergibt 1,10715 

Siehe auch: 

KOMPLEXE, IMABS, IMEXP, IMKONJUGIERTE 

IMCOS (Cosinus einer komplexen Zahl) 

Syntax: 

IMCOS(KomplexeZahl) 

Beschreibung: 

Liefert den Cosinus einer komplexen Zahl. 

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Beispiel: 

IMCOS("2+4i") ergibt -11,3642347064011 - 24,8146514856342i 

Siehe auch: 

KOMPLEXE, IMSIN 

IMDIV (Division komplexer Zahlen) 

Syntax: 

IMDIV(KomplexeZahl1; KomplexeZahl2) 
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Beschreibung: 

Liefert das Ergebnis der Division der komplexen Zahl KomplexeZahl1 durch die 

komplexe Zahl KomplexeZahl2. 

Die Argumente müssen komplexe Zahlen im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Beispiel: 

IMDIV("4+12i"; "2+4i") ergibt 2,8+0,4i 

Siehe auch: 

KOMPLEXE, IMPRODUKT, IMSUB, IMSUMME 

IMEXP (Algebraische Form einer komplexen Zahl) 

Syntax: 

IMEXP(KomplexeZahl) 

Beschreibung: 

Liefert die algebraische Form einer in exponentieller Schreibweise vorliegenden 

komplexen Zahl. 

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Beispiel: 

IMEXP("2+4i") ergibt -4,82980938326939 - 5,59205609364098i 

Siehe auch: 

KOMPLEXE, IMABS, IMARGUMENT, IMKONJUGIERTE 
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IMKONJUGIERTE (Konjugiert komplexe Zahl) 

Syntax: 

IMKONJUGIERTE(KomplexeZahl) 

Beschreibung: 

Liefert die konjugiert komplexe Zahl zu einer komplexen Zahl. 

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Beispiel: 

IMKONJUGIERTE("2+4i") ergibt 2-4i 

Siehe auch: 

KOMPLEXE, IMABS, IMARGUMENT, IMEXP 

IMLN (Natürlicher Logarithmus einer komplexen Zahl) 

Syntax: 

IMLN(KomplexeZahl) 

Beschreibung: 

Liefert den Logarithmus einer komplexen Zahl zur Basis e (natürlicher Logarith-

mus). 

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Beispiel: 

IMLN("2+4i") ergibt 1,497866136777 + 1,10714871779409i 
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Siehe auch: 

KOMPLEXE, IMLOG10, IMLOG2 

IMLOG10 (Zehnerlogarithmus einer komplexen Zahl) 

Syntax: 

IMLOG10(KomplexeZahl) 

Beschreibung: 

Liefert den Logarithmus einer komplexen Zahl zur Basis 10 (Zehnerlogarithmus 

oder dekadischer Logarithmus). 

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Beispiel: 

IMLOG10("2+4i") ergibt 0,650514997831991 + 0,480828578784234i 

Siehe auch: 

KOMPLEXE, IMLN, IMLOG2 

IMLOG2 (Zweierlogarithmus einer komplexen Zahl) 

Syntax: 

IMLOG2(KomplexeZahl) 

Beschreibung: 

Liefert den Logarithmus einer komplexen Zahl zur Basis 2 (Zweierlogarithmus). 

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 
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Beispiel: 

IMLOG2("2+4i") ergibt 2,16096404744368 + 1,59727796468811i 

Siehe auch: 

KOMPLEXE, IMLN, IMLOG10 

IMNEG (Negativer Wert einer komplexen Zahl) 

Syntax: 

IMNEG(KomplexeZahl) 

Beschreibung: 

Liefert den negativen Wert einer komplexen Zahl. 

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Kompatibilitätshinweise: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Tipp: Alternativ zu z.B. IMNEG(A1) können Sie auch die folgende Formel ver-

wenden: 

KOMPLEXE(-IMREALTEIL(A1); -IMAGINÄRTEIL(A1)) 

Beispiel: 

IMNEG("2+4i") ergibt -2-4i 

Siehe auch: 

KOMPLEXE 
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IMPRODUKT (Produkt komplexer Zahlen) 

Syntax: 

IMPRODUKT(KomplexeZahl1 [; KomplexeZahl2; KomplexeZahl3 ...]) 

Beschreibung: 

Liefert das Produkt der übergebenen komplexen Zahlen. 

Die Argumente müssen komplexe Zahlen im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Beispiel: 

IMPRODUKT("2+4i"; "1+2i") ergibt -6+8i 

Siehe auch: 

KOMPLEXE, IMDIV, IMSUB, IMSUMME 

IMREALTEIL (Realteil einer komplexen Zahl) 

Syntax: 

IMREALTEIL(KomplexeZahl) 

Beschreibung: 

Liefert den Realteil einer komplexen Zahl. 

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Beispiel: 

IMREALTEIL("2+4i") ergibt 2 
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Siehe auch: 

KOMPLEXE, IMAGINÄRTEIL 

IMSIN (Sinus einer komplexen Zahl) 

Syntax: 

IMSIN(KomplexeZahl) 

Beschreibung: 

Liefert den Sinus einer komplexen Zahl. 

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Beispiel: 

IMSIN("2+4i") ergibt 24,8313058489464 - 11,3566127112182i 

Siehe auch: 

KOMPLEXE, IMCOS 

IMSUB (Differenz komplexer Zahlen) 

Syntax: 

IMSUB(KomplexeZahl1; KomplexeZahl2) 

Beschreibung: 

Liefert die Differenz zweier komplexer Zahlen, subtrahiert also KomplexeZahl2 

von KomplexeZahl1. 

Die Argumente müssen komplexe Zahlen im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 
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Beispiel: 

IMSUB("2+4i"; "1+2i") ergibt 1+2i 

Siehe auch: 

KOMPLEXE, IMDIV, IMPRODUKT, IMSUMME 

IMSUMME (Summe komplexer Zahlen) 

Syntax: 

IMSUMME(KomplexeZahl1 [; KomplexeZahl2; KomplexeZahl3 ...]) 

Beschreibung: 

Liefert die Summe der übergebenen komplexen Zahlen. 

Die Argumente müssen komplexe Zahlen im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Beispiel: 

IMSUMME("2+4i"; "1+2i") ergibt 3+6i 

Siehe auch: 

KOMPLEXE, IMDIV, IMPRODUKT, IMSUB 

IMWURZEL (Quadratwurzel einer komplexen Zahl) 

Syntax: 

IMWURZEL(KomplexeZahl) 
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Beschreibung: 

Liefert die Quadratwurzel einer komplexen Zahl. 

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: 

Komplexe Zahlen können mit der Funktion KOMPLEXE gebildet werden. 

Beispiel: 

IMWURZEL("2+4i") ergibt 1,79890743994787 + 1,11178594050284i 

Siehe auch: 

KOMPLEXE, IMAPOTENZ 

INDEX (Zelle in einem Bereich) 

Syntax: 

INDEX(Bereich; Zeile; Spalte [; Teilbereich]) 

Beschreibung: 

Liefert einen Bezug auf die Zelle, die sich in der angegebenen Zeile und Spalte 

von Bereich befindet. 

Für Bereich ist der gewünschte Zellbereich anzugeben. 

Mit Zeile und Spalte bestimmen Sie, in welcher Zeile und Spalte von Bereich sich 

die zu liefernde Zelle befindet (ausgehend von der linken oberen Ecke von Be-

reich). 

Wenn Zeile oder Spalte zu groß ist, liefert die Funktion den Fehlerwert #BEZUG. 

Das optionale Argument Teilbereich ist nur aus Gründen der Excel-Kompatibilität 

vorhanden. Es kann angegeben werden, wird von PlanMaker aber nicht ausgewer-

tet. 

Kompatibilitätshinweise: 

Diese Funktion ist nicht vollständig kompatibel zur gleichnamigen Excel-Funktion: 
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Beim Argument Bereich werden Mehrfachmarkierungen (unzusammenhängende 

Zellbereiche) nicht unterstützt. 

Das Argument Teilbereich wird nicht ausgewertet. 

Beispiel: 

INDEX(B2:D4; 2; 2) liefert einen Bezug auf die Zelle C3 

Siehe auch: 

VERGLEICH, SVERWEIS, WVERWEIS 

INDIREKT (Bezug aus Zeichenkette bilden) 

Syntax: 

INDIREKT(Zeichenkette [; Modus]) 

Beschreibung: 

Bildet aus einer Zeichenkette einen Zellbezug. 

Die übergebene Zeichenkette kann beispielsweise eine Zelladresse (z.B. "A1" 

oder "$A$1") oder einen Bereichsnamen enthalten. 

Der optionale Wahrheitswert Modus bestimmt, in welchem Format die übergebene 

Zelladresse vorliegen muss: 

WAHR oder nicht angegeben: Normale Zelladresse (z.B. A1) 

FALSCH: Zelladresse im Format „Z1S1“ (eine alternative Art der Zelladressie-

rung, die nur von Microsoft Excel unterstützt wird) 

Beispiel: 

INDIREKT("A1") liefert einen Bezug auf die Zelle A1. 

Steht in Zelle D2 der Text "E5", so liefert INDIREKT(D2) einen Bezug auf die 

Zelle E5. Mit GANZZAHL(INDIREKT(D2)) könnten Sie beispielsweise den In-

halt der Zelle E5 auf eine ganze Zahl abrunden. 
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Weisen Sie einem Zellbereich den Namen „Name1“ zu, so liefert INDI-

REKT("Name1") einen Bezug auf diesen benannten Bereich. 

Siehe auch: 

ADRESSE, BEREICH.VERSCHIEBEN, SPALTE, ZEILE  

ISOKALENDERWOCHE (Kalenderwoche nach ISO-Norm) 

Syntax: 

ISOKALENDERWOCHE(Datum) 

Beschreibung: 

Ermittelt, in der wievielten Kalenderwoche eines Jahres sich ein Datum befindet. 

Im Gegensatz zur Funktion KALENDERWOCHE verwendet diese Funktion nicht 

die in den USA und vielen anderen Teilen der Welt übliche Rechenmethode. Sie 

richtet sich vielmehr nach der u.a. in Deutschland, Österreich und der Schweiz 

verbindlichen ISO-Norm 8601. Diese legt folgendes fest: 

1. Wochenbeginn ist stets ein Montag (nicht Sonntag). 

2. Die erste Kalenderwoche eines Jahres ist diejenige, die den 4. Januar enthält. 

Hinweis: 

Hierbei kann es vorkommen, dass der 29., 30. und 31. Dezember bereits zur ersten 

Kalenderwoche des nächsten Jahres gezählt werden – oder der 1., 2., 3. Januar zur 

letzten Kalenderwoche des vorherigen Jahrs. Siehe Beispiele. 

Tipp: In PlanMaker gibt es deshalb als Alternative eine (nicht Excel-kompatible) 

Funktion namens ISOWOCHE. Diese liefert exakt die gleichen Ergebnisse, kann 

aber optional das Jahr zurückgeben, dem das Datum gemäß ISO-Norm zugerechnet 

wird.  
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Kompatibilitätshinweise: 

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versio-

nen ist die Funktion unbekannt. 

Beispiel: 

ISOKALENDERWOCHE("01.01.2014") ergibt 1. 

ISOKALENDERWOCHE("01.01.2011") ergibt 52, denn dieser Tag war ein Sams-

tag. 

Siehe auch: 

ISOWOCHE, KALENDERWOCHE, JAHR, MONAT, TAG, WOCHENTAG 

ISOWOCHE (Kalenderwoche nach ISO-Norm) 

Syntax: 

ISOWOCHE(Datum [; JahrZurückgeben]) 

Beschreibung: 

Ermittelt, in der wievielten Kalenderwoche eines Jahres sich ein Datum befindet. 

Im Gegensatz zur Funktion KALENDERWOCHE verwendet diese Funktion nicht 

die in den USA und vielen anderen Teilen der Welt übliche Rechenmethode. Sie 

richtet sich vielmehr nach der u.a. in Deutschland, Österreich und der Schweiz 

verbindlichen ISO-Norm 8601. Diese legt folgendes fest: 

1. Wochenbeginn ist stets ein Montag (nicht Sonntag). 

2. Die erste Kalenderwoche eines Jahres ist diejenige, die den 4. Januar enthält. 

Hinweis: 

Hierbei kann es vorkommen, dass der 29., 30. und 31. Dezember bereits zur ersten 

Kalenderwoche des nächsten Jahres gezählt werden – oder der 1., 2., 3. Januar zur 

letzten Kalenderwoche des vorherigen Jahrs.  
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Deshalb verfügt die Funktion zusätzlich über den Parameter JahrZurückgeben, 

der folgende Auswirkung hat: 

Ist dieser 0 oder nicht angegeben, liefert die Funktion die Wochennummer zurück. 

Ist dieser 1, liefert die Funktion stattdessen das Jahr zurück, dem das Datum ge-

mäß ISO-Norm zugerechnet wird. Siehe Beispiele. 

Kompatibilitätshinweise: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Tipp: Als Alternative für diese Funktion können Sie die Excel-kompatible Funktion 

ISOKALENDERWOCHE verwenden. Diese liefert identische Ergebnisse; ihr fehlt 

allerdings der optionale Parameter zum Anzeigen des Jahres. 

Beispiel: 

ISOWOCHE("01.01.2014") ergibt 1. 

ISOWOCHE("01.01.2011") ergibt 52, denn dieser Tag war ein Samstag.  

ISOWOCHE("01.01.2011"; 1) ergibt dementsprechend 2010 – nicht 2011. 

Siehe auch: 

ISOKALENDERWOCHE, KALENDERWOCHE, JAHR, MONAT, TAG, WO-

CHENTAG 

ISPMT (Zinszahlung) 

Syntax: 

ISPMT(Zins; Zr; Zzr; Bw) 

Beschreibung: 

Liefert die im angegebenen Zeitraum gezahlten Zinsen für eine Investition mit 

gleichbleibenden Raten. 
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Die Funktion erwartet folgende Argumente: 

Zins = Zinssatz (pro Periode) 

Zr = die zu betrachtende Periode 

Zzr = Zahl der Zahlungszeiträume (wie viele Perioden umfasst die Laufzeit?) 

Bw = Barwert (der anfängliche Betrag) 

Siehe auch: 

KAPZ, RMZ, ZINSZ 

ISTBEZUG (Ist ein Zellbezug?) 

Syntax: 

ISTBEZUG(Wert) 

Beschreibung: 

Liefert den Wahrheitswert WAHR, wenn der übergebene Wert ein gültiger Zellbe-

zug ist. 

Beispiel: 

ISTBEZUG(A1) ergibt WAHR 

ISTBEZUG($A$1) ergibt WAHR 

ISTBEZUG(A1:C7) ergibt WAHR 

ISTBEZUG("beliebiger Text") ergibt FALSCH 

ISTBEZUG(Quartal1) ergibt so lange FALSCH, bis Sie einem Zellbereich den 

Namen „Quartal1“ zuweisen – ab dann ergibt auch diese Berechnung WAHR. 

Siehe auch: 

ISTFORMEL 



 

638  •  Formeln und Funktionen Handbuch PlanMaker 

ISTFEHL (Ist Fehlerwert außer #NV?) 

Syntax: 

ISTFEHL(Zelle) 

Beschreibung: 

Im Unterschied zur Funktion ISTFEHLER (siehe dort) liefert ISTFEHL nur dann 

den Wahrheitswert WAHR, wenn die übergebene Zelle einen Fehlerwert außer 

#NV liefert. 

Beispiel: 

ISTFEHL(A1) ergibt WAHR, wenn der Inhalt der Zelle A1 einen Fehlerwert außer 

#NV ergibt. 

ISTFEHL(A1) ergibt FALSCH, wenn Zelle A1 keinen Fehler zurückliefert oder 

dort die Funktion NV() eingetragen ist. 

Siehe auch: 

ISTFEHLER, ISTNV, FEHLER.TYP, WENNFEHLER, Abschnitt über 

„Fehlerwerte“ ab Seite 515 

ISTFEHLER (Ist ein Fehler?) 

Syntax: 

ISTFEHLER(Zelle) 

Beschreibung: 

Liefert den Wahrheitswert WAHR, wenn die übergebene Zelle einen beliebigen 

Fehlerwert liefert. 
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Beispiel: 

ISTFEHLER(A1) ergibt WAHR, wenn der Inhalt der Zelle A1 einen beliebigen 

Fehlerwert zurückliefert. 

Siehe auch: 

ISTFEHL, ISTNV, FEHLER.TYP, WENNFEHLER, Abschnitt über „Fehlerwerte“ 

ab Seite 515 

ISTFORMEL (Ist eine Formel?) 

Syntax: 

ISTFORMEL(Zelle) 

Beschreibung: 

Liefert den Wahrheitswert WAHR, wenn die übergebene Zelle eine Formel enthält. 

Kompatibilitätshinweise: 

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versio-

nen ist die Funktion unbekannt. 

Beispiel: 

Steht in der Zelle A1 eine Formel, in Zelle C7 beispielsweise ein fester Zahlenwert 

oder Klartext, so gilt: 

ISTFORMEL(A1) ergibt WAHR 

ISTFORMEL(C7) ergibt FALSCH 

Siehe auch: 

ISTBEZUG 
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ISTGERADE (Ist eine gerade Zahl?) 

Syntax: 

ISTGERADE(Zahl) 

Beschreibung: 

Liefert den Wahrheitswert WAHR, wenn Zahl eine gerade Zahl ist.  

Hinweis: 

Zahl sollte eine ganze Zahl sein. Ist dies nicht der Fall, entfernt PlanMaker die 

Nachkommastellen automatisch. 

Beispiel: 

ISTGERADE(2) ergibt WAHR 

ISTGERADE(2,75) ergibt WAHR 

ISTGERADE(3) ergibt FALSCH 

ISTGERADE(3,75) ergibt FALSCH 

Siehe auch: 

ISTUNGERADE 

ISTKTEXT (Ist kein Text?) 

Syntax: 

ISTKTEXT(Zelle) 



 

Handbuch PlanMaker Formeln und Funktionen  •  641 

Beschreibung: 

Die Funktion ISTKTEXT (sprich: „Ist kein Text“) liefert nur dann den Wahr-

heitswert WAHR, wenn die übergebene Zelle keine Zeichenkette enthält. 

Beispiel: 

Enthält Zelle A1 eine feste Zeichenkette oder eine Berechnung, die eine Zeichen-

kette liefert, Zelle C7 hingegen eine Zahl, so gilt: 

ISTKTEXT(A1) ergibt FALSCH 

ISTKTEXT(C7) ergibt WAHR 

Siehe auch: 

ISTTEXT, ISTLOG, ISTZAHL 

Anmerkung: 

ISTTEXT ist das Gegenstück zu dieser Funktion: Sie liefert WAHR, wenn sich in 

der Zelle eine Zeichenkette befindet. 

ISTLEER (Ist leer?) 

Syntax: 

ISTLEER(Zelle) 

Beschreibung: 

Liefert den Wahrheitswert WAHR, wenn die übergebene Zelle leer ist. 

Beispiel: 

Enthält Zelle A1 beispielsweise einen beliebigen Wert, Zelle C7 ist hingegen leer, 

so gilt: 

ISTLEER(A1) ergibt FALSCH 
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ISTLEER(C7) ergibt WAHR 

Siehe auch: 

ISTNV, ANZAHL, ANZAHL2 

ISTLOG (Ist Wahrheitswert?) 

Syntax: 

ISTLOG(Zelle) 

Beschreibung: 

Liefert den Wahrheitswert WAHR, wenn die übergebene Zelle einen Wahrheitswert 

(WAHR oder FALSCH) enthält. 

Beispiel: 

Enthält Zelle A1 einen Wahrheitswert, oder eine Berechnung, die einen Wahr-

heitswert liefert, Zelle C7 hingegen Text, so gilt: 

ISTLOG(A1) ergibt WAHR 

ISTLOG(C7) ergibt FALSCH 

Siehe auch: 

ISTTEXT, ISTZAHL 

ISTNV (Ist nicht vorhanden?) 

Syntax: 

ISTNV(Zelle) 
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Beschreibung: 

Liefert den Wahrheitswert WAHR, wenn die übergebene Zelle den Fehlerwert #NV 

(„nicht vorhanden“) liefert.  

Eine Zelle liefert diesen Fehlerwert dann, wenn darin die Funktion NV() eingetra-

gen wurde oder die Zelle eine Berechnung enthält, die den Fehler #NV liefert. 

Informationen über die Verwendung des Fehlerwerts #NV finden Sie bei der Be-

schreibung der Funktion NV (Nicht vorhanden) ab Seite 699. 

Beispiel: 

In Zelle A1 wurde die Funktion NV() eingetragen, um zu kennzeichnen, dass hier 

ein für eine andere Berechnung zwingend erforderlicher Wert noch nicht vorhan-

den ist.  

Zelle C7 führt eine Berechnung mit Zelle A1 durch, zum Beispiel A1*2. Da Zelle 

A1 aber den Fehlerwert #NV liefert, ist das Ergebnis dieser Berechnung ebenfalls 

der Fehlerwert #NV. 

Hier gilt also: 

ISTNV(A1) ergibt WAHR 

ISTNV(C7) ergibt ebenfalls WAHR 

Siehe auch: 

NV(), FEHLER.TYP, ISTFEHL, ISTFEHLER, WENNFEHLER, Abschnitt über 

„Fehlerwerte“ ab Seite 515 

ISTTEXT (Ist eine Zeichenkette?) 

Syntax: 

ISTTEXT(Zelle) 

Beschreibung: 

Liefert den Wahrheitswert WAHR, wenn die übergebene Zelle eine Zeichenkette 

enthält. 
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Beispiel: 

Enthält Zelle A1 eine feste Zeichenkette oder eine Berechnung, die eine Zeichen-

kette liefert, Zelle C7 hingegen eine Zahl, so gilt: 

ISTTEXT(A1) ergibt WAHR 

ISTTEXT(C7) ergibt FALSCH 

Siehe auch: 

ISTKTEXT, ISTLOG, ISTZAHL 

Anmerkung: 

ISTKTEXT ist das Gegenstück zu dieser Funktion: Sie liefert WAHR, wenn sich in 

der Zelle keine Zeichenkette befindet. 

ISTUNGERADE (Ist eine ungerade Zahl?) 

Syntax: 

ISTUNGERADE(Zahl) 

Beschreibung: 

Liefert den Wahrheitswert WAHR, wenn Zahl eine ungerade Zahl ist.  

Hinweis: 

Zahl sollte eine ganze Zahl sein. Ist dies nicht der Fall, entfernt PlanMaker die 

Nachkommastellen automatisch. 

Beispiel: 

ISTUNGERADE(1) ergibt WAHR 

ISTUNGERADE(1,75) ergibt WAHR 

ISTUNGERADE(2) ergibt FALSCH 
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ISTUNGERADE(2,75) ergibt FALSCH 

Siehe auch: 

ISTGERADE 

ISTZAHL (Ist eine Zahl?) 

Syntax: 

ISTZAHL(Zelle) 

Beschreibung: 

Liefert den Wahrheitswert WAHR, wenn die übergebene Zelle eine Zahl enthält. 

Datumsangaben werden ebenfalls als Zahlen betrachtet; Wahrheitswerte (WAHR 

und FALSCH) hingegen nicht. 

Beispiel: 

Die Zellen A1 bis A4 enthalten folgende Werte:  

"Text", 42, 25.09.2018 und WAHR 

Hier gilt: 

ISTZAHL(A1) ergibt FALSCH 

ISTZAHL(A2) ergibt WAHR 

ISTZAHL(A3) ergibt WAHR 

ISTZAHL(A4) ergibt FALSCH 

Siehe auch: 

ISTZAHLP, ISTLOG, ISTTEXT, ISTKTEXT 
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ISTZAHLP (PlanMaker 97-Kompatibilitätsfunktion) 

Syntax: 

ISTZAHLP(Zelle) 

Beschreibung: 

Liefert den Wahrheitswert WAHR, wenn die übergebene Zelle eine Zahl oder einen 

Wahrheitswert enthält. 

Datumsangaben werden ebenfalls als Zahlen betrachtet. 

Hinweis: 

Diese Funktion ist nur aus Kompatibilitätsgründen zu PlanMaker 97 noch vorhan-

den. Verwenden Sie diese Funktion möglichst nicht mehr, sondern stattdessen die 

Excel-kompatible Funktion ISTZAHL (ohne „P“). 

Der Unterschied: 

ISTZAHLP betrachtet auch Wahrheitswerte als Zahlen, ISTZAHL hingegen nicht. 

Kompatibilitätshinweise: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

Die Zellen A1 bis A4 enthalten folgende Werte:  

"Text", 42, 25.09.2018 und WAHR 

Hier gilt: 

ISTZAHLP(A1) ergibt FALSCH 

ISTZAHLP(A2) ergibt WAHR 

ISTZAHLP(A3) ergibt WAHR 
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ISTZAHLP(A4) ergibt WAHR (!) 

Zum Vergleich: ISTZAHL(A4) ergibt hingegen FALSCH 

Siehe auch: 

ISTZAHL 

JAHR (Jahr aus einem Datumswert ermitteln) 

Syntax: 

JAHR(Datum) 

Beschreibung: 

Liefert die Jahreszahl eines Datumswerts. 

Beispiel: 

JAHR("25.9.2018") ergibt 2018 

Siehe auch: 

ISOKALENDERWOCHE, MONAT, TAG, WOCHENTAG 

JETZT (Aktuelles Datum, aktuelle Uhrzeit) 

Syntax: 

JETZT() 

Beschreibung: 

Liefert das aktuelle Datum und die aktuelle Uhrzeit. 
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Das Ergebnis ist – wie alle Datumsangaben in einer Tabellenkalkulation – eine 

Zahl. PlanMaker weist ihr automatisch das Zahlenformat „Datum/Zeit“ im Format 

hh:mm:ss zu, damit sie als Uhrzeit angezeigt wird. 

Das Ergebnis enthält allerdings auch das Datum. Formatieren Sie die Zelle also 

zum Beispiel in das Zahlenformat TT.MM.JJJJ hh:mm um, wird das aktuelle Da-

tum und die aktuelle Uhrzeit angezeigt. 

Siehe auch: 

HEUTE 

KALENDERWOCHE (Kalenderwoche) 

Syntax: 

KALENDERWOCHE(Datum [; Wochenbeginn]) 

Beschreibung: 

Ermittelt, in der wievielten Kalenderwoche eines Jahres sich ein Datum befindet. 

Hierbei wird die in den USA und vielen anderen Teilen der Welt übliche Rechen-

methode angewandt: Als erste Kalenderwoche des Jahres gilt stets die Woche, die 

den 1. Januar enthält. 

Hinweis: 

In Deutschland wird normalerweise nach einer anderen Methode gerechnet; hier 

folgt man der ISO-Norm (siehe Funktion ISOKALENDERWOCHE). 

Wichtig: 

Beachten Sie außerdem, dass diese Funktion standardmäßig den Sonntag als Wo-

chenbeginn ansieht – nicht den Montag. 

Mit dem optionalen Argument Wochenbeginn können Sie dies allerdings ändern. 

Für Wochenbeginn sind folgende Werte zulässig: 

1 oder nicht angegeben: Woche beginnt am Sonntag 
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2: Woche beginnt am Montag 

Beispiel: 

Am 5.1.2014 (einem Sonntag) gilt: 

KALENDERWOCHE("5.1.2014"; 1) ergibt 2 

KALENDERWOCHE("5.1.2014"; 2) ergibt 1 

Siehe auch: 

ISOKALENDERWOCHE, ISOWOCHE, JAHR, MONAT, TAG, WOCHENTAG 

KAPZ (Kapitalrückzahlung) 

Syntax: 

KAPZ(Zins; Zr; Zzr; Bw [; Zw] [; Fälligkeit]) 

Beschreibung: 

Liefert den Tilgungsanteil der Zahlung in der angegebenen Periode, basierend auf 

einer Investition mit regelmäßigen konstanten Zahlungen und feststehendem Zins. 

Sie können mit dieser Funktion beispielsweise berechnen, wie groß bei einem Kre-

dit der Tilgungsanteil der Annuität in einer bestimmten Periode ist.  

„Periode“ bezeichnet einen Zahlungszeitraum. Bei einem Kredit mit monatlichen 

Rückzahlungen ist die dritte Periode beispielsweise der dritte Monat. 

Die Funktion erwartet folgende Argumente: 

Zins = Zinssatz (pro Periode) 

Zr = die zu betrachtende Periode 

Zzr = Zahl der Zahlungszeiträume (wie viele Perioden umfasst die Laufzeit?) 

Bw = Barwert (der anfängliche Betrag) 
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Zw (optional) = Zukünftiger Wert, also der Endstand, den Sie nach der letzten Zah-

lung erreichen möchten. Wenn Sie das Argument Zw nicht angeben, wird es auf 

Null gesetzt. 

Fälligkeit (optional) = Wann die Zahlungen fällig sind: 

0 oder nicht angegeben: jeweils am Ende der Periode 

1: jeweils am Anfang der Periode 

Beispiel: 

Es wird ein Kredit über € 100.000,- zu folgenden Bedingungen aufgenommen: 

Jahreszins: 10% 

Rückzahlungen: monatlich 

Laufzeit: 6 Jahre 

Wie groß ist der Tilgungsanteil der Zahlung in Monat 32? 

KAPZ(10%/12; 32; 6*12; 100000) ergibt -1.318 Euro. 

Beachten Sie dabei, dass alle Angaben auf der gleichen Zeiteinheit basieren müs-

sen – hier also auf Monaten, da die Rückzahlungen monatlich erfolgen.  

Deshalb wurde in der obigen Formel der Jahreszins durch 12 geteilt (um den Zins 

pro Monat zu erhalten) und die Laufzeit mit 12 multipliziert (um die Laufzeit in 

Monaten zu erhalten). 

Siehe auch: 

BW, ISPMT, KUMKAPITAL, KUMZINSZ, RMZ, ZINS, ZINSZ, ZW, ZZR 

Anmerkung: 

Die Funktion ZINSZ ist das Gegenstück zu KAPZ: Sie liefert den Zinsanteil der 

Zahlung in dieser Periode.  

Die Funktion RMZ hingegen liefert den Gesamtbetrag der Zahlung (Annuität) pro 

Periode, also die Summe von Tilgungsanteil und Zinsanteil. 
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KGRÖSSTE (k-größter Wert) 

Syntax: 

KGRÖSSTE(Bereich; k) 

Beschreibung: 

Liefert den k-größten Wert einer Zahlenmenge. Der 1-größte Wert ist der größte 

Wert, der 2-größte ist der zweitgrößte Wert etc. 

Bereich ist ein Bereich mit numerischen Daten – in der Regel also ein Bezug auf 

einen Zellbereich, in dem Zahlen eingetragen sind. 

k bestimmt, die „wievielt-größte“ Zahl geliefert werden soll. 

k darf nicht kleiner als 1 oder größer als die Anzahl an Zahlen in Bereich sein, 

andernfalls liefert die Funktion den Fehlerwert #ZAHL!. 

Beispiel: 

Sind in den Zellen A1:A5 die Zahlen 4, 2, 6, 5, 9 eingetragen, so gilt: 

KGRÖSSTE(A1:A5; 1) ergibt 9 

KGRÖSSTE(A1:A5; 2) ergibt 6 

KGRÖSSTE(A1:A5; 3) ergibt 5 

etc. 

Siehe auch: 

KKLEINSTE, MAX, QUANTIL, QUANTILSRANG, RANG 

KGV (Kleinstes gemeinsames Vielfaches) 

Syntax: 

KGV(Zahl1 [; Zahl2; Zahl3 ...]) 
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Beschreibung: 

Ermittelt das kgV („kleinstes gemeinsames Vielfaches“) einer Menge von Zahlen. 

Das kgV ist die kleinste all derjenigen ganzen Zahlen, die ein Vielfaches der Ar-

gumente sind. 

Als Argumente können Zahlen oder Zellbezüge übergeben werden. 

Alle übergebenen Zahlen müssen größer gleich 1 sein. Weiterhin sollten nur ganze 

Zahlen verwendet werden. Ist dies nicht der Fall, schneidet PlanMaker die Nach-

kommastellen automatisch ab. 

Beispiel: 

KGV(5; 10; 15) ergibt 30 

Sind die Zellen A1 bis A3 mit den Werten 4, 8 und 6 gefüllt, so gilt: 

KGV(A1:A3) ergibt 24 

Siehe auch: 

GGT 

KKLEINSTE (k-kleinster Wert) 

Syntax: 

KKLEINSTE(Bereich; k) 

Beschreibung: 

Liefert den k-kleinsten Wert einer Zahlenmenge. Der 1-kleinste Wert ist der kleins-

te Wert, der 2-kleinste ist der zweitkleinste Wert etc. 

Bereich ist ein Bereich mit numerischen Daten – in der Regel also ein Bezug auf 

einen Zellbereich, in dem Zahlen eingetragen sind. 

k bestimmt, die „wievielt-kleinste“ Zahl geliefert werden soll. 

k darf nicht kleiner als 1 oder größer als die Anzahl an Zahlen in Bereich sein, 

andernfalls liefert die Funktion den Fehlerwert #ZAHL!. 
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Beispiel: 

Sind in den Zellen A1:A5 die Zahlen 4, 2, 6, 5, 9 eingetragen, so gilt: 

KKLEINSTE(A1:A5; 1) ergibt 2 

KKLEINSTE(A1:A5; 2) ergibt 4 

KKLEINSTE(A1:A5; 3) ergibt 5 

etc. 

Siehe auch: 

KGRÖSSTE, MIN, QUANTIL, QUANTILSRANG, RANG 

KLEIN (In Kleinbuchstaben wandeln) 

Syntax: 

KLEIN(Zeichenkette) 

Beschreibung: 

Wandelt alle Buchstaben einer Zeichenkette in Kleinbuchstaben um. 

Beispiel: 

KLEIN("PlanMaker") ergibt planmaker 

Siehe auch: 

GROSS, GROSS2 
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KOMBINATIONEN (Kombinationen) 

Syntax: 

KOMBINATIONEN(n; k) 

Beschreibung: 

Ermittelt die Anzahl der ungeordneten Stichproben vom Umfang k, die man einer 

Gesamtheit von n verschiedenen Elementen ohne Zurücklegen entnehmen kann. 

Im Klartext: Es stehen insgesamt n Elemente zur Verfügung. Aus diesen soll eine 

Teilmenge von genau k Elementen gezogen werden. Diese Funktion berechnet, wie 

viele unterschiedliche Teilmengen es hierbei geben kann. 

n gibt an, aus wie vielen Elementen die Gesamtheit besteht. n muss größer als k 

sein. 

k gibt an, wie viele Elemente in einer Stichprobe gezogen werden sollen. k muss 

größer als 0 und kleiner als n sein. 

n und k sollten ganze Zahlen sein. Ist das nicht der Fall, kürzt PlanMaker die 

Nachkommastellen automatisch weg. 

Beispiel: 

Betrachten wir eine Lotterie, bei der 6 aus 49 verschiedenen Kugeln gezogen wer-

den. 

Um zu berechnen, wie viele Kombinationen hierbei möglich sind, würde man 

schreiben: 

KOMBINATIONEN(49; 6) 

Es gibt also 13.983.816 Kombinationsmöglichkeiten. 

Siehe auch: 

VARIATIONEN 
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KOMPLEXE (Komplexe Zahl bilden) 

Syntax: 

KOMPLEXE(Realteil; Imaginärteil [; Suffix]) 

Beschreibung: 

Bildet aus dem angegebenen Realteil und Imaginärteil eine komplexe Zahl in der 

Form x+yi oder x+yj. 

Mit Suffix können Sie bei Bedarf bestimmen, welcher Buchstabe für die imaginäre 

Einheit verwendet werden soll: entweder "i" oder "j" (Kleinbuchstabe!). Wird Suf-

fix nicht angegeben, wird automatisch "i" verwendet. 

Tipp: 

Um komplexe Zahlen in Tabellenzellen einzugeben, benötigen Sie die Funktion 

KOMPLEXE eigentlich nicht, sondern können den Wert auch einfach eintippen. 

Wenn Sie in eine Zelle also zum Beispiel die komplexe Zahl 2+4i eintragen möch-

ten, müssen Sie nicht =KOMPLEXE(2;4) eingeben, sondern können einfach 2+4i 

tippen. 

Auch in Formeln lassen sich komplexe Zahlen einfach eintippen. Wichtig: Umge-

ben Sie die komplexe Zahl dabei mit doppelten Anführungszeichen. Statt 

=IMAPOTENZ(KOMPLEXE(2;4)) können Sie also auch einfach 

=IMAPOTENZ("2+4i") schreiben. 

Beispiel: 

KOMPLEXE(2;4) ergibt 2+4i 

KOMPLEXE(2;4;"i") ergibt ebenfalls 2+4i 

KOMPLEXE(2;4;"j") ergibt 2+4j 

Siehe auch: 

IMAGINÄRTEIL, IMREALTEIL 
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KONFIDENZ (Konfidenzintervall) 

Syntax: 

KONFIDENZ(Alpha; Sigma; n) 

Beschreibung: 

Ermöglicht die Bestimmung des 1-Alpha-Konfidenzintervalls für den Erwartungs-

wert (= Mittelwert) einer Wahrscheinlichkeitsverteilung. 

Das 1-Alpha-Konfidenzintervall ist ein symmetrischer Bereich um den Mittelwert 

einer Stichprobe, das den Mittelwert der Grundgesamtheit mit einer Wahrschein-

lichkeit von 1-Alpha enthält. 

Alpha ist die Irrtumswahrscheinlichkeit. Zulässig sind nur Werte aus dem Intervall 

[0..1]. 

Ist Alpha beispielsweise 0,05 (also 5%), so ist die Wahrscheinlichkeit, dass der 

tatsächliche Mittelwert außerhalb des mit Hilfe der KONFIDENZ-Funktion ermit-

telten Intervalls liegt, 5%. Man spricht hier vom 95%-Konfidenzintervall. 

Sigma ist die Standardabweichung der Grundgesamtheit. Sie muss größer als Null 

sein. 

n gibt den Umfang der Stichprobe an. Dieser muss größer als Null sein. 

Beispiel: 

In einem Schweinezuchtbetrieb soll das Durchschnittsgewicht von 1000 Ferkeln 

bestimmt werden. Dazu wird eine Stichprobe (mit Zurücklegen) vom Umfang 

n=65 genommen. Das dabei ermittelte Durchschnittsgewicht liegt bei 30 kg. Die 

Standardabweichung beträgt 1,6 kg. 

Es soll nun das 95%-Konfidenzintervall (Alpha ist hier also 0,05) ermittelt werden. 

Man würde also berechnen: 

KONFIDENZ(0,05; 1,6; 65) ergibt 0,38897 (kg) 

Das Durchschnittsgewicht der Grundgesamtheit (= aller 1000 Schweine) liegt also 

mit einer Wahrscheinlichkeit von 95% zwischen 30-0,38897 kg und 30+0,38897 

kg. 
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KORREL (Korrelationskoeffizient) 

Syntax: 

KORREL(Bereich1; Bereich2) 

Beschreibung: 

Berechnet den Korrelationskoeffizienten von zwei Datengruppen. 

Der Korrelationskoeffizient ist ein Maß für die wechselseitige Beziehung zwischen 

den Datengruppen. 

Bereich1 und Bereich2 sind Zellbezüge auf die beiden Datengruppen. Leere Zel-

len sowie Zeichenketten und Wahrheitswerte werden ignoriert. 

Die Datengruppen müssen die gleiche Anzahl an Werten besitzen, ansonsten liefert 

die Funktion den Fehlerwert #NV. 

Beispiel: 

Sind die Zellen A1 bis A3 mit den Werten 2, 5, 3 und die Zellen B1 bis B3 mit den 

Werten 2, 7, 4 gefüllt, so gilt: 

KORREL(A1:A3; B1:B3) ergibt 0,99718 

Siehe auch: 

FISHER, KOVAR 

KOVAR (Kovarianz) 

Syntax: 

KOVAR(Bereich1; Bereich2) 

Beschreibung: 

Berechnet die Kovarianz zweier Datengruppen. 
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Die Kovarianz ist ein Maß für die gemeinsame lineare Streuung der Datengruppen. 

Sie wird aus dem Mittelwert der Produkte der Abweichungen der Wertepaare um 

das arithmetische Mittel gebildet. 

Bereich1 und Bereich2 sind Zellbezüge auf die beiden Datengruppen. Diese müs-

sen ganze Zahlen enthalten. Leere Zellen sowie Zeichenketten und Wahrheitswerte 

werden ignoriert. 

Die Datengruppen müssen die gleiche Anzahl an Werten besitzen, ansonsten liefert 

die Funktion den Fehlerwert #NV. 

Beispiel: 

Sind die Zellen A1 bis A3 mit den Werten 2, 5, 3 und die Zellen B1 bis B3 mit den 

Werten 2, 7, 4 gefüllt, so gilt: 

KOVAR(A1:A3; B1:B3) ergibt 2,55556 

Siehe auch: 

FISHER, KORREL 

KRITBINOM 

Syntax: 

KRITBINOM(n; p; Alpha) 

Beschreibung: 

Liefert den kleinsten Wert für eine binomialverteilte Zufallsvariable, bei dem die 

angegebene Irrtumswahrscheinlichkeit Alpha nicht überschritten wird. 

Es wird also berechnet, wie oft ein bestimmtes Ereignis mit der Wahrscheinlichkeit 

p beim Durchführen einer Stichprobe mit n Wiederholungen höchstens eintreten 

darf, bevor seine kumulierten Wahrscheinlichkeiten einen Wert größer oder gleich 

der Irrtumswahrscheinlichkeit Alpha annehmen. 

Diese Funktion ist nur bei Binomialverteilungen anwendbar (siehe auch Funktion 

BINOMVERT); es muss sich also um unabhängige Ziehungen handeln, bei denen 
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nur zwei Ergebnisse möglich sind: Erfolg (Ereignis tritt ein) oder Fehlschlag (Er-

eignis tritt nicht ein). 

n ist die Anzahl der durchgeführten Versuche. 

p ist die Wahrscheinlichkeit des Erfolgs pro Wiederholung. Zulässig sind nur Werte 

aus dem Intervall [0..1]. 

Alpha ist die Irrtumswahrscheinlichkeit, die nicht überschritten werden darf. Zu-

lässig sind nur Werte aus dem Intervall [0..1]. 

Beispiel: 

Aus früheren Lieferungen ist ihnen bekannt, dass normalerweise 7% eines be-

stimmten elektronischen Bauteils defekt sind. Um diese Aussage zu überprüfen, 

führen Sie bei einer neuen Lieferung eine Stichprobe von 100 Bauteilen durch. Wie 

viele davon dürfen höchstens defekt sein, wenn die Irrtumswahrscheinlichkeit 1% 

nicht überschreiten soll? 

KRITBINOM(100; 7%; 1%) ergibt 2 

Siehe auch: 

BINOMVERT 

KUMKAPITAL (Kumulierte Kapitalrückzahlungen) 

Syntax: 

KUMKAPITAL(Zins; Zzr; Bw; z1; z2; Fälligkeit) 

Beschreibung: 

Ermittelt die Summe der zwischen Periode z1 und z2 fälligen Kapitalrückzahlun-

gen (Tilgungsanteile), basierend auf einer Investition mit regelmäßigen konstanten 

Zahlungen und feststehendem Zins. 

Sie können mit dieser Funktion beispielsweise berechnen, wie groß bei einem Kre-

dit der Tilgungsanteil der Annuitäten in den angegebenen Perioden ist.  
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„Periode“ bezeichnet einen Zahlungszeitraum. Bei einem Kredit mit monatlichen 

Rückzahlungen ist die dritte Periode beispielsweise der dritte Monat. 

Die Funktion erwartet folgende Argumente: 

Zins = Zinssatz (pro Periode). 

Zzr = Zahl der Zahlungszeiträume (wie viele Perioden umfasst die Laufzeit?) 

Bw = Barwert (der anfängliche Betrag) 

z1; z2 = der zu betrachtende Zeitraum: z1 ist die erste zu berücksichtigende Perio-

de, z2 die letzte. (Die Perioden sind mit 1 beginnend durchnummeriert.) 

Fälligkeit = Wann die Zahlungen fällig sind: 

0 oder nicht angegeben: jeweils am Ende der Periode 

1: jeweils am Anfang der Periode 

Beispiel: 

Es wird ein Kredit über € 100.000,- zu folgenden Bedingungen aufgenommen: 

Jahreszins: 10% 

Zahlungen: monatlich, jeweils am Monatsende 

Laufzeit: 6 Jahre 

Wie groß ist der Tilgungsanteil der Zahlungen in den Perioden (=Monaten) 24 bis 

36 insgesamt? 

KUMKAPITAL(10%/12; 6*12; 100000; 24; 36; 0) ergibt -16863,71 Euro. 

Beachten Sie dabei, dass alle Angaben auf der gleichen Zeiteinheit basieren müs-

sen – hier also auf Monaten, da die Zahlungen monatlich erfolgen.  

Deshalb wurde in der obigen Formel der Jahreszins durch 12 geteilt (um den Zins 

pro Monat zu erhalten) und die Laufzeit mit 12 multipliziert (um die Laufzeit in 

Monaten zu erhalten). 

Siehe auch: 

KUMZINSZ, KAPZ, ZINSZ, RMZ 
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Anmerkung: 

Die Funktion KUMZINSZ ist das Gegenstück zu KUMKAPITAL: Sie liefert die 

Summe der Zinsanteile. 

KUMZINSZ (Kumulierte Zinszahlungen) 

Syntax: 

KUMZINSZ(Zins; Zzr; Bw; z1; z2; Fälligkeit) 

Beschreibung: 

Ermittelt die Summe der zwischen Periode z1 und z2 fälligen Zinszahlungen, ba-

sierend auf einer Investition mit regelmäßigen konstanten Zahlungen und festste-

hendem Zins. 

Sie können mit dieser Funktion beispielsweise berechnen, wie groß bei einem Kre-

dit der Zinsanteil der Annuitäten in den angegebenen Perioden ist.  

„Periode“ bezeichnet einen Zahlungszeitraum. Bei einem Kredit mit monatlichen 

Rückzahlungen ist die dritte Periode beispielsweise der dritte Monat. 

Die Funktion erwartet folgende Argumente: 

Zins = Zinssatz (pro Periode). 

Zzr = Zahl der Zahlungszeiträume (wie viele Perioden umfasst die Laufzeit?) 

Bw = Barwert (der anfängliche Betrag) 

z1; z2 = der zu betrachtende Zeitraum: z1 ist die erste zu berücksichtigende Perio-

de, z2 die letzte. (Die Perioden sind mit 1 beginnend durchnummeriert.) 

Fälligkeit = Wann die Zahlungen fällig sind: 

0 oder nicht angegeben: jeweils am Ende der Periode 

1: jeweils am Anfang der Periode 

Beispiel: 

Es wird ein Kredit über € 100.000,- zu folgenden Bedingungen aufgenommen: 
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Jahreszins: 10% 

Zahlungen: monatlich, jeweils am Monatsende 

Laufzeit: 6 Jahre 

Wie groß ist der Zinsanteil der Zahlungen in den Perioden (=Monaten) 24 bis 36 

insgesamt? 

KUMZINSZ(10%/12; 6*12; 100000; 24; 36; 0) ergibt -7219,88 Euro. 

Beachten Sie dabei, dass alle Angaben auf der gleichen Zeiteinheit basieren müs-

sen – hier also auf Monaten, da die Zahlungen monatlich erfolgen.  

Deshalb wurde in der obigen Formel der Jahreszins durch 12 geteilt (um den Zins 

pro Monat zu erhalten) und die Laufzeit mit 12 multipliziert (um die Laufzeit in 

Monaten zu erhalten). 

Siehe auch: 

KUMKAPITAL, KAPZ, ZINSZ, RMZ 

Anmerkung: 

Die Funktion KUMKAPITAL ist das Gegenstück zu KUMZINSZ: Sie liefert die 

Summe der Tilgungsanteile. 

KURT (Kurtosis einer Verteilung) 

Syntax: 

KURT(Zahl1; Zahl2; Zahl3; Zahl4 [; Zahl5 ...]) 

oder 

KURT(Bereich1 [; Bereich2; Bereich3 ...]) 

Beschreibung: 

Berechnet die Kurtosis („Gipfligkeit“) einer Wahrscheinlichkeitsverteilung. 
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Die Kurtosis ist ein Maß für die Wölbung der Dichtefunktion einer Verteilung im 

Vergleich zur Dichtefunktion der Normalverteilung. 

Bei einer steiler gewölbten („schmalgipfligen“) Verteilung ist die Kurtosis ein posi-

tiver Wert, bei flacher gewölbten („breitgipfligen“) Kurve ein negativer Wert.  

Wenn sich die Kurtosis Null annähert, entspricht die betrachtete Verteilung in guter 

Näherung einer Normalverteilung (siehe Funktion NORMVERT). 

Zahl1, Zahl2, Zahl3, Zahl4 etc. sind die Werte der Verteilung, deren Kurtosis 

berechnet werden soll. Leere Zellen sowie Zeichenketten und Wahrheitswerte wer-

den ignoriert. 

Es müssen mindestens vier Werte angegeben sein; andernfalls liefert die Funktion 

den Fehlerwert #DIV/0! (Division durch Null). 

Hinweis: 

Diese Funktion erwartet als Argumente keine Wertepaare (x-Wert und y-Wert), 

sondern nur die Werte der Verteilung. Mehrmals vorkommende Werte müssen ent-

sprechend oft wiederholt werden (siehe Beispiel). 

Beispiel: 

Sie messen die Körpergrößen einer Gruppe von Personen und erhalten dabei fol-

gende Ergebnisse: 1 x 1,60m, 2 x 1,65m, 4 x 1,70m, 2 x 1,75m und 1x1,80m.  

Die Verteilung (Dichtefunktion) dieser Messergebnisse hat folgende Gipfligkeit: 

KURT(1,60; 1,65; 1,65; 1,70; 1,70; 1,70; 1,70; 1,75; 1,75; 1,80) ergibt 0,08036. 

Siehe auch: 

SCHIEFE, NORMVERT 

KÜRZEN (Zahl auf n Nachkommastellen kürzen) 

Syntax: 

KÜRZEN(Zahl [; n]) 
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Beschreibung: 

Kürzt eine Zahl auf n Nachkommastellen (ohne zu runden). 

n ist die gewünschte Anzahl an Nachkommastellen.  

Wird n nicht angegeben, wird die Zahl auf 0 Nachkommastellen gekürzt. 

n darf auch ein negativer Wert sein, worauf auch der ganzzahlige Teil der Zahl ge-

kürzt wird (siehe letztes Beispiel). 

Beispiel: 

KÜRZEN(5,779) ergibt 5 

KÜRZEN(5,779; 2) ergibt 5,77 

KÜRZEN(1234; -2) ergibt 1200 

Siehe auch: 

ABRUNDEN, AUFRUNDEN, NACHKOMMA, RUNDEN 

Anmerkung: 

Die Nachkommastellen erhalten Sie mit der Funktion NACHKOMMA. 

LÄNGE (Länge einer Zeichenkette) 

Syntax: 

LÄNGE(Wert) 

Beschreibung: 

Ermittelt, aus wie vielen Zeichen der übergebene Wert besteht.  

Wenn der übergebene Wert eine Zahl, ein Datum oder ein Wahrheitswert ist, wird 

er in eine Zeichenkette konvertiert. 

Beachten Sie: Bei Datumsangaben wird die serielle Datumszahl in eine Zeichen-

kette konvertiert, nicht das formatierte Datum selbst (siehe letztes Beispiel). 
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Beispiel: 

LÄNGE("Text") ergibt 4 

LÄNGE(42) ergibt 2 

LÄNGE(-42) ergibt 3 

LÄNGE(42,5) ergibt 4 

LÄNGE(42,50) ergibt ebenfalls 4 (die überflüssige Null wird automatisch ent-

fernt!) 

LÄNGE(WAHR) ergibt 4 

Beachten Sie bei Datumsangaben: Wenn in Zelle A1 das Datum 25.09.2014 in ei-

ner beliebigen Formatierung steht, so gilt: 

LÄNGE(A1) ergibt 5 

Grund: Datumswerte werden in einer Tabellenkalkulation stets als Zahlen gespei-

chert – das Datum 25.09.2014 beispielsweise als 41907. Insofern ist das Ergebnis 

der Berechnung zwar unerwartet, aber völlig korrekt – denn: 

LÄNGE(41907) ergibt ebenfalls 5 

Siehe auch: 

LINKS, RECHTS, TEIL 

LAUFZEIT (Laufzeit) 

Syntax: 

LAUFZEIT(Zins; Bw; Zw) 

Beschreibung: 

Ermittelt den Zeitraum (die Anzahl an Perioden), der benötigt wird, um mit einer 

festverzinslichen Anlage einen bestimmten Betrag zu erreichen.  

Es werden keine regelmäßigen Zahlungen geleistet; es gibt also nur eine einzige 

Einzahlung am Beginn der Laufzeit. 
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Die Funktion erwartet folgende Argumente: 

Zins = Zinssatz (pro Periode) 

Bw = Barwert (der anfängliche Betrag) 

Zw = Zukünftiger Wert (der Zielwert) 

Kompatibilitätshinweise: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Tipp: Sie können Berechnungen mit der Funktion LAUFZEIT wie folgt mit Excel-

kompatiblen Funktionen durchführen: 

Laufzeit(Zins; Bw; Zw) entspricht ZZR(Zins; 0; Bw; -Zw) 

Beachten Sie dabei das Minuszeichen vor Zw! 

Beispiel: 

Sie möchten mit einer Anlage von € 3000,- auf eine Auszahlung von € 5000,- 

kommen. Der Zinssatz beträgt 6% pro Jahr. Wie viele Perioden (= Jahre) werden 

dafür benötigt? 

LAUFZEIT(6%; 3000; 5000) ergibt 8,76669 (Jahre) 

Siehe auch: 

ZSATZINVEST 

LIA (Lineare Abschreibung) 

Syntax: 

LIA(AW; RW; ND) 
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Beschreibung: 

Liefert den Wert der linearen Abschreibung eines Objekts pro Periode. 

AW = Anschaffungskosten des Objekts 

RW = Restwert des Objekts am Ende der Nutzungsdauer 

ND = Nutzungsdauer (Anzahl der Perioden, über die das Objekt abgeschrieben 

wird) 

Beispiel: 

LIA(6000; 3000; 5) ergibt 600 

Siehe auch: 

DIA, GDA 

LINKS (Teil einer Zeichenkette) 

Syntax: 

LINKS(Zeichenkette [; n]) 

Beschreibung: 

Liefert die ersten n Zeichen einer Zeichenkette. 

Ist n nicht angegeben, liefert die Funktion nur das erste Zeichen. 

Beispiel: 

LINKS("Tiergarten"; 4) ergibt Tier 

LINKS("Tiergarten") ergibt T 

Siehe auch: 

RECHTS, TEIL, ERSETZEN 
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LN (Natürlicher Logarithmus) 

Syntax: 

LN(Zahl) 

Beschreibung: 

Liefert den natürlichen Logarithmus (Basis e) einer Zahl. 

Die übergebene Zahl muss größer als Null sein. 

Anmerkung: 

Die Umkehrfunktion zu dieser Funktion ist EXP. 

Beispiel: 

LN(0,7) ergibt -0,3567 

LN(EXP(1,234)) ergibt 1,234 

Siehe auch: 

LOG, LOG10, EXP 

LOG (Logarithmus) 

Syntax: 

LOG(Zahl [; Basis]) 

Beschreibung: 

Liefert den Logarithmus einer Zahl zur angegebenen Basis.  

Die übergebene Zahl muss größer als Null sein. 
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Ist das Argument Basis nicht angegeben, wird als Basis 10 verwendet. 

Beispiel: 

LOG(100) entspricht log 10 (100), ergibt also 2 

LOG(10 ^ 0,1234) ergibt 0,1234 

LOG(8; 2) entspricht log 2 (8), ergibt also 3 

Siehe auch: 

LOG10, LN 

LOG10 (Zehnerlogarithmus) 

Syntax: 

LOG10(Zahl) 

Beschreibung: 

Liefert den Zehnerlogarithmus (dekadischer Logarithmus) einer Zahl, also den 

Logarithmus zur Basis 10. 

Die übergebene Zahl muss größer als Null sein. 

Beispiel: 

LOG10(100) ergibt 2 

LOG10(10 ^ 0,1234) ergibt 0,1234 

Siehe auch: 

LOG, LN 
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LOGINV (Quantile einer Lognormalverteilung) 

Syntax: 

LOGINV(Wahrscheinlichkeit; Mittelwert; Standardabweichung) 

Beschreibung: 

Liefert Quantile einer logarithmischen Normalverteilung („Lognormalverteilung“). 

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der Lognormalvertei-

lung. Zulässig sind nur Werte aus dem Intervall [0..1]. 

Mittelwert ist der Mittelwert von LN(x). 

Standardabweichung ist die Standardabweichung von LN(x). Diese muss größer 

als Null sein. 

Siehe auch: 

LN, LOGNORMVERT 

LOGNORMVERT (Logarithmische Normalverteilung) 

Syntax: 

LOGNORMVERT(x; E; S) 

Beschreibung: 

Liefert die Wahrscheinlichkeiten einer logarithmisch normalverteilten Zufallsvari-

ablen. 

Sie können mit dieser Funktion Wahrscheinlichkeitsverteilungen betrachten, bei 

denen nicht die Zufallsvariable selbst, sondern ihr natürlicher Logarithmus nor-

malverteilt ist. 

x ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. x muss größer als 

Null sein. 
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Für E ist der Erwartungswert  (My) der Verteilung anzugeben. 

Für S ist die Standardabweichung  (Sigma) der Verteilung anzugeben. S muss 

größer als Null sein. 

Anmerkung: 

Geliefert wird die Verteilungsfunktion (also die integrierte Dichtefunktion). 

Siehe auch: 

LN, LOGINV, NORMVERT, STANDNORMVERT 

MAX (Maximalwert) 

Syntax: 

MAX(Zahl1 [; Zahl2; Zahl3 ...]) 

Beschreibung: 

Liefert den größten Wert innerhalb der angegebenen Zahlen. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte. 

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder 

Wahrheitswerte enthalten, so werden diese ignoriert. 

Beispiel: 

MAX(5; 7; 4; 9) ergibt 9 

Wenn die Zellen A1 bis A3 mit den Werten -1, -2 und WAHR gefüllt sind, so gilt: 

MAX(A1:A3) ergibt -1 (der Wahrheitswert WAHR wird ignoriert) 

Siehe auch: 

MAXA, MIN, KGRÖSSTE 
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MAXA (Maximalwert) 

Syntax: 

MAXA(Zahl1 [; Zahl2; Zahl3 ...]) 

Beschreibung: 

Die Funktion MAXA entspricht nahezu der Funktion MAX (siehe Hinweis). Sie 

liefert also den größten Wert innerhalb der angegebenen Zahlen. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte. 

Hinweis: 

Im Gegensatz zu MAX berücksichtigt die Funktion MAXA auch Werte, die keine 

Zahlen sind: Beliebige Zeichenketten und der Wahrheitswert FALSCH werden als 

0 interpretiert, WAHR als 1. 

Leere Zellen werden hingegen auch hier ignoriert. 

Beispiel: 

MAXA(5; 7; 4; 9) ergibt 9 

Wenn die Zellen A1 bis A3 mit den Werten -1, -2 und WAHR gefüllt sind, so gilt: 

MAXA(A1:A3) ergibt 1 (denn WAHR = 1) 

MAX(A1:A3) ergibt hingegen -1 (denn der Wahrheitswert WAHR wird bei der 

Funktion MAX ignoriert) 

Siehe auch: 

MAX 
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MDET (Determinante einer Matrix) 

Syntax: 

MDET(Matrix) 

Beschreibung: 

Liefert die Determinante einer quadratischen Matrix. 

Matrix kann eine Matrix oder ein entsprechender Zellbezug sein. Matrix muss 

numerische Werte enthalten und quadratisch sein, also die gleiche Anzahl an Zeilen 

und Spalten besitzen. 

Beispiel: 

MDET({9.8.8; 2.4.6; 1.2.1}) ergibt -40 

Siehe auch: 

Abschnitt „Arbeiten mit Matrizen“ ab Seite 516, MINV, MMULT, MSOLVE, 

MTRANS 

MEDIAN (Median) 

Syntax: 

MEDIAN(Zahl1 [; Zahl2; Zahl3 ...]) 

Beschreibung: 

Liefert den Median der angegebenen Zahlen. 

Der Median ist die Zahl, die in der Mitte einer Reihe von Zahlen liegt. Die Hälfte 

dieser Zahlen hat also Werte, die kleiner sind als der Median, die andere Hälfte 

Werte, die größer sind. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte. 
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Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder 

Wahrheitswerte enthalten, so werden diese ignoriert. 

Beachten Sie: 

Ist eine ungerade Anzahl an Werten gegeben, liefert MEDIAN die Zahl in der Mit-

te. 

Ist eine ungerade Anzahl an Werten gegeben, liefert MEDIAN den Mittelwert der 

beiden in der Mitte liegenden Zahlen (siehe zweites Beispiel). 

Beispiel: 

MEDIAN(1; 2; 3; 4; 5) ergibt 3 

MEDIAN(1; 2; 3; 4; 5; 1000) ergibt 3,5 

Siehe auch: 

MITTELWERT, MODALWERT, QUANTIL 

MILLISEKUNDEN (Millisekunden aus einem Datumswert 

ermitteln) 

Syntax: 

MILLISEKUNDEN(Uhrzeit) 

Beschreibung: 

Liefert den Millisekundenanteil aus einem Datumswert. 

Kompatibilitätshinweise: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 
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Beispiel: 

MILLISEKUNDEN("12:34:56,555") ergibt 555 

MILLISEKUNDEN("25.09.2018 12:34:56,555") ergibt 555 

Siehe auch: 

STUNDE, MINUTE, SEKUNDE 

MIN (Minimalwert) 

Syntax: 

MIN(Zahl1 [; Zahl2; Zahl3 ...]) 

Beschreibung: 

Liefert den kleinsten Wert innerhalb der angegebenen Zahlen. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte. 

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder 

Wahrheitswerte enthalten, so werden diese ignoriert. 

Beispiel: 

MIN(5; 7; 4; 9) ergibt 4 

Wenn die Zellen A1 bis A3 mit den Werten 5, 2 und WAHR gefüllt sind, so gilt: 

MIN(A1:A3) ergibt 2 (der Wahrheitswert WAHR wird ignoriert) 

Siehe auch: 

MINA, MAX, KKLEINSTE 
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MINA (Minimalwert) 

Syntax: 

MINA(Zahl1 [; Zahl2; Zahl3 ...]) 

Beschreibung: 

Die Funktion MINA entspricht nahezu der Funktion MIN (siehe Hinweis). Sie 

liefert also den kleinsten Wert innerhalb der angegebenen Zahlen. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte. 

Hinweis: 

Im Gegensatz zu MIN berücksichtigt die Funktion MINA auch Werte, die keine 

Zahlen sind: Beliebige Zeichenketten und der Wahrheitswert FALSCH werden als 

0 interpretiert, WAHR als 1. 

Leere Zellen werden hingegen auch hier ignoriert. 

Beispiel: 

MINA(5; 7; 4; 9) ergibt 4 

Wenn die Zellen A1 bis A3 mit den Werten 5, 2 und WAHR gefüllt sind, so gilt: 

MINA(A1:A3) ergibt 1 (denn WAHR = 1)  

MIN(A1:A3) ergibt hingegen 2 (denn der Wahrheitswert WAHR wird hier igno-

riert) 

Siehe auch: 

MIN 
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MINUTE (Minute aus einem Datumswert ermitteln) 

Syntax: 

MINUTE(Uhrzeit) 

Beschreibung: 

Liefert den Minutenanteil aus einem Datumswert. 

Beispiel: 

MINUTE("12:34:56") ergibt 34 

MINUTE("25.09.2018 10:30:56") ergibt 30 

Siehe auch: 

STUNDE, SEKUNDE, MILLISEKUNDEN 

MINV (Inverse einer Matrix) 

Syntax: 

MINV(Matrix) 

Beschreibung: 

Liefert die Inverse einer quadratischen Matrix.  

Die Inverse A-1 einer Matrix A ist die Matrix, mit der A multipliziert werden muss, 

um die Einheitsmatrix 1 zu erhalten. 

Matrix kann eine Matrix oder ein entsprechender Zellbezug sein. Matrix muss 

numerische Werte enthalten und quadratisch sein, also die gleiche Anzahl an Zeilen 

und Spalten besitzen. 
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Anmerkung: 

Singuläre Matrizen (Matrizen, deren Determinante Null ist) haben keine Inverse. 

Hier liefert MINV den Fehlerwert #ZAHL. 

Hinweis: 

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu fin-

den Sie im Abschnitt „Arbeiten mit Matrizen“ ab Seite 516. 

Beispiel: 

MINV({9.8.8;2.4.6;1.2.1}) ergibt: 

{0,2.-0,2.-0,4;-0,1.-0,025.0,95;0.0,25.-0,5} 

Siehe auch: 

Abschnitt „Arbeiten mit Matrizen“ ab Seite 516, MDET, MMULT, MSOLVE, 

MTRANS 

MITTELABW (Mittlere Abweichung vom Mittelwert) 

Syntax: 

MITTELABW(Zahl1 [; Zahl2; Zahl3 ...]) 

Beschreibung: 

Berechnet die durchschnittliche Abweichung der angegebenen Zahlen von ihrem 

Mittelwert. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte. 

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder 

Wahrheitswerte enthalten, so werden diese ignoriert. 

Beispiel: 

MITTELABW(2; 2; 2; 2) ergibt 0 
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MITTELABW(2; 2; 2; 3) ergibt 0,375 

Siehe auch: 

SUMQUADABW, STABW, VARIANZ 

MITTELWERT (Arithmetisches Mittel) 

Syntax: 

MITTELWERT(Zahl1 [; Zahl2; Zahl3 ...]) 

Beschreibung: 

Liefert das einfache arithmetische Mittel der übergebenen Zahlen.  

Dieses wird durch Teilen der Summe der Einzelwerte durch deren Anzahl berech-

net. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte. 

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder 

Wahrheitswerte enthalten, so werden diese ignoriert. 

Beispiel: 

MITTELWERT(1; 2; 6) entspricht (1+2+6) / 3, ergibt also 3 

Wenn die Zellen A1 bis A4 die Werte 0, 1, 2 und den Wahrheitswert WAHR enthal-

ten, so gilt: 

MITTELWERT(A1:A4) entspricht (0+1+2) / 3, ergibt also 1. Die Zelle mit dem 

Wahrheitswert wird hierbei nicht berücksichtigt – auch nicht beim Ermitteln der 

Anzahl der Werte. 

Siehe auch: 

MITTELWERTA, GEOMITTEL, HARMITTEL 
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MITTELWERTA (Arithmetisches Mittel) 

Syntax: 

MITTELWERTA(Zahl1 [; Zahl2; Zahl3 ...]) 

Beschreibung: 

Die Funktion MITTELWERTA entspricht nahezu der Funktion MITTELWERT 

(siehe Hinweis). Sie liefert also das arithmetische Mittel der übergebenen Zahlen.  

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte. 

Hinweis: 

Im Gegensatz zu MITTELWERT berücksichtigt die Funktion MITTELWERTA 

auch Werte, die keine Zahlen sind: Beliebige Zeichenketten und der Wahrheitswert 

FALSCH werden als 0 interpretiert, WAHR als 1. 

Leere Zellen werden hingegen auch hier ignoriert. 

Beispiel: 

MITTELWERTA(1; 2; 6) entspricht (1+2+6) / 3, ergibt also 3 

Wenn die Zellen A1 bis A4 die Werte 0, 1, 4 und den Wahrheitswert WAHR enthal-

ten, so gilt: 

MITTELWERTA(A1:A4) entspricht (0+1+4+1) / 4, ergibt also 1,5. Der Wahr-

heitswert WAHR wird hier als 1 interpretiert. 

Zum Vergleich: 

MITTELWERT(A1:A4) entspricht (0+1+4) / 3, ergibt also etwa 1,66667. Der 

Wahrheitswert wird hier ignoriert. 

Siehe auch: 

MITTELWERT 
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MITTELWERTWENN (Mittelwert ausgewählter Werte) 

Syntax: 

MITTELWERTWENN(Suchbereich; Suchkriterium [; Mittelwertbereich]) 

Beschreibung: 

Liefert den Mittelwert (einfaches arithmetisches Mittel) derjenigen Werte in einem 

Bereich, für die die angegebene Bedingung zutrifft.  

Suchbereich ist der zu durchsuchende Bereich. 

Suchkriterium ist die zu erfüllende Bedingung: 

Hier können Sie einerseits einfach einen Wert angeben (zum Beispiel "42" oder 

"Schrauben"). In diesem Fall wird der Mittelwert aller Posten geliefert, die diesem 

Wert entsprechen. 

Andererseits ist auch eine Bedingung wie ">10" oder "<=5" zulässig. Hier wird der 

Mittelwert aller Posten geliefert, die dieser Bedingung entsprechen. 

Hinweis: Das Suchkriterium sollte stets mit doppelten Anführungszeichen (") um-

geben werden. 

Das optionale Argument Mittelwertbereich bestimmt, das Mittel welcher Werte 

geliefert werden soll. Wenn Mittelwertbereich nicht angegeben ist, werden die 

Werte im Suchbereich verwendet. 

Kompatibilitätshinweise: 

Diese Funktion ist nicht kompatibel zum .xls-Dateiformat von Microsoft Excel 

2003 und früher. Wenn Sie ein Dokument in diesem Format speichern, werden alle 

Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester 

Wert ersetzt.  

Wenn Sie diese Funktion einsetzen möchten, sollten Sie Ihr Dokument also nicht 

im Dateiformat „Microsoft Excel 97-2003 (.xls)“ speichern, sondern eines der fol-

genden Formate verwenden: 

 „PlanMaker-Dokument (.pmdx oder .pmd)“ 

 oder: „Microsoft Excel 2007-2016 (.xlsx)“ 
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Beispiel: 

In den Zellen A1 bis A5 stehen die Werte 1; 2; 3; 2; 1. Hier gilt: 

MITTELWERTWENN(A1:A5; "2") ergibt 2 

MITTELWERTWENN(A1:A5; ">=2") ergibt (2+3+2)/3, also 2,33333 

Siehe auch: 

MITTELWERT, MITTELWERTWENNS, SUMMEWENN, SUMMEWENNS, 

ZÄHLENWENN, ZÄHLENWENNS 

MITTELWERTWENNS (Mittelwert ausgewählter Werte) 

Syntax: 

MITTELWERTWENNS(Mittelwertbereich; Suchbereich1; Suchkriterium1 [; 

Suchbereich2; Suchkriterium2 ...]) 

Beschreibung: 

Liefert den Mittelwert (einfaches arithmetisches Mittel) derjenigen Werte in einem 

Bereich, für die alle angegebenen Bedingungen zutreffen.  

Entspricht der Funktion MITTELWERTWENN, erlaubt allerdings die Verwendung 

mehrerer Suchbereiche (inklusive eines Suchkriteriums für jeden Bereich). 

Beachten Sie: Die Reihenfolge der Parameter ist hier anders als bei MITTEL-

WERTWENN: Bei MITTELWERTWENNS ist der Mittelwertbereich der erste 

Parameter und nicht der letzte.  

Mittelwertbereich ist der Bereich mit den Werten, deren Mittelwert berechnet 

werden soll.  

Suchbereich1 ist der erste zu durchsuchende Bereich. Dieser muss die gleichen 

Ausmaße haben wie der Mittelwertbereich. 

Suchkriterium1 ist die Bedingung, die die Werte in Suchbereich1 erfüllen müs-

sen: 
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Hier können Sie einerseits einfach einen Wert angeben (zum Beispiel "42" oder 

"Schrauben"). In diesem Fall wird der Mittelwert aller Posten geliefert, die diesem 

Wert entsprechen. 

Andererseits ist auch eine Bedingung wie ">10" oder "<=5" zulässig. Hier wird der 

Mittelwert aller Posten geliefert, die dieser Bedingung entsprechen. 

Hinweis: Die Suchkriterien sollten stets mit doppelten Anführungszeichen (") um-

geben werden. 

Im Gegensatz zur Funktion MITTELWERTWENN können Sie bei MITTEL-

WERTWENNS auch mehrere Suchbereiche mit jeweils dazugehörendem Suchkri-

terium angeben. Es werden dann nur diejenigen Werte in die Berechnung einbezo-

gen, bei denen alle Kriterien erfüllt sind. 

Kompatibilitätshinweise: 

Diese Funktion ist nicht kompatibel zum .xls-Dateiformat von Microsoft Excel 

2003 und früher. Wenn Sie ein Dokument in diesem Format speichern, werden alle 

Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester 

Wert ersetzt.  

Wenn Sie diese Funktion einsetzen möchten, sollten Sie Ihr Dokument also nicht 

im Dateiformat „Microsoft Excel 97-2003 (.xls)“ speichern, sondern eines der fol-

genden Formate verwenden: 

 „PlanMaker-Dokument (.pmdx oder .pmd)“ 

 oder: „Microsoft Excel 2007-2016 (.xlsx)“ 

Beispiel: 

MITTELWERTWENNS(A1:A10; C1:C10; ">1"; C1:C10; "<2")  

Diese Formel liefert den Mittelwert all derjenigen Zellen im Bereich A1:A10, bei 

denen die entsprechende Zelle im Bereich C1:C10 größer als 1 und kleiner als 2 

ist. 

Siehe auch: 

MITTELWERT, MITTELWERTWENN, SUMMEWENN, SUMMEWENNS, 

ZÄHLENWENN, ZÄHLENWENNS 
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MMULT (Multiplikation zweier Matrizen) 

Syntax: 

MMULT(Matrix1; Matrix2) 

Beschreibung: 

Liefert das Produkt zweier Matrizen. 

Matrix1 und Matrix2 können Matrizen oder entsprechende Zellbezüge sein. Beide 

Matrizen müssen numerische Werte enthalten.  

Beachten Sie: Die Spaltenzahl von Matrix1 muss mit der Zeilenzahl von Matrix2 

übereinstimmen; andernfalls ist eine Multiplikation nicht möglich. 

Hinweis: 

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu fin-

den Sie im Abschnitt „Arbeiten mit Matrizen“ ab Seite 516. 

Beispiel: 

MMULT({1.2;3.4}; {5.6;7.8}) ergibt {19.22;43.50} 

Siehe auch: 

Abschnitt „Arbeiten mit Matrizen“ ab Seite 516, MDET, MINV, MSOLVE, 

MTRANS 

MODALWERT (Häufigster Wert) 

Syntax: 

MODALWERT(Zahl1 [; Zahl2; Zahl3 ...]) 
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Beschreibung: 

Ermittelt den häufigsten Wert (auch Modalwert oder dichtester Wert genannt) in-

nerhalb der angegebenen Zahlenwerte. 

Bei der Dichtefunktion einer Wahrscheinlichkeitsverteilung entspricht der Modal-

wert dem „Gipfel“ des Graphen. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte. 

Wenn die Werte mehrere Modalwerte enthalten, wird der kleinste Modalwert gelie-

fert. 

Enthalten die Werte keinen mehrfach vorkommenden Wert, liefert die Funktion den 

Fehlerwert #NV. 

Beispiel: 

MODALWERT(1; 2; 4; 4; 4; 2; 1) ergibt 4 

MODALWERT(1; 2; 4; 4; 2; 1) ergibt 1 (hier wird der kleinste der drei Modalwer-

te geliefert) 

MODALWERT(1; 4; 2) ergibt #NV, da kein Wert mehr als ein Mal vorkommt. 

Siehe auch: 

MEDIAN, NORMVERT 

MONAT (Monat aus einem Datumswert ermitteln) 

Syntax: 

MONAT(Datum) 

Beschreibung: 

Liefert die Monatszahl eines Datumswerts. 
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Beispiel: 

MONAT("25.9.2018") ergibt 9 

MONAT("17. August") ergibt 8 

Siehe auch: 

ISOKALENDERWOCHE, JAHR, TAG, WOCHENTAG 

MONATSENDE (Monatsende in/vor n Monaten) 

Syntax: 

MONATSENDE(Ausgangsdatum; m) 

Beschreibung: 

Liefert das Monatsende, das m Monate vor/nach dem Ausgangsdatum liegt.  

Das Argument Ausgangsdatum muss ein gültiger Datumswert sein, andernfalls 

liefert die Funktion den Fehlerwert #WERT!. 

Mit dem Argument m geben Sie die Zahl der Monate an. 

Wenn m Null ist, wird das Monatsende des gleichen Monats ermittelt. 

Wenn m positiv ist, wird das Monatsende berechnet, das m Monate hinter dem 

Ausgangsdatum liegt. 

Wenn m negativ ist, erhalten Sie das Monatsende, das m Monate vor dem Aus-

gangsdatum liegt. 

m sollte eine ganze Zahl sein. Ist dies nicht der Fall, entfernt PlanMaker die Nach-

kommastellen automatisch. 

Beispiel: 

MONATSENDE("25.09.2018"; 0) ergibt den 30.09.2018 

MONATSENDE("25.09.2018"; 1) ergibt den 31.10.2018 

MONATSENDE("25.09.2018"; -1) ergibt den 31.08.2018 
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Siehe auch: 

EDATUM 

MSOLVE (Lösung eines linearen Gleichungssystems) 

Syntax: 

MSOLVE(A_Matrix; B_Vektor) 

Beschreibung: 

Liefert die Lösung eines linearen Gleichungssystem Ax=B. 

A_Matrix ist die Matrix A. Sie können hierfür eine Matrix oder einen entspre-

chenden Zellbezug angeben. A_Matrix muss numerische Werte enthalten und 

quadratisch sein, also die gleiche Anzahl an Zeilen und Spalten besitzen.  

Weiterhin darf die Determinante dieser Matrix nicht Null sein, da diese Funktion 

sonst keine oder unendlich viele Lösungen liefern würde. 

B_Vektor ist der Vektor B. Auch hierfür können Sie einen Zellbereich oder eine 

Matrix angeben. Es muss sich dabei um einen Vektor (also einen eindimensionalen 

Bereich) handeln, was bedeutet, dass B_Vektor entweder nur eine Zeile oder nur 

eine Spalte umfassen darf. 

Das Ergebnis dieser Funktion ist ein Vektor mit den Lösungen. 

Kompatibilitätshinweise: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Anmerkung: 

Die Lösung wird bei dieser Funktion mit der Methode der Singulärwertzerlegung 

ermittelt. Bei größeren Matrizen (mehr als 10-20 Zeilen) kann es hierbei unter Um-

ständen zu signifikanten Rundungsfehlern kommen. 
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Hinweis: 

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu fin-

den Sie im Abschnitt „Arbeiten mit Matrizen“ ab Seite 516.  

Beispiel: 

Sie möchten folgendes lineares Gleichungssystem lösen: 

2x + 3y = 4 

2x + 2y = 8 

Dazu würden Sie folgende Formel formulieren: 

MSOLVE({2.3;2.2};{4;8}) 

Als Ergebnis wird der Vektor {8;-4} geliefert. x ist also 8, y ist -4. 

Siehe auch: 

Abschnitt „Arbeiten mit Matrizen“ ab Seite 516, MDET, MINV, MMULT, 

MTRANS 

MTRANS (Transponieren einer Matrix) 

Syntax: 

MTRANS(Matrix) 

Beschreibung: 

Transponiert die übergebene Matrix, vertauscht also die Zeilen mit den Spalten. 

Wenn Sie beispielsweise eine 2x4-Matrix transponieren, erhalten Sie eine 4x2-

Matrix. 

Matrix kann eine Matrix oder ein entsprechender Zellbezug sein. 

Hinweis: 

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu fin-

den Sie im Abschnitt „Arbeiten mit Matrizen“ ab Seite 516.  
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Beachten Sie dabei insbesondere, dass der vor der Eingabe der Formel zu markie-

rende Bereich die korrekten Ausmaße haben muss. Wenn die Matrix aus x Spalten 

und y Zeilen besteht, muss dieser Bereich y Spalten und x Zeilen umfassen. 

Beispiel: 

MTRANS({1.2.3;4.5.6}) ergibt {1.4;2.5;3.6} 

Siehe auch: 

Abschnitt „Arbeiten mit Matrizen“ ab Seite 516, MDET, MINV, MMULT, MSOL-

VE 

N (Wert in Zahl umwandeln) 

Syntax: 

N(Wert) 

Beschreibung: 

Wandelt den übergebenen Wert in eine Zahl. 

Der übergebene Wert muss eine Zahl, ein Datumswert oder ein Wahrheitswert sein, 

andernfalls liefert N den Wert Null zurück.  

Hinweis: 

Diese Funktion ist nur aus Gründen der Kompatibilität mit älteren Tabellenkalkula-

tionen noch vorhanden. PlanMaker selbst benötigt sie nicht mehr, da er Werte bei 

Bedarf automatisch in Zahlen umwandelt. 

Beispiel: 

N("Text") ergibt 0 

N("42") ergibt 0 

N(42) ergibt 42 
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N(WAHR) ergibt 1 

Steht in Zelle A1 das Datum 25.09.2014, so gilt: 

N(A1) ergibt 41907, die serielle Datumszahl für dieses Datum 

Siehe auch: 

T, WERT, TEXT 

NACHKOMMA (Nachkommastellen einer Zahl) 

Syntax: 

NACHKOMMA(Zahl) 

Beschreibung: 

Liefert den Nachkommaanteil der angegebenen Zahl. 

Kompatibilitätshinweise: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

NACHKOMMA(5,779) ergibt 0,779 

Siehe auch: 

KÜRZEN 

Anmerkung: 

Die Vorkommastellen erhalten Sie mit der Funktion KÜRZEN. 
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NBW (Nettobarwert) 

Syntax: 

NBW(Zins; Zahlung1 [; Zahlung2; Zahlung3 ...]) 

Beschreibung: 

Liefert den Nettobarwert (Kapitalwert) einer Investition, basierend auf einer Inves-

tition mit regelmäßigen Zahlungen und feststehendem Zins. 

Die Funktion erwartet folgende Argumente: 

Zins ist der Zinssatz für die Dauer einer Periode. 

Zahlung1, Zahlung2 etc. sind die Zahlungsvorgänge. Sie können entweder ein-

zelne Werte oder ganze Zellbereiche mit Werten angeben. Wichtig: Die Zahlungen 

müssen jeweils an Ende einer Periode erfolgen.  

Die Zahlungen können unterschiedlich groß sein und aus Einzahlungen (positive 

Werte) und Auszahlungen (negative Werte) bestehen. Sie müssen jedoch in gleich-

bleibenden Zeitabständen (jeweils am Ende einer Periode) erfolgen und in genau 

der Reihenfolge eingetragen werden, in der sie tatsächlich erfolgt sind.  

Ausgelassene Zahlungen müssen mit 0 (Null) eingetragen werden. 

Die Unterschiede zur Funktion BW: 

1. Bei NBW sind unterschiedlich große Zahlungen möglich, bei BW nur gleich-

bleibende. 

2. Bei NBW müssen Zahlungen stets am Ende der Periode erfolgen, bei BW kön-

nen sie auch am Beginn der Periode erfolgen. 

Beispiel: 

NBW(6,5%; 4000; 5000) ergibt 8164,16 

Siehe auch: 

BW, XKAPITALWERT 
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NEG (Negativer Wert einer Zahl) 

Syntax: 

NEG(Zahl) 

Beschreibung: 

Kehrt das Vorzeichen einer Zahl um.  

Kompatibilitätshinweise: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Als Alternative können Sie einfach die Multiplikation mit dem Wert -1 verwenden. 

NEG(x) entspricht (-1) * x. 

Beispiel: 

NEG(42) ergibt -42 

NEG(-42) ergibt 42 

NEG(0) ergibt 0 

Siehe auch: 

ABS, VORZEICHEN 

NEGBINOMVERT (Negative Binomialverteilung) 

Syntax: 

NEGBINOMVERT(k; r; p) 



 

Handbuch PlanMaker Formeln und Funktionen  •  693 

Beschreibung: 

Liefert die Wahrscheinlichkeiten einer negativ-binomialverteilten Zufallsvariablen. 

Die negative Binomialverteilung (auch Pascal-Verteilung genannt) liefert die 

Wahrscheinlichkeit für das Erhalten von k Fehlschlägen vor dem r-ten Treffer bei 

einem Zufallsexperiment mit voneinander unabhängigen Wiederholungen und nur 

zwei möglichen Ergebnissen (Treffer oder Fehlschlag), wobei die Wahrscheinlich-

keit für einen Treffer pro Wiederholung p beträgt. 

k ist die Anzahl an Misserfolgen. 

r ist die Anzahl an Treffern. 

k und r sollten ganze Zahlen sein. Ist das nicht der Fall, kürzt PlanMaker die 

Nachkommastellen automatisch weg. 

p ist die Trefferwahrscheinlichkeit pro Wiederholung. 

Beispiel: 

In einer Urne befinden sich 1 rote und 5 schwarze Kugeln. Wie groß ist die Wahr-

scheinlichkeit, mit Zurücklegen 10 schwarze Kugeln (=Misserfolge) zu ziehen, 

bevor die 2-te rote Kugel (=Erfolg) gezogen wird? 

NEGBINOMVERT(10; 2; 1/6) ergibt 0,04935. 

Siehe auch: 

BINOMVERT 

NETTOARBEITSTAGE (Zahl der Arbeitstage) 

Syntax: 

NETTOARBEITSTAGE(Ausgangsdatum; Enddatum [; FreieTage]) 

Beschreibung: 

Ermittelt die Zahl der Arbeitstage zwischen Ausgangsdatum und Enddatum. 
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Samstage und Sonntage werden dabei übersprungen. Weiterhin kann der Funktion 

optional eine Liste mit freien Tagen (z.B. Feiertagen) übergeben werden. Diese 

werden dann ebenfalls übersprungen. 

Ausgangsdatum und Enddatum sind der erste beziehungsweise der letzte Tag des 

zu betrachtenden Zeitintervalls. 

Für FreieTage kann optional eine Liste mit freien Tagen angegeben werden. (Hier-

für verwendet man üblicherweise einen Zellbereich oder eine Matrix, die die ent-

sprechenden Datumswerte enthält.) 

Beispiel: 

NETTOARBEITSTAGE("1.1.2010"; "31.1.2010") ergibt 22.  

Der Januar 2010 hatte also 22 Arbeitstage (ohne Berücksichtigung der Feiertage). 

Möchte man dabei die Feiertage am 1.1.2010 und am 6.1.2010 berücksichtigen, 

kann man diese beiden Daten beispielsweise in die Zellen A1 und A2 eintragen und 

dann schreiben: 

NETTOARBEITSTAGE("1.1.2010"; "31.1.2010"; A1:A2)  

Das Ergebnis ist 20, da diese Feiertage im Jahr 2010 beide auf Wochentage fielen, 

also 2 Tage abzuziehen sind. 

Siehe auch: 

ARBEITSTAG, TAGE 

NICHT (Logisches NICHT) 

Syntax: 

NICHT(Wahrheitswert) 

Beschreibung: 

Kehrt den übergebenen Wahrheitswert um. WAHR wird zu FALSCH und FALSCH 

wird zu WAHR. 
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Beispiel: 

NICHT(WAHR) ergibt FALSCH 

NICHT(A1=0) ergibt WAHR, wenn der Inhalt der Zelle A1 verschieden von Null 

ist. 

Siehe auch: 

ODER, UND, XODER 

NOMINAL (Nominalverzinsung) 

Syntax: 

NOMINAL(EffZins; Zinsgutschriften) 

Beschreibung: 

Ermittelt den nominalen Jahreszins, ausgehend vom effektiven Jahreszins und der 

Zahl der Zinsgutschriften pro Jahr. 

EffZins ist der effektive Jahreszins. 

Zinsgutschriften ist die Zahl der Zinsgutschriften pro Jahr (muss mindestens 1 

sein). 

Beispiel: 

Eine Geldanlage bietet 5% effektiven Jahreszins, Zinsen werden 4x pro Jahr gutge-

schrieben. Wie hoch liegt der nominale Jahreszins? 

NOMINAL(5%; 4) ergibt ca. 4,91% 

Siehe auch: 

EFFEKTIV 
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NORMINV (Quantile einer Normalverteilung) 

Syntax: 

NORMINV(Wahrscheinlichkeit; Mittelwert; Standardabweichung) 

Beschreibung: 

Liefert Quantile einer Normalverteilung.  

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der Verteilung. Zu-

lässig sind nur Werte aus dem Intervall [0..1]. 

Mittelwert ist der Mittelwert der Verteilung. 

Standardabweichung ist die Standardabweichung der Verteilung. Diese muss grö-

ßer als Null sein. 

Hinweis: 

Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. 

Findet PlanMaker nach 100 Iterationen kein Ergebnis, das weniger als 3x10^-7 

von Wahrscheinlichkeit abweicht, zeigt er den Fehlerwert #NV an und bricht die 

Näherung ab. 

Siehe auch: 

NORMVERT 

NORMVERT (Normalverteilung) 

Syntax: 

NORMVERT(x; E; S; Kumuliert) 

Beschreibung: 

Liefert die Wahrscheinlichkeiten einer normalverteilten Zufallsvariablen. 
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Die Normalverteilung (auch Gauß-Verteilung oder Gaußsche Glockenkurve ge-

nannt) ist in der Wahrscheinlichkeitsrechnung von großer Bedeutung, da viele Zu-

fallsvariablen normalverteilt oder zumindest annähernd normalverteilt sind. 

x ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. 

Für E ist der Erwartungswert  (My) der Verteilung anzugeben. 

Für S ist die Standardabweichung  (Sigma) der Verteilung anzugeben. 

Mit dem Wahrheitswert Kumuliert bestimmen Sie, welche Funktion geliefert wer-

den soll: 

FALSCH: Es wird die Dichtefunktion (also die Gaußsche Glockenkurve) geliefert. 

WAHR: Es wird die Verteilungsfunktion (also die integrierte Dichtefunktion) gelie-

fert. 

      

Dichtefunktion (links) und Verteilungsfunktion (rechts) 

Siehe auch: 

NORMINV, STANDNORMVERT  

NOTIERUNGBRU (Geldbetrag in Dezimalbruch wandeln) 

Syntax: 

NOTIERUNGBRU(Zahl; Teiler) 

Beschreibung: 

Wandelt einen Geldbetrag, der als Dezimalzahl ausgedrückt ist, in einen Dezimal-

bruch um. 
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(In den USA ist es bei manchen Arten von Geldgeschäften üblich, Geldbeträge als 

Bruchzahlen darzustellen – zum Beispiel 27 4/8 statt 27,50.) 

Zahl ist die umzuwandelnde Zahl. 

Teiler ist der gewünschte Teiler. Er muss größer gleich 1 sein. Weiterhin sollte Tei-

ler eine ganze Zahl sein. Ist dies nicht der Fall, entfernt PlanMaker automatisch 

alle Nachkommastellen. 

Beispiel: 

NOTIERUNGBRU(27,5; 8) ergibt 27,4 (da 27,5 dem Bruch 27 4/8 entspricht) 

Siehe auch: 

NOTIERUNGDEZ 

NOTIERUNGDEZ (Geldbetrag in Dezimalzahl wandeln) 

Syntax: 

NOTIERUNGDEZ(Zahl; Teiler) 

Beschreibung: 

Wandelt einen Geldbetrag, der als Dezimalbruch ausgedrückt ist, in eine Dezimal-

zahl um. 

(In den USA ist es bei manchen Arten von Geldgeschäften üblich, Geldbeträge als 

Bruchzahlen darzustellen – zum Beispiel 27 4/8 statt 27,50.) 

Zahl ist die umzuwandelnde Zahl. 

Teiler ist der verwendete Teiler. Er muss größer gleich 1 sein. Weiterhin sollte Tei-

ler eine ganze Zahl sein. Ist dies nicht der Fall, entfernt PlanMaker automatisch 

alle Nachkommastellen. 

Beispiel: 

NOTIERUNGDEZ(27,4; 8) wandelt die Bruchzahl 27 4/8 in die Dezimalzahl 27,5 

um. 
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Siehe auch: 

NOTIERUNGBRU 

NV (Nicht vorhanden) 

Syntax: 

NV() 

Beschreibung: 

Liefert den Fehlerwert #NV („nicht vorhanden“). 

Mit Hilfe dieser Funktion können Sie leere Zellen, die erst später ausgefüllt werden 

sollen, als noch nicht vorhanden kennzeichnen. Alle Berechnungen, die sich auf 

eine solche Zelle beziehen, haben stets den Fehlerwert #NV als Ergebnis. 

Auf diese Weise können Sie verhindern, dass Berechnungen mit leeren Zellen 

durchgeführt werden, obwohl diese Zellen zwingend mit Werten gefüllt sein müss-

ten, damit ein korrektes Ergebnis geliefert werden kann.  

Anmerkung: 

Statt =NV() können Sie auch #NV in die Zelle eingeben, was das gleiche Resultat 

liefert. 

Beispiel: 

Sie möchten Ihren Jahresumsatz anhand der Summe der vier Quartalsergebnisse 

berechnen. Diese werden in die Zellen A1 bis A4 eingetragen; der Jahresumsatz 

ließe sich also mit der Formel SUMME(A1:A4) berechnen. 

Es gibt nur ein Problem: Das Ergebnis für das vierte Quartal liegt noch nicht vor; 

die Zelle A4 ist also leer. Der Jahresumsatz darf also noch nicht ausgerechnet wer-

den. 

PlanMaker berechnet jedoch stur die Summe von A1 bis A4 – auch dann, wenn 

einer der Werte fehlt. Ergebnis: ein scheinbar miserables Jahresergebnis, schreiend 

davonlaufende Aktionäre. 
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Wesentlich gesünder ist es, die Zelle A4 nicht einfach leer zu lassen, sondern dort 

NV() einzutragen. Damit kennzeichnen Sie die Zelle als noch „nicht vorhanden“. 

Das bewirkt, dass die Summenformel jetzt als Ergebnis keinen falschen Zahlenwert 

mehr hat, sondern den Fehlerwert #NV. Das signalisiert, dass eines der Quartalser-

gebnisse noch nicht vorhanden ist, der Jahresumsatz also noch nicht berechnet 

werden kann. Ergebnis: keine schreiend davonlaufenden Aktionäre. 

Siehe auch: 

ISTNV, ISTFEHL, ISTFEHLER, FEHLER.TYP, Abschnitt über „Fehlerwerte“ ab 

Seite 515 

OBERGRENZE (Aufrunden auf ein Vielfaches von n) 

Syntax: 

OBERGRENZE(Zahl; Basis) 

Beschreibung: 

Rundet Zahl auf ein Vielfaches von Basis auf. 

Bei positiven Zahlen wird auf das nächstgrößere Vielfache von Basis aufgerundet, 

bei negativen Zahlen hingegen auf das nächstkleinere Vielfache abgerundet. 

Zahl und Basis müssen das gleiche Vorzeichen haben, sonst liefert die Funktion 

den Fehlerwert #ZAHL! 

Beispiel: 

OBERGRENZE(42,5; 1) ergibt 43 

OBERGRENZE(-42,5; -1) ergibt -43 

OBERGRENZE(21; 5) ergibt 25 

OBERGRENZE(12,3456; 0,01) ergibt 12,35 

Siehe auch: 

UNTERGRENZE, VRUNDEN, RUNDEN, KÜRZEN 
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ODER (Logisches ODER) 

Syntax: 

ODER(Wahrheitswert1 [; Wahrheitswert2; Wahrheitswert3 ...]) 

Beschreibung: 

Diese Funktion liefert WAHR, wenn mindestens einer der übergebenen Wahr-

heitswerte WAHR ist, ansonsten liefert sie FALSCH. 

Sie können damit beispielsweise prüfen, ob von mehreren Bedingungen mindestens 

eine zutrifft. 

Beispiel: 

ODER(WAHR; WAHR) ergibt WAHR 

ODER(WAHR; FALSCH) ergibt WAHR 

ODER(FALSCH; FALSCH) ergibt FALSCH 

ODER(A1=0; A1>10) ergibt WAHR; wenn A1 entweder Null oder größer als Zehn 

ist. 

Siehe auch: 

XODER, UND, NICHT 

OKTINBIN (Oktalzahl in Binärzahl wandeln) 

Syntax: 

OKTINBIN(Zahl [; Stellen]) 

Beschreibung: 

Wandelt eine Oktalzahl (Basis 8) in eine Binärzahl (Basis 2) um. 



 

702  •  Formeln und Funktionen Handbuch PlanMaker 

Zahl ist die umzuwandelnde Zahl. 

Negative Zahlen müssen im 32 Bit-Zweier-Komplement notiert sein (siehe letztes 

Beispiel).  

Der zulässige Wertebereich für Zahl ist (in Oktalschreibweise): 

20000000000  Zahl  17777777777 

Das entspricht in Dezimalschreibweise: 

-2.147.483.648  Zahl  2.147.483.647 

Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen 

angezeigt werden sollen. Wird es nicht angegeben, ermittelt PlanMaker die benö-

tigte Stellenzahl automatisch. 

Stellen muss größer Null sein. Weiterhin sollte Stellen eine ganze Zahl sein. Ist 

dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab. 

Wenn Stellen kleiner als die für die Darstellung der Zahl benötigte Mindestanzahl 

an Stellen ist, liefert die Funktion den Fehlerwert #ZAHL!. 

Wenn Zahl negativ ist, wird das Ergebnis im 32 Bit-Zweier-Komplement darge-

stellt; das Argument Stellen wird in diesem Fall ignoriert. 

Beispiel: 

OKTINBIN("52") ergibt 101010 

OKTINBIN("52"; 8) ergibt 00101010 

OKTINBIN("52"; 2) ergibt den Fehlerwert #ZAHL!, da diese Zahl nur mit mindes-

tens 6 Stellen dargestellt werden kann 

OKTINBIN("37777777726") ergibt 11111111111111111111111111010110 (negati-

ve Zahl) 

Siehe auch: 

BININOKT, OKTINDEZ, OKTINHEX 
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OKTINDEZ (Oktalzahl in Dezimalzahl wandeln) 

Syntax: 

OKTINDEZ(Zahl) 

Beschreibung: 

Wandelt eine Oktalzahl (Basis 8) in eine Dezimalzahl (Basis 10) um. 

Zahl ist die umzuwandelnde Zahl. 

Negative Zahlen müssen im 32 Bit-Zweier-Komplement notiert sein (siehe letztes 

Beispiel).  

Der zulässige Wertebereich für Zahl ist (in Oktalschreibweise): 

20000000000  Zahl  17777777777 

Das entspricht in Dezimalschreibweise: 

-2.147.483.648  Zahl  2.147.483.647 

Beispiel: 

OKTINDEZ("52") ergibt 42 

OKTINDEZ("0052") ergibt ebenfalls 42 

OKTINDEZ("37777777726") ergibt -42 

Siehe auch: 

DEZINOKT, OKTINBIN, OKTINHEX, DEZIMAL  

OKTINHEX (Oktalzahl in Hexadezimalzahl wandeln) 

Syntax: 

OKTINHEX(Zahl [; Stellen]) 
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Beschreibung: 

Wandelt eine Oktalzahl (Basis 8) in eine Hexadezimalzahl (Basis 16) um. 

Zahl ist die umzuwandelnde Zahl. 

Negative Zahlen müssen im 32 Bit-Zweier-Komplement notiert sein (siehe letztes 

Beispiel).  

Der zulässige Wertebereich für Zahl ist (in Oktalschreibweise): 

20000000000  Zahl  17777777777 

Das entspricht in Dezimalschreibweise: 

-2.147.483.648  Zahl  2.147.483.647 

Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen 

angezeigt werden sollen. Wird es nicht angegeben, ermittelt PlanMaker die benö-

tigte Stellenzahl automatisch. 

Stellen muss größer Null sein. Weiterhin sollte Stellen eine ganze Zahl sein. Ist 

dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab. 

Wenn Stellen kleiner als die für die Darstellung der Zahl benötigte Mindestanzahl 

an Stellen ist, liefert die Funktion den Fehlerwert #ZAHL!. 

Wenn Zahl negativ ist, wird das Ergebnis im 32 Bit-Zweier-Komplement darge-

stellt; das Argument Stellen wird in diesem Fall ignoriert. 

Beispiel: 

OKTINHEX("52") ergibt 2A 

OKTINHEX("0052") ergibt ebenfalls 2A 

OKTINHEX("52"; 1) ergibt den Fehlerwert #ZAHL!, da diese Zahl nur mit min-

destens 2 Stellen dargestellt werden kann 

OKTINHEX("37777777726") ergibt FFFFFFD6 (negative Zahl) 

Siehe auch: 

HEXINOKT, OKTINBIN, OKTINDEZ 
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PEARSON (Pearsonscher Korrelationskoeffizient) 

Syntax: 

PEARSON(Bereich1; Bereich2) 

Beschreibung: 

Berechnet den Pearsonschen Korrelationskoeffizienten r zweier Datengruppen. 

Dieser ist ein Maß für die lineare Abhängigkeit der Datengruppen. 

PEARSON kann Werte zwischen -1 und 1 annehmen. 1 bedeutet perfekte lineare 

Abhängigkeit. -1 zeigt perfekte reziproke Abhängigkeit (die Werte in Bereich2 

nehmen so ab, wie die Werte in Bereich1 zunehmen). 

Bereich1 und Bereich2 sind Zellbezüge auf die beiden Datengruppen. Diese soll-

ten Zahlen enthalten. Leere Zellen sowie Zeichenketten und Wahrheitswerte wer-

den ignoriert. 

Die beiden Datengruppen müssen die gleiche Anzahl an Werten besitzen, ansons-

ten liefert die Funktion den Fehlerwert #NV. 

Beispiel: 

Sind die Zellen A1 bis A3 mit den Werten 1, 2, 3 und die Zellen B1 bis B3 mit den 

Werten 2, 3, 4 gefüllt, so gilt: 

PEARSON(A1:A3; B1:B3) ergibt 1 

Sind die Zellen A1 bis A3 mit den Werten 1, 2, 3 und die Zellen B1 bis B3 mit den 

Werten 4, 3, 2 gefüllt, so gilt: 

PEARSON(A1:A3; B1:B3) ergibt -1 

Siehe auch: 

BESTIMMTHEITSMASS, STEIGUNG, ACHSENABSCHNITT 
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PHI (Standardnormalverteilung) 

Syntax: 

PHI(x) 

Beschreibung: 

Liefert die Dichtefunktion einer Standardnormalverteilung. 

Kompatibilitätshinweise: 

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versio-

nen ist die Funktion unbekannt. 

Wir empfehlen Ihnen daher, stattdessen die Funktion NORMVERT zu verwenden, 

da diese von allen Excel-Versionen unterstützt wird: 

PHI(x) entspricht NORMVERT(x; 0; 1; FALSCH) 

Siehe auch: 

NORMVERT, GAUSS 

PI (Kreiszahl Pi) 

Syntax: 

PI() 

Beschreibung: 

Liefert die Kreiszahl  (Pi), die das Verhältnis vom Umfang eines Kreises (2r) zu 

seinem Durchmesser (2r) angibt.  

Beispiel: 

PI() ergibt 3,14159265... 
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POISSON (Poisson-Verteilung) 

Syntax: 

POISSON(x; Lambda; Kumuliert) 

Beschreibung: 

Liefert Wahrscheinlichkeiten einer Poisson-verteilten Zufallsvariablen. 

Die Poisson-Verteilung beschreibt das Eintreffen voneinander unabhängiger, 

gleichartiger Ereignisse in einem Zeitraum (zum Beispiel das Eintreffen von Kun-

den an einem Schalter oder das Eingehen von Telefonanrufen).  

Sie eignet sich besonders für Wahrscheinlichkeitsverteilungen, bei denen sehr viele 

Ergebnisse aus einer Stichprobe vorliegen und die Wahrscheinlichkeit, dass das zu 

untersuchende Ereignis eintritt, sehr klein ist. Hier nähert sich die Poisson-

Verteilung nämlich der Binomialverteilung (mit Lambda = n*p) an. Im Gegensatz 

zur Binomialverteilung benötigt sie (abgesehen von x) jedoch nur einen Parameter: 

den Erwartungswert Lambda (siehe Beispiel). 

x ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. x muss größer als 

Null sein. Weiterhin sollte x eine ganze Zahl sein. Ist dies nicht der Fall, schneidet 

PlanMaker die Nachkommastellen automatisch ab. 

Lambda () ist der erwartete Wert (Mittelwert) für x. Lambda muss größer als 

Null sein. 

Mit dem Wahrheitswert Kumuliert bestimmen Sie, welche Funktion geliefert wer-

den soll: 

FALSCH: Es wird die Dichtefunktion geliefert. 

WAHR: Es wird die Verteilungsfunktion (also die integrierte Dichtefunktion) gelie-

fert. 

Beispiel: 

Bei einem bestimmten Reifentyp für Pkws treten bei 100.000 km Fahrt durch-

schnittlich 4 Reifenschäden auf.  

Wie groß ist die Wahrscheinlichkeit, dass nur 3 Reifenschäden auftreten? 
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Möchte man dies mit der Funktion BINOMVERT (Binomialverteilung) berechnen, 

müsste man schreiben: 

BINOMVERT(3; 100000; 4/100000; FALSCH) ergibt 0,195368768 

Verwendet man hingegen die Poisson-Verteilung, kann man auf die Parameter n 

und p verzichten und schreibt schlicht und ergreifend: 

POISSON(3; 4; FALSCH) ergibt 0,195366815 

Die beiden Ergebnisse sind (wie oben beschrieben) erwartungsgemäß sehr ähnlich. 

Weiteres Beispiel: Wie groß ist die Wahrscheinlichkeit, dass höchstens 3 Schäden 

auftreten? 

Hier verwendet man statt der Dichtefunktion die Verteilungsfunktion (Argument 

Kumuliert mit WAHR angeben): 

POISSON(3; 4; WAHR) ergibt 0,43347 

Siehe auch: 

BINOMVERT 

POLYNOMIAL (Multinomialkoeffizient) 

Syntax: 

POLYNOMIAL(Zahl1 [; Zahl2; Zahl3 ...]) 

Beschreibung: 

Liefert den Multinomialkoeffizienten (auch: „Polynomialkoeffizient“) einer Grup-

pe von Zahlen. 

Alle übergebenen Zahlen müssen größer gleich 1 sein. 

Beispiel: 

POLYNOMIAL(1; 2; 3; 4; 5) ergibt 37837800 
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Siehe auch: 

FAKULTÄT 

POTENZ (Potenzierung) 

Syntax: 

POTENZ(x; y) 

Beschreibung: 

Berechnet x hoch y. 

Anmerkung: 

Mit dem Operator ^ können Sie genau das Gleiche erreichen:  

POTENZ(x; y) entspricht x^y. 

Beispiel: 

POTENZ(2; 4) entspricht 2^4, ergibt also 16 

Siehe auch: 

LOG, WURZELN, Abschnitt „Operatoren in Berechnungen“ ab Seite 504 

POTENZREIHE (Potenzreihe) 

Syntax: 

POTENZREIHE(x; n; m; Koeffizienten) 

Beschreibung: 

Liefert eine Potenzreihe gemäß folgender Formel: 
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POTENZREIHE(x,n,m,a) =  

a1*x^n + a2*x^(n+m) + a3*x^(n+2m) + a4*x^(n+3m) + ... 

x ist die Basis. 

n ist der Exponent für das erste Glied der Reihe. 

m ist das Inkrement für n. 

Koeffizienten sind die Koeffizienten, mit denen die einzelnen Glieder der Reihe 

multipliziert werden. Koeffizienten kann entweder ein Zellbezug oder eine ein-

spaltige Matrix sein. 

Die Zahl der Koeffizienten bestimmt gleichzeitig, aus wie vielen Gliedern die Rei-

he bestehen wird. Sind beispielsweise 10 Koeffizienten angegeben, wird eine Rei-

he mit 10 Gliedern gebildet. 

Beispiel: 

POTENZREIHE(2; 2; 1; {1; 2; 3; 4; 5}) ergibt 516 

Siehe auch: 

POTENZ 

PRODUKT (Produkt) 

Syntax: 

PRODUKT(Zahl1 [; Zahl2; Zahl3 ...]) 

Beschreibung: 

Liefert das Produkt der angegebenen Zahlen, multipliziert sie also miteinander. 

Anmerkung: 

Beachten Sie: Normalerweise berücksichtigt diese Funktion nur Zahlen und igno-

riert Zeichenketten und Wahrheitswerte. Anders sieht es allerdings aus, wenn Sie 

ihr feste Werte übergeben: Hier werden Zeichenketten, die Zahlen enthalten, mit-
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gezählt. Weiterhin werden die Wahrheitswerte WAHR als 1 und FALSCH als 0 

behandelt. Siehe Beispiele: 

Beispiel: 

PRODUKT(2; 3; 4) entspricht 2*3*4, ergibt also 24 

Wenn die Zellen A1 bis A3 mit den Werten 2, 3 und 4 gefüllt sind, gilt: 

PRODUKT(A1:A3) entspricht 2*3*4, ergibt also 24 

Beachten Sie: 

PRODUKT(2; "5"; WAHR) ergibt 2*5*1, also 10 

Aber: Sind die Zellen A1 bis A3 mit 2, "5" und WAHR gefüllt, liefert die Formel 

PRODUKT(A1:A3) ein anderes Ergebnis: Es kommt 2 heraus, da Zeichenketten 

und Wahrheitswerte nur berücksichtigt werden, wenn sie als feste Werte übergeben 

werden. 

Siehe auch: 

SUMME 

QIKV (Modifizierter interner Zinsfuß) 

Syntax: 

QIKV(Werte; Investition; Reinvestition) 

Beschreibung: 

Liefert ein modifiziertes Modell des IKV (interner Zinsfuß), das Sollzins (für In-

vestitionen) und Habenzins (für Reinvestitionen) berücksichtigt.  

Als Basis dienen die im Bereich Werte angegebenen Auszahlungen (negative Wer-

te) und Einzahlungen (positive Werte). Die Zahlungen dürfen unterschiedlich groß 

sein, müssen jedoch in gleichmäßigen Zeitintervallen (z.B. monatlich oder jährlich) 

auftreten. 

Die Funktion erwartet folgende Argumente: 



 

712  •  Formeln und Funktionen Handbuch PlanMaker 

Für Werte gibt man einen Zellbezug an, in dem die Zahlungen eingetragen wur-

den. Es muss mindestens eine Auszahlung und eine Einzahlung vorliegen. 

Für Investition ist der Sollzins (für Investitionen) anzugeben. 

Für Reinvestition ist der Habenzins (für Reinvestitionen) anzugeben.  

Siehe auch: 

IKV, XINTZINSFUSS, ZINS 

QUADRATESUMME (Summe der Quadrate) 

Syntax: 

QUADRATESUMME(Zahl1 [; Zahl2; Zahl3 ...]) 

Beschreibung: 

Ermittelt die Summe der Quadrate der übergebenen Zahlenwerte. 

Beispiel: 

QUADRATESUMME(1; 2; 3) entspricht 1^2 + 2^2 + 3^2, ergibt also 14. 

Siehe auch: 

SUMME 

QUANTIL (Quantile einer Datenmenge) 

Syntax: 

QUANTIL(Bereich; Alpha) 
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Beschreibung: 

Ermittelt das Alpha-Quantil einer Datenmenge.  

Geben Sie für Alpha beispielsweise 0,5 an, wird das 0,5-Quantil (der Median) ge-

liefert. 

Bereich ist ein Bereich mit numerischen Daten – in der Regel also ein Bezug auf 

einen Zellbereich, in dem Zahlen eingetragen sind. 

Alpha ist der gewünschte Prozentwert. Zulässig sind Werte zwischen 0 (=0%) bis 

1 (=100%). 

Beispiel: 

Sind in den Zellen A1 bis A9 die Werte 1 bis 9 eingetragen, so gilt: 

QUANTIL(A1:A9; 0,75) ergibt 7 

Siehe auch: 

QUARTILE, QUANTILSRANG, MEDIAN, MODALWERT 

QUANTILSRANG (Prozentrang eines Wertes) 

Syntax: 

QUANTILSRANG(Bereich; Zahl [; Stellen]) 

Beschreibung: 

Liefert den prozentualen Rang (Alpha) eines Werts innerhalb einer Datenmenge. 

Bereich ist ein Bereich mit numerischen Daten – in der Regel also ein Bezug auf 

einen Zellbereich, in dem Zahlen eingetragen sind. 

Zahl ist der Wert, dessen Rang bestimmt werden soll. Wenn Zahl nicht in der an-

gegebenen Datenmenge enthalten ist, wird eine Interpolation durchgeführt. 

Mit dem optionalen Argument Stellen können Sie bestimmen, auf wie viele Nach-

kommastellen das Ergebnis berechnet werden soll. Geben Sie dazu die gewünschte 
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Anzahl an Nachkommastellen an. Wenn Sie nichts angeben, werden drei Nach-

kommastellen verwendet. 

Beispiel: 

Sind in den Zellen A1 bis A9 die Werte 1, 2, 3, 4, 5, 6, 7, 8, 9 eingetragen, so gilt: 

QUANTILSRANG(A1:A9; 5) ergibt 0,5 (5 liegt also genau in der Mitte der Da-

tenmenge) 

Siehe auch: 

QUANTIL, QUARTILE 

QUARTILE (Quartile einer Datenmenge) 

Syntax: 

QUARTILE(Bereich; n) 

Beschreibung: 

Liefert eines der Quartile einer Datenmenge. 

Bereich ist ein Bereich mit numerischen Daten – in der Regel also ein Bezug auf 

einen Zellbereich, in dem auszuwertenden Zahlen eingetragen sind. 

n bestimmt, welches Quartil geliefert werden soll. Zulässig sind folgende Werte: 

0: das Minimum (also der kleinste Wert) 

1: das untere Quartil (also das 0,25-Quantil) 

2: das mittlere Quartil (also das 0,5-Quantil, der Median) 

3: das obere Quartil (also das 0,75-Quantil) 

4: das Maximum (also der größte Wert) 

Ist n < 0 oder > 4, liefert die Funktion den Fehlerwert #ZAHL. 
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Beispiel: 

Sind in den Zellen A1 bis A9 die Werte 1, 2, 3, 4, 5, 6, 7, 8, 9 eingetragen, so gilt: 

QUARTILE(A1:A9; 3) entspricht QUANTIL(A1:A9; 0,75), ergibt also 7 

Siehe auch: 

QUANTIL, QUANTILSRANG, MEDIAN, MODALWERT 

QUOTIENT (Ganzzahliger Teil einer Division) 

Syntax: 

QUOTIENT(x; y) 

Beschreibung: 

Ermittelt den ganzzahligen Teil der Division von x durch y. 

Beispiel: 

QUOTIENT(6; 4) ergibt 1 

Siehe auch: 

REST, RESTP 

RANG (Rang eines Wertes in einer Wertemenge) 

Syntax: 

RANG(Zahl; Bereich [; Aufsteigend]) 
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Beschreibung: 

Liefert den Rang einer Zahl in einer Menge von Zahlen. Die größte Zahl hat den 

Rang 1, die zweitgrößte Zahl den Rang 2 etc. 

Zahl ist die Zahl, deren Rang ermittelt werden soll. Wenn Zahl in Bereich nicht 

vorhanden ist, liefert die Funktion den Fehlerwert #NV. 

Bereich ist ein Bereich mit numerischen Daten – in der Regel also ein Bezug auf 

einen Zellbereich, in dem die vorliegenden Zahlen eingetragen sind. 

Der optionale Wahrheitswert Aufsteigend bestimmt, ob eine aufsteigende oder 

eine absteigende Reihenfolge verwendet werden soll: 

FALSCH oder nicht angegeben: absteigende Reihenfolge (die größte Zahl hat 

Rang 1) 

WAHR: aufsteigende Reihenfolge (die kleinste Zahl hat Rang 1) 

Hinweis: 

Ist eine Zahl in Bereich mehrere Male enthalten, so wirkt sich das auf die nachfol-

genden Ränge aus: Kommt die Zahl 42 beispielsweise zweimal vor und hat den 

Rang 10, so erhält die nächstkleinere Zahl den Rang 12 – nicht 11! 

Beispiel: 

Sind in den Zellen A1:A5 die Zahlen 4, 2, 6, 5, 9 eingetragen, so gilt: 

RANG(9; A1:A5) ergibt 1 

RANG(2; A1:A5) ergibt 5 

RANG(2; A1:A5; WAHR) ergibt 1 

Siehe auch: 

KKLEINSTE, KGRÖSSTE, QUANTIL, QUANTILSRANG 
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RECHTS (Teil einer Zeichenkette) 

Syntax: 

RECHTS(Zeichenkette [; n]) 

Beschreibung: 

Liefert die letzten n Zeichen einer Zeichenkette. 

Ist n nicht angegeben, liefert die Funktion nur das letzte Zeichen. 

Beispiel: 

RECHTS("Tiergarten"; 6) ergibt garten 

RECHTS("Tiergarten") ergibt n 

Siehe auch: 

LINKS, TEIL, ERSETZEN 

REST (Rest einer Division) 

Syntax: 

REST(x; y) 

Beschreibung: 

Ermittelt den Rest der Division von x durch y nach der „Excel-Methode“. 

Wichtig: Diese Funktion liefert teilweise falsche Ergebnisse (siehe Anmerkung)! 

Beispiel: 

REST(5; 3) ergibt 2 
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REST(5; 0) ergibt den Fehlerwert #DIV/0! 

REST(5; -3) ergibt -1 (falsch! – siehe Anmerkung) 

Siehe auch: 

RESTP, QUOTIENT 

Anmerkung: 

Die Tabellenkalkulation Microsoft Excel liefert bei dieser Funktion falsche Er-

gebnisse, wenn entweder Zähler oder Nenner negativ sind. 

PlanMaker liefert aus Kompatibilitätsgründen ebenfalls falsche Ergebnisse, ver-

fügt aber zusätzlich über die Funktion RESTP, die korrekte Ergebnisse zurückgibt. 

Den Unterschied zwischen REST und RESTP können Sie dieser Tabelle entneh-

men (die hinterlegten Ergebnisse sind falsch): 

 

Kompatibilitätshinweise: 

Hinweis: Die Funktion RESTP ist in Excel nicht vorhanden. Wenn Sie ein Doku-

ment mit dieser Funktion im Excel-Format speichern, wird sie durch ihren letzten 

Wert ersetzt. 

RESTP (Rest einer Division) 

Syntax: 

RESTP(x; y) 
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Beschreibung: 

Ermittelt den Rest der Division von x durch y nach der „PlanMaker-Methode“ 

(siehe Anmerkung). 

Beispiel: 

RESTP(5; 3) ergibt 2 

RESTP(5; 0) ergibt den Fehlerwert #DIV/0! 

RESTP(5; -3) ergibt 2 (siehe Anmerkung) 

Siehe auch: 

REST, QUOTIENT 

Anmerkung: 

Die Tabellenkalkulation Microsoft Excel liefert bei der Funktion REST falsche 

Ergebnisse, wenn entweder Zähler oder Nenner negativ sind.  

Wenn Sie korrekte Ergebnisse erhalten möchten, sollten Sie statt REST die hier 

beschriebene Funktion RESTP verwenden. 

Den Unterschied zwischen REST und RESTP können Sie dieser Tabelle entneh-

men (die hinterlegten Ergebnisse sind falsch): 

 

Kompatibilitätshinweise: 

Hinweis: Die Funktion RESTP ist in Excel nicht vorhanden. Wenn Sie ein Doku-

ment mit dieser Funktion im Excel-Format speichern, wird sie durch ihren letzten 

Wert ersetzt. 
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RGP (Kenngrößen einer linearen Regression) 

Syntax: 

RGP(y_Werte [; x_Werte] [; Konstante] [; Statistik]) 

Beschreibung: 

Liefert verschiedene Kenngrößen einer linearen Regression. 

Unter einer linearen Regression versteht man das Anpassen einer linearen Funktion 

(Regressionsgerade oder Ausgleichsgerade genannt) an eine Menge von Punkten 

(zum Beispiel den Messpunkten einer Messreihe). 

Die Funktionsgleichung für diese Regressionsgerade lautet: 

y = m*x + b  

RGP erwartet als Argumente die y-Werte (und, sofern angegeben, die zugehörigen 

x-Werte) und liefert als Ergebnis eine Matrix in der Form {m.b}. m ist die Steigung 

der Geraden, b ist der y-Achsenabschnitt (also die y-Koordinate des Punktes, an 

dem die Gerade die y-Achse schneidet). 

Liegen mehrere Bereiche mit x-Werten vor, lautet die Funktionsgleichung: 

y = (m1*x1) + (m2*x2) + ... + (mn*xn) + b 

In diesem Fall liefert die Funktion RGP eine Matrix in der Form {mn . mn-1 . ... . m2 

. m1 . b}.  

Wird das optionale Argument Statistik verwendet, wird die resultierende Matrix 

um weitere Kenngrößen (Standardfehler, Bestimmtheitsmaß etc.) erweitert. 

Die Funktion RGP erwartet folgende Argumente: 

y_Werte: Hier geben Sie die vorliegenden y-Koordinaten, also die abhängigen 

Werte, an. y_Werte kann entweder ein Zellbezug oder eine Matrix sein. 

x_Werte: Hier können optional die x-Koordinaten, also die unabhängigen Werte 

angegeben werden. Auch x_Werte kann entweder ein Zellbezug oder eine Matrix 

sein. Wird x_Werte nicht angegeben, verwendet die Funktion automatisch die 

Werte 1, 2, 3, ... (entsprechend der Anzahl der vorliegenden y_Werte). 

Konstante: Mit dem optionalen Argument Konstante können Sie festlegen, ob die 

Konstante b (der y-Achsenabschnitt) auf Null gesetzt werden soll: 
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WAHR oder nicht angegeben: b wird aus den vorliegenden Daten automatisch be-

rechnet. 

FALSCH: b wird auf Null gesetzt. Die Regressionsgerade wird dadurch gezwun-

gen, durch den Nullpunkt zu laufen. Dies geschieht durch entsprechendes Anpas-

sen des Koeffizienten m. 

Statistik: Das optionale Argument Statistik bestimmt, ob zusätzliche Kenngrößen 

geliefert werden sollen: 

FALSCH oder nicht angegeben: keine zusätzlichen Kenngrößen liefern. 

WAHR: zusätzliche Kenngrößen liefern. In diesem Falle wird eine Matrix zurück-

geliefert, die nicht nur m und b, sondern folgende Werte enthält: 

{mn . mn-1 . ... . m2 . m1 . b ; smn . smn-1 . ... . sm2 . sm1 . sb ; R2 . sey ; F. df ; ssreg . 

ssresid} 

Grafisch dargestellt sieht diese Matrix also wie folgt aus: 

 

Bei obigen Kürzeln handelt es sich um folgende Kenngrößen: 

Kürzel Erläuterung 

sm1, sm2 etc. Standardfehler für die Koeffizienten m1, m2 etc. 

sb Standardfehler für die Konstante b 

R2 Bestimmtheitsmaß R2 (Korrelationskoeffizient) 

sey Standardfehler für y 

F F-Wert 

df Freiheitsgrade 

ssreg Regressions-Quadratsumme 

ssresid Residual-Quadratsumme 
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Hinweis: 

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu fin-

den Sie im Abschnitt „Arbeiten mit Matrizen“ ab Seite 516. 

Anmerkung: 

Die lineare Regression wird bei dieser Funktion mit Hilfe der Methode der kleins-

ten Quadrate durchgeführt. 

Beispiel: 

RGP({4; 5; 6}) liefert die Matrix {1.3}. Die Steigung m beträgt also 1 und der y-

Achsenabschnitt b ist 3. (Da die x-Werte nicht angegeben wurden, hat die RGP-

Funktion dafür automatisch die Werte 1, 2, 3, ... verwendet.) 

Siehe auch: 

RKP, TREND, VARIATION 

RKP (Kenngrößen einer exponentiellen Regression) 

Syntax: 

RKP(y_Werte [; x_Werte] [; Konstante] [; Statistik]) 

Beschreibung: 

Liefert verschiedene Kenngrößen einer exponentiellen Regression. 

Unter einer exponentiellen Regression versteht man das Anpassen einer Exponenti-

alkurve an eine Menge von Punkten (zum Beispiel den Messpunkten einer Mess-

reihe). 

Die Funktionsgleichung für diese Exponentialkurve lautet: 

y = b*m^x 

beziehungsweise (wenn mehrere Bereiche mit x-Werten vorliegen): 

y = b * (m1^x1) * (m2^x2) * ... * (mn^xn) 



 

Handbuch PlanMaker Formeln und Funktionen  •  723 

RKP erwartet als Argumente die y-Werte (und, sofern angegeben, die zugehörigen 

x-Werte) und liefert als Ergebnis eine Matrix in der Form {mn . mn-1 . ... . m2 . m1 . 

b}.  

Wird das optionale Argument Statistik verwendet, wird die resultierende Matrix 

um weitere Kenngrößen (Standardfehler, Bestimmtheitsmaß etc.) erweitert. 

Die Funktion RKP erwartet folgende Argumente: 

y_Werte: Hier geben Sie die vorliegenden y-Koordinaten, also die abhängigen 

Werte, an. y_Werte kann entweder ein Zellbezug oder eine Matrix sein. 

x_Werte: Hier können optional die x-Koordinaten, also die unabhängigen Werte 

angegeben werden. Auch x_Werte kann entweder ein Zellbezug oder eine Matrix 

sein. Wird x_Werte nicht angegeben, verwendet die Funktion automatisch die 

Werte 1, 2, 3, ... (entsprechend der Anzahl der vorliegenden y_Werte). 

Konstante: Mit dem optionalen Argument Konstante können Sie festlegen, ob die 

Konstante b auf Eins gesetzt werden soll: 

WAHR oder nicht angegeben: b wird aus den vorliegenden Daten automatisch be-

rechnet. 

FALSCH: b wird fest auf Eins gesetzt, und die Kurve wird entsprechend „hingebo-

gen“. Dies geschieht durch Anpassen des Koeffizienten m. 

Statistik: Das optionale Argument Statistik bestimmt, ob zusätzliche Kenngrößen 

geliefert werden sollen: 

FALSCH oder nicht angegeben: keine zusätzlichen Kenngrößen liefern. 

WAHR: zusätzliche Kenngrößen liefern. In diesem Falle wird eine Matrix zurück-

geliefert, die nicht nur m und b, sondern folgende Werte enthält: 

{mn . mn-1 . ... . m2 . m1 . b ; smn . smn-1 . ... . sm2 . sm1 . sb ; R2 . sey ; F. df ; ssreg . 

ssresid} 

Grafisch dargestellt sieht diese Matrix also wie folgt aus: 
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Bei obigen Kürzeln handelt es sich um folgende Kenngrößen: 

Kürzel Erläuterung 

sm1, sm2 etc. Standardfehler für die Koeffizienten m1, m2 etc. 

sb Standardfehler für die Konstante b 

R2 Bestimmtheitsmaß R2 (Korrelationskoeffizient) 

sey Standardfehler für y 

F F-Wert 

df Freiheitsgrade 

ssreg Regressions-Quadratsumme 

ssresid Residual-Quadratsumme 

Hinweis: 

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu fin-

den Sie im Abschnitt „Arbeiten mit Matrizen“ ab Seite 516. 

Siehe auch: 

RGP, TREND, VARIATION 

RMZ (Regelmäßige Zahlung) 

Syntax: 

RMZ(Zins; Zzr; Bw [; Zw] [; Fälligkeit]) 

Beschreibung: 

Liefert die Höhe der Zahlung (Annuität) pro Periode, basierend auf einer Investiti-

on mit regelmäßigen konstanten Zahlungen und feststehendem Zins. 

Sie können mit dieser Funktion beispielsweise berechnen, wie hoch die (konstan-

ten) Zahlungen pro Periode ausfallen. Diese Zahlungen („Annuitäten“) bestehen 
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stets aus einem Tilgungsanteil (siehe Funktion KAPZ) und einem Zinsanteil (siehe 

Funktion ZINSZ). 

„Periode“ bezeichnet einen Zahlungszeitraum. Bei einem Kredit mit monatlichen 

Rückzahlungen ist die dritte Periode beispielsweise der dritte Monat. 

Die Funktion erwartet folgende Argumente: 

Zins = Zinssatz (pro Periode) 

Zzr = Zahl der Zahlungszeiträume (wie viele Perioden umfasst die Laufzeit?) 

Bw = Barwert (der anfängliche Betrag) 

Zw (optional) = Zukünftiger Wert, also der Endstand, den Sie nach der letzten Zah-

lung erreichen möchten. Wenn Sie das Argument Zw nicht angeben, wird es auf 

Null gesetzt. 

Fälligkeit (optional) = Wann die Zahlungen fällig sind: 

0 oder nicht angegeben: jeweils am Ende der Periode 

1: jeweils am Anfang der Periode 

Beispiel: 

RMZ(6,5%; 10; 1000) ergibt -139,10 

Siehe auch: 

BW, ISPMT, KAPZ, ZINS, ZINSZ, ZW, ZZR 

RÖMISCH (Römische Schreibweise einer Zahl) 

Syntax: 

RÖMISCH(Zahl [; Darstellung]) 

Beschreibung: 

Wandelt eine Zahl in eine Zeichenkette mit der römischen Schreibweise dieser 

Zahl um. 
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Der zulässige Wertebereich für Zahl ist: 0  Zahl < 4000. 

Zahl sollte eine ganze Zahl sein. Ist dies nicht der Fall, entfernt PlanMaker auto-

matisch alle Nachkommastellen. 

Wenn Zahl Null ist, wird eine leere Zeichenkette zurückgeliefert. 

Wird das optionale Argument Darstellung angegeben, versucht PlanMaker, die 

römische Zahl in verkürzter Schreibweise darzustellen (siehe Beispiele). Für Dar-

stellung sind Werte von 0 (nicht kürzen) bis 4 (so kurz wie möglich) zulässig. 

Beispiel: 

RÖMISCH(1999) ergibt MCMXCIX 

RÖMISCH(1999; 0) ergibt ebenfalls MCMXCIX 

RÖMISCH(1999; 1) ergibt MLMIL 

RÖMISCH(1999; 2) ergibt MXMIX 

RÖMISCH(1999; 3) ergibt MVMIV 

RÖMISCH(1999; 4) ergibt MIM 

RUNDEN (Runden auf n Stellen) 

Syntax: 

RUNDEN(Zahl; n) 

Beschreibung: 

Rundet eine Zahl auf n Nachkommastellen. 

n ist die gewünschte Anzahl an Nachkommastellen.  

Wird n nicht angegeben, wird die Zahl auf 0 Nachkommastellen gerundet. 

n darf auch ein negativer Wert sein, worauf der ganzzahlige Teil der Zahl gerundet 

wird: Ist n beispielsweise -2, wird die Zahl auf ein Vielfaches von Hundert gerun-

det (siehe letztes Beispiel). 
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Beispiel: 

RUNDEN(1,234; 2) ergibt 1,23 

RUNDEN(1,235; 2) ergibt 1,24 

RUNDEN(444,222; 0) ergibt 444 

RUNDEN(444,222; -2) ergibt 400 

Siehe auch: 

ABRUNDEN, AUFRUNDEN, KÜRZEN, VRUNDEN 

SÄUBERN (Nicht-druckbare Zeichen entfernen) 

Syntax: 

SÄUBERN(Zeichenkette) 

Beschreibung: 

Entfernt alle nicht-druckbaren Zeichen aus einer Zeichenkette (alle Zeichen mit 

einem ANSI-Code < 32). 

SCHÄTZER (Schätzwert für einen linearen Trend) 

Syntax: 

SCHÄTZER(x; y_Werte; x_Werte) 

Beschreibung: 

Liefert zum angegebenen x-Wert x den y-Wert auf einer Regressionsgeraden, die 

anhand der übergebenen x- und y-Werte gebildet wird. 

Eine Regressionsgerade ist das Resultat einer linearen Regression. Darunter ver-

steht man das Anpassen einer linearen Funktion (Regressionsgerade oder Aus-
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gleichsgerade genannt) an eine Menge von Punkten (zum Beispiel den Messpunk-

ten einer Messreihe). 

Mit der Funktion SCHÄTZER können Sie voraussagen, welchen Wert y (der ab-

hängigen Variable) bei einem bestimmten Wert x (der unabhängigen Variable) un-

gefähr haben wird. 

Sie können somit beispielsweise abschätzen, welchen Widerstand ein temperatur-

abhängiger Widerstand bei einer bestimmten Temperatur haben wird, nachdem Sie 

den Widerstand bei verschiedenen anderen Temperaturen gemessen haben. 

Für die Argumente y_Werte und x_Werte geben Sie in der Regel einen Zellbe-

reich an. 

y_Werte sind die abhängigen Variablen (in obigem Beispiel also der Widerstand). 

x_Werte sind die unabhängigen Variablen (in obigem Beispiel also die Tempera-

tur). 

Hinweis: 

Beachten Sie, dass diese Funktion als zweites und drittes Argument erst die 

y_Werte und dann die x_Werte erwartet – nicht umgekehrt. 

Anmerkung: 

Die lineare Regression wird bei dieser Funktion mit Hilfe der Methode der kleins-

ten Quadrate durchgeführt. 

Beispiel: 

Von einem temperaturabhängigen Widerstand wurde gemessen, welcher Wider-

stand bei verschiedenen Temperaturen vorliegt. 

In den Zellen A1 bis A4 sind die x-Koordinaten der Messpunkte eingetragen (also 

die unabhängigen Variablen; in unserem Beispiel ist das die Temperatur): 8, 20, 25, 

28 

In den Zellen B1 bis B4 sind die y-Koordinaten eingetragen (also die abhängigen 

Variablen; in unserem Beispiel ist dies der Widerstand): 261, 508, 608, 680 

Mit der folgenden Formel können Sie abschätzen, welcher Widerstand bei 15°C 

geliefert werden wird: 

SCHÄTZER(15; B1:B4; A1:A4) ergibt 405,21805 (Ohm) 
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Siehe auch: 

ACHSENABSCHNITT, STEIGUNG 

Anmerkung: 

ACHSENABSCHNITT(y_Werte; x_Werte) entspricht SCHÄTZER(0; y_Werte; 

x_Werte). 

SCHIEFE (Schiefe einer Verteilung) 

Syntax: 

SCHIEFE(Zahl1; Zahl2; Zahl3 [; Zahl4 ...]) 

oder 

SCHIEFE(Bereich1 [; Bereich2; Bereich3 ...]) 

Beschreibung: 

Berechnet die Schiefe der Dichtefunktion einer Wahrscheinlichkeitsverteilung. 

Die Schiefe ist ein Maß für den Grad der Asymmetrie dieser Funktion. 

Befinden sich mehr Werte rechts des arithmetischen Mittels der Verteilung, spricht 

man von einer „rechtsschiefen“ Verteilung. SCHIEFE liefert hier einen positiven 

Wert. 

Den umgekehrten Fall bezeichnet man als „linksschiefe“ Verteilung. Hier liefert 

SCHIEFE einen negativen Wert. 

Wenn sich die SCHIEFE Null annähert, so ist die betrachtete Dichtefunktion in 

guter Näherung symmetrisch. 

Zahl1, Zahl2, Zahl3 etc. sind die Werte der Verteilung, deren Schiefe berechnet 

werden soll. Leere Zellen sowie Zeichenketten und Wahrheitswerte werden igno-

riert. 

Es müssen mindestens drei Werte angegeben sein; andernfalls liefert die Funktion 

den Fehlerwert #DIV/0! (Division durch Null). 
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Hinweis: 

Diese Funktion erwartet als Argumente keine Wertepaare (x-Wert und y-Wert), 

sondern nur die Werte der Verteilung. Mehrmals vorkommende Werte müssen ent-

sprechend oft wiederholt werden (siehe Beispiel). 

Beispiel: 

Sie messen die Körpergrößen von Menschen und erhalten dabei folgende Ergeb-

nisse: 1 x 1,60m, 2 x 1,65m, 4 x 1,70m, 2 x 1,75m und 1x1,80m.  

Die Dichtefunktion der Verteilung dieser Messergebnisse hat folgende Schiefe: 

SCHIEFE(1,60; 1,65; 1,65; 1,70; 1,70; 1,70; 1,70; 1,75; 1,75; 1,80) ergibt 

4,66562E-15; liegt also nahezu bei Null. 

Siehe auch: 

ACHSENABSCHNITT, SCHÄTZER, KURT, NORMVERT 

SCHNITTBEREICH (Schnittmenge zweier Bereiche) 

Syntax: 

SCHNITTBEREICH(Bereich1; Bereich2) 

Beschreibung: 

Liefert einen Bezug auf den Schnittbereich von Bereich1 und Bereich2 (also den 

Zellbereich, an dem sich Bereich1 und Bereich2 überlappen). 

Anmerkung: 

Alternativ zu dieser Funktion können Sie auch den Operator Leerzeichen verwen-

den, um den Schnittbereich zweier Bereiche zu erhalten. Beispiel: 

SUMME(SCHNITTBEREICH(A1:D4; C3:E6))  

ist gleichbedeutend mit: 

SUMME(A1:D4 C3:E6). 
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Kompatibilitätshinweise: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, wird daher jedes Vorkommen dieser Funktion durch den 

Schnittbereichoperator (also ein Leerzeichen) ersetzt (siehe Anmerkung oben). 

Beispiel: 

SCHNITTBEREICH(A1:D4; C3:E6) liefert einen Bezug auf C3:D4 

SEKUNDE (Sekunde aus einem Datumswert ermitteln) 

Syntax: 

SEKUNDE(Uhrzeit) 

Beschreibung: 

Liefert den Sekundenanteil aus einem Datumswert. 

Beispiel: 

SEKUNDE("12:34:56") ergibt 56 

SEKUNDE("25.09.2018 10:30:56") ergibt 56 

Siehe auch: 

STUNDE, MINUTE, MILLISEKUNDEN 

SIN (Sinus) 

Syntax: 

SIN(Zahl) 
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Beschreibung: 

Liefert den Sinus eines Winkels.  

Der Winkel ist dabei im Bogenmaß (Radiant) anzugeben. 

Tipp: 

Mit der Funktion BOGENMASS können Sie einen in Grad vorliegenden Winkel 

ins Bogenmaß umrechnen. 

Beispiel: 

SIN(PI()/2) ergibt 1 

SIN(BOGENMASS(90)) ergibt 1 

Siehe auch: 

ARCSIN 

SINHYP (Sinus Hyperbolicus) 

Syntax: 

SINHYP(Zahl) 

Beschreibung: 

Die Funktion SINHYP (Sinus Hyperbolicus) liefert den hyperbolischen Sinus ei-

ner Zahl. 

Beispiel: 

SINHYP(0,45) ergibt 0,4653 

Siehe auch: 

ARCSINHYP 
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SORTIERENM (Sortieren) 

Syntax: 

SORTIERENM(Bereich; Schlüssel [; GroßKlein] [; Spaltenweise] [; Spaltennum-

mer]) 

Beschreibung: 

Diese Funktion sortiert einen Zellbereich oder eine Matrix nach einem oder mehre-

ren Kriterien. Als Ergebnis liefert sie eine Matrix mit den sortierten Werten. 

Bereich bestimmt den Datenbereich, der sortiert werden soll. Sie können einen 

hierfür ein- oder zweidimensionalen Zellbereich oder eine Matrix angeben. 

Schlüssel bestimmt, nach welchen Zeilen der Datenbereich sortiert werden soll. 

Geben Sie dazu einen zweizeiligen Zellbereich oder eine zweizeilige Matrix mit 

folgendem Inhalt an: 

In der ersten Zeile müssen die Nummern der Zeilen im Datenbereich angegeben 

werden, nach denen sortiert werden soll. Geben Sie also als Sortierschlüssel {1.3} 

an, wird nach der ersten und der dritten Zeile sortiert.  

In der zweiten Zeile kann (optional) anhand eines Wahrheitswerts angegeben wer-

den, dass absteigend sortiert werden soll:  

FALSCH oder nicht angegeben: aufsteigend sortieren 

WAHR: absteigend sortieren 

Geben Sie also als Sortierschlüssel {1.3; wahr.falsch} an, wird nach der ersten Zei-

le absteigend und der dritten Zeile aufsteigend sortiert. 

Das optionale Argument GroßKlein bestimmt, ob bei Zeichenketten auch nach 

Groß-/Kleinschreibung sortiert werden soll: 

FALSCH oder nicht angegeben: Groß-/Kleinschreibung ignorieren 

WAHR: Groß-/Kleinschreibung beachten, also Begriffe, bei denen der erste Buch-

stabe klein geschrieben ist, vor Begriffe sortieren, die mit demselben Buchstaben in 

Großschreibung beginnen. 

Das optionale Argument Spaltenweise bestimmt, ob die Sortierung zeilen- oder 

spaltenweise erfolgen soll: 

FALSCH oder nicht angegeben: zeilenweise sortieren 
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WAHR: spaltenweise sortieren 

Wenn Sie das optionale Argument Spaltennummer verwenden, liefert die Funkti-

on statt der gesamten Daten nur eine bestimmte Spalte (beziehungsweise Zeile – 

bei spaltenweiser Sortierung) zurück: 

Wird dieses Argument nicht angegeben, liefert die Funktion alle Spalten des Da-

tenbereichs zurück. 

Wird es auf n gesetzt, wird nur die n-te Spalte des Datenbereichs zurückgeliefert. 

Hinweis: 

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu fin-

den Sie im Abschnitt „Arbeiten mit Matrizen“ ab Seite 516. 

Kompatibilitätshinweise: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

SORTIERENM({4;2;3}; {1}) ergibt {2;3;4} 

SORTIERENM({4;2;3}; {1; WAHR}) ergibt {4;3;2} 

Siehe auch: 

SORTIERENV, Abschnitt „Sortieren“ ab Seite 104 

SORTIERENV (Sortieren) 

Syntax: 

SORTIERENV(Bereich [; Absteigend] [; GroßKlein] [; Datenbereich]) 
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Beschreibung: 

Diese Funktion sortiert einen eindimensionalen Zellbereich oder Vektor. Als Er-

gebnis liefert sie einen Vektor mit den sortierten Werten. 

Der Unterschied zur Funktion SORTIERENM liegt darin, dass SORTIERENV nur 

auf eindimensionale Bereiche angewandt werden kann. Das sind Bereiche, die 

entweder nur eine Zeile oder nur eine Spalte umfassen. 

Bereich ist der eindimensionale Bereich, der sortiert werden soll. 

Das optionale Argument Absteigend bestimmt, ob absteigend sortiert werden soll: 

FALSCH oder nicht angegeben: aufsteigend sortieren 

WAHR: absteigend sortieren 

Das optionale Argument GroßKlein bestimmt, ob bei Zeichenketten auch nach 

Groß-/Kleinschreibung sortiert werden soll: 

FALSCH oder nicht angegeben: Groß-/Kleinschreibung ignorieren 

WAHR: Groß-/Kleinschreibung beachten, also Begriffe, bei denen der erste Buch-

stabe klein geschrieben ist, vor Begriffe sortieren, die mit demselben Buchstaben in 

Großschreibung beginnen. 

Wenn Sie das optionale Argument Datenbereich verwenden, liefert die Funktion 

als Ergebnis nicht die Daten aus Bereich, sondern die Daten aus Datenbereich 

zurück. Datenbereich muss genau die gleichen Ausmaße wie Bereich haben. 

Dies ist praktisch, wenn Sie beispielsweise eine Tabelle erstellen, die eine Spalte 

mit den Namen von Sportlern und daneben eine Spalte mit deren Punktzahl enthält. 

Geben Sie hier als Bereich die Spalte mit den Punktzahlen ein, als Datenbereich 

jedoch die Spalte mit den Namen, erhalten Sie als Ergebnis eine Namensliste, die 

nach Punktzahlen sortiert ist. 

Hinweis: 

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu fin-

den Sie im Abschnitt „Arbeiten mit Matrizen“ ab Seite 516. 

Kompatibilitätshinweise: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 
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Beispiel: 

SORTIERENV({4;2;3}) ergibt {2;3;4} 

SORTIERENV({4;2;3}; WAHR) ergibt {4;3;2} 

SORTIERENV({4.2.3}) ergibt {2.3.4} 

Siehe auch: 

SORTIERENM, Abschnitt „Sortieren“ ab Seite 104 

SPALTE (Spaltennummer von Zellen) 

Syntax: 

SPALTE([Bezug]) 

Beschreibung: 

Liefert die Spaltennummer(n) einer Zelle oder eines Bereichs von Zellen: 

Ist Bezug eine einzelne Zelle, liefert die Funktion die Spaltennummer dieser Zelle. 

Ist Bezug ein Bereich von Zellen, liefert die Funktion die darin enthaltenen Spal-

tennummern als horizontale Matrix. Hinweis: In diesem Fall muss die Formel als 

Matrixformel eingegeben werden (siehe Abschnitt „Arbeiten mit Matrizen“ ab Sei-

te 516). 

Wird das Argument Bezug nicht angegeben, liefert die Funktion die Spaltennum-

mer der Zelle, in der sie aufgerufen wurde. 

Beispiel: 

SPALTE(D2) ergibt 4 

SPALTE(D2:F4) ergibt {4.5.6} 

SPALTE() ergibt 3, wenn Sie die Funktion SPALTE() beispielsweise in der Zelle 

C5 aufrufen 
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Siehe auch: 

ZEILE, SPALTEN 

SPALTEN (Anzahl Spalten) 

Syntax: 

SPALTEN(Bereich) 

Beschreibung: 

Liefert die Zahl der Spalten im angegebenen Bereich. 

Beispiel: 

SPALTEN(A1:D5) ergibt 4 

Siehe auch: 

ZEILEN, SPALTE 

STABW (Standardabweichung einer Stichprobe) 

Syntax: 

STABW(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Liefert einen Schätzwert für die Standardabweichung der Grundgesamtheit anhand 

einer Stichprobe. 

Die Standardabweichung gibt an, um welchen Betrag die übergebenen Werte 

durchschnittlich vom Mittelwert abweichen. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Werte (Stichprobe).  
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Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder 

Wahrheitswerte enthalten, so werden diese ignoriert. 

Anmerkung: 

Die Standardabweichung wird nach der Methode „Erwartungstreue Schätzung“ 

oder „n-1“ berechnet. 

Beispiel: 

STABW(2; 2; 3; 4; 1) ergibt 1,14018 

Siehe auch: 

STABWN, VARIANZ 

STABWA (Standardabweichung) 

Syntax: 

STABWA(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Die Funktion STABWA entspricht nahezu der Funktion STABW (siehe Hinweis). 

Sie liefert also einen Schätzwert für die Standardabweichung der Grundgesamtheit 

anhand einer Stichprobe. 

Die Standardabweichung gibt an, um welchen Betrag die übergebenen Werte 

durchschnittlich vom Mittelwert abweichen. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Werte (Stichprobe).  

Hinweis: 

Im Gegensatz zu STABW berücksichtigt die Funktion STABWA auch Werte, die 

keine Zahlen sind: Beliebige Zeichenketten und der Wahrheitswert FALSCH wer-

den als 0 interpretiert, WAHR als 1. 
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Leere Zellen werden hingegen auch hier ignoriert. 

Anmerkung: 

Die Standardabweichung wird nach der Methode „Erwartungstreue Schätzung“ 

oder „n-1“ berechnet. 

Beispiel: 

STABWA(2; 2; 3; 4; 1) ergibt 1,14018 

Siehe auch: 

STABW 

STABWN (Standardabweichung einer Grundgesamtheit) 

Syntax: 

STABWN(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Liefert die Standardabweichung einer Grundgesamtheit. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Werte. Es müssen alle Werte der 

Grundgesamtheit angegeben werden. Falls nur eine Stichprobe aus der Grundge-

samtheit vorliegt, ist statt STABWN die Funktion STABW zu verwenden. Diese 

liefert einen Schätzwert für die Standardabweichung. 

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder 

Wahrheitswerte enthalten, so werden diese ignoriert. 

Anmerkung: 

Die Standardabweichung wird nach der Methode „n“ berechnet. 
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Beispiel: 

STABWN(2; 2; 3; 4; 1) ergibt 1,0198 

Siehe auch: 

STABW, VARIANZEN 

STABWNA (Standardabweichung) 

Syntax: 

STABWNA(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Die Funktion STABWNA entspricht nahezu der Funktion STABWN (siehe Hin-

weis). Sie liefert also die Standardabweichung einer Grundgesamtheit. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Werte. Es müssen alle Werte der 

Grundgesamtheit angegeben werden. Falls nur eine Stichprobe aus der Grundge-

samtheit vorliegt, ist statt STABWNA die Funktion STABWA zu verwenden. Diese 

liefert einen Schätzwert für die Standardabweichung. 

Hinweis: 

Im Gegensatz zu STABWN berücksichtigt die Funktion STABWNA auch Werte, 

die keine Zahlen sind: Beliebige Zeichenketten und der Wahrheitswert FALSCH 

werden als 0 interpretiert, WAHR als 1. 

Leere Zellen werden hingegen auch hier ignoriert. 

Anmerkung: 

Die Standardabweichung wird nach der Methode „n“ berechnet. 

Beispiel: 

STABWNA(2; 2; 3; 4; 1) ergibt 1,0198 
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Siehe auch: 

STABWN 

STANDARDISIERUNG (Standardisierung) 

Syntax: 

STANDARDISIERUNG(x; Mittelwert; Standardabweichung) 

Beschreibung: 

Berechnet den standardisierten Wert von x, basierend auf einer durch Mittelwert 

und Standardabweichung definierten Verteilung. 

x ist der zu standardisierende Wert. 

Mittelwert ist das arithmetische Mittel der Verteilung. 

Standardabweichung ist die Standardabweichung der Verteilung. 

Beispiel: 

STANDARDISIERUNG(5; 4; 1,25) ergibt 0,8 

Siehe auch: 

MITTELWERT, STABW, NORMVERT, STANDNORMVERT 

STANDNORMINV (Quantile einer Standardnormalverteilung) 

Syntax: 

STANDNORMINV(Wahrscheinlichkeit) 

Beschreibung: 

Liefert Quantile einer Standardnormalverteilung.  
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Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der Verteilung. Zu-

lässig sind nur Werte aus dem Intervall [0..1]. 

Hinweis: 

Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. 

Findet PlanMaker nach 100 Iterationen kein Ergebnis, das weniger als 3x10^-7 

von Wahrscheinlichkeit abweicht, zeigt er den Fehlerwert #NV an und bricht die 

Näherung ab. 

Siehe auch: 

NORMINV, STANDNORMVERT 

STANDNORMVERT (Standardnormalverteilung) 

Syntax: 

STANDNORMVERT(x) 

Beschreibung: 

Liefert die kumulierten Wahrscheinlichkeiten einer standardnormalverteilten Zu-

fallsvariablen. 

Die Standardnormalverteilung (auch „standardisierte Normalverteilung“ genannt) 

ist eine Normalverteilung (siehe Funktion NORMVERT), deren arithmetisches 

Mittel  gleich Null und deren Standardabweichung  gleich 1 ist. 

x ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. 

Anmerkung: 

Geliefert wird die Verteilungsfunktion (also die integrierte Dichtefunktion). 

Siehe auch: 

NORMVERT 



 

Handbuch PlanMaker Formeln und Funktionen  •  743 

STEIGUNG (Steigung einer Regressionsgeraden) 

Syntax: 

STEIGUNG(y_Werte; x_Werte) 

Beschreibung: 

Ermittelt die Steigung einer Regressionsgeraden. Als Steigung bezeichnet man den 

Wert, um den die y-Koordinate wächst, wenn man die x-Koordinate um Eins er-

höht. 

Eine Regressionsgerade ist das Resultat einer linearen Regression. Darunter ver-

steht man das Anpassen einer linearen Funktion (Regressionsgerade oder Aus-

gleichsgerade genannt) an eine Menge von Punkten (zum Beispiel den Messpunk-

ten einer Messreihe). 

Für die Argumente y_Werte und x_Werte geben Sie in der Regel einen Zellbe-

reich an. 

y_Werte sind die abhängigen Variablen. 

x_Werte sind die unabhängigen Variablen. 

Hinweis: 

Beachten Sie, dass diese Funktion erst die y_Werte und dann die x_Werte erwar-

tet – nicht umgekehrt. 

Anmerkung: 

Die lineare Regression wird bei dieser Funktion mit Hilfe der Methode der kleins-

ten Quadrate durchgeführt. 

Beispiel: 

Von einem temperaturabhängigen Widerstand wurde gemessen, welcher Wider-

stand bei verschiedenen Temperaturen vorliegt. 

In den Zellen A1 bis A4 sind die x-Koordinaten der Messpunkte eingetragen (also 

die unabhängigen Variablen; in unserem Beispiel ist das die Temperatur): 8, 20, 25, 

28 
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In den Zellen B1 bis B4 sind die y-Koordinaten eingetragen (also die abhängigen 

Variablen; in unserem Beispiel ist dies der Widerstand): 261, 508, 608, 680 

Mit der folgenden Formel können Sie die Steigung der Regressionsgeraden ermit-

teln, die obigen Messwerten zugrunde liegt: 

STEIGUNG(B1:B4; A1:A4) ergibt 20,76799 

Siehe auch: 

ACHSENABSCHNITT, SCHÄTZER 

STFEHLERYX (Standardfehler einer linearen Regression) 

Syntax: 

STFEHLERYX(y_Werte; x_Werte) 

Beschreibung: 

Liefert den Standardfehler einer linearen Regression. 

Der Standardfehler ist ein Maß für die Zuverlässigkeit einer linearen Regression: Je 

größer der Standardfehler, desto stärker weichen die geschätzten Werte von den 

tatsächlichen Werten ab. 

Für die Argumente y_Werte und x_Werte geben Sie in der Regel einen Zellbe-

reich an. 

y_Werte sind die abhängigen Variablen. 

x_Werte sind die unabhängigen Variablen. 

Hinweis: 

Beachten Sie, dass diese Funktion erst die y_Werte und dann die x_Werte erwar-

tet – nicht umgekehrt. 
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Anmerkung: 

Die lineare Regression wird bei dieser Funktion mit Hilfe der Methode der kleins-

ten Quadrate durchgeführt. 

Beispiel: 

Von einem temperaturabhängigen Widerstand wurde gemessen, welcher Wider-

stand bei verschiedenen Temperaturen vorliegt. 

In den Zellen A1 bis A4 sind die x-Koordinaten der Messpunkte eingetragen (also 

die unabhängigen Variablen; in unserem Beispiel ist das die Temperatur): 8, 20, 25, 

28 

In den Zellen B1 bis B4 sind die y-Koordinaten eingetragen (also die abhängigen 

Variablen; in unserem Beispiel ist dies der Widerstand): 261, 508, 608, 680 

Mit der folgenden Formel ermitteln Sie den Standardfehler der Regression, die 

obigen Messwerten zugrunde liegt: 

STFEHLERYX(B1:B4; A1:A4) ergibt 4,97351 

Siehe auch: 

ACHSENABSCHNITT, STEIGUNG, SCHÄTZER 

STUNDE (Stunde aus einem Datumswert ermitteln) 

Syntax: 

STUNDE(Uhrzeit) 

Beschreibung: 

Liefert den Stundenanteil aus einem Datumswert. 

Beispiel: 

STUNDE("12:34:56") ergibt 12 

STUNDE("25.09.2018 10:30:56") ergibt 10 
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Siehe auch: 

MINUTE, SEKUNDE, MILLISEKUNDEN 

SUCHEN (Text in Zeichenkette suchen) 

Syntax: 

SUCHEN(Suchbegriff; Zeichenkette [; Startposition]) 

Beschreibung: 

Ermittelt die Position von Suchbegriff in Zeichenkette. 

Mit dem optionalen Argument Startposition können Sie festlegen, ab welchem 

Zeichen der Zeichenkette gesucht werden soll. Wird er nicht angegeben, beginnt 

die Suche mit dem ersten Zeichen. 

Die Groß-/Kleinschreibung des Suchbegriffs spielt dabei keine Rolle. Verwenden 

Sie die Funktion FINDEN, wenn die Groß-/Kleinschreibung beachtet werden soll. 

Beispiel: 

SUCHEN("a"; "Banane") ergibt 2 

SUCHEN("A"; "Banane") ergibt 2 

SUCHEN("a"; "Banane"; 3) ergibt 4 

SUCHEN("x"; "Banane") ergibt den Fehlerwert #WERT!, da in der durchsuchten 

Zeichenkette kein „x“ vorkommt. 

Siehe auch: 

FINDEN, IDENTISCH, WECHSELN 
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SUMME (Summe) 

Syntax: 

SUMME(Zahl1 [; Zahl2; Zahl3 ...]) 

Beschreibung: 

Bildet die Summe aus den angegebenen Zahlenwerten. 

Anmerkung: 

Beachten Sie: Normalerweise berücksichtigt diese Funktion nur Zahlen und igno-

riert Zeichenketten und Wahrheitswerte. Anders sieht es allerdings aus, wenn Sie 

ihr feste Werte übergeben: Hier werden Zeichenketten, die Zahlen enthalten, einbe-

zogen. Weiterhin werden die Wahrheitswerte WAHR als 1 und FALSCH als 0 be-

handelt. Siehe Beispiele. 

Beispiel: 

SUMME(1; 2; 3; 4) entspricht 1+2+3+4, ergibt also 10 

Wenn die Zellen A1 bis A4 mit den Werten 1, 2, 3 und 4 gefüllt sind, gilt: 

SUMME(A1:A4) entspricht 1+2+3+4, ergibt also 10 

Aber: 

SUMME(1; "2"; WAHR) ergibt 1+2+1, also 4 

Aber: Sind die Zellen A1 bis A3 mit 1, "2" und WAHR gefüllt, liefert die Formel 

SUMME(A1:A3) ein anderes Ergebnis: Es kommt 1 heraus, da Zeichenketten und 

Wahrheitswerte nur berücksichtigt werden, wenn sie als feste Werte übergeben 

wurden. 

Tipp  

Über das AutoSummen-Symbol  in der Funktionsleiste können Sie beson-

ders schnell die Summe eines bestimmten Zellbereichs bilden: 
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Wenn Sie dieses Symbol in einer leeren Zelle direkt unter einer Gruppe von Zellen 

mit Zahlen anklicken, fügt es dort automatisch die Summenfunktion für diesen 

Zellbereich ein.  

Alternativ können Sie auch erst einen Bereich von Zellen mit Zahlen markieren 

und das Symbol dann anklicken, worauf es die Summe dieses Zellbereichs direkt 

darunter einfügt. 

Sie können dieses Symbol auch für andere Rechenfunktionen verwenden. Klicken 

Sie dazu auf das Pfeilchen rechts neben dem Symbol. Es öffnet sich eine Liste der 

verfügbaren Funktionen – zum Beispiel Anzahl, Produkt, Mittelwert etc. Wählen 

Sie darin die gewünschte Funktion und gehen Sie dann wie oben beschrieben vor. 

Siehe auch: 

PRODUKT, SUMMENPRODUKT 

SUMMENPRODUKT (Summenprodukt) 

Syntax: 

SUMMENPRODUKT(Bereich1 [; Bereich2; Bereich3 ...]) 

Beschreibung: 

Multipliziert alle sich entsprechenden Elemente von zwei oder mehr Matrizen mit-

einander und bildet dann die Summe dieser Produkte. 

Bereich1, Bereich2 etc. sind die Matrizen, deren Summenprodukt berechnet wer-

den soll. In der Regel sind hier die Zellbereiche anzugeben, in denen die Werte 

enthalten sind.  

Die Zahl der Zeilen und Spalten der einzelnen Matrizen muss identisch sein, an-

dernfalls liefert die Funktion den Fehlerwert #NV. 

Leere Zellen und Zellen mit einem nicht-numerischen Inhalt (Zeichenketten etc.) 

werden als Null interpretiert. 

Beispiel: 

Sie haben ein Dokument erstellt, in dem Sie Ihren Lagerbestand erfassen.  
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Das Dokument enthält zwei gleich große Bereiche. Im ersten sind die Stückzahlen 

der Artikel eingetragen. Im zweiten Bereich die zugehörigen Einzelpreise.  

 

Um den Gesamtwert aller Artikel im Lager auszurechnen, müssen die Stückzahlen 

der einzelnen Artikel mit ihrem jeweiligen Einzelpreis multipliziert werden. 

Schließlich muss die Summe dieser Produkte gebildet werden.  

Diese gesamte Berechnung bekommen Sie mit der Funktion SUMMENPRODUKT 

unter einen Hut:  

SUMMENPRODUKT(B4:C6; B11:C13) ergibt 12710.  

Es befinden sich derzeit also Artikel im Wert von € 12710,- im Lager. 

Siehe auch: 

SUMME 

SUMMEWENN (Summe ausgewählter Werte) 

Syntax: 

SUMMEWENN(Suchbereich; Suchkriterium [; Summenbereich]) 
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Beschreibung: 

Bildet die Summe derjenigen Werte in einem Bereich, für die die angegebene Be-

dingung zutrifft.  

Suchbereich ist der zu durchsuchende Bereich. 

Suchkriterium ist die zu erfüllende Bedingung: 

Hier können Sie einerseits einfach einen Wert angeben (zum Beispiel "42" oder 

"Schrauben"). In diesem Fall werden alle Posten addiert, die diesem Wert entspre-

chen. 

Andererseits ist auch eine Bedingung wie ">10" oder "<=5" zulässig. Hier werden 

alle Posten addiert, die dieser Bedingung entsprechen. 

Hinweis: Das Suchkriterium sollte stets mit doppelten Anführungszeichen (") um-

geben werden. 

Das optionale Argument Summenbereich bestimmt, welche Werte tatsächlich ad-

diert werden sollen. Wenn Summenbereich nicht angegeben ist, werden die Werte 

im Suchbereich addiert. 

Beispiel: 

In den Zellen A1 bis A5 stehen die Werte 1; 2; 3; 2; 1. Hier gilt: 

SUMMEWENN(A1:A5; "2") ergibt 2+2, also 4 

SUMMEWENN(A1:A5; ">=2") ergibt 2+3+2, also 7 

Sie tragen Ihre Tageseinnahmen in eine Tabelle ein – etwa wie folgt: 

 

Wie groß ist die Summe der Umsätze, wenn man nur Umsätze größer als € 40,- 

berücksichtigt? 
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SUMMEWENN(D2:D5; ">40") ergibt 100,80 Euro 

Wie viele Blumen der Gattung „Rosen“ wurden verkauft? 

SUMMEWENN(C2:C5; "Rosen"; B2:B5) ergibt 18 

Bei obiger Formel wurde das optionale Argument Summenbereich eingesetzt: Der 

Suchbereich C2:C5 (also die Sorte) wurde durchsucht, die zu addierenden Zahlen 

wurden jedoch dem Summenbereich B2:B5 (also der Stückzahl) entnommen. 

Siehe auch: 

MITTELWERTWENN, MITTELWERTWENNS, SUMME, SUMMEWENNS, 

ZÄHLENWENN, ZÄHLENWENNS 

SUMMEWENNS (Summe ausgewählter Werte) 

Syntax: 

SUMMEWENNS(Summenbereich; Suchbereich1; Suchkriterium1 [; Suchbe-

reich2; Suchkriterium2 ...]) 

Beschreibung: 

Bildet die Summe derjenigen Werte in einem Bereich, für die alle angegebenen 

Bedingungen zutreffen.  

Entspricht der Funktion SUMMEWENN, erlaubt allerdings die Verwendung meh-

rerer Suchbereiche (inklusive eines Suchkriteriums für jeden Bereich). 

Beachten Sie: Die Reihenfolge der Parameter ist hier anders als bei SUMME-

WENN: Bei SUMMEWENNS ist der Summenbereich der erste Parameter und 

nicht der letzte.  

Summenbereich ist der Bereich mit den Werten, die addiert werden sollen.  

Suchbereich1 ist der erste zu durchsuchende Bereich. Dieser muss die gleichen 

Ausmaße haben wie der Summenbereich. 

Suchkriterium1 ist die Bedingung, die die Werte in Suchbereich1 erfüllen müs-

sen: 
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Hier können Sie einerseits einfach einen Wert angeben (zum Beispiel "42" oder 

"Schrauben"). In diesem Fall werden alle Posten addiert, die diesem Wert entspre-

chen. 

Andererseits ist auch eine Bedingung wie ">10" oder "<=5" zulässig. Hier werden 

alle Posten addiert, die dieser Bedingung entsprechen. 

Hinweis: Die Suchkriterien sollten stets mit doppelten Anführungszeichen (") um-

geben werden. 

Im Gegensatz zur Funktion SUMMEWENN können Sie bei SUMMEWENNS 

auch mehrere Suchbereiche mit jeweils dazugehörendem Suchkriterium angeben. 

Es werden dann nur diejenigen Werte addiert, bei denen alle Kriterien erfüllt sind. 

Kompatibilitätshinweise: 

Diese Funktion ist nicht kompatibel zum .xls-Dateiformat von Microsoft Excel 

2003 und früher. Wenn Sie ein Dokument in diesem Format speichern, werden alle 

Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester 

Wert ersetzt.  

Wenn Sie diese Funktion einsetzen möchten, sollten Sie Ihr Dokument also nicht 

im Dateiformat „Microsoft Excel 97-2003 (.xls)“ speichern, sondern eines der fol-

genden Formate verwenden: 

 „PlanMaker-Dokument (.pmdx oder .pmd)“ 

 oder: „Microsoft Excel 2007-2016 (.xlsx)“ 

Beispiel: 

SUMMEWENNS(A1:A10; C1:C10; ">1"; C1:C10; "<2")  

Diese Formel liefert die Summe all derjenigen Zellen im Bereich A1:A10, bei de-

nen die entsprechende Zelle im Bereich C1:C10 größer als 1 und kleiner als 2 ist. 

Siehe auch: 

MITTELWERTWENN, MITTELWERTWENNS, SUMME, SUMMEWENN, 

ZÄHLENWENN, ZÄHLENWENNS 
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SUMMEX2MY2 (Summe von x^2 - y^2) 

Syntax: 

SUMMEX2MY2(Bereich1; Bereich2) 

Beschreibung: 

Subtrahiert jeweils die Quadrate der sich entsprechenden Elemente von zwei Mat-

rizen und bildet dann die Summe dieser Differenzen. 

Es wird also folgende Berechnung durchgeführt: 

SUMMEX2MY2 = (x^2 - y^2) 

Bereich1 und Bereich2 sind die Matrizen, deren SummeX2MY2 berechnet wer-

den soll. In der Regel sind hier die Zellbereiche anzugeben, in denen die Werte 

enthalten sind.  

Die Zahl der Zeilen und Spalten dieser beiden Matrizen muss identisch sein, an-

dernfalls liefert die Funktion den Fehlerwert #NV. 

Wertepaare, bei denen mindestens ein Wert leer oder nicht-numerisch ist, werden 

ignoriert. 

Beispiel: 

In den Zellen A1 bis A3 stehen folgende Werte: 9, 4, 7 

In den Zellen B1 bis B3 stehen folgende Werte: 1, 0, 5 

Wenn Sie hier SUMMEX2MY2(A1:A3; B1:B3) berechnen, entspricht das folgen-

der Berechnung: 

(9^2) - (1^2) + (4^2) - (0^2) + (7^2) - (5^2) 

Das Ergebnis ist 120. 

Siehe auch: 

SUMME, SUMMENPRODUKT, SUMMEX2PY2, SUMMEXMY2, QUADRA-

TESUMME 
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SUMMEX2PY2 (Summe von x^2 + y^2) 

Syntax: 

SUMMEX2PY2(Bereich1; Bereich2) 

Beschreibung: 

Summiert die Quadrate der Elemente von zwei Matrizen. 

Es wird also folgende Berechnung durchgeführt: 

SUMMEX2PY2 = (x^2 + y^2) 

Bereich1 und Bereich2 sind die Matrizen, deren SummeX2PY2 berechnet werden 

soll. In der Regel sind hier die Zellbereiche anzugeben, in denen die Werte enthal-

ten sind.  

Die Zahl der Zeilen und Spalten dieser beiden Matrizen muss identisch sein, an-

dernfalls liefert die Funktion den Fehlerwert #NV. 

Wertepaare, bei denen mindestens ein Wert leer oder nicht-numerisch ist, werden 

ignoriert. 

Beispiel: 

In den Zellen A1 bis A3 stehen folgende Werte: 9, 4, 7 

In den Zellen B1 bis B3 stehen folgende Werte: 1, 0, 5 

Wenn Sie hier SUMMEX2PY2(A1:A3; B1:B3) berechnen, entspricht das folgen-

der Berechnung: 

(9^2) + (1^2) + (4^2) + (0^2) + (7^2) + (5^2) 

Das Ergebnis ist 172. 

Siehe auch: 

SUMME, SUMMENPRODUKT, SUMMEX2MY2, SUMMEXMY2, QUADRA-

TESUMME 
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SUMMEXMY2 (Summe von (x - y)^2) 

Syntax: 

SUMMEXMY2(Bereich1; Bereich2) 

Beschreibung: 

Berechnet jeweils das Quadrat der Differenz der sich entsprechenden Elemente von 

zwei Matrizen und bildet dann die Summe dieser Differenzen. 

Es wird also folgende Berechnung durchgeführt: 

SUMMEXMY2 = (x - y)^2 

Bereich1 und Bereich2 sind die Matrizen, deren SummeXMY2 berechnet werden 

soll. In der Regel sind hier die Zellbereiche anzugeben, in denen die Werte enthal-

ten sind. 

Die Zahl der Zeilen und Spalten dieser beiden Matrizen muss identisch sein, an-

dernfalls liefert die Funktion den Fehlerwert #NV. 

Wertepaare, bei denen mindestens ein Wert leer oder nicht-numerisch ist, werden 

ignoriert. 

Beispiel: 

In den Zellen A1 bis A3 stehen folgende Werte: 9, 4, 7 

In den Zellen B1 bis B3 stehen folgende Werte: 1, 0, 5 

Wenn Sie hier SUMMEXMY2(A1:A3; B1:B3) berechnen, entspricht das folgender 

Berechnung: 

(9-1)^2 + (4-0)^2 + (7-5)^2 

Das Ergebnis ist 84. 

Siehe auch: 

SUMME, SUMMENPRODUKT, SUMMEX2MY2, SUMMEX2PY2, QUADRA-

TESUMME 
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SUMQUADABW (Mittlere quadratische Abweichung vom 

Mittelwert) 

Syntax: 

SUMQUADABW(Zahl1 [; Zahl2; Zahl3 ...]) 

Beschreibung: 

Berechnet die mittlere quadratische Abweichung der angegebenen Zahlenwerte 

von ihrem Mittelwert. 

Leere Zellen, Zeichenketten und Wahrheitswerte werden ignoriert. 

Beispiel: 

SUMQUADABW(2; 2; 2; 3) ergibt 0,75 

Siehe auch: 

MITTELABW, STABW, SUMME, VARIANZ 

SVERWEIS (Zellbereich spaltenweise durchsuchen) 

Syntax: 

SVERWEIS(Suchkriterium; Bereich; n [; Sortiert]) 

Beschreibung: 

Diese Funktion sucht in der ersten Spalte von Bereich nach dem ersten Vorkom-

men von Suchkriterium. Wird es gefunden, liefert die Funktion den Inhalt der 

Zelle, die sich in der gleichen Zeile und der n-ten Spalte von Bereich befindet. 

Suchkriterium ist der gesuchte Wert. Die Groß-/Kleinschreibung spielt keine Rol-

le. 
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Bereich ist der zu durchsuchende Zellbereich. Die erste Spalte muss die zu durch-

suchenden Werte enthalten. Dies können Zeichenketten, Zahlen oder Wahrheits-

werte sein. 

Für n ist anzugeben, aus der wievielten Spalte von Bereich ein Wert zurückgelie-

fert werden soll, wenn das Suchkriterium gefunden wird. 

Ist n kleiner als 1, wird der Fehlerwert #BEZUG! zurückgeliefert. Ist n größer als 

die Spaltenzahl von Bereich, wird der Fehlerwert #BEZUG! zurückgeliefert.  

Sortiert ist ein Wahrheitswert, mit dem Sie angeben, ob die Werte in der ersten 

Zeile von Bereich sortiert sind: 

Ist Sortiert WAHR oder nicht angegeben, müssen die Werte in der ersten Spalte 

von Bereich aufsteigend sortiert sein. 

Ist Sortiert FALSCH, spielt die Reihenfolge der Werte in der ersten Spalte keine 

Rolle. 

Wichtig: Wenn Sie Sortiert also nicht explizit auf FALSCH setzen, müssen diese 

Werte in sortierter Reihenfolge vorliegen! 

Hinweis: 

Wenn Sortiert auf WAHR gesetzt ist und SVERWEIS keinen exakt mit dem 

Suchkriterium übereinstimmenden Wert findet, wird automatisch der nächstklei-

nere Wert genommen. Existiert kein kleinerer Wert, weil Suchkriterium kleiner 

als der kleinste vorhandene Wert ist, liefert die Funktion den Fehlerwert #NV. 

Beispiel: 

Sie verkaufen Blumen zu unterschiedlichen Stückpreisen – je nachdem, wie viele 

Pflanzen der Kunde abnimmt. Dazu haben Sie eine Tabelle mit einer Rabattstaffel 

erstellt: 
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Jetzt können Sie die Funktion SVERWEIS einsetzen, um abhängig von der Stück-

zahl den Preis für eine bestimmte Blumensorte zu ermitteln.  

Verwenden Sie dazu folgende Argumente: 

Als Suchkriterium geben Sie den Namen der Blumensorte an (also "Rosen", 

"Nelken" oder "Tulpen"). 

Als Bereich geben Sie die den Zellbereich an, der in der ersten Zeile die Namen 

der Blumensorten und darunter die Preise enthält – hier also A2:D4. 

Für n geben Sie die Stückzahl plus Eins an, denn die erste Spalte (n=1) enthält ja 

keine Preise, sondern die Namen der Pflanzen. 

Beispiele: 

SVERWEIS("Rosen"; A2:D4; 2; FALSCH) liefert den Stückpreis bei der Abnahme 

von einer Rose, also 5,50 Euro. 

SVERWEIS("Rosen"; A2:D4; 3; FALSCH) liefert den Stückpreis bei der Abnahme 

von zwei Rosen, also 5,10 Euro. 

SVERWEIS("Rosen"; A2:D4; 4; FALSCH) liefert den Stückpreis bei der Abnahme 

von drei Rosen, also 4,95 Euro. 

SVERWEIS("Nelken"; A2:D4; 4; FALSCH) liefert den Stückpreis bei der Abnah-

me von drei Nelken, also 4,50 Euro. 

SVERWEIS("Nelken"; A2:D4; 5; FALSCH) liefert den Fehlerwert #BEZUG, da n 

größer als die Zeilenzahl von Bereich ist. 

SVERWEIS("Petunien"; A2:D4; 4; FALSCH) liefert den Fehlerwert #NV, da „Pe-

tunien“ in der ersten Zeile von Bereich nicht vorkommt. 

Siehe auch: 

WVERWEIS, INDEX, VERGLEICH 

T (Wert in eine Zeichenkette umwandeln) 

Syntax: 

T(Wert) 
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Beschreibung: 

Wandelt den übergebenen Wert in eine Zeichenkette. 

Der übergebene Wert muss eine Zeichenkette sein, andernfalls liefert die Funktion 

eine leere Zeichenkette zurück. 

Hinweis: 

Diese Funktion ist nur aus Gründen der Kompatibilität mit älteren Tabellenkalkula-

tionen noch vorhanden. PlanMaker selbst benötigt sie nicht mehr, da er Werte bei 

Bedarf automatisch in Zeichenketten umwandelt. 

Beispiel: 

T("Text") ergibt Text 

T("42") ergibt 42 

T(42) ergibt eine leere Zeichenkette 

T(WAHR) ergibt eine leere Zeichenkette 

Siehe auch: 

N, WERT, TEXT 

TAG (Tag aus einem Datumswert ermitteln) 

Syntax: 

TAG(Datum) 

Beschreibung: 

Liefert den Tag eines Datumswerts. 

Beispiel: 

TAG("25.9.2018") ergibt 25 
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TAG("17. August") ergibt 17 

Siehe auch: 

ISOKALENDERWOCHE, JAHR, MONAT, WOCHENTAG 

TAGE (Differenz zwischen zwei Daten) 

Syntax: 

TAGE(Enddatum; Ausgangsdatum) 

Beschreibung: 

Liefert die Differenz zwischen zwei Datumswerten in Tagen. 

Beachten Sie dabei die Reihenfolge der Parameter: Die Funktion erwartet erst das 

Enddatum, dann das Ausgangsdatum.  

Hinweis: 

Diese Funktion wurde in PlanMaker 2016 überarbeitet: Die Reihenfolge ihrer zwei 

Parameter wurde umgedreht. 

Hintergrund: Die Funktion TAGE ist in PlanMaker schon seit langer Zeit vorhan-

den. Excel kannte diese Funktion bisher nicht. In Excel 2013 wurde dann eine 

Funktion mit dem gleichen Namen eingeführt. Diese funktioniert auch exakt so wie 

die Funktion TAGE in PlanMaker – allerdings ist die Reihenfolge der Parameter in 

Excel anders herum: erst Enddatum, dann Ausgangsdatum. Um kompatibel zu 

Excel zu sein, wurde diese Reihenfolge in PlanMaker 2016 entsprechend angegli-

chen.  

Die bisherige Version der Funktion wurde in TAGEP umbenannt. Die Funktionen 

TAGE und TAGEP sind also identisch, nur die Reihenfolge der Parameter unter-

scheidet sich: 

TAGE(Enddatum; Ausgangsdatum) entspricht 

TAGEP(Ausgangsdatum; Enddatum) 
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Kompatibilitätshinweise: 

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versio-

nen ist die Funktion unbekannt. 

Beispiel: 

TAGE("14.01.2018"; "01.1.2018") ergibt 13 

Siehe auch: 

DATEDIF, NETTOARBEITSTAGE, TAGE360, TAGEP, ZEITDIFFERENZ 

TAGE360 (Differenz zwischen zwei Daten) 

Syntax: 

TAGE360(Ausgangsdatum; Enddatum [; Methode]) 

Beschreibung: 

Die Funktion TAGE360 liefert die Differenz zwischen zwei Datumswerten in Ta-

gen. Im Unterschied zur Funktion TAGE führt sie die Berechnung jedoch auf Basis 

eines Jahres mit 360 Tagen (12 Monate à 30 Tage) durch und lässt Schaltjahre au-

ßer acht. 

Das optionale Argument Methode bestimmt, wie dabei mit Daten umgegangen 

werden soll, die auf den 31. des Monats fallen: 

FALSCH oder nicht angegeben: Es wird die amerikanische Buchführungsmetho-

de verwendet: Ist das Ausgangsdatum der 31. des Monats, wird dieses zum 30 des-

selben Monats. Ist das Enddatum der 31., wird es zum 1. des Folgemonats. 

WAHR: Es wird die europäische Buchführungsmethode verwendet: Ist Ausgangs- 

oder Enddatum der 31. des Monats, wird dieses zum 30. des Monats. 

Hinweis: 

Sofern Sie also nicht nach der amerikanischen Buchführungsmethode rechnen 

möchten, muss das Argument Methode mit WAHR angegeben werden. 
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Beispiel: 

TAGE360("1.1.2018"; "1.2.2018"; WAHR) ergibt 30 

TAGE360("1.2.2018"; "1.3.2018"; WAHR) ergibt 30 

TAGE360("1.1.2012"; "1.1.2013"; WAHR) ergibt 360 

Siehe auch: 

DATEDIF, NETTOARBEITSTAGE, TAGE, ZEITDIFFERENZ 

TAGEIMJAHR (Zahl der Tage eines Jahres) 

Syntax: 

TAGEIMJAHR(Datum) 

Beschreibung: 

Liefert die Anzahl der Tage eines bestimmten Jahres. 

Kompatibilitätshinweise: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

TAGEIMJAHR("1.1.2012") ergibt 366 (2012 war ein Schaltjahr) 

TAGEIMJAHR("1.1.2013") ergibt 365 (2013 war kein Schaltjahr) 

Siehe auch: 

JAHR, TAGE, TAGE360 
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TAGEIMMONAT (Zahl der Tage eines Monats) 

Syntax: 

TAGEIMMONAT(Datum) 

Beschreibung: 

Liefert die Anzahl der Tage eines bestimmten Monats. 

Kompatibilitätshinweise: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

TAGEIMMONAT("25.09.2018") ergibt 30 (Tage) 

TAGEIMMONAT("25.10.2018") ergibt 31 (Tage) 

TAGEP (Kompatibilitätsfunktion) 

Syntax: 

TAGEP(Ausgangsdatum; Zieldatum) 

Beschreibung: 

Kompatibilitätsfunktion für ältere PlanMaker-Dokumente.  

Diese Funktion wurde durch die Funktion TAGE ersetzt. (Beachten Sie, dass bei 

dieser die Reihenfolge der Parameter genau umgekehrt ist.) 

Siehe nachfolgende Hinweise. 
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Hinweis: 

TAGEP ist lediglich eine Kompatibilitätsfunktion. Wenn Sie ein Dokument öffnen, 

das mit PlanMaker 2012 oder früher erstellt wurde, werden darin alle Vorkommen 

der Funktion TAGE automatisch in TAGEP konvertiert. Grund: In PlanMaker 2016 

wurde die Reihenfolge der Parameter für die Funktion TAGE umgedreht. 

Für neue Dokumente sollten Sie statt dieser Funktion vorzugsweise die Excel 

2013-kompatible Funktion TAGE verwenden. Diese ist völlig identisch – bis auf 

die vertauschte Reihenfolge der Parameter: 

TAGE(Enddatum; Ausgangsdatum) entspricht 

TAGEP(Ausgangsdatum; Enddatum) 

Kompatibilitätshinweise: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

TAGEP("01.1.2018"; "14.01.2018") ergibt 13 

Siehe auch: 

TAGE 

TAN (Tangens) 

Syntax: 

TAN(Zahl) 

Beschreibung: 

Liefert den Tangens eines Winkels.  

Der Winkel ist dabei im Bogenmaß (Radiant) anzugeben. 
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Tipp: 

Mit der Funktion BOGENMASS können Sie einen in Grad vorliegenden Winkel 

ins Bogenmaß umrechnen. 

Beispiel: 

TAN(PI()/4) ergibt 1 

TAN(BOGENMASS(45)) ergibt 1 

Siehe auch: 

ARCTAN 

TANHYP (Tangens Hyperbolicus) 

Syntax: 

TANHYP(Zahl) 

Beschreibung: 

Die Funktion TANHYP (Tangens Hyperbolicus) liefert den hyperbolischen Tan-

gens einer Zahl. 

Beispiel: 

TANHYP(0,45) ergibt 0,4219 

Siehe auch: 

ARCTANHYP 
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TEIL (Teil einer Zeichenkette) 

Syntax: 

TEIL(Zeichenkette; Start; Anzahl) 

Beschreibung: 

Liefert einen Teil einer Zeichenkette.  

Das Teilstück beginnt bei Start und ist Anzahl Zeichen lang. 

Beispiel: 

TEIL("Kartoffel"; 2; 3) ergibt art 

TEIL("Kartoffel"; 2; 8) ergibt artoffel 

TEIL("Kartoffel"; 2; 100) ergibt artoffel 

TEIL("Kartoffel"; 100; 100) ergibt eine leere Zeichenkette 

Siehe auch: 

LINKS, RECHTS, ERSETZEN, FINDEN, SUCHEN 

TEILERGEBNIS (Berechnungen ohne ausgeblendete Zellen) 

Syntax: 

TEILERGEBNIS(Funktionsnummer; Bereich1 [; Bereich2; Bereich3...]) 

Beschreibung: 

Diese Funktion wendet eine der unten aufgelisteten Rechenfunktionen auf einen 

oder mehrere Zellbereiche an, ignoriert dabei jedoch alle Zellen, die momentan 

ausgeblendet sind. 
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Im Detail: Wenn Sie mit dem Menübefehl Arbeitsblatt > Filter Teile eines Zellbe-

reichs herausfiltern und dann beliebige Rechenfunktionen auf diesen Bereich an-

wenden, beziehen diese immer auch die gefilterten Zellen mit ein. Anders sieht es 

bei der Funktion TEILERGEBNIS aus: diese ignoriert die gefilterten Zellen. 

Bei Bereich1, Bereich2 etc. geben Sie den Zellbereich oder die Zellbereiche an, 

die Sie auswerten möchten. 

Mit dem Argument Funktionsnummer bestimmen Sie, welche Rechenfunktion 

angewandt werden soll. Geben Sie dazu einen Zahlenwert zwischen 1 und 11 ge-

mäß folgender Tabelle ein: 

Wert Rechenfunktion Erläuterung 

1: MITTELWERT (arithmetisches Mittel) 

2: ANZAHL (wie viele Zellen sind mit Zahlen ausgefüllt?) 

3: ANZAHL2 (wie viele Zellen sind ausgefüllt?) 

4: MAX (größter Wert) 

5: MIN (kleinster Wert) 

6: PRODUKT (Produkt) 

7: STABW (Standardabweichung Stichprobe) 

8: STABWN (Standardabweichung Grundgesamtheit) 

9: SUMME (Summe) 

10: VARIANZ (Varianz Stichprobe) 

11: VARIANZEN (Varianz Grundgesamtheit) 

Tragen Sie für Funktionsnummer also beispielsweise 9 ein, liefert TEILERGEB-

NIS die Summe des Zellbereichs – ignoriert dabei aber alle Zellen, die mit dem 

Menübefehl Arbeitsblatt > Filter ausgeblendet wurden. 

Manuell ausgeblendete Zellen ebenfalls ignorieren: 

Es gibt noch eine zweite Variante dieser Funktion. Bei dieser werden zusätzlich 

alle Zeilen ignoriert, die manuell ausgeblendet wurden (zum Beispiel mit dem Me-

nübefehl Arbeitsblatt > Zeile Ausblenden oder dem Menübefehl Arbeitsblatt > 

Gliederung > Gruppieren). Um diese Variante einzusetzen, verwenden Sie für die 

Funktionsnummer einfach Werte von 101 bis 111 anstelle von Werten von 1 bis 

11: 

Wert Rechenfunktion Erläuterung 

101: MITTELWERT (arithmetisches Mittel) 

102: ANZAHL (wie viele Zellen sind mit Zahlen ausgefüllt?) 

103: ANZAHL2 (wie viele Zellen sind ausgefüllt?) 

104: MAX (größter Wert) 

105: MIN (kleinster Wert) 

106: PRODUKT (Produkt) 

107: STABW (Standardabweichung Stichprobe) 

108: STABWN (Standardabweichung Grundgesamtheit) 

109: SUMME (Summe) 
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110: VARIANZ (Varianz Stichprobe) 

111: VARIANZEN (Varianz Grundgesamtheit) 

Tragen Sie für Funktionsnummer also beispielsweise 109 ein, liefert TEILER-

GEBNIS die Summe des Zellbereichs – ignoriert dabei aber alle Zellen, die mit 

dem Menübefehl Arbeitsblatt > Filter ausgeblendet wurden. Außerdem werden 

alle Zeilen ignoriert, die über die Menübefehle Arbeitsblatt > Zeile > Ausblenden 

oder mit Arbeitsblatt > Gliederung > Gruppieren manuell ausgeblendet wurden.  

Beachten Sie: Hierbei wird nur das Ausblenden von Zeilen berücksichtigt, das 

Ausblenden von Spalten spielt keine Rolle. 

Beispiel: 

TEILERGEBNIS(9; A1:A10) berechnet die Summe des Bereichs A1:A10, igno-

riert dabei jedoch alle mit dem Menübefehl Arbeitsblatt > Filter herausgefilterten 

Zellen. 

Siehe auch: 

Informationen zu Filtern finden Sie im Abschnitt „Filtern“ ab Seite 109. 

TEXT (Zahl in formatierten Text wandeln) 

Syntax: 

TEXT(Zahl; Format) 

Beschreibung: 

Wandelt eine Zahl in eine Zeichenkette mit beliebig definierbarer Formatierung 

um.  

Über das Argument Format geben Sie die gewünschte Formatierung an. Tragen 

Sie hier eine entsprechende Zeichenkette ein. Diese muss aufgebaut sein wie eine 

Zeichenkette, die Sie beim Anlegen benutzerdefinierter Zahlenformate mit dem 

Menübefehl Format > Zelle eingeben (siehe Abschnitt „Aufbau eines benutzerde-

finierten Zahlenformats“ ab Seite 175). 
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Anmerkung: 

Wenn Sie das Format von Zahlen ändern möchten, ohne sie dabei in eine Zeichen-

kette zu wandeln, rufen Sie den Menübefehl Format > Zelle auf und wählen das 

gewünschte Zahlenformat. 

Beispiel: 

TEXT("25.9.2018"; "TT.MM.JJ") ergibt den Text 25.09.18 

TEXT(2,715; "0,00 ""EUR""") ergibt den Text 2,72 EUR 

Siehe auch: 

WERT, T, N 

TINV (Quantile einer t-Verteilung) 

Syntax: 

TINV(Wahrscheinlichkeit; Freiheitsgrade) 

Beschreibung: 

Liefert Quantile einer t-Verteilung.  

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der t-Verteilung. Zu-

lässig sind nur Werte aus dem Intervall [0..1]. 

Freiheitsgrade bestimmt die Zahl der Freiheitsgrade. Dieser Wert darf nicht klei-

ner als 1 sein. Erwartet wird jeweils eine ganze Zahl; ist dies nicht der Fall, schnei-

det PlanMaker die Nachkommastellen automatisch ab. 

Hinweis: 

Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. 

Findet PlanMaker nach 100 Iterationen kein Ergebnis, das weniger als 3x10^-7 

von Wahrscheinlichkeit abweicht, zeigt er den Fehlerwert #NV an und bricht die 

Näherung ab. 
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Siehe auch: 

TTEST, TVERT 

TREND (Werte einer linearen Regression) 

Syntax: 

TREND(y_Werte [; x_Werte] [; Neue_x_Werte] [; Konstante]) 

Beschreibung: 

Liefert die Werte einer linearen Regression. 

Unter einer linearen Regression versteht man das Anpassen einer linearen Funktion 

(Regressionsgerade oder Ausgleichsgerade genannt) an eine Menge von Punkten 

(zum Beispiel den Messpunkten einer Messreihe). 

TREND erwartet als Argumente die y-Werte (und, sofern angegeben, die zugehöri-

gen x-Werte) und liefert als Ergebnis eine Matrix mit den entsprechenden y-

Koordinaten der Regressionsgeraden. 

Im Einzelnen erwartet die Funktion folgende Argumente: 

y_Werte: Hier geben Sie die vorliegenden y-Koordinaten, also die abhängigen 

Werte, an. y_Werte kann entweder ein Zellbezug oder eine Matrix sein. 

x_Werte: Hier können optional die x-Koordinaten, also die unabhängigen Werte 

angegeben werden. Auch x_Werte kann entweder ein Zellbezug oder eine Matrix 

sein. Wird x_Werte nicht angegeben, verwendet die Funktion automatisch die 

Werte 1, 2, 3, ... (entsprechend der Anzahl der vorliegenden y_Werte). 

Neue_x_Werte: Wird dieses Argument nicht angegeben, liefert die Ergebnismatrix 

dieser Funktion die y-Koordinaten der Regressionsgeraden entsprechend den in 

x_Werte angegebenen x-Koordinaten. Bei Bedarf können Sie mit Neue_x_Werte 

jedoch andere x-Koordinaten angeben. Auch Neue_x_Werte kann entweder ein 

Zellbezug oder eine Matrix sein.  

Konstante: Mit dem optionalen Argument Konstante können Sie festlegen, ob die 

Konstante b (der y-Achsenabschnitt) auf Null gesetzt werden soll: 

WAHR oder nicht angegeben: b wird aus den vorliegenden Daten automatisch be-

rechnet. 
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FALSCH: b wird auf Null gesetzt. Die Regressionsgerade wird dadurch gezwun-

gen, durch den Nullpunkt zu laufen. Dies geschieht durch entsprechendes Anpas-

sen des Koeffizienten m. 

Hinweis: 

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu fin-

den Sie im Abschnitt „Arbeiten mit Matrizen“ ab Seite 516. 

Anmerkung: 

Die lineare Regression wird bei dieser Funktion mit Hilfe der Methode der kleins-

ten Quadrate durchgeführt. 

Beispiel: 

Von einem temperaturabhängigen Widerstand wurde gemessen, welcher Wider-

stand bei verschiedenen Temperaturen vorliegt. 

In den Zellen A1 bis A4 sind die x-Koordinaten der Messpunkte eingetragen (also 

die unabhängigen Variablen; in unserem Beispiel ist das die Temperatur): 8, 20, 25, 

28 

In den Zellen B1 bis B4 sind die y-Koordinaten eingetragen (also die abhängigen 

Variablen; in unserem Beispiel ist dies der Widerstand): 261, 508, 608, 680 

Mit der folgenden Formel erhalten Sie die y-Koordinaten der entsprechenden 

Punkte auf der Regressionsgeraden (als Matrix): 

TREND(B1:B4; A1:A4) 

Siehe auch: 

RGP, RKP, VARIATION 

TTEST (t-Test) 

Syntax: 

TTEST(Werte1; Werte2; Seiten; Typ) 
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Beschreibung: 

Liefert die Teststatistik eines Studentschen t-Tests.  

Mit einem t-Test kann die Konsistenz der Mittelwerte zweier Stichproben geprüft 

werden. 

Werte1 und Werte2 sind die zu untersuchenden Wertebereiche (Stichproben). 

Seiten bestimmt, ob ein ein- oder ein zweiseitiger Test verwendet werden soll: 

1: einseitiger Test 

2: zweiseitiger Test 

Typ bestimmt die Art des Tests: 

1: abhängige Stichproben („gepaart“) 

2: unabhängige Stichproben, gleiche Varianzen („homoskedastisch“) 

3: unabhängige Stichproben, ungleiche Varianzen („heteroskedastisch“) 

Siehe auch: 

TINV, TVERT 

TVERT (t-Verteilung) 

Syntax: 

TVERT(X; Freiheitsgrade; Seiten) 

Beschreibung: 

Liefert Werte der Verteilungsfunktion einer t-verteilten (Student-verteilten) Zu-

fallsvariablen. 

X ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. X darf keine ne-

gative Zahl sein. 

Freiheitsgrade bestimmt die Zahl der Freiheitsgrade. Dieser Wert darf nicht klei-

ner als 1 sein. Erwartet wird jeweils eine ganze Zahl; ist dies nicht der Fall, schnei-

det PlanMaker die Nachkommastellen automatisch ab. 
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Seiten bestimmt, ob ein ein- oder ein zweiseitiger Test verwendet werden soll: 

1: einseitiger Test 

2: zweiseitiger Test 

Siehe auch: 

TINV, TTEST 

TYP (Typ des Arguments ermitteln) 

Syntax: 

TYP(Wert) 

Beschreibung: 

Liefert den Datentyp des Arguments in Form einer Zahl. 

Welche Zahl für welchen Typ steht, können Sie der nachfolgenden Tabelle ent-

nehmen: 

Argument ist ... Ergebnis 

Zahl oder leere Zelle 1 

Zeichenkette 2 

Wahrheitswert 4 

Fehlerwert 16 

Matrix 64 

Beispiel: 

TYP(42) ergibt 1 

Steht in Zelle A1 die Zeichenkette "Text", so gilt: 

TYP(A1) ergibt 2 
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Siehe auch: 

FEHLER.TYP 

UMWANDELN (Maßeinheiten umrechnen) 

Syntax: 

UMWANDELN(Zahl; Quelleinheit, Zieleinheit) 

Beschreibung: 

Wandelt eine Zahl von einer Einheit in eine andere um. 

Die Argumente Quelleinheit und Zieleinheit geben Sie mit Hilfe der Codes in der 

nachfolgenden Tabelle an.  

Beide Einheiten müssen aus der gleichen Kategorie sein. So können Sie beispiels-

weise Meter in Meilen umrechnen, aber natürlich nicht in Gramm. 

Wenn diese Funktion den Fehlerwert #NV zurückliefert, liegt dies meist daran, 

dass a) Quelleinheit und Zieleinheit nicht aus derselben Kategorie stammen oder b) 

einer der beiden Codes in falscher Schreibweise angegeben wurde. 

Achten Sie genau auf die Groß-/Kleinschreibung der Codes! 

Es gibt folgende Codes: 

Masse Code 

Gramm g 

Stück (Gewichtseinheit) sg 

Pfund* (Handelsgewicht) lbm 

u (Atommasse) u 

Unze ozm 

* Entspricht nicht dem im deutschen Sprachraum teil-

weise noch verwendeten Pfund (½ Kilo) 

 

Länge Code 

Meter m 

Meile (Landmeile) mi 

Meile (nautische Meile) Nmi 

Zoll (Inch) in 

Fuß (Feet) ft 

Yard yd 
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Ångström ang 

Pica Pica 

Lichtjahr* ly 

Parsec (Parallaxensekunde)* parsec 

* Diese Einheit wird von Excel nicht unterstützt.  

Zeit Code 

Sekunde sec 

Minute mn 

Stunde hr 

Tag day 

Jahr** yr 

Fortnight* ftn 

* Diese Einheit wird von Excel nicht unterstützt.  

** Basierend auf einem Jahr mit 365,25 Tagen  

Flüssigkeitsmaße Code 

Liter l (kleines „L“) 

Teelöffel (Teaspoon) tsp 

Esslöffel (Tablespoon) tbs 

Flüssige Unze (Ounce) oz 

Tasse (Cup) cup 

Pint (U.S.) pt 

Pint (U.K.) uk_pt 

Quart (amerikanisches) qt 

Gallone (amerikanische) gal 

Kraft Code 

Newton N 

Dyne dyn 

Pound-force lbf 

Leistung Code 

Watt W 

PS HP 

Feldstärke Code 

Tesla T 

Gauß ga 

Energie Code 

Joule J 

Erg e 

Thermodynamische Kalorie c 

Kalorie cal 

Elektronvolt eV 
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PS mal Stunde HPh 

Wattstunden Wh 

Foot-pound force flb 

BTU (British Thermal Unit) BTU 

Druck Code 

Pascal Pa 

Atmosphären atm 

mm Quecksilbersäule mmHg 

Temperatur Code 

Grad Fahrenheit F 

Grad Celsius C 

Grad Kelvin K 

Weiterhin können Sie vor den Code einen der gebräuchlichen Präfixe setzen. So 

lässt sich beispielsweise der Präfix „m“ (Milli...) mit der Einheit „g“ (Gramm) zur 

Einheit „mg“ (Milligramm) kombinieren. 

Achten Sie auch hier genau auf die Groß-/Kleinschreibung! 

Es gibt folgende Präfixe: 

Präfix (und Faktor) Code 

Exa (10^18) E 

Peta (10^15) P 

Tera (10^12) T 

Giga (10^9) G 

Mega (10^6) M 

Kilo (1000) k 

Hekto (100) h 

Deka (10) e 

Dezi (0,1) d 

Zenti (0,01) c 

Milli (0,001) m 

Mikro (10^-6) u 

Nano (10^-9) n 

Piko (10^-12) p 

Femto (10^-15) f 

Atto (10^-18) a 

Beispiel: 

UMWANDELN(1; "day"; "sec") ergibt 86400 (Tage -> Sekunden) 

UMWANDELN(1; "mi"; "km") ergibt 1,60934 (Meilen -> Kilometer) 

UMWANDELN(100; "kW"; "HP") ergibt 134,10201 (100 kW -> PS) 
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UMWANDELN(1;"aparsec";"cm") ergibt 3,08568 (Attoparsec -> cm) 

UND (Logisches UND) 

Syntax: 

UND(Wahrheitswert1 [; Wahrheitswert2; Wahrheitswert3 ...]) 

Beschreibung: 

Diese Funktion liefert WAHR, wenn alle ihr übergebenen Wahrheitswerte WAHR 

sind, ansonsten liefert sie FALSCH. 

Sie können damit beispielsweise prüfen, ob mehrere Bedingungen allesamt zutref-

fen. 

Beispiel: 

UND(WAHR; WAHR) ergibt WAHR 

UND(WAHR; FALSCH) ergibt FALSCH 

UND(FALSCH; FALSCH) ergibt FALSCH 

UND(A1>0; A1<1) ergibt WAHR; wenn A1 größer als Null und kleiner als Eins 

ist. 

Siehe auch: 

ODER, XODER, NICHT 

UNGERADE (Aufrunden auf eine ungerade Zahl) 

Syntax: 

UNGERADE(Zahl) 
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Beschreibung: 

Rundet Zahl auf die betragsmäßig nächstgrößere ungerade Zahl auf. 

Beispiel: 

UNGERADE(41) ergibt 41 

UNGERADE(42) ergibt 43 

UNGERADE(-42) ergibt -43 

Siehe auch: 

GERADE, VRUNDEN, RUNDEN, ISTUNGERADE 

UNTERGRENZE (Abrunden auf ein Vielfaches von n) 

Syntax: 

UNTERGRENZE(Zahl; Basis) 

Beschreibung: 

Rundet Zahl auf ein Vielfaches von Basis ab. 

Bei positiven Zahlen wird auf das nächstkleinere Vielfache von Basis abgerundet, 

bei negativen Zahlen wird hingegen auf das nächstgrößere Vielfache aufgerundet. 

Zahl und Basis müssen das gleiche Vorzeichen haben, sonst liefert die Funktion 

den Fehlerwert #ZAHL! 

Beispiel: 

UNTERGRENZE(42,5; 1) ergibt 42 

UNTERGRENZE(-42,5; -1) ergibt -42 

UNTERGRENZE(21; 5) ergibt 20 

UNTERGRENZE(12,3456; 0,01) ergibt 12,34 



 

Handbuch PlanMaker Formeln und Funktionen  •  779 

Siehe auch: 

OBERGRENZE, VRUNDEN, RUNDEN, KÜRZEN 

VARIANZ (Varianz einer Stichprobe) 

Syntax: 

VARIANZ(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Liefert einen Schätzwert für die Varianz einer Grundgesamtheit anhand einer 

Stichprobe. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Werte (Stichprobe).  

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder 

Wahrheitswerte enthalten, so werden diese ignoriert. 

Anmerkung: 

Die Varianz wird nach der Methode „Erwartungstreue Schätzung“ oder „n-1“ be-

rechnet. 

Beispiel: 

VARIANZ(2; 2; 3; 4; 1) ergibt 1,3 

Siehe auch: 

VARIANZA, VARIANZEN, STABW, STABWN 

VARIANZA (Varianz) 

Syntax: 

VARIANZA(Zahl1; Zahl2 [; Zahl3 ...]) 
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Beschreibung: 

Die Funktion VARIANZA entspricht nahezu der Funktion VARIANZ (siehe Hin-

weis). Sie liefert also einen Schätzwert für die Varianz einer Grundgesamtheit an-

hand einer Stichprobe. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Werte (Stichprobe).  

Hinweis: 

Im Gegensatz zu VARIANZ berücksichtigt die Funktion VARIANZA auch Werte, 

die keine Zahlen sind: Beliebige Zeichenketten und der Wahrheitswert FALSCH 

werden als 0 interpretiert, WAHR als 1. 

Leere Zellen werden hingegen auch hier ignoriert. 

Anmerkung: 

Die Varianz wird nach der Methode „Erwartungstreue Schätzung“ oder „n-1“ be-

rechnet. 

Beispiel: 

VARIANZA(2; 2; 3; 4; 1) ergibt 1,3 

Siehe auch: 

VARIANZ 

VARIANZEN (Varianz einer Grundgesamtheit) 

Syntax: 

VARIANZEN(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Liefert die Varianz einer vollständigen Grundgesamtheit. 
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Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte. Es müssen alle Werte 

der Grundgesamtheit angegeben werden. Falls nur eine Stichprobe aus der Grund-

gesamtheit vorliegt, ist statt VARIANZEN die Funktion VARIANZ zu verwenden. 

Diese liefert einen Schätzwert für die Varianz. 

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder 

Wahrheitswerte enthalten, so werden diese ignoriert. 

Anmerkung: 

Die Varianz wird nach der Methode „n“ berechnet. 

Beispiel: 

VARIANZEN(2; 2; 3; 4; 1) ergibt 1,04 

Siehe auch: 

VARIANZ, STABW, STABWN 

VARIANZENA (Varianz) 

Syntax: 

VARIANZENA(Zahl1; Zahl2 [; Zahl3 ...]) 

Beschreibung: 

Die Funktion VARIANZENA entspricht nahezu der Funktion VARIANZEN (siehe 

Hinweis). Sie liefert also die Varianz einer vollständigen Grundgesamtheit. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte. Es müssen alle Werte 

der Grundgesamtheit angegeben werden. Falls nur eine Stichprobe aus der Grund-

gesamtheit vorliegt, ist statt VARIANZENA die Funktion VARIANZA oder VA-

RIANZ zu verwenden. Diese liefert einen Schätzwert für die Varianz. 
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Hinweis: 

Im Gegensatz zu VARIANZEN berücksichtigt die Funktion VARIANZENA auch 

Werte, die keine Zahlen sind: Beliebige Zeichenketten und der Wahrheitswert 

FALSCH werden als 0 interpretiert, WAHR als 1. 

Leere Zellen werden hingegen auch hier ignoriert. 

Beispiel: 

VARIANZENA(2; 2; 3; 4; 1) ergibt 1,04 

Siehe auch: 

VARIANZEN 

VARIATION (Werte einer exponentiellen Regression) 

Syntax: 

VARIATION(y_Werte [; x_Werte] [; Neue_x_Werte] [; Konstante]) 

Beschreibung: 

Liefert die Werte einer exponentiellen Regression. 

Unter einer exponentiellen Regression versteht man das Anpassen einer Exponenti-

alkurve an eine Menge von Punkten (zum Beispiel den Messpunkten einer Mess-

reihe). 

VARIATION erwartet als Argumente die y-Werte (und, sofern angegeben, die zu-

gehörigen x-Werte) und liefert als Ergebnis eine Matrix mit den y-Koordinaten der 

Exponentialkurve. 

Im Einzelnen erwartet die Funktion folgende Argumente: 

y_Werte: Hier geben Sie die vorliegenden y-Koordinaten, also die abhängigen 

Werte, an. y_Werte kann entweder ein Zellbezug oder eine Matrix sein. Es sind 

nur positive Werte zulässig; andernfalls liefert die Funktion den Fehlerwert 

#ZAHL. 
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x_Werte: Hier können optional die x-Koordinaten, also die unabhängigen Werte 

angegeben werden. Auch x_Werte kann entweder ein Zellbezug oder eine Matrix 

sein. Wird x_Werte nicht angegeben, verwendet die Funktion automatisch die 

Werte 1, 2, 3, ... (entsprechend der Anzahl der vorliegenden y_Werte). 

Neue_x_Werte: Wird dieses Argument nicht angegeben, liefert die Ergebnismatrix 

dieser Funktion die y-Koordinaten der Regressionsgeraden entsprechend den in 

x_Werte angegebenen x-Koordinaten. Bei Bedarf können Sie mit Neue_x_Werte 

jedoch andere x-Koordinaten angeben. Auch Neue_x_Werte kann entweder ein 

Zellbezug oder eine Matrix sein.  

Konstante: Mit dem optionalen Argument Konstante können Sie festlegen, ob die 

Konstante b auf Eins gesetzt werden soll: 

WAHR oder nicht angegeben: b wird aus den vorliegenden Daten automatisch be-

rechnet. 

FALSCH: b wird fest auf Eins gesetzt und die Kurve durch Anpassen des Koeffi-

zienten m entsprechend „hingebogen“. 

Hinweis: 

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu fin-

den Sie im Abschnitt „Arbeiten mit Matrizen“ ab Seite 516. 

Siehe auch: 

RGP, RKP, TREND 

VARIATIONEN (Variationen) 

Syntax: 

VARIATIONEN(n; k) 

Beschreibung: 

Ermittelt die Anzahl der geordneten Stichproben vom Umfang k, die man einer 

Gesamtheit von n verschiedenen Elementen ohne Zurücklegen entnehmen kann. 



 

784  •  Formeln und Funktionen Handbuch PlanMaker 

n gibt an, aus wie vielen Elementen die Gesamtheit besteht. n muss größer als k 

sein. 

k gibt an, wie viele Elemente in einer Stichprobe gezogen werden sollen. k muss 

größer als 0 und kleiner als n sein. 

n und k sollten natürlich ganze Zahlen sein. Ist das nicht der Fall, kürzt PlanMaker 

die Nachkommastellen automatisch weg. 

Anmerkung: 

VARIATIONEN unterscheidet sich von KOMBINATIONEN wie folgt: Bei den 

Variationen darf die Reihenfolge der gezogenen Elemente nachträglich nicht mehr 

verändert werden, bei den Kombinationen spielt sie keine Rolle.  

Mit VARIATIONEN können Sie also zum Beispiel berechnen, wie viele Möglich-

keiten es für die ersten 3 Plätze eines Wettlaufs mit 10 Teilnehmern gibt. Mit 

KOMBINATIONEN können Sie hingegen ermitteln, wie viele Möglichkeiten es 

beim Ziehen von 6 Kugeln aus 49 gibt. 

Der Unterschied: Während sich die Reihenfolge der gezogen Lottozahlen nach 

Belieben ändern lässt (sie könnten diese also zum Beispiel nachträglich aufsteigend 

sortieren), würden die Läufer natürlich protestieren, wenn Sie die Plätze 1-3 nun 

plötzlich nach den Anfangsbuchstaben der Nachnamen umsortieren würden.  

Bei den Variationen spielt also die Anordnung eine Rolle; bei den Kombinationen 

hingegen nicht. 

Beispiel: 

Greifen wir gleich das Beispiel mit den Läufern auf. Sie möchten wissen, wie viele 

Variationen es für die ersten 3 Plätze eines Wettlaufs mit 10 Läufern gibt. Die For-

mel hierfür lautet: 

VARIATIONEN(10; 3) 

Ergebnis: Es gibt 720 Variationsmöglichkeiten. 

Siehe auch: 

KOMBINATIONEN 
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VERGLEICH (Position eines Werts in einem Bereich) 

Syntax: 

VERGLEICH(Suchkriterium; Suchvektor [; Modus]) 

Beschreibung: 

Durchsucht einen Vektor (also einen eindimensionalen Zellbereich) nach einem 

Suchkriterium und liefert dann dessen Position innerhalb dieses Zellbereichs. Ist 

das Suchkriterium also das fünfte Element des Suchvektors, liefert die Funktion 

das Ergebnis 5. 

Suchkriterium ist der gesuchte Wert. Zulässig sind alle Werte von Werten oder ein 

Zellbezug. 

Suchvektor ist der zu durchsuchende Zellbereich. Dieser kann entweder Zeichen-

ketten, Zahlen oder Wahrheitswerte enthalten. Es muss sich dabei um einen Vektor 

handeln (also um einen Bereich mit entweder nur einer Zeile oder einer Spalte). 

Modus gibt an, welche Art von Suche durchgeführt werden soll: 

1 oder nicht angegeben: Es wird der größte Wert gesucht, der kleiner oder gleich 

Suchkriterium ist. Wichtig: Die Elemente im Suchvektor müssen bei diesem Mo-

dus aufsteigend sortiert sein. Andernfalls liefert die Funktion möglicherweise fal-

sche Ergebnisse.  

0: Es wird der Wert gesucht, der dem Suchkriterium genau entspricht. Die Elemen-

te im Suchvektor brauchen bei diesem Modus nicht sortiert zu sein.  

-1: Es wird der kleinste Wert gesucht, der größer oder gleich Suchkriterium ist. 

Wichtig: Die Elemente im Suchvektor müssen bei diesem Modus absteigend sor-

tiert sein. Andernfalls liefert die Funktion möglicherweise falsche Ergebnisse.  

Tipp: Wenn Sie Modus 0 verwenden und nach einer Zeichenkette suchen, darf das 

Suchkriterium darf auch Platzhalter enthalten: ein Fragezeichen (?) steht für ein 

beliebiges Zeichen, ein Sternchen (*) für beliebig viele Zeichen. 

Beispiel: 

VERGLEICH("b"; {"a";"b";"c";"d"}; 0) ergibt 2. "b" ist also das zweite Element 

des durchsuchten Vektors. 
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Siehe auch: 

INDEX, SVERWEIS, VERWEIS, WVERWEIS 

VERKETTEN (Zeichenketten verbinden) 

Syntax: 

VERKETTEN(Zeichenkette1 [; Zeichenkette2; Zeichenkette3 ...]) 

Beschreibung: 

Verbindet zwei oder mehr Zeichenketten zu einer einzigen Zeichenkette. 

Anmerkung: 

Der Operator & tut exakt das gleiche. VERKETTEN("Text1"; "Text2") entspricht 

also "Text1" & "Text2". 

Beispiel: 

VERKETTEN("Guten "; "Morgen") ergibt Guten Morgen 

VERKETTEN(2; " Stück"; " Zucker") ergibt 2 Stück Zucker 

VERWEIS (Zellbereich durchsuchen) 

Vorbemerkung: 

Die Funktion VERWEIS durchsucht einen Zellbereich nach einem Suchkriterium 

(also z.B. nach einer Zahl oder einer Zeichenkette) und liefert dann den Inhalt einer 

anderen Zelle mit entsprechender Position.  

Die zu durchsuchenden Daten müssen dabei in sortierter Reihenfolge vorliegen. 

Tipp: Es gibt zwei Alternativen zu dieser Funktion, die auch mit unsortierten Daten 

zurechtkommen und zudem etwas flexibler sind: SVERWEIS und WVERWEIS. 

Die Funktion VERWEIS kann auf zwei verschiedene Arten eingesetzt werden: 
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Variante mit zwei eindimensionalen Bereichen: Hier werden der Funktion zwei 

Vektoren (also eindimensionale Bereiche) übergeben: Suchvektor und Ergebnis-

vektor. Findet die Funktion das Suchkriterium im Suchvektor, liefert sie als Er-

gebnis die Zelle mit der gleichen Position im Ergebnisvektor. 

Variante mit einem zweidimensionalen Bereich: Hier wird der Funktion ein 

zweidimensionaler Bereich übergeben. Findet sie das Suchkriterium in der ersten 

Zeile (beziehungsweise Spalte) dieses Bereichs, liefert sie als Ergebnis die Zelle 

mit der gleichen Position in der letzten Zeile (beziehungsweise Spalte) dieses Be-

reichs. 

Variante mit zwei eindimensionalen Bereichen 

Syntax: 

VERWEIS(Suchkriterium; Suchvektor; Ergebnisvektor) 

Beschreibung: 

Diese Variante der Funktion VERWEIS durchsucht den Zellbereich Suchvektor 

nach dem Suchkriterium. Wird es gefunden, liefert sie den Inhalt der Zelle, die 

sich in der gleichen Zeile/Spalte im Zellbereich Ergebnisvektor befindet. 

Suchkriterium ist der gesuchte Wert. Die Groß-/Kleinschreibung spielt keine Rol-

le. 

Suchvektor ist der zu durchsuchende Zellbereich. Dieser kann Zeichenketten, 

Zahlen oder Wahrheitswerte enthalten. Es muss sich dabei allerdings um einen 

Vektor (also einen eindimensionalen Bereich) handeln, was bedeutet, dass Such-

vektor entweder nur eine Zeile oder nur eine Spalte umfassen darf. 

Wichtig: Die Werte in Suchvektor müssen aufsteigend sortiert sein. Andernfalls 

liefert diese Funktion möglicherweise falsche Ergebnisse. Falls die Werte nicht 

sortiert sind, können Sie alternativ die Funktionen SVERWEIS oder WVERWEIS 

verwenden. 

Ergebnisvektor ist der Zellbereich, aus dem das Ergebnis der Funktion geliefert 

werden soll. Auch dieser Bereich muss ein Vektor sein. Außerdem muss seine Grö-

ße und seine Ausrichtung (horizontal oder vertikal) der von Ergebnisvektor ent-

sprechen. 
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Hinweis: 

Wenn VERWEIS keinen exakt mit dem Suchkriterium übereinstimmenden Wert 

findet, wird automatisch der nächstkleinere Wert genommen. 

Existiert kein kleinerer Wert, weil Suchkriterium kleiner als der kleinste vorhan-

dene Wert ist, liefert die Funktion den Fehlerwert #NV. 

Beispiel: 

Bei folgender Tabelle ... 

 

... liefert VERWEIS folgende Ergebnisse: 

VERWEIS(1; A1:A3; B1:B3) ergibt Ergebnis_1 

VERWEIS(2; A1:A3; B1:B3) ergibt Ergebnis_2 

VERWEIS(3; A1:A3; B1:B3) ergibt Ergebnis_3 

VERWEIS(2,5; A1:A3; B1:B3) ergibt Ergebnis_2 (da hier der nächstkleinere Wert 

genommen wird) 

VERWEIS(10; A1:A3; B1:B3) ergibt Ergebnis_3 (aus dem gleichen Grund) 

VERWEIS(0; A1:A3; B1:B3) ergibt #NV 

Siehe auch: 

SVERWEIS, WVERWEIS, INDEX, VERGLEICH 

Variante mit einem zweidimensionalen Bereich 

Syntax: 

VERWEIS(Suchkriterium; Bereich) 
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Beschreibung: 

Diese Variante der Funktion VERWEIS durchsucht die erste Spalte von Bereich 

nach dem Suchkriterium. Wird es gefunden, liefert sie den Inhalt der Zelle, die 

sich in der gleichen Zeile der letzten Spalte von Bereich befindet. 

Alternativ kann diese Funktion den Bereich auch spaltenweise durchsuchen. Die 

Suchrichtung wird nämlich durch die Dimensionen von Bereich bestimmt:  

Umfasst Bereich mehr Spalten als Zeilen, durchsucht die Funktion die erste Zeile 

und liefert den Wert aus der letzten Zeile.  

Umfasst Bereich mehr Zeilen als Spalten oder ist quadratisch, durchsucht die 

Funktion die erste Spalte und liefert den Wert aus der letzten Spalte.  

Suchkriterium ist der gesuchte Wert. Die Groß-/Kleinschreibung spielt keine Rol-

le. 

Bereich ist der zu durchsuchende Bereich. Er muss in der ersten Zeile (bezie-

hungsweise Spalte) die zu durchsuchenden Werte und in der letzten Zeile (bezie-

hungsweise Spalte) die zu liefernden Ergebnisse enthalten. Es kann sich dabei um 

Zeichenketten, Zahlen oder Wahrheitswerte handeln. Der Bereich muss zweidi-

mensional sein, also mindestens zwei Zeilen und zwei Spalten umfassen. 

Wichtig: Die Werte in der ersten Zeile (beziehungsweise Spalte) müssen aufstei-

gend sortiert sein. Andernfalls liefert diese Funktion möglicherweise falsche Er-

gebnisse. Falls die Werte nicht sortiert sind, können Sie alternativ die Funktionen 

SVERWEIS oder WVERWEIS verwenden. 

Hinweis: 

Wenn VERWEIS keinen exakt mit dem Suchkriterium übereinstimmenden Wert 

findet, wird automatisch der nächstkleinere Wert genommen. 

Existiert kein kleinerer Wert, weil Suchkriterium kleiner als der kleinste vorhan-

dene Wert ist, liefert die Funktion den Fehlerwert #NV. 

Beispiel: 

Bei folgender Tabelle ... 
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... liefert VERWEIS folgende Ergebnisse: 

VERWEIS(1; A1:B3) ergibt Ergebnis_1 

VERWEIS(2; A1:B3) ergibt Ergebnis_2 

VERWEIS(3; A1:B3) ergibt Ergebnis_3 

VERWEIS(2,5; A1:B3) ergibt Ergebnis_2 (da hier der nächstkleinere Wert ge-

nommen wird) 

VERWEIS(10; A1:B3) ergibt Ergebnis_3 (aus dem gleichen Grund) 

VERWEIS(0; A1:B3) ergibt #NV 

Siehe auch: 

SVERWEIS, WVERWEIS, INDEX, VERGLEICH 

VORZEICHEN (Vorzeichen einer Zahl) 

Syntax: 

VORZEICHEN(Zahl) 

Beschreibung: 

Diese Funktion liefert das Vorzeichen einer Zahl. Sie kann folgende Werte anneh-

men: 

1, wenn die übergebene Zahl positiv ist 

-1, wenn die Zahl negativ ist 

0, wenn die Zahl Null ist 
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Beispiel: 

VORZEICHEN(-5) ergibt -1 

Siehe auch: 

ABS, NEG 

VRUNDEN (Runden auf ein Vielfaches von n) 

Syntax: 

VRUNDEN(Zahl; Basis) 

Beschreibung: 

Rundet Zahl auf ein Vielfaches von Basis. 

Basis muss größer als Null sein. 

Ist der Rest der Division von Zahl durch Basis kleiner als die Hälfte von Basis, 

wird abgerundet. Ist er größer oder gleich der Hälfte von Basis, wird aufgerundet 

(siehe Beispiele). 

Beispiel: 

VRUNDEN(1234,5678; 1) ergibt 1235 

VRUNDEN(1234,5678; 0,01) ergibt 1234,57 

VRUNDEN(22; 5) ergibt 20 

VRUNDEN(23; 5) ergibt 25 

VRUNDEN(22,5; 5) ergibt 25 

Siehe auch: 

UNTERGRENZE, OBERGRENZE, ABRUNDEN, AUFRUNDEN, RUNDEN, 

KÜRZEN 
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WAHL (Auswahl aus einer Liste) 

Syntax: 

WAHL(Index; Wert1 [; Wert2; Wert3 ...]) 

Beschreibung: 

Diese Funktion wählt mit Hilfe von Index einen Wert aus der Liste der Argumente 

aus. 

Index gibt die Position in der Liste der Argumente an. Ist Index 1, wird das erste 

Element zurückgeliefert, ist Index 2, das zweite Element etc. 

Wenn Index kleiner als 1 oder größer als die Anzahl der Listeneinträge ist, liefert 

die Funktion den Fehlerwert #WERT! zurück. 

Beispiel: 

WAHL(2; "Eins"; "Zwei"; "Drei") ergibt Zwei 

Siehe auch: 

INDEX, SVERWEIS, WVERWEIS 

WAHR (Wahrheitswert) 

Syntax: 

WAHR() 

Beschreibung: 

Liefert den Wahrheitswert WAHR.  

Siehe auch: 

FALSCH 
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WAHRSCHBEREICH (Wahrscheinlichkeit) 

Syntax: 

WAHRSCHBEREICH(Werte; Wahrscheinlichkeiten; k1 [; k2]) 

Beschreibung: 

Liefert die Wahrscheinlichkeit für ein Intervall von Werten, deren Einzelwahr-

scheinlichkeiten jeweils angegeben sind. 

Einfacher ausgedrückt: Diese Funktion summiert die jeweiligen Wahrscheinlich-

keiten der Werte in diesem Intervall. 

Werte sind die zu untersuchenden Werte. 

Wahrscheinlichkeiten sind die dazugehörigen Einzelwahrscheinlichkeiten. 

Alle Wahrscheinlichkeiten müssen größer gleich 0 (0%) und kleiner gleich 1 

(100%) sein. Die Summe der Einzelwahrscheinlichkeiten muss 1 ergeben. 

Sind mehr oder weniger Werte als Wahrscheinlichkeiten angegeben, liefert die 

Funktion den Fehler #NV. 

k1 und k2 bestimmen das Intervall von Werten, deren gemeinsame Wahrschein-

lichkeit ermittelt werden sollen. Wenn k2 nicht angegeben ist, wird nur die Wahr-

scheinlichkeit des Wertes k1 ermittelt. 

Beispiel: 

In den Zellen A1 bis A3 sind die Werte 1, 2, 3 eingetragen, in den Zellen B1 bis B3 

die dazugehörigen Wahrscheinlichkeiten: 17%, 33%, 50%. 

Wie groß ist die Wahrscheinlichkeit, dass ein Wert zwischen 2 und 3 liegt? 

WAHRSCHBEREICH(A1:A3; B1:B3; 2; 3) ergibt 33% + 50% = 83% 
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WÄHRUNG (Zahl als Währung formatieren) 

Syntax: 

WÄHRUNG(Zahl [; n]) 

Beschreibung: 

Konvertiert eine Zahl in eine Zeichenkette. Diese enthält die auf n Stellen gerunde-

te und als Währung formatierte Zahl. 

PlanMaker ermittelt die anzuzeigende Währung aus den Ländereinstellungen Ihres 

Betriebssystems. Bei Anwendern in Deutschland und Österreich wird der Betrag 

also in Euro angezeigt, bei Schweizern in sFr etc. 

Zahl ist die umzuwandelnde Zahl. 

Das optionale Argument n bestimmt gewünschte Anzahl an Nachkommastellen. 

Wird es nicht angegeben, wird die Zahl auf 2 Nachkommastellen gerundet. 

n darf auch ein negativer Wert sein, worauf der ganzzahlige Teil der Zahl gerundet 

wird: Ist n beispielsweise -2, wird die Zahl auf ein Vielfaches von Hundert gerun-

det (siehe letztes Beispiel). 

Hinweis: 

Beachten Sie, dass das Ergebnis dieser Funktion eine Zeichenkette ist. Um eine 

Zahl zu runden, ohne sie in eine Zeichenkette zu wandeln, verwenden Sie eine der 

Rundungsfunktionen wie zum Beispiel RUNDEN.  

Um eine Zahl nur gerundet und als Währung formatiert anzuzeigen, können Sie 

auch über den Menübefehl Format > Zelle ihr Zahlenformat ändern. 

Kompatibilitätshinweise: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

WÄHRUNG(123,456) ergibt die Zeichenkette € 123,46 
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WÄHRUNG(123,456; 2) ergibt die Zeichenkette € 123,46 

WÄHRUNG(123,456; -2) ergibt die Zeichenkette € 100 

WECHSELN (Text in Zeichenkette ersetzen) 

Syntax: 

WECHSELN(Zeichenkette; Suchtext; Ersatztext [; n]) 

Beschreibung: 

Ersetzt den Suchtext in einer Zeichenkette durch den Ersatztext. 

Zeichenkette ist die ursprüngliche Zeichenkette. 

Suchtext ist der zu ersetzende Text. Hierbei ist die Groß-/Kleinschreibung zu be-

achten. 

Ersatztext ist neue Text. 

Das optionale Argument n bestimmt, das wievielte Vorkommen des Suchbegriffs 

ersetzt werden soll. Wird n nicht angegeben, werden alle Vorkommen ersetzt. 

Beispiel: 

WECHSELN("aabbaabb"; "aa"; "xx") ergibt xxbbxxbb 

WECHSELN("aabbaabb"; "aa"; "xx"; 2) ergibt aabbxxbb 

WECHSELN("aabbaabb"; "AA"; "xx") ergibt aabbaabb 

Siehe auch: 

FINDEN, SUCHEN, ERSETZEN 
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WEIBULL (Weibull-Verteilung) 

Syntax: 

WEIBULL(x; Alpha; Beta; Kumuliert) 

Beschreibung: 

Liefert Wahrscheinlichkeiten einer Weibull-verteilten Zufallsvariablen. 

Die Weibull-Verteilung ist eine Erweiterung der Exponentialverteilung (siehe 

Funktion EXPONVERT) auf Ereignisse, die nicht rein zufällig sind und nicht exakt 

der Poisson-Verteilung (siehe Funktion POISSON) genügen. 

Sie wird besonders bei Zuverlässigkeitsbetrachtungen eingesetzt. 

x ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. x muss größer 

oder gleich Null sein. 

Alpha ist ein Parameter der Verteilung. Alpha bestimmt die Form der Verteilungs-

kurve. Bei Alpha=1 entspricht die Weibull-Verteilung einer Exponentialverteilung 

mit Lambda = 1/Beta. 

Beta ist ein weiterer Parameter der Verteilung. Beta bestimmt die Skalierung der 

Verteilungskurve, streckt beziehungsweise staucht den Funktionsgraphen also. 

Beide Parameter müssen größer als Null sein. 

Mit dem Wahrheitswert Kumuliert bestimmen Sie, welche Funktion geliefert wer-

den soll: 

FALSCH: Es wird die Dichtefunktion geliefert. 

WAHR: Es wird die Verteilungsfunktion (also die integrierte Dichtefunktion) gelie-

fert. 

Beispiel: 

WEIBULL(42; 2; 100; WAHR) ergibt 0,16172 

WEIBULL(42; 2; 100; FALSCH) ergibt 0,00704 
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Siehe auch: 

EXPONVERT, POISSON 

WENN (Wenn-Dann-Sonst-Bedingung) 

Syntax: 

WENN(Bedingung; WennWahr [; WennFalsch]) 

Beschreibung: 

Diese Funktion liefert den Wert WennWahr, wenn Bedingung wahr ist, ansonsten 

den Wert WennFalsch (sofern angegeben). 

Bedingung kann ein beliebiger Ausdruck sein, der WAHR oder FALSCH zurück-

liefert. 

WennWahr und WennFalsch können beliebige Werte oder Ausdrücke (also auch 

Formeln) sein. 

Beispiel: 

Die Formel WENN(A1<5; "Nachbestellen!"; "Bestand ok") liefert die Zeichenkette 

„Nachbestellen!“, wenn A1<5 ist. Ist dies nicht der Fall (A1 ist also  5), liefert sie 

die Zeichenkette „Bestand ok“. 

Siehe auch: 

AUSWAHL 

WENNFEHLER (liefert Zeichenkette bei Fehler) 

Syntax: 

WENNFEHLER(Wert; Zeichenkette) 
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Beschreibung: 

Gibt normalerweise den übergebenen Wert zurück. Liefert dieser Wert jedoch ei-

nen (beliebigen) Fehlerwert, wird stattdessen die übergebene Zeichenkette zu-

rückgegeben. 

Kompatibilitätshinweise: 

Diese Funktion ist nicht kompatibel zum .xls-Dateiformat von Microsoft Excel 

2003 und früher. Wenn Sie ein Dokument in diesem Format speichern, werden alle 

Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester 

Wert ersetzt.  

Wenn Sie diese Funktion einsetzen möchten, sollten Sie Ihr Dokument also nicht 

im Dateiformat „Microsoft Excel 97-2003 (.xls)“ speichern, sondern eines der fol-

genden Formate verwenden: 

 „PlanMaker-Dokument (.pmdx oder .pmd)“ 

 oder: „Microsoft Excel 2007-2016 (.xlsx)“ 

Beispiel: 

WENNFEHLER(A1; "Fehler!") liefert den Inhalt der Zelle A1, solange diese kei-

nen Fehlerwert enthält. Befindet sich in dieser Zelle jedoch ein Fehlerwert, wird 

stattdessen der Text „Fehler!“ geliefert. 

Siehe auch: 

ISTFEHL, ISTFEHLER, ISTNV, FEHLER.TYP, Abschnitt über „Fehlerwerte“ ab 

Seite 515 

WERT (Zeichenkette in Zahl umwandeln) 

Syntax: 

WERT(Zeichenkette) 
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Beschreibung: 

Wandelt eine Zeichenkette in eine Zahl um (sofern diese aus einer gültigen Zahl 

besteht). 

Hinweis: 

Diese Funktion ist nur aus Gründen der Kompatibilität mit älteren Tabellenkalkula-

tionen noch vorhanden. PlanMaker selbst benötigt sie nicht mehr, da er Zeichen-

ketten bei Bedarf automatisch in Zahlen umwandelt. 

Beispiel: 

WERT("42") ergibt 42 

WERT("42 DM") ergibt 42, denn „DM“ ist eine Währungseinheit. 

WERT("42 Bolzen") ergibt hingegen den Fehlerwert #WERT!. 

WERT("WAHR") ergibt 1 

WERT("25.09.2014") ergibt 41907, die serielle Datumszahl für das Datum 

25.09.2014 

Siehe auch: 

TEXT, T, N 

WIEDERHOLEN (Zeichenkette n mal wiederholen) 

Syntax: 

WIEDERHOLEN(Zeichenkette; n) 

Beschreibung: 

Wiederholt die übergebene Zeichenkette n mal. 

Über das Argument n bestimmen Sie die Anzahl der Wiederholungen. n sollte eine 

ganze Zahl sein. Ist dies nicht der Fall, schneidet PlanMaker die Nachkommastel-

len automatisch ab. 
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Beispiel: 

WIEDERHOLEN("Text"; 3) ergibt TextTextText 

Siehe auch: 

ERSETZEN, WECHSELN 

WOCHENTAG (Wochentag aus Datum ermitteln) 

Syntax: 

WOCHENTAG(Datum [; Modus]) 

Beschreibung: 

Liefert den Wochentag eines Datums in Form einer Zahl von 1 bis 7 beziehungs-

weise 0 bis 6. 

Über das optionale Argument Modus können Sie festlegen, welche Ergebnisse 

diese Funktion liefern soll: 

Ist Modus 1 oder nicht angegeben, liefert die Funktion Werte von 1 (=Sonntag) bis 

7 (=Samstag). 

Ist Modus 2, liefert die Funktion Werte von 1 (=Montag) bis 7 (=Sonntag). 

Ist Modus 3, liefert die Funktion Werte von 0 (=Montag) bis 6 (=Sonntag). 

Beispiel: 

WOCHENTAG("25.9.1966") ergibt 1 (also Sonntag) 

WOCHENTAG("25.9.1966"; 2) ergibt 7 (also Sonntag) 

Siehe auch: 

ISOKALENDERWOCHE, JAHR, MONAT, TAG 
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WURZEL (Quadratwurzel) 

Syntax: 

WURZEL(Zahl) 

Beschreibung: 

Liefert die Quadratwurzel einer Zahl.  

Die übergebene Zahl muss größer gleich Null sein. 

Beispiel: 

WURZEL(25) ergibt 5 

WURZEL(-25) ergibt den Fehlerwert #ZAHL! 

Siehe auch: 

WURZELN, POTENZ 

WURZELN (Wurzel) 

Syntax: 

WURZELN(Zahl [; n]) 

Beschreibung: 

Zieht die n-te Wurzel aus einer Zahl. Wird n nicht angegeben, liefert die Funktion 

die Quadratwurzel (n=2).  

n sollte eine ganze Zahl sein. Ist dies nicht der Fall, schneidet PlanMaker die 

Nachkommastellen automatisch ab. 

Wenn n gerade ist, muss Zahl positiv sein. 
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Kompatibilitätshinweise: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Tipp: Alternativ können Sie die n-te Wurzel auch mit folgender Excel-kompatibler 

Funktion berechnen:  

WURZELN(Zahl; n) entspricht POTENZ(Zahl; 1/n) 

Beispiel: 

WURZELN(25) ergibt 5 

WURZELN(-25) ergibt den Fehlerwert #ZAHL! 

WURZELN(125; 3) ergibt 5 

WURZELN(-125; 3) ergibt -5 

Siehe auch: 

WURZEL, POTENZ 

WURZELPI (Quadratwurzel von x*Pi) 

Syntax: 

WURZELPI(Zahl) 

Beschreibung: 

Liefert die Quadratwurzel einer mit der Kreiszahl Pi multiplizierten Zahl. 

Die übergebene Zahl muss größer gleich Null sein. 

Beispiel: 

WURZELPI(42) entspricht WURZEL(42*PI()), ergibt also 11,48681381 

Siehe auch:   
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PI, WURZEL, WURZELN 

WVERWEIS (Zellbereich zeilenweise durchsuchen) 

Syntax: 

WVERWEIS(Suchkriterium; Bereich; n [; Sortiert]) 

Beschreibung: 

Sucht in der ersten Zeile von Bereich nach dem ersten Vorkommen von Suchkri-

terium. Wird es gefunden, liefert die Funktion den Inhalt der Zelle, die sich in der 

gleichen Spalte und der n-ten Zeile von Bereich befindet. 

Suchkriterium ist der gesuchte Wert. Die Groß-/Kleinschreibung spielt keine Rol-

le. 

Bereich ist der zu durchsuchende Zellbereich. Die erste Zeile muss die zu durchsu-

chenden Werte enthalten. Dies können Zeichenketten, Zahlen oder Wahrheitswerte 

sein. 

Für n ist anzugeben, aus der wievielten Zeile von Bereich ein Wert zurückgeliefert 

werden soll, wenn das Suchkriterium gefunden wird. 

Ist n kleiner als 1, wird der Fehlerwert #WERT! zurückgeliefert. Ist n größer als 

die Zeilenzahl von Bereich, wird der Fehlerwert #BEZUG! zurückgeliefert.  

Sortiert ist ein Wahrheitswert, mit dem Sie angeben, ob die Werte in der ersten 

Zeile von Bereich sortiert sind: 

Ist Sortiert WAHR oder nicht angegeben, müssen die Werte in der ersten Zeile von 

Bereich aufsteigend sortiert sein. 

Ist Sortiert FALSCH, spielt die Reihenfolge der Werte in der ersten Zeile keine 

Rolle. 

Wichtig: Wenn Sie Sortiert also nicht explizit auf FALSCH setzen, müssen diese 

Werte in sortierter Reihenfolge vorliegen! 

Hinweis: 

Wenn WVERWEIS keinen exakt mit dem Suchkriterium übereinstimmenden 

Wert findet, wird automatisch der nächstkleinere Wert genommen.  
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Existiert kein kleinerer Wert, weil Suchkriterium kleiner als der kleinste vorhan-

dene Wert ist, liefert die Funktion den Fehlerwert #NV. 

Beispiel: 

Sie verkaufen Blumen zu unterschiedlichen Stückpreisen – je nachdem, wie viele 

Pflanzen der Kunde abnimmt. Dazu haben Sie eine Tabelle mit einer Rabattstaffel 

erstellt: 

 

Jetzt können Sie die Funktion WVERWEIS einsetzen, um abhängig von der Stück-

zahl den Preis für eine bestimmte Blumensorte zu ermitteln. 

Verwenden Sie dazu folgende Argumente: 

Als Suchkriterium geben Sie den Namen der Blumensorte an (also "Rosen", 

"Nelken" oder "Tulpen"). 

Als Bereich geben Sie die den Zellbereich an, der in der ersten Zeile die Namen 

der Blumensorten und darunter die Preise enthält – hier also B1:D4. 

Für n geben Sie die Stückzahl plus Eins an, denn die erste Zeile (n=1) enthält ja 

keine Preise, sondern die Namen der Pflanzen. 

Beispiele: 

WVERWEIS("Rosen"; B1:D4; 2; FALSCH) liefert den Preis für eine Rose, also € 

5,50. 

WVERWEIS("Rosen"; B1:D4; 4; FALSCH) liefert den Preis für drei Rosen, also € 

4,95. 

WVERWEIS("Nelken"; B1:D4; 4; FALSCH) liefert den Preis für drei Nelken, also 

€ 4,50. 

WVERWEIS("Nelken"; B1:D4; 5; FALSCH) liefert den Fehlerwert #BEZUG, da n 

größer als die Zeilenzahl von Bereich ist. 
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WVERWEIS("Petunien"; B1:D4; 4; FALSCH) liefert den Fehlerwert #NV, da „Pe-

tunien“ in der ersten Zeile von Bereich nicht vorkommt. 

Siehe auch: 

SVERWEIS, INDEX, VERGLEICH  

XINTZINSFUSS (Interner Zinsfuß) 

Syntax: 

XINTZINSFUSS(Werte; Daten [; Schätzwert]) 

Beschreibung: 

Liefert einen Schätzwert für den internen Zinsfuß einer Investition mit nicht perio-

disch anfallenden Zahlungen. 

Als Basis dienen die im Bereich Werte angegebenen Auszahlungen (negative Wer-

te) und Einzahlungen (positive Werte). Die Zahlungen dürfen zu beliebigen Zeit-

punkten erfolgen. Das Datum für jede Zahlung ist jeweils im Bereich Daten anzu-

geben. 

Die Funktion erwartet folgende Argumente: 

Für Werte gibt man einen Zellbezug an, in dem die Zahlungen eingetragen wur-

den. Es muss mindestens eine Auszahlung und eine Einzahlung vorliegen. 

Für Daten gibt man einen Zellbezug an, in dem die Datumsangaben für jede im 

Bereich Werte eingetragene Zahlung angegeben ist. 

Für Schätzwert können Sie (optional) einen Schätzwert für das Ergebnis der Be-

rechnung angeben (siehe Hinweis). 

Hinweis: 

Die Berechnung erfolgt mit Hilfe eines Näherungsverfahrens (Iterationsverfahren). 

Falls die Funktion nach 20 Näherungsschritten noch kein Ergebnis mit einer Ge-

nauigkeit von 0,00001% oder besser findet, bricht sie die Näherung ab und liefert 

als Ergebnis den Fehlerwert #ZAHL!. Versuchen Sie in diesem Fall einen anderen 

Wert für Schätzwert anzugeben. 



 

806  •  Formeln und Funktionen Handbuch PlanMaker 

Siehe auch: 

IKV, QIKV, XKAPITALWERT, ZINS 

XKAPITALWERT (Nettobarwert) 

Syntax: 

XKAPITALWERT(Zins; Werte; Daten) 

Beschreibung: 

Liefert den Kapitalwert (Nettobarwert) einer Investition mit nicht periodisch anfal-

lenden Zahlungen. 

Als Basis dienen die im Bereich Werte angegebenen Auszahlungen (negative Wer-

te) und Einzahlungen (positive Werte). Die Zahlungen dürfen zu beliebigen Zeit-

punkten erfolgen. Das Datum für jede Zahlung ist jeweils im Bereich Daten anzu-

geben. 

Die Funktion erwartet folgende Argumente: 

Zins ist der Kapitalzinsfuß für die Zahlungen. 

Für Werte gibt man einen Zellbezug an, in dem die Zahlungen eingetragen wur-

den. Es muss mindestens eine Auszahlung und eine Einzahlung vorliegen. 

Für Daten gibt man einen Zellbezug an, in dem die Datumsangaben für jede im 

Bereich Werte eingetragene Zahlung angegeben ist. 

Siehe auch: 

NBW, XINTZINSFUSS 

XODER (Logisches EXKLUSIV ODER) 

Syntax: 

XODER(Wahrheitswert1 [; Wahrheitswert2; Wahrheitswert3 ...]) 
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Beschreibung: 

Die Funktion XODER („Exklusiv Oder“) liefert WAHR, wenn eine ungerade An-

zahl der ihr übergebenen Wahrheitswerte WAHR ist, ansonsten liefert sie FALSCH. 

Häufig wird diese Funktion mit nur zwei Argumenten verwendet. Hier gilt entspre-

chend: Wenn entweder das eine oder das andere Argument WAHR ist, liefert sie 

WAHR. Sind hingegen beide WAHR oder beide FALSCH, liefert sie FALSCH. 

Kompatibilitätshinweise: 

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versio-

nen ist die Funktion unbekannt. 

Beispiel: 

XODER(WAHR; WAHR) ergibt FALSCH 

XODER(WAHR; FALSCH) ergibt WAHR 

XODER(FALSCH; WAHR) ergibt WAHR 

XODER(FALSCH; FALSCH) ergibt FALSCH 

Siehe auch: 

ODER, UND, NICHT 

ZÄHLENWENN (Zählen ausgewählter Werte) 

Syntax: 

ZÄHLENWENN(Suchbereich; Suchkriterium) 

Beschreibung: 

Ermittelt, wie viele Werte in einem Bereich der angegebenen Bedingung entspre-

chen. 

Suchbereich ist der zu durchsuchende Bereich. 
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Suchkriterium ist die zu erfüllende Bedingung: 

Hier können Sie einerseits einen einfachen Wert angeben (zum Beispiel "42" oder 

"Schrauben"). In diesem Fall werden alle Posten gezählt, die diesem Wert entspre-

chen.  

Tipp: Um alle nicht-leeren Zellen zu zählen, geben Sie als Kriterium "*" an. ZÄH-

LENWENN(D2:D4; "*") zählt beispielsweise alle Zellen im angegebenen Bereich, 

die nicht leer sind. 

Weiterhin ist auch eine Bedingung wie ">10" oder "<=5" zulässig. Hier werden 

alle Posten gezählt, die dieser Bedingung entsprechen. 

Hinweis: Das Suchkriterium sollte stets mit doppelten Anführungszeichen (") um-

geben werden. 

Beispiel: 

In den Zellen A1 bis A5 stehen die Werte 1; 2; 3; 2; 1. Hier gilt: 

ZÄHLENWENN(A1:A5; "2") ergibt 2 

ZÄHLENWENN(A1:A5; ">=2") ergibt 3 

Siehe auch: 

ANZAHL, MITTELWERTWENN, MITTELWERTWENNS, SUMMEWENN, 

SUMMEWENNS, ZÄHLENWENNS 

ZÄHLENWENNS (Zählen ausgewählter Werte) 

Syntax: 

ZÄHLENWENNS(Suchbereich1; Suchkriterium1 [; Suchbereich2; Suchkriterium2 

...]) 

Beschreibung: 

Prüft die Zellen aus mehreren Bereichen auf jeweils eine Bedingung und zählt, wie 

oft dabei alle Bedingungen erfüllt sind.  
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Entspricht der Funktion ZÄHLENWENN, erlaubt allerdings die Verwendung meh-

rerer Suchbereiche (inklusive eines Suchkriteriums für jeden Bereich). 

Suchbereich1 ist der erste zu durchsuchende Bereich. Beachten Sie, dass alle 

Suchbereiche die gleichen Ausmaße haben müssen. 

Suchkriterium1 ist die Bedingung, die die Werte in Suchbereich1 erfüllen müs-

sen: 

Hier können Sie einerseits einen einfachen Wert angeben (zum Beispiel "42" oder 

"Schrauben"). In diesem Fall gilt die Bedingung als erfüllt, wenn die Zelle diesen 

Wert enthält. 

Weiterhin ist auch eine Bedingung wie ">10" oder "<=5" zulässig. Hier gilt die 

Bedingung als erfüllt, wenn der Zellinhalt dieser Bedingung entspricht. 

Hinweis: Das Suchkriterium sollte stets mit doppelten Anführungszeichen (") um-

geben werden. 

Im Gegensatz zur Funktion ZÄHLENWENN können Sie bei ZÄHLENWENNS 

auch mehrere Bereiche (jeweils mit zugehörigem Suchkriterium) angeben. Es wird 

dann gezählt, wie oft die Zellen aus den einzelnen Bereichen alle ihrem jeweiligen 

Kriterium entsprechen. Siehe Beispiele. 

Kompatibilitätshinweise: 

Diese Funktion ist nicht kompatibel zum .xls-Dateiformat von Microsoft Excel 

2003 und früher. Wenn Sie ein Dokument in diesem Format speichern, werden alle 

Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester 

Wert ersetzt.  

Wenn Sie diese Funktion einsetzen möchten, sollten Sie Ihr Dokument also nicht 

im Dateiformat „Microsoft Excel 97-2003 (.xls)“ speichern, sondern eines der fol-

genden Formate verwenden: 

 „PlanMaker-Dokument (.pmdx oder .pmd)“ 

 oder: „Microsoft Excel 2007-2016 (.xlsx)“ 

Beispiel: 

ZÄHLENWENNS(C1:C10; ">1"; C1:C10; "<2")  

Diese Formel ermittelt, wie viele der Werte im Bereich C1:C10 größer als 1 und 

kleiner als 2 sind. 
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ZÄHLENWENNS(A1:D4; "Thunfisch"; G10:K14; ">500")  

Diese Formel ermittelt, wie oft die folgenden Bedingungen zutreffen: die Zelle im 

Bereich A1:D4 enthält „Thunfisch“ und die entsprechende Zelle im Bereich 

G10:K14 ist größer als 500. 

Siehe auch: 

ANZAHL, MITTELWERTWENN, MITTELWERTWENNS, SUMMEWENN, 

SUMMEWENNS, ZÄHLENWENN 

ZEICHEN (Zeichen per ANSI-Code) 

Syntax: 

ZEICHEN(Zahl) 

Beschreibung: 

Liefert das Zeichen mit dem ANSI-Code Zahl. 

Zahl muss größer oder gleich 10 sein. 

Beispiel: 

ZEICHEN(65) ergibt A 

ZEICHEN(32) ergibt ein Leerzeichen 

ZEICHEN(CODE("X") ergibt X 

Siehe auch: 

CODE 
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ZEILE (Zeilennummer von Zellen) 

Syntax: 

ZEILE([Bezug]) 

Beschreibung: 

Liefert die Zeilennummer(n) einer Zelle oder eines Bereichs von Zellen: 

Ist Bezug eine einzelne Zelle, liefert die Funktion die Zeilennummer dieser Zelle. 

Ist Bezug ein Bereich von Zellen, liefert die Funktion die darin enthaltenen Zeilen-

nummern als vertikale Matrix. Hinweis: In diesem Fall muss die Formel als Mat-

rixformel eingegeben werden (siehe Abschnitt „Arbeiten mit Matrizen“ ab Seite 

516). 

Wird das Argument Bezug nicht angegeben, liefert die Funktion die Zeilennummer 

der Zelle, in der sie aufgerufen wurde. 

Beispiel: 

ZEILE(D2) ergibt 2 

ZEILE(D2:F4) ergibt {2;3;4} 

ZEILE() ergibt 5, wenn Sie die Funktion ZEILE() beispielsweise in der Zelle A5 

aufrufen 

Siehe auch: 

SPALTE, ZEILEN 

ZEILEN (Zahl der Zeilen) 

Syntax: 

ZEILEN(Bereich) 
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Beschreibung: 

Liefert die Anzahl der Zeilen im angegebenen Bereich. 

Beispiel: 

ZEILEN(A1:D5) ergibt 5 

Siehe auch: 

ZEILE, SPALTEN 

ZEIT (Datumswert bilden) 

Syntax: 

ZEIT(Stunde; Minute; Sekunde) 

Beschreibung: 

Bildet einen Datumswert aus den Argumenten Stunde, Minute und Sekunde. 

Beispiel: 

ZEIT(0; 20; 0) ergibt 0,01389. Dieser Datumswert wird von PlanMaker allerdings 

automatisch im Zahlenformat „Datum/Zeit“ formatiert, so dass in der Zelle steht: 

00:20:00. 

Siehe auch: 

ZEITWERT, DATUM, DATWERT 
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ZEITDIFFERENZ (Differenz zwischen zwei Uhrzeiten) 

Syntax: 

ZEITDIFFERENZ(Beginn; Ende) 

Beschreibung: 

Berechnet die zwischen zwei Uhrzeiten verstrichene Zeit. 

Für Beginn und Ende ist jeweils eine Uhrzeit anzugeben.  

Sie können auch ein Datum mit einer Uhrzeit angeben (siehe letztes Beispiel), in 

diesem Fall müssen aber sowohl Beginn als auch Ende ein Datum enthalten, sonst 

liefert die Funktion den Fehlerwert #WERT!. 

Hinweis: 

Diese Funktion liefert auch dann sinnvolle Resultate, wenn Ende kleiner als Be-

ginn ist.  

Beispiel: Ein Arbeiter nimmt seine Tätigkeit um 22:00 auf und geht um 6:00 nach 

Hause. Würden Sie jetzt, um seine Arbeitszeit zu ermitteln, einfach Anfangszeit 

von Endzeit abziehen, wäre das Ergebnis -16 Stunden. Verwenden Sie hingegen die 

Funktion ZEITDIFFERENZ, ist das Ergebnis 8 Stunden. 

Kompatibilitätshinweise: 

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-

Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch 

ihr aktuelles Ergebnis als fester Wert ersetzt. 

Beispiel: 

ZEITDIFFERENZ("8:00"; "16:00") ergibt 8:00 

ZEITDIFFERENZ("22:00"; "6:00") ergibt 8:00 

ZEITDIFFERENZ("1.10.2018 22:00"; "2.10.2018 6:00") ergibt 8:00 
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Siehe auch: 

ZEIT, ZEITWERT 

ZEITWERT (Text in Uhrzeit wandeln) 

Syntax: 

ZEITWERT(Zeichenkette) 

Beschreibung: 

Wandelt eine als Zeichenkette übergegebene Zeitangabe in eine Uhrzeit (genauer 

gesagt: in eine serielle Datumszahl) um.  

Hinweis: 

Diese Funktion ist nur aus Kompatibilitätsgründen zu älteren Tabellenkalkulatio-

nen noch vorhanden. PlanMaker selbst benötigt sie nicht mehr, da er Uhrzeiten, 

die als Text angegeben sind, bei Bedarf automatisch in den Typ Datum/Uhrzeit 

umwandelt. 

Beispiel: 

ZEITWERT("10:30:00") ergibt die serielle Datumszahl 0,4375. 

Formatieren Sie diese mit dem Menübefehl Format > Zelle nun in einem der Da-

tum/Zeit-Formate (zum Beispiel h:mm), so wird in der Zelle die Uhrzeit angezeigt, 

die sich hinter diesem Wert verbirgt: 10:30. 

Siehe auch: 

DATWERT, DATUM, ZEIT 
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ZELLE (Informationen über eine Zelle) 

Syntax: 

ZELLE(Typ [; Bezug]) 

Beschreibung: 

Liefert verschiedene Informationen über die angegebene Zelle zurück. 

Der Parameter Typ bestimmt, welche Art von Information geliefert werden soll. 

Geben Sie dazu eine der folgenden Zeichenketten an: 

Typ Erläuterung 

"Adresse" Liefert die Adresse der Zelle (als Text). 

"Breite" (Wird nicht unterstützt und liefert deshalb den Fehlerwert #NV.) 

"Dateiname" Liefert den vollständigen Pfad und Dateinamen des Dokuments, in 

dem sich die Zelle befindet. 

"Farbe" Liefert 1, wenn das Zahlenformat der Zelle die Option Negative 

Werte in Rot verwendet; ansonsten wird 0 zurückgeliefert. 

"Format" (Wird nicht unterstützt und liefert deshalb den Fehlerwert #NV.) 

"Inhalt" Liefert den Wert zurück, der sich in der Zelle befindet. 

"Klammern" (Wird nicht unterstützt und liefert deshalb den Fehlerwert #NV.) 

"Präfix" Liefert eine der folgenden Zeichenketten zurück: 

', wenn die Zelle linksbündigen Text enthält 

^, wenn die Zelle zentrierten Text enthält 

", wenn die Zelle rechtsbündigen Text enthält 

\, wenn die Zelle ausgefüllten Text enthält 

"", wenn die Zelle etwas anderes enthält 

"Schutz" Liefert 1, wenn die Zelle geschützt ist; ansonsten wird 0 zurückgelie-

fert. 

"Spalte" Liefert die Spaltennummer der Zelle (als Zahl). 

"Typ" Liefert eine der folgenden Zeichenketten zurück: 

b, wenn die Zelle leer ist 

l, wenn die Zelle Text enthält 

w, wenn die Zelle etwas anderes enthält 
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"Zeile" Liefert die Zeilennummer der Zelle. 

Bezug (optional) ist die Adresse der Zelle, zu der Informationen geliefert werden 

sollen.  

Wenn Bezug mehrere Zellen umfasst, wird nur die linke obere Zelle verwendet. 

Wenn Bezug weggelassen wird, wird die aktuelle Zelle verwendet. (Excel verhält 

sich hier anders; siehe Hinweis.) 

Kompatibilitätshinweise: 

Diese Funktion ist nicht 100% identisch mit der gleichnamigen Excel-Funktion. Es 

gibt folgende Einschränkungen: 

1. PlanMaker unterstützt nicht alle Typen von Informationen (siehe Tabelle oben).  

2. Wenn der Parameter Bezug leer gelassen wird, liefert PlanMaker Informationen 

zur aktuellen Zelle, Excel hingegen zu der zuletzt geänderten Zelle. 

Beispiel: 

=ZELLE("Zeile"; B5) liefert die Zeilennummer dieser Zelle, also 5. 

Siehe auch: 

DATEINAME, SPALTE, ZEILE 

ZSATZINVEST (Zinssatz) 

Syntax: 

ZSATZINVEST(Zr; Bw; Zw) 

Beschreibung: 

Berechnet den Zinssatz pro Periode, der benötigt wird, um mit einer festverzinsli-

chen Anlage innerhalb einer bestimmten Anzahl an Perioden einen bestimmten 

Betrag zu erreichen.  
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Es werden hierbei keine regelmäßigen Zahlungen geleistet; es gibt also nur eine 

einzige Einzahlung am Beginn der Laufzeit. 

Die Funktion erwartet folgende Argumente: 

Zr = Zeitraum (Anzahl der Perioden). Wird beispielsweise der Jahreszins betrach-

tet, ist eine Periode ein Jahr lang. 

Bw = Barwert (der anfängliche Betrag) 

Zw = Zukünftiger Wert (der Zielwert) 

Kompatibilitätshinweise: 

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versio-

nen ist die Funktion unbekannt. 

In früheren Versionen von PlanMaker hieß diese Funktion ZGZ. 

Beispiel: 

Sie möchten mit einer festverzinslichen Anlage von € 3000,- innerhalb von 10 Jah-

ren € 5000,- erreichen. Wie hoch muss der jährliche Zinssatz sein? 

ZSATZINVEST(10; 3000; 5000) ergibt einen Jahreszins von 0,05241 (also etwa 

5,24%). 

Siehe auch: 

LAUFZEIT, ZINS 

ZINS (Zinssatz per Iterationsverfahren) 

Syntax: 

ZINS(Zzr; Rmz; Bw [; Zw] [; Fälligkeit] [; Schätzwert]) 

Beschreibung: 

Liefert eine Schätzung für den Zinsanteil der Zahlung pro Periode, basierend auf 

einer Investition mit regelmäßigen konstanten Zahlungen und feststehendem Zins. 
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Die Funktion erwartet folgende Argumente: 

Zzr = Zahl der Zahlungszeiträume (wie viele Perioden umfasst die Laufzeit?) 

Rmz = Annuität (Betrag, der pro Periode gezahlt wird) 

Bw = Barwert (der anfängliche Betrag) 

Zw (optional) = Zukünftiger Wert, also der Endstand, den Sie nach der letzten Zah-

lung erreichen möchten. Wenn Sie das Argument Zw nicht angeben, wird es auf 

Null gesetzt. 

Fälligkeit (optional) = Wann die Zahlungen fällig sind: 

0 oder nicht angegeben: jeweils am Ende der Periode 

1: jeweils am Anfang der Periode 

Schätzwert (optional) = Ihr Schätzwert, wie hoch der Zinssatz vermutlich sein 

wird (siehe Hinweis). 

Hinweis: 

Die Berechnung erfolgt mit Hilfe eines Näherungsverfahrens (Iterationsverfahren). 

Falls die Funktion nach 20 Näherungsschritten noch kein Ergebnis mit einer Ge-

nauigkeit von 0,00001% oder besser findet, bricht sie die Näherung ab und liefert 

als Ergebnis den Fehlerwert #ZAHL!. Versuchen Sie in diesem Fall einen anderen 

Wert für Schätzwert anzugeben. 

Beispiel: 

ZINS(12*10; -650; 60000) ergibt 0,455087% 

Diese Formel berechnet per Iterationsverfahren den Zinssatz bei einem Kredit über 

€ 60.000 mit einer Laufzeit von 10 Jahren (=12*10 Monate) und einer Zahlung von 

€ 650,- (pro Monat). 

Das Ergebnis ist der Zinssatz pro Monat. Um den Jahreszins zu erhalten, muss es 

also mit 12 multipliziert werden. 

Siehe auch: 

BW, KAPZ, RMZ, XINTZINSFUSS, ZINSZ, ZW, ZZR 
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ZINSZ (Zinszahlung) 

Syntax: 

ZINSZ(Zins; Zr; Zzr; Bw [; Zw] [; Fälligkeit]) 

Beschreibung: 

Liefert den Zinsanteil der Zahlung in der angegebenen Periode, basierend auf einer 

Investition mit regelmäßigen konstanten Zahlungen und feststehendem Zins. 

Sie können mit dieser Funktion beispielsweise berechnen, wie groß bei einem Kre-

dit der Zinsanteil der Annuität in einer bestimmten Periode ist.  

„Periode“ bezeichnet einen Zahlungszeitraum. Bei einem Kredit mit monatlichen 

Rückzahlungen ist die dritte Periode beispielsweise der dritte Monat. 

Die Funktion erwartet folgende Argumente: 

Zins = Zinssatz (pro Periode) 

Zr = die zu betrachtende Periode 

Zzr = Zahl der Zahlungszeiträume (wie viele Perioden umfasst die Laufzeit?) 

Bw = Barwert (der anfängliche Betrag) 

Zw (optional) = Zukünftiger Wert, also der Endstand, den Sie nach der letzten Zah-

lung erreichen möchten. Wenn Sie das Argument Zw nicht angeben, wird es auf 

Null gesetzt. 

Fälligkeit (optional) = Wann die Zahlungen fällig sind: 

0 oder nicht angegeben: jeweils am Ende der Periode 

1: jeweils am Anfang der Periode 

Beispiel: 

Es wird ein Kredit über € 100.000,- zu folgenden Bedingungen aufgenommen: 

Jahreszins: 10% 

Zahlungen: monatlich 

Laufzeit: 6 Jahre 
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Wie groß ist der Zinsanteil der Zahlung (Annuität) in Monat 32? 

ZINSZ(10%/12; 32; 6*12; 100000) ergibt -534 Euro 

Beachten Sie dabei, dass alle Angaben auf der gleichen Zeiteinheit basieren müs-

sen – hier also auf Monaten, da die Zahlungen monatlich erfolgen.  

Deshalb wurde in der obigen Formel der Jahreszins durch 12 geteilt (um den Zins 

pro Monat zu erhalten) und die Laufzeit mit 12 multipliziert (um die Laufzeit in 

Monaten zu erhalten). 

Siehe auch: 

BW, ISPMT, KAPZ, RMZ, ZINS, ZW, ZZR 

Anmerkung: 

Die Funktion KAPZ ist das Gegenstück zu ZINSZ: Sie liefert den Tilgungsanteil 

der Zahlung in dieser Periode.  

Die Funktion RMZ hingegen liefert den Gesamtbetrag der Zahlung (Annuität) pro 

Periode, also die Summe von Tilgungsanteil und Zinsanteil. 

ZUFALLSBEREICH (zufälliger Wert) 

Syntax: 

ZUFALLSBEREICH(Untergrenze; Obergrenze) 

Beschreibung: 

Liefert eine ganze Zufallszahl x im Bereich Untergrenze  x  Obergrenze. 

Bei jeder Neuberechnung des Dokuments wird diese Zufallszahl neu erzeugt.  

Tipp: Durch Aufruf des Menübefehl Weiteres > Neu berechnen können Sie ein 

Dokument manuell neu berechnen lassen. 
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Beispiel: 

ZUFALLSBEREICH(1; 6) liefert ganze Zufallszahlen zwischen 1 und 6, simuliert 

also einen Würfel. 

Siehe auch: 

ZUFALLSZAHL 

ZUFALLSZAHL (zufälliger Wert) 

Syntax: 

ZUFALLSZAHL() 

Beschreibung: 

Liefert eine Zufallszahl x im Bereich 0  x  1. 

Bei jeder Neuberechnung des Dokuments wird diese Zufallszahl neu erzeugt.  

Tipp: Durch Aufruf des Menübefehl Weiteres > Neu berechnen können Sie ein 

Dokument manuell neu berechnen lassen. 

Beispiel: 

Folgende Formel liefert eine ganze Zufallszahl zwischen 1 und 6, simuliert also 

einen Würfel: 

GANZZAHL(ZUFALLSZAHL()*6+1) 

Tipp: Einfacher geht dies allerdings mit ZUFALLSBEREICH(1; 6). 

Siehe auch: 

ZUFALLSBEREICH  
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ZULETZTGEDRUCKT (Datum des letzten Ausdrucks) 

Syntax: 

ZULETZTGEDRUCKT() 

Beschreibung: 

Liefert das Datum, an dem das aktuelle Dokument zuletzt ausgedruckt wurde. 

Siehe auch: 

ZULETZTGESPEICHERT 

ZULETZTGESPEICHERT (Datum des letzten Speicherns) 

Syntax: 

ZULETZTGESPEICHERT() 

Beschreibung: 

Liefert das Datum, an dem das aktuelle Dokument zuletzt gespeichert wurde. 

Siehe auch: 

ZULETZTGEDRUCKT 

ZW (Zukünftiger Wert) 

Syntax: 

ZW(Zins; Zzr; Rmz [; Bw] [; Fälligkeit]) 
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Beschreibung: 

Liefert den zukünftigen Wert einer Investition, basierend auf einer Investition mit 

regelmäßigen konstanten Zahlungen und feststehendem Zins. 

Sie können mit dieser Funktion beispielsweise den zukünftigen Wert (= Endwert) 

eines Kredits ausrechnen. 

Die Funktion erwartet folgende Argumente: 

Zins = Zinssatz (pro Periode) 

Zzr = Zahl der Zahlungszeiträume (wie viele Perioden umfasst die Laufzeit?) 

Rmz = Annuität (Betrag, der pro Periode gezahlt wird) 

Bw (optional) = Barwert. Wenn Sie das Argument Bw nicht angeben, wird es auf 

Null gesetzt. 

Fälligkeit (optional) = Wann die Zahlungen fällig sind: 

0 oder nicht angegeben: jeweils am Ende der Periode 

1: jeweils am Anfang der Periode 

Beispiel: 

ZW(6,5%/12; 10; -1000) ergibt 10.247,30 

Siehe auch: 

BW, KAPZ, RMZ, ZINS, ZINSZ, ZW2, ZZR 

ZW2 (Zukünftiger Wert) 

Syntax: 

ZW2(Bw; Zinsen) 

Beschreibung: 

Liefert den zukünftigen Wert einer Investition für eine Reihe unterschiedlicher 

periodischer Zinssätze. 
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Es werden keine regelmäßigen Zahlungen geleistet; es gibt also nur eine einzige 

Einzahlung am Beginn der Laufzeit. 

Sie können mit dieser Funktion beispielsweise den zukünftigen Wert (= Endwert) 

eines Kredits ausrechnen. 

Die Funktion erwartet folgende Argumente: 

Bw = Barwert (der anfängliche Betrag) 

Zinsen = Zellbezug auf einen Tabellenbereich, in dem die unterschiedlichen Zinss-

ätze pro Periode enthalten sind (in entsprechender Reihenfolge, also beispielsweise 

erst der Zinssatz für das erste Jahr, dann der für das zweite Jahr etc.). 

Beispiel: 

Für eine Einlage von € 10.000,- erhalten Sie im ersten Jahr 5% Zinsen, im zweiten 

5,2%, im dritten 5,5%, im vierten 5,9%. Um den zukünftigen Wert dieser Investiti-

on zu berechnen, tragen Sie diese vier Zinssätze (in der korrekten Reihenfolge) 

beispielsweise in die Zellen A1 bis A4 ein und wenden dann die folgende Formel 

an: 

ZW2(10000; A1:A4) ergibt 12.341 Euro 

Die unterschiedlichen Zinssätze können auch direkt in folgender Form angegeben 

werden: 

ZW2(10000; {5%; 5,2%; 5,5%; 5,9%}) 

Siehe auch: 

ZW 

ZWEIFAKULTÄT (Zweierfakultät) 

Syntax: 

ZWEIFAKULTÄT(Zahl) 

Beschreibung: 

Liefert die Zweierfakultät einer Zahl. 
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Die Zweierfakultät wird wie folgt gebildet: 

Ist Zahl gerade, wird das Produkt aller geraden positiven Zahlen von 2 bis Zahl 

berechnet (also 2*4*6*...*Zahl). 

Ist Zahl ungerade, wird das Produkt aller ungeraden positiven Zahlen von 1 bis 

Zahl berechnet (also 1*3*5*...*Zahl). 

Die übergebene Zahl muss positiv sein. Nachkommastellen werden automatisch 

abgeschnitten. 

Beispiel: 

ZWEIFAKULTÄT(8) entspricht 2*4*6*8, ergibt also 384 

ZWEIFAKULTÄT(9) entspricht 1*3*5*7*9, ergibt also 945 

Siehe auch: 

FAKULTÄT 

ZZR (Zinszeitraum) 

Syntax: 

ZZR(Zins; Rmz; Bw [; Zw] [; Fälligkeit]) 

Beschreibung: 

Ermittelt die Zahl der Zahlungszeiträume (Perioden), basierend auf einer Investiti-

on mit regelmäßigen konstanten Zahlungen und feststehendem Zins. 

Sie können mit dieser Funktion beispielsweise berechnen, wie viele regelmäßige 

Zahlungen (Annuitäten) bei einem Kredit erfolgen müssen. 

„Periode“ bezeichnet einen Zahlungszeitraum. Bei einem Kredit mit monatlichen 

Rückzahlungen ist die dritte Periode beispielsweise der dritte Monat. 

Die Funktion erwartet folgende Argumente: 

Zins = Zinssatz (pro Periode) 
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Rmz = Annuität (Betrag, der pro Periode gezahlt wird) 

Bw = Barwert (der anfängliche Betrag) 

Zw (optional) = Zukünftiger Wert, also der Endstand, den Sie nach der letzten Zah-

lung erreichen möchten. Wenn Sie das Argument Zw nicht angeben, wird es auf 

Null gesetzt. 

Fälligkeit (optional) = Wann die Zahlungen fällig sind: 

0 oder nicht angegeben: jeweils am Ende der Periode 

1: jeweils am Anfang der Periode 

Siehe auch: 

BW, KAPZ, RMZ, ZINS, ZINSZ, ZW 
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Anhang 
Im Anhang des Handbuchs finden Sie folgende Informationen: 

 Menübefehle und entsprechende Ribbonbefehle 

 In diesem Abschnitt finden Sie eine Tabelle aller Menübefehle und dem jeweils 

entsprechenden Befehl im Ribbon (Menüband). 

 Tastenbelegung 

 Dieser Abschnitt enthält Tabellen mit den wichtigsten Tastenkürzeln, die Sie im 

Programm verwenden können.  

Menübefehle und entsprechende Ribbonbefehle 

In diesem Abschnitt finden Sie eine Tabelle aller Menübefehle und dem jeweils 

entsprechenden Befehl im Ribbon (Menüband). 

Tipp: Sie können die Benutzeroberfläche jederzeit zwischen Ribbon und klassi-

schen Menüs mit Symbolleisten umschalten. Rufen Sie dazu im Menü den Befehl 

Weiteres > Einstellungen auf (beziehungsweise im Ribbon den Befehl Datei > 

Einstellungen). Wechseln Sie in dem Dialog auf die Karteikarte Aussehen und 

klicken Sie darin auf die Schaltfläche Benutzeroberfläche. Es erscheint ein wei-

terer Dialog, in dem Sie die gewünschte Art von Benutzeroberfläche wählen 

können. 

Die nachfolgende Tabelle enthält folgende Spalten: 

 Linke Spalte: Menübefehl 

 Die linke Spalte listet alle Menübefehle im Programm, geordnet nach der Rei-

henfolge im Hauptmenü.  

 Rechte Spalte: entsprechender Befehl im Ribbon 

 In der rechten Spalte finden Sie jeweils den entsprechenden Befehl im Ribbon 

– in folgendem Format: 

 Karteikarte > Sektion > Befehl 

 Beispiel:  
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 Der Ribbonbefehl Datei > Dokument > Speichern ist auf dem Ribbon also 

wie folgt zu finden: Karteikarte Datei, Sektion Dokument, Symbol Speichern.  

 Bei manchen Befehlen ist zusätzlich noch ein vierter Eintrag angehängt. Hier 

befindet sich der entsprechende Befehl in der Liste, die sich öffnet, wenn Sie 

auf das angegebene Symbol (oder das Pfeilchen rechts davon) klicken. 

Hier also die angekündigte Tabelle: 

 

 Menü       Ribbon 

 
Datei > Neu  Datei > Datei > Neu >> Weitere 

 
Datei > Öffnen  Datei > Datei > Öffnen 

 
Datei > Schließen  Datei > Datei > Schließen 

 
Datei > Speichern  Datei > Dokument > Speichern 

 
Datei > Speichern unter  Datei > Dokument > Speichern unter 

 
Datei > Alles speichern  Datei > Dokument > Alles speichern 

 
Datei > Zurück zu vorheriger Versi-

on 

 Datei > Dateiverwaltung > Versionen 

 
Datei > Holen  Einfügen > Objekte > Grafikrahmen >> 

Von Scanner 

 Datei > Quelle wählen  Einfügen > Objekte > Grafikrahmen >> 

Quelle wählen 

 
Datei > Eigenschaften  Datei > Dateiverwaltung > Eigenschaften 

 
Datei > Dateimanager  Datei > Dateiverwaltung > Dateimanager 

 
Datei > Seite einrichten  Datei > Drucken > Seite einrichten 

 
Datei > Druckvorschau  Datei > Drucken > Druckvorschau 

 
Datei > Druckbereich > Druckbe-

reich festlegen 

 Datei > Drucken > Druckbereich festlegen 
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 Datei > Druckbereich > Druckbe-

reich entfernen 

 Datei > Drucken > Druckbereich festlegen 

>> Druckbereich entfernen 

 
Datei > Drucken  Datei > Drucken > Drucken 

 
Datei > Als PDF-Dokument expor-

tieren 

 Datei > Dokument > PDF-Export 

 
Datei > Versenden  Datei > Dokument > Versenden 

    

 
Bearbeiten > Rückgängig  Schnellzugriffsleiste > Rückgängig 

 
Bearbeiten > Wiederherstellen  Schnellzugriffsleiste > Wiederherstellen 

 
Bearbeiten > Wiederholen  Schnellzugriffsleiste > Wiederholen 

 
Bearbeiten > Ausschneiden  Start > Bearbeiten > Ausschneiden 

 
Bearbeiten > Kopieren  Start > Bearbeiten > Kopieren 

 
Bearbeiten > Einfügen  Start > Bearbeiten > Einfügen 

 
Bearbeiten > Duplizieren  Layout > Objekte > Duplizieren 

 
Bearbeiten > Inhalte einfügen  Start > Bearbeiten > Einfügen >> Inhalte 

einfügen 

 
Bearbeiten > Alles markieren  Start > Auswahl > Alles markieren 

 
Bearbeiten > Ausfüllen  Start > Inhalte > Füllen 

 Bearbeiten > Selektiv löschen  Start > Inhalte > Löschen 

 
Bearbeiten > Suchen  Start > Suchen > Suchen 

 
Bearbeiten > Ersetzen  Start > Suchen > Ersetzen 

 
Bearbeiten > Suchen wiederholen  Start > Suchen > Weitersuchen 
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Bearbeiten > Gehe zu  Start > Suchen > Gehe zu 

 
Bearbeiten > Verknüpfung  OLE-Objekt > OLE > Verknüpfung bear-

beiten 

 
Bearbeiten > OLE-Objekt  OLE-Objekt > OLE > OLE-Objekt 

    

 
Ansicht > Fingereingabemodus  Schnellzugriffsleiste > Fingereingabemo-

dus 

 
Ansicht > Fixieren  Ansicht > Fenster > Titel fixieren 

 
Ansicht > Originalgröße  Ansicht > Zoom > Originalgröße 

 
Ansicht > Vergrößerungsstufe  Ansicht > Zoom > Vergrößerungsstufe 

 
Ansicht > Objektmodus  Ansicht > Modus > Objektmodus 

 
Ansicht > Formelanzeige  Ansicht > Ansicht > Formelanzeige 

 
Ansicht > Syntaxhervorhebung  Ansicht > Ansicht > Syntaxhervorhebung 

 
Ansicht > Zeilen- & Spaltenköpfe  Ansicht > Ansicht > Zeilen- und Spalten-

köpfe 

 
Ansicht > Beobachtungsfenster  Formeln > Beobachtung > Beobachtungs-

liste anzeigen 

 
Ansicht > Vollbild  Ansicht > Fenster > Vollbildmodus 

 Ansicht > Pivot-Tabellen-

Seitenleiste 

 Ansicht > Fenster > Pivot-Tabellen-

Seitenleiste 

    

 
Format > Zelle  Start > Zahl und Start > Ausrichtung 

 
Format > Zeichen  Start > Zeichen 

 
Format > Standard  Start > Inhalte > Löschen >> Zeichenfor-

matierung zurücksetzen 
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Format > Absatz  Start > Ausrichtung 

 
Format > Umrandung  Start > Format > Umrandung 

 
Format > Schattierung  Start > Format > Schattierung 

 
Format > Hyperlink  Einfügen > Verknüpfungen > Hyperlink 

 
Format > Hyperlink entfernen  Start > Inhalte > Löschen >> Hyperlink 

entfernen 

 
Format > Zellenvorlage  Start > Format > Zellenvorlagen >> Zel-

lenvorlagen verwalten 

 
Format > Bedingte Formatierung > 

Neue Regel 

 Start > Format > Bedingte Formatierung 

>> Neue Regel 

 
Format > Bedingte Formatierung > 

Regeln verwalten 

 Start > Format > Bedingte Formatierung 

>> Regeln verwalten 

 
Format > Gültigkeitsprüfung  Überprüfen > Gültigkeitsprüfung > Gül-

tigkeitsprüfung 

 
Format > Format übertragen  Start > Bearbeiten > Format übertragen 

    

 
Einfügen > Funktion  Formeln > Funktion > Funktion 

 
Einfügen > Kommentar  Einfügen > Kommentare > Kommentar 

 
Einfügen > Sonderzeichen  Einfügen > Text > Sonderzeichen 

 
Einfügen > Textbaustein  Einfügen > Text > Textbaustein 

 
Einfügen > Kopf- und Fußzeile  Einfügen > Text > Kopf- oder Fußzeile 

 Einfügen > Seitenumbruch  Layout > Seite einrichten > Seitenum-

bruch 

    

 
Arbeitsblatt > Spalte > Breite  Layout > Zellen > Zellengröße 



 

832  •  Anhang Handbuch PlanMaker 

 
Arbeitsblatt > Spalte > Optimale 

Breite 

 Layout > Zellen > Optimale Breite 

 Arbeitsblatt > Spalte > Einblenden  Start > Zellen > Sichtbarkeit >> Spalten 

anzeigen 

 Arbeitsblatt > Spalte > Ausblenden  Start > Zellen > Sichtbarkeit >> Spalten 

verbergen 

 
Arbeitsblatt > Zeile > Höhe  Layout > Zellen > Zellengröße 

 
Arbeitsblatt > Zeile > Optimale 

Höhe 

 Layout > Zellen > Optimale Höhe 

 Arbeitsblatt > Zeile > Einblenden  Start > Zellen > Sichtbarkeit >> Zeilen 

anzeigen 

 Arbeitsblatt > Zeile > Ausblenden  Start > Zellen > Sichtbarkeit >> Zeilen 

verbergen 

 
Arbeitsblatt > Blatt > Einfügen  Einfügen > Tabellen > Blatt >> Einfügen 

 Arbeitsblatt > Blatt > Kopieren  Einfügen > Tabellen > Blatt >> Kopieren 

 Arbeitsblatt > Blatt > Verschieben  Einfügen > Tabellen > Blatt >> Verschie-

ben 

 
Arbeitsblatt > Blatt > Löschen  Einfügen > Tabellen > Blatt >> Löschen 

 Arbeitsblatt > Blatt > Umbenennen  Einfügen > Tabellen > Blatt >> Umbe-

nennen 

 Arbeitsblatt > Blatt > Einblenden  Einfügen > Tabellen > Blatt >> Einblen-

den 

 Arbeitsblatt > Blatt > Ausblenden  Einfügen > Tabellen > Blatt >> Ausblen-

den 

 
Arbeitsblatt > Blatt > Eigenschaften  Einfügen > Tabellen > Blatt >> Eigen-

schaften 

 
Arbeitsblatt > Zellen einfügen  Start > Zellen > Einfügen 

 
Arbeitsblatt > Zellen löschen  Start > Zellen > Löschen 

 
Arbeitsblatt > Entfernen > Leere 

Zeilen 

 Daten > Bearbeiten > Leere Zeilen entfer-

nen 
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Arbeitsblatt > Entfernen > Doppelte 

Zeilen 

 Daten > Bearbeiten > Leere Zeilen entfer-

nen >> Doppelte Zeilen entfernen 

 
Arbeitsblatt > Namen > Bearbeiten  Formeln > Benannte Bereiche > Namen 

bearbeiten 

 
Arbeitsblatt > Namen > Anwenden  Formeln > Benannte Bereiche > Namen 

anwenden 

 
Arbeitsblatt > Namen > Überneh-

men 

 Formeln > Benannte Bereiche > Namen 

erstellen 

 
Arbeitsblatt > Namen > Liste ein-

fügen 

 Formeln > Benannte Bereiche > Namen 

einfügen 

 
Arbeitsblatt > Sortieren  Start > Inhalte > Sortieren und filtern >> 

Sortieren 

 
Arbeitsblatt > Transponieren  Daten > Bearbeiten > Transponieren 

 
Arbeitsblatt > Filter > AutoFilter  Start > Inhalte > Sortieren und filtern >> 

AutoFilter 

 
Arbeitsblatt > Filter > Alles anzei-

gen 

 Start > Inhalte > Sortieren und filtern >> 

Alles anzeigen 

 
Arbeitsblatt > Filter > Filter erneut 

anwenden 

 Start > Inhalte > Sortieren und filtern >> 

Filter erneut anwenden 

 
Arbeitsblatt > Filter > Spezialfilter  Start > Inhalte > Sortieren und filtern >> 

Spezialfilter 

 
Arbeitsblatt > Text in Spalten auf-

teilen 

 Daten > Bearbeiten > Text in Spalten 

 
Arbeitsblatt > Gliederung > Gliede-

rungsfeld automatisch anzeigen 

  

 
Arbeitsblatt > Gliederung > Grup-

pieren 

 Daten > Gliederung > Gruppieren 

 
Arbeitsblatt > Gliederung > Grup-

pierung aufheben 

 Daten > Gliederung > Gruppierung auf-

heben 

 
Arbeitsblatt > Gliederung > Gliede-

rung entfernen 

 Daten > Gliederung > Gliederung kom-

plett entfernen 

 
Arbeitsblatt > Gliederung > Details 

einblenden 

 Daten > Gliederung > Details anzeigen 
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Arbeitsblatt > Gliederung > Details 

ausblenden 

 Daten > Gliederung > Details verbergen 

 Arbeitsblatt > Gliederung > Optio-

nen 

 Daten > Gliederung 

 
Arbeitsblatt > Externe Bezüge  Daten > Bearbeiten > Externe Bezüge 

 
Arbeitsblatt > Daten konsolidieren  Daten > Analyse > Datenkonsolidierung 

 
Arbeitsblatt > Pivot-Tabelle  Einfügen > Tabellen > Pivot-Tabelle 

 
Arbeitsblatt > Neue Tabelle  Einfügen > Tabellen > Tabelle 

 
Arbeitsblatt > Tabelle > Tabellenbe-

reich 

 Tabelle > Tabelle > Bereich 

 
Arbeitsblatt > Tabelle > Tabellenei-

genschaften 

 Tabelle > Tabelle > Eigenschaften 

 
Arbeitsblatt > Tabelle > Pivot-

Tabelle erstellen 

 Tabelle > Tabelle > Als Pivot-Tabelle 

zusammenfassen 

 
Arbeitsblatt > Tabelle > In Bereich 

konvertieren 

 Tabelle > Tabelle > In Bereich konvertie-

ren 

 
Arbeitsblatt > Tabelle > Tabelle 

löschen 

 Tabelle > Tabelle > Tabelle löschen 

 
Arbeitsblatt > Tabelle > Selektieren 

> Zeilen selektieren 

 Tabelle > Auswahl > Zeilen selektieren 

 
Arbeitsblatt > Tabelle > Selektieren 

> Spalten selektieren 

 Tabelle > Auswahl > Spalten selektieren 

 
Arbeitsblatt > Tabelle > Selektieren 

> Tabelle selektieren 

 Tabelle > Auswahl > Tabelle selektieren 

 
Arbeitsblatt > Tabelle > Einfügen > 

Zeilen oberhalb einfügen 

 Tabelle > Bearbeiten > Oberhalb einfügen 

 
Arbeitsblatt > Tabelle > Einfügen > 

Zeilen unterhalb einfügen 

 Tabelle > Bearbeiten > Unterhalb einfü-

gen 

 
Arbeitsblatt > Tabelle > Einfügen > 

Spalten links einfügen 

 Tabelle > Bearbeiten > Links einfügen 

 
Arbeitsblatt > Tabelle > Einfügen > 

Spalten rechts einfügen 

 Tabelle > Bearbeiten > Rechts einfügen 
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Arbeitsblatt > Tabelle > Löschen > 

Zeilen löschen 

 Tabelle > Bearbeiten > Zeilen löschen 

 
Arbeitsblatt > Tabelle > Löschen > 

Spalten löschen 

 Tabelle > Bearbeiten > Spalten löschen 

 Arbeitsblatt > Tabelle > Kopfzeile  Tabelle > Vorlage > Kopfzeile 

 Arbeitsblatt > Tabelle > Ergebnis-

zeile 

 Tabelle > Vorlage > Ergebniszeile 

    

 
Objekt > Neuer Diagrammrahmen  Einfügen > Objekte > Diagrammrahmen 

 
Objekt > Neuer Textrahmen  Einfügen > Objekte > Textrahmen 

 
Objekt > Neuer Grafikrahmen  Einfügen > Objekte > Grafikrahmen 

 
Objekt > Neuer OLE-Objektrahmen  Einfügen > Objekte > OLE-Objektrahmen 

 
Objekt > Neues Formularobjekt > 

Kontrollkästchen 

 Einfügen > Objekte > Formularobjekt >> 

Kontrollkästchen 

 
Objekt > Neues Formularobjekt > 

Optionsfeld 

 Einfügen > Objekte > Formularobjekt >> 

Optionsfeld 

 
Objekt > Neues Formularobjekt > 

Auswahlliste 

 Einfügen > Objekte > Formularobjekt >> 

Auswahlliste 

 
Objekt > Neues Formularobjekt > 

Liste 

 Einfügen > Objekte > Formularobjekt >> 

Liste 

 
Objekt > Neues Formularobjekt > 

Schaltfläche 

 Einfügen > Objekte > Formularobjekt >> 

Schaltfläche 

 
Objekt > Neues Formularobjekt > 

Drehfeld 

 Einfügen > Objekte > Formularobjekt >> 

Drehfeld 

 
Objekt > Neues Formularobjekt > 

Bildlaufleiste 

 Einfügen > Objekte > Formularobjekt >> 

Bildlaufleiste 

 
Objekt > Neues Formularobjekt > 

Bezeichnung 

 Einfügen > Objekte > Formularobjekt >> 

Bezeichnung 

 
Objekt > Neues Formularobjekt > 

Gruppenfeld 

 Einfügen > Objekte > Formularobjekt >> 

Gruppenfeld 
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Objekt > Neue Zeichnung > Linie  Einfügen > Objekte > Linien 

 
Objekt > Neue Zeichnung > Kurve  Einfügen > Objekte > Linien 

 
Objekt > Neue Zeichnung > Frei-

handform 

 Einfügen > Objekte > Linien 

 
Objekt > Neue Zeichnung > Gerade 

Verbindung 

 Einfügen > Objekte > Linien 

 
Objekt > Neue Zeichnung > Ge-

winkelte Verbindung 

 Einfügen > Objekte > Linien 

 
Objekt > Neue Zeichnung > Ge-

krümmte Verbindung 

 Einfügen > Objekte > Linien 

 
Objekt > Neue Zeichnung > Recht-

eck 

 Einfügen > Objekte > Autoform 

 
Objekt > Neue Zeichnung > Abge-

rundetes Rechteck 

 Einfügen > Objekte > Autoform 

 
Objekt > Neue Zeichnung > Ellip-

se/Kreis 

 Einfügen > Objekte > Autoform 

 
Objekt > Neue Zeichnung > Auto-

Form 

 Einfügen > Objekte > AutoForm 

 
Objekt > Neue Zeichnung > 

TextArt 

 Einfügen > Objekte > TextArt-Objekt 

 
Objekt > Gruppieren  Layout > Objekte > Gruppieren 

 
Objekt > Reihenfolge > In den Vor-

dergrund 

 Layout > Position > In den Vordergrund 

 
Objekt > Reihenfolge > In den Hin-

tergrund 

 Layout > Position > In den Hintergrund 

 
Objekt > Reihenfolge > Eine Ebene 

nach vorne 

 Layout > Position > In den Vordergrund 

>> Eine Ebene nach vorne 

 
Objekt > Reihenfolge > Eine Ebene 

nach hinten 

 Layout > Position > In den Hintergrund 

>> Eine Ebene nach hinten 

 
Objekt > Drehen oder kippen > 

Horizontal kippen 

 Layout > Position > Objekt drehen >> 

Horizontal kippen 

 
Objekt > Drehen oder kippen > 

Vertikal kippen 

 Layout > Position > Objekt drehen >> 

Vertikal kippen 
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Objekt > Drehen oder kippen > 90° 

gegen den Uhrzeigersinn drehen 

 Layout > Position > Objekt drehen >> 90° 

gegen den Uhrzeigersinn drehen 

 
Objekt > Drehen oder kippen > 90° 

im Uhrzeigersinn drehen 

 Layout > Position > Objekt drehen >> 90° 

im Uhrzeigersinn drehen 

 
Objekt > Ausrichten oder verteilen 

> Linksbündig ausrichten 

 Layout > Position > Objekte ausrichten 

>> Linksbündig 

 
Objekt > Ausrichten oder verteilen 

> Horizontal zentrieren 

 Layout > Position > Objekte ausrichten 

>> Horizontal zentrieren 

 
Objekt > Ausrichten oder verteilen 

> Rechtsbündig ausrichten 

 Layout > Position > Objekte ausrichten 

>> Rechtsbündig 

 
Objekt > Ausrichten oder verteilen 

> Oben ausrichten 

 Layout > Position > Objekte ausrichten 

>> Oben ausrichten 

 
Objekt > Ausrichten oder verteilen 

> Vertikal zentrieren 

 Layout > Position > Objekte ausrichten 

>> Vertikal zentrieren 

 
Objekt > Ausrichten oder verteilen 

> Unten ausrichten 

 Layout > Position > Objekte ausrichten 

>> Unten ausrichten 

 
Objekt > Ausrichten oder verteilen 

> Horizontal verteilen 

 Layout > Position > Objekte ausrichten 

>> Horizontal verteilen 

 
Objekt > Ausrichten oder verteilen 

> Vertikal verteilen 

 Layout > Position > Objekte ausrichten 

>> Vertikal verteilen 

 
Objekt > Diagramm > Daten in 

Spalten 

 Diagramm > Daten > Datenreihen in 

Spalten 

 
Objekt > Diagramm > Daten in 

Zeilen 

 Diagramm > Daten > Datenreihen in Zei-

len 

 
Objekt > Diagramm > Position des 

Diagramms ändern 

 Diagramm > Position > Diagrammpositi-

on 

 
Objekt > Diagramm > Als Grafik 

speichern 

 Diagramm > Exportieren > Diagramm als 

Grafik speichern 

 
Objekt > Diagramm > Eigenschaf-

ten des Elements 

 Diagramm > Diagrammelemente > Ele-

ment bearbeiten 

 
Objekt > Eigenschaften  Objekt > Format > AutoForm-Vorlagen 

>> Weitere 

    

 
Weiteres > Rechtschreibprüfung  Überprüfen > Rechtschreibung > Recht-

schreibprüfung 
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 Weiteres > Wörterbücher bearbeiten  Überprüfen > Rechtschreibung > Recht-

schreibprüfung >> Wörterbücher bearbei-

ten 

 
Weiteres > Blattschutz  Überprüfen > Berechtigungen > Blatt-

schutz 

 
Weiteres > Arbeitsmappenschutz  Überprüfen > Berechtigungen > Arbeits-

mappenschutz 

 
Weiteres > Script starten  Datei > Skripte > Script starten 

 Weiteres > Script bearbeiten  Datei > Skripte > Script bearbeiten 

 Weiteres > Listen editieren   

 
Weiteres > Szenarien  Daten > Analyse > Szenario-Manager 

 
Weiteres > Zielwertsuche  Daten > Analyse > Zielwertsuche 

 
Weiteres > Kommentare > Kom-

mentar bearbeiten 

 Überprüfen > Kommentare > Bearbeiten 

 
Weiteres > Kommentare > Vorheri-

ger Kommentar 

 Überprüfen > Kommentare > Vorheriger 

Kommentar 

 
Weiteres > Kommentare > Nächster 

Kommentar 

 Überprüfen > Kommentare > Nächster 

Kommentar 

 
Weiteres > Kommentare > Diesen 

Kommentar anzeigen 

 Überprüfen > Kommentare > Kommen-

tarsichtbarkeit >> Diesen Kommentar 

anzeigen 

 
Weiteres > Kommentare > Alle 

Kommentare anzeigen 

 Überprüfen > Kommentare > Kommen-

tarsichtbarkeit >> Alle Kommentare an-

zeigen 

 
Weiteres > Kommentare > Kom-

mentarposition zurücksetzen 

 Überprüfen > Kommentare > Kommen-

tarsichtbarkeit >> Alle Kommentarpositi-

onen zurücksetzen 

 
Weiteres > Formelüberwachung > 

Spur zu den Vorgängern 

 Formeln > Spuren > Spur zu den Vorgän-

gern 

 
Weiteres > Formelüberwachung > 

Spuren zu den Vorgängern entfer-

nen 

 Formeln > Spuren > Alle Spuren entfer-

nen >> Spuren zu den Vorgängern entfer-

nen 

 
Weiteres > Formelüberwachung >  Formeln > Spuren > Spur zu den Nach-
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Spur zu den Nachfolgern folgern 

 
Weiteres > Formelüberwachung > 

Spuren zu den Nachfolgern entfer-

nen 

 Formeln > Spuren > Alle Spuren entfer-

nen >> Spuren zu den Nachfolgern ent-

fernen 

 
Weiteres > Formelüberwachung > 

Alle Spuren entfernen 

 Formeln > Spuren > Alle Spuren entfer-

nen 

 Weiteres > Formelüberwachung > 

Vorgänger selektieren 

 Formeln > Spuren > Spur zu den Vorgän-

gern >> Vorgänger selektieren 

 Weiteres > Formelüberwachung > 

Nachfolger selektieren 

 Formeln > Spuren > Spur zu den Nach-

folgern >> Nachfolger selektieren 

 
Weiteres > Formelüberwachung > 

Spur zum Fehler 

 Formeln > Spuren > Spur zum Fehler 

 
Weiteres > Formelüberwachung > 

Gehe zum vorhergehenden Fehler 

 Formeln > Spuren > Vorheriger Fehler 

 
Weiteres > Formelüberwachung > 

Gehe zum nächsten Fehler 

 Formeln > Spuren > Nächster Fehler 

 
Weiteres > Formelüberwachung > 

Ungültige Daten markieren 

 Daten > Überprüfung > Ungültige Daten 

markieren 

 
Weiteres > Formelüberwachung > 

Markierung für ungültige Daten 

entfernen 

 Daten > Überprüfung > Markierung ent-

fernen 

 
Weiteres > Formelüberwachung > 

Gehe zur vorhergehenden ungülti-

gen Zelle 

 Daten > Überprüfung > Vorhergehende 

ungültige Zelle 

 
Weiteres > Formelüberwachung > 

Gehe zur nächsten ungültigen Zelle 

 Daten > Überprüfung > Nächste ungültige 

Zelle 

 
Weiteres > Neu berechnen  Formeln > Aktualisieren > Daten aktuali-

sieren >> Berechnungen aktualisieren 

 
Weiteres > Diagramme aktualisie-

ren 

 Formeln > Aktualisieren > Daten aktuali-

sieren >> Diagramme aktualisieren 

 Weiteres > Alle Pivot-Tabellen 

aktualisieren 

 Formeln > Aktualisieren > Daten aktuali-

sieren >> Pivot-Tabellen aktualisieren 

 Weiteres > Externe Bezüge aktuali-

sieren 

 Formeln > Aktualisieren > Daten aktuali-

sieren >> Externe Bezüge aktualisieren 

 Weiteres > Anpassen  Datei > Einstellungen > Anpassen >> 

Ribbon anpassen 
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Weiteres > Einstellungen  Datei > Einstellungen > Einstellungen 

 

Tastenbelegung 

Auf den nächsten Seiten finden Sie Tabellen mit den wichtigsten Tastenkürzeln, die 

Sie im Programm verwenden können: 

 Tastenkürzel in der Windows-Version und der Linux-Version 

 Tastenkürzel in der Mac-Version 

Tipp: Über den Menübefehl Weiteres > Anpassen können Sie die vordefinierten 

Tastenkürzel jederzeit abändern und auch neue Tastenkürzel festlegen (siehe Ab-

schnitt „Tastenkürzel anpassen“ ab Seite 491). 

Tastenkürzel in der Windows-Version und der Linux-Version 

In der Windows-Version und der Linux-Version gibt es folgende Tastenkürzel: 

Tastenkürzel zum Editieren von Tabellen 

Befehl   Tastenkürzel 

Zur nächsten ausgefüllten Zelle            (Strg) + 
(æ)/(Æ)/(½)/(¼) 

Zur ersten Zelle der aktuellen Spalte  (Strg)(Bild½) 

Zur letzten Zelle der aktuellen Spalte  (Strg)(Bild¼) 

Zur ersten Zelle der aktuellen Zeile  (Pos1) 

Zur letzten ausgefüllten Zelle der aktuellen Zeile  (Ende) 

Zur ersten Zelle der Tabelle (Zelle A1)  (Strg)(Pos1) 

Zur letzten ausgefüllten Zelle der Tabelle  (Strg)(Ende) 

Zum vorherigen Arbeitsblatt  (Strg)(ª)(Tab) 
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Befehl   Tastenkürzel 

Zum nächsten Arbeitsblatt  (Strg)(Tab) 

Zur nächsten zirkulären Verknüpfung   (ª)(F5) 

Zelle über der aktuellen Zelle kopieren  (Strg)(,) (Komma) 

Wert aus Zelle über der aktuellen Zelle kopieren  (Strg)(ª)(,) (Komma) 

Matrixformel eingeben  (Strg)(ª)(¢) 

Matrixformel selektieren  (Strg)(7) 

Bedingtes Format selektieren  (Strg)(6) 

Auswahlliste mit den Zellinhalten direkt  

oberhalb oder unterhalb der Zelle öffnen 

 (Alt)(ª)(¼) 

Umschalten zwischen den Eingabemodi AUTO und TEXT 

(siehe Abschnitt „Statuszeile“, Seite 37) 

 (Strg)(ª)(F4) 

Hexadezimalen Zeichencode in Unicode-Zeichen wandeln*  (Strg)(Alt)(ª)(X) 

* Tippen Sie beispielsweise 20AC ein und betätigen dann diese Tastenkombination, erscheint ein Euro-

zeichen (da dieses Zeichen im Unicode-Zeichensatz den Code 20AC hat). 

Tastenkürzel für Menübefehle 

Menübefehl   Tastenkürzel 

Datei > Neu            (Strg)(N) 

Datei > Öffnen  (Strg)(O) 

Datei > Schließen  (Strg)(W) oder (Strg)(F4) 

Datei > Speichern  (Strg)(S) 

Datei > Dateimanager  (F12) 

Datei > Drucken  (Strg)(P) 

Datei > Beenden  (Strg)(Q) oder (Alt)(F4) 

   

Bearbeiten > Rückgängig  (Strg)(Z) 

Bearbeiten > Wiederherstellen  (Strg)(Y) 
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Menübefehl   Tastenkürzel 

Bearbeiten > Wiederholen  (Strg)(ª)(Y) 

Bearbeiten > Ausschneiden  (Strg)(X) 

Bearbeiten > Kopieren  (Strg)(C) 

Bearbeiten > Einfügen  (Strg)(V) 

Bearbeiten > Inhalte einfügen  (Strg)(ª)(V) 

Bearbeiten > Alles markieren  (Strg)(A) 

Bearbeiten > Suchen  (Strg)(F) 

Bearbeiten > Ersetzen  (Strg)(H) 

Bearbeiten > Suchen wiederholen  (F3) 

Bearbeiten > Gehe zu  (Strg)(G) oder (F5) 

   

Ansicht > Vollbild  (F6) 

   

Format > Zelle  (Strg)(1) 

Zahlenformat: Zahl  (Strg)(ª)(1) 

Zahlenformat: Wissenschaftlich  (Strg)(ª)(2) 

Zahlenformat: Währung  (Strg)(ª)(4) 

Zahlenformat: Prozent  (Strg)(ª)(5) 

Format > Zeichen  (Strg)(2) 

Schriftart in der Formatleiste wählen  (Strg)(D) 

Fettdruck ein-/ausschalten  (Strg)(ª)(F) oder (Strg)(B) 

Kursivschrift ein-/ausschalten  (Strg)(ª)(K) oder (Strg)(I) 

Unterstreichen ein-/ausschalten  (Strg)(ª)(U) 

Hochstellen  (Strg)(ª)(Num+) 

Tiefstellen  (Strg)(ª)(Num-) 

Hoch-/Tiefstellen abschalten  (Strg)(ª)(Num*) 
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Menübefehl   Tastenkürzel 

Ausrichtung: Standard  (Strg)(T) 

Ausrichtung: Linksbündig  (Strg)(L) 

Ausrichtung: Zentriert  (Strg)(E) 

Ausrichtung: Rechtsbündig  (Strg)(R) 

Ausrichtung: Blocksatz  (Strg)(J) 

   

Einfügen > Funktion  (F7) 

Einfügen > Kommentar  (ª)(F2) 

Aktuelles Datum einfügen  (Strg)(.) (Punkt) 

Aktuelle Uhrzeit einfügen  (Strg)(ª)(.) (Punkt) 

   

Aktuelle Zeile ausblenden  (Strg)(9) 

Aktuelle Zeile einblenden  (Strg)(ª)(9) 

Aktuelle Spalte ausblenden  (Strg)(0) 

Aktuelle Spalte einblenden  (Strg)(ª)(0) 

   

Arbeitsblatt > Zellen einfügen  (Strg)(+) 

Arbeitsblatt > Zellen löschen  (Strg)(-) 

   

Weiteres > Neu berechnen  (F9) 

Nur aktuelles Arbeitsblatt neu berechnen  (ª)(F9) 

Weiteres > Diagramme aktualisieren  (F8) 
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Tastenkürzel in der Mac-Version 

Anmerkung: Bei den meisten Tastenkürzeln mit der Cmd-Taste lässt sich alter-

nativ auch die Ctrl-Taste statt der Cmd-Taste verwenden. Für das Tastenkürzel 
(Cmd)(S) können Sie also wahlweise auch (Ctrl)(S) drücken. 

In der Mac-Version gibt es folgende Tastenkürzel: 

Tastenkürzel zum Editieren von Tabellen 

Befehl   Tastenkürzel 

Zur nächsten ausgefüllten Zelle            (Cmd) + 
(æ)/(Æ)/(½)/(¼) 

Zur ersten Zelle der aktuellen Spalte  (Cmd)(Bild½) 

Zur letzten Zelle der aktuellen Spalte  (Cmd)(Bild¼) 

Zur ersten Zelle der aktuellen Zeile  (Pos1) 

Zur letzten ausgefüllten Zelle der aktuellen Zeile  (Ende) 

Zur ersten Zelle der Tabelle (Zelle A1)  (Cmd)(Pos1) 

Zur letzten ausgefüllten Zelle der Tabelle  (Cmd)(Ende) 

Zum vorherigen Arbeitsblatt  (Cmd)(ª)(Tab) 

Zum nächsten Arbeitsblatt  (Cmd)(Tab) 

Zur nächsten zirkulären Verknüpfung   (ª)(F5) 

Zelle über der aktuellen Zelle kopieren   (Cmd)(,) (Komma) 

Wert aus Zelle über der aktuellen Zelle kopieren  (Cmd)(ª)(,) (Komma) 

Matrixformel eingeben  (Cmd)(ª)(¢) 

Matrixformel selektieren  (Cmd)(7) 

Bedingtes Format selektieren  (Cmd)(6) 

Auswahlliste mit den Zellinhalten direkt  

oberhalb oder unterhalb der Zelle öffnen 

 (Alt)(ª)(¼) 

Umschalten zwischen den Eingabemodi AUTO und TEXT 

(siehe Abschnitt „Statuszeile“, Seite 37) 

 (Cmd)(ª)(F4) 
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Befehl   Tastenkürzel 

Hexadezimalen Zeichencode in Unicode-Zeichen wandeln*  (Cmd)(Alt)(ª)(X) 

* Tippen Sie beispielsweise 20AC ein und betätigen dann diese Tastenkombination, erscheint ein Euro-

zeichen (da dieses Zeichen im Unicode-Zeichensatz den Code 20AC hat). 

Tastenkürzel für Menübefehle 

Menübefehl   Tastenkürzel 

Datei > Neu            (Cmd)(N) 

Datei > Öffnen  (Cmd)(O) 

Datei > Schließen  (Cmd)(W) oder (Cmd)(F4) 

Datei > Speichern  (Cmd)(S) 

Datei > Dateimanager  (F12) 

Datei > Drucken  (Cmd)(P) 

Datei > Beenden  (Cmd)(Q) oder (Alt)(F4) 

   

Bearbeiten > Rückgängig  (Cmd)(Z) 

Bearbeiten > Wiederherstellen  (Cmd)(Y) 

Bearbeiten > Wiederholen  (Cmd)(ª)(Y) 

Bearbeiten > Ausschneiden  (Cmd)(X) 

Bearbeiten > Kopieren  (Cmd)(C) 

Bearbeiten > Einfügen  (Cmd)(V) 

Bearbeiten > Inhalte einfügen  (Cmd)(ª)(V) 

Bearbeiten > Alles markieren  (Cmd)(A) 

Bearbeiten > Suchen  (Cmd)(F) 

Bearbeiten > Ersetzen  (Ctrl)(H) 

Bearbeiten > Suchen wiederholen  (F3) 

Bearbeiten > Gehe zu  (Cmd)(G) oder (F5) 
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Menübefehl   Tastenkürzel 

   

Ansicht > Vollbild  (F6) 

   

Format > Zelle  (Cmd)(1) 

Zahlenformat: Zahl  (Cmd)(ª)(1) 

Zahlenformat: Wissenschaftlich  (Cmd)(ª)(2) 

Zahlenformat: Währung   (Cmd)(ª)(4) 

Zahlenformat: Prozent  (Cmd)(ª)(5) 

Format > Zeichen  (Cmd)(2) 

Schriftart in der Formatleiste wählen  (Cmd)(D) 

Fettdruck ein-/ausschalten  (Cmd)(ª)(F) oder (Cmd)(B) 

Kursivschrift ein-/ausschalten  (Cmd)(ª)(K) oder (Cmd)(I) 

Unterstreichen ein-/ausschalten  (Cmd)(ª)(U) 

Hochstellen  (Cmd)(ª)(Num+) 

Tiefstellen  (Cmd)(ª)(Num-) 

Hoch-/Tiefstellen abschalten  (Cmd)(ª)(Num*) 

Ausrichtung: Standard  (Cmd)(T) 

Ausrichtung: Linksbündig  (Cmd)(L) 

Ausrichtung: Zentriert  (Cmd)(E) 

Ausrichtung: Rechtsbündig  (Cmd)(R) 

Ausrichtung: Blocksatz  (Cmd)(J) 

   

Einfügen > Funktion  (F7) 

Einfügen > Kommentar  (ª)(F2) 

Aktuelles Datum einfügen  (Cmd)(.) (Punkt) 

Aktuelle Uhrzeit einfügen  (Cmd)(ª)(.) 
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Menübefehl   Tastenkürzel 

   

Aktuelle Zeile ausblenden  (Cmd)(9) 

Aktuelle Zeile einblenden  (Cmd)(ª)(9) 

Aktuelle Spalte ausblenden  (Cmd)(0) 

Aktuelle Spalte einblenden  (Cmd)(ª)(0) 

   

Arbeitsblatt > Zellen einfügen  (Cmd)(+) 

Arbeitsblatt > Zellen löschen  (Cmd)(-) 

   

Weiteres > Neu berechnen  (F9) 

Nur aktuelles Arbeitsblatt neu berechnen  (ª)(F9) 

Weiteres > Diagramme aktualisieren  (F8) 
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Index 

# 
#BEZUG! 515 

#DIV/0! 515 

#FEHLER! 515 

#NAME? 515 

#NV 515, 590, 591, 638, 642, 699 

#WERT! 515 

#ZAHL! 515 

$ 
$-Zeichen 508, 509 

% 
%-Zeichen 504, 505 

3 
3D-Ansicht 

bei Diagrammen 329 

3D-Effekt 

bei Objekten 262 

A 
ABRUNDEN (Abrunden auf n Stellen) 522 

Abrunden auf ein Vielfaches von n 

(UNTERGRENZE) 778 

ABS (Absolutbetrag) 523 

Absatz (Menü Format) 195, 196, 197, 198, 

199, 359, 360 

Abschreibung 

arithmetisch-degressiv (DIA) 581 

geometrisch-degressiv (GDA) 603 
geometrisch-degressiv (GDA2) 604 

linear (LIA) 666 

Absolutbetrag (ABS) 523 

Absolute Zellbezüge 508, 509 

Abstand zur Blattkante 229, 230 

Achsen (in Diagrammen) 316, 318, 320 

ACHSENABSCHNITT (Achsenabschnitt 

einer Regressionsgeraden) 523 

Addition 504, 505 

ADRESSE (Zelladresse als Text ausgeben) 

525 

Aktualisieren 63, 65, 125 

Aktualisierungen suchen 451, 452 

Alle schließen (Menü Fenster) 427, 428 

Alles markieren (Menü Bearbeiten) 72 

Alles speichern (Menü Datei) 48 

Als PDF-Dokument exportieren (Menü Datei) 

394, 395 

Analysieren von Tabellen 114 

Änderungsdatum 234, 237 

Annuität 724, Siehe RMZ (Regelmäßige 

Zahlung) 

Anpassen (Menü Weiteres) 

Benutzerdefinierte Symbole erstellen 490 

Symbolleisten anpassen 475 
Tastenkürzel anpassen 491, 492 

Ansicht > Beobachtungsfenster 118 

Ansicht > Fingereingabemodus 441, 442 

Ansicht > Fixieren 158 

Ansicht > Formelanzeige 115, 116 

Ansicht > Objektmodus 251 

Ansicht > Originalgröße 468 

Ansicht > Symbolleisten 469, 470 

Ansicht > Syntaxhervorhebung 116 

Ansicht > Vergrößerungsstufe 468 

Ansicht > Vollbild 468 

Ansicht > Zeilen- & Spaltenköpfe 465, 466 

ANSI-Code eines Zeichens (CODE) 559 

Antialiasing 441, 444 

ANZAHL (Wie viele Zellen mit Zahlen 

ausgefüllt?) 526 

ANZAHL2 (Wie viele Zellen ausgefüllt?) 527 

ANZAHLLEEREZELLEN (Wie viele Zellen 

leer?) 527 

ANZAHLP (PlanMaker 97-

Kompatibilitätsfunktion) 528 

Arabische Schriftzeichen 419, 435, 436 

Arbeitsblatt 93 

Ausblenden 96 

Eigenschaften ändern 96, 97, 465 

Einblenden 96 
Einfügen 94 

Kopieren 96 

Löschen 96 
Umbenennen 96 

Verschieben 96 

Arbeitsblatt > Blatt 94, 96 

Arbeitsblatt > Daten konsolidieren 135, 137, 

141, 144 
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Arbeitsblatt > Eigenschaften 96, 97, 465 

Arbeitsblatt > Entfernen 

Doppelte Zeilen 79 

Leere Zeilen 78 

Arbeitsblatt > Externe Bezüge 512 

Arbeitsblatt > Filter 

Alles anzeigen 109, 111, 114 

Autofilter 111 

Spezialfilter 109 

Arbeitsblatt > Gliederung 

Gliederung entfernen 381, 382 
Gliederungsfeld automatisch einblenden 

383, 384 

Gruppieren 381 

Gruppierung aufheben 381, 382 

Optionen 383 

Arbeitsblatt > Namen 98, 102 

Anwenden 103 
Bearbeiten 99, 100 

Liste einfügen 102 

Übernehmen 100, 101 

Arbeitsblatt > Neue Tabelle 145, 147 

Arbeitsblatt > Sortieren 104 

Arbeitsblatt > Spalte 

Ausblenden 167, 168 

Breite 166 

Einblenden 167, 168 
Optimale Breite 166 

Arbeitsblatt > Tabelle 

Einfügen 149, 150 

In Bereich konvertieren 148, 149 

Löschen 149, 151 
Selektieren 149, 151 

Tabelle löschen 148, 149 

Tabellenbereich 149, 150 
Tabelleneigenschaften 152 

Arbeitsblatt > Text in Spalten aufteilen 107 

Arbeitsblatt > Transponieren 107 

Arbeitsblatt > Zeile 

Ausblenden 167 

Einblenden 167, 168 
Höhe 166 

Optimale Höhe 166, 167 

Arbeitsblatt > Zellen einfügen 79 

Arbeitsblatt > Zellen löschen 77 

Arbeitsblattregister 94, 432, 435, 459, 461 

Arbeitsmappe 93 

Arbeitsmappenschutz (Menü Weiteres) 404, 

405 

ARBEITSTAG (Datum nach x Arbeitstagen) 

529 

Arbeitstage zählen (NETTOARBEITSTAGE) 

693 

ARCCOS (Arcuscosinus) 530 

ARCCOSHYP (Arcuscosinus Hyperbolicus) 

531 

ARCCOT (Arcuscotangens) 532 

ARCCOTHYP (Arcuscotangens 

Hyperbolicus) 533 

ARCSIN (Arcussinus) 533 

ARCSINHYP (Arcussinus Hyperbolicus) 534 

ARCTAN (Arcustangens) 535 

ARCTAN2 (Arcustangens) 535 

ARCTANHYP (Arcustangens Hyperbolicus) 

536 

Arcuscosinus (ARCCOS) 530 

Arcuscosinus Hyperbolicus (ARCCOSHYP) 

531 

Arcuscotangens (ARCCOT) 532 

Arcuscotangens Hyperbolicus 

(ARCCOTHYP) 533 

Arcussinus (ARCSIN) 533 

Arcussinus Hyperbolicus (ARCSINHYP) 534 

Arcustangens 

ARCTAN 535 

ARCTAN2 535 

Arcustangens Hyperbolicus (ARCTANHYP) 

536 

Asiatische Schriftzeichen 435, 436 

AUFRUNDEN (Aufrunden auf n Stellen) 537 

Aufrunden auf ein Vielfaches von n 

(OBERGRENZE) 700 

Ausblenden von Zellen 

manuell 167 

mittels einer Gliederung 379 

Ausfüllen (Menü Bearbeiten) 87, 88 

Ausfüllen von Zellen (automatisch) 87 

Ausrichten oder verteilen (Menü Objekt) 255 

Ausrichtung 

bei Textrahmen 270, 272 

der Druckseiten 229, 230 
von Zellinhalten 185, 186, 187 

Ausschneiden (Menü Bearbeiten) 80, 81 

AUSWAHL (Ist x>0, x=0 oder x<0?) 538 

Auswahlliste (Formularobjekt) 342 

Auto-Eingabemodus 37, 38 

Autofilter 111 

AutoFormat (Menü Format) 211 

AutoFormen 
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Eigenschaften ändern 291 

Text hinzufügen 290 

Zeichnen 286, 289 

Automatisch berechnen 462 

Automatische Prozentwerteingabe 437 

Automatische Wiederherstellung 447, 449 

B 
B (Kompatibilitätsfunktion) 539 

BAK-Dateien 374, 375 

Balkendiagramm 298, 299 

Barwert (BW) 557 

BasicMaker 423 

BASIS (Dezimalzahl in anderes Zahlensystem 

wandeln) 540 

Bearbeiten > Alles markieren 72 

Bearbeiten > Ausfüllen 87, 88 

Bearbeiten > Ausschneiden 80, 81 

Bearbeiten > Duplizieren 256 

Bearbeiten > Einfügen 80, 81 

Bearbeiten > Ersetzen 242, 243 

Bearbeiten > Ersetzen wiederholen 243 

Bearbeiten > Gehe zu 246 

Bearbeiten > Gehe zu Hyperlink 385, 387 

Bearbeiten > Inhalte einfügen 83 

Bearbeiten > Kopieren 80, 81 

Bearbeiten > Löschen 44, 76 

Bearbeiten > Rückgängig 44, 70 

Bearbeiten > Selektiv löschen 76 

Bearbeiten > Suchen 241, 243 

Bearbeiten > Suchen wiederholen 243 

Bearbeiten > Verknüpfungen 282 

Bearbeiten > Wiederherstellen 44, 70 

Bearbeiten > Wiederholen 71 

Bearbeitungsleiste 34 

Bedingte Formatierung (Menü Format) 211 

Neue Regel 212, 213 

Regeln in den markierten Zellen löschen 
220, 221 

Regeln verwalten 217 

Bedingung 

AUSWAHL 538 
WENN 797 

Beenden (Menü Datei) 48 

Beim Speichern nach Dokumentinfo fragen 

447, 449 

Benutzerdaten 435 

Benutzerdaten ausgeben (BENUTZERFELD) 

541 

Benutzerdefinierte Zahlenformate 170, 173, 

175 

BENUTZERFELD (Benutzerdaten ausgeben) 

541 

Benutzeroberfläche (Ribbon oder 

Menüs/Symbolleisten?) 441, 442 

Benutzerwörterbücher 358 

Beobachtungsfenster (Menü Ansicht) 118 

BEREICH.VERSCHIEBEN (Versetzter 

Zellbezug) 543 

BEREICHE (Zahl der Bereiche) 543 

Bereiche benennen 98, Siehe Namen 

Beschnitt (von Grafiken) 275, 277, 278 

Bessel 544, 545, 546 

BESSELI (Modifizierte Besselfunktion erster 

Art) 544 

BESSELJ (Besselfunktion erster Art) 545 

BESSELK (Modifizierte Besselfunktion 

zweiter Art) 545 

BESSELY (Besselfunktion zweiter Art) 546 

Bestimmtheitskoeffizient 

(BESTIMMTHEITSMASS) 546 

BESTIMMTHEITSMASS 

(Bestimmtheitskoeffizient) 546 

BETAINV (Quantile einer Betaverteilung) 

547 

BETAVERT (Betaverteilung) 548 

Betaverteilung 

BETAINV 547 
BETAVERT 548 

Bildlaufleiste (Formularobjekt) 348 

Bildlaufleiste ein-/ausschalten 459, 461 

Bildschirmschriftarten glätten 441, 444 

Binärzahl in Dezimalzahl wandeln 

(BININDEZ) 549 

Binärzahl in Hexadezimalzahl wandeln 

(BININHEX) 550 

Binärzahl in Oktalzahl wandeln (BININOKT) 

551 

BININDEZ (Binärzahl in Dezimalzahl 

wandeln) 549 

BININHEX (Binärzahl in Hexadezimalzahl 

wandeln) 550 

BININOKT (Binärzahl in Oktalzahl wandeln) 

551 

Binomialverteilung 

BINOMVERT 552 
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KRITBINOM 658 

NEGBINOMVERT 692 

BINOMVERT (Binomialverteilung) 552 

Blasendiagramm 298, 299 

Blatt (Menü Arbeitsblatt) 94, 96 

BLATT (Nummer eines Arbeitsblatts) 553 

BLATTNAME (Name eines Tabellenblatts) 

554 

BLATTNUMMER (Kompatibilitätsfunktion) 

555 

Blattschutz 401 

Blattschutz (Menü Weiteres) 401, 403 

Blattschutz aufheben (Menü Weiteres) 404 

Blocksatz, vertikaler 270, 272 

Bodenfläche (in Diagrammen) 309 

BOGENMASS (Grad in Bogenmaß 

umwandeln) 556 

Bogenmaß in Grad umwandeln (GRAD) 609 

Börsendiagramm 298, 301 

Boxplot-Diagramm 298, 302 

Box-Whisker-Plot 298, 302 

Breite einer Spalte ändern 165 

Bruch (Zahlenformat) 170, 172 

Buchhaltung (Zahlenformat) 170, 171 

BW (Barwert) 557 

C 
CHIINV (Quantile einer Chi-Quadrat-

Verteilung) 558 

Chi-Quadrat-Unabhängigkeitstest (CHITEST) 

558 

Chi-Quadrat-Verteilung 

CHIINV 558 
CHIVERT 559 

CHITEST (Chi-Quadrat-Unabhängigkeitstest) 

558 

CHIVERT (Chi-Quadrat-Verteilung) 559 

CODE (ANSI-Code eines Zeichens) 559 

COS (Cosinus) 560 

COSHYP (Cosinus Hyperbolicus) 561 

Cosinus (COS) 560 

Cosinus Hyperbolicus (COSHYP) 561 

COT (Cotangens) 561 

Cotangens (COT) 561 

Cotangens Hyperbolicus (COTHYP) 562 

COTHYP (Cotangens Hyperbolicus) 562 

CSV-Dateiformat 413 

D 
DATEDIF (Datumsdifferenz) 563 

Datei > Alles speichern 48 

Datei > Als PDF-Dokument exportieren 394, 

395 

Datei > Beenden 48 

Datei > Dateimanager 370 

Datei > Druckbereich 

Druckbereich entfernen 231, 233 

Druckbereich festlegen 231, 233 

Datei > Drucken 391 

Datei > Druckvorschau 389, 390 

Datei > Eigenschaften 456 

Karteikarte Berechnen 462 

Karteikarte Farben 456 

Karteikarte Infos 370, 456 
Karteikarte Optionen 459 

Karteikarte Schriften 465 

Karteikarte Schutz 406, 407, 465 
Karteikarte Statistik 459 

Datei > Holen 274 

Datei > Neu 45, 208, 209 

Datei > Öffnen 45, 209, 210, 411, 412 

Datei > Quelle wählen 274, 275 

Datei > Schließen 427 

Datei > Seite einrichten 229, 231, 234 

Datei > Speichern 48 

Datei > Speichern unter 48, 411, 412 

Datei > Versenden 400 

Datei > Zurück zu vorheriger Version 374, 

376 

Dateierweiterungen verknüpfen 451, 452 

Dateiformat 411, 412 

Dateiformate 411 

Dateimanager (Menü Datei) 370 

DATEINAME (Dateiname des Dokuments) 

564 

Dateityp 411, 412 

Daten in Zellen eingeben 67 

Daten konsolidieren (Menü Arbeitsblatt) 135, 

137, 141, 144 

Datenbankfunktionen 519, 566, 567, 568, 

569, 570, 571, 572, 573, 574, 575 

Datenbereich (von Diagrammen) 325, 326 

Datenpunkte (in Diagrammen) 310 

Datenquelle (von Diagrammen) 325, 326 

Datenreihen (in Diagrammen) 310, 325, 326 



 

Handbuch PlanMaker Index  •  853 

Datum 

aktuelles (HEUTE) 613 

aktuelles, mit Uhrzeit (JETZT) 647 
Datumswert bilden (DATUM) 565 

Eingeben 67 

DATUM (Datumswert bilden) 565 

Datum des Erstellens eines Dokuments 

(ERSTELLDATUM) 585 

Datum in/vor n Monaten (EDATUM) 582 

Datum/Zeit (Zahlenformat) 170, 171 

Datumsdifferenz (DATEDIF) 563 

DATWERT (Text in Datum wandeln) 566 

DBANZAHL (Datenbankfunktion) 566, 567 

dBase-Dateiformat 411, 413 

DBAUSZUG (Datenbankfunktion) 568 

DBMAX (Datenbankfunktion) 569 

DBMIN (Datenbankfunktion) 570 

DBMITTELWERT (Datenbankfunktion) 570 

DBPRODUKT (Datenbankfunktion) 571 

DBSTDABW (Datenbankfunktion) 572 

DBSTDABWN (Datenbankfunktion) 573 

DBSUMME (Datenbankfunktion) 573 

DBVARIANZ (Datenbankfunktion) 574 

DBVARIANZEN (Datenbankfunktion) 575 

DELTA (Prüfen auf Gleichheit zweier Werte) 

576 

Design Science 285 

Determinante einer Matrix (MDET) 673 

DEZIBEL (Dezibelwert zweier Größen) 576 

DEZIMAL (Zahl aus anderem Zahlensystem 

umwandeln) 577 

Dezimaltrenner nach Zahleneingabe 

verschieben 459, 460 

Dezimalzahl in anderes Zahlensystem 

wandeln (BASIS) 540 

Dezimalzahl in Binärzahl wandeln 

(DEZINBIN) 578 

Dezimalzahl in Hexadezimalzahl wandeln 

(DEZINHEX) 579 

Dezimalzahl in Oktalzahl wandeln 

(DEZINOKT) 580 

DEZINBIN (Dezimalzahl in Binärzahl 

wandeln) 578 

DEZINHEX (Dezimalzahl in 

Hexadezimalzahl wandeln) 579 

DEZINOKT (Dezimalzahl in Oktalzahl 

wandeln) 580 

DIA (Arithmetisch-degressive Abschreibung) 

581 

Diagramm (Menü Objekt) 

Als Grafik speichern 332 

Daten in Spalten 303 
Daten in Zeilen 303 

Horizontale Gitternetzlinien anzeigen 322 

Position des Diagramms ändern 331 
Trendlinie hinzufügen 314, 315 

Vertikale Gitternetzlinien anzeigen 322 

Diagramme 295 

Aktualisieren 330 
als Grafik speichern 332 

Anordnung der Datenreihen ändern 303, 

325, 326 
Bearbeiten 297 

Diagrammeigenschaften ändern 324 

Diagrammelemente bearbeiten 304 
Diagrammtyp ändern 298 

Einfügen 296 

Position ändern 331 

Diagramme aktualisieren (Menü Weiteres) 

330, 462, 464 

Diagrammelemente 304 

Diagrammfläche (in Diagrammen) 306 

Diagrammleiste 297 

Diagrammtitel 328 

Diagrammtyp 298 

Dialogsprache 441 

Division 504, 505 

Dokumenteigenschaften 456 

Karteikarte Berechnen 462 

Karteikarte Farben 456 
Karteikarte Infos 456 

Karteikarte Optionen 459 

Karteikarte Schriften 465 
Karteikarte Schutz 465 

Karteikarte Statistik 459 

Dokumentfenster 425 

Dokumentinfos 370 

Dokumentschutz 406 

Dokumentstatistik 459 

Dokumentvorlagen 208, 209 

Doppelte Zeilen entfernen 79 

Drag and Drop 80, 81 

Drehen 

Achsenbeschriftungen 316, 318, 320, 321 

Objekte 254, 256, 257 

Text in AutoFormen 292 
Text in Textrahmen 270, 272 

Zellinhalte 185, 187 
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Drehen oder Kippen (Menü Objekt) 254, 255 

Drehfeld (Formularobjekt) 346 

Dreidimensionale Berechnungen 58, 97 

Druckbereich 231, 232 

Druckbereich (Menü Datei) 

Druckbereich entfernen 231, 233 

Druckbereich festlegen 231, 233 

Druckdatum 234, 237 

Drucken (Menü Datei) 391 

Druckrichtung 231, 232 

Druckvorschau (Menü Datei) 389, 390 

Druckzeit 234, 237 

Duplikate entfernen 79 

Duplizieren (Menü Bearbeiten) 256 

Durchstreichen 191 

E 
Echtzeitvorschau 441, 443 

Ecken (in Diagrammen) 310 

EDATUM (Datum in/vor n Monaten) 582 

Editiermodus 251 

Effekte (bei Objekten) 263 

EFFEKTIV (Effektivzins) 583 

Effektivzins (EFFEKTIV) 583 

Eigenschaften (Menü Arbeitsblatt) 96, 97, 465 

Eigenschaften (Menü Datei) 456 

Karteikarte Berechnen 462 

Karteikarte Farben 456 

Karteikarte Infos 370, 456 
Karteikarte Optionen 459 

Karteikarte Schriften 465 

Karteikarte Schutz 406, 407, 465 
Karteikarte Statistik 459 

Eigenschaften (Menü Objekt) 

Allgemeine Eigenschaften 256 

Bei Auswahllisten 342 

Bei Bezeichnungen 350 
Bei Bildlaufleisten 348 

Bei Diagrammen 298, 324 
Bei Drehfeldern 346 

Bei Grafiken 275 

Bei Gruppenfeldern 350 
Bei Kontrollkästchen 338 

Bei Listen 344 

Bei OLE-Objekten 283 

Bei Optionsfeldern 340 

Bei Schaltflächen 345 

Bei Textrahmen 270 
Bei Zeichnungen 291 

Standardeinstellungen ändern 266 

Einblenden von Zellen 167 

Einfügen 

Spalten 79 
Zeilen 79 

Zellen 79 

Einfügen (Menü Bearbeiten) 80, 81 

Einfügen > Funktion 506, 507 

Einfügen > Kommentar 126 

Einfügen > Kopf- und Fußzeile 234 

Einfügen > Seitenumbruch 238 

Einfügen > Sonderzeichen 160 

Einfügen > Textbaustein 362, 363, 364 

Einstellungen 431 

Einstellungen (Menü Weiteres) 432 

Karteikarte Allgemein 435 

Karteikarte Ansicht 432 

Karteikarte Aussehen 441 
Karteikarte Bearbeiten 437 

Karteikarte Dateien 447 

Karteikarte Schriften 455 
Karteikarte Sprache 446 

Karteikarte System 451 

Einzüge 196 

Ellipsen 

Eigenschaften ändern 291 

Zeichnen 286, 289 

E-Mail 400 

Endergebnis runden 462, 464 

Entfernen (Menü Arbeitsblatt) 

Doppelte Zeilen 79 
Leere Zeilen 78 

Ersetzen (Menü Bearbeiten) 242, 243 

ERSETZEN (Text in Zeichenkette ersetzen) 

584 

Ersetzen wiederholen (Menü Bearbeiten) 243 

Erstelldatum 234, 237 

ERSTELLDATUM (Datum des Erstellens 

eines Dokuments) 585 

Erweiterte Unterstützung für arabischen Text 

419, 435, 436 

Erweiterte Unterstützung für asiatische 

Schriften 435, 436 

EUROCONVERT (Euro-Währungen 

konvertieren) 586 

Euro-Währungen konvertieren 

(EUROCONVERT) 586 

Excel-Dateiformat 337, 411, 412, 415, 416, 

418 



 

Handbuch PlanMaker Index  •  855 

EXP (e hoch x) 587 

Exponentialverteilung (EXPONVERT) 588 

Exponentielle Regression 

Kenngrößen (RKP) 722 
Werte (VARIATION) 782 

EXPONVERT (Exponentialverteilung) 588 

Export (eines Fremdformats) 411 

Externe Bezüge (Menü Arbeitsblatt) 512 

Externe Bezüge aktualisieren (Menü 

Weiteres) 512, 513 

Externe Zellbezüge 510 

F 
FAKULTÄT (Fakultät) 589 

FALSCH (Wahrheitswert) 590 

Farbe 

von Objekten 258 

von Text 192 

von Zellen 183 

Farbpalette bearbeiten 456 

Farbverlauf (bei Objekten) 258, 259 

FEHLER.TYP (Fehlerwerte abfragen) 590 

Fehlerindikator (in Diagrammen) 310, 313 

Fehlerwerte 123, 515 

Fehlerwerte abfragen (FEHLER.TYP) 590 

FEIERTAG (Datum von beweglichen 

Feiertagen) 591 

Felder (für Kopf-/Fußzeilen) 234, 236 

Fenster > Alle schließen 427, 428 

Fenster > Nebeneinander anzeigen 428, 429 

FEST (Zahl mit festen Nachkommastellen 

formatieren) 592 

Fett 191 

Filter 109, 766 

Filter (Menü Arbeitsblatt) 

Alles anzeigen 109, 111, 114 

Autofilter 111 

Spezialfilter 109 

FINDEN (Text in Zeichenkette suchen) 594 

Fingereingabemodus 441, 442 

Fingereingabemodus (Menü Ansicht) 441, 

442 

FINV (Quantile einer F-Verteilung) 594 

FISHER (Fisher-Transformation) 595 

FISHERINV (Umkehrung der Fisher-

Transformation) 596 

Fixieren (Menü Ansicht) 158 

Flächendiagramm 298, 299 

Format > Absatz 195, 196, 197, 198, 199, 

359, 360 

Format > AutoFormat 211 

Format > Bedingte Formatierung 211 

Neue Regel 212, 213 
Regeln in den markierten Zellen löschen 

220, 221 

Regeln verwalten 217 

Format > Format übertragen 228 

Format > Gültigkeitsprüfung 124, 221, 222 

Format > Hyperlink 385 

Format > Hyperlink entfernen 385, 387 

Format > Schattierung 183 

Format > Standard 195 

Format > Umrandung 180, 181 

Format > Zeichen 188, 190, 191, 192, 193, 

194, 195 

Format > Zeichenvorlage 199, 200, 201, 202, 

203 

Format > Zelle 

Karteikarte Ausrichtung 185 
Karteikarte Schattierung 183 

Karteikarte Schutz 402 

Karteikarte Umrandung 180 
Karteikarte Zahlenformat 168, 170, 173 

Format > Zellenvorlage 204, 205, 207 

Format übertragen (Menü Format) 228 

Formatleiste 33, 190, 191, 192 

Formel einer Zelle anzeigen 

(FORMELTEXT) 596 

Formelanzeige (Menü Ansicht) 115, 116 

Formeleditor 285 

FORMELTEXT (Formel einer Zelle 

anzeigen) 596 

Formelüberwachung (Menü Weiteres) 119, 

121, 122, 123, 124 

Formelüberwachungsleiste 119, 120 

Formulare 333 

Formularleiste 335 

Fraktil 712, Siehe QUANTIL 

Freihandformen 

Eigenschaften ändern 291 

Zeichnen 286, 288 

Fremdformate 411 

F-Test (FTEST) 597 

FTEST (F-Test) 597 

Füllung 



 

856  •  Index Handbuch PlanMaker 

von Objekten 258 

von Zellen 183 

Funktion (Menü Einfügen) 506, 507 

Funktionen 

Beschreibungen aller Funktionen 522 

einfügen 506, 507 

Funktionsleiste 33 

Fußzeile 234 

FVERT (F-Verteilung) 597 

F-Verteilung 

FINV 594 

FVERT 597 

G 
GAMMA (Gammafunktion) 598 

Gammafunktion 

GAMMA 598 

GAMMALN 599 

GAMMAINV (Quantile einer 

Gammaverteilung) 599 

GAMMALN (Logarithmus der 

Gammafunktion) 599 

GAMMAVERT (Gammaverteilung) 600 

Gammaverteilung 

GAMMAINV 599 

GAMMAVERT 600 

GANZZAHL (Runden auf ganze Zahl) 600 

GAUSS (Standardnormalverteilung) 601 

GAUSSFEHLER (Gaußsche Fehlerfunktion) 

602 

GAUSSFKOMPL (Komplement zur 

Gaußschen Fehlerfunktion) 602 

Gaußsche Fehlerfunktion 

GAUSSFEHLER 602 

GAUSSFKOMPL 602 

Gauß-Test (GTEST) 611 

Gauß-Verteilung (NORMVERT) 696 

GDA (Geometrisch-degressive Abschreibung) 

603 

GDA2 (Geometrisch-degressive 
Abschreibung) 604 

Gehe zu (Menü Bearbeiten) 246 

Gehe zu Hyperlink (Menü Bearbeiten) 385, 

387 

Geometrisches Mittel (GEOMITTEL) 605 

GEOMITTEL (Geometrisches Mittel) 605 

GERADE (Aufrunden auf eine gerade Zahl) 

605 

GESTUTZTMITTEL (Mittelwert ohne 

Randwerte) 606 

GGANZZAHL (Zahl größer gleich 

Schwellenwert?) 607 

GGT (Größter gemeinsamer Teiler) 608 

Gipfligkeit einer Verteilung (KURT) 662 

Gitternetzlinien 

in Diagrammen 322 
zwischen Tabellenzellen 465, 466 

GLÄTTEN (Überflüssige Leerzeichen 

entfernen) 609 

Gleichheit zweier Werte (DELTA) 576 

Gliederung (Menü Arbeitsblatt) 
Gliederung entfernen 381, 382 

Gliederungsfeld automatisch einblenden 

383, 384 
Gruppieren 381 

Gruppierung aufheben 381, 382 

Optionen 383 

Gliederungen 379 

Ein- und Ausblenden von gruppierten 
Zellen 381, 383 

Einstellungen ändern 383 

Gliederungsansicht schützen 383, 384 

Gliederungsfeld 379, 383, 384 

Gliederungsleiste 379, 381 

GRAD (Bogenmaß in Grad umwandeln) 609 

Grad in Bogenmaß umwandeln 

(BOGENMASS) 556 

Grafiken 273 

Eigenschaften ändern 275 

Einfügen 273 

Einscannen 274 
Rotieren 254 

Grafiken im Speicher komprimieren 451 

GROSS (In Großbuchstaben wandeln) 610 

GROSS2 (In Groß-/Kleinbuchstaben 

wandeln) 610 

Großbuchstaben 191 

Großbuchstaben, wandeln in (GROSS) 610 

Großbuchstaben, wandeln in (GROSS2) 610 

Größe 

von Objekten 253 

von Zellen 165 

Größe der Benutzeroberfläche 441, 445 

Größenachse (in Diagrammen) 318 

Größter gemeinsamer Teiler (GGT) 608 

Grundlagen 41 

Gruppieren 
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von Objekten 268 

Gruppieren (Menü Objekt) 268 

Gruppierung aufheben (Menü Objekt) 268 

GTEST (Gauß-Test) 611 

Gültigkeitsprüfung 221 

Gültigkeitsprüfung (Menü Format) 124, 221, 

222 

H 
Handbuch 23 

HARMITTEL (Harmonisches Mittel) 612 

Harmonisches Mittel (HARMITTEL) 612 

HÄUFIGKEIT (Häufigkeitsverteilung) 612 

Häufigkeitsverteilung (HÄUFIGKEIT) 612 

HEUTE (Aktuelles Datum) 613 

Hexadezimalzahl in Binärzahl wandeln 

(HEXINBIN) 614 

Hexadezimalzahl in Dezimalzahl wandeln 

(HEXINDEZ) 615 

Hexadezimalzahl in Oktalzahl wandeln 

(HEXINOKT) 616 

HEXINBIN (Hexadezimalzahl in Binärzahl 

wandeln) 614 

HEXINDEZ (Hexadezimalzahl in 

Dezimalzahl wandeln) 615 

HEXINOKT (Hexadezimalzahl in Oktalzahl 

wandeln) 616 

Hintergrundfarbe 

des Programms 441, 445 
von Text 192 

von Zellen 183 

Hochformat 229, 230 

Hochstellen 193 

Hoch-Tief-Diagramm 298, 301 

Höhe einer Zeile ändern 165 

Holen (Menü Datei) 274 

Horizontale Ausrichtung 

von Zellinhalten 185, 186 

Horizontale Gitternetzlinien anzeigen 322 

HTML-Dokumente 387 

Hunspell-Wörterbücher 446, 447, 497 

Hypergeometrische Verteilung 

(HYPGEOMVERT) 619 

HYPERLINK (Hyperlink) 617 

Hyperlink (Menü Format) 385 

Hyperlink entfernen (Menü Format) 385, 387 

Hyperlinks (Verknüpfungen) 

bei Objekten 264, 265 

bei Zellinhalten 385 

Funktion HYPERLINK 617 

HYPGEOMVERT (Hypergeometrische 

Verteilung) 619 

I 
IDENTISCH (Zeichenketten identisch?) 620 

IF-Bedingung 797, Siehe WENN 

Ignoriere Wörter, die mit einer Zahl beginnen 

446, 447 

IKV (Interner Zinsfuß) 621 

Im Dokument ablegen (Grafiken) 273, 274 

IMABS (Absolutbetrag einer komplexen 

Zahl) 622 

IMAGINÄRTEIL (Imaginärteil einer 

komplexen Zahl) 622 

IMAPOTENZ (Potenz einer komplexen Zahl) 

623 

IMARGUMENT (Winkel einer komplexen 

Zahl) 623 

IMCOS (Cosinus einer komplexen Zahl) 624 

IMDIV (Division komplexer Zahlen) 624 

IMEXP (Algebraische Form einer komplexen 

Zahl) 625 

IMKONJUGIERTE (Konjugiert komplexe 

Zahl) 626 

IMLN (Natürlicher Logarithmus einer 

komplexen Zahl) 626 

IMLOG10 (Zehnerlogarithmus einer 

komplexen Zahl) 627 

IMLOG2 (Zweierlogarithmus einer 

komplexen Zahl) 627 

IMNEG (Negativer Wert einer komplexen 

Zahl) 628 

Import (eines Fremdformats) 411 

IMPRODUKT (Produkt komplexer Zahlen) 

629 

IMREALTEIL (Realteil einer komplexen 

Zahl) 629 

IMSIN (Sinus einer komplexen Zahl) 630 

IMSUB (Differenz komplexer Zahlen) 630 

IMSUMME (Summe komplexer Zahlen) 631 

IMWURZEL (Quadratwurzel einer 

komplexen Zahl) 631 

In den Ordner des Dokuments kopieren 

(Grafiken) 273, 274 

INDEX (Zelle in einem Bereich) 632 



 

858  •  Index Handbuch PlanMaker 

INDIREKT (Bezug aus Zeichenkette bilden) 

633 

Informationen über eine Zelle (ZELLE) 815 

Inhalte einfügen (Menü Bearbeiten) 83 

Innenränder 

von Text in AutoFormen 292 
von Textrahmen 270, 271 

von Zellen 185, 187 

Installation 

Android 28 

Linux 27 
macOS 26 

Windows 25 

Internen Grafikcache begrenzen 451 

Interner Zinsfuß 

IKV 621 

QIKV 711 
XINTZINSFUSS 805 

Internet 

HTML-Dokumente 387 

Inverse einer Matrix (MINV) 677 

ISOKALENDERWOCHE (Kalenderwoche 

nach ISO-Norm) 634 

ISOWOCHE (Kalenderwoche nach ISO-

Norm) 635 

ISPMT (Zinszahlung) 636 

ISTBEZUG (Ist ein Zellbezug?) 637 

ISTFEHL (Ist ein Fehlerwert außer #NV?) 

515, 638 

ISTFEHLER (Ist ein Fehler?) 515, 638 

ISTFORMEL (Ist eine Formel?) 639 

ISTGERADE (Ist eine gerade Zahl?) 640 

ISTKTEXT (Ist kein Text?) 640 

ISTLEER (Ist leer?) 641 

ISTLOG (Ist Wahrheitswert?) 642 

ISTNV (Ist nicht vorhanden?) 642 

ISTTEXT (Ist eine Zeichenkette?) 643 

ISTUNGERADE (Ist eine ungerade Zahl?) 

644 

ISTZAHL (Ist eine Zahl?) 645 

ISTZAHLP (PlanMaker 97-

Kompatibilitätsfunktion) 646 

Iterationen 462, 464 

J 
JAHR (Jahr aus einem Datumswert ermitteln) 

647 

JETZT (Aktuelles Datum, aktuelle Uhrzeit) 

647 

K 
Kalenderwoche 

ISOKALENDERWOCHE 634 

ISOWOCHE 635 
KALENDERWOCHE 648 

KALENDERWOCHE (Kalenderwoche) 648 

Kantenglättung von Grafiken 451 

Kapitälchen 191 

Kapitalrückzahlung (KAPZ) 649 

Kapitalrückzahlung, kumuliert 

(KUMKAPITAL) 659 

Kapitalwert 

NBW 691 
XKAPITALWERT 806 

KAPZ (Kapitalrückzahlung) 649 

Kegeldiagramm 298, 301 

Kenngrößen einer Regression 

RGP (linear) 720 

RKP (exponentiell) 722 

Kerning 194 

KGRÖSSTE (k-größter Wert) 651 

KGV (Kleinstes gemeinsames Vielfaches) 651 

Kippen (von Objekten) 254 

KKLEINSTE (k-kleinster Wert) 652 

Klassische Menüs und Symbolleisten 441, 

442 

KLEIN (In Kleinbuchstaben wandeln) 653 

Kleinbuchstaben, wandeln in (KLEIN) 653 

Kleinstes gemeinsames Vielfaches (KGV) 651 

KOMBINATIONEN 654 

Kommentar (Menü Einfügen) 126 

Kommentare immer anzeigen 459, 460 

KOMPLEXE (Komplexe Zahl bilden) 655 

Komplexe Schriftzeichen 435, 436 

Komplexe Zahlen 655 

Absolutbetrag (IMABS) 622 
Algebraische Form (IMEXP) 625 

Cosinus (IMCOS) 624 

Differenz (IMSUB) 630 
Division (IMDIV) 624 

Imaginärteil (IMAGINÄRTEIL) 622 

KOMPLEXE (Komplexe Zahl bilden) 655 
Konjugierte (IMKONJUGIERTE) 626 

Logarithmus, natürlicher (IMLN ) 626 

Logarithmus, Zehner (IMLOG10 ) 627 
Logarithmus, Zweier (IMLOG2 ) 627 
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Negativer Wert (IMNEG) 628 

Potenz (IMAPOTENZ) 623 

Produkt (IMPRODUKT) 629 
Quadratwurzel (IMWURZEL) 631 

Realteil (IMREALTEIL) 629 

Sinus (IMSIN) 630 
Summe (IMSUMME) 631 

Winkel (IMARGUMENT) 623 

KONFIDENZ (Konfidenzintervall) 656 

Konfidenzintervall (KONFIDENZ) 656 

Konsolidieren von Daten 135 

Kontextmenü 32 

Kontrollkästchen (Formularobjekt) 338 

Kopf- und Fußzeile (Menü Einfügen) 234 

Kopfzeile 234 

Kopieren (Menü Bearbeiten) 80, 81 

KORREL (Korrelationskoeffizient) 657 

Korrelationskoeffizient 

KORREL 657 
PEARSON 705 

KOVAR (Kovarianz) 657 

Kovarianz (KOVAR) 657 

Kreisdiagramm 298, 300 

Kreise 

Eigenschaften ändern 291 

Zeichnen 286, 289 

KRITBINOM 658 

KUMKAPITAL (Kumulierte 

Kapitalrückzahlungen) 659 

KUMZINSZ (Kumulierte Zinszahlungen) 661 

Kursdiagramm 298, 301 

Kursiv 191 

KURT (Kurtosis einer Verteilung) 662 

Kurtosis einer Verteilung (KURT) 662 

Kurven 

Eigenschaften ändern 291 

Zeichnen 286, 288 

KÜRZEN (Zahl auf n Nachkommastellen 

kürzen) 663 

L 
LÄNGE (Länge einer Zeichenkette) 664 

Laufweite 194 

LAUFZEIT 665 

Leere Zeilen löschen 78 

Leerzeichen entfernen (GLÄTTEN) 609 

Legende (in Diagrammen) 323 

Leuchteffekt (bei Objekten) 263, 264 

LIA (Lineare Abschreibung) 666 

Lineare Regression 

ACHSENABSCHNITT 523 

Kenngrößen (RGP) 720 

SCHÄTZER 727 
Trend in Diagrammen anzeigen 314 

Werte (TREND) 770 

Lineares Gleichungssystem (MSOLVE) 687 

Linien 

Eigenschaften ändern 291 

Zeichnen 286, 287 

zur Umrandung von Objekten 260 

Liniendiagramm 298, 299 

Linke Alt-Taste für Tastenkürzel verwenden 

437, 440 

LINKS (Teil einer Zeichenkette) 667 

Links (Verknüpfungen) 

bei Objekten 264, 265 

bei Zellinhalten 385 
Funktion HYPERLINK 617 

Linksbündig 185, 186 

Liste (Formularobjekt) 343 

Listen editieren (Menü Weiteres) 494, 495 

LN (Natürlicher Logarithmus) 668 

LOG (Logarithmus) 668 

LOG10 (Zehnerlogarithmus) 669 

Logarithmische Normalverteilung 

LOGINV 670 

LOGNORMVERT 670 

Logarithmus 

natürlicher (LN) 668 

Zehner (LOG10) 669 
zu beliebiger Basis (LOG) 668 

LOGINV (Quantile einer 

Lognormalverteilung) 670 

LOGNORMVERT (Logarithmische 

Normalverteilung) 670 

Löschen 

Doppelte Zeilen 79 

Leere Zeilen 78 

Zellen 77 
Zellinhalte 76 

Löschen (Menü Bearbeiten) 44, 76 

Lösung eines LGS (MSOLVE) 687 

M 
Mailen eines Dokuments 400 

Makros 337, 418 

Marken anzeigen 459, 460 
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Markieren 

Objekte 250 

Zellen 71 

Markierung nach Eingabe ... bewegen 437 

Maßeinheit 441, 445 

Maßeinheiten umrechnen (UMWANDELN) 

774 

MathType 285 

Matrix 516 

Arbeiten mit Matrizen 516 
MDET (Determinante) 673 

MINV (Inverse) 677 

MMULT (Multiplikation) 684 

MSOLVE (Lösung eines LGS) 687 

MTRANS (Transponieren) 688 

Matrixfunktionen 516, 517 

MAX (Maximalwert) 671 

MAXA (Maximalwert) 672 

Maximal widerrufbare Aktionen 435 

MDET (Determinante einer Matrix) 673 

MEDIAN 673 

Meldung bei fehlerhaften Formeln 437, 438 

Menüband 21, 35, Siehe Ribbon, Siehe 

Ribbon 

Menüleiste 32 

Menüs/Symbolleisten oder Ribbon? 441, 442 

MILLISEKUNDEN (Millisekunden aus 

einem Datumswert ermitteln) 674 

MIN (Minimalwert) 675 

MINA (Minimalwert) 676 

MINUTE (Minute aus einem Datumswert 

ermitteln) 677 

MINV (Inverse einer Matrix) 677 

MITTELABW (Mittlere Abweichung vom 

Mittelwert) 678 

Mittelwert 

Arithmetisch (MITTELWERT) 679 
Arithmetisch (MITTELWERTA) 680 

Ausgewählter Werte 

(MITTELWERTWENN) 681 
Ausgewählter Werte 

(MITTELWERTWENNS) 682 

Geometrisch (GEOMITTEL) 605 
Harmonisch (HARMITTEL) 612 

Ohne Randwerte (GESTUTZTMITTEL) 

606 

MITTELWERT (Arithmetisches Mittel) 679 

MITTELWERTA (Arithmetisches Mittel) 680 

MITTELWERTWENN (Mittelwert 

ausgewählter Werte) 681 

MITTELWERTWENNS (Mittelwert 

ausgewählter Werte) 682 

Mittlere Abweichung vom Mittelwert 

(MITTELABW) 678 

Mittlere Maustaste 437, 440 

Mittlere quadratische Abweichung vom 

Mittelwert (SUMQUADABW) 756 

MMULT (Multiplikation zweier Matrizen) 

684 

MODALWERT (Häufigster Wert) 684 

Modifizierter interner Zinsfuß (QIKV) 711 

Modulo 717, Siehe REST 

MONAT (Monat aus einem Datumswert 

ermitteln) 685 

MONATSENDE (Monatsende in/vor n 

Monaten) 686 

MSOLVE (Lösung eines linearen 

Gleichungssystems) 687 

MTRANS (Transponieren einer Matrix) 688 

Multinomialkoeffizient (POLYNOMIAL) 708 

Multiplikation 504, 505 

Multiplikation zweier Matrizen (MMULT) 

684 

N 
N (Wert in Zahl umwandeln) 689 

Nach Produktaktualisierungen suchen 451, 

452 

NACHKOMMA (Nachkommastellen einer 

Zahl) 690 

Namen (für Tabellenbereiche) 98 

Namen (Menü Arbeitsblatt) 98, 102 

Anwenden 103 

Bearbeiten 99, 100 
Liste einfügen 102 

Übernehmen 100, 101 

NBW (Nettobarwert) 691 

Nebeneinander anzeigen (Menü Fenster) 428, 

429 

NEG (Negativer Wert einer Zahl) 692 

Negative Binomialverteilung 

(NEGBINOMVERT) 692 

Negativer Wert (NEG) 692 

NEGBINOMVERT (Negative 

Binomialverteilung) 692 

NETTOARBEITSTAGE (Zahl der 

Arbeitstage) 693 

Nettobarwert 
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NBW 691 

XKAPITALWERT 806 

Netzdiagramm 298, 299, 329 

Neu (Menü Datei) 45, 208, 209 

Neu berechnen (Menü Weiteres) 125, 462, 

463 

Neuberechnen nur vor dem ... 462 

Neue Tabelle (Menü Arbeitsblatt) 145, 147 

Neue Zeichnung (Menü Objekt) 286 

Neuer Diagrammrahmen (Menü Objekt) 296 

Neuer Grafikrahmen (Menü Objekt) 273 

Neuer Grafikrahmen aus der Galerie (Menü 

Objekt) 275 

Neuer OLE-Objektrahmen (Menü Objekt) 

279, 280, 281 

Neuer Textrahmen (Menü Objekt) 269, 270 

Neues Formularobjekt (Menü Objekt) 335 

Auswahlliste 342 

Bezeichnung 349, 350 

Bildlaufleiste 348 
Drehfeld 346 

Gruppenfeld 349, 350 

Kontrollkästchen 338 

Liste 343 

Optionsfeld 340 

Schaltfläche 345 

Neumannfunktion (BESSELY) 546 

NICHT (Logisches NICHT) 694 

NOMINAL (Nominalverzinsung) 695 

Normal.pmvx 210 

Normalverteilung 

NORMINV 696 

NORMVERT 696 

Normalverteilung, logarithmische 

LOGINV 670 
LOGNORMVERT 670 

NORMINV (Quantile einer 

Normalverteilung) 696 

NORMVERT (Normalverteilung) 696 

NOTIERUNGBRU (Geldbetrag in 

Dezimalbruch wandeln) 697 

NOTIERUNGDEZ (Geldbetrag in 

Dezimalzahl wandeln) 698 

Nullwerte anzeigen/verbergen 168, 170, 465, 

466 

NV (Nicht vorhanden) 699 

O 
Oberflächendiagramm 298, 300 

OBERGRENZE (Aufrunden auf ein 

Vielfaches von n) 700 

Objekt > Ausrichten oder verteilen 255 

Objekt > Diagramm 

Als Grafik speichern 332 

Daten in Spalten 303 

Daten in Zeilen 303 
Horizontale Gitternetzlinien anzeigen 322 

Position des Diagramms ändern 331 

Trendlinie hinzufügen 314, 315 
Vertikale Gitternetzlinien anzeigen 322 

Objekt > Drehen oder Kippen 254, 255 

Objekt > Eigenschaften 

Allgemeine Eigenschaften 256 

Bei Auswahllisten 342 

Bei Bezeichnungen 350 
Bei Bildlaufleisten 348 

Bei Diagrammen 298, 324 

Bei Drehfeldern 346 
Bei Grafiken 275 

Bei Gruppenfeldern 350 

Bei Kontrollkästchen 338 
Bei Listen 344 

Bei OLE-Objekten 283 

Bei Optionsfeldern 340 

Bei Schaltflächen 345 

Bei Textrahmen 270 

Bei Zeichnungen 291 
Standardeinstellungen ändern 266 

Objekt > Gruppieren 268 

Objekt > Gruppierung aufheben 268 

Objekt > Neue Zeichnung 286 

Objekt > Neuer Diagrammrahmen 296 

Objekt > Neuer Grafikrahmen 273 

Objekt > Neuer Grafikrahmen aus der Galerie 

275 

Objekt > Neuer OLE-Objektrahmen 279, 280, 

281 

Objekt > Neuer Textrahmen 269, 270 

Objekt > Neues Formularobjekt 335 

Auswahlliste 342 

Bezeichnung 349, 350 

Bildlaufleiste 348 
Drehfeld 346 

Gruppenfeld 349, 350 

Kontrollkästchen 338 
Liste 343 

Optionsfeld 340 

Schaltfläche 345 

Objekt > Reihenfolge 267, 268 

Objekte 249 

Ausrichten und verteilen 255 
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Duplizieren 256 

Eigenschaften ändern 256 

Einfügen 250 
Größe ändern 253 

Gruppieren 268 

Position ändern 253 
Reihenfolge ändern 267 

Rotieren 254, 256, 257 

Selektieren 250 
Verbergen 267 

Verteilen 255 

Objektleiste 251, 252 

Objektmodus 251 

Objektmodus (Menü Ansicht) 251 

ODER (Logisches ODER) 701 

Öffnen (Menü Datei) 45, 209, 210, 411, 412 

Oktalzahl in Binärzahl wandeln (OKTINBIN) 

701 

Oktalzahl in Dezimalzahl wandeln 

(OKTINDEZ) 703 

Oktalzahl in Hexadezimalzahl wandeln 

(OKTINHEX) 703 

OKTINBIN (Oktalzahl in Binärzahl wandeln) 

701 

OKTINDEZ (Oktalzahl in Dezimalzahl 

wandeln) 703 

OKTINHEX (Oktalzahl in Hexadezimalzahl 

wandeln) 703 

OLE-Objekte 279 

Bearbeiten 281, 282 

Eigenschaften ändern 283 

Einfügen 279 

Online-Berechnung 437, 441 

OpenGL-Bibliothek verwenden 451, 453 

Operatoren 504 

Optimale Breite 166 

Optimale Höhe 166 

Optionsfeld (Formularobjekt) 340 

Originalgröße (Menü Ansicht) 468 

P 
Papiergröße 229, 230 

Papierschacht 229, 230 

Papierschächte 229, 230 

Pascal-Verteilung (NEGBINOMVERT) 692 

PDF-Export 394, 395 

PEARSON (Pearsonscher 

Korrelationskoeffizient) 705 

PHI (Standardnormalverteilung) 706 

PI (Kreiszahl Pi) 706 

PlanMaker-Dateiformat 411, 412, 413 

PlanMaker-Tour 51 

PMBAK-Dateien 374, 377 

PMD-Dateiformat 411, 413 

PMDX-Dateiformat 411, 412 

POISSON (Poisson-Verteilung) 707 

Poisson-Verteilung (POISSON) 707 

POLYNOMIAL (Multinomialkoeffizient) 708 

Polynomialkoeffizient (POLYNOMIAL) 708 

Position 

von Objekten 253 

Position eines Werts in einem Bereich 

(VERGLEICH) 785 

POTENZ (Potenzierung) 709 

Potenzierung 

Funktion POTENZ 709 

Operator 504, 505 

Potenzreihe (POTENZREIHE) 709 

POTENZREIHE (Potenzreihe) 709 

Primäre Achsen (in Diagrammen) 328 

PRODUKT (Produkt) 710 

Prozent (Zahlenformat) 170, 171 

Prozentzeichen 504, 505 

Pyramidendiagramm 298, 301 

Q 
QIKV (Modifizierter interner Zinsfuß) 711 

QUADRATESUMME (Summe der Quadrate) 

712 

Quadratwurzel (WURZEL) 801 

QUANTIL (Quantile einer Datenmenge) 712 

QUANTILSRANG (Prozentrang eines 

Wertes) 713 

QUARTILE (Quartile einer Datenmenge) 714 

Quelle wählen (Menü Datei) 274, 275 

Querformat 229, 230 

Quickinfos 441, 443 

Quickinfos für Formeln 437, 438 

QUOTIENT (Ganzzahliger Teil einer 

Division) 715 

R 
Rahmen 249, Siehe Objekte 

Rahmen und Zeichnungen direkt einfügen 

437, 439 
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Ränder 

Innenränder von AutoFormen 292 

Innenränder von Textrahmen 270, 271 
Innenränder von Zellen 185, 187 

Seitenränder 229, 230 

RANG (Rang eines Wertes in einer 

Wertemenge) 715 

Raster 465, 466 

Rechtecke 

Eigenschaften ändern 291 

Zeichnen 286, 289 

RECHTS (Teil einer Zeichenkette) 717 

Rechtsbündig 185, 186 

Rechtschreibprüfung 353 

Benutzerwörterbücher bearbeiten 358 

Nachträglich 355 

Sprache einstellen 353 
Während des Tippens 357, 446 

Wörterbücher nachinstallieren 497 

Rechtschreibprüfung (Menü Weiteres) 355 

Redo 44, 70 

Regelmäßige Zahlung (RMZ) 724 

Registerkarten für Dokumente 36, 425, 426, 

427, 428 

Regression, exponentielle 

Kenngrößen (RKP) 722 

Werte (VARIATION) 782 

Regression, lineare 

Kenngrößen (RGP) 720 
Werte (TREND) 770 

Reihenachse (in Diagrammen) 320 

Reihenfolge (Menü Objekt) 267, 268 

Reihenfolge (von Objekten) 267 

Relative Zellbezüge 508, 509 

REST (Rest einer Division) 717 

RESTP (Rest einer Division) 718 

RGP (Kenngrößen einer linearen Regression) 

720 

Ribbon 21, 35, 441, 442 

Anpassen 481 

Liste aller Menübefehle und Ribbonbefehle 

827 

Ribbon oder Menüs/Symbolleisten? 441, 442 

Ringdiagramm 298, 300 

RKP (Kenngrößen einer exponentiellen 

Regression) 722 

RMZ (Regelmäßige Zahlung) 724 

RÖMISCH (Römische Schreibweise einer 

Zahl) 725 

Rotieren 

Achsenbeschriftungen 316, 318, 320, 321 

Objekte 254, 256, 257 
Text in AutoFormen 292 

Text in Textrahmen 270, 272 

Zellinhalte 185, 187 

Rubrikenachse (in Diagrammen) 316 

Rückgängig (Menü Bearbeiten) 44, 70 

Runden 

ABRUNDEN 522 

AUFRUNDEN 537 

FEST 592 
GANZZAHL 600 

GERADE 605 
KÜRZEN 663 

OBERGRENZE 700 

RUNDEN 726 
UNGERADE 777 

UNTERGRENZE 778 

VRUNDEN 791 
Zahlen gerundet anzeigen (per 

Zahlenformat) 168, 169 

RUNDEN (Runden auf n Stellen) 726 

S 
SÄUBERN (Nicht-druckbare Zeichen 

entfernen) 727 

Säulendiagramm 298 

Scannen 274 

Schaltfläche (Formularobjekt) 345 

Schatten (bei Objekten) 261 

Schattierung (Menü Format) 183 

SCHÄTZER (Schätzwert für einen linearen 

Trend) 727 

SCHIEFE (Schiefe einer Verteilung) 729 

Schließen (Menü Datei) 427 

Schnellwahlpfade 368 

Schnellzugriffsleiste 35, 441, 442, 483, 484, 

489 

Schnittbereich 

Funktion SCHNITTBEREICH 730 

Operator 504, 505 

SCHNITTBEREICH (Schnittmenge zweier 

Bereiche) 730 

Schreibrichtung 420, 421 

Schriftart 188, 190 

Schriftenliste mit echten Schriften 441, 442 

Schriftfarbe 192 

Schriftgröße 188, 190 
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Schutzanzeiger 459, 460 

Schützen 401 

Arbeitsmappenschutz 404 

Blattschutz 401 

Dokumentschutz 406 
Gliederungsansicht schützen 383, 384 

Schwellenwert (GGANZZAHL) 607 

Script bearbeiten (Menü Weiteres) 423 

Script starten (Menü Weiteres) 423 

Scripts 337, 418, 423 

Seite einrichten (Menü Datei) 229, 231, 234 

Seitenformat 229 

Seitennummer 231, 232, 234, 237 

Seitenränder 229, 230 

Seitenumbruch 

Ein-/Ausblenden 465, 466 
Manuell beeinflussen 238 

Seitenumbruch (Menü Einfügen) 238 

Seitenverhältnis beibehalten 256, 257 

Seitenzahl 234, 237 

Sekundäre Achsen (in Diagrammen) 326, 328 

SEKUNDE (Sekunde aus einem Datumswert 

ermitteln) 731 

Selektieren 

Objekte 250 
Zellen 71 

Selektiv löschen (Menü Bearbeiten) 76 

SHM-Erweiterungen verwenden 451, 453 

Sicherungskopien 374, 375, 447, 450 

Silbentrennung 359 

in Textrahmen 359 

in Zellen 360 

Sprache einstellen 353 

SIN (Sinus) 731 

SINHYP (Sinus Hyperbolicus) 732 

Sinus (SIN) 731 

Sinus Hyperbolicus (SINHYP) 732 

Skalierung (von Druckseiten) 231, 233 

Skalierung beibehalten 256, 257 

SoftMaker 23 

SoftMaker Basic 423 

SoftMaker Formeleditor 285 

Sonderzeichen (Menü Einfügen) 160 

Sortieren 

Befehl Arbeitsblatt > Sortieren 104 

Funktion SORTIERENM 733 
Funktion SORTIERENV 734 

Sortieren (Menü Arbeitsblatt) 104 

SORTIERENM (Sortieren) 733 

SORTIERENV (Sortieren) 734 

Spalte 

Breite ändern 165 
Ein-/ausblenden 167 

Einfügen 79 

Löschen 77 
Markieren 72 

Spalte (Menü Arbeitsblatt) 

Ausblenden 167, 168 

Breite 166 

Einblenden 167, 168 
Optimale Breite 166 

SPALTE (Spaltennummer von Zellen) 736 

SPALTEN (Anzahl Spalten) 737 

Spaltenkopf 

Ändern der Spaltenbreite 165, 166 
Drucken 231 

Ein-/Ausblenden 465, 466 

Verwenden zum Markieren 72 

Spaltennummer von Zellen (SPALTE) 736 

Speichern (Menü Datei) 48 

Speichern unter (Menü Datei) 48, 411, 412 

Spezialfilter 109 

Spiegeln (von Objekten) 254 

Spiegelungseffekt (bei Objekten) 263 

Sprache 

Für die Benutzeroberfläche 441 
für Rechtschreibung/Silbentrennung 353 

Sprachmodule 353 

STABW (Standardabweichung einer 

Stichprobe) 737 

STABWA (Standardabweichung einer 

Stichprobe) 738 

STABWN (Standardabweichung einer 

Grundgesamtheit) 739 

STABWNA (Standardabweichung einer 

Grundgesamtheit) 740 

Standard (Menü Format) 195 

Standard (Zahlenformat) 170 

Standardabweichung 

Grundgesamtheit (STABWN) 739 

Grundgesamtheit (STABWNA) 740 

Stichprobe (STABW) 737 
Stichprobe (STABWA) 738 

Standard-Dateiformat 447, 448 

Standardfehler einer linearen Regression 

(STFEHLERYX) 744 

STANDARDISIERUNG (Standardisierung) 

741 
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Standardnormalverteilung 

STANDNORMINV 741 

STANDNORMVERT 742 

Standardschrift 202 

Standardwährung 459, 461 

STANDNORMINV (Quantile einer 

Standardnormalverteilung) 741 

STANDNORMVERT 

(Standardnormalverteilung) 742 

Statistik (des Dokuments) 459 

Statuszeile 37 

STEIGUNG (Steigung einer 

Regressionsgeraden) 743 

STFEHLERYX (Standardfehler einer linearen 

Regression) 744 

Studentscher t-Test (TTEST) 771 

Student-Verteilung 

TINV 769 

TVERT 772 

STUNDE (Stunde aus einem Datumswert 

ermitteln) 745 

Subtraktion 504, 505 

Suchen 

Dateien 372 

Funktion FINDEN 594 
Funktion SUCHEN 746 

Zellinhalte 241 

Suchen (Menü Bearbeiten) 241, 243 

SUCHEN (Text in Zeichenkette suchen) 746 

Suchen wiederholen (Menü Bearbeiten) 243 

SUMME (Summe) 747 

Summe ausgewählter Werte 

(SUMMEWENN) 749 

Summe ausgewählter Werte 

(SUMMEWENNS) 751 

SUMMENPRODUKT (Summenprodukt) 748 

SUMMEWENN (Summe ausgewählter 

Werte) 749 

SUMMEWENNS (Summe ausgewählter 

Werte) 751 

SUMMEX2MY2 (Summe von x^2 - y^2) 753 

SUMMEX2PY2 (Summe von x^2 + y^2) 754 

SUMMEXMY2 (Summe von (x - y)^2) 755 

SUMQUADABW (Mittlere quadratische 

Abweichung vom Mittelwert) 756 

Support 23 

SVERWEIS (Zellbereich spaltenweise 

durchsuchen) 756 

Symbolleisten 

Anpassen 469, 470, 475 

Benutzerdefinierte Symbole erstellen 490 

Verwenden 33 

Symbolleisten (Menü Ansicht) 469, 470 

Syntaxhervorhebung (Menü Ansicht) 116 

System-Dateidialoge verwenden 441, 444 

Systemmenüs verwenden 441, 443 

Systemvoraussetzungen 24 

Szenarien (Menü Weiteres) 129 

T 
T (Wert in eine Zeichenkette umwandeln) 758 

Tabelle 

Bearbeiten 63 

Gestalten 163 
Markieren 72 

Neu anlegen 45 

Öffnen 45 
Schützen 401, 406 

Tabelle (Menü Arbeitsblatt) 

Einfügen 149, 150 

In Bereich konvertieren 148, 149 

Löschen 149, 151 

Selektieren 149, 151 

Tabelle löschen 148, 149 

Tabellenbereich 149, 150 
Tabelleneigenschaften 152 

Tabellen automatisch erweitern 437, 439 

Tabellen in Tabellen 145 

Tabulatorbreite (in Textrahmen) 459 

TAG (Tag aus einem Datumswert ermitteln) 

759 

TAGE (Differenz zwischen zwei Daten) 760 

TAGE360 (Differenz zwischen zwei Daten) 

761 

TAGEIMJAHR (Zahl der Tage eines Jahres) 

762 

TAGEIMMONAT (Zahl der Tage eines 

Monats) 763 

TAGEP (Kompatibilitätsfunktion) 763 

TAN (Tangens) 764 

Tangens (TAN) 764 

Tangens Hyperbolicus (TANHYP) 765 

TANHYP (Tangens Hyperbolicus) 765 

Tastatur automatisch ein-/ausblenden 451, 453 

Tastenkürzel 

Anpassen 491, 492 

für Sonderzeichen 160 

für Zeichenvorlagen 200, 201 
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für Zellenvorlagen 205, 206 

Vordefinierte 840 

Mac 844 
Windows/Linux 840 

Technischer Support 23 

TEIL (Teil einer Zeichenkette) 766 

TEILERGEBNIS 766 

TEXT (Zahl in formatierten Text wandeln) 

768 

Text (Zahlenformat) 170, 172 

Text eingeben 67, 69 

Text in Spalten aufteilen (Menü Arbeitsblatt) 

107 

Text in Zeichenkette ersetzen 

ERSETZEN 584 
WECHSELN 795 

TextArt-Objekte 

Eigenschaften ändern 291 

Zeichnen 286, 289 

Textauszeichnungen 188, 191 

Textbaustein (Menü Einfügen) 362, 363, 364 

Textbausteine 

Automatisch ersetzen 437, 440 

Verwenden 361, 362 

Textdatei-Dateiformat 411, 413 

Text-Eingabemodus 37, 38 

TextMaker-Dateiformat 411, 413 

Textrahmen 269 

Eigenschaften ändern 269, 270 

Einfügen 269 

Textrahmen-Hilfslinien 459, 461 

Tiefstellen 193 

TINV (Quantile einer t-Verteilung) 769 

Titel (von Diagrammen) 328 

Titelleiste 31 

Tortendiagramm 298, 300 

Transparenz (von Grafiken) 275, 277 

Transponieren (Menü Arbeitsblatt) 107 

Transponieren einer Matrix (MTRANS) 688 

TREND (Werte einer linearen Regression) 

770 

Trendlinien (in Diagrammen) 314 

Trennzeichen für Zahlen 437, 441 

t-Test (TTEST) 771 

TTEST (t-Test) 771 

TVERT (t-Verteilung) 772 

t-Verteilung 

TINV 769 

TVERT 772 

TYP (Typ des Arguments ermitteln) 773 

U 
Überlappende Objekte 270, 271, 292 

Uhrzeiten eingeben 67 

Umrandung (Menü Format) 180, 181 

UMWANDELN (Maßeinheiten umrechnen) 

774 

UND (Logisches UND) 777 

Undo 44, 70 

UNGERADE (Aufrunden auf eine ungerade 

Zahl) 777 

UNTERGRENZE (Abrunden auf ein 

Vielfaches von n) 778 

Unterschneidung (Kerning) 194 

Unterstreichen 191 

Updates 451, 452 

V 
Varianz 

Grundgesamtheit (VARIANZEN) 780 

Grundgesamtheit (VARIANZENA) 781 

Stichprobe (VARIANZ) 779 
Stichprobe (VARIANZA) 779 

VARIANZ (Varianz einer Stichprobe) 779 

VARIANZA (Varianz einer Stichprobe) 779 

VARIANZEN (Varianz einer 

Grundgesamtheit) 780 

VARIANZENA (Varianz einer 

Grundgesamtheit) 781 

VARIATION (Werte einer exponentiellen 

Regression) 782 

VARIATIONEN 783 

VBA 423 

VBA-Scripts 337, 418 

Verbergen 

Objekte 267 

Zellinhalte 402 

Verbindungen 

Eigenschaften ändern 291 

Verbindungslinien 

Zeichnen 286, 288 

Verborgene Dateien und Ordner anzeigen 451, 

454 

Verborgene Objekte anzeigen 459, 461 

VERGLEICH (Position eines Werts in einem 

Bereich) 785 
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Vergrößerungsstufe (Menü Ansicht) 468 

VERKETTEN (Zeichenketten verbinden) 786 

Verkettung von Zeichenketten 504, 505, 786 

Verknüpfungen (Hyperlinks) 

bei Objekten 264, 265 

bei Zellinhalten 385 
Funktion HYPERLINK 617 

Verknüpfungen (Menü Bearbeiten) 282 

Verschieben um ... Stellen 459, 460 

Verschlüsselung 406, Siehe Dokumentschutz 

Versenden (Menü Datei) 400 

Versenden eines Dokuments per E-Mail 400 

Vertikale Ausrichtung 

bei AutoFormen 292 
bei Textrahmen 270, 272 

von Zellinhalten 185, 187 

Vertikale Gitternetzlinien anzeigen 322 

Vertikaler Text 185, 188 

VERWEIS (Zellbereich durchsuchen) 786 

Visual Basic 423 

Vollbild (Menü Ansicht) 468 

Vollbildansicht 468 

Vorlagenpfad 447, 448 

Vorschau (auf ein Dokument) 45, 47 

Vorzeichen 504, 505 

VORZEICHEN (Vorzeichen einer Zahl) 790 

VRUNDEN (Runden auf ein Vielfaches von 

n) 791 

W 
WAHL (Auswahl aus einer Liste) 792 

WAHR (Wahrheitswert) 792 

Wahrheitswert (Zahlenformat) 170, 172 

WAHRSCHBEREICH (Wahrscheinlichkeit) 

793 

WÄHRUNG (Zahl als Währung formatieren) 

794 

Währung (Zahlenformat) 170, 171 

Wände (in Diagrammen) 308 

Warnton bei Meldungen 441, 443 

Warnton bei Tippfehlern 446, 447 

Warnung beim Laden von OLE-Objekten 435, 

436 

Weberfunktion (BESSELY) 546 

WECHSELN (Text in Zeichenkette ersetzen) 

795 

WEIBULL (Weibull-Verteilung) 796 

Weiche Kanten-Effekt (bei Objekten) 263, 

264 

Weiteres > Anpassen 

Benutzerdefinierte Symbole erstellen 490 

Symbolleisten anpassen 475 
Tastenkürzel anpassen 491, 492 

Weiteres > Arbeitsmappenschutz 404, 405 

Weiteres > Blattschutz 401, 403 

Weiteres > Blattschutz aufheben 404 

Weiteres > Diagramme aktualisieren 330, 462, 

464 

Weiteres > Einstellungen 432 

Karteikarte Allgemein 435 

Karteikarte Ansicht 432 
Karteikarte Aussehen 441 

Karteikarte Bearbeiten 437 

Karteikarte Dateien 447 
Karteikarte Schriften 455 

Karteikarte Sprache 446 

Karteikarte System 451 

Weiteres > Externe Bezüge aktualisieren 512, 

513 

Weiteres > Formelüberwachung 119, 121, 

122, 123, 124 

Weiteres > Listen editieren 494, 495 

Weiteres > Neu berechnen 125, 462, 463 

Weiteres > Rechtschreibprüfung 355 

Weiteres > Script bearbeiten 423 

Weiteres > Script starten 423 

Weiteres > Szenarien 129 

Weiteres > Wörterbücher bearbeiten 358 

Weiteres > Zielwertsuche 127 

WENN (Wenn-Dann-Sonst-Bedingung) 797 

WENNFEHLER (liefert Zeichenkette bei 

Fehler) 797 

WERT (Zeichenkette in Zahl umwandeln) 798 

Wiederherstellen (Menü Bearbeiten) 44, 70 

Wiederholen (Menü Bearbeiten) 71 

WIEDERHOLEN (Zeichenkette n mal 

wiederholen) 799 

Wiederholungsspalten 231 

Wiederholungszeilen 231 

Wissenschaftliches Zahlenformat 170, 172 

WOCHENTAG (Wochentag aus Datum 

ermitteln) 800 

Wölbung einer Verteilung (KURT) 662 

Wörterbücher bearbeiten (Menü Weiteres) 

358 
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Wörterbücher nachinstallieren (für 

Rechtschreibprüfung) 497 

Wurzel 

WURZEL 801 

WURZELN 801 
WURZELPI 802 

WURZEL (Quadratwurzel) 801 

WURZELN (Wurzel) 801 

WURZELPI (Quadratwurzel von x*Pi) 802 

WVERWEIS (Zellbereich zeilenweise 

durchsuchen) 803 

X 
X-Achse (in Diagrammen) 316 

XIM verwenden 451, 454 

XINTZINSFUSS (Interner Zinsfuß) 805 

XKAPITALWERT (Nettobarwert) 806 

XLS-Dateiformat 411, 412 

XLSX-Dateiformat 411, 412 

XODER (Logisches EXKLUSIV ODER) 806 

XY-Punktdiagramm 298, 299 

Y 
Y-Achse (in Diagrammen) 318 

Z 
Z-Achse (in Diagrammen) 320 

Zahl (Zahlenformat) 170, 171 

Zählen 

ANZAHL 526 

ANZAHL2 527 

ANZAHLLEEREZELLEN 527 

ZÄHLENWENN 807 

ZÄHLENWENNS 808 

Zahlen eingeben 67 

Zahlenformat 168, 170, 173, 175 

ZÄHLENWENN (Zählen ausgewählter 

Werte) 807 

ZÄHLENWENNS (Zählen ausgewählter 

Werte) 808 

Zehnerlogarithmus (LOG10) 669 

Zeichen (Menü Format) 188, 190, 191, 192, 

193, 194, 195 

ZEICHEN (Zeichen per ANSI-Code) 810 

Zeichenbreite 194 

Zeichenformat 188 

Zeichenformatierung auf das ganze Wort 

anwenden 437, 438 

Zeichenketten 

Teil ausschneiden (LINKS) 667 

Teil ausschneiden (RECHTS) 717 
Teil ausschneiden (TEIL) 766 

Verbinden (VERKETTEN) 786 

Zeichenvorlage (Menü Format) 199, 200, 201, 

202, 203 

Zeichenvorlagen 199 

Zeichnungen 286 

Eigenschaften ändern 291 

Einfügen 286 

Rotieren 254 

Zeichnungsfläche (in Diagrammen) 307 

Zeile 

Ein-/ausblenden 167 
Einfügen 79 

Höhe ändern 165 

Löschen 77, 78, 79 
Markieren 72 

Zeile (Menü Arbeitsblatt) 

Ausblenden 167 

Einblenden 167, 168 

Höhe 166 
Optimale Höhe 166, 167 

ZEILE (Zeilennummer von Zellen) 811 

Zeilen- & Spaltenköpfe (Menü Ansicht) 465, 

466 

ZEILEN (Zahl der Zeilen) 811 

Zeilenabstand 196 

Zeilenkopf 

Ändern der Zeilenhöhe 165, 166 

Drucken 231 

Ein-/Ausblenden 465, 466 

Verwenden zum Markieren 72 

Zeilennummer von Zellen (ZEILE) 811 

Zeilenumbruch 185, 187 

ZEIT (Datumswert bilden) 812 

ZEITDIFFERENZ (Differenz zwischen zwei 

Uhrzeiten) 813 

ZEITWERT (Text in Uhrzeit wandeln) 814 

Zelladresse als Text ausgeben (ADRESSE) 

525 

Zellbearbeitung wird nie mit linker Pfeiltaste 

verlassen 437, 438 

Zelle 

Ausfüllen 67 
Automatisch ausfüllen 87 

Einfügen 79 

Größe ändern 165 
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Löschen 77 

Markieren 71, 72, 73 

Schützen 401 
Verbinden 185, 188 

ZELLE (Informationen über eine Zelle) 815 

Zelle (Menü Format) 

Karteikarte Ausrichtung 185 
Karteikarte Schattierung 183 

Karteikarte Schutz 402 

Karteikarte Umrandung 180 
Karteikarte Zahlenformat 168, 170, 173 

Zelle direkt in der Tabelle editieren 437 

Zellen automatisch vervollständigen 67, 70, 

437 

Zellen einfügen (Menü Arbeitsblatt) 79 

Zellen löschen (Menü Arbeitsblatt) 77 

Zellen verbinden 185, 188 

Zellenvorlage (Menü Format) 204, 205, 207 

Zellenvorlagen 204 

Zellmarkierung 432, Siehe Zellrahmen 

Zellrahmen 43, 432, 435 

Zentriert 185, 186 

ZGZ (Zinssatz) 816, 817 

Zielwertsuche (Menü Weiteres) 127 

ZINS (Zinssatz per Iterationsverfahren) 817 

Zinsfuß 

IKV 621 

QIKV 711 
XINTZINSFUSS 805 

Zinssatz (ZGZ) 816, 817 

Zinssatz (ZSATZINVEST) 816 

Zinssatz per Iterationsverfahren (ZINS) 817 

ZINSZ (Zinszahlung) 819 

Zinszahlung (ZINSZ) 819 

Zinszahlung, kumuliert (KUMZINSZ) 661 

Zinszeitraum (ZZR) 825 

Zirkulärer Bezug 37, 38, 462, 464 

ZSATZINVEST (Zinssatz) 816 

z-Test 611, Siehe GTEST (Gauß-Test) 

ZUFALLSBEREICH (zufälliger Wert) 820 

ZUFALLSZAHL (zufälliger Wert) 821 

Zukünftiger Wert (ZW) 822 

Zukünftiger Wert (ZW2) 823 

ZULETZTGEDRUCKT (Datum des letzten 

Ausdrucks) 822 

ZULETZTGESPEICHERT (Datum des 

letzten Speicherns) 822 

Zurück zu vorheriger Version (Menü Datei) 

374, 376 

ZW (Zukünftiger Wert) 822 

ZW2 (Zukünftiger Wert) 823 

Zweierfakultät (ZWEIFAKULTÄT) 824 

ZWEIFAKULTÄT (Zweierfakultät) 824 

Zwischenergebnisse runden 462, 464 

Zylinderdiagramm 298, 301 

ZZR (Zinszeitraum) 825 
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